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Microsoft Windows 3.0 

Welcome to Microsoft ® Windows TM, the software that transforms the way you 
use your personal computer. Windows' ability to run more than one application at 
a time and transfer information between applications, the superior way it uses the 
full power of your computer, and its rich graphical interface provide a more 
intuitive, more efficient work environment than ever before available on a PC. 

This introductory section of the Windows User's Guide tells you about the com
puter equipment and software you need to run Windows, and what you'll receive 
when you register your copy of Windows. It also offers a preview of the Windows 
graphical environment and highlights its new features and enhancements. Perhaps 
most importantly, this section prepares you to make the most of the User's Guide 
by defining typographical conventions and important terminology. 

If You Have a Previous Version of Windows 
Updates are already available for some of the Windows applications that you ran 
with previous versions of Windows. The updated versions take full advantage of 
the new features and power of Windows 3.0. 

If you have not received information about Windows 3.0 updates for your favorite 
Windows applications, check with the manufacturers. 

Until you receive an update, you can run Windows 2.x applications that you 
already own by starting Windows in real mode, the operating mode used by pre
vious versions of Windows. See Chapter 11, "Options for Starting Windows," for 
information about starting in real mode. To learn more about running applications 
that were developed for previous versions of Windows, see "Older Windows 
Applications" in Chapter 12. 

What You Need to Run Windows 
Windows 3.0 can run in three modes: real mode, standard mode, or 386 ™ 
enhanced mode. The mode that you use depends on the equipment you have 
and the software applications you want to run in the Windows environment. 

Real mode is the operating mode that provides maximum compatibility with pre
vious versions of Windows applications (2.x versions). Real mode is also the only 

ix 
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mode available for computers with less than 1 megabyte (MB) of memory (640 
kilobytes (K) of conventional memory and 256K of extended memory). 

Standard mode is the normal operating mode for running Windows. This mode 
provides access to extended memory and also lets you switch among non
Windows applications. 

386 enhanced mode provides access to the virtual memory capabilities of the 
Intel ® 80386 processor. Virtual memory capabilities let Windows applications use 
more memory than is physically available. Enhanced mode also allows for multi
tasking of non-Windows applications. 

Windows 3.0 works with most personal computers on the market today. In the 
Windows package, you received a Hardware Compatibility List of equipment that 
passed Windows compatibility testing. Any hardware that is 100 percent com
patible with hardware on the list should work fine with Windows. If you intend to 
use equipment that is not on this list, ask the equipment manufacturer about any 
special software you might need before you can use it with Windows 3.0. 

The minimum software and hardware requirements your computer system needs 
to run Windows successfully are: 

• MS-DOS ® or PC-DOS, version 3.1 or later. 

• For 386 enhanced mode, a personal computer with the Intel 80386 processor 
(or higher) and 2 megabytes (MB) or more of memory (640K of conventional 
memory and 1024K of extended memory). 

For standard mode, a personal computer with the Intel 80286 processor (or 
higher) and 1 megabyte or more of memory (640K conventional memory and 
256K of extended memory). 

For real mode, a personal computer with the Intel 8086 or 8088 processor (or 
higher) and 640K of conventional memory. 

• A hard disk with 6 to 8 megabytes of free disk space, and at least one floppy 
disk drive. 

• A monitor that is supported by Windows. 

• A printer that is supported by Windows if you want to print with Windows. 

• A Hayes ®-compatible modem that is supported by Windows if you want to use 
Terminal, the Windows communications software. 

• A mouse that is supported by Windows. Though it is not required, a mouse is 
highly recommended so that you can take full advantage of Windows' easy-to
use graphical interface. 
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Windows detennines which operating mode your system uses when you start up 
using the standard procedure outlined in Chapter 1, "Getting Started." For infor
mation about starting Windows in an alternate mode, see Chapter 11, "Options for 
Starting Windows." For infonnation about memory, see Chapter 13, "Optimizing 
Windows." 

NOTE If your computer has more than 640K of memory, you should configure it as 
extended memory to get the best performance from Windows. Memory considerations are 
discussed in Chapter 13, "Optimizing Windows." 

With less than 1 MB of memory, Windows will run only in rea/mode. See Chapter 12, "More 
About Applications," for an explanation of running Windows in real mode. 

Registering Windows 
Please take a moment to fill out and mail the Registration Card you received with 
Windows. Registering Windows entitles you to the following additional benefits: 

• Microsoft's technical support if you have any difficulty using Windows. Your 
questions will be answered by dedicated support specialists experienced in 
assisting Windows customers. 

• Automatic notification of upgrades or revisions to Windows. By receiving 
timely notices directly from Microsoft, you'll be among the first to know about 
upgrades. 

• Automatic notification when new products related to Windows are released. 
You'll receive up-to-date infonnation about exciting new Windows applica
tions as soon as they become available. In some cases, you'll be offered special 
introductory pricing. 

What Is Microsoft Windows? 
Windows is a graphical environment that introduces new, more streamlined ways 
for you to work with your personal computer. Windows not only gives you more 
control over the way you work, it unleashes your computer so it can operate at its 
full power, unhampered by previous memory restrictions. 

With Windows, you'll find it easy to start up and work with your software applica
tions, run more than one application at a time, transfer infonnation between them, 
and organize and manage the files you create with them. 
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In Windows, your computer screen is referred to as a desktop. The desktop dis
plays all your work in rectangular areas called windows. You work with your 
applications and documents in these windows. 

'---"""T"'""- Windows 
I 

........ 1.. .. 
"""I Calendar - MEETINGS.CAL 
File Edit View Show Alarm Options Help 

1:34 PM ,+,+, Wednesday. September 27.1989 , 

9:00 AM 206 16th St. West 
1+1 : 

10:00 
11 :00 
11:30 
12:00 PM 
1:00 
2:00 
3:00 
4:00 
5:00 
6:00 
7:00 
8:00 

Program Manager 

Icon 

file j;dit Search 

Lunch in Pacific Rm 
TO DO THIS WEEK: 

• I • 

!:!elp 

Present last month's 1. Prepare charts for Thursday -:.:-: 
status meeting. results 

Review strategy 2. Schedule seminar for next 
month. 

Meet sales staff at tI 3. Finish writing report by 
Friday. 

.:.:.: 

:-:.:. 

I 

4. Finish going through mail 
receiued while out of town. :-:.:. 

5. Call Jim McMurray and set 
up a meeting. 

l Desktop 

You arrange windows on the desktop just as you move work items around on your 
actual desk. For example, to review a spreadsheet and a report from two separate 
applications, you change the size of their windows so that they can fit side by side 
on the desktop. 
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If you want to leave an application for a while, you shrink its window to an 
application icon and the application keeps running. When you shrink an applica
tion, Windows places its application icon at the lower edge of the desktop until 
you restore it to window size again. 

..... 1 Notepad - TODO.lXT 1"'1'" 
Eile .Edit S.earch Help 

TO DO THIS WEEK: 

1. Prepare charts for Thursday 
status meeting. 

2. Schedule seminar for next 
month. 

3. Finish writing report by 
Friday. 

4. Finish going through mail 
receiued while out of town. 

5. Call Jim McMurray and set 
up a meeting. 

rn!l] 
Program Manager Calendar· MEETINGS.CAL 

.!. 

+ 

Eile .Edit ~iew ~ard 

Help 
Card View L+J+J 

IJohnson, Paul 
IFord, Janice 

IBall, Tom and Hancy 
McMurray, Jim 

Sales Manager 
JM Fountains 
1478 Lake Uiew Rd. 
Mequon. Wisconsin 
127-1958 

Control Panel 

··_"'1'" 
S.earch 

4 Cards 

0......-_____ """-______ 0......-_ Application Icons 

With Windows, you can run several powerful applications at once and switch 
quickly among them. For example, you could switch from a database application 
to a spreadsheet, and then to your word processor-with a few simple moves and 
without waiting while you quit one application and restart another. 
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When you work with two or more applications, whether they were designed 
specifically for Windows or not, you can transfer information from one to another. 
You select the information you want from one application, cut or copy it to the 
Clipboard, and then paste it into another application. By moving information in 
this way, you can combine the work you've done in a number of different applica
tions into a single, compound document. 

For example, you could start by writing the text for an invitation to the company 
picnic with your word processor. 

File .Edit .s.earch 

WHAT: 

WHO: 

WHEN: 

WHERE: 

t1 

.~ f I -

.character Earagraph Qocument Help 

-> Company Picnic <-

Free food and drink - sheltered picnic tables 
Swimming, boating, fishing, volleyball and 
baseball games 
Two music stages 

All full-time employees and their families or 
one guest 

August L 1990 
11:00AM - 9:00PM 

Corporate Park (See the following map.) 

I 

..!. 
0': 
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Then you could draw a map to the picnic grounds with a graphics application. 

Benline Rd. 

Finally, you could add the map to the invitation by cutting it from the graphics 
application and pasting it into the text you created with your word processor. 

.Eile !;dit Search ~haracter Earagraph .!locument !!elp 

WHAT: 

WHO: 

WHEN: 

WHERE: 

-, .. 

-> Company Picnic <-

Free food and drink - sheltered picnic tables 
Swimming, boating, fishing, volleyball and 
baseball games 
Two music stages 

All full-time employees and their families or 
one guest 

August 1, 1990 
11:00AM - 9:00PM 

Corporate Park (See the following map.) 

Corporate 
Park 

Benline Rd. 

I 

+ 
;:;:;:;: ::::::::::::::::::;: + :;:;: 
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As you work with an application, you can pause at any time to take care of other 
tasks. For example, you might need to make some additions to your card files, 
schedule yet another meeting on your calendar, or pull together some quick totals 
with Windows' electronic calculator. 

9:00 
10:00 
11:00 
12:00 PM 
1:00 
2:00 
3:00 
4:00 
5:00 
6:00 
7:00 

mm 
Program Manager 

Windows comes with a collection of useful accessory programs to help you man
age the various parts of your daily work. These accessories include a clock, an ap
pointment calendar, a calculator, a notepad, a card file, and a macro recorder. 

And to get you started working with applications, Windows includes three full
featured applications: Write, Paintbrush TM, and Terminal. Use these applications 
to prepare and edit documents, create colorful illustrations, and connect to other 
computers and information services with your modem. 

For those idle moments, or just to put some play in your day, Windows provides 
two games: Solitaire and Reversi. You can also use the games to practice some of 
the basic skills you need to operate Windows efficiently. See Chapter 2, "Basic 
Skills," to learn about operating Windows. 
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New Features in Windows 3.0 
If you are already familiar with earlier versions of Microsoft Windows, you'll no
tice right away that Windows 3.0 brings you many significant additions. The most 
visible improvement is the desktop's appearance. There you'll find a new standard 
color scheme, proportionally spaced type in the menus and dialog boxes, and a 
three-dimensional look to many icons and buttons. 

Three new applications-Program Manager, File Manager, and Task List- pro
vide more powerful, more intuitive ways to start programs, manage files 
and directories, and switch between running applications. 

You'll also find an on-line Help system that gives you quick, easy-to-use infor
mation about Windows' features. 

file Edit ~earch 

Erocedures 
.!1sing Help 

About Notepad ... 

Help menu in Notepad window 

+ 

One of the most dramatic improvements is the way Windows 3.0 can use memory. 
Windows looks beyond the previous limitation of 640K and addresses extended 
memory, the additional memory that is available in today's more powerful per
sonal computers. Now you can run several applications at once and work with 
much larger document files without running out of memory . 

Other new features and improvements include the following: 

• A new Setup program makes it easier to install Windows and later view or 
change your setup options. 

• A redesigned Control Panel lets you connect to network printers, set up addi
tional ports, set multitasking options for 386 enhanced mode, and customize 
the appearance of your desktop. 



xviii New Features in Windows 3.0 

• Print Manager provides more information about files that are printing
allowing you to view network print queues, for example. 

• Program Manager lets you organize your applications into distinct groups and 
then start the applications and their related documents quickly and easily. 

• File Manager allows a full range of mouse maneuvers so you can copy and 
move files and directories by dragging and dropping their icons with your 
mouse. 

• File Manager also lets you connect to and disconnect from network servers 
while using Windows. 

• Recorder lets you save a series of keyboard and mouse sequences and play 
them back whenever you want to repeat the sequence. This procedure creates 
what is known as a macro. 

• Paintbrush, a more powerful and sophisticated painting program, lets you 
create full-color illustrations. 

• Terminal supports new terminal emulations, communications protocols, file
transfer capabilities, and the assignment of multiple keystroke sequences to 
single keys. 

• Printing support has been improved for HP ®/PCL ® and PostScript ® printers. 

• New commands let you rearrange the windows on the desktop, making them 
easier to find and view. 

• A new, expanded symbol font is included. 

• Running Windows in 386 enhanced mode provides increased control over 
non-Windows applications. 

• System messages now include clear explanations and recommended remedies. 

• A new game, Solitaire, lets you practice the basic skills you use to operate 
Windows. 
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About Your Windows Documentation 
The Windows 3.0 documentation set consists of this User's Guide, an on-line Help 
system, and several read-me text files that are copied onto your hard disk when 
you install Windows. The pages that follow outline the contents of the User's 
Guide and define terminology that is important to your understanding of Windows. 

The way you like to learn and how much you already know about Windows 
and about computers will determine how you use the different pieces of the 
documentation. 

• The Windows User's Guide provides a comprehensive description of Windows 
and the ways you can work with it. It includes explanations and procedures for 
first-time users, as well as advanced topics for those already familiar with the 
Windows environment. 

• On-line Help is a new feature of Windows. It provides a quick reference for 
procedures, keystroke sequences, and commands you will need when operating 
Windows. You can find information in Help without leaving your computer. 

• Several text files are copied onto your hard disk when you install Windows. 
These. TXT files include information that was received too late to be printed in 
the User's Guide as well as information that is reserved for advanced users. 
You can read (and print) the files by opening them with any text processor 
(such as Notepad). These files include: 

README. TXT 

PRINTERS. TXT 

NETWORKS. TXT 

SYSINLTXT 

WININLTXT 

Information received after the User's Guide was 
printed. 

Information about particular printers and fonts 
that helps you configure them to run in the 
Windows environment. 

Information about operating Windows with 
specific network configurations. 

Procedures for modifying SYSTEM.INI settings 
(for advanced users only). 

Procedures for modifying WIN .INI settings 
(for advanced users only). 
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What's Included in Your Windows User's Guide? 

You'll probably find yourself using some Windows features, such as the new Pro
gram Manager, more often than others, such as PIF Editor. The User's Guide 
is organized with this in mind. Those features you are likely to use most often are 
described in the early chapters; those you'll use less frequently appear later. 

The User's Guide is divided into the following parts: 

Part 1, Windows Fundamentals. Chapters in this part explain the basic structure 
of Windows and the skills you need to work with Windows. They also show you 
how to use the important system-management applications you received with 
Windows. These applications are: 

• Task List, which lets you quickly switch applications on your desktop anytime. 

• Clipboard, which lets you move and copy infonnation from one window to 
another across applications. 

• Program Manager, which helps you organize your applications for easy access. 

• File Manager, which helps you organize and manage all the files and 
directories on your disks. 

• Control Panel, which lets you change colors and fonts, set up printers and mod
ems, or change the appearance of your desktop without leaving Windows. 

• Print Manager, which schedules and fills all print requests you send from 
Windows and non-Windows applications. 

Part 2, Windows Accessories. Chapters in this part describe the accessory 
applications that are included with the Windows package. You received three 
full-featured applications: 

• Windows Write, an executive word processor 

• Paintbrush, a color painting program 

• Tenninal, a communications program 

You also received several programs that add convenient capabilities to your 
Windows desktop, including Calculator, Calendar, Cardfile, Clock, Notepad, 
Recorder, and PIF Editor. 

Part 3, Advanced Topics. This part contains four chapters of infonnation for 
advanced users. It explains how to set options for running certain applications 
and how to modify Windows to run most efficiently with your computer and the 



Microsoft Windows 3.0 xxi 

applications you want to use. And it offers instructions for using Windows on a 
network. 

Appendixes. The appendixes provide reference material on the following topics: 

• How to reconfigure your Windows environment using Setup 

• How to enter special characters, such as special symbols or letters used in 
languages other than American English 

• How to change the specifications for terminal emulations 

• How to enter specialized CONFIG.SYS command lines 

This User's Guide also includes a glossary and a comprehensive index. 

For your convenience, each chapter in the User's Guide begins with a table of 
contents listing the topics you'll find in that chapter. 

Assumptions 

The User's Guide assumes the following: 

• Windows refers to Microsoft Windows version 3.0 or later. 

• MS-DOS refers to versions 3.1 or later of MS-DOS or PC-DOS. 

• You are using a mouse with Windows. However, you'll also find the equivalent 
keyboard techniques with each description, in the step-by-step procedures, and 
in on-line Help. 

Conventions 

To help you locate and interpret information easily, the User's Guide employs 
consistent visual cues, a few standard text formats, and some special terminology. 
These conventions are explained as follows. 
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Visual Cues 
You will find the following typographic conventions throughout the User's Guide. 

Type style 

italic 

bold 

ALL CAPITALS 

SMALL CAPITALS 

Initial Capitals 

Symbol 

[> 

o 
Mouse 

f(eyboard 

13861' 

Used for 

Anything that you must type exactly as it appears. For 
example, if you are asked to type dir \windows, you would 
type all the italicized characters exactly as they are printed 
in the guide. 

Italic type also signals a new term. An explanation 
immediately follows the italicized term. 

Placeholders for information you must provide. For 
instance, if you are asked to type filename, you would 
type the actual name for a file instead of the word shown 
in bold print. 

Directory names, filenames, and acronyms. 

The names of keys on your keyboard. For example, CTRL, 
ESC, or HOME. 

Menu items, command names, and dialog-box names and 
options. For example, File menu, Save command, or Line 
Wrap option. 

Used For 

Signals the beginning of a procedure. 

Signals a procedure that has only one step. 

Instructions for mouse users. 

Instructions for keyboard users. 

Signals a section that is specific to operating Windows in 
386 enhanced mode. 

NOTE Windows starts in one of three operating modes depending on your hardware 
configuration. For a definition of the various modes, see the "Terminology" section that 
follows and Chapter 1, "Getting Started." For information about starting Windows in a 
different mode, see Chapter 11, "Options for Starting Windows." 
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Keyboard Formats 
Key combinations and key sequences appear in the following format: 

Format 

KEYl + KEY2 

KEYl. KEY2 

Terminology 

Meaning 

A plus sign (+) between key names means to hold down 
the first key while you press the second key. For example, 
Press ALT + ESC means to hold down the ALT key and press 
the ESC key. Then release both keys. 

A comma (,) between key names means to press and re
lease the keys one after the other. For example, press ALT. 

F means to press and release the ALT key. Then press and 
release the F key. 

The following terms take on special meanings in the context of Windows. Your fa
miliarity with them will make the concepts and procedures presented in this guide 
and in on-line Help easier to understand. 

Term 

386 enhanced 
mode 

Application 

Application icon 

Choose 

Click 

Meaning 

A special operating mode that provides access to the 
virtual memory capabilities of the Intel 80386 processor. 
Virtual memory capabilities let Windows applications use 
more memory than is physically available. Enhanced 
mode also allows for the multitasking of non-Windows 
applications. To run Windows in 386 enhanced mode, you 
must be using a personal computer that has the Intel 
80386 processor or higher and at least 2MB of memory. 

A computer program used for a particular kind of work, 
such as word processing. (See also Windows applications 
and non-Windows applications.) 

A graphical representation of a running application that 
has been minimized. Application icons appear on the desk
top. 

To use a mouse or key combination to pick an item that 
begins an action in Windows. (Contrast with select). 

To quickly press and release the mouse button. 
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Term 

Desktop 

DIRECTION keys 

Directory 

Document icon 

Double-click 

Drag 

Group 

Icon 

Menu 

Non-Windows 
applications 

Meaning 

The screen background for Windows. The Windows desk
top is similar to the surface of the desk you use at work or 
at home. You can perform the same kinds of tasks elec
tronically on the Windows desktop that you would do 
manually on your work desk. 

The four arrow keys on your computer keyboard. Each 
arrow key is named for the direction the key points: 
UP ARROW, DOWN ARROW, RIGHT ARROW, and LEFT 

ARROW. 

A collection of computer files (programs and data) that 
are stored at the same location ona disk. The name of the 
directory identifies its location. 

A graphical representation for a document window that is 
minimized. Document icons appear only in applications 
that allow two or more documents to be opened in the 
application workspace at one time. Program Manager and 
File Manager are examples of such applications. 

To click the mouse button twice in rapid succession. 

To hold down the mouse button while you slide the 
mouse. 

A collection of applications in the Program Manager 
window. 

A graphic representation for various elements in 
Windows. Icons are used to represent running applica
tions, groups, and program items in Program Manager. 
For example, a graphic of a clock represents the Clock 
application. 

A list of items. Most menu items are Windows 
commands. 

Computer programs that were not designed to run within 
the Windows environment. Non-Windows applications do 
not necessarily conform to Windows user interface 
standards. 



Term 

Pathname 

Point 

Program item 
icon 

Real mode 

Select 

Standard mode 

Window 

Windows 
applications 
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Meaning 

A designation for the location of files or directories on 
your disk. For example, c:\windows\userl is the 
pathname to the \USERI subdirectory of the \WINDOWS 
directory on drive C. 

To slide the mouse until the tip of the pointer rests on the 
item of choice. 

A graphical representation for program items you can use 
to start up applications. Program item icons appear in 
group windows in Program Manager. 

The operating mode that provides maximum compati
bility with previous versions of Windows applications. 
Real mode is also the only mode available for computers 
with less than 1MB of extended memory. When operating 
in real mode, Windows uses only the standard 640K of 
memory and does not directly access extended memory. 

To mark an item by highlighting it with key combinations 
or by clicking it with a mouse. Selecting does not initiate 
an action. After selecting an item you choose the action 
you want to affect the item. For example, you might 
select a filename and then choose the Delete command to 
remove the file from a directory. (Contrast with choose.) 

The normal operating mode for running Windows. 
Standard mode provides access to extended memory and 
also lets you switch among non-Windows applications. To 
run Windows in standard mode, you must be using a per
sonal computer that has the Intel 80286 processor or 
higher and at least 1MB of memory. 

A rectangular area that contains a software application, or 
a document file. Windows can be opened and closed, re
sized and moved. You can open several of them on the 
desktop at the same time and you can shrink windows to 
icons or enlarge them to fill the entire desktop. 

Applications that were designed for the Windows environ
ment and that will not run without Windows. Windows 
applications conform to the same conventions for the 
arrangement and style of menus, the style of dialog boxes, 
the use of the keyboard and mouse, and so on. 
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Installing Windows with Setup 
The Setup program on Disk 1 of the Microsoft Windows disk set makes installing 
the software easy and straightforward. After you type setup at the DOS prompt, 
Setup guides you through the installation. First it evaluates your computer system 
to determine what kind of equipment you have. Then it copies essential Windows 
files onto your hard disk, asking you to verify critical information and make 
changes if necessary. 

After this preliminary installation, Setup continues by starting Windows for you, 
installing the remaining files, and offering you some options-such as choosing 
and configuring a printer, installing software programs (called applications in this 
User's Guide), and viewing on-line documents. 

After installation, Setup works just like the other Windows applications. You 
can run it again anytime to review or change some of the options you originally 
installed and to add a new piece of equipment or a new application to your system. 
See Appendix A, "Using Setup to Maintain Windows," for information about 
making additions or changes. 

Running Setup 

During the Setup procedure, you'll be asked to verify and provide information 
about the following: 

• The directory where you want to store Windows 

• The type of computer you are using 

• Your monitor 

• Your mouse, if any 

• Your keyboard and keyboard layout 

• Your language 

• The kind of network you are on, if any 

• The printer and printer port you use, if any 

• Applications on your hard disk that you want to run with Windows 
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[> To install Windows: 

1. Put the Windows Disk 1 in the drive you want to use for the installation and 
close the drive door. 

Windows Setup lets you use any active disk drive. 

2. To make the installation drive active, type the drive letter followed by a colon 
(:), and press ENTER. 

3. Type setup and press ENTER. 

4. Follow the instructions on the screen. 

The Setup program's instructions should be self-explanatory. But, if you do have 
questions about any of the procedures or options, you can request on-line Help by 
pressing the FI key. 

NOTE Do not try to install Windows by copying files directly from the Setup disks. The 
files are converted into usable files during the Setup process. If you do want to transfer a file 
directly from a particular Setup disk onto your hard disk, see Chapter 14, "Networks and 
Windows," for information about the proper procedure. 

Starting Windows 
[> To start Windows: 

[J At the DOS prompt, type win and press ENTER. 

The very first time you start Windows, the Program Manager window is open with 
the Main Group window open inside it and the other Windows groups represented 
as group icons at the lower edge of the Program Manager window as shown in the 
following illustration. 
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~ • II. .,- ""I'" 
File Options Window Help 

... ""I'" 

~ ~ ~ g I III 
IilIID!!I Control Panel Print Manager Clipboard DOS Prompt 

ffi 
Windows Setup 

m emD m DDD m DDD m DDD 

Accessories Games Windows Applications N on-Windows Applications 

Depending on which applications you installed to run with Windows when 
you used Setup, the Windows Applications group icon or the Non-Windows 
Applications group icon might not be shown on your screen. 

Windows Operating Modes 

When you type win, Windows automatically starts in one of three operating 
modes. The type of computer system you are using and how much memory it has 
determines which mode Windows uses. See "What You Need to Run Windows" 
in the introduction of this User's Guide for the system requirements for each 
mode. 

NOTE To discover which mode Windows is using, open the Help menu from the Program 
Manager menu bar and select About Program Manager. See Chapter 2, "Basic Skills," to 
learn about opening menus and selecting items. 

You can type an alternate start-up command at the DOS prompt if you want to 
start Windows in a different mode. For example, if you want to use Windows 
applications that have not been updated to run with Windows 3.0, you must start 
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Windows in real mode. See Chapter 11, "Options for Starting Windows," for 
instructions. The three modes are defined as follows. 

• Real mode is the operating mode that provides maximum compatibility with 
previous versions of Windows applications (2.x versions). If you want to run 
applications from earlier versions of Windows, unless they are upgraded ver
sions that run with Windows 3.0, you should start Windows in real mode. Real 
mode is also the only mode available for computers with less than 1 megabyte 
of memory (640K conventional, 256K extended). 

• Standard mode is the normal operating mode for running Windows. This mode 
provides access to extended memory and also lets you switch among non
Windows applications. With access to extended memory, more Windows appli
cations can run at the same time. In addition, applications run faster on systems 
that have more memory. 

• 386 enhanced mode provides access to the virtual memory capabilities of the 
Intel 80386 processor. Virtual memory capabilities let Windows applications 
use more memory than is physically available. 386 enhanced mode also allows 
for the multitasking of non-Windows applications. 

Enhanced mode also gives you greater control over non-Windows applica
tions. For example, instead of running non-Windows applications full-screen, 
you can run most of them in windows, taking full advantage of the graphical 
environment. 

See Chapter 13, "Optimizing Windows," for details about memory configurations 
and Windows operating modes. 

Quitting Windows 
You always quit Windows from Program Manager after first quitting the applica
tions you are running. 

You can quit Windows from the File menu or from the Control menu. No matter 
which method you use, Program Manager always asks you to confirm your request 
to quit and gives you the opportunity to save the current layout of the Program 
Manager window. If you save the current layout, the next time you start Windows, 
the same group windows will be open in Program Manager and all group win
dows, group icons, and program item icons will be in the same positions as they 
were the last time you used Windows. 
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[> To quit Windows from Program Manager's File menu: 

Mouse 1. Quit any applications that are currently running. 

2. Click Program Manager's File menu to open it. 

New ... 
Qpen Enter 
M,(lV(! ... 

(;.0 py ... 
Uelete Del 
fropcrtics ... 

Bun ... 

E~it Windows ... 

3. Click Exit Windows. 

The Exit Windows confirmation dialog box appears. 

Exit Windows 

4. If the Save Changes box is empty, click it to enter an X and save the layout of 
Program Manager as it currently appears. If you do not want to save the cur
rent appearance of Program Manager, click the box to clear the X. 

5. Click OK to exit Windows. 

f(eyboard 1. Quit any applications that are currently running. 

Press ALT, F to open Program Manager's File menu. 

2. Press X (the underlined letter in Exit). 

Or press DOWN ARROW to move the highlight to Exit Windows and then press 
ENTER. 

3. The Exit Windows confirmation dialog box appears. 

If the Save Changes box is empty, press TAB to move the selection cursor (a 
dotted rectangle) to it. Press the SPACEBAR to place an X in the box and save 
the current layout of Program Manager and its group windows. 
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Press the SPACEBAR again if you want to clear the X and exit Windows 
without saving the current layout of Program Manager. 

4. Press ENTER to choose OK and exit Windows. 

You can also exit Windows from Program Manager's Control menu by opening 
the Control-menu box and selecting Close. The Control-menu box is a small box 
in the upper-left comer of the Program Manager window. 

r Control-menu box 

• I I • 

file Qptions Window Help 

[> To quit Windows from Program Manager's Control menu: 

Mouse 1. Quit any applications that are currently running. 

2. Click the Control-menu box to open the Control menu. 

ne~;t(lH~ 

Move 
,Size 
Minimize 
Ma~imize 

!;.Iose AIHF4 

S~itch To ... CtrlfEsc 
_____ ...J 

3. Click Close. 

4. The Exit Windows dialog box appears. Continue as described in the previous 
procedure. 

HINT Double-click the Control-menu box to bypass selecting Close. The Exit Windows 
dialog box appears immediately. 
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[(eyboard 1. Quit any applications that are currently running. 

2. Press ALT, SPACEBAR to open the Control menu. (Pressing ALT closes it again.) 

3. Press the letter C to select Close. 

Or press DOWN ARROW to move the highlight to Close and press ENTER. 

4. The Exit Windows dialog box appears. Continue as described in the previous 
procedure. 

HINT Press ALT + F4 to bypass opening the Control menu and selecting Close. The Exit 
Windows dialog box opens immediately. 

NOTE As you run Windows, some applications may create temporary files. These 
filenames generally begin with a tilde character (-) and end with the .TMP extension. Do not 
delete these files while Windows is running because an application may be using them. If 
you quit Windows as described in the preceding procedure, any temporary files are auto
matically deleted. But if you quit Windows in some other way (for example, by turning off 
your computer while Windows is running), some temporary files may remain. You can 
safely delete these files as soon as you restart your computer. 

Working with System Messages 
Windows displays a message box if it cannot complete a command or if you 
should know about the possible consequences of a choice you made. As a new 
feature of Windows 3.0, the message box contains an explanation of what went 
wrong and, where appropriate, tells you what you can do to fix the problem. 

Notepad 

(]) MAYSALESREPORT.TXT is not 0 volid filenome; 

check to ensure the filenome hos no more 
thon 8 chorocters followed by 0 period ond 
o 3-letter extension. 

Whenever you are asked to make a choice before you can proceed, the message 
box contains an OK button and a Cancel button. You can choose OK by pressing 
ENTER or choose Cancel by pressing ESC. 
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Some message dialog boxes also include a Retry button. If you use a mouse, click 
Retry to try the command again. If you use a keyboard, press ALT + R or press TAB 

to select the Retry command button and then press ENTER. 
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The Basic Elements of Windows 
If you are new to Microsoft Windows, this chapter is probably the most important 
one in the User's Guide since it explains the basic concepts and skills you need to 
work with Windows successfully. You can use this chapter initially to learn how 
to operate within the Windows environment, and you can return to it later as a 
reference. 

Windows includes all the programs you need to manage your software applica
tions and files easily and efficiently. The following illustration shows the basic 
structure of Windows' rich graphical environment. 

~ . " .,- .... 1 .... 
.Eile Qptions Window Help 

... .... 1 .... 

~ ~ ~ g I III ~ 
lilllml~H Control Panel Print Manager Clipboard Dos Prompt Windows Setup 

ml ~rm ml ~~~ ml ~~~ ml ~~~ 

Windows Applications Accessories Non-Windows Applications Games 

"'1 Accessories 1 .... 1 .... "'1 Games 1 .... 1 .... 

~ ~ S ~ I [M •• 
Write Paintbrush Terminal IDmI!l Solitaire Reversi 

"eJO 6 I!m Olliil 18 DaDc::::II 

Recorder Cardfile Calendar Calculator 

m ~ 
Clock PIFEditor 

NOTE The appearance and contents of the Windows Applications and Non-Windows 
Applications groups depend on your choices during Setup. 

All Windows operations take place within the framework of the desktop, the 
screen space Windows occupies. You can think of this area as you would the sur
face of an actual desk. You can move work items around on the desk, bring new 
ones onto it, and remove items you won't need for a while. 
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The Program Manager application is open on your desktop the first time you start 
up Windows. Program Manager is central to the operation of Windows. You can 
organize your applications into groups and start them by using Program Manager. 

After you start up an application, it runs in an application window on the desktop. 
If you are running several applications at a time, you can shrink as many applica
tion windows as you'd like to application icons. By shrinking these windows to 
icons, you can clear some space on your desktop without exiting the running 
applications. 

The following illustration shows applications that are running in windows and 
applications that are running as icons on the desktop. A complete discussion of 
starting, running, and exiting applications follows later in this chapter . 

r Desktop .-------------r-- Applications running in windows 

I 
"""I Notepad - TODO.lXT 1 ... 1 .... 
File Edit Search Help 

TO DO THIS WEEK: 

1. Prepare charts for Thursday 
status lIIeeting. 

2. Schedule selllinar for next 
lIIonth. 

3. Finish writing report by 
Friday. 

+: r-, 
0»:: 
:::::;: 

4. Finish going through lIIail )( 
receiued while out of town. 7' 

m!)] 
Program Manager Calendar -MEETINGS.CAL 

liettings 

...•... .. .. 
• \V • 
.. .. ...•.. 
~ 
W 

Paintbrush - (Untitled) 

.. 

... 1 .... 

.. 
• 

• 

L...-_____ ....L-______ --L-__ Applications running as icons 
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Two Kinds of Windows 
As you work with applications, two different kinds of windows appear on your 
desktop: application windows and document windows. 

• Application windows contain running applications. The name of the applica
tion, the associated document, and the application's menu bar appear at the top 
of the application window. Application windows can be positioned anywhere 
within the desktop borders. 

In 386 enhanced mode, most non-Windows applications can run in application 
windows, while others require the entire'screen. In standard mode and in real 
mode, all non-Windows applications occupy the entire desktop instead of run
ning inside application windows. 

The following is an example of an application window. 

File Edit Search Help 

• Document windows appear only with applications that can open two or more 
documents at a time inside the same workspace. For example, with Windows 
File Manager you can open a number of directories at the same time. Each 
directory appears in a separate document window (called a directory window) 
in the File Manager workspace. 

Being able to open more than one document at a time inside an application's 
workspace makes working with a number of documents easy. 
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Document windows share the application window's menu bar. Commands that 
affect the application affect the document as well. 

Document windows have their own title bars unless they are maximized. When 
maximized, they fill the application workspace and share the application win
dow's title bar. The document name follows the name of the application on a 
shared title bar. 

Program Manager is another example of an application that lets you open 
several document windows (called group windows) in its application 
workspace. 

.--_____ ---.-_ Document windows do I I not have menu bars . 

• I I • 
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If you are working with a mouse, there is no difference in the procedures you use 
to manipulate application and document windows. If you prefer to use the key
board, however, the keystrokes required to use the Control menu and to switch 
between document windows are different for each type of window. 

The instructions in this guide note procedural differences where they exist. In addi
tion, on-line Help provides summaries of the appropriate keystrokes whenever you 
see the Keyboard category on a Help menu. 
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Parts of a Window 

Each application and some documents you choose to work with open as separate 
windows. Every window has some common elements; however, not all windows 
use all the elements. 

Control-menu box Window border 

r 
Selection cursor rTitle bar Minimize button 

r Menu bar r Window title r Workspace r Maximize button 

!i ______ ~ .. mm ...... ~·ml~ 
Eile I .Edit .search !!elp 

/ 
+ 

+ iF",,,,',"";;"";;""" i'i'i'i'i'i'i'iii';;iii' iH'i'i;;i;;;;iiiiii"i,i),,,,,,,i,i,i,,',,,,,,,,,i,,,i,i,i,,,,,,,,,,,,i{"",!,i,i,i""i ,iiii'i'i;;;;'i ;;iiiii;;iii""""i,i,i,,,i,,,i',',,,i,iH,,,i,,,,,,,,,,,' IU:U,,:d + 

( Window corner Mouse pointer l Horizontal scroll bar Vertical scroll bar 

The elements in the preceding illustration are your tools for working with the win
dow and the application or document within the window. You'll learn more about 
how to use the elements throughout this chapter. 

• The Control-menu box is located in the upper-left comer of each window. The 
Control menu (also called the System menu) is most useful if you prefer to use 
your keyboard when you work with Windows. With Control-menu commands, 
you can resize, move, maximize, minimize, and close windows, and switch to 
Task List. (If you use a mouse, you can move, resize, minimize, maximize, and 
close windows simply by clicking and dragging.) 
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• The title bar shows the name of the application or document. If more than one 
window is open, the title bar for the active window (the one in which you are 
working) is a different color or intensity than other title bars. 

• The window title, depending on the type of window it appears in, can be the 
name of an application and the name of a document, or the name of a group, a 
directory, or other data file. For documents, until the document is saved, a 
placeholder such as (untitled) usually appears. 

• The menu bar lists the available menus. Most applications have a File menu, an 
Edit menu, and a Help menu as well as menus unique to the application. 

• Scroll bars let you move parts of a document into view when the entire docu
ment won't fit in the window. They also let you view unseen portions of lists 
and other information that is too long to fit in the allotted space. 

• The Maximize and Minimize buttons (chosen with the mouse) enlarge the active 
application window to fill the entire desktop or shrink the window to an icon. 
Document windows enlarge to fill the application workspace only, not the 
entire desktop. After you enlarge a window, the Maximize button changes to a 
Restore button. You can use the Restore button to return the window to its 
previous size. 

• The window border is the outside edge of a window. You can lengthen or 
shorten each side of a border. 

• The window corner can be used to shorten or lengthen two sides of a border at 
the same time. 

• The workspace is where you do most of your work with an application. For 
example, if you start a word processor, the contents of your document appear in 
the workspace. Some applications allow you to open more than one document 
window within this workspace. 

• The selection cursor shows where you are in an individual document. It marks 
the place text or graphics appears when you begin typing or drawing. 

• The arrow-shaped mouse pointer appears if you have a mouse installed. You 
use it to indicate items you want to select or choose with the mouse. 

NOTE Some applications might use different types of cursors and pointers than the ones 
shown in the previous illustration. 
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Three Kinds of Icons 
Icons are used in the Windows graphical environment to represent applications 
that are running minimized, document windows that are minimized, and applica
tions you can start. 

• Application icons appear only after you start up an application and choose the 
Minimize command for that application. The application shrinks from window 
size to an application icon and continues to run minimized at the bottom edge 
of your desktop. Application icons are the only icons that appear on the desktop 
outside the window borders. 

You can move application icons anywhere on the desktop, but not into an open 
window. Even though Windows will let you physically place an application 
icon in an open window, the icon is actually still occupying space on the 
desktop. If you move the window, the application icon does not move with it, 
and if you close the window, the application icon remains on the desktop. 
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,. 

L...-_____ -'--______ --'-__ Application icons 

Most application icons resemble the program item icons that start their 
applications. 
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• 

Document icons represent document windows that are minimized. Document 
icons appear at the bottom of the application window and can be moved any
where within the application's workspace, but not outside its borders. 

Notice in the following illustration that the document icons for Program 
Manager groups look the same. Only the labels that identify them are different. 

[ile .Qptions Window Help 

i _ 
Solitaire IiIIII 
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Accessories Windows Applications Non-Windows Applications Main 
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When you choose a document icon, it opens into a document window. For 
Program Manager, it contains program item icons. For File Manager, docu
ment windows contain directories. The contents of a document window depend 
on its application. 

Program item icons are exclusive to the Program Manager application. They 
represent the applications and their associated documents you can start up from 
Program Manger. They are contained in document windows called group win
dows. These icons can be moved between group windows and from group win
dows to group icons, but not out of the Program Manager window. 
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File Options Window Help 

~ ~ •• a ~ 
Write Paintbrush Terminal mal 
~ 6 ~ [iliill 18 

Recorder Cardfile Calendar Calculator 

~ 
Clock PIF Editor 

Iim'DI Iim'DI Iim'DI 
~ ~ ~ 
Games Windows Applications Non-Windows Applications 

~ 
Program Manager Calendar - MEETINGS.CAL 

Program item icons are 
contained in group windows. 

~ 
W 

Paintbrush - (Untitled) 

Application Document 
icon icon 

Most program item icons are easy to distinguish from one another at a glance 
since most of them are unique graphics. However, icons for many non
Windows applications are identical. Also, when you include a document to 
start with an application, the new program item icon you create is identical to 
the existing program item icon for the application. So, a group window could 
contain several identical program item icons distinguished only by their labels. 

NOTE Individual applications, such as File Manager and Control Panel, also use a variety 
of icons that are related to their unique activities. Each icon is described in the appropriate 
chapters. 

Working with Menus 
Windows commands are listed on menus. Each application has its own menus, 
with a Control menu common to all applications. The Control menu, also called 
the System menu, opens from the small box in the upper-left comer of each win
dow. Other menus are represented by names in the menu bar at the top of each 
application window. 
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In Windows, you select a menu, and then choose a command from that menu. 
Choosing the command carries out the action. 

Selecting and Canceling Menus 
I> To select a menu: 

Mouse D Point to the name of the menu on the menu bar and click the name to open the 
menu. (You can drag the selection cursor down the menu if you want to move 
to a menu item immediately.) 

I(eyboard 1. Press ALT (or FlO) to select the menu bar. 

2. Press LEFT ARROW or RIGHT ARROW to select the menu you want. (Using the 
DIRECTION keys also selects the Control-menu box for the application and the 
active document window.) 

3. Press ENTER to open the selected menu. 

HINT If the menu names have underlined letters, you can move to the menu bar, select a 
menu, and open it with one step. Press ALT, and then press the underlined letter. For 
example, to open Program Manager's File Menu, press ALT, F. 

If more than one menu name has the same underlined letter, Windows selects the first name 
listed. Press ALT, then the letter again to select the next menu. 

I> To cancel a menu: 

D Click the menu name or anywhere outside the menu. 

Or press ALT (or FlO) to cancel the menu and move back to the application 
workspace. 

Or press ESC to cancel the menu but remain on the menu bar so that you can 
select another menu. 
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Choosing Menu Commands 
Let's take a look at some typical Windows menus: 

Qpen Enter Ctl~ ShitNDd Ctrl+O 
Move ... .~~.opy Ctrll-lns Ctrl+C 
~opy ... .p~l(;te 8hitt·.lrl{~ 
Uelete Del DI:I!:h: DI:I 
Eroperties ... 

~electAIl 
Bun ... Timel!!ate F5 
E~it Windows ... Word Wrap 

The items listed on menus are most often commands that represent actions you can 
tell the application to carry out. But they can also be characteristics you assign to 
graphics or text (such as bold or centered), a list of open windows or files, or the 
names of cascading menus, which are menus that list more commands. No matter 
which items you want to choose, you use the same procedure. 

[> To choose an item from a selected menu: 

o Click the item name. 

Or type the underlined letter in the item name. You can also use the UP and 
DOWN ARROW keys to select the item you want; then press ENTER. 

If you look again at the menus in the preceding illustration, you'll notice that 
some items appear dimmed, two have checkmarks next to them, several have 
ellipses ( ... ) after their names, and others have key combinations listed across 
from them. 

Windows applications all follow certain conventions when listing items on a 
menu. These conventions signal that extra information about the menu commands 
follows. 
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Menu convention 

Dimmed command name 

An ellipsis ( ... ) after the name 

A checkmark ( " ) next to the 
name 

A key combination after the 
name 

A triangle ( ~ ) at the right side 
of a menu command 

Using the Control Menus 

What it means 

The command is not available at this time. 
You might have to select something before 
you can use the command, or it might be 
that the command cannot be used with your 
application. 

A dialog box will appear when the com
mand is chosen, asking for information the 
application needs to carry out the command. 

The command is active. This convention is 
used for commands that toggle between one 
state and another. 

The key combination shown is a shortcut 
for this command. Use this key combina
tion to choose the menu command without 
first opening the menu. 

The command leads to a cascading menu, 
which lists additional commands that are 
available. 

Application windows, application icons, document windows, group icons, and 
some dialog boxes have Control menus (also called System menus). 

You open the Control menu for application windows, document windows, and 
dialog boxes by choosing the Control-menu box from the upper-left comer of the 
window or dialog box. Control menus for icons open directly above the selected 
icon. 

The Control menus for application windows, document windows, and dialog 
boxes are somewhat different, as are the Control menus for non-Windows applica
tions. The following section describes how you work with Control menus in all 
these environments. 

Opening the Control Menu 
The procedure you use to open the Control menu depends on whether you are 
working in an application window, a document window, a dialog box, or with an 
icon. 
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[> To open the Control menu for an application or an application icon: 

Mouse 0 Click the Control-menu box in the upper-left comer of the window or click the 
icon. 

Be careful not to double-click, or you will close the window or restore the icon 
to a window. 

I(eyboard 1. Press ALT + ESC repeatedly to cycle through the open application windows and 
icons until you reach the one you want. 

2. Press ALT, SPACEBAR to open the Control menu. (Press ALT if you want to 
close the menu without choosing a menu item.) 

F-
ne{,tom 
Move 
.size 
Minimize 
Ma~imize 

!;.Iose AIt+F4 

Switch To ..• CtrltEsc 
'- _____ ..J 

[> To open the Control menu for a document window or document icon: 

Mouse 0 Click the Control-menu box in the document window or click the document 
icon. 

I(eyboard 1. Press CTRL + F6 (or CTRL + TAB) repeatedly to cycle through the open docu
ment windows and document icons until you reach the one you want. 

2. Press ALT, HYPHEN (-) to open the Control menu. (Press ALT if you want to 
close the menu without choosing a menu item.) 

_____ ..J 
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l> To open the Control menu for a dialog box: 

D Click the Control-menu box in the dialog box. 

Or press ALT, SPACEBAR. (Press ALT to close the menu without choosing a 
menu item.) 

Non-Windows applications running in standard mode or in real mode do not run in 
application windows, but occupy the entire screen. You can open their Control 
menus only by switching back to Windows, thereby shrinking the non-Windows 
application to an icon. The Control menu is available from the application icon. 

HINT To find out which mode Windows is running in, open Program Manager and choose 
the About Program Manager command from the Help menu. 

[> To open Control menus for standard or real mode, non-Windows applications: 

1. Press ALT + ESC to switch from the running application back to Windows. The 
non-Windows application appears as an application icon at the lower edge of 
the Windows desktop. 

2. Click the icon with the mouse to open the Control menu. 

Or press ALT + ESC to select the icon you want, and then press 
ALT, SPACEBAR to open the Control menu. 

Restore 
Move 
.~1.i2e 
Mlnlml.w 
Ma>.<;lmlzl~ 

S~itch To... Ctrl+Esc 
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I 3861. Control menus for non-Windows applications that are running in 386 enhanced 
mode are available from application windows (for applications that can run in 
Windows) and from application icons (for applications that must run full-screen). 

[> To open the Control menu for a 386 enhanced mode non-Windows application: 

Mouse 0 Click the Control-menu box in the upper-left comer of the window or click the 
icon. 

Be careful not to double-click, or you will close the window or restore the icon 
to a window. 

I(eyboard l. Press ALT + ESC repeatedly to cycle through the open application windows and 
icons until you reach the one you want. 

2. Press ALT, SPACEBAR to open the Control menu. (Press ALT if you want to 
close the menu again without choosing a menu item.) 

NOTE The Control menu for a non-Windows application that you are running in 386 en
hanced mode includes a cascading menu for the Edit command. With the mouse, you open 
the cascading menu by clicking Edit. With a keyboard, you open the cascading menu by 
pressing RIGHT ARROW (or ENTER). 

Restore 
Move 
.S.i2(: 
Mi.nimlzl~ 

Ma~imize 

S~itch To ... Ctrl+Esc 

Se!tings... I COPY. [:nt(:r 1......----=......::..-----1
1 

Paste 

II 1.....-~_I;r~o]_I __ ~ 
ri!IIImm] 
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Control-Menu Commands 
The following table defines the Control-menu commands. Not all applications use 
all of these commands. 

Command 

Restore 

Move 

Size 

Minimize 

Maximize 

Close 

Switch To ... 

Next 

Paste 

Action 

Restores the window to its former size after it has been 
enlarged (by using the Maximize command) or shrunk to 
an icon (by using the Minimize command). 

Allows you to use the keyboard to move the window to 
another position on the desktop. 

Allows you to use the keyboard to change the size of the 
window. 

Shrinks the window to an icon. 

Enlarges the window to its maximum size. 

Closes the window. 

Starts Task List, which lets you switch among running applica
tions and rearrange their windows and icons on your desktop. 

Switches among open document windows and icons. 
(Available for document windows only.) 

Copies text from the Clipboard to the active document win
dow, inserting the text at the Windows cursor position. 
(Available in real and standard modes only.) 

1386 1'1 Edit Displays a cascading menu with four additional commands. 
(Available for non-Windows applications running in 386 
enhanced mode only.) 

&''',"",>,«<<<<<:.,<<,,_0»><'1' 

Command 

Mark 

Copy 

Paste 

Scroll 

Action 

Allows you to use a keyboard to select text to 
move onto the Clipboard, a temporary storage 
location in memory. 

Copies the selected text onto the Clipboard. 

Copies text from the Clipboard to the active 
window, inserting it at the Windows cursor. 

Allows you to view information not currently 
visible in the window. 



Command 

I 386 I: Settings 
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Action 

Displays a dialog box that requests infonnation about multi
tasking options such as foreground or background operation, 
or about allocation of system resources when running the ap
plication. See Chapter 12, "More About Applications," for 
infonnation about these options. (Available for non-Windows 
applications running in 386 enhanced mode only.) 

Working with Dialog Boxes 
Windows uses dialog boxes to request infonnation from you and provide infor
mation to you. For example, when Windows needs additional infonnation to carry 
out a command you have chosen, a dialog box requests that infonnation. You 
complete the dialog by providing the missing infonnation. 

Whenever you see an ellipsis ( ... ) after a menu command, a dialog box follows. 
For example, when you choose Open ... from the Notepad File menu, Notepad dis
plays the File Open dialog box asking for the filename of the file you want to open. 

File Open 

Filename: ..",1"=.:=11'--___ ----'11 OK 

Directory: c:\windows I Cancel 

files: !!irectories: 

leter2.txt 
leUer1.txt 
leUer3.txt 

( .. ] 
(devtools] 
(graphics] 
(system] 
(-a-] 
(-c-] 
(+] 
(-u-] 

Windows also uses dialog boxes to display additional infonnation and warnings, 
or to explain why a requested task could not be accomplished. 

Most dialog boxes contain options, each one asking for a different kind of infor
mation. After you supply all the requested infonnation, you choose a command 
button to carry out the command. 
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Moving Dialog Boxes 

Dialog boxes that have title bars can be moved around on your desktop like win
dows. See "Working with a Window" later in this chapter to learn how to move a 
dialog box. 

Moving Within Dialog Boxes 

Often you need to move around within a dialog box to make several selections. 
The current option is marked by a highlight or dotted rectangle (or both) around 
the name of the option or button. 

[> To move within a dialog box: 

Mouse D Click the option or group you want to move to. 

Keyboard 1. Press TAB to move forward (generally from left to right and top to bottom) or 
SHIFT + TAB to move in the opposite direction. 

Or, while you hold down ALT, you can type the underlined letter in the option 
name or group name. 

2. Within a group of options, use the DIRECTION keys to move from one option to 
another. 

Choosing Options 

The next few sections describe each kind of dialog box option and how to move to 
and select options. 

Command Buttons 
Command buttons initiate an immediate action. One command button in each 
dialog box carries out the command you choose, using the information supplied in 
the dialog box. Other command buttons let you cancel the command or choose 
from additional options. 
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This button closes the dialog box and 
cancels the command you choose. 

This button carries out the 
command you choose. 

Help .•• 

About... 

This kind of button presents 
additional options. 

Command buttons marked with an ellipsis ( ... ) open another dialog box so you can 
provide more information. Command buttons marked with a pair of greater-than 
symbols (») expand the current dialog box. For example, the Color dialog box in 
Control Panel has a button labeled Color Palette» that expands the Color dialog 
box to show you new options for changing the colors of many of the 
elements on your desktop. 

Buttons that are unavailable are dimmed. The currently selected, or default, button 
has a darker border than the other buttons. You can choose the selected button by 
pressing ENTER. 

You can close the dialog box without completing a command by choosing Cancel. 

t> To choose a command button: 

Mouse D Click the command button. 

{(eyboard 1. Press TAB to move to the command button you want. 

A dotted rectangle around the button text marks the selected button. 

2. Press the SPACEBAR (or ENTER) to choose the button and complete the 
command. 

HINT If the button has an underlined letter in its name, you can choose the command 
button in one step. Hold down ALT and press the underlined letter. 
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Text Boxes 
A text box is a rectangle into which you type information. 

Remove 

Remove Appointments: 

flom: 00 
10: I I Cancel I 

You type information 
into text boxes. 

When you move to an empty text box, an insertion point (flashing vertical bar) 
appears at the far left side of the box. The text you type starts at the insertion point. 

If the box already contains text when you move to it, all the text in the box is auto
matically selected and any text you type replaces it. Or, you can erase the existing 
text by pressing DELETE or BACKSPACE. See "Working with Text" later in this 
chapter for text editing procedures. 

[> To select text in a text box: 

Mouse 0 Drag the pointer across the text you want to select. Or you can double-click to 
select one word at a time. 

Keyboard 1. Use the DIRECTION keys to move to the first character you want to select in the 
box. 

2. Hold down SHIff and press a DIRECTION key to extend the selection. (Press 
SHIff + HOME to extend the selection to the first character in the box. Press 
SHIff + END to extend the selection to the last character in the box.) 

See "Selecting Text" in "Working with Documents" later in this chapter for 
other keyboard selection options and the editing options available for selected 
text. 

List Boxes 
A list box shows a column of available choices. If there are more choices than can 
fit in the list box, scroll bars are provided so that you can use your mouse to move 
up and down quickly through the list. See "Using Scroll Bars" later in this chapter 
if you need detailed instructions about scrolling. 
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Usually, you can select only one item from the list, but some list boxes (such as 
the box that lists applications you can install with Windows Setup) let you select 
multiple items if appropriate. 

t> To select a single item from a list box: 

Mouse 1. Click the scroll arrows until your choice appears in the list box. 

2. Click the item you want to select and then choose the command button you 
want. Or double-click the item to choose it and complete the command. 

f(eyboard 1. Use the DIRECTION keys to scroll to the item you want. 

Or type the first letter of the item you want. Windows moves the highlight to 
the first item that starts with that letter. 

2. Press ENTER to choose the item and complete the selected command. 

NOTE To change your selection, simply select a different item before choosing the 
command button. 

If an application lets you select more than one item in a list box, the selection 
process works like a toggle switch, turning the selection on or off. You can select 
as many items as you want and also cancel any selections. 
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[> To select more than one item in a list box: 

Mouse D Click each item you want to select. 

To cancel a selection, click the item again. 

Keyboard 1. Use the DIRECTION keys to move the highlight to the first item you want. 

2. Press the SPACEBAR to select the item. To cancel the selection, press the 
SPACEBAR again. 

Repeat steps 1 and 2 until all the items you want are selected. 

NOTE With some applications you can use other key combinations to extend a selection 
to items that follow sequentially in a list box. See the application's reference manual for 
instructions. 

Drop-Down List Boxes 
A drop-down list box appears initially as a rectangular box with the current choice 
(default) highlighted in the box. The arrow in a square box at the right opens into a 
list of available choices when you select it. If there are more choices than can fit in 
the drop-down list box, scroll bars are provided. 

Drop-down list boxes are typically used in dialog boxes that are too small or too 
crowded to contain open list boxes. 

Drop-down list boxes open 
to show available choices. 
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t> To open a drop-down list box and select an item: 

Mouse 

J(eyboard 

1. 

2. 

3. 

1. 

2. 

Click the arrow at the right of the box to open the drop-down list box. 

Click the Up or Down scroll arrow or drag the scroll box to move to the item 
you want. 

Click the item. 

Press ALT + DOWN ARROW to open the drop-down list box. 

Use the UP or DOWN ARROW key to reach the item you want, and press 
ALT + UP ARROW or ALT + DOWN ARROW to select the item. 

Option Buttons 
Option buttons appear in dialog boxes as a list of mutually exclusive items. You 
can select only one option from the list at a time. You can change a selection by 
selecting a different button. 

The selected option button contains a black dot. Unavailable options are dimmed. 

Options buttons present 
mutually exclusive options. 

Desktop 
Pattern----------. 
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t> To select an option button: 

Mouse D Click the option button. 

I(eyboard 1. Press TAB to move into the option group you want. 

2. Use the DIRECTION keys to select the option button you want. 

HINT If the option name contains an underlined letter, you can hold down ALI and press 
the underlined letter from anywhere in the dialog box to select an option button. 

Check Boxes 
Check boxes offer a list of options you can switch on and off. You can select as 
many or as few check box options as are appropriate. When an option in a check 
box is selected, it contains an X. Otherwise, the box is empty . Names of options 
that are temporarily unavailable are dimmed. 

Check boxes present nonexclusive options. 

View Other 

Details-------, 
Dfsiz";;l 
D L~"~"t Modification Date 
D Last Modification Time 
D £ile Attributes -

[8J Set S}'stem !!.efault 

OK I I'---C-an-ce-I---' 

This option is selected. 

t> To select or clear check box options: 

Mouse D Click each empty check box you want to select. 

Click a selected box again to clear the selection. 

{(eyboard 1. Press TAB to move to the empty check box you want to select. 

2. Press the SPACEBAR to enter an X. Press the SPACEBAR again if you want to 
clear the selection. 

HINT If the check-box name has an underlined letter, hold down ALI and press the 
underlined letter for each check box you want to select or clear. 
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Canceling Dialog Boxes 
When you choose a command button, the dialog box closes and the command 
takes effect. 

[> To close a dialog box without completing the command: 

D Choose Cancel. 

Or double-click the Control-menu box. 

Or press ESC. 

For dialog boxes that do not have Cancel buttons, choose the Close command 
(press ALT + F4) from the Control menu. For dialog boxes that do not have 
Cancel buttons or Control menus, choose the appropriate button. 

Working with a Window 
Whenever you work with applications and documents, you'll probably have a num
ber of different windows open on your desktop. This section explains how to move 
windows, dialog boxes, and icons; how to resize windows; how to scroll through 
their contents; and how to arrange them on the desktop. 

Moving Windows, Icons, and Dialog Boxes 
You can move application windows, document windows, and icons to different 
places on your desktop. You can also move any dialog box that has a title bar. 

[> To move a window, icon, or dialog box: 

Mouse 1. Drag the window's title bar, the icon, or the dialog box title bar to the new 
location. 

As you move the mouse pointer, an outline of the window or dialog box moves 
with it. For an icon, the mouse pointer changes to a black and white outline of 
the icon that moves as you slide the mouse. 
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2. When the window, icon, or dialog box is positioned where you want it, release 
the mouse button. 

You can press ESC anytime before you release the mouse button to cancel the 
move. 

I(eyboard 1. Select the window, icon, or dialog box you want to move. 

Press ALT + ESC to cycle through the application windows and icons until you 
reach the one you want. 

Press CTRL + F6 (or CTRL + TAB) to cycle through document windows and 
icons. 

2. Open the Control menu. 

Press ALT, SPACEBAR for an application window, icon, or dialog box. 

Press ALT, HYPHEN (-) for a document window or icon. 

3. Choose the Move command. 

The pointer changes to a four-headed arrow. 

4. Press the DIRECTION keys to move the window, icon, or dialog box. 

An outline of the window or dialog box moves as you press the DIRECTION 
keys. 

5. When the window, icon, or dialog box is where you want it, press ENTER. 

You can press ESC anytime before you press ENTER to cancel the move. 

Changing the Size of a Window 

Sometimes you might want to change the size and shape of the windows open on 
your desktop. For example, to compare the contents of two documents, you could 
reduce the size of each window so that they fit side by side. 

You can change the size and shape of most windows on your desktop. If you are 
using a mouse, you can drag each side of the window border or its comers to 
adjust its size. If you are using the keyboard, the commands on the Control menu 
let you modify the window's size and shape. 

NOTE The minimum size for all windows is about 2 inches by 1 inch. In addition, some 
application windows are limited in the ways their size can be changed. For example, Control 
Panel has a fixed size. 
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t> To change the size of a window: 

Mouse 1. Select the window you want to resize. 

2. Point to a border or corner that you want to move. 

The pointer changes to a two-headed arrow. 

3. Drag the corner or border until the window is the size you want. 

If you drag a border, the window size changes on only one side, the side of the 
border you drag. If you drag a corner, the two adjoining sides that form the 
corner change size at the same time. 

An outline shows the size and shape you selected. 

4. Release the mouse button. 

I(eyboard 1. Select the window you want to resize. 

Press ALT + ESC to cycle through the application windows and icons until you 
reach the one you want. 

Press CTRL + F6 (or CTRL + TAB) to cycle through document windows and 
icons. 

2. Open the Control menu. 

For an application window, press ALT, SPACEBAR. 

For a document window, press ALT, HYPHEN (-). 

3. Choose the Size command. 

The pointer changes to a four-headed arrow. 

4. Press one of the DIRECTION keys to move the pointer to the border you want to 
move. 

5. Press a DIRECTION key to move the border. 

An outline shows the size and shape as you change it. 

6. Press ENTER when the window is the size you want. 

If you want to change the size both horizontally and vertically, after choosing the 
Size command, press two DIRECTION keys simultaneously to select a corner of the 
window. (up ARROW + RIGHT ARROW, for example, selects the top-right corner of 
the window. Then press RIGHT ARROW to stretch the window to the right and 
UP ARROW to stretch the window toward the top of the desktop until the window 
is the size you want. Press ENTER to complete the resizing. ) 

HINT You can cancel the resizing. With a mouse, press ESC before you release the mouse 
button. With the keyboard, press ESC before you press ENTER. 
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Shrinking a Window to an Icon 
You can shrink a window to an icon when you finish working with an application 
or document window, but want it available for later use. When you shrink an appli
cation window to an icon, the application is still running in memory, but its 
window is not taking up space on your desktop. 

You can select and move icons on your desktop in the same way you select and 
move windows. When you want to work with your application or document in a 
window again, you can double-click the icon to restore the window (or use the 
Maximize or Restore command on the Control menu). 

[> To shrink a window to an icon: 

MOllse 1. Select the window you want to shrink. 

2. Click the Minimize button in the upper-right comer of the window. 

r 
Click the Minimize button to shrink 
the active window to an icon. 

Bi_-_-iii!.:gl ... 
File .Edit Search Help 

..!. 

] 
----------~ 

I(eyboard 1. Select the window you want to shrink. 

Press ALT + ESC to cycle through the application windows and icons until you 
reach the window you want. 

Press CTRL + F6 (or CTRL + TAB) to cycle through document windows and 
icons. 

2. Open the Control menu. 

For an application window, press ALT, SPACEBAR. 

For a document window, press ALT, HYPHEN (-). 

3. Choose Minimize. 

NOTE Before you use the Minimize button to shrink a document window that is enlarged, 
you must restore it to its previous size. When you enlarge a document window it fills the 
application window, covering other document windows and icons. The document's name 
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appears after the application's name on the title bar. The Maximize and Minimize buttons 
affect the application window and all its contents. Only the Restore button affects the 
document window alone. You can, however, shrink an enlarged document window to an 
icon by choosing Minimize from the document's Control menu. 

Enlarging a Window 
You can enlarge the windows of most applications to fill a larger portion of the 
desktop or even the entire desktop. 

A document window can be enlarged to fill all of an application window except 
the menu bar space. You cannot enlarge a document window beyond the bound
aries of its application window. 

C> To enlarge a window to its maximum size: 

Mouse 1. Select the window you want to enlarge. 

2. Click the Maximize button in the upper-right comer of the window. 

r 
Click the Maximize button to 
enlarge the active window. 

Bi ___ -iiiE ... 8]I ... 

File Edit .s.earch Help 

__________ t.:.:.:.:.: 

J(eyboard 1. Select the window you want to enlarge. 

Press ALT + ESC to cycle through the application windows and icons until 
you reach the one you want. 

Press CTRL + F6 (or CTRL + TAB) to cycle through document windows and 
icons. 

2. Open the Control menu. 

For an application window, press ALT, SPACEBAR. 

For a document window, press ALT, HYPHEN (-). 

3. Choose Maximize. 
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The window enlarges to its maximum size and the Maximize button is replaced by 
the Restore button. The title bar of a maximized document window is incorporated 
into its application's title bar.The Minimize and Maximize buttons belong to the 
application. Only the Restore button affects the document window alone. 

HINT When you have two or more document windows open in an application window and 
you enlarge one of the document windows, all the others are covered up by the enlarged win
dow. To uncover them, choose the Restore button to return the enlarged window to its pre
vious size or choose Minimize from the document's Control menu to shrink it to an icon. 

Restoring an Icon or a Window to Its Previous Size 
You can restore an icon or a window. The Restore command returns a window or 
an icon to the size and position it occupied before you enlarged it or shrank it to an 
icon. 

[> To restore an icon to a window: 

Mouse D Double-click the icon. 

[(eyboard 1. Press ALT + ESC as needed to select the application icon. For a document, press 
CTRL + F6 (or CTRL + TAB) to select the icon. 

2. Open the Control menu. 

For an application icon, press ALT, SPACEBAR. 

For a document icon, press ALT, HYPHEN (-). 

3. Choose Restore. 

[> To restore an enlarged window to its previous size: 

Mouse D Click the Restore button in the upper-right comer of the window . 

• I I , 

.. file Qptions Window .!:!elp 

PIF Editor Clipboard Clock Calculator 

Click the Restore button 
to return the window to 
its previous size. 
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For an application window, press ALT, SPACEBAR. 

For a document window, press ALT, HYPHEN (-). 

2. Choose Restore. 

Using Scroll Bars 
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Some windows and dialog boxes have scroll bars you can use to view text that 
requires more than the available space. 

File Edit Search Help 

.!. Scron box 

iili 

IIII ~ Scroll bar 

Iii 

~~~~~~~~~~~~~~~~~~~~~~~I~I~~_scrona~w 
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[> To scroll information displayed in a window or dialog box: 

Mouse 0 Drag the scroll box to a position in the scroll bar corresponding to the general 
location where you want to work (beginning, middle, or end of the file or list). 
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All the scrolling options are listed in the following table. 

To scroll 

One line 

One window 

Continuously 

To any position 

Do this 

Click one of the scroll arrows. 

Click the scroll bar above or below the scroll box on ver
tical scroll bars, and to the left or right of the scroll box 
on horizontal scroll bars. 

Point to one of the scroll arrows and hold down the 
mouse button until the information you want comes into 
view. 

Drag the scroll box up or down the scroll bar to the posi
tion of choice. The section of the document or list that 
moves into view depends on the placement of the scroll 
box. For example, if you position the scroll box halfway 
down the scroll bar, the text halfway through the docu
ment or list appears. 

Keyboard D Press the DIRECTION key that points in the direction you want to scroll. Other 
scrolling options are listed in the following table. 

To scroll 

One window up or down 

One window left or right 

To the beginning of a line 

To the end of a line 

To the beginning of the 
document 

To the end of the document 

Closing a Window 

Press these keys 

PAGE UP or PAGE DOWN 

CTRL + PAGE UP or CTRL + PAGE DOWN 

HOME 

END 

CTRL+HOME 

CTRL+END 

When you are working with an application window, one way to exit from the appli
cation is to close the window. Similarly, when you are working with a document 
window, you can exit from that document by closing the window. If you made 
changes to your document since last saving it, you are asked if you want to save 
the document before closing the window. 
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C> To close a window: 

D Choose Exit from the File menu. 

Or choose Close from the Control menu. 

As a shortcut, you can double-click the Control-menu box. 

Working with Applications 
One of the major advantages of Windows is its ability to run two or more applica
tions at the same time. This means that while a spreadsheet is calculating complex 
year-end formulas, you can be working on the text for the annual report in your 
word processor, and your computer can be receiving the latest information about 
industry sales trends for you to use in the introduction. 

Windows not only gives you the power to work with more than one application 
at a time, you can also move important information between running applications 
like your spreadsheet, terminal, and word processor. This feature can mean 
tremendous gains in productivity and a virtual end to duplicated efforts. 

-, 

Many types of applications take full advantage of the graphical interface and other 
powerful features in Windows 3.0. They use drop-down menus and dialog boxes, 
provide certain standard menu items, follow the same keyboard and mouse conven
tions as those used by Windows, and so on. These applications, as well as all of 
the applications you received with your Windows package, are called Windows 
applications. 

NOTE If you also own a previous version of Windows, some of the applications you ran 
with that version might not yet be updated to run with version 3.0. An application that has 
not been updated displays a message telling you to start Windows in real mode. See Chapter 
11, "Options for Starting Windows," for information about starting Windows in real mode. 

Other applications, many of them written before Windows was available, were 
developed to run under MS-DOS. These applications, called non-Windows 
applications, were not designed to take advantage of Windows graphical interface. 
They do not necessarily use drop-down menus or dialog boxes or make use of the 
mouse. They may work differently in other ways as well; however, most non
Windows applications can operate within the Windows graphical environment. 

In standard mode or real mode, all non-Windows applications runfull-screen. 
This means that the application takes over the entire desktop and looks exactly 
as it looks when running under MS-DOS without Windows. 
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I 386 I In 386 enhanced mode, you can multitask several non-Windows applications and 
most can run in a window. 

This section explains the basics about running Windows and non-Windows appli
cations. If you want to learn more about the various ways applications can run 
with Windows, see Chapter 12, "More About Applications." 

Running Two or More Applications 

One of Windows' most powerful features is its ability to run two or more applica
tions at the same time. For example, your communications program can accept 
information sent over a modem while you continue to work with your word pro
cessing application. 

When applications run together, they share your computer's resources. The way 
they share the resources depends on the type of computer you have, the type and 
amount of memory that is available, whether they are Windows or non-Windows 
applications, and which Windows mode you are running. Chapters 12 and 13 in 
Part 3, "Advanced Topics," discuss more fully the various ways you can run appli
cations with Windows. 

NOTE Because of the advanced way 386 enhanced mode can use memory, it can run 
more Windows applications at the same time than standard mode or real mode, given the 
same amount of physical memory. 

To find out which mode Windows is running in, open the Program Manager window and 
choose About Program Manager from the Help menu. 

Starting Applications 

To make starting applications easy, Windows offers three methods: 

• Choose a program item from a group window in Program Manager. 

• Choose a program file (or a PIF) from the appropriate directory window in File 
Manager. (Starting applications with PIFs is discussed in Chapter 12, "More 
About Applications.") 

• Choose the Run command from the File menu in Program Manager or File 
Manager. 

NOTE Some applications, called memory-resident or "pop-up" programs (such as 
Borland ® SideKick ®), ordinarily suspend the application you are using while you work with 
them, and then, when you are finished, return you to the suspended application. You can 
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use memory-resident programs with Windows just like you would any other applications. 
Make sure you start Windows before you start the pop-up program. See Chapter 12, "More 
About Applications," for additional discussion. 

Starting Applications from Program Manager 
As long as an application belongs to a group, the easiest way to start it is to choose 
it from the group window. If a document is included with the application, it will be 
loaded into the application workspace. See Chapter 3, "Program Manger," to learn 
about organizing applications in groups and how to include a document so that it 
starts up with an application. 

[> To start an application from a group: 

Mouse 

I(eyboard 

1. 

2. 

1. 

2. 

3. 

Open the Program Manager window, if not already open, and open the group 
window that contains the application you want to start. 

Double-click the icon for the application. 

Open the Program Manager window, if not already open, and open the group 
window that contains the application you want to start. 

Use the DIRECTION keys to move the highlight to the icon for the application. 

Choose Open from the File menu or press ENTER. 

HINT You can choose the Minimize on Use command from the Options menu if you want 
to shrink Program Manager to an icon whenever you start an application. 

Starting Applications from File Manager 
You can start an application from File Manager by opening the program file from 
a directory window. Program files have .COM, .EXE, .PIF, or .BAT filename ex
tensions. If the application can run in a window, the window will appear in front of 
any File Manager windows that are open. If the application is a full-screen applica
tion, the application screen will replace the File Manager window. 

NOTE If you plan to use an application frequently, you might find it more convenient to 
add it to a group in Program Manager rather than to start it from File Manager. To learn how 
to add an application to a group, see Chapter 3, "Program Manager." 
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t> To start an application from File Manager: 

Mouse 1. Start File Manager and open the directory window that contains the program 
file. 

2. Double-click the filename. 

I(eyboard 1. Start File Manager and open the directory window that contains the program 
file. 

2. Press the DIRECTION keys to select the filename. 

3. Choose Open from the File menu or press ENTER. 

You can use the Minimize on Use command on the Options menu to automatically 
shrink File Manager to an icon whenever you start an application. See Chapter 4, 
"File Manager," for procedures on using File Manager commands. 

Starting Applications with the Run Command 
The Run command is a handy way to start applications that you want to run only 
occasionally or have not yet added to a group. You can open a document at the 
same time you start the application. Unless the program file is in your current path, 
you need to know the exact directory location and name of the program file (and 
document) before you can start the application. 

t> To start an application with the Run command: 

1. Choose Run from the File menu in Program Manager or File Manager. 

The Run dialog box appears. 

D Run M.inimized 
r----. 

OK Cancel 

2. Type the pathname and the exact name of the program file, including the exten
sion if there is one. 

For example, if Aldus PageMaker ® is stored in the directory C:\P AGEMKR, 
you would type c:\pagemkr\pm.exe in the text box. 
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You can open a document at the same time you start most applications by 
typing a space and the document filename (including the pathname) after the 
program name. 

For example, to open a document called NEWSLTR in the AUGUST 
subdirectory of C:\P AGEMKR, you would type the following in the text box: 

c:\pagemkr\pm.exe august\newltr.pm3 

3. If you want the application to shrink to an icon as soon as it starts, make sure 
the Run Minimized check box contains an X. 

4. Choose OK or press ENTER. 

Using the DOS Command Prompt 
You might occasionally want to run a non-Windows application, such as an 
MS-DOS utility program, from Windows. You can run it in the same way you run 
Windows applications by using Program Manager or File Manager. You can also 
run it by starting a copy of the MS-DOS command interpreter. That way, you can 
type in MS-DOS commands just as you would if you were not running Windows. 

The DOS prompt appears as a program item in the Program Manager Main Group, 
so you can get to MS-DOS without leaving Windows. 

[> To start the DOS Prompt: 

1. Open the Main Group window in Program Manager. 

2. Double-click the DOS Prompt icon. 

Or use the DIRECTION keys to move the highlight to the icon; then press ENTER. 

When the DOS prompt appears, you can type the MS-DOS commands and start 
any non-Windows applications. 

[> To exit the DOS Prompt: 

o Type exit and press ENTER. 

You can also leave MS-DOS running and switch back to Windows to work 
with Windows applications. See the next section of this chapter for information 
about switching among applications. 



54 Working with Applications 
I 

CAUTION CHKDSK IF and other MS-DOS commands that might modify file allocation 
tables do not run properly from inside Windows. (CHKDSK without the IF switch runs fine.) 
Other commands that you should avoid running from inside Windows include file undelete 
utilities and disk compaction or optimization utilities such as Norton's SD.EXE. If you need 
to run such commands, exit from Windows first. 

Switching Among Application Windows 

Many times you'll have more than one application window open on your desktop. 
The window you are currently working in is called the active window. When you 
want to work with another application, you must select its application window to 
make it the active window. So that the active window can easily be distinguished 
from inactive windows, its title bar is a different color or intensity. 

The active window always appears in the foreground, which means it might over
lap non-active windows, partially or completely obscuring them. You can move 
part of the active application window beyond the borders of the desktop, thereby 
forcing some of the window's contents outside your view, but the active window 
cannot be covered by any other window. 

When the application window you want to switch to is visible, the easiest selection 
method is to click it with the mouse or use key combinations to cycle through open 
applications until you reach it. 

When you run a number of applications, some of their windows may not be 
visible. Even when the windows are not visible, Task List lets you switch easily 
from one application to another. 

[:> To switch application windows: 

Cl Click anywhere in the inactive window. 

Or press ALT + ESC repeatedly until the window you want is active. 

[> To use Task List to switch application windows: 

MOllse 1. Double-click anywhere on the desktop to display Task List. 

Or choose Switch To from any Control menu. 

2. Double-click the application name you want from the list box in Task List. 

Or select the name of the application you want from the list box and then 
choose Switch To. 



, ". 
Cardfile - (untitled) 
Calculator 
Terminal - (Untitled) 
Program Manager 
Notepad - (untitled) 

Task List 
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I(eyboard 1. Press CTRL + ESC to display Task List. 

Or choose Switch To from any Control Menu. 
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2. Press UP or DOWN ARROW to select the application you want in the list box. 
Press ENTER. 

When an application window appears as an icon, you can switch to the application 
and open the application window in one step if you are using a mouse. 

t> To switch to and open an application icon: 

Mouse 0 Double-click the icon. 

f(eyboard 1. Press ALT + ESC repeatedly until the icon you want is selected. 

2. Press ALT, SPACEBAR to open the Control menu for the application icon. 

3. Press ENTER to choose the Restore command from the Control menu. 

Arranging Application Windows and Icons 
You can use the Cascade and Tile commands from Task List to rearrange applica
tion windows so that all the active applications are visible on your desktop. The 
Cascade command causes the windows to overlap so that each title bar is visible. 
The Tile command arranges the open windows in smaller sizes to fit on the 
desktop. 

t> To arrange application windows on your desktop: 

1. Double-click on the desktop to open Task List. 

Or press CTRL + ESC. 

2. Choose Cascade or Tile. 
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HINT You can also open Task List by choosing Switch To from the application's Control 
menu. 

If you have a number of applications running as icons and they are scattered across 
your desktop, you can rearrange them evenly across the bottom with the Arrange 
Icons command button. 

t> To rearrange application icons: 

1. Double-click on the desktop to open Task List. 

Or press CTRL + ESC. 

2. Choose Arrange Icons. 

The icons line up in an orderly arrangement across the bottom of the desktop. 

HINT You can also open Task List by choosing Switch To from the application's Control 
menu. 

Transferring Information Between Applications with Clipboard 

The Windows Clipboard is a temporary storage location that is always available 
when you want to transfer information during a Windows session. You can cut or 
copy information from an application onto the Clipboard and then transfer that 
information from the Clipboard into other applications. 

Information you cut or copy onto the Clipboard remains there until you clear the 
Clipboard, cut or copy another piece of information onto it, or exit from Windows. 
Since the Clipboard retains its contents until you change them, you can paste the 
information into the destination whenever you want, and you can paste the same 
information repeatedly. 

Cutting or Copying Information onto the Clipboard 
The method you use to transfer information onto the Clipboard depends on 
whether the application is a Windows or a non-Windows application and whether 
it is running in a window or uses the full screen. 

With Windows applications, you can cut or copy selected information onto the 
Clipboard. You can also copy an image of the entire desktop or a single window 
for any application that is running in a window. 
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With non-Windows applications that are running in a window on the desktop, you 
can copy selected infonnation, the entire desktop, or a single window onto the 
Clipboard. For a non-Windows application that is running full-screen, you copy 
the entire screen onto the Clipboard. 

[> To cut or copy selected information from a Windows application: 

1. Select the infonnation you want to cut or copy. (See "Selecting Text" in 
"Working with Documents" later in this chapter for Windows text selection 
procedures. For text selection procedures for other applications, see the manual 
specific to each application.) 

You can cut or copy text, graphics, or a combination of text and graphics. 

2. Choose Cut or Copy from the application's Edit menu. 

The Cut command removes the infonnation from the application and places it 
on the Clipboard. 

The Copy command places a copy of the infonnation on the Clipboard, leaving 
the original infonnation unchanged. 

To use the following procedure, you must be running Windows in 386 enhanced 
mode and the application you want to copy infonnation from must be running in a 
window. 

[> To copy selected information from a windowed, non-Windows application: 

Mouse 1. Drag the mouse pointer across the infonnation you want to copy. 

2. Click the Control menu and open the Edit cascading menu. 

3. Choose Copy. 

Keyboard 1. Press AL T, SPACEBAR to open the Control menu for the application. 

2. Select the Edit cascading menu and choose Mark. 

A rectangular cursor appears at the upper-left comer of the window. 

3. Move the cursor to the first character you want to select. 

4. Press SHIff + DIRECTION keys to mark the infonnation you want to copy. 

5. Select Edit from the Control menu again and choose Copy to transfer the 
selected infonnation to the Clipboard. 
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Copying an Entire Screen 

You can copy the contents of an entire Windows or non-Windows application 
screen onto the Clipboard no matter which mode Windows is using. If you are 
running Windows in standard mode or in real mode, this is the only method you 
can use to copy information from a non-Windows application. 

This procedure does not work for non-Windows applications that are running in 
graphics mode. 

HINT If you aren't sure which mode Windows is running in, open the Program Manager 
window and choose About Program Manager from the Help menu. 

[> To copy the contents of an entire screen onto the Clipboard: 

1. Make sure the information you want to copy is on the screen. 

2. Press PRINT SCREEN. 

This takes a "snapshot" of the screen contents and places it onto the Clipboard. 

PRINT SCREEN creates a bitmap of the entire screen. Not all applications can 
read bitmaps (.BMP files). Make sure the application you want to paste infor
mation into can understand the bitmap format. 

HINT If the preceding procedure does not copy the screen onto the Clipboard, your key
board is probably an older, unenhanced model. Try the following key combinations to copy 
the screen: ALT + PRINT SCREEN or SHIFT + PRINT SCREEN. 

Copying an Entire Window 
1 3861 To use the following procedure, you must be running Windows in 386 enhanced 

mode and the Windows or non-Windows application you want to copy informa
tion from must be running in a window. 

[> To copy the contents of the active window onto the Clipboard: 

1. Make sure the information you want to copy is in the active window. 

2. Press ALT + PRINT SCREEN. 

This takes a "snapshot" of the active window and places it on the Clipboard. 

ALT + PRINT SCREEN creates a bitmap of the entire screen. Not all applications can 
read bitmaps (.BMP files). Make sure the application you want to paste informa
tion into can understand the bitmap format. 
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HINT If ALT + PRINT SCREEN does not work, try SHIFT + PRINT SCREEN. Older keyboards might 
not recognize ALT + PRINT SCREEN. 

Pasting Information from the Clipboard 
You can paste information from the Clipboard into a destination application at any 
time. Anything you cut or copy onto the Clipboard remains there until you change 
it, clear it, or exit Windows. 

Some Windows applications recognize text files, and others graphics, while 
several recognize both text and graphics. Non-Windows applications recognize 
text only. The method you use to paste information depends on whether you are 
pasting into a Windows or a non-Windows application. 

Pasting Information into Windows Applications 

To paste information from the Clipboard into a Windows application, you use the 
Paste command from the destination application's Edit menu. 

[> To paste information into a Windows application: 

1. Make sure the information you want to paste is on the Clipboard. (See 
"Working with the Clipboard's Contents" later in this section.) 

2. Start the destination application and place the insertion point where you want 
the information from the Clipboard to appear. 

3. Choose Paste from the application's Edit menu. 

Windows copies the information to the location marked by the insertion point. 

Pasting Information into Non-Windows Applications 

To paste information from the Clipboard into any non-Windows application, you 
use the Paste command from the destination application's Control menu. You can 
paste only unformatted text into non-Windows applications. If you paste formatted 
text, the formatting will be lost. 

The method you use to paste from the Clipboard depends on whether non
Windows applications are running full-screen or in windows. 
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[> To paste information into a full-screen, non-Windows application: 

1. Make sure the information you want to transfer is on the Clipboard. (See 
"Working with the Clipboard's Contents" later in this section.) 

2. Start the destination application and place the insertion point where you want 
the information from the Clipboard to appear. 

3. Press ALT + ESC to switch back to Windows without quitting the application. 

The application appears as an application icon at the lower edge of the 
Windows desktop. 

4. Click the application icon to open the Control menu for the destination 
application. 

Or press ALT + ESC until you select the application icon you want. Then press 
ALT, SPACEBAR to open the Control menu. 

5. Choose Paste. 

If you are running Windows in 386 enhanced mode, select the Edit cascading 
menu from the application icon's Control menu and then choose Paste. 

The information is pasted into the destination one character at a time, as if you 
were typing it. 

1386 I' To use the following procedure, you must be running Windows in 386 enhanced 
mode and the application you want to transfer information into must be running in 
a window. 

[> To paste information into a windowed, non-Windows application: 

1. Make sure the information you want to transfer is on the Clipboard. (See 
"Working with the Clipboard's Contents" later in this section.) 

2. Start or select the destination application and place the insertion point where 
you want the information from the Clipboard to appear. 

3. Open the application's Control menu. 

4. Select the Edit cascading menu and choose Paste. 

The information is pasted into the destination one character at a time, as if you 
were typing it. 

HINT You can switch back and forth between running an application full-screen and 
running it in a window. Press ALT + ENTER (386 enhanced mode only). 
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Working with the Clipboard's Contents 
You can open the Clipboard, look at its contents, save its contents to a file, retrieve 
Clipboard files, and remove the current contents of the Clipboard. 

t> To view the Clipboard's contents: 

1. Switch to Program Manager, if it isn't the active application, and open the 
Main Group window. 

2. Choose the Clipboard icon from the Main Group window. 

The Clipboard window appears, with the contents visible in the window's 
workspace. 

NOTE Clipboard sometimes has to change the line length of the information you copy or 
cut so that all of it is included in the View Clipboard window. When you paste from the 
Clipboard into the destination application, the information you copied or cut will be intact. 

The Clipboard accepts a number of different text and graphics formats. When you 
transfer information from one application to another, the original application puts 
the information on the Clipboard in the formats it understands. 

The application you paste the information into determines which format to use. 
Typically, if there are several choices, the application chooses the format that 
provides the most information. 

You can view the information on the Clipboard in any of the formats that were 
supplied by the original application. 

t> To view another format: 

o Choose the alternate format from the Display menu. 

t> To return to the first format that was displayed: 

o Choose Auto from the Display menu. 

You can save the contents of the Clipboard to a file and then retrieve the file to 
view or paste later. The file you save can be read only by the Clipboard. 
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[> To save the Clipboard's contents: 

1. Choose Save As from the File menu. 

The File Save As dialog box appears. 

2. Type a filename for the Clipboard contents and choose OK. The default 
extension for a Clipboard file is .CLP. 

You can also type a pathname to store the Clipboard file in a different 
directory. 

You can open a Clipboard file and then paste it into any application. Only files 
with a .CLP extension can be opened in the Clipboard. 

[> To retrieve a Clipboard file: 

1. Choose Open from the File menu. 

The File Open dialog box appears. 

2. Select the file you want to retrieve from the Files list box and choose OK. 

Or you can type the pathname for the file you want to retrieve in the text box. 

NOTE If the Clipboard is not empty, you'll be asked if you want to clear it. If you choose 
OK, the contents of the current Clipboard will be replaced with the contents of the file you 
specified. 

If you need more memory to run an application, you can clear the Clipboard's 
contents. Since the Clipboard stores information in multiple formats, clearing the 
Clipboard might free up some memory. 

[> To clear the Clipboard's contents: 

1. Choose Delete from the Edit menu or press DELETE. 

2. Choose OK. 
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Receiving Messages from Inactive Applications 

When an inactive application has a status or error message for you, a beep sounds 
and the application flashes its title bar or icon. 

[> To receive a status or error message: 

o Select the application window or icon. 

The message appears as soon as you select the window or icon. 

Quitting Applications 

There are three ways to quit a Windows application that is running. 

t> To quit a Windows application: 

o Choose Exit from the application's File menu. 

Or choose Close from the Control menu. 

Or double-click the Control-menu box. 

If you have changed the document since you last saved it, the application will 
prompt you to save the file. 

t> To quit a non-Windows application: 

1. Choose the application's Exit command. 

If you are using DOS Prompt" type exit. 

2. The application closes and returns you to Windows. 

NOTE When you exit a non-Windows application that is running full-screen, Windows 
usually returns you to the Windows desktop, just as you left it. However, you can change a 
setting in the program information file (PIF) to return to what's called an inactive window. 

The inactive window captures information from the application that was displayed as you 
exited. Sometimes that type of information stays on the screen too briefly to be read, 
making the inactive window a handy feature. See Chapter 12, "More About Applications," to 
learn about establishing and modifying program information files. 
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Working with Documents 
This section explains tasks that are common to many different Windows applica
tions: opening and saving documents, and doing basic text editing. See Chapter 3, 
"Program Manager," and Chapter 4, "File Manager," for information about 
organizing your applications and documents within the Windows environment. 

NOTE The descriptions in this section apply to the applications you received with the 
Windows package. Other applications you use might work differently. 

Opening Documents and Files 

[> To open a document: 

1. Choose Open from the application's File menu. 

2. Move to the Directories list box. 

3. Double-click the directory that contains the file you want to open. 

Or press UP or DOWN ARROW to select the directory and press ENTER. 

Windows displays the names of all files in that directory in the Files list box. 

4. Move to the Files list box and select the file you want. 

Some applications provide a check box to specify that the file be read-only 
(which means that changes cannot be made to the file). If you want the file to 
be read-only, select this check box. 

5. Double-click the filename or choose OK. 

Saving Documents and Files 

With many applications, the File menu contains two different commands for 
saving files: Save and Save As. 

You use the Save command to save changes to an existing file. 

You use the Save As command to name and save a new file or to save an existing 
file under a new name. For example, you might want to make changes to an 
existing document without modifying the original. With Save As, you can save 
another copy of the original file by giving it another name. 
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[> To save an existing file: 

o Choose Save from the File menu. 

[> To save a new file or an existing file under an additional name: 

1. Choose Save As from the File menu. 

2. Move to the Directories list box and select the directory in which you want to 
save the file. 

3. Move to the Filename text box and type the name you want to assign to the 
file, including a filename extension if you want to specify one. (If you prefer, 
you can include the complete pathname in this text box instead of selecting the 
directory as described in the previous step.) 

If you don't specify an extension, many applications automatically append an 
extension that is unique to the application. For example, Notepad automatically 
adds the extension .TXT to its files. If you specify an extension, it overrides 
any automatic extension. 

4. Choose OK. 

Switching Among Document Windows 
With some applications, you can open more than one document at a time, each in 
its own window. 

[> To switch among document windows in the application workspace: 

o Click anywhere in the window of the document you want to switch to. 

Or open the application's Window menu and choose the document you want. 

HINT Press CTRL + F6 (or CTRL + TAB) repeatedly until the document you want is selected. 
This is a shortcut to the Control menu's Next command. 

Arranging Document Windows 
You can use the Cascade and Tile commands from the application's Window 
menu to rearrange document windows so that all of them are visible within the 
application workspace. 
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The Cascade command causes the windows to overlap so that each title bar is 
visible. The Tile command arranges the open windows in smaller sizes to fit 
within the application workspace. 

[> To arrange document windows: 

D Open the application's Window menu and choose Cascade or Tile. 

Working with Text 

Most applications require that you enter text from time to time. In a word 
processor or text editor, of course, entering and editing text is your main task. 
But even in a spreadsheet or database, text entry is important. 

All Windows applications share the same procedures for typing text, correcting 
errors, and simple text editing. This section describes those procedures. 

Entering Text 
When you begin to enter text, an insertion point (flashing vertical bar) marks the 
place where the text you type will begin. 

[> To enter text in a new document: 

D Just start typing. 

Press ENTER or the SPACEBAR to move the insertion point to a different 
place on the page. Pressing ENTER moves the insertion point to the next line. 
Pressing the SPACEBAR moves the insertion point across the line to the right. 

l> To enter text in an existing document: 

D Click where you want text to appear, and start typing. 

Or use the DIRECTION keys to move the insertion point where you want text to 
appear. 

NOTE You can move the insertion point only to a place in the document where it's been 
before. For example, to type a report title 10 tines from the top of a new page and 20 spaces 
in from the left margin, you press ENTER 10 times and then press the SPACEBAR 20 times 
before you type the title. Anytime you have trouble moving the insertion point with the 
DIRECTION keys, try using the ENTER key or the SPACEBAR. 
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Moving Within Text 
After you enter text, you can easily move the insertion point wherever you want 
within the text. 

To move to 

The next line 

The previous line 

The end of the line 

The beginning of the line 

The next window 

The previous window 

The next word 

The previous word 

The end of the document 

The beginning of the document 

Correcting Typing Mistakes 

Press these keys 

DOWN ARROW 

UPARROW 

END 

HOME 

PAGE DOWN 

PAGE UP 

CTRL + RIGHT ARROW 

CTRL + LEFf ARROW 

CTRL+END 

CTRL+HOME 

If you make a mistake while entering text, you can correct it by using one of the 
methods in the following table. Or if you need to change more than a few char
acters, you can select the text and edit it as explained later in this section. 

To do this 

Erase the character (or selected text) 
to the left of the insertion point. 

Erase the character (or selected text) 
to the right of the insertion point. 

Insert characters at the insertion point. 

Selecting Text 

Do this 

Press BACKSPACE. 

Press DELETE. 

Type the characters. 

You can make changes to blocks of text by selecting the text you want to change 
and then choosing one of the commands from the application's Edit menu. 
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[> To select text: 

Mouse 1. Point to the first character you want to select. 

2. Drag the insertion point to the last character you want to select. 

3. Release the mouse button. 

If you want to cancel the selection, click again anywhere in the document. 

HINT With some applications, you can select a single word by double-clicking the word. 

/(eyboard 1. Use the DIRECTION keys to move the insertion point to the first character you 
want to select. 

2. Hold down SHIFf and use the DIRECTION keys to move the insertion point to 
the last character you want to select. 

3. Release the keys. 

If you want to cancel the selection, press a DIRECTION key. 

HINT With some applications, you can select all the text in your file. Choose Select All 
from the Edit Menu. 

Other keyboard selection options are shown in the following table. A specific ap
plication might use only some of these options. In general, you can select an area 
of text by holding down SHIFf while you use the standard movement keystrokes. 
Check your application's manual for a list of valid key combinations. 

To do this 

Extend the selection to the next line. 
Or, if the next line is already selected, 
cancel the selection. 

Extend the selection to the previous 
line. Or, if the previous line is already 
selected, cancel the selection. 

Extend the selection to the end of the 
line. 

Extend the selection to the beginning 
of the line. 

Press these keys 

SHIFf + DOWN ARROW 

SHIFf + UP ARROW 

SHIFf + END 

SHIFf + HOME 



To do this 

Extend the selection down one win
dow. Or, if the next window is 
already selected, cancel the selection. 

Extend the selection up one window. 
Or, if the previous window is already 
selected, cancel the selection. 

Extend the selection to the next word. 
Or, if the next word is already 
selected, cancel the selection. 

Extend the selection to the previous 
word. Or, if the previous word is al
ready selected, cancel the selection. 

Extend the selection to the end of the 
document. 

Extend the selection to the beginning 
of the document. 

Editing Selected Text 
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Press these keys 

SHIFf + PAGE DOWN 

SHIFf + PAGE UP 

CTRL + SHIFf + RIGHT ARROW 

CTRL + SHIFf + LEFf ARROW 

CTRL + SHIFf + END 

CTRL + SHIFf + HOME 

You can edit the text you have selected in any of the ways listed in the following 
table. You can find a full explanation of how to transfer information between appli
cations and documents using the Clipboard earlier in this chapter. 

To do this 

Delete the selected text and place it 
on the Clipboard, a temporary storage 
area in memory. 

Make a copy of the selected text and 
place it on the Clipboard. 

Replace the text with new text. 

Delete the text. (It is not placed on 
the Clipboard.) 

Reverse the previous editing 
operation. 

Do this 

Choose Cut (SHIFf + DELETE) from 
the Edit menu. 

Choose Copy (CTRL + INSERT) from 
the Edit menu. 

Type the new text. 

Press DELETE or BACKSPACE. 

Choose Undo (ALT + BACKSPACE) 
from the Edit menu. 
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To do this 

Paste text from the Clipboard to the 
active window. 

Do this 

Place the insertion point where you 
want the Clipboard text to begin and 
choose Paste (SHIFf + INSERT) from 
the Edit menu. 

NOTE The Undo command reverses the previous editing operation in many text and 
graphics applications you might use with Windows. For applications that are not part of the 
Windows package, check the reference manual you received with the product. For applica
tions that came with the Windows package, see the appropriate section of the User's Guide 
for information about using Undo. 

Using Windows Help 
Windows Help is a convenient, quick way to use your mouse or keyboard to look 
up information on-line, such as information about the basic skills you need to 
operate Windows, a procedure you're trying to follow, a keyboard equivalent, a 
feature you'd like to know more about, or a command you want to use. 

Help for Windows and the applications you received with the Windows package is 
available whenever you see a Help command button or Help on a menu bar. 

file fdit liearch Help 

f! 
------------------------------~ 

The applications and accessories (except Clock) you received with the Windows 
package include on-line Help as described in this section. Other Windows applica
tions and non-Windows applications might also provide help, but you'll need to 
refer to each application's manual for instructions. 

Starting Help 

You can request Windows Help in several ways. Because Help might be displayed 
differently depending on which application you are using and what kind of infor
mation you need, Help gives you the following options. 
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[> To request Help: 

o Choose a Help category from the Help menu. Some categories take you 
directly to the infonnation (like Keyboard). With others, you select the topic 
you want from a list of topics about the category you chose. 

Or press Fl. Then choose an item from the main Help Index for the application 
you are using. You can also search for a topic using the Search command. 

Or choose the Help command button you'll find in some dialog boxes. This 
method gives you quick access to different kinds of Help topics. 

Or highlight a dialog box option or select a command and then press Fl to 
move directly to an explanation of the option (PIF Editor). Or press Fl for 
infonnation about a message (Setup). This context-sensitive method is 
available in PIF Editor and in Setup when you first use it to install Windows. 

Using the Help Menu 

Each Help menu appears last on the menu bar, as shown in the preceding illustra
tion. When you select Help from the menu bar, a list of Help categories drops 
down. 

[> To get Help from a menu: 

Mouse 1. Click Help on the menu bar. 

file Edit ,S.earch 

Keyboard 
~ommands 

Erocedures 
llsing Help 

About Notepad ... 

2. Click the Help category you want. 

+ 

You will see either infonnation about the category or a list of topics for the 
category. 
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I(eyboard 1. Press ALT, H. 

2. Press the underlined letter for the Help category you want. 

Or press DOWN or UP ARROW to reach the Help category you want and then 
press ENTER. 

You will see information about the category or a list of topics for the category. 

NOTE If this is the first time you've used on-line Help, choose Using Help from the Help 
menu to learn about the type of assistance that is available. Using Help includes a brief 
tutorial on Help called Help Basics. 

Help Menu Options 
The following table outlines the standard items on most Windows Help menus. 

Menu item 

Index 

Keyboard 

Commands 

Procedures 

Using Help 

About 
(Application) 

What you'll find 

An alphabetical list of all Help topics that are available for 
the active application. 

Tables of key combinations for using your keyboard with the 
active application. 

An explanation of all the commands used in the active 
application. 

Step-by-step procedures for using the active application's 
features. 

Short tutorial and other information about using Windows 
Help. 

Important information about the active application, which 
includes copyright, version, and application name. 

Finding Information in Help 

If you request Help by pressing Fl, the main Index appears for the application you 
are using. 

If you request Help by selecting a category from the Help menu, one of three 
things happens. The information you requested appears, the main Index for the 
application appears, or a list of topics about the category appears. 
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You can select from the Index or the list of topics or you can use the Help Search 
feature to locate the information you want. 

Finding Information with Search 
The Search feature is the most efficient way to find the information you need. 
When you already know a keyword or phrase that you want Help on, you can type 
it in the Search dialog box and let Windows Help find the information for you. 

[> To search for a Windows Help topic: 

1. Open Help and choose the Search button. The Search dialog box appears. 

2. Type a word or short phrase in the Search For text box that describes the infor
mation you want. Or you can scroll through the keyword entries in the list box 
beneath the Search For text box and select the appropriate keyword. 

As you type, the top entry in the list box beneath the Search For text box 
changes to match what you type as closely as possible. 

3. Choose Search. A list of topics that match or relate to the keyword or phrase 
appears in the Topics Found list box. 

4. Choose the topic you want. 

NOTE Search does not require you to type an entire word. Help matches the characters 
you type as closely as possible with the available keywords below the text box. Help auto
matically selects the keyword that most closely resembles what you type. When you choose 
the Search button, Help lists all the topics it finds that relate to the selected keyword or 
phrase. Then you choose the topic you want from that list. 

The next time you open the Search dialog box, you'll see the name of the topic 
you searched for previously. 

Finding Information with Help Index and Table of Contents 
When you request Help by pressing FI, you'll see a Help Index, alphabetized by 
category, of all the topics that are available for the application you are using. 

When you request Help by choosing a category from the Help menu, you'll either 
go directly to the information about the category or to a list that resembles a table 
of contents. This list refers strictly to the application you are currently using. 

You scroll through the list and choose a topic. The mouse pointer (or highlight if 
you use a keyboard) turns into a hand pointer when it touches an underlined topic. 
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The hand pointer indicates that information is available for the topic. When you 
choose an active topic, a window containing the information appears. 

[> To choose a topic from an Index or Table of Contents: 

1. Press PI or choose a Help category you want from the Help menu. 

2. Scroll to the topic you want information about. 

3. When the mouse pointer turns to a hand, click the topic you want. 

Or press TAB to highlight the topic you want and then press ENTER. 

Sometimes, at the end of the Help text, there is a list of related topics you can 
choose from, as explained in the preceding steps. 

Additional Methods 
When you finish reading about a topic, you have several choices. If a list of related 
topics follows the information, you can choose from the list. Or you can choose 
one of the buttons described as follows. 

Use this button 

I ~ I index 

To do this 

View the Help Index for the application. 

View previous information. Pressing Back retraces your 
path through the Help topics you've already seen until you 
reach the Index. 

View the previous topic in a series of related topics. When 
you reach the first topic in the series, the button is dimmed. 

View the next topic in a series of related topics. When you 
reach the last topic in the series, the button is dimmed. 

Locate information about a topic (keyword or phrase) you 
select from a list or that you type in the Search For text 
box. 

HINT You can keep Help handy by resizing it and arranging it on your desktop to fit 
beside the running application. 
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Practicing Basic Skills 
If you are a new user of Windows, or just want to explore the features of Windows 
3.0, Solitaire and Reversi give you the perfect opportunity to practice many of the 
skills covered in this chapter. These two games were copied onto your hard disk 
when you installed Windows. 

Both games provide a rich graphical environment that includes many of Windows' 
most powerful features. Play while you learn to use on-line Help, open menus and 
select items, move and resize application windows, work with dialog boxes, and 
switch between applications. 

You start the games like you start any other application. See "Starting 
Applications" earlier in this chapter. 
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What Is Program Manager? 
Program Manager is central to the operation of Microsoft Windows. It starts auto
matically whenever you start Windows and continues to run as long as you are 
using Windows. 

Starting applications from Program Manager is easy; you simply choose the pro
gram item icon for the application you want to use and Program Manager does the 
rest. When you do run other applications, Program Manager runs in the back
ground or on your desktop as an application icon. 

The very first time you start up Windows, Program Manager opens on your desk
top with the Main Group window open inside it. 
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The Accessories Group, the Games Group, and, depending on which other applica
tions you told Windows to install from your hard disk, the Windows Applications 
Group and the Non-Windows Applications Group are represented as identical 
group icons at the bottom of the Program Manager window. These groups contain 
the program item icons for all the applications you installed and the applications 
you will use to manage the operation of Windows. 
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Program Manager is also an organizational tool. You can use it to organize your 
applications into groupings that make sense to you. You can also control how 
those groups and their contents are arranged on your desktop with Program 
Manager. 

You must return to Program Manager when you want to end your Windows 
session. You cannot quit Program Manager without also quitting Windows. See 
the end of this chapter for instructions on quitting Program Manager. 

Working with Groups 
Each group contains a collection of program item icons, each representing an appli
cation you can run. Depending on the information you specify when you add a pro
gram item to a group, choosing a program item icon from a group can start an 
application or start the application and, at the same time, open a related document. 

Windows comes with several predefined groups, each containing several program 
item icons. 

• The Main Group, which contains the Windows system applications: File 
Manager, Control Panel, Print Manager, Clipboard, DOS Prompt, and 
Windows Setup. 

• The Accessories Group, which includes Windows applications for word 
processing, drawing, and communications, as well as several less complex 
applications that you will probably find very convenient: a clock, a calculator, 
a macro recorder, a calendar, a notepad, a card file, and an editor for program 
information files (PIF Editor). 

• The Games Group, which offers two games that you can use to practice the 
basic skills you learn as you operate Windows or to give yourself a relaxing 
break from work. 

• The Windows Applications Group, which contains any Windows-based applica
tions found on your hard disk during the Setup procedure. 

• The Non-Windows Applications Group, which contains non-Windows applica
tions that Setup was able to install during the Setup procedure. 

You start up the applications in these groups by opening a group window and 
choosing the program item icon for the application you want to run. 
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When you exit Windows and save the changes you made during your Windows 
session, Windows will start your next session with the Program Manager's group 
windows, group icons, and program item icons arranged as they were at the end of 
the previous session. 

, 

The group window shows the 
items that make up the group. 
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The following list describes the unique elements of the Program Manager window. 

• Group windows are document windows that occupy the Program Manager's ap
plication workspace. They contain icons that start up applications. Each group 
window has its own Control menu, but no menu bar. Group windows are 
affected by commands from Program Manager's menu bar. Group windows 
cannot be moved outside the Program Manager workspace. 

• Group icons are minimized group windows. Group icons are located at the 
lower edge of the Program Manager window and are distinguished only by the 
labels beneath each icon, since all group icons look alike. Like group windows, 
they cannot be moved outside the Program Manager workspace. 

• Program item icons are inside of group windows and represent the applications 
and documents you can start from Program Manager. Choosing a program item 
icon starts the application the icon represents. You can move program item 
icons from one group window to another, but not into the Program Manager ap
plication window or outside Program Manager. 
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Most program item icons have a unique appearance, making them easy to 
locate at a glance. However, some non-Windows applications use identical pro
gram item icons. Also, if you create separate program items for the same appli
cation, the resulting icons look the same. 

For example, suppose you want a group to include several documents that will 
be loaded when you start an application, and they all use the same application. 
You must add a separate program item for each document. Each program item 
includes pathnames and filenames for the application and one document. The 
resulting group contains several program item icons that all look just like the 
original icon for the application. Only their labels distinguish them. (See 
"Adding Program Items and Documents to a Group" later in this chapter.) 

Opening Group Windows and Shrinking Them to Icons 

To open an application (and its related document) from a group, you must first 
open the window for the group that contains the program item icon for that applica
tion. You can then shrink the group back to its icon size to make room on your 
desktop. 

l> To open a group window: 

D Double-click the group icon. 

Or press CTRL + F6 (or CTRL + TAB) until the group icon you want is high
lighted; then press ENTER. (You can also select the group name from the list at 
the bottom of the Window menu.) 

l> To shrink a group window to an icon: 

D Click the Minimize button. 

Or press ALT, HYPHEN (-) to open the group's Control menu, and choose 
Minimize. 

Group windows do not close like other windows. If you double-click the group's 
Control-menu box or choose Close from the Control menu, Program Manager 
shrinks the group to a program item icon. 

NOTE When you shrink Program Manager to an icon, all the program group windows, 
group icons, and program item icons are included. 
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Resizing Group Windows 
The procedure for changing the size of a group window is the same as resizing any 
other window. See "Changing the Size of a Window" in Chapter 2 for instructions. 

However, since group windows usually contain a number of program item icons, 
some or all of the icons might not be visible after you change a window's size, 
especially if you make it smaller. 

• II. ...1 .... 

file Qptions Window Help 

... 1 .... 

~ ~ ~ g ~ 
Ii!III!ImI Control Panel Print Manager Clip 

Accessories Games Windows App N on-Windows Applications 

You can adjust the arrangement of the program icons in two ways. Choose the 
Arrange Icons command on Program Manager's Window menu each time you 
finish resizing a group window. Or select the Auto Arrange command on Program 
Manager's Options menu before you resize a group window (a checkmark beside 
Auto Arrange means it is active). 
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With either command, Program Manager rearranges the program item icons to fit 
into the new group window size. If all the icons can't fit, a scroll bar is provided. 
When selected, the Auto Arrange command rearranges program item icons auto
matically every time the size of their group window changes. To use the Arrange 
Icons command, you must choose it each time. 

Rearranging Group Windows 
When you open several group windows at a time, they begin to overlap in such a 
way that some of the windows are hidden beneath other windows. You can use the 
Cascade and Tile commands found on the Window menu to rearrange all the 
group windows so that some part of each window is visible. 

The Cascade command resizes and layers the open group windows within the 
Program Manager workspace so that each title bar is visible as shown in the 
following illustration. 
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Cascading windows 

The Tile command divides the available space in the Program Manager workspace 
into smaller windows of similar sizes for each group window that you have open. 
As many program item icons as can fit in the allotted space for each group will 
show. The following illustrates tiling: 
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If you open another group window after cascading or tiling, it will overlap the 
rearranged windows. To include it among the rearranged windows, you must 
choose the command again. 

[> To rearrange all the open group windows: 

[J Choose Cascade or Tile from the Window menu. 

Arranging Icons 

You can move any group icon within the Program Manager workspace by drag
ging it with the mouse or by using the Move command from the group's Control 
menu. 

You can also move program item icons between group windows or into group 
icons. (See the sections on copying and moving program items later in this 
chapter.) 

[> To rearrange group icons: 

1. Select any group icon. 

2. Choose Arrange Icons from the Window menu to distribute the group icons 
evenly at the bottom of the Program Manager window. 

Or you can drag individual icons with the mouse to a new location. With the 
keyboard, you press ALT, HYPHEN (-) to open the group icon's Control menu. 
Then choose the Move command and press DIRECTION keys until the icon is in 
the location you want. 

[> To rearrange program item icons: 

1. Select the group window in which you want to rearrange program item icons. 

2. Choose Arrange Icons from the Window menu to distribute the program item 
icons evenly within the selected group window. 

Or you can drag the individual icons with the mouse to a new location within 
the group window. 
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Creating and Deleting Groups 
You can add any number of groups to Program Manager at any time to help 
organize your applications and documents in a way that makes sense to you. 
And if you find that you no longer need a group, you can delete it and free up 
some space on your desktop. 

[> To create a new group: 

1. Choose New from the File menu. 

Program Manager displays the New Program Object dialog box. 

2. Select the Program Group option and choose OK. 

Program Manager displays the Program Group Properties dialog box. 

Program Group Properties 

.!! escriplion: 

!iroup File: 
"'--:==:;----;::====:::;--------l 

OK Cancel 

3. Type a description for the group you want to create. This description appears 
in the title bar of the group window and just below the group icon. 

HINT Keep the description short to conserve space on your desktop. 

4. Choose OK. 

Program Manager automatically creates a .GRP file for the new group, so you 
can leave the Group File text box blank. 

After creating the group, you can add the program item icons that you want 
included in the group. See "Adding Program Items and Documents to a Group" 
later in this chapter. 
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[> To delete a group: 

1. Click the icon for the group you want to delete. 

Or press CTRL + F6 (or CTRL + TAB) repeatedly until you select the group icon. 

2. Choose Delete from the File menu. 

Program Manager displays a dialog box, asking you to confirm that you want 
to delete the group. Program Manager will delete the group you selected and 
any program item icons in it, so be sure before you continue. This does not, 
however, remove any program or document files from your disk. 

3. Choose Yes to remove the group from Windows. 

Changing the Properties of a Group 
You can change the description for any group. The description labels the group 
icon and appears in the title bar of the group window. 

[> To change the description of a group: 

1. Select the group icon for which you want to change the description. 

2. Choose Properties from the File menu. The Program Group Properties dialog 
box appears. 

3. Type a new description and choose OK. 

Changing the Contents of Groups 

You can change the contents of any group by adding new program items, copying 
or moving program items from one group to another, or deleting program items. 

Adding Program Items and Documents to a Group 
One of the ways to change the contents of a group is to add a new program item. 
You can add new program items from your hard disk to existing groups in the 
following ways: 

• By using the New command in Program Manager 

• By dragging program files and document files from File Manager (mouse only) 

• By using Windows Setup 
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NOTE Including more than 40 program items per group is not recommended. 

You can also place a document in a Program Manager group by including it with 
the application as a program item. When you do that, the document is automati
cally loaded into the application workspace whenever you start up the application 
from Program Manager. 

Only one document can be included per program item. It shares the application's 
program item icon and the label fo(that icon. Each time you want to include 
another document with that application, you create another program item and an 
identical program item icon is added to the group. Their labels distinguish the 
items from one another. 

NOTE Each separate program item starts another application. If you have a number of 
program items for the same application, each time you choose one, the application is loaded 
into memory again. 

Including documents with program item icons lets you organize all the pieces of a 
single project into one group. For example, to prepare a monthly newsletter you 
might have a group that looks something like this: 

m!l1 a ~ ~ 
[!IDI Terminal Mayeal Feature 

~ ~ •• ~ •• ~ • • 
Deptnews Feature1 Feature2 Map 

~ •• [§] ~ ~ a 
Feature3 File Manager Control Panel Print Manager 

[> To add a program item and a document to a group with Program Manager: 

1. Open the group window for the group you want to add to. 

2. Choose New from the File menu. 

The New Program Object dialog box appears. 

3. Select Program Item and choose OK. 
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The Program Item Properties dialog box appears. 

Program Item Properties 

I! escription: 

!;ommand Line: I 
~==~~==~====~ 

DK I I Cancel I .!!rowse... I Ch<m~le !.e()n ... 

4. Type a description for the program item in the Description text box. 

The description is a label for the program item icon that represents the program 
file (and its associated document) in the group window. 

NOTE The description is optional. If you leave this text box blank, Program Manager 
labels the icon for you with a suitable description. However, a description of your own 
can be very useful, especially if you intend to include several documents that start with 
the same application within the same group. 

5. Type the name of the program file, including the extension (if there is one), in 
the Command Line text box. Include the complete pathname required to locate 
the file, if necessary. 

For example, to add Microsoft Excel, stored in a directory on a hard disk 
named C:\EXCEL, type c:\excel\excel.exe in the text box. 

If you don't know the name for the program file, choose the Browse button 
to display a list of files and directories. Select the appropriate filename (and 
directory if necessary) from the list. Then choose OK to insert that filename in 
the Command Line text box. 

Browse 

Filename: '=iImm=· =. ____ ----', I OK 

Directory: c:lwindows I Cancel 

files: I!irectories: 

calc. eKe 
calendar. eKe 
cardfile.eKe 
c1ipbrd_eKe 
clock_eKe 
control.eKe 
msdos_exe 
notepad_exe 
pbrush_exe 

ifedit.exe 

• [--I 
[devtoolsl 
[graphicsl 
[pclfontsl 
[systeml 
[-a-I 
[-b-I 
[-c-I 
[-s-I 
+ 
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HINT You don't need to type the entire pathname if the location of the application's 
program file is included in the Path command in your AUTOEXEC.BAT file or if the pro
gram file is in the current directory. In fact, if the program file is included in your AUTO
EXEC.BAT Path command, you can specify a current directory other than the one that 
contains the application. For example, you might want to start Microsoft Excel and make 
the \BUDGETS directory current. To do so, make sure the directory containing Excel is 
included in your AUTOEXEC.BAT path. Then, type c:\budgets\exce/.exe in the Command 
Line text box. 

6. If you want to include a document with the program item, press the SPACEBAR 
after the program's filename and type the filename of the document. Include 
the complete pathname required to locate the document. 

For example, to add a spreadsheet named 91BUDGET.XLS stored in 
C:\ADMIN\FY91 and relate it to Microsoft Excel, type 
c:\excel\excei.exe c:\admin\fy9J\9J budget.xis in the text box. 

NOTE If the document is located in the same directory as the application, you do 
not have to repeat the pathname when you type the filename for the document. For 
example, to include a spreadsheet located in the C:\EXCEL path, you would type 
c:\exce/\exce/.exe expense.x/s. 

7. Choose OK. 

NOTE Program Manager selects an icon for each program item in the group window. If 
more than one icon is available for a program item, you can use a different one by choosing 
Change Icon in the Program Item Properties dialog box. You cycle through the other 
available icons by choosing View Next. 

You can also use File Manager to create program item icons in Program Manager 
groups. You can move applications and associated documents from File Manager 
directories to Program Manager group windows or to group icons. 

The following procedure requires a mouse. 

[> To add a program item to a group using File Manager: 

1. Position the group icon or resize the group window that will receive the new 
program item so that it occupies one side of your desktop, leaving room for the 
File Manager window. 

If you are not concerned with the placement of the new program item icon in 
the group, you do not need to open and position a group window. You can 
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simply drop the program file or document file icon from File Manager onto the 
group icon in Program Manager. 

2. Open File Manager and position and resize it so that you can see both File 
Manager and Program Manager. 

HINT If you have no other application windows open, you can use the Tile command 
to arrange the windows for File Manager and Program Manager. 

r- Group Window 

• II. "'I'" .... 1 File Manager 
file Qptions Window !!elp File Disk Tree View Options 

= I I· "'I'" Window Help 

Directory Tree 

~~ .. g.~.~ ...................... . , 
• "" 1 C:\WINDOWS\*.* 1"'1'" 
: LJ [ .. ] l§l CLiENTS.CRD 
: D ACCESS.GRP r::J CLlPBRD.EXE 
• D ACCESSOR.GRP D CLlPBRD.HLP : 
: D BUDGET.GRP r::J CLOCK.EXE· Program file 
:~t!1l~~ ••• r::J CONTROL.EXE 
: D CALC.HLP D CONTROL.HLP 
: r::J CALENDAR.EXE r::J D.BAT 
: D CALENDAR.HLP r::J DB. BAT 
: D CALENDAR.PCX l§l DEPTNEWS.W 
: r::J CARDFILE.EXE D DlGITAL.FON 
: D CARDFILE.HLP l§l FEATURE.WRI . - Document file / m m m : l§l CLiENTS.CAL D FEATURE1.PC)c. 

/~~G=am=eS===A=cc=es=sor=ieS==Wi=lnd=ow=s=AP~Pfi=,ca=tio~nsJ#~+~II:::~::::::~:::>~::::::~::::::~::::::~::::::~::::::~::.~.:::::~::::::~::::::~::::::~::::::~::::::~:::::~::::::~::::::~::::::~::::::~:::::+~:+~ 
+1 I:::::::::::::::::::::::::::::::::::::::::::::::::::::;:;:;:;:::::;:;:;:;:::::::::;:;:::::::::::::::::::::::1+ Selected 1 file(s) (38032 bytes) out of 09 

Group icon 

3. Locate and select the program file or the document file in File Manager for the 
item you want to add. 

Generally program files use .EXE and .COM extensions, but you can also 
move files with .BA T and .PIF extensions to Program Manager groups. 
(See Chapter 4, "File Manager," if you need help locating the appropriate files.) 

4. Drag the program or document file from File Manager to Program Manager 
and drop it in the group window or on the group icon. As you drag the file, the 
mouse pointer turns into a black and white replica of the file's icon. 

The preceding procedure has no keyboard equivalent. 
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r.> To add a program item to a group using Windows Setup: 

1. Start Setup from the Main Group. The Windows Setup dialog box appears. 

2. Select Options from the menu bar and choose Set Up Applications. You'll see 
the Set Up Applications dialog box. 

3. If you do not want Setup to search your entire hard disk for applications, open 
the drop-down list box and select the option you want Setup to search. Choose 
OK. 

Setup searches for available applications as you specified and lists the ones 
Windows recognizes in the list box for Applications found on hard disk(s). 

, Set Up Applications 

Applications found on hard disk(s): 

dBASE III Plus 
DESIGNER 
GRAPH 

icrosoft Excel 
Word Perfect 
Microsoft Basic 
Microsoft Advanced Basic 
Microsoft Works 

iI Microsoft Excel 
C:\WINDOWS\EXCEL 

Setup for use with Windows. 

Microsoft Word 

Add -) 

1<- Remove I 

MdAIl I 

,-I __ O_K_----J1 1 Cancel 

4. Select as many applications as you want to add from the list box on the left. 

If you are using a mouse, click to select each one. (You can click a selected 
application again to clear the highlight.) 

With the keyboard, use the DIRECTION keys to move to the next application 
you want and press the SPACEBAR to select it. (Y ou can press the SPACEBAR 
again to clear the selection.) 

5. After you select all the applications you want, choose Add to mov ~ the 
selected application(s) from the list box on the left to the list box on the right. 

If you change your mind about setting up an application after you add it, select 
it again and choose Remove to move it back to the list box on the left. 

6. Choose OK. 

Setup adds a program item icon for each application you selected to either the 
Windows Applications Group or the Non-Windows Applications Group, as 
appropriate. 
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Deleting a Program Item from a Group 
You can delete a program item from a group easily. Deleting it does not remove 
the application from your disk; it only removes the program item icon from the 
group window. 

[> To delete a program item from a group: 

1. Open the group window that contains the item you want to delete. 

2. Select the program item icon for the item. 

3. Choose Delete from the File menu. 

Program Manager displays a confirmation message. 

4. Choose Yes. 

Copying Program Items from One Group to Another 
The easiest way to copy a program item from one group to another is to drag the 
program item icon with the mouse and drop it on the other group icon or in the 
other group window. If you don't have a mouse, you can use the Copy command 
on the File menu. 

[> To copy a program item to another group: 

Mouse 1. If you don't care about the placement of the new program item icon in the 
group window, open the group window that contains the program item icon 
you want to copy and leave the destination group an icon. 

If you do want to place the new program item icon in a particular location in a 
group window, open the group windows for both the source and the destination. 

2. Hold down CTRL and drag the program item icon from its current location to 
the destination group's icon or window. 

The mouse pointer changes into a black and white copy of the program item 
icon you are copying. 

3. When the copied icon is on top of the destination group's icon or inside the 
destination group's window, release the mouse button and the CTRL key. 
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J(eyboard I. Open the group window that contains the program item you want to copy. 

2. Use the DIRECTION keys to select the program item icon. 

3. Choose Copy from the File menu. 

4. Select the name of the group you want to copy the program item to. 

5. Choose OK. 

HINT You can create a duplicate program item within a group. Hold down CTRL while you 
drag the icon and drop it in the source group window. Or with the keyboard, you can select 
the source group name from the To Group list in the Copy Program Item dialog box. 

Moving Program Items to Another Group 
Like copying a program item, moving one is easiest if you have a mouse, since 
you can simply drag the program item icon to the other group icon or group win
dow. If you don't have a mouse, you can use the Move command on the File 
menu. 

t> To move a program item to another group: 

Mouse 1. Open the group window that contains the program item you want to move. 

2. Drag the program item icon to the destination group's icon or window. 

The mouse pointer changes to a black and white image of the program item 
icon you are moving. 

3. When the program item icon is on top of the destination group's icon or inside 
the destination group's window, release the mouse button. 

J(eyboard 1. Open the group window that contains the program item you want to move. 

2. Use the DIRECTION keys to select the program item icon. 

3. Choose Move from the File menu. 

4. Select the name of the group you want to move the program item to. 

5. Choose OK. 
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Changing the Properties of Program Items 
At any time, you can change the description, program filename, related document 
filename, or icop for an item in a group. These elements are called the properties 
of the item. 

[> To change the properties for a program item: 

1. Select the program item icon. 

2. Choose Properties from the File menu. 

3. Make any desired changes. 

4. Choose OK. 

Starting. Applications from Program Manager 
Grouping applications with Program Manager makes finding and starting an appli
cation easy. You can also start applications from File Manager. See "Starting 
Applications from File Manager" in Chapter 4 for instructions. 

Starting Applications from Groups 

Whenever an application is represented by a program item icon in a group, the eas
iest way to start the application is to choose the program item icon from the group 
window. If you included a document with the program item, it appears in the appli
cation workspace. See "Adding Program Items and Documents to a Group" earlier 
in this chapter. 

[> To start an application from a group: 

1. Open the group window that contains the program item icon for the application. 

2. Double-click the icon. 

Or use the DIRECTION keys to select the icon; then press ENTER. 

When you start an application, Program Manager changes the current directory to 
the directory that contains the application, as you specified when you added the 
program item to the group. You can change this directory by specifying a different 
directory in the Command Line text box as explained earlier in this chapter. Non
Windows applications can override this directory change if you specify an initial 
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directory in their program information files (PIFs). See Chapter 12, "More About 
Applications," for more information. 

You can set Program Manager to shrink to an application icon whenever you start 
an application. This is useful because the icon remains visible at the bottom edge 
of the desktop when most applications are running, making it easy to find when 
you want to switch back to Program Manager. 

[> To shrink Program Manager to an icon whenever you run an application: 

o Choose Minimize on Use from the Options menu. 

A checkmark ("') appears beside the text for this command when it is active. To 
cancel the command, choose it again. 

Returning to Program Manager from Applications 

When you are working with an application or document and want to start a 
different application, you can do so by either returning to Program Manager or 
using File Manager. See "Starting Applications from File Manager" in Chapter 4 
for instructions about using File Manager. 

[> To return to Program Manager from an application: 

Mouse 0 Click the Program Manager window or double-click the Program Manager icon. 

If the Program Manager window is not visible, press ALT + ESC repeatedly 
until you reach it. 

f(eyboard D Press ALT + ESC repeatedly to cycle through open application windows and ap
plication icons until you reach Program Manager. 

If Program Manager appears as an icon, press ALT, SPACEBAR to open its 
Control menu. Then press ENTER to restore it to a window. 

You can also use Task List to return to Program Manager. Press CTRL + ESC to 
display Task List and choose Program Manager from the list of running appli
cations. See Chapter 2, "Basic Skills," for more information about using Task 
List to switch among applications. 
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Quitting Program Manager 
Even when you run applications, Program Manager remains running in the back
ground. You quit Program Manager only when you are ready to quit Windows. 

[> To quit Program Manager (and Windows): 

1. Quit all applications that are running, if any. 

2. Choose Exit Windows from the File menu. 

Windows displays a confirmation dialog box, asking if you're sure you want to 
end this Windows session. 

3. If you want to save the arrangement of Program Manager's group windows 
and icons, make sure the Save Changes check box contains an X. 

If you select the Save Changes box, then the next time you start Windows, the 
Program Manager workspace will look just as it did when you last used it. 
Everything you added, deleted, or changed during that last session will be 
permanent until you make more changes to the Program Manager workspace 
and save your changes again. 

4. Choose OK. 
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What Is File Manager? 
Microsoft Windows File Manager, like Program Manager, is new to Windows 3.0. 
It replaces the MS-DOS Executive found in previous versions of Windows. 

File Manager is a powerful tool that can help organize your files and directories. 
A directory is a collection of files stored under the same name. You can use File 
Manager to view all your files and directories and then build a structure of those 
files and directories that makes the most sense to you. You can also start applica
tions from File Manager. 

If you work with many applications and store a large number of files, as most 
Windows users do, you will find it easier to keep track of these files if you main
tain a logical and orderly directory structure. 

By storing related files in their own directories, you can develop a filing system 
that works for you. For example, you might store all memos and letters in one 
directory, and budget spreadsheets in another. Or, if your business is project 
related, you might keep files for each project in individual directories. 

As you work with File Manager to organize and manipulate your files and directo
ries, you will work with two kinds of windows: 

• The Directory Tree window, which contains the Directory Tree. The Directory 
Tree shows you the overall organization of directories and subdirectories on 
any disk drive. Directories are shown as branches off the top-level directory, 
which is known as the root directory. 

• Any number of directory windows. Each directory window shows the contents 
of a selected directory. From directory windows you can move, copy, delete, 
and rename files and directories. You can also start applications from directory 
windows. 

Starting File Manager 
The first time you start Windows, the program item icon for File Manager appears 
in the first position in the Main Group window of Program Manager. You start 
File Manager the same way you start other applications. 
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I> To start File Manager: 

[] Double-click the File Manager program item icon. 

Or press the LEFf or RIGHT ARROW key to move the highlight to the File 
Manager program item icon. Then press ENTER or choose Open from the File 
menu. 

File Manager displays the Directory Tree window for your current disk drive. 

NOTE If you find that you run applications from File Manager most of the time, you can 
change your Windows initialization (.INI files) settings so that File Manager, instead of 
Program Manager, appears whenever you start Windows. For instructions about changing 
the Shell= line, start Notepad (or any other text editor) and open SYSINI,TXT. 

Working with the Directory Tree 
The Directory Tree window shows the structure of your directories and subdirecto
ries on any disk drive. The directory structure resembles a tree. The tree begins 
with the root directory, the first directory on a disk drive. The root directory is 
created when you format a disk. It is represented by a backslash (\). In other 
words, C:\ is the root directory for drive C. The root directory and each directory 
that you create from the root can contain more directories. 

From the Directory Tree window, you can open directory windows to list files and 
subdirectories for your individual directories. You can also select different disk 
drives to view their directory structures. You can open as many directory windows 
as you like. However, only one Directory Tree window can be open at a time. 

The Directory Tree window and its elements are shown in the following 
illustration. 
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Scroll bar 

The Directory Tree window contains the following parts: 

• The disk-drive icons represent the disk drives on your computer. A drive letter 
follows each icon. The highlighted icon and letter represent the current disk 
drive. Different icons are used to represent the hard disk drives and floppy 
diskette drives on your computer, network disk drives you are connected to, 
RAM drives you may have set up in your computer's memory, and CD-ROM 
drives. 

• The volume label is the name that identifies your disk; it appears in square 
brackets ([ ]) in the status line below the drive icons. You see this information 
only if you have assigned a label to your disk. 

• The directory path for the Directory Tree window appears in the status line 
below the drive icons. The directory path for a directory window appears in the 
title bar for each directory window. 

• The current directory is the directory that is highlighted in the Directory Tree 
window. File Manager commands affect this directory. 
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• The directory icons represent each directory on your computer. Directories are 
listed in alphabetical order beneath the root directory (\). Directory icons are 
joined to the root directory by a vertical line. If a directory contains subdirecto
ries, a plus sign (+) appears inside the directory icon. When listed, subdirectory 
icons are shown beneath directories and are connected to the appropriate 
directory by a vertical line. 

• A scroll bar appears if there are more directories and subdirectories than will 
fit in the Directory Tree window. 

The Directory Tree window is a document window . You can resize and move this 
window in the File Manager workspace. You can enlarge it to fill the entire File 
Manager workspace or you can shrink it to an icon. 

Changing Disk Drives 

When you start File Manager, the Directory Tree shows the directory structure on 
the current disk drive. You can tell which disk drive is current because its icon and 
letter are highlighted. 

Select another disk drive icon to display the directories on that disk. 

[> To select another disk drive and display its Directory Tree: 

Mouse [] Click the disk-drive icon for the drive you want. 

f(eyboard 1. Press TAB to move to the disk-drive icon area. 

If you want to move back to the Directory Tree window without changing 
drives, press TAB again. 

2. Press the DIRECTION keys to select the icon you want and then press ENTER. 

HINT If you are using a keyboard, you can hold down CTRL and press the letter for the 
disk drive you want to select. 

Using Network Disk Drives 

If you are connected to a network, you can use any disk drive on the network if 
you know its location and password. Some networks will even allow you to 
browse through all the available disk drives. 

When you start Windows, it recognizes network connections you already made 
and shows the network drives as distinct icons, different from other drive icons. 
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NOTE When you select the disk drive icon for the network, the path appears in the status 
bar at the bottom of the File Manager application window. 

Connecting to and Disconnecting from Network Drives 
You can use File Manager to connect to additional network disk drives or to dis
connect from disk drives to which you are currently connected. You must connect 
to the network before you start Windows or the network options will be dimmed. 

[> To connect to a network disk drive: 

1. Choose Connect Net Drive from the Disk menu. 

The Connect Network Drive dialog box appears. File Manager assumes you 
want to assign the next available letter and enters that letter in the Drive Letter 
drop-down list box. 

Connect Network Drive 

!!rive Letter: Imll:!: I 
Nelwork Palh: 1""1 ~"-------------, 

Pass!!ord: 1'----____ ----' 
[gJ Add 10 Previous Lisl 

!;onnecl I I Cancel I I frevious... II .!~WWMl ... 

2. If you want to assign a different drive, open the Drive Letter drop-down list 
box and choose the letter you want. 

Or you can type the drive letter in the Drive Letter text box. 

3. Type the network pathname required to locate the drive, and type the password 
(if a password is required). 

File Manager will maintain a list of previous connections if you want. Then 
you can select a connection from the Previous list rather than typing the net
work path. To select from the Previous list, choose Previous. The Previous 
Network Connections dialog box appears. Select the path you want from the 
list. 

4. If this is a new connection and you want to add it to the Previous list, make 
sure the Add to Previous List check box contains an X. 

5. Choose Connect. 
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NOTE Some non-Windows applications let you connect to network drives while running 
the application. If you make such a connection, you should disconnect from the network 
drive before quitting the application. 

[> To disconnect from a network drive: 

1. If your current drive is also the network drive, choose a different drive. You 
cannot disconnect the current drive. 

2. Choose Disconnect Net Drive from the Disk menu. 

The Disconnect Drive dialog box appears. 

3. Select the network drive you want to disconnect. 

A message appears, asking you to confirm the drive that you want to 
disconnect. 

4. Choose OK. 

NOTE If you are running Windows in 386 enhanced mode, you might not be able to dis
connect from network drives that were active before you started your Windows session. 

Browsing Through Network Disk Drives 
Some networks allow you to browse through the drives on the network until you 
find the one you want. If your network does not provide this capability, the 
Browse button in the Connect Network Drive dialog box will be dimmed. 

[> To view the available network drives: 

1. Choose Connect Net Drive from the Disk menu. 

2. Choose Browse. 

File Manager displays a dialog box that lists the available drives. This dialog 
box will look different for different networks. 
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For example, if you are using the Microsoft LAN Manager version 2.0, the 
dialog box will look like the following illustration. 

Network Disk Resources 
Help 

Qomain: /HEADQTRS /~/ 

Nelwork Selvels: 

ADMINSTR 
EXECUTIVE .... . 
ftesoulces al \\PRODUCTION: 

•• 
RECORDS 
SALElIST 
USERS 

Adminisllalive lecolds 
Maslel dalabase lisls 
Logon selvel shale 

OK 

Cancel 

3. To view the shares on another network server, click the network server name 
from the Network Servers list box. 

Or use the DIRECTION keys to move the highlight to the network server name. 

4. To specify a connection to one of the listed shares, select the share from the 
Resources list box. 

5. Choose OK. 

The Connect Network Drive dialog box appears. 

6. Choose Connect. 
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Changing Directories 

The selection cursor, a dotted rectangle around the highlighted icon and text, 
marks the current directory in the Directory Tree window. 

MAIL 
MANAGERS 
MEMOS 
MOUSEl 
PRACTICE 
PROJECTl 
PROJECT2 

Current directory 

You can select only one directory at a time in this window. To change to a 
different directory, you move the selection cursor. 

l> To select another directory: 

Mouse D Click the directory name that you want to select. 

J(eyboard D Use the following keys to select a directory. 

To move to 

A directory above or below the cur
rent directory 

The root directory 

The last directory in the list 

The first subdirectory of the current 
directory, if one exists 

The next directory level up from the 
current directory, if one exists 

The directory one window up from 
the current directory 

Press 

UP or DOWN ARROW 

HOME 

END 

RIGHT ARROW 

LEFT ARROW 

PAGE UP 



To move to 

The directory one window down 
from the current directory 

The previous directory at the same 
level, if one exists 

The next directory at the same level, 
if one exists 

A specific directory name 

Expanding Directory Levels 
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Press 

PAGE DOWN 

CTRL + UP ARROW 

CTRL+ DOWN ARROW 

The first letter of the directory name 

You can control the level of directory information shown in the Directory Tree 
window. When you first start File Manager, the Directory Tree shows the first 
level of directories on the current disk drive. You use the commands on the Tree 
menu to expand and reduce the directory information shown. 

In the following Directory Tree illustration, you will see that one directory icon 
contains a plus sign (+). A plus sign indicates that one or more subdirectories exist 
for that directory. 

MAIL 
Ll MANAGERS 
LlMEMOS 
Ll MOUSEl 
Ll PRACTICE 
Ll PROJECTl 
Ll PROJECT2 
Ll REPORTS 

Expandable directory 

If you select a directory icon that contains a plus sign, File Manager lists the 
subdirectories. This is called expanding the directory. You can expand an entire 
branch, a single level of the branch, or all branches. The directory icon for an 
expanded directory contains a minus sign (-). 
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[> To expand one level of a directory: 

Mouse D Click the plus sign ( +) in the directory icon next to the name of the directory 
you want to expand. 

I(eyboard 1. Use the DIRECTION keys to select the directory you want to expand. 

2. Choose Expand One Level from the Tree menu. 

Or press the PLUS (+) key. 

You use the Expand Branch command to show all directory levels beneath a 
selected directory. 

[> To expand an entire branch: 

1. Select the directory you want to expand. 

2. Choose Expand Branch from the Tree menu. 

Or press the ASTERISK (*) key. 

You use the Expand All command to display all directory levels in the Directory 
Tree at once. 

t> To expand all branches in the Directory Tree: 

D Choose Expand All from the Tree menu. 

Or press CTRL + ASTERISK (*). 

Collapsing Directory Levels 

You can collapse a directory to retract any listed subdirectories. The minus sign (-) 
changes to a plus sign (+) next to the directory name. All directories are collapsed 
when you start File Manager. 
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Collapsible directory 

t> To collapse a directory: 

Mouse 0 Click the minus sign (-) in the directory icon next to the name of the directory 
you want to collapse. 

/(eyboard 1. Use the DIRECTION keys to select the name of the directory you want to 
collapse. 

2. Choose Collapse Branch from the Tree menu. 

Or press the HYPHEN (-) key. 

Only the directory names are displayed, no subdirectories. The minus sign (-) 
changes to a plus sign (+) to indicate that the additional levels are available. 

Working with Directory Windows 
The Directory Tree window shows you the overall structure of your directories. 
From the Directory Tree window you can open directory windows. 

A directory window is a document window. You can resize and move this window 
in the File Manager workspace. You can enlarge it to fill the entire File Manager 
workspace or you can shrink it to an icon. 

From a directory window, you can list the contents of other directories, change the 
information you see, and reorder the files that are listed. 
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Opening Directory Windows 

To view the contents of a directory, you must open its directory window. More 
than one directory window can be open at a time. The number of directory win
dows you can have open depends on available memory. 

Directory windows open in front of the Directory Tree. Subdirectories and all the 
files in a selected directory are listed in its window. 

The disk drive and pathname appear at the top of the window in the title bar. The 
pathname shows the location of the directory in relation to the root directory. 
Directories in the pathname are separated by backslashes (\). 

From a directory window, you can open windows for any of the directories 
displayed and work with the various files and directories included. 

t> To open a directory window: 

D In the Directory Tree window or a directory window, double-click the directory 
name. 

Or press UP ARROW or DOWN ARROW to select the directory you want to open. 
Then press ENTER or choose Open from the File menu. 

Disk drive and pathname 

1ii----c;NI-n ... -.... --------aiil 
E:l[ .. ] 
~VI.BAK 

VI.BAT 
L::JVI.EXE 
~VI.INI 
~VI.OLD 

The icon to the left of the filename indicates whether the file is a directory, a pro
gram file, a document file, or another type of file. The table that follows describes 
the various icons you'll see in directory windows. 
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Kind of file 

Directories. These are listed first, in alphabetical order. 

Program files and batch files. The default filename exten
sions are .EXE, .COM, .PIF, and .BAT. These files can 
start up applicat'ions. 

Document files. These files are associated with an 
application. When you choose these files, they start up the 
application and load the associated document into the 
application workspace. 

All other files. 

NOTE You can change the default for an icon by modifying the WIN.INI file, a special 
initialization file that contains the default settings Windows uses throughout its operation. 
To learn about changing Windows initialization settings, start Notepad (or any other text 
editor) and open the WININI,TXT file. 

Selecting Open Directory Windows 

Although many directory windows can be open on your desktop at a time, only 
one of those windows can be active. A directory window must be active before 
you can work in that directory. To make an inactive window active, you select it. 

t> To select an open directory window: 

Mouse D Click anywhere in the window. 

Or choose a window from the list at the bottom of the Window menu. 

f(eyboard 1. Press ALT, HYPHEN (-) to open the Control menu. 

2. Press T to choose Next. 

3. Repeat steps 1 and 2 until you select the window you want. 

Or you can select the window you want from the list at the bottom of the 
Window menu. Then press ENTER to open the window. 

HINT To cycle quickly through the open directory windows, press GTRL + F6 
(or GTRL + TAB) until the window you want appears. 
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When the window is selected, the title bar changes color or intensity and the win
dow moves in front of the other open windows. 

HINT If the window you want to select is hidden by another window, you can use the 
Cascade or Tile command (on the Window menu) to rearrange the open File Manager 
windows so that all of them are visible. You can also move or resize any windows that are 
covering the window you want. . 

I 

Replacing the Contents of the Active Directory Window 

As you open directory windows, each appears in front of other directory windows 
that are already open. If you want, you can tell Windows to replace the contents of 
the active directory window whenever you want new directory information. That 
way, fewer directory windows are open at a time. 

I> To replace the contents of the active directory window: 

D Choose Replace on Open from the View menu. (A checkmark appears next to 
the command when it is active.) 

You can cancel the command at any time by choosing it again. 

Only the contents of the active directory window are replaced. Other open 
directory windows remain open. Their contents are not altered. 

Changing the Information Displayed in Directory Windows 

When you first use File Manager to display a directory window, filenames are 
listed in alphabetical order. You can change the order of the files and list details 
about them by using commands from the View and Options menus. 

If the Directory Tree window is active when you choose a command on the View 
menu, the directory windows you open afterward will be affected. Directory win
dows that are already open will not change. 

If a directory window is active, most View commands will affect only that 
window. However, three commands on the View menu-Other, Sort By, and 
Include-provide an option called Set System Default. When you select Set 
System Default, File Manager uses your choices in the dialog box as the new 
settings for all directory windows you open subsequently. 

NOTE To save the new settings, make sure the Save Settings check box in the Exit File 
Manager dialog box contains an X when you exit File Manager. 
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Changing the Information Displayed for Each File 
You can use the first three commands on the View menu to tell File Manager what 
kind of information to display in the directory window. File Manager can display 
all file information, the names of the files and directories only, or selected 
information. 

When you first start File Manager, the Name command is checked. This means 
that only file and directory names appear in a directory window. 

r> To change the information displayed for each file: 

1. Select the directory window whose file information you want to change. 

2. Choose Name, File Details, or Other from the View menu. 

If you choose Name or File Details, the change takes place immediately. If you 
choose Other, the View Other dialog box appears. 

View Other 

Details--------, 
Df!:i'i"z'el 
o L~'~t' Modification Date 
o Last Modification Time 
o file Attributes -

o Set System !lefault 

OK I I"---C-an-ce-I--' 

3. Select the options for the information you want to display. The table that 
follows describes each option. If you want these same options to apply to all 
other directory windows you open, make sure the Set System Default check 
box contains an X. 

4. Choose OK. 

You can select the following options from the View Other dialog box: 

Use this option 

Size 

Last Modification 
Date 

To do this 

Show the size of each file in bytes. 

List the date the file was last modified. 
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Use this option 

Last Modification 
Time 

File Attributes 

Set System Default 

To do this 

List the time of day the file was last modified. (The 
time and date are taken from the system clock.) 

Indicate whether files are hidden, read-only, archive, or 
system files. (See "Setting File Attributes" later in this 
chapter.) 

Make the options selected in this dialog box apply to all 
directory windows you open. Otherwise, the change 
will apply only to the active directory window. To save 
these settings, make sure you select the Save Settings 
check box when you exit File Manager. 

If the Directory Tree window is active when you choose the Other command, the 
settings you specify become the new system settings. 

If a directory window is active, then the settings affect only the active window un
less the Set System Default check box contains an X. If you select this option, the 
new settings affect the active window and any subsequent windows you open. 
Directory windows that are already open remain unchanged. 

Choosing the Order in Which Files Are Displayed 
When you first open directories, File Manager displays the contents of each 
directory with subdirectories listed first and then all the files, sorted alphabetically 
by filename. You can change this by telling File Manager to sort by file type, size, 
or last modification date. 

If the Directory Tree window is active when you choose a sort command, the set
tings you create with the command become the new system settings. If a directory 
window is active, then the settings affect only the active window unless you select 
the Set System Default check box. If you select this option, the new settings affect 
the active window and any subsequent directory windows you open. 

You can sort files according to file type. This means that files are sorted alpha
betically according to their extension-the last three characters of the filename. 
For example, files ending with .COM would appear before files ending with .EXE. 
You can also sort files based on other file information such as the date each file 
was created. 
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I> To change the order of sorting in a directory window: 

1. Select the directory window whose order of sorting you want to change. 

2. Choose By Name, By Type, or Sort By from the View menu. 

If you choose By Name or By Type, the change occurs immediately. If you 
choose Sort By, the Sort By dialog box appears. 

o Si~e 
o Las! M.odification Date 

D ~et System Default 

OK I Cancel I 

3. Select one of the options. If you want these sort options to apply to all 
subsequent directory windows that you open, also make sure the Set System 
Default check box contains an X. The table that follows describes each option. 

4. Choose OK. 

You can select the following options in the Sort By dialog box: 

Use this option 

Name 

Type 

Size 

Last Modification 
Date 

Set System Default 

To do this 

Sort by filename, in alphabetical order. 

Sort by extension, then by filename prefix, in alpha
betical order. 

Sort by file size, from largest to smallest. 

Sort by the date when the file was last modified, with 
the most recently modified file listed first. 

Make the options selected in this dialog box apply to all 
directory windows you open. Otherwise, the change 
applies only to the active directory window. To save 
these settings, make sure you select the Save Settings 
check box when you exit File Manager. 
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Choosing the Type of File to Display 
When you first use File Manager, it displays all the files and directories in each 
directory window. You can tell File Manager to display certain types of files, or 
groups of files with similar filenames and/or extensions. 

[> To change the type of files displayed in the directory window: 

1. Select the directory window whose list you want to change. 

2. Choose Include from the View menu. 

The Include dialog box appears. 

Include 

Harne: l=iiI=--____ --' 
File Type 

t8J Qireclories 

t8J frograms 

t8J Docu!!!.ents 

t8J !!ther Files 

D Show !::!.idden/Syslem Files 

D ,S.el System Default 

OK I I Cancel I 

3. Select the options that specify which files you want to display. If you want 
these options to apply to all subsequent directory windows, also select Set 
System Default. The table following this procedure describes each option. 

4. Choose OK. 
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You can select the following options in the Include dialog box: 

Use this option 

Name 

File Type 

Show Hidden/System 
Files 

Set System Default 

To do this 

Display files with similar names. Use MS-DOS 
wildcard characters to specify a group of files. You 
could, for example, display only those files with the 
filename extension .TXT by typing *.TXT in this 
box. The default is *. *, meaning all files in the 
directory. (For more infonnation on using wildcard 
characters, see your MS-DOS manual.) 

Choose the types of files you want to display. The 
Directories option displays all the subdirectories 
this directory contains. The Programs option dis
plays all files that have .EXE, .COM, .PIF, or .BAT 
extensions. The Documents option displays text and 
graphics files that are associated with an applica
tion. The Other Files option displays everything 
else. 

Display all files for which the system or hidden file 
attribute is set. See "Setting File Attributes" later in 
this chapter. 

Make the options selected in this dialog box apply 
to all directory windows you open. Otherwise, the 
change will apply only to the active directory win
dow. To save these settings, make sure you select 
the Save Settings check box when you exit File 
Manager. 
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Choosing Other Display Options 
File Manager lets you make a few other, more minor changes to the way your File 
Manager windows appear on the desktop. 

t> To change the display options: 

D Choose any of the following commands from the Options menu. 

Use this command 

Lower Case 

Status Bar 

Minimize on Use 

Arranging Directory Windows 

To do this 

Change the information in the directory window 
between uppercase letters and lowercase letters. 

Tum the status bar (at the bottom of the directory 
window) on and off. In a directory window, the 
status bar displays the number of files selected, 
the disk space occupied by them, and the total 
number of items listed in the window. In the 
Directory Tree, the status bar shows the number 
of bytes available on the disk drive. When the 
active drive is a network drive, the status bar also 
shows the network pathname for the drive. 

Shrink File Manager to an icon whenever you run 
an application from a directory window. 

The Window menu includes two commands, Cascade and Tile, to help you 
organize the way File Manager windows appear on your screen. These commands 
affect the Directory Tree window and any open directory windows. 

[> To arrange the open File Manager windows: 

D Choose Cascade or Tile from the Window menu. 

If you choose Cascade, File Manager arranges the windows so that they over
lap, starting in the upper-left comer of the File Manager workspace. Each win
dow's title remains visible, making it easy for you to select any window. 

If you choose Tile, File Manager resizes and arranges the windows to fit in the 
File Manager workspace so that each window's contents are visible and no 
windows overlap. 
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Updating Directory Windows 
File Manager updates open directory windows automatically, in most cases. For 
example, if you save a file using Notepad, the file will show up immediately in the 
proper directory window. Sometimes, however, especially if you are using net
work directories, File Manager cannot complete an automatic update. In that case, 
you can use the Refresh command to update the active directory window. 

[> To update a File Manager window: 

D Choose Refresh from the Window menu. 

Closing Directory Windows 

[> To close the active directory window: 

D Double-click the Control-menu box. 

Or press ALT, HYPHEN (-) and choose Close from the Control menu. 

[> To close all the open directory windows: 

D Choose Close All Directories from the Window menu. 

Working with Files and Directories 
This section explains how to use File Manager commands to work with your files 
and directories. With a few exceptions, all the tasks described in this section apply 
to both files and directories. The exceptions are creating a directory, printing a file, 
and viewing file information. These topics are discussed separately. 

You can also work with files and directories individually or in groups. When the 
instructions tell you to select a file or directory, you can select as many files and 
directories as you want. See "Extending a Selection" later in this section. 



122 Working with Files and Directories 

Naming Files and Directories 

Many File Manager tasks involve naming or renaming files and directories. 
Windows follows the rules of MS-DOS for naming files: 

• The name of a file or directory can have two parts: a name and an optional 
extension. The two parts are separated by a period (.). For example, 
MYFILE.NEW is a valid filename, where MYFILE is the name of the file 
and .NEW is the filename extension. 

• The name can be up to eight characters and the extension up to three characters. 

• Names must start with either a letter or a number and can contain any upper
case or lowercase characters except the following: 

. (period) 

/ (slash) 

[ ] (brackets) 

; (semicolon) 

= (equal sign) 

" (quotation mark) 

\ (backslash) 

: (colon) 

I (vertical bar) 

, (comma) 

• The following cannot be used as names: CON, AUX, COMl, COM2, COM3, 
COM4, LPTl, LPT2, LPT3, PRN, and NUL. 

Examples of valid filenames are: 

LETTER. DOC 
MEMO.TXT 
BUDGET.89 
2NDTRY.RPT 

Creating Directories 

You can create a new directory by using the Create Directory command. File 
Manager creates a subdirectory in the current directory. If the Directory Tree 
window is active, the current directory is the one that is selected. 

After you create a directory, you can copy files and directories into it from other 
locations by using the Move and Copy commands. See "Moving and Copying 
Files and Directories" later in this chapter. 
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t> To create a new directory: 

1. Select the directory in which you want the new directory. 

2. Choose Create Directory from the File menu. 

The Create Directory dialog box appears. 

Create Directory 

Current dilectolY is C:\ 
Harne: r:-U------------, 

OK Cancel 

3. Type the name for the new directory and choose OK. 

Directory names follow the same conventions as filenames. They can have up 
to eight characters followed by a period and an extension of one to three 
characters. 

Searching for Files and Directories 
When you want to find a file or directory but can't remember where it is located, 
you can use the Search command. By using MS-DOS wildcard characters, you can 
search for a group of files or directories that have related filenames or extensions. 

For example, if you name all your correspondence with an .L TR extension, you 
can tell File Manager to search for * LTR. File Manager will list every letter 
(.LTR) file on the current disk. 

If files are found that match the information you specified, the filenames are listed 
in the Search Results window. You can select items in this window and use most 
File Manager commands, just as you would in any directory window. However, 
you cannot copy or move other files into the Search Results window. 

t> To search for a file or directory: 

1. Select the disk drive and the directory you want to search. 

2. Choose Search from the File menu. 

File Manager displays the Search dialog box. 
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Search 

Current directory is C:\ 
Search Eor: r:-U ---------------, 

['8J Search E.ntire Disk 

OK Cancel 

3. Type the name of the file or directory, using wildcard characters if you want to 
search for a group of files or directories with similar names or extensions. 

Examples: 

Type this 

filename. ext 

*.abc 

To find these files 

The file with the name you typed 

All files with the extension .ABC 

4. File Manager will search the entire disk drive. To search the current directory 
and its subdirectories, make sure the Search Entire Disk check box is empty. 

5. Choose OK. 

File Manager begins searching at the root directory (or, if you canceled Search 
Entire Disk, at the current directory) and searches through all branches of the 
Directory Tree for the current disk drive. It displays a window called Search 
Results that lists all the files and directories it found. 

Iii iI 
~C:\ALL.BAT '. .. '. .. '[I 

L'j C:\AUTOEXEC.BAT 
L'j C:\BIN\CHANGE.BAT 
L'j C:\BIN\DODlFF.BAT 
L'j C:\BIN\INDCHECK.BAT 
L'j C:\BIN\INDPAGE.BAT 
L'j C:\BIN\NETGO.BAT 
L'j C:\BIN\PIX2MSP.BAT 
L'j C:\BlNWI.BAT 
L'j C:\DOS\AUTOEXEC.BAT • 

The Search Results window looks like a directory window except that the full 
pathname for each file and directory is always included. You cannot change the 
way this information is displayed. Nor can you move or copy files into the Search 
Results window. 
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However, you can select files and directories in the window and use File menu 
commands to print, copy, and move window contents. You can also shrink the 
Search Results window to an icon. The Search Results window is listed in the 
Window menu, along with the other open windows. 

The Search Results window remains open until you close it or shrink it to an icon. 
The contents of the Search Results window are replaced when you use the Search 
command again. 

Selecting Files and Directories 

Before you can work with a file or a directory, you must select one. 

t> To select a file or directory: 

Mouse 0 Click the filename or directory name. 

f(eyboard 0 Use the following keys to select files and directories: 

To select 

A file or directory above or below 
the current selection 

The last file or directory in the list 

The first file or directory in the list 

The file or directory at the top of the 
previous window 

The file or directory at the bottom 
of the next window 

A specific file or directory in the list 

Extending a Selection 

Press 

UP or DOWN ARROW 

END 

HOME 

PAGE UP 

PAGE DOWN 

The first letter of the name until you 
reach the file or directory you want 

In directory windows, you can select more than one file or directory at a time. 
Selecting more than one item in a directory window is called extending a selection. 
For example, you can select several files and move them to another directory. You 
can select a group of files or directories that appear in consecutive order or that are 
scattered throughout the list. 
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[> To select two or more items in sequence: 

Mouse 1. Click the first filename or directory name you want to select. 

2. Hold down SHIFf while you click the last item in the group. 

E::J [oo] 
D FULL.STY 
D HP2000.GL Y 
D HYPH.DAT 
D KEYLES.CHK 
D KEYONE.ClX 
D KEYONE.SCN 
D KEYONE.SOB 
D KEYTWO.ClX 
D KEYTWO.SCN 
D KEYTWO.SOB 
Ll LEARN.COM 

Ll LEARN.PIF 
DLW.PGM 
.MACRO.GLY 
!I!iiJ MAKE PRD.EXE 
.MEMO.GLY 
!I!iiJ MERGEPRD.EXE 
DMW.HLP 
~MW.lNI 
DMW.PGM 
D MW014681.TMP 
D MW163658.TMP 
D MW181473.TMP 

+ ::::::::::::: ............. :.:.:.:.:.:.: ....... :.:::::.:.:.;.;.:.;.:.:.;.:.:.;.;. 

D MW215729.TMP 
D MW504525.TMP 
D MW512320.TMP 
D OUTLlNE.STY 
~ POSTSCRLlNI 
D POSTSCRL.PRD 
~ POSTSCRP.lNI 
D POSTSCRP.PRD 
D README.DOC 
D SAMPLE.STY 
D SEMI.STY 
D SIDEBY.STY 

f(eyboard 1. Press the DIRECTION keys to move to the first item you want to select. 

2. Hold down SHIFf while you press the DIRECTION keys to select the remaining 
items in the group. 

You can also extend the selection to items that are not in consecutive order. 

[> To select two or more items out of sequence: 

Mouse D Hold down CTRL while you click each item. 

Iii iii1 
E::J [oo] Ll LEARN.PIF D MW215729.TMP Ll 

I ~D~F~U~LL;.S~TY~ .. IIII~D~LW~.P~G~M~~II~ED,M~W~50~4&52~5Q.T~MiP".~D D HP2000.GL Y • •• D MW512320.TMP LJ 

• •. Ll MAKEPRD.EXE • 
D KEYLES.CHK D MEMO.GL Y ~ POSTSCRLlNI D 
D KEYONE.ClX Ll MERGEPRD.EXE D POSTSCRL.PRD ~ 
D KEYONE.SCN D MW.HLP ~ POSTSCRP.lNI D 
D KEYONE.SOB ~ MW.lNI D POSTSCRP.PRD D 
D KEYTWO.ClX D MW.PGM D README.DOC Ll 
D KEYTWO.SCN D MW014681.TMP 
D KEYTWO.SOB D MW163658.TMP 
Ll LEARN.COM D MW181473.TMP 

• SAMPLE.STY 
D SEMI.STY 
D SIDEBY.STY 
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J(eyboard 1. Press and release SHIff + F8. 

The selection cursor begins to blink. 

2. Press the DIRECTION keys to move to each item. 

3. Press the SPACEBAR to select each item. 

4. Press SHIff + F8 again when you are finished extending the selection. 

You can also select more than one group of items by combining selection 
techniques. 

[> To select more than one group of items: 

Mouse 1. To select the first group of items, click the first item and then hold down SHIff 
while you click the last item in the group. 

2. To select the next group of items, hold down CTRL while you click the first 
item in the next group. Then hold down CTRL + SHIff while you click the last 
item in the group. 

J(eyboard 1. To select the first group of items, hold down SHIff while you press the 
DIRECTION keys to move from the first to the last item in the group. 

2. Press and release SHIff + F8. 

The selection cursor begins to blink. 

3. Press DIRECTION keys to move to the first item in the next group of items. 

4. Press the SPACEBAR to select the first item. 

S. Press SHIff + DIRECTION keys to select the remaining items in the group. 

6. Press SHIff + F8 again when you are finished extending the selection. 

[> To select all the files in a directory window: 

[J Choose Select All from the File menu. 

Or press CTRL + SLASH (/). 



128 Working with Files and Directories 

Canceling a Selection 

[> To cancel a selection: 

MOllse D Hold down CTRL while you click the item. 

J(eyboard 1. If you have not already done so, press SHIff + F8. 

The selection cursor begins to blink. 

2. Press DIRECTION keys to move to the item. 

3. Press the SPACEBAR. 

4. Press SHIff + F8 to cancel selection mode. 

[> To cancel all selections: 

D Choose Deselect All from the File menu. 

Or press CTRL + BACKSLASH (\). 

HINT If you want to select a group of files that have related filenames, first choose the 
command you want and then type MS-DOS wildcard characters in the dialog box to select 
the files you want. For example, to move all files with the extension .TXT to a new directory, 
choose Move from the File menu. When the dialog box appears, type *. TXTin the From text 
box and type the name of the new directory in the To text box. To learn more about MS-DOS 
wildcards, see your MS-DOS manual. 

Moving and Copying Files and Directories 

You can move and copy files and directories from one File Manager location 
(called the source) to another (called the destination) by dragging the source file or 
directory with the mouse or by using the Copy or Move command. You can copy 
and move items between directories, to and from the Directory Tree, and between 
disk drives. The destination can be a window or an icon. 
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If you use a mouse, the items you move and the destination (the window or icon) 
must both be visible. You can use the Tile command on the Window menu to 
arrange the windows. You can also copy program files and document files from 
File Manager to Program Manager groups if you use a mouse. 

In the Directory Tree window, you can select only one directory at a time. From a 
directory window, you can move or copy more than one file or directory at a time 
by extending your selection. See "Extending a Selection" earlier in this chapter for 
information about extending a selection in a directory window. 

[> To move files or directories: 

Mouse 1. Make sure the source and destination directories (or disk-drive icon) are 
visible. 

2. Hold down ALT while you drag the source file or directory to the destination 
window, icon, or disk drive. 

The mouse pointer changes to the icon for the file or directory and it moves out 
of the directory window as you slide the mouse. 

3. Release the mouse button, and then release ALT. 

A confirmation message appears. (You can suppress this confirmation message 
by selecting Confirmation from the Options menu as explained later in this 
chapter.) 

4. To complete the move, click Yes. 

HINT If you are moving files or directories to a destination on the same disk drive, you 
can simply drag with the mouse. You do not have to use the ALI key. 
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I(eyboard 1. Select the file or directory you want to move. 

2. Choose Move from the File menu. 

The Move dialog box appears with the name of the source file or directory in 
the From text box. 

Currenl dileclolY is C:\MOUSEl 

[10m: IMOUSE.COM 

Move 

10 :11 l!-__________ -' 

.Move Cancel 

3. Type the pathname for the destination in the To text box. 

4. Choose Move. 

A confirmation message appears. 

5. To complete the move, choose Yes. 

If the destination contains a file with the same name as the file you are moving, 
File Manager asks if you want to overwrite it. If you want to replace the existing 
file, choose OK. 

The file or directory disappears from its original location and appears in the desti
nation. If you move a directory, all the files and directories contained in it move 
with the directory. 

t> To copy files or directories: 

Mouse 1. Make sure the source and destination directories ( or disk-drive icon) are visible. 

2. Hold down CTRL while you drag the source file or directory to the destination 
window, icon, or disk drive. 

The mouse pointer changes to a copy of the icon for the file or directory. 

3. Release the mouse button, and then release CTRL. 

A confirmation message appears. (You can suppress this confirmation message 
by selecting Confirmation from the Options menu as explained later in this 
chapter.) 

4. To complete the copy, click Yes. 
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HINT If you are copying files or directories to a different disk drive, you can simply drag 
with the mouse. You do not have to use the GTRL key. 

I(eyboard 1. Select the file or directory you want to copy. 

2. Choose Copy from the File menu. 

The Copy dialog box appears. 

Cunent director}' is C:\MOUSEl 

[rom: IMOUSE.COM 

Copy . 

10: ,-I _________ ----' 

I;op}' Cancel 

3. Type the pathname of the destination in the To text box. 

4. Choose Copy. 

If the destination contains a file with the same name as the file you are copying, 
File Manager displays a warning message. Make sure you want to replace the 
existing file; then choose OK. 

The file or directory is copied to the destination and remains in the directory win
dow for the source directory as well. If you copy a directory, all the files and direc
tories contained in it are copied too. 

NOTE You can copy document files and program files from a directory window in File 
Manager to a group window or group icon in Program Manager by dragging with a mouse. 
See "Changing the Contents of a Group" in Chapter 3 for the complete procedure. 

Deleting Files and Directories 

You can delete files and directories from any disk drive. File Manager is much 
more powerful for deleting directories than MS-DOS. When you delete a directory 
with File Manager, all files and all subdirectories within the directory are also 
removed. 

CAUTION Be very careful about deleting files and directories. The Delete command 
removes them from your disk. They are not recoverable after you delete them. 
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[> To delete a file or directory: 

1. Select the file or directory you want to delete. 

2. Choose Delete from the File menu. 

The Delete dialog box appears. 

3. Choose Delete to remove the selected file or directory, or type another name if 
you decide you want to remove a different item. 

File Manager asks you to confirm the deletion. (You can suppress the confir
mation message if you want to omit this extra step.) 

4. Choose Yes. 

NOTE You can extend the selection of files or directories to more than one. If you choose 
more than one file or directory to delete, you are asked to confirm each one. 

Suppressing Confirmation Messages 

If you do not want to see a confirmation dialog box each time you want to delete 
or replace files, directories, and subtrees, you can change the confirmation set
tings. You can also cancel the setting that requires you to confirm mouse opera
tions like moving and copying. 

If you tum off the confirmation dialogs, Windows will carry out delete, replace, 
and mouse operations as soon as the command is issued. 

NOTE When File Manager deletes a directory, all files and subdirectories in that directory 
are also removed from your disk. 

I> To suppress confirmation messages: 

1. Choose Confirmation from the Options menu. 

The Confirmation dialog box appears. 

Confirmation 

~ r.~·:::I~=·~·::~~·~:~~·~·:·~ Delete 

[8l Confirm on B.eplace 

[8l Confirm on !!louse Operation 

I OK I I Cancel I 
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2. Clear the check box for each confirmation option you want to cancel. 
Choose OK. 

The confirmation options are described as follows. 

Use this option 

Confirm on Delete 

Confirm on Subtree 
Delete 

Confirm on Replace 

Confirm on Mouse 
Operation 

To do this 

Display a warning message before deleting files. 

Display a warning message before deleting 
directories. 

Display a warning message before writing over an 
existing file. 

Display a warning message before completing a 
direct manipulation with a mouse, such as dragging, 
moving, or copying. 

Renaming Files and Directories 

You can rename any file or directory by choosing the Rename command from the 
File menu. 

CAUTION Do not rename any of the files you received with Windows. 

I> To rename a file or directory: 

1. Select the file or directory you want to rename. 

You can select directories from either the Directory Tree or a directory win
dow. You can select files from a directory window only. 

2. Choose Rename from the File menu. 

The Rename dialog box appears. 

3. Type the new name in the To text box and choose Rename. 

If a file with the new name already exists, File Manager asks if you want to 
write over the existing file. Choose OK to write over it or Cancel if you want 
to start over with a different name. 
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Printing Files 

Most applications have a Print command you can use to print files created with the 
application. You should use that command, rather than the File Manager Print com
mand, whenever possible. The application usually provides formatting capabilities 
and other options that enhance the appearance of the printed material. 

Only text files will print reliably when you use the File Manager Print command. 
Files created by Notepad, for example, are text files. Text files contain no special 
characters or formatting and are usually named with the. TXT extension. If you try 
to print non-text files using the Print command, some unexpected "garbage" 
characters might appear in the printout or nothing at all will print. 

When you do print from File Manager, the file is printed on the active printer. 
Before you use the Print command, you should set up your printer. If you did not 
set up a printer when you installed Windows, you can do so at any time by using 
Control Panel. See "Installing a Printer" in Chapter 5 for more information. 

t> To print a file: 

1. Open the directory window that contains the file you want to print. 

2. Select the file you want to print. 

3. Choose Print from the File menu. 

Setting File Attributes 

File attributes are part of the directory information MS-DOS maintains for each 
file. This information helps identify a file to MS-DOS and controls the kinds of 
operations you can perform on the file. The four file attributes are defined in the 
following table. Their abbreviations appear in the attribute information column in 
their directory windows. 

Abbreviation 

R 

A 

Means 

Read Only. Prevents a file from being changed. 

Archive. Identifies a file that has been modified. Using 
some MS-DOS utilities, such as BACKUP and XCOPY, 
turns off the archive attribute. 



Abbreviation 

H 

S 
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Means 

Hidden. Prevents a file from appearing in an MS-DOS 
directory listing, though it is still visible in the directory 
window. Files with the hidden attribute appear only if you 
selected Show Hidden/System in the Include dialog box on 
the View menu. 

System. Identifies the file as an MS-DOS system file. Files 
with the system attribute appear only if you selected Show 
Hidden/System in the Include dialog box on the View 
menu. 

You can see the file attributes in a directory window by choosing the File Details 
command from the View menu. This command displays all the file information, 
including the attribute information, in the directory window. 

[> To select and cancel attribute settings: 

1. Select the file for which you want to set or cancel attributes. 

2. Choose Change Attributes from the File menu. 

The Change Attributes dialog box appears. 

Change Attributes 

OK 

D Hidden 

D fuoslem 

Cancel 

3. Select or clear the check boxes for the attribute settings you want. Attributes 
are set for each check box that contains an X. 

4. Choose OK. 

Associating Documents with an Application 

The Associate command lets you associate documents that have the same filename 
extension with an application. Then, when you choose the document file, the appli
cation starts and loads the associated document into the application's workspace. 
The document file icon represents documents that are associated. 
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For example, if you associate .DOC filenames with the Microsoft Word program 
file, then whenever you open any .DOC file, File Manager automatically starts 
Word and loads the chosen document into the Word workspace. 

NOTE Windows makes this association for you automatically for most Windows applica
tions. For these applications, any new document you create is automatically associated as 
well. 

[> To associate documents with an application program: 

1. Open a directory window containing a text or graphics file that you want to 
associate with an application. 

2. Select the filename. 

3. Choose Associate from the File menu. 

The Associate dialog box appears. 

Associate 

'.DOC' files ale associated with: 

Ole I I Cancel 

4. Type the program filename or pathname, if necessary, in the text box and 
choose OK. (Type the complete name of the program file, including any exten
sion, For example, to associate the selected document extension with Microsoft 
Word, you would type WORD.EXE in the text box.) 

The icons for all the files with the associated extension will change to docu
ment file icons in the active directory window. 

If you later decide you no longer want the documents associated with the applica
tion (for example, if you remove the application from your disk), you can remove 
the association, 

I> To delete the association between a document and an application: 

1. Open the directory window containing the document whose association you 
want to delete. 

2. Select the document. 
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3. Choose Associate from the File menu. 

The application's filename is displayed in a dialog box. 

4. Press BACKSPACE to delete the filename. 

5. Choose OK. 

Starting Applications from File Manager 
You can start an application by opening a program file or a document file from 
a directory window. Program files typically use .COM, .EXE, .PIF, or .BAT 
filename extensions. Document files can have any filename extensions that are 
typically used for text or graphics files. Document files are associated with appli
cations so that they can open the application and load the document when you 
choose them. 

If the application can run in a window, the window will appear in front of any File 
Manager windows that are open. If the application is a full-screen application, the 
application screen will replace the File Manager window. 

HINT If you plan to use an application frequently, you might find it more convenient to 
add it to a Program Manager group rather than to start it from File Manager. You can copy 
program and document files from File Manager to Program Manager by dragging with a 
mouse. To learn how to add items to a Program Manager group, see Chapter 3, "Program 
Manager." 

[> To start an application from a program file or document file: 

Mouse 1. Open the directory window that contains the correct file. 

2. Double-click the filename. 

f(eyboard I. Open the directory window that contains the correct file. 

2. Select the filename. 

3. Choose Open from the File menu, or press ENTER. 

To shrink File Manager to an icon as soon as you start an application, choose 
Minimize on Use from the Options menu. 
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[> To start an application and a data file: 

Mouse 1. Open the directory window that contains the data file. If the program file is not 
listed in the same directory, also open the directory window that contains the 
program file. 

2. Drag the icon for the data file onto the program file. (The program must recog
nize the data file format or the application will not start.) 

Keyboard 1. Choose Run from the File menu. 

The Run dialog box appears. 

Currenl direclory is C:\ 

~ommand line: 1':'"""11---------' 
o Run M.inimized 

OK Cancel 

2. Type the pathname for the program file; then press the SPACEBAR and type the 
pathname (if different from the program file's pathname) for the file you want 
to open. 

3. Choose OK. 

NOTE As with MS-DOS command lines, you do not need to include the pathname if the 
files are in the current directory, or the pathname is included in your AUTOEXEC.BAT file. 

Maintaining Disks and Diskettes 
The Disk menu includes commands that prepare floppy diskettes for storing infor
mation, copy the contents of one diskette to another, and label a disk. 

Formatting Diskettes 

Formatting prepares the floppy diskette so that MS-DOS can use it for storing 
and retrieving information. When you choose the Format Diskette command, 
File Manager removes all the information from the diskette, writes directory 
information on it, and checks for unusable portions. 
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CAUTION Do not try to format more than one diskette at a time. Windows might let you 
try if you are using two different applications, but the results are unpredictable. 

[> To format a diskette: 

1. Insert the diskette you want to format into the proper drive. 

2. Choose Format Diskette from the Disk menu. 

3. If your computer has a dual-diskette drive, select the letter for the drive you 
want to use for the formatting and choose OK. 

If your computer has a single-diskette drive, you will not see the dialog asking 
you to designate the destination drive. 

A Format Diskette dialog box appears asking you to verify that you want to 
format the diskette. After a diskette is formatted, there is no way to recover any 
information that was previously stored on it. So make sure that the diskette in 
the drive you selected is the one you want to format. 

4. Choose Format. 

A Format Diskette dialog box appears asking you to choose options. 

5. If you are formatting a high capacity diskette, make sure the High Capacity 
option box is selected. 

If you want to include system files on the diskette you are formatting, make 
sure the Make System Disk option box is selected. 

6. Choose OK. 

A status message appears to keep you informed of the progress as your diskette 
is being formatted. 

Making a System Diskette 

You can use File Manager to copy operating system files onto a diskette. A 
diskette that includes system files can be used to start up computers with the 
MS-DOS operating system. 

[> To copy system files onto a diskette: 

1. Select the drive icon for the disk drive that contains the MS-DOS system files. 

2. Insert the destination diskette into the proper drive. 

3. Choose Make System Diskette from the Disk menu. 
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4. If your computer has a dual-diskette drive, select the letter for the drive that 
contains the diskette and choose OK. 

If your computer has a single-diskette drive, you will not see the dialog asking 
you to designate the destination drive. 

A dialog box appears asking you to verify that you want to add system files to 
the diskette. 

5. Choose Yes. 

A status message appears to keep you informed of the progress as your system 
diskette is being formatted. 

NOTE Not all diskettes can accept system files. A system message will notify you if this is 
the case. 

Copying Diskettes 

You can copy the entire contents of one diskette to another diskette by using the 
Copy Diskette command from the Disk menu. Typically, this is done to make a 
backup copy. 

You can use the Disk menu Copy Diskette command to copy diskettes only if the 
diskettes have the same disk capacities. For example, if the source diskette (the 
diskette you want to copy from) holds 720K, the destination diskette (the diskette 
you want to copy to) must also. 

To copy between diskettes that have different capacities, you can use the Copy 
command from the File menu. To copy an entire diskette, use the MS-DOS wild
card *. * on your Copy command line. 

l> To copy an entire diskette: 

1. Insert the source diskette in the drive you want to copy from and, if you have a 
dual-diskette drive computer, insert the destination diskette in the drive you 
want to copy to. 

2. Select the disk-drive icon for the source diskette. 

3. Choose Copy Diskette from the Disk menu. 
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4. If your computer has a dual-diskette drive, select the letter for the destination 
drive and choose OK. 

If your computer has a single-diskette drive, you will not need to specify a 
destination drive. 

A dialog box appears, asking you to verify that you want to copy the diskette. 
When you copy an entire diskette, there is no way to recover information pre
viously stored on the destination diskette. So make sure that the diskette in the 
destination drive is the one you want to copy to. 

S. Choose Copy. 

A status message appears to keep you informed of the progress as your diskette 
is being copied. If your source and destination drives are the same, follow the 
instructions to switch source and destination diskettes as needed. 

Labeling Disks 

You can create a label for a disk that does not already have one, or you can change 
an existing label by selecting the Label Disk command from the Disk menu. 

[> To assign (or change) a volume label: 

1. Click the disk-drive icon for the disk you want to label. 

Or press TAB to move the highlight to the disk-drive icon area and use the 
DIRECTION keys to select the icon for the disk you want to label. 

2. Choose Label Disk from the Disk menu. 

The Label Disk dialog box appears. 

3. Type the label name for the disk in the Label text box. 

The name can be up to 11 characters long. 

4. Choose OK. 
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Quitting File Manager 
You can quit File Manager by using the Exit command on the File menu. File 
Manager asks if you want to save your settings. If the Save Settings check box 
contains an X, settings created with the following commands are saved: 

• All settings on the View menu 

• All settings on the Options menu 

[> To quit File Manager: 

1. Choose Exit from the File menu. 

2. When the Exit File Manager dialog box appears, make sure an X appears in the 
Save Settings check box if you want to preserve your settings for your next 
File Manager session. If you do not want File Manager to save your settings, 
clear the Save Settings check box. 

3. Choose OK. 
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Starting Control Panel 
This chapter describes how to use Control Panel, a program that lets you change 
the way your system is configured while you're using Microsoft Windows. Using 
Control Panel, you can adjust various hardware and software options. 

You start Control Panel by choosing it from Program Manager's Main Group. If 
Program Manager isn't the active window, use Task List (press CTRL + ESC) to 
switch to it. 

t> To start Control Panel: 

1. Open the Main Group window. 

2. Double-click the Control Panel icon. 

Or use the DIRECTION keys to move the highlight to the icon; then press ENTER. 

Windows displays the Control Panel window. 

;; Control Panel a 
liettings .!:::Ielp 

~~~ Ati <= 

~ ~ p " -Color Fonts Ports Mouse Desktop Network 

~ ~ iii 1fJ rfl<5 , 
Printers International Keyboard Date/Time Sound 386 Enhanced 
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The icons in this window represent the groups of options you can set with Control 
Panel. For each icon, there is a corresponding command on the Settings menu. The 
following list summarizes the options you can set. 

Choose this icon 

Color 

A~ 
Fonts 

Ports 

Mouse 

Desktop 

@~ 
~~ 

Network 

Printers 

International 

Keyboard 

Il1 
DatelTime 

To do this 

Set the color of the desktop and many elements on it. 

Add or remove fonts for your printers and display. 

Set the communications parameters for your serial com
munications ports. 

Customize the way you use the mouse, including adjusting 
how fast the pointer moves across the display and setting 
the speed of double-clicking, as well as swapping the 
functions of the left and right mouse buttons. 

Choose patterns or images to decorate the desktop, specify 
a "magnetic" desktop grid to help you align objects on the 
desktop, and set the cursor blink rate. 

Control your connection to the network. The exact options 
depend on your network, but might allow you to do such 
tasks as signing onto and off the network or changing your 
user identification or password. (This icon is available 
only if you have a network installed and started.) 

Install and configure printers, which can include assigning 
output ports, choosing paper sizes and orientation, 
specifying graphics resolution, connecting to network 
printers, choosing the default printer, and using the 
Windows Print Manager program. 

Set international options such as country and language, 
number and currency formats, and date and time formats. 

Adjust the keyboard repeat rate. 

Change the system date and time. 



Choose this icon 

I ,~_~_~ .. IJ , 
386 Enhanced 

[:> To choose an icon: 
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To do this 

Turn on or suppress the warning beep that indicates an 
error condition. 

Specify how applications running concurrently in 386 
enhanced mode compete for use of peripheral devices and 
how much of the computer's resources are allocated to 
Windows applications running in the foreground and back
ground. (This option is available only in 386 enhanced 
mode.) 

[:J Double-click the icon. 

Or use the DIRECTION keys to move the highlight to the icon you want; then 
press ENTER to choose it. 

Or you can choose the corresponding menu command from the Settings menu. 

Customizing the Desktop Colors 
Windows is shipped with several color schemes. You can choose one of these 
schemes or change the colors to create new schemes, defining custom colors in the 
process if you want. 

Choosing an Existing C%r Scheme 
[:> To choose an existing color scheme: 

1. Choose the Color icon from the Control Panel window. 

The Color dialog box appears. The name of the current color scheme is shown 
in the Color Schemes drop-down list box, and the sample screen shows the 
colors for the current scheme. (The visible portion of the list box will be empty 
if you made changes to the current scheme without saving them as a scheme. 
See the following section for information on saving schemes.) 
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ColoJ ~alelle » 

OK I I Cancel 

Sample screen shows 
color selections. 

2. Click the Down arrow at the right of the Color Schemes list box to open the 
drop-down list box. 

Or press ALT + DOWN ARROW. 

3. Select the color scheme that you want. 

You can view any scheme by selecting it and looking at the colors shown in 
the sample screen. Or, as a shortcut, just press UP ARROW or DOWN ARROW to 
cycle to the next scheme without opening the list box. 

4. Choose OK to change to the new scheme. 

Changing an Existing C%r Scheme 

You can change the color assigned to any Windows screen element. You can make 
the color change effective until you change it again, or you can save it for future 
sessions. 

[> To change the color selections for a color scheme: 

1. Select the color scheme you want to change from the Color Schemes drop
down list box. 

2. Choose the Color Palette button. 
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Control Panel expands the Color dialog box to include a list of screen 
elements, a palette of basic colors available on your display, and-until you 
define additional colors-an empty palette titled Custom Colors. 

Color ~chemes------' 

Basic Colors palette 
Drop-down list of elements 
whose colors you can change 

IWindowsDefauli If I l[mll· ~ ••••• II!lfl 
S~ye Scheme II n\\!).!~W~~ !,cnmnfl I 

Inactive n 

File Edit 
+ 

Window Text 

+ 

OK I I Cancel 

J!asic Colors: 

~ustom Colors: 

DDDDDDDD 
DDDDDDDD 
I .!lefine Custom Colors ... 

Custom Colors palette 

3. In the sample screen, click the element whose color you want to change. 

Or press ALT + DOWN ARROW to open the Screen Element list box. Then select 
the element from the list. 

4. Select a color by clicking the color in the Basic Colors palette. 

Or press TAB to move to the palette and use the DIRECTION keys to move the 
dotted rectangle to the color you want. Press the SPACEBAR to select the color. 

You'll see the color displayed in the sample screen. 

S. Change the color of any other screen elements, until you are satisfied with the 
color scheme. However, notice that Control Panel will only use the solid color 
closest to the selected non-solid color for the following screen elements: the 
Window Frame, Window Text, Window Background, Menu Bar, Menu Text, 
and Title Bar Text. 

6. If you want to save the new color selections, choose the Save Scheme button 
and type a name for the scheme. 
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If you don't save the scheme, Windows will use the new color selections until 
you change them again, even if you quit Windows and restart it. But when you 
make another change or choose an existing scheme, the color selections will be 
lost. 

7. Choose OK to change the colors. 

If you find that you use only one or two color schemes, you can shorten the list of 
selections by removing schemes you no longer want to have available. The only 
color scheme that cannot be deleted is Windows Default, the standard scheme that 
you see the first time you start Windows. 

[> To remove an existing color scheme: 

1. Select the color scheme from the Color Schemes drop-down list box. 

2. Choose the Remove Scheme button. 

Defining Custom Co/Drs 
You can specify up to 16 additional colors and use them in your color schemes. 
Control Panel offers two different methods of defining custom colors: 

• By selecting from a color refiner box that shows the full range of possible 
colors. 

• By specifying numbers for either hue, saturation, and luminosity or relative 
amounts of red, green, and blue. 

Hue is the position of the color along the color spectrum. Saturation is the purity of 
the hue, moving from gray to the pure color. Luminosity is the brightness of the 
color on a scale from black to white. Luminosity takes precedence over saturation, 
and saturation over hue. 

t> To define a custom color: 

1. Choose the Color Palette button from the Color dialog box. 

Control Panel expands the Color dialog box to include an empty palette titled 
Custom Colors. 

2. Choose Define Custom Colors from the expanded Color dialog box. 

Windows displays the Custom Color Selector dialog box. 
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3. Drag the color refiner cursor to the area of the color refiner box that shows the 
color you want. Then drag the arrow up or down in the vertical luminosity bar 
to adjust the luminosity of the color. 

Or enter values in the Red/Green/Blue or the Hue/Sat/Lum text boxes. You 
can type values into the boxes or click the scroll arrows to the right of the 
appropriate text box to increase or decrease the number. 

As you change the color, the new color is displayed on the left side of the 
Color/Solid box. The right side of the box displays the solid color closest to 
your choice. A solid color is a color directly supported by your display. Non
solid colors are produced by a pattern of colored dots that simulate the desired 
color. If you want to select the solid color, double-click the right side of the 
box (or press ALT + 0). 

4. When you are satisfied with the color, select a box in the Custom Colors 
palette for the new color. You can select an empty box or one that contains a 
color you want to change. The new color will replace the current one. 

If you do not select a box for the new color, Control Panel places it in the 
upper-left position in the Custom Colors palette. Subsequent custom colors fill 
boxes in sequence from upper left to lower right unless you choose a specific 
box for the new color. 

5. Choose the Add Color button to add the new color to the Custom Colors 
palette. 
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6. Define any other custom colors you want to add to the palette. 

7. To close the Custom Color Selector dialog box and return to the Color dialog 
box, choose the Close button. 

To return to the Color dialog box without closing the Custom Color Selector 
dialog box, move the Custom Color Selector dialog box to the side. 

You can now choose the custom colors the same way you would choose a 
color from the Basic Colors palette. 

Choosing Desktop Options 
You can further customize the appearance of your desktop by displaying a pattern 
or image as the desktop surface. You can also set a "magnetic" grid to make it 
easier to align windows and icons on the desktop, and you can adjust the cursor 
blink rate. 

Displaying Desktop Patterns 

When you install Windows, the desktop is a solid color. You can replace the solid 
color with a pattern by using the Desktop Pattern option. You can choose a pre
designed desktop pattern or create one of your own. 

The background color for the pattern will be the same as the Desktop color. The 
foreground color (the lines that make up the design) will be the same as the color 
of the Window Text screen element. See "Customizing the Desktop Colors" 
earlier in this chapter. 

[> To choose a pattern: 

1. Choose the Desktop icon from the Control Panel window. 

Control Panel displays the Desktop dialog box. 
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2. Click the Down arrow in the Pattern Name list box to open the drop-down list 
box. 

Or press ALT + DOWN ARROW. 

3. Select a pattern from the list of names. 

You can view any pattern by selecting it and choosing OK. Or, as a shortcut, 
just press UP ARROW or DOWN ARROW to cycle to the next pattern without 
opening the list box. 

4. Choose OK. 

If you are using a mouse, you can change an existing desktop pattern or create a 
new one and save it with a new name. 

[> To change an existing pattern: 

1. Choose the Edit Pattern button in the Desktop dialog box. 

You'll see a dialog box in which you can choose a pattern to change. 

2. Click the Down scroll arrow to open the Pattern Name drop-down list box. 

Or press ALT + DOWN ARROW. 

3. Choose a pattern from the list. 

You'll see a sample of the pattern in the Sample box and a cell in which you 
can make changes to the pattern. (The cell shows an enlarged version of the 
pattern.) 
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4. In the cell, click locations where you want to reverse the colors in the pattern. 

You cannot change a pattern with the keyboard. 

5. When the Sample box shows the pattern you want, choose the Change button 
and then choose OK. 

[> To create a new pattern: 

1. Choose the Edit Pattern button in the Desktop dialog box. 

The Edit Pattern dialog box appears, showing a sample of the selected pattern 
in the Sample box. 

2. Type a name for the new pattern. 

3. Click locations where you want to reverse the colors in the pattern. 

4. When the cell shows the pattern you want, choose the Add button and then 
choose OK. 

The pattern is now available for use from the Pattern Name drop-down list box 
in the Desktop dialog box. 

The pattern you define is repeated as many times as necessary to completely fill 
the background. If you design an asymmetrical pattern, the individual cells may 
combine to form an overall pattern that you didn't expect. If you experiment with 
the patterns, you'll soon understand the effects you can create. Remember, the 
colors of the pattern are determined by the desktop and window text colors you 
choose. 

If you find that you use only one or two patterns, you can shorten the list of 
selections by removing patterns you no longer use. 

[> To remove a pattern: 

1. Choose the Edit Pattern button in the Desktop dialog box. 

2. Select the pattern you want to remove. 

3. Choose the Remove button. 

4. Choose Yes to confirm the deletion. 

5. Choose OK. 
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Displaying Custom Wallpaper 

You can alter the appearance of your desktop dramatically by displaying a bitmap 
as wallpaper in place of the desktop color or pattern. You can display any bitmap 
(any file with the .BMP extension), even an elaborate one such as a scanned color 
photograph. 

You can use Paintbrush or another painting program that produces .BMP files to 
create a bitmap to use as wallpaper. After you create the bitmap, copy the .BMP 
file into the directory where Windows is located. If the file is not in the same 
directory, Control Panel won't be able to locate the bitmap unless you type in a 
full pathname. 

Not all bitmaps will cover the entire desktop when the wallpaper is displayed. You 
can repeat small bitmaps by selecting the Tile options. 

NOTE If Windows is running in real mode and using expanded memory, after you change 
the wallpaper, you must restart Windows to display your new wallpaper selection. 

l> To choose a bitmap to display as wallpaper: 

1. Choose the Desktop icon from the Control Panel window. 

2. Click the Down scroll arrow in the Wallpaper File box to open the list. 

Or press TAB to reach the list and then press ALT + DOWN ARROW. 

3. Select a bitmap from the Wallpaper File drop-down list box. 

Or type in a full pathname for the bitmap. 

4. Select Center or Tile. 

The Center option positions the bitmap in the center of the desktop. The Tile 
option repeats the bitmap as many times as is necessary to cover the entire 
desktop, placing the first copy in the upper-left comer of the desktop. 

If you select both a pattern and custom wallpaper in the Desktop dialog box, 
the wallpaper overlays the pattern. If you select the Center option for the wall
paper and the bitmap doesn't cover the entire desktop, you'll see the pattern 
around the edges of the bitmap. If the original bitmap is too large to fit or takes 
up too much memory, Windows will not display it at all. 

S. Choose OK. 
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If you want to remove a wallpaper from the list, delete the bitmap file from the 
directory that contains Windows. 

NOTE When Windows displays wallpaper, it uses more memory than when it displays a 
solid color or a desktop pattern. If you run out of memory when running applications, 
changing to a color or pattern will free up some memory for use by applications. 

Changing the Spacing Between Icons 

Windows calculates the standard spacing for application, document, and program 
item icons based on the size of the widest icon. Usually this spacing is adequate. 
However, sometimes the description for an icon exceeds the icon's width, causing 
it to overlap adjacent icons. 

You can increase the space between icons by typing a higher number in the Icon 
Spacing text box. The number represents pixels, the smallest unit of measurement 
on the screen. Increments of 10 pixels result in noticeable increases in spacing be
tween icons. 

[> To increase icon spacing: 

1. Choose the Desktop icon from the Control Panel window. 

2. Move to the Icon Spacing text box in the Icons area. 

3. Click the Up or Down scroll arrow to the right of the text box to increase or 
decrease the spacing between icons. Or type the number you want. 

4. Choose OK. 

The spacing change occurs when you choose Arrange Icons from Task List for ap
plication icons or from the Windows menu for document and program item icons. 
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Changing the Sizing Grid 

Until you set the granularity of the invisible sizing grid to a number greater than 0, 
the grid is off. And Windows leaves icons and windows wherever you place them 
on the desktop. With the sizing grid set to a number greater than 0, all items on 
your desktop align in an orderly fashion and conform to the spacing of the 
invisible grid whenever you move any of them. They "snap" to the nearest 
invisible grid line. The grid affects both the position and size of windows you 
manipulate. 

[> To set the grid spacing: 

1. Choose the Desktop icon from the Control Panel window. 

2. Move to the Granularity text box in the lower-right portion of the dialog box. 

3. Click the Up or Down scroll arrow to the right of the text box to increase or 
decrease the size of the grid. Or type the number you want. 

The allowed range is 0 through 49. The grid changes in multiples of eight 
pixels. A value of 1 creates a grid with magnetic spots every eight pixels, 
2 places magnetic spots every 16 pixels, and so forth. For each increment of 1, 
the distance between grid lines increases by eight pixels. A value of 0 cancels 
the grid. 

4. Choose OK. 

Changing Border Width 

You can change the width of the borders around all the windows on your desktop 
except those (such as Control Panel) with a fixed size. 

[> To change the border width: 

1. Choose the Desktop icon from the Control Panel window. 

2. Move to the Border Width text box at the bottom right of the dialog box. 

3. Click the Up or Down scroll arrow to the right of the text box to increase or 
decrease the width. Or type the number you want. 

The allowed range is 1 through 49, with 1 being the narrowest border. 

4. Choose OK. 
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Setting the Cursor Blink Rate 

If the cursor blinks too fast or too slow for your optimal use, you can change the 
rate. 

t> To change the cursor blink rate: 

1. Choose the Desktop icon from the Control Panel window. 

2. Move to the Cursor Blink Rate scroll bar. 

Or press ALT + R. 

3. Slide the scroll box toward Fast or Slow to move quickly to a new blink rate. 

Or click the Right or Left scroll arrow to speed up or slow down the rate, 
respectively. 

Or press RIGHT ARROW or LEFf ARROW to move the scroll box. 

4. Choose OK. 

Installing a Printer 
When you use the Setup program to install Windows, Setup runs Control Panel for 
the first time so you can install one or more printers. If you did not install a printer 
when you installed Windows or simply want to add another one, use the pro
cedures described in this section. See Appendix A, "Using Setup to Maintain 
Windows," for more information about installing Windows. 

Microsoft Windows Help and the PRINTERS.TXT document provide some 
specific information about many of the printers supported by Windows. It is also a 
good idea to read your printer manual. 

To use a printer with Windows applications, you need to do the following: 

• Install the printer-driver file for that printer on your hard disk. 

• Select the port to which you want to assign the printer. 

• Choose the printer and printer settings you'll use with the installed printer
driver file. 

• Choose the active printer for each port. 

• Choose the default printer. 
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Installing a Printer-Driver File 

Windows comes with printer-driver files for most of the commonly used printers. 
A printer-driver file gives Windows important information about your printer, 
including details about printer features and the printing interface, descriptions of 
fonts (such as sizes and styles), character translations, and control sequences the 
printer uses to achieve various formats. 

When you choose to install a printer, Control Panel displays a list of printers from 
which to select. If you do not find your printer in this list, it means that Windows 
does not have a printer-driver file specifically for your printer. Your printer might 
be supported, however, through a printer-driver file for another printer, or a driver 
might have been developed since Windows was shipped. For more information 
about what to do in this situation, see "If Your Printer Is Not Listed in the Printers 
Dialog Box" later in this chapter. 

t> To install a printer-driver file by using Control Panel: 

1. Choose Control Panel from the Main Group window in Program Manager. 

The Control Panel window appears. 

2. Choose the Printers icon. 

The Printers dialog box appears. 

3. Choose the Add Printer button. 

The dialog box expands to display a list of printers for the printer-driver files 
available on the Setup disks. These drivers are part of the Windows package, 
and the ones you select are copied onto your system. 

If you did not install a printer during Setup, Control Panel will automatically 
choose the Add Printer button for you. 
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4. In the List of Printers box, select the printer you want to install. 

5. Choose Install. 

A dialog box appears, instructing you to insert the disk that contains the printer
driver file for the selected printer. If a driver for that printer is already on your 
system, you'll see a dialog box asking if you want to use the existing driver or 
install a new one. For more information, see the following section. 

6. Insert the disk that contains the printer-driver file and choose OK. 

Control Panel installs the printer-driver file for the printer you selected. It does 
not configure your particular printer to operate with the installed printer driver. 
Most printer drivers are common to a number of different printer models. To 
customize the printer-driver file so that your printer works with Windows, you 
must follow all the printer configuration procedures later in this chapter. 

For the first printer driver you install, the name of the printer driver appears 
highlighted in the Installed Printers box along with LPT 1 to indicate the port 
assignment and Active to indicate the current status. Subsequent printer drivers 
you install will appear with None for the port assignment and Inactive for the 
current status. 

If appropriate, a dialog box also appears, prompting you for the disk that con
tains the font files or other files associated with the printer. 

7. If Control Panel prompts you for another file, insert the appropriate disk and 
choose OK. 

Windows copies the file to your hard disk. 

NOTE Before you can actually print something using the printer driver you installed, you 
must complete the following procedures for assigning a printer port (if necessary), making 
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the printer active (if necessary), and configuring the printer to operate the way you want 
with Windows. All printer drivers come with standard settings for features such as printer 
model, paper source, paper size, and orientation. You can change these settings when you 
configure your printer. 

If a Printer-Driver File Is Already Installed 
Because printer-driver files can be used by more than one printer, there may be 
times when you choose to install a new printer and find that the printer-driver file 
it uses has already been installed. You might also have a printer-driver that you 
installed in a previous version of Windows. 

If a printer-driver file already exists on your hard disk, a dialog box appears when 
you choose Install in the Printers dialog box. 

You can choose either to use the currently installed version of the printer-driver 
file or to install a new version. If you want to install a newer printer-driver file, 
choose New. Otherwise, choose Current. 

C> To use the currently installed printer-driver file: 

o Choose Current in the dialog box reporting the existing printer-driver file. 

Control Panel installs the new printer using the currently installed printer 
driver. 

C> To install a newer version of the existing printer-driver file: 

1. Choose New in the dialog box reporting the existing file. 

Another dialog box appears, instructing you to insert the disk that contains the 
printer-driver file. 

2. Insert the disk and choose OK. 

The new printer-driver file replaces the existing one, and all the printers using 
that printer-driver file will now use the new one. 

If appropriate, a dialog box appears, prompting you for the disk that contains 
other files associated with the printer. 

3. Insert the disk that contains the files and choose OK. 

Windows copies the font files to your hard disk. 
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If Your Printer Is Not Listed in the Printers Dialog Box 
If your printer does not appear in the Printers dialog box, you can still make your 
printer work with Windows. 

The first thing you should do is check the Hardware Compatibility List provided in 
the Windows package. If your printer is not on the Hardware Compatibility List, 
you should check the printer manual. It might indicate whether your printer is 
100 percent compatible or has an emulation mode that is compatible with one of 
the printers in the List of Printers box. Look for a section on dip switch settings or 
modes in the index of the manual. 

For example, many dot-matrix printers can be made compatible with an Epson ® 

printer by changing dip switch settings on the back of the printer. Also, many laser 
printers can be made compatible with an HP ® LaserJet ® by changing dip switch 
settings or by selecting the proper choice from a menu panel on the printer. When 
you use your printer in emulation mode, however, be aware that you might not be 
able to use all the features unique to the printer. 

If your printer is not 100 percent compatible and does not have an emulation mode 
that is compatible with one of the printers in the List of Printers box, you have two 
options. 

• Contact your printer manufacturer for a new printer driver that works with 
Windows. 

• Request the Driver Library Disk from Microsoft. Microsoft adds drivers as 
they become available. See the Hardware Compatibility List for contact 
information. 

See the next section, "Installing a Printer Driver Not Supplied by Windows," for 
instructions on installing such a printer-driver file. 

If none of these suggestions works for you, choose Genericffext Only from the 
List of Printers box. The Genericffext Only printer-driver works with most 
printers and should be chosen for daisy-wheel printers. It prints text, but no 
graphics. 

Installing a Printer Driver Not Supplied by Windows 
If you receive a new driver from a printer manufacturer, you should follow any 
special instructions the manufacturer provides for the installation. 
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If there are no special instructions, use the procedure outlined earlier in this 
chapter for installing a printer-driver file. When asked to select the name of your 
printer, select Unlisted Printer at the end of the List of Printers box. 

There might be files other than the printer driver you will need to copy before you 
can operate your printer. So, before you configure printer settings, make sure you 
copy all other associated files into the \SYSTEM subdirectory of the directory that 
contains Windows. You can use File Manager to complete this procedure. See 
Chapter 4, "File Manager," for instructions for copying files. 

Complete the remaining procedures to configure your printer properly. 

Selecting a Printer Port 

After you install the printer-driver file on your hard disk, you must assign the 
printer to a port. 

[> To select the printer port: 

1. Choose the Printers icon from the Control Panel window. 

2. From the Installed Printers box, select the printer for which you want to choose 
a port. 

3. Choose Configure in the Printers dialog box. 

You'll see the Configure dialog box in which the ports are listed. LPT ports 
are parallel ports. COM ports are serial ports. EPT is a port used for certain 
printers, such as the IBM ® Personal Pageprinter. You can use the EPT port 
only if you have installed a special card in your computer. FILE is used for 
printing to a file. 

The Ports box 
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4. Select the port you want to assign the printer to. 

If you are connecting a serial printer to a serial port, you might need to use the 
Control Panel's Ports feature to change the port's communications settings 
(that is, provide the correct port, baud rate, parity, data bits, flow control, and 
stop bits). Windows automatically sets the most commonly used communica
tions settings for serial printers, and these settings should work with most 
printers. See also "Configuring Communications Ports" later in this chapter. 

If you want the option of printing to a file first rather than immediately to a 
printer, select the FILE option from the list of ports. See Chapter 6, "Print 
Manager," for more information on printing to a file. 

While you have the Configure dialog box open, you must change the default 
configurations to match your printer. For a description of configuration 
options, see the following section, "Configuring a Printer." 

5. Choose OK when you are ready to return to the Printers dialog box. 

The selected port appears next to the highlighted printer in the Installed 
Printers box. 

13861 Setting Access Priorities for 386 Enhanced Mode 
If you are using non-Windows applications in 386 enhanced mode, you can deter
mine what happens when several applications compete for access to a printer port. 
For more information, see "Setting Options for Running in 386 Enhanced Mode" 
later in this chapter. 

Configuring a Printer 
After connecting your printer to your computer, installing the printer-driver file, 
and selecting a port, you need to follow some or all of the listed procedures before 
printing. 

• Choose the correct printer for the printer-driver file you installed. 

• Change printer settings, such as the paper you want to print on from standard 
letter size to another size. 

• Change the printer that is active on a particular port. 

• Choose a default printer when you install more than one printer. 

• Choose the time you want Windows to wait before sending you messages about 
printer problems. 
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Choosing a Printer 

Because different kinds of printers can use the same printer-driver file, you must 
use the Configure command to tell Windows what printer you will use with the 
printer-driver file you installed. 

t> To choose a printer: 

1. Choose the Printers icon from the Control Panel window. 

2. Choose Configure from the Printers dialog box. 

3. Choose Setup from the Configure dialog box. 

A Setup Printer dialog box appears, displaying the current print options for the 
printer-driver file you are configuring. The following is an example of a Setup 
Printer dialog box for the HP LaserJet Series II. (This dialog box will show the 
options specific to the printer-driver you install.) 
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4. Select the name of your printer from the list in the Printer drop-down list box. 

While you have the Setup Printer dialog box open, you can change optional 
configurations of your printer. For a description of other print options you can 
set, see the following topic. 

5. Choose OK to return to the Configure dialog box. 
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Setting the Print Options 

Print options are printer-specific settings such as the page orientation-portrait or 
landscape-or the manner in which paper feeds through the printer. These options 
vary from printer to printer. 

When you install a new printer, you must set the Printer option in the Setup Printer 
dialog box to indicate the printer you want to use with a printer-driver file. See the 
preceding section, "Choosing a Printer," for a description of how to set the Printer 
option. 

Additionally, Windows sets other print options that should work for your printer in 
most situations. You can change these settings to do such things as use a different 
paper size or change the way paper feeds through the printer. 

[> To change the standard print options: 

1. Choose the Printers icon from the Control Panel window. 

The Printers dialog box appears. 

2. From the Installed Printers box, select the printer for which you want to change 
the standard print options. 

3. Choose Configure. 

The Configure dialog box appears. 
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4. Choose Setup. 

A Setup Printer dialog box appears, displaying the current print options for the 
selected printer. The following is an example of a Setup Printer dialog box. 
(This dialog box will show the options specific to the printer-driver you 
install.) 
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5. Make any necessary changes to the options and choose OK. 

The following list explains some of the common print options that you will find in 
a Setup Printer dialog box. However, since each printer's Setup Printer dialog box 
is different, the terms used may be different or not exist for every printer. 

Use this option 

Printer 

Paper Source (or Feed) 

Paper Size (or Format) 

To do this 

Specify the printer you are using with a printer
driver file. You need to set this option when you 
install a printer. See "Choosing a Printer" earlier 
in this chapter for a description of how to set the 
Printer option. 

Specify the tray or bin feeder option if your 
printer uses single sheets of paper. A Tractor set
ting assumes your printer prints on paper that 
feeds continuously into the printer on tractor 
wheels. On some printers, you can choose to feed 
paper manually. 

Use a nonstandard paper size. For most printers, 
Windows assumes that you want to print on stand
ard letter-size paper (8 1/2 by 11 inches). If you 
are using a different size paper, you must change 
this setting to accommodate the new size. 
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Use this option 

Memory 

Orientation 

Graphics Resolution 

Cartridges 

Fonts 

Options 

Help 

To do this 

Specify the amount of printer memory. See your 
printer's manual or contact the manufacturer to 
find out how much you have. If you can't find the 
information, simply use the default setting. 

Specify portrait or landscape orientation. Portrait 
means the page is taller than it is wide when you 
view the printed text upright. Landscape means 
the page is wider than it is tall when you view the 
printed text upright. 

Select Graphics Resolution if your printer sup
ports printing graphics at different resolutions. 
Graphics resolution options can appear in the 
Setup Printer dialog box as High, Medium, or 
Low, or as dots per inch (such as 300 DPI or 
120 x 144). The more dots per inch, the higher the 
resolution. Higher resolutions print more slowly 
but produce a higher quality picture. Lower 
resolutions print faster and can give you a quick, 
but lower quality, copy of your picture. 

Select up to the maximum number of cartridges 
that can be physically plugged in to your printer 
from the list of those available for that printer. 

Set up additional fonts on your printer. Fonts can 
be either font cartridges or downloadable soft-font 
files. Notice that these are fonts supplied by a 
printer or font vendor, not the fonts supplied with 
Windows. 

Select from the unique options available for that 
printer. See Windows Help or the on-line docu
ments for more information on these additional 
options. 

Obtain specific information about how to set up 
the options in the printer-driver file and any 
special printer settings you may need to use when 
printing with this printer driver from Windows. 

You might also be able to change the print options while using some Windows ap
plications. See the documentation for your Windows application to find out if this 
feature is supported. 
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NOTE If you change the port a printer is connected to, be sure to check the print options 
to make sure they are correct. Print options settings do not follow a printer from one port to 
another. 

Choosing an Active Printer 
When you install more than one printer on a port, you must choose which printer 
will be the active one. The active printer is the printer currently connected to the 
port. Although you can assign more than one printer to a port, only one printer can 
be active on that port at a time. 

You can change the active status of a printer at any time. 

[> To choose the active printer for a port: 

1. Choose the Printers icon from the Control Panel window. 

The Printers dialog box appears. 

Cl I HP laserJet on lPT2. Active 
PostScript Printer on LPT2:. Inactive 

roefault Printer 
PCl I HP laserJel on lPT2: 

[8J !Lse Print Manager 

The Active and 
Inactive buttons 

Cancel 

I !;onfigurem I 
I Hetwork... I 

Add Printer» I 

2. In the Installed Printers box, select the printer you want to designate as active. 

3. Select Active. 

The word Inactive changes to Active next to the printer's name in the Installed 
Printers box. 

4. Choose OK to return to Control Panel. 
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Choosing the Oefault Printer 

The default printer is the printer that many Windows applications automatically 
use when you choose the Print command. You can have only one default printer 
and it must also be the Active printer. 

[> To choose a default printer: 

1. Choose the Printers icon from the Control Panel window. 

The Printers dialog box appears. 

The name of the default printer appears here. 

Printers 

Installed Printers: 
. , 

PostScript Printer on LPT1:.Active 

Qefault Printer---------, 

PCL / HP LaserJet on LPT2: 

[8J !lse Print Manager 

OK 

Cancel 

I ,!;;onfigure... I 
I Network ... I 

I 

2. In the Installed Printers box, double-click the printer you want to use as the 
default printer (or select the printer and press ALT + D). 

The printer's name appears in the Default Printer box. 

3. If necessary, choose Configure and then Setup to set print options for the 
default printer. 

See "Setting the Print Options" earlier in this chapter for more information 
about print options. 

4. Choose OK when you are ready to return to the Control Panel window. 

If you have several printers installed, you can use Control Panel anytime you want 
to change the default printer. 

Other Windows applications sometimes use the Printer Setup command so that 
you can choose a default printer for only that application. See the documentation 
for the application to see if this feature is supported. 
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Choosing Timeout Options 
You can use the Timeout options in the Printers dialog box to adjust the amount of 
time Windows waits before sending you messages about printer problems. The 
Device Not Selected setting controls the amount of time Windows waits before 
notifying you that a printer is off-line. The standard setting is 15 seconds. The 
Transmission Retry setting controls the amount of time Windows waits for output 
characters to be received by a printer before notifying you that it cannot print to 
the device. The standard setting is 45 seconds. 

The standard settings for the Timeout options work with all printers, and you 
should use these settings unless you are having a specific problem. For example, 
you might need to change the Transmission Retry setting to greater than 45 sec
onds if you are printing to a serial port or printing complicated graphics. It some
times takes longer to transmit information to serial printers than to parallel printers 
and for printers to print complex graphic pictures. If you print to a network printer 
and network traffic is heavy, there may be enough of a delay to require you to 
change to higher timeout settings. Printing to a PostScript printer might also re
quire higher settings. 

[> To change either of the Timeout options: 

1. Choose the Printers icon from the Control Panel window. 

The Printers dialog box appears. 

2. From the Installed Printers box, select the printer you want to change a 
Timeout setting for. 

3. Choose Configure. 

The Configure dialog box appears. 

Printers - Configure 

peL I HP LaserJel on LPT1: 

forls: 

~ •• +J I rs'~:,:~~::;::) 
+ I Remove 

c:::....:..::::....----",,-, 

Timeouls (seconds) 
.!!evice Nol Selecled: 

Iransmission Relry: 

Type new Timeout options here. 



172 Connecting to a Network Printer 

4. In the Device Not Selected box, type the number of seconds you want 
Windows to wait before sending you a message that the printer is off-line. 

5. In the Transmission Retry box, type the number of seconds you want Windows 
to wait before sending you a message that it cannot print to your printer. 

6. Choose OK when you are ready to return to the Printers dialog box. 

7. Choose OK to return to Control Panel. 

Connecting to a Network Printer 
Instead of connecting a printer to your computer with a printer cable, you might 
use a network printer. If you did not connect to the network printer before starting 
Windows, you'll have to make the connection before printing. This section is 
applicable only if you installed Windows for use with a network and have a net
work running currently. 

[> To connect to a network printer: 

1. Choose the Printers icon from the Control Panel window. 

The Printers dialog box appears. 

2. Choose Network. 

The Network Connections dialog box appears. This dialog box lists any net
work printer connections that have already been made. (Contents of this dialog 
box vary depending on the type of network you are using.) 

Printers - Network Connections 

Network Printer Connections: 
LPT2: I\printers\printerl OK 

.!!isconnect 

----------------------------------------..... _-----------------------------------------------
forI: ILPT1: If I 
P~th: ;=1 ==-----, 

Passrford: I .!1WWMJ ... 

3. Click the Down arrow to open the Port drop-down list box. 

Or press ALT + DOWN ARROW. 

4. Choose the port you want to use. 
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5. Type the network name for the printer in the Path text box. Check your net
work documentation for the information required in the Path or Password 
fields. 

6. If a password is required, type it in the Password text box. 

An asterisk (*) appears for each character you type. 

7. Choose the Connect button. 

Control Panel adds the printer connection to the list in the dialog box. Notice 
that if another network printer is already connected to the port you chose, 
Control Panel prompts you to disconnect the other printer. 

8. Choose OK to return to the Printers dialog box. 

NOTE If your network supports it, you'll be able to choose the Browse button to look at 
the list of available network printers. See Chapter 4, "File Manager," for an explanation of the 
Browse dialog for networks. 

t> To disconnect from a network printer: 

1. Choose the Network button from the Printers dialog box. 

2. Select the network printer you want to disconnect from. 

3. Choose the Disconnect button. 

Removing an Installed Printer 
If you are no longer using an installed printer, you can remove the printer from the 
Installed Printers box in Control Panel. 

t> To remove an installed printer: 

1. Choose the Printers icon from the Control Panel window. 

The Printers dialog box appears. 

2. In the Installed Printers box, select the printer you want to remove. 

3. Choose Configure. 

The Configure dialog box appears. 
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Printers - Configure 

PCl' HP laserJet on LPn: ~ 
Ports: ,------, I Cancel I 

lietup ... 

Remove t----+-- The Remove button 

Timeouls (seconds) 
Qevice Nol Selecled: 0 
Iransminion Relrv: ~ 

4. Choose Remove. 

A dialog box asks you to confirm the removal. 

The printer disappears from the Installed Printers box. 

5. Choose OK to return to the Printers dialog box. 

Removing a printer from the Installed Printers box removes the printer-driver file 
from the Windows directory only if no other printer is using that printer-driver 
file. Removing the printer-driver file does not remove any associated fonts. 
Another printer-driver file might be using the fonts. If you want to remove these 
fonts, see "Removing a Font" later in this chapter for more information. 

Printing Without Print Manager 
When Windows Print Manager is turned on, it controls printing in the background 
while you continue to work with your applications in the foreground. Usually, you 
will want to use Print Manager because it will free your computer to run other ap
plications while your printer is printing. 

However, if you want, you can print from a Windows application without using 
Print Manager. Your application then prints directly to your local printer or to the 
network. If you print without Print Manager, you cannot work with your computer 
until your file is completely delivered to the network print manager or until it 
finishes printing on your local printer. 
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[> To print without using Print Manager: 

1. Choose the Printers icon from the Control Panel window. 

The Printers dialog box appears. 

Inslalled Plinlels: 
. - . 

PoslSclipl Plinlel on None. Inaclive 

iDefault Plinlel 
I PCl I HP laselJel on lPT2: 

l2ll!se Plinl Managel 

Clear this check box to 
bypass Print Manager. 

Printers 

OK 

Cancel 

I I;onfigule... I 
I l!elwOIk... I 

Add Plinlel » I 

2. Clear the Use Print Manager check box. 

3. Choose OK. 

Print Manager also lets you view information about jobs currently printing, 
including network print jobs. See Chapter 6, "Print Manager," to learn how to 
use Print Manager's features. 

NOTE If you use a network printer, turning Print Manager off mayor may not speed up 
printing time. See Chapter 6, "Print Manager," for a discussion. 

Configuring Communications Ports 
Control Panel provides options for specifying the communications settings for 
each serial port (the ports named COMl, COM2, and so on) used by your system. 
Serial ports are typically used for connecting modems, mice, or certain printers. 
The communications settings specify how information is transferred from your 
computer to the device. 
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[> To configure a communications port: 

1. Choose the Ports icon from the Control Panel window. 

Control Panel displays the Ports dialog box showing icons for the four possible 
serial ports. 

2. Double-click the icon for the port whose communications settings you want to 
specify. 

Or use the DIRECTION keys to select the icon for the port you want and then 
choose the Settings button. 

To select more than one port, hold down SHIFf while you select ports and then 
choose the Settings button. 

Control Panel displays the Settings dialog box. 

Ports - Settings 

S eUings for CO M 1 

J!aud Rale: 1- I[!J ~ I Cancel I 
Qala ~Iop 

Bils farilJ' Bils flow Conlrol 

04 o Even 

05 o Odd 
@1 o Xon IXoff 

06 @None 01.5 o Hardware 

07 o Mark 
02 @None 

@B o Space 

3. Set the options in this dialog box to match the device that is connected to the 
port. 

Refer to the manual you received with the device to find the correct settings. 

4. Choose OK. 

For information on the communications options, see Chapter 9, "Terminal." 
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Setting Network Options 
If you installed a network when setting up Windows, the Control Panel window 
will include a Network icon. You use the options represented by this icon to view 
information about your network or to set special options that might be available 
for your network. 

When you choose the Network icon, you'll see a dialog box that is specific to your 
network. The following are some of the options you might be able to set in this 
dialog box: 

• Signing on and off the network 

• Changing user ID and password 

• Sending messages to other network users 

For information about any options available with your network, see the operating 
guide for your network software and the Help feature (if available) in the dialog 
box. 

Adding and Removing Fonts 
The options represented by the Fonts icon allow you to add and delete font sets, 
which determine what characters will look like on the screen and when they are 
printed. A font set is a collection of sizes for one typeface, customized for a 
particular display and printer. Windows supplies raster (or screen) fonts and vector 
(or stroke) fonts. Printer or font manufacturers provide built-in printer fonts, car
tridge fonts, and soft fonts, and Windows supports these fonts through the 
Windows printer-driver files. 

When you send a file to the printer, Windows checks the appropriate printer-driver 
file to see if it contains the font selected for printing. If the printer-driver file 
doesn't supply the font, for some printers Windows will generate a raster font 
from the font files provided in the Windows package, format the characters itself, 
and send the document to the printer. 
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What Are Fonts? 

A/ont is a graphic design applied to all numerals, symbols, and characters in the 
alphabet. A variety of different fonts are available for printing with Microsoft 
Windows. Choosing the right font can help you create whatever look you want for 
a document-professional, casual, and so on. Fonts can also make a document 
easier or harder to read. 

Different fonts are usually provided for emphasizing (that is, bolding, italicizing, 
and underlining) text. Font sizes are measured in points-a point equals 1/72 of an 
inch. Points describe the height of a character. How much text will fit on one page 
of a document depends on both the font and the size used. You might want to 
experiment with the different fonts and sizes supported by your printer to learn 
how best to use them to get the results you want. 

Viewing Fonts on the Screen 

The Windows package includes a basic selection of raster (or screen) fonts for dis
playing fonts that you choose for printing. (These fonts are also used by some 
printers, such as dot-matrix or ink-jet type printers.) If Windows does not have a 
screen font for a font you have chosen to print with, it substitutes a font that 
resembles the selected printer font as closely as possible. Though it may not look 
exactly like the font that you see in the printed document, the substitute font 
creates the same line lengths and page breaks on the screen as you will see in the 
printed document. 

If you purchase extra fonts from a printer or font manufacturer, the font package 
mayor may not include screen fonts. If it does not, you might want to check with 
the manufacturer to see if they can also supply screen fonts. 

Adding a Font 

When you install a printer, any raster (or screen) fonts that can be used by your 
printer are automatically installed. If your printer-driver file does not supply the 
corresponding screen fonts for the printer fonts supported, you may be able to 
obtain some from your printer manufacturer or a font manufacturer. If you are able 
to obtain additional raster (or screen) fonts, use any installation program provided 
with the fonts to install them. If no installation program is provided, you can use 
Control Panel to install the screen fonts. 
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If the printer-driver file for your printer supports cartridge or soft fonts, you can 
add these types of fonts by using the printer-driver file's own font installer pro
gram. Or, for more information on installing printer fonts, you can start Notepad 
(or any text editor) and read PRINTERS.TXT. 

t> To add a font: 

1. Choose the Fonts icon from the Control Panel window. 

Control Panel displays the Fonts dialog box. All previously installed fonts are 
listed in the dialog box, and a sample of the selected font is shown in all the 
available sizes unless the font is a vector font. Vector fonts can be scaled to 
any height, so the only size that is displayed is the size that was used to design 
the font. 

In$lalled Eonb: 
ourier 9 10 12 IVGA res) 

Helv 8.10.12.14.18.24 [VGA re$] 
Modern 
Roman 

Fonts 

OK 

~c~~~, 8.10.12.14.18.24 GA re$ I Remove I 
=:=.:....==:....!<.!..:==-=-&..:....::::..:..:.=L--___ ---' I Add... I 
Sample of Fonl 

Courier 10 ABCDEFGHIJKLMNOPQRSTUVWXYZabcdefghijkl 
Courier 12 ABCDEFGHIJKLMNOPQRSTUVWXYZabcdef 
Courier 15 ABCDEFGHIJKLMNOPQRSTU 

2. Choose the Add button. 

Control Panel asks for the filename for the font set you want to install. 

3. Enter the font filename in the text box or select a directory and file from the 
list boxes. 

If you want to install more than one font set at a time, extend the selection to 
all the font sets you want to install from the current directory. (See "List 
Boxes" in Chapter 2 to learn how to extend the selection.) 

4. Choose OK to add the font. 

] 
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Removing a Font 

Every installed font set takes up memory. If you are not using one or more of the 
installed font sets, you can remove them to free up memory for use by your 
applications. 

CAUTION The Helv font set is used for most Windows dialog boxes. Do not remove this 
set, or the text in the dialog boxes will be difficult to read. 

I> To remove a font: 

1. Choose the Fonts icon from the Control Panel window. 

Control Panel displays the Fonts dialog box. 

2. Select the font you want to remove. 

3. Choose Remove. 

A dialog box asks you to confirm the removal. 

4. Choose OK to return to Control Panel. 

Setting International Options 
With the international options you can specify settings for Windows and all the 
Windows applications that use the items you specify. If you are using Windows in 
English within the United States, you do not need to make any changes to the inter
national settings. 

Basic Settings 

Control Panel lets you set basic international options such as country, language, 
keyboard layout, system of measurement, and list separator. Usually, you should 
just select the country in which you are working-Control Panel then auto
matically adjusts all the other settings. But you can adjust any of the other settings 
to customize them for your particular situation. 
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[> To select international settings: 

o Choose the International icon from the Control Panel window. 

Control Panel displays the International dialog box. 

International 

!;ounlry: U1tffitmlilft;4 OK 

.Language: I English (Amelican) I f I Cancel 

t;eyboald Layout: ISlandald (US) If I 

Measulement: I English If I 

Lisl ~epalalol: [] 

!!ale FOImal 

9128/1989 I Change... I 
Sunday. 5 Malch. 1989 

C!!nency FOImal 

$1.22 

($1.22) I Change ... I 
lime FOImal----,rHumbel FOImal---' 

6:52:37 PM I Change ... I 1.234.22 I Change ... I 

The first four options in the dialog box are drop-down list boxes that present the 
choices for country, language, keyboard layout, and system of measurement. The 
next option is a text box where you can fill in the list separator. If you want to 
accept the standard choices for your country, select the country and then choose 
OK. To personalize the settings, select from the following options: 

Use this option 

Country 

Language 

Keyboard 
Layout 

To do this 

Specify the country whose standard settings you want to 
use. When you choose a country, the other option groups 
change to show the standard settings for that country. 

Specify the language you want to work in. Windows appli
cations that provide language-specific tasks, such as 
sorting or case conversion, use this setting. 

Specify the keyboard layout of your computer. The 
keyboard layout varies from country to country to 
accommodate the special characters and symbols that 
are part of the language for that country. This setting tells 
Windows how to interpret the keys that you press. 
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Use this option To do this 

Measurement Select the metric or English system of measurement. 

List Separator Enter the symbol you want to use to separate elements in a 
list. In English, the list separator is typically a comma and 
is used to separate words or numbers in a sentence when 
they appear in a series. 

Date Format 
You can change the format used to display the date within applications that have a 
date function. For example, you can vary the order of month-day-year or change 
the punctuation used to separate those parts of the date. 

[> To change the date format: 

1. Move to the Date Format box and choose the Change button. 

Control Panel displays the Date Format dialog box . 

. International - Date Format. 

Shorl Dale Formal OK 

!!rder: @l~J:>'Y.1 0 DMY 0 YMD Cancel 

lieparalor: [0 
[8J I!ay leading Zero (07 YS. 7) 

o Monlh leading Zero (02 YS. 2) 

[8J .cenlury (90 YS. 1990) 

long Dale Formal----------, 

Older: @ MOY 0 OMY 0 YMO 

I Sunday IflDIMarch IflOlo4 If lDI1990 If I 

Sunday. March 4 • 1990 

2. Set the options you want for both the Short and Long Date Format; then 
choose OK. 
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The Short Date Format displays the date as three numbers, representing the month, 
day, and year. You specify the order and number of digits for each part of the date. 
The Long Date Format displays the date as a combination of words and numbers
for example, Monday, October 15,1989, or a variation you specify. The options 
for both formats are described in the following table: 

Use this option 

Order 

Separator 

Day!Month Leading 
Zero 

Century 

Long Date Format 
options 

Time Format 

To do this 

Specify the order of the month (M), day (D), and year 
(Y). This option works the same for Short and Long 
Formats. 

Enter the symbol you want to use to separate the 
month, day, and year. You can specify any character as 
the separator, though the most common are the 
slash (I) and the hyphen (-). 

Specify that the day or month always be displayed as 
two digits. For example, February 7 would be dis
played as 02-07. 

Specify that the year be displayed as four digits. For 
example, December 10, 1989, would display as 
12-10-1989. 

Specify alternative choices for the Long Date Format, 
including abbreviations for the words and different 
separators. 

You can choose either the 12-hour or 24-hour format, specifying the separator 
between the parts and displaying numbers representing the hours before 10 with 
a leading zero if you want. You can also add suffixes to the date (for example, 
English suffixes such as AM to indicate morning or PST for Pacific Standard 
Time). 
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[> To change the time format: 

1. Move to the Time Format box and choose the Change button. 

Control Panel displays the Time Format dialog box for the selected country. 

International - Time Format 

@ 1~ hour 00:00-11:59 ~ 
o 2! hour 12:00-23:59 ~ 

.s.eparalor: D 
leading Zero: @ r~.~I$.J 0 09:15 

OK 

Cancel 

2. Select the options you want and then choose OK. The following table 
describes each option. 

Use this option 

12-hour/24-hour 

AM/PM 

Separator 

Leading Zero 

To do this 

Display time in numbers representing the hours 
between 1 and 12 or between 0 and 23. 

If you use the 12-hour format, specify your country's 
notation for before noon in the top text box next to 
00:00-11 :59. 

If you use the 12-hour format, specify your country's 
notation for after noon in the lower text box next to 
12:00-23:59. 

If you use the 24-hour format, you can only use the 
lower text box to specify any special suffix, such as 
PST. 

Choose the character you want Windows to use to 
separate the hours, minutes, and seconds. Any char
acter is allowed, but the most common is the colon (:). 

Display the hours before 10 as a two-digit number, 
with the ftrst digit being a O. For example, 9 o'clock 
would be displayed as 09:00. 
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Currency Format 
t> To change the currency format: 

1. Move to the Currency Fonnat box and choose the Change button. 

Control Panel displays the Currency Fonnat dialog box. 

International- Currency Format 

Symbol ~Iacement: M&~ OK 

Hegative: I ($123.22) I! I Cancel 

fuombol: U 
I!ecimal Digits: ~ 

2. Set the options you want and choose OK. The following table describes each 
option. 

Use this option 

Symbol Placement 

Negative 

Symbol 

Decimal Digits 

To do this 

Specify the placement and spacing of the currency 
symbol relative to the amount. 

Select the way you want negative numbers to be 
displayed. 

Select the currency symbol for your country. 

Specify the number of digits you want Windows to 
display after the decimal separator. 
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Number Format 
You can control the way numbers are displayed in Windows and many Windows 
applications. 

t> To change the number format: 

1. Move to the Number Format box and choose the Change button. 

Control Panel displays the Number Format dialog box. 

International - Number Format 

1000 ~eparalor: [[] OK 

Qecimal Separator: D Cancel 
D~cimal Digits: ~ 

leading Zero: @.7 00.7 

2. Set the options you want and choose OK. The following table describes each 
option. 

Use this option 

1000 Separator 

Decimal 
Separator 

Decimal Digits 

Leading Zero 

To do this 

Change the punctuation used to separate thousands. 

Change the punctuation used to separate the fractional 
part of a decimal number from the whole number part. 

Specify the number of digits to display after the decimal 
separator. 

Choose whether or not numbers less than 1 are preceded 
by a zero. 
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Customizing Use of the Mouse 
You can make several adjustments to the way Windows works with your mouse, 
including switching the functions of the left and right buttons, changing the speed 
of the double-click, or changing the speed at which moving the mouse moves the 
pointer. 

[> To customize use of the mouse: 

1. Choose the Mouse icon from the Control Panel window. 

Control Panel displays the Mouse dialog box. 

Mouse 

Qouble Click Speed 
Slow Fasl 

1 + I::::::::{{(:{)(:I I::){){):::I + I 
~ 0 ~wap left/Righi Bullons 

2. If you want to change the speed at which the pointer travels across the screen, 
use the Mouse Tracking Speed scroll bar. To change the speed, drag the scroll 
box toward Fast or Slow or click the appropriate scroll arrow. 

Or press TAB to move to the Mouse Tracking Speed box, and then press 
RIGHT ARROW or LEFT ARROW to move the scroll box. 

3. If you want to change the speed at which Windows will register a double-click 
when you press your mouse button, use the Double Click Speed scroll bar. 
Drag the scroll box toward Fast or Slow, or click the appropriate scroll arrow. 

Or press TAB to move to the Double Click Speed box, and then press 
RIGHT ARROW or LEFT ARROW to move the scroll box. 

If you increase the speed, double-click the Test button to make sure you're 
clicking fast enough for the new setting. The Test box will invert to show that 
your double-click is fast enough. 
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4. If you want to switch the functions of the left and right buttons, select the 
Swap Left/Right Buttons check box. 

Many applications use the left button as the primary tool for selecting text and 
choosing items. If you are left-handed, you might find it more convenient to 
switch the two buttons. Notice that the mouse diagram in the dialog box 
reflects your choice, and be aware that this change takes effect immediately, 
before you close the dialog box. Thus, if you switch the buttons, you need to 
click the right button to choose OK or Cancel, or to switch the buttons again. 

5. Choose OK. 

Setting the System Date and Time 
You can change the system date and time by using the Date!fime option. The 
system date and time are reflected in Clock and Calendar (two of the Windows 
accessories), as well as in the information kept by File Manager for each file you 
save on your disk. The format of the date and time depends on the international 
settings you chose (see "Setting International Options" earlier in this chapter). 

[> To change the date: 

1. Choose the Date!fime icon from the Control Panel window. 

Control Panel displays the Date & Time dialog box. 

Date & Time 

r
Date 

1218189 
II OK I 

[ill Cancel I 

rTime 

I ~ 11:59:04 PM [il 

2. Select the part of the date (day, month, or year) that you want to change. 

3. Type the new value for the selected part. 

Or click the arrows at the right of the Date text box to change one date element 
(day, month, or year) at a time. (Or press UP ARROW or DOWN ARROW.) 

4. Choose OK. 
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[> To change the time: 

1. Select the part of the time (hour, minute, second, suffix) you want to change. 

2. Type the new value for the selected part. 

Or click the arrows at the right of the Time text box to change the selected part 
one unit at a time. (Or press UP ARROW or DOWN ARROW.) 

3. Choose OK. 

Adjusting Keyboard Speed 
The Keyboard option allows you to specify how fast a key repeats when you hold 
it down. 

[> To change the keyboard repeat rate: 

1. Choose the Keyboard icon from the Control Panel window. 

Control Panel displays the Keyboard dialog box. 

Keyboard 

Key !lepeat Rate--------, r-;::;;--J 
Slow Fast ~ 

2. Drag the scroll box toward Fast or Slow or click the appropriate scroll arrow. 

Or press RIGHT ARROW or LEFf ARROW to increase or decrease the rate. 

3. If you want to test the speed, move to the Test Typematic box and hold down 
any key on the keyboard. Readjust the scroll box position until you reach a 
speed with which you are comfortable. 

4. Choose OK. 
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Controlling Sound 
Windows uses a warning beep to signal you when you attempt to do something 
that is not allowed, but you can tum this sound off at any time. 

[> To turn the warning beep on or off: 

1. Choose the Sound icon from the Control Panel window. 

Control Panel displays the Sound dialog box. 

2. Click the Warning Beep check box. 

Or press the SPACEBAR to tum the option on or off. 

3. Choose OK. 

Setting Options for Running in 386 Enhanced 
Mode 

If you are running in 386 enhanced mode, the Control Panel window will include a 
386 Enhanced icon. The options represented by this icon allow you to specify how 
the various applications compete for peripheral devices and how much of the com
puter's resources are allocated to Windows and non-Windows applications. 

iii Control,Panel a 
.s.eHings .!::!.elp 

~~~ A~ -= 
L:3 [Qi] p " -Color Fonts Ports Mouse Desktop Network 

~ ~ &1 Jm1 rfl~ , 
Printers International Keyboard DatelTime Sound 1I1_1IIft1 

Handling Device Contention 

When more than one application is running at the same time in 386 enhanced 
mode, they sometimes request the use of a device such as a printer or modem at 
the same time. The device contention options determine how Windows arbitrates 
these requests. 
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The device contention options apply only when a non-Windows application is one 
of the applications requesting access to the device. When more than one Windows 
application requests access to a device, Windows handles their use of the device 
without these options. 

[> To specify how to handle contention for a device: 

1. Choose the 386 Enhanced icon from the Control Panel window. 

Control Panel displays the 386 Enhanced dialog box. 

386 Enhanced 

Device Contention-------. '---1. 

LJ
~T1 0 Always Warn OK 

o Never Warn Cancel 

@ Idle (in sec.) ~ 

Scheduling----------, 

Windows in [oreground: 1100 ftl 
Windows in !!ackground: ~ 

D .Exclusive in Foreground 

Minimum Timeslice (in msec): ~ 

2. Select the port that is connected to the device you want to control. 

3. Set the options you want and choose OK. 

The device contention options are described in the following table. Generally, it is 
a good idea to accept the standard settings. Situations that might warrant changing 
the settings are included in the option descriptions. 

Use this option 

Always Warn 

To do this 

Specify that a warning message be displayed every time 
an application tries to use the device when the device is 
already in use. The warning message asks you which 
application should be given control of the port. In most 
situations, you will want to select this option. 
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Use this option 

NeverWam 

Idle 

To do this 

Specify that any application can use the device at any time, 
without a warning message. However, this means that two 
applications could conceivably try to use the same device 
at the same time, with undesirable results such as a garbled 
printed document. 

For example, it .would make sense to select this option 
when you are absolutely sure that no more than one 
printing or communicating application will try to use the 
device at the same time. 

Specify the number of seconds after an application stops 
using a device before another application can use the same 
device without causing the warning message to be dis
played. The range is from 1 to 999 seconds. 

For example, it would make sense to specify idle time 
when the device is capable of switching back and forth 
between two applications. For example, you might use 
Cardfile to automatically dial an on-line service and then 
switch to another application to communicate with the 
service. In this example, you would specify a short delay, 
such as 2 seconds. 

Setting Multitasking Options 

The other 386 enhanced mode options are used to determine how Windows 
behaves when multitasking. These options are summarized in the following list 
and explained more completely in Chapter 12, "More About Applications." 

Use this option 

Minimum 
Timeslice 

To do this 

Specify the number of milliseconds an application is 
allowed to run before Windows gives processor control to 
another application. Notice that all Windows applications 
share one timeslice, and each non-Windows application 
gets its own timeslice. 



Use this option 

Windows in 
Foreground 

Windows in 
Background 

Exclusive in 
Foreground 
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To do this 

The smaller the timeslice, the more frequently Windows 
switches between applications. Frequent switching makes 
running more than one application at a time seem 
smoother. However, overall system performance declines. 
Specifying a larger timeslice increases performance, but 
makes the switching operation more apparent. 

Specify the amount of processing time (the proportion of 
total time slices ) normally shared by all Windows applica
tions. When a non-Windows application is the active 
application (foreground), Windows uses the value for 
Windows in Background. The number specified is relative 
to the time allocated to all non-Windows applications run
ning in the background. The range of numbers that can be 
entered is from 1 through 10,000, but the important value 
is the ratio between this setting and the sum of this setting 
and the settings for the running non-Windows applications 
(background set in the PIF). See Chapter 12, "More About 
Applications," for information on PIF editor. 

Specify the amount of processing time (the proportion of 
total timeslices) normally shared by all Windows applica
tions when a non-Windows application is running in the 
foreground. The range of numbers that can be entered is 
from 1 through 10,000, but the important value is the ratio 
between this setting and the sum of this setting and the 
settings for the foreground application and all other non
Windows applications running in the background. 

Specify that Windows always gets 100 percent of the com
puter's processing time whenever a Windows application 
is the active application. In other words, if a Windows ap
plication is in the foreground, all Windows applications 
run and no non-Windows applications run. 

NOTE When running Windows in 386 enhanced mode, even non-Windows applications 
can appear in Windows. However, that does not mean they are Windows applications. 

See Chapter 12, "More About Applications," for more information about adjusting 
the priorities for individual non-Windows applications and about multitasking 
Windows and non-Windows applications. 
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Printing with Windows Applications 
After you connect your printer to your computer and install it using Control Panel, 
you can print information from Microsoft Windows applications. If you have not 
yet installed your printer and need assistance, see Chapter 5, "Control Panel." 

You might find slight differences in the way you print with different Windows 
applications. To make sure you understand any differences that exist, it is a good 
idea to read the documentation on printing that comes with an application. 

When you print from a Windows application, the application creates a print file 
and sends it to the Windows Print Manager. From this point on, Print Manager 
manages the printing of the file. Working with Print Manager is the same in each 
application. 

The appearance of your printed copy depends on whether or not your application 
allows you to assign fonts, the fonts and formats you assign, and the fonts and 
formats your printer can print. Printers differ in their abilities to use fonts, 
graphics, spacing, alignment, and character formats. The appearance of printed 
copy can vary greatly from printer to printer. Although some applications attempt 
to display files on the screen in the same format that you will see on the printed 
page, you might need to experiment with your printer to get the results you want. 

Printing with Non-Windows Applications 
When you print from a Windows application, the application uses the Windows 
printer drivers and Print Manager. When you print from a non-Windows applica
tion that you have started from Windows, the non-Windows application prints just 
as it would if you had started it from MS-DOS. It does not use Print Manager or 
any Windows printer drivers. If you want it to do so, you must transfer the infor
mation you want to print into a Windows application. See Chapter 2, "Basic 
Skills," and Chapter 12, "More About Applications," for more information on 
using non-Windows applications. 
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Printing with Print Manager 
When you print from a Windows application, the application sends the print file to 
the Windows Print Manager. Print Manager works in the background, sending 
your files to the printer while you continue working. As you send files to Print 
Manager, Print Manager forms a print queue-a list indicating the file currently 
printing and those files waiting to be printed. You can check on the status of a file 
in the print queue at any time and change the status of the file up until the time that 
it starts printing. 

Looking at the Print Queue 

There are two types of print queues: local and network. The local queue defines a 
list of files printed from a Windows application to a printer connected locally to 
your computer (that is, the computer and the printer are directly connected by a 
cable). 

The network queue refers to the print queue on the network server. This queue is 
generally managed by a network print manager, which is completely separate from 
the Windows Print Manager. To properly print over a network queue, you should 
have a Windows network driver installed (see Chapter 5, "Control Panel," for 
more information on networks). When running with a network printer, Print 
Manager tracks the progress of your print files on the network print manager. The 
standard method is for print files to be passed directly through to the network 
queue, where they are spooled to the printer. 

When Print Manager starts printing to a local queue, its icon appears at the bottom 
of your screen. If you enlarge the icon to a window, you see the print queue for 
any active printer connected to your computer. You can use the Print Manager win
dow to check the status of the files in the print queue or to interrupt or cancel the 
printing of the print queue. 

When Print Manager prints to a network queue, the file is sent directly to the net
work printer. To view the status of your print job, you must start Print Manager 
from the Program Manager group. There is no Print Manager icon at the bottom of 
your screen when you print to a network queue. 
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t> To look at the print queue: 

[J Choose the Print Manager icon from the Main Group window. 

r A file information line 
_ The printer queue information line for a local queue r Message box 

Options View Help I 
fause I Resume -'- .P.\\h\ttl lIThe pel I HP laserJet on LPn (local) is Printing I 

25% of 12K 4:45 PM 9-29-1989 
6K 4:47 PM 9-29-1989 

25K 4:49 PM 9-29-1989 

100K 4:47 PM 9-29-1989 

_ The printer queue information line for a network queue 

The printer queue information line in the print queue tells you the following: 

The name of the printer 

Where the printer connects to your computer 

The current status of the printer 
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The file information line gives you information specific to the file, such as: 

• The title of the print job assigned by the application (if your network software 
supports this) 

• The file's position in the queue or a printer icon if the file is printing 

• The size of the file in kilobytes (if the Print File Size command is turned on) 

• The time and date you sent the file to Print Manager (if the TimelDate Sent 
command is turned on) 

If a file is currently printing, its information line also tells you the amount (as a 
percentage) of the file printed so far. 

If you have more than one printer connected to your machine, you see multiple 
printer queue information lines and you might see a print queue for each printer. If 
you are connected to a network printer, the printer queue information line shows 
the network server connection. Any detailed information the network can provide 
appears in the message box at the upper-right comer of the Print Manager window. 
Networks can provide varying degrees of detailed information. 

Print Manager only reports the status of the files that you send to the network in 
your Print Manager window. If you want to see all the files in a network queue, 
see "Viewing the Entire Network Queue" later in this chapter. 

Changing the Order of the Queue 

You can change the position of a file in a local print queue, as long as that file has 
not yet begun to print. However, you cannot change the position of files in a net
work queue. 

[> To change the order of the queue: 

[] Select the file whose position you want to change, drag it to its new position in 
the print queue, and then release the mouse button. 

Or select the file, hold down CTRL, and press UP ARROW or DOWN ARROW to 
move the file to its new position. Then release CTRL and the ARROW key. 

The numbers and file information in the print queue change to reflect the new 
positions of the files. 
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Pausing and Resuming Printing 

U sing buttons in the Print Manager window, you can interrupt the printing of a 
print queue. Some networks allow you to pause an individual print file. However, 
your ability to interrupt a network queue depends on the specific features the net
work supports. 

Qptions Y:iew .!ielp 

fa,,!se I Resume I .!?.d(~ttl liThe peL I HP LaserJel on LPTl (Local) is Paused 

1L...-_----I.1 ___ .l...--1 _ Use these buttons to interrupt, 
resume, and cancel printing. 

t> To temporarily interrupt printing: 

1. Select the information line for the printer queue (local) or the print file 
(network). 

2. Choose the Pause button. 

Or press ALT + P. 

The information line for the printer now indicates that printing has paused. 

[> To continue printing after interrupting it: 

1. Select the information line for the printer queue (local) or the print file 
(network). 

2. Choose the Resume button. 

Or press ALT + R. 

The selected information line changes to indicate that printing has resumed. 
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Deleting a File from a Print Queue 

You can use the Delete button in the Print Manager window to delete a file from a 
print queue at any time. 

[> To delete a file from a print queue: 

1. Select the information line for the file from the print queue. 

2. Choose the Delete button. 

Or press ALT + D. 

A dialog box appears, asking you to confirm the deletion. 

3. Choose OK. 

[> To delete all files from all print queues: 

1. Choose Exit from the Options menu. 

A dialog box appears, asking you to confirm the deletion. 

2. Choose OK. 

If you do not choose OK, Print Manager will continue to operate, and the files 
will continue to print. 

CAUTION If you delete a file currently printing in graphics mode, you might need to reset 
your printer to ensure that the printer's buffer is clear. (Turn it off and back on again or 
select the Reset option, if available. It is most important to do this with Laser-type printers.) 

Changing the Printing Speed 

You can specify the rate at which information is transferred from Print Manager to 
the printer ports by using the Low Priority, Medium Priority, and High Priority 
commands on the Options menu. 



A checkmark next to a command 
indicates the current setting. 

\PRT31155\APL31155 .A.ctrv'e] 
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[> To increase printing speed and slow down applications: 

o Choose High Priority from the Options menu. 

This setting uses more of your computer's processor time for Print Manager, 
causing other applications to run more slowly. 

[> To print and run applications equally: 

o Choose Medium Priority from the Options menu. 

This setting shares your computer's processor time as equally as possible between 
Print Manager and other applications that are running. This is the standard setting. 

[> To decrease printing speed and run applications faster: 

o Choose Low Priority from the Options menu. 

This setting uses more of the computer's processor time to run applications, 
causing Print Manager to slow down. 

The setting you choose remains in effect until you use the Options menu to 
change it. 
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Displaying Print Manager Messages 

Occasionally, Print Manager needs to display a message. For example, if your 
printer is set up for manual paper feed, Print Manager will request that you feed in 
a new sheet of paper. The Options menu provides three commands for controlling 
the way Print Manager handles this type of message. 

\',PRT31155\APL31155 [Active] 

These commands determine how 
Print Manager displays messages. 

The following table describes these commands: 

Menu command 

Alert Always 

Flash if Inactive 

Ignore if Inactive 

Function 

Immediately displays a message box when a condition 
occurs that requires user interaction. 

Beeps once and flashes the Print Manager icon or the 
title bar of the inactive Print Manager window until you 
enlarge the icon or make the window active. Then Print 
Manager displays its message. This is the standard 
setting. 

Ignores the condition requiring user interaction when 
Print Manager is an icon or the Print Manager window 
is inactive. 

The command you choose remains in effect until you use the Options menu to 
change it. 

NOTE These commands do not control the display of system messages, such as a 
notification that your printer is off-line. 
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Displaying the Time/Date and File Size 

When you first enlarge the Print Manager icon, a print queue automatically dis
plays the time and date you sent a file to Print Manager and the size of the file. If 
you do not want to see the time and date or the file size, you can tum off either 
option by choosing the appropriate command from the View menu. 

[> To turn off the time and date or file size display: 

o Choose TimelDate Sent or choose Print File Size from the View menu. 

The checkmark next to the command on the View menu disappears, and the infor
mation disappears from the Print Manager window. If you want to display the time 
and date or file size again, choose the appropriate command again from the View 
menu. 

Exiting from Print Manager 

If running as an icon, Print Manager terminates automatically (and frees the 
memory it was using) when it finishes printing. If the Print Manager window is 
open, it does not terminate automatically. 
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[> To exit from the Print Manager window: 

[J Choose Exit from the Options menu. 

If filenames remain in the print queue, a dialog box appears, asking if you want to 
cancel the printing of these files. If you choose OK, Print Manager does not print 
the remaining files. 

Printing on a Network 
If you are set up to print on a network, Print Manager offers a number of options 
to assist you. For example, you can: 

• View all the files in a network printer's queue, instead of just the files you send 
to the printer. 

• View a network queue that you are not currently connected to. 

• Bypass Print Manager and print directly to the network. 

You can also tell Print Manager to ignore the status of a network print queue to cut 
down on network traffic during periods of heavy network use. 

For information about setting up to print on a network, see Chapter 5, "Control 
Panel." 

NOTE The level of support for the following options depends on the capabilities of your 
network software and the support provided in your Windows network driver. 

Viewing the Entire Network Queue 

When you print a file on a network printer, Print Manager displays a print queue 
that shows only the files you have sent to that printer. The Selected Net Queue 
command lets you see all the files sent to that printer. 

[> To view the entire queue for a network printer that you are connected to: 

1. Select the information line for the printer queue in the Print Manager window. 

2. Choose Selected Net Queue from the View menu. 

Print Manager displays the entire queue for the selected printer. 
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3. Choose Close to close the dialog box. 
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You can choose Selected Net Queue from the View menu at any time to display an 
updated queue for a network printer that you are connected to. 

Viewing Other Network Queues 
In addition to viewing queues for network printers that you are connected to, you 
can view queues for network printers that you are not connected to. This allows 
you to look at how many files are in the queues for different network printers 
before deciding which one you want to print to. However, you must use Control 
Panel to connect to a network printer before you can print to it. See Chapter 5, 
"Control Panel," for more information. 

[> To view the queue for a network printer you are not connected to: 

1. Choose Other Net Queue from the View menu. 

The Other Net Queue dialog box appears, asking for the location and name of 
the network queue you want to view. 

2. Type the network pathname to the network print queue in the Network Queue 
box and choose View. 

Print Manager displays the status information for the queue in the box above 
the Network Queue box. See your network software documentation for infor
mation on how to enter the network pathname. 
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3. Type the name of another queue that you want to view, or choose Close when 
you want to close the Other Net Queue dialog box. 

NOTE Remember, viewing a queue for a network printer that you are not connected to 
does not connect you to that network printer for printing. You must use Control Panel to 
connect to the network printer before you can print. 

Manual Updating of the Network Queue Status 

The network queue status is updated automatically on a periodic basis or when a 
change on the network has occurred. This depends on your network software. In 
some cases, you may want to update the network queue status manually. 

[> To update the network queue status manually: 

[J Choose Update Net Queues from the View menu. 

Print Manager will update the network queue information. 

Automatic Updating of the Network Queue Status 

When running as an icon, Print Manager does not update the status of the file in 
the network print queue. If you enlarge the Print Manager icon, Print Manager 
automatically updates the status of the network queue, and it continues to do so 
periodically. However, if you are concerned about network traffic, or you do not 
need to view the network status, you can tell Print Manager to ignore the status of 
a network queue, even when you enlarge the Print Manager icon. 
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t> To have Print Manager ignore the status of a network queue: 

1. Choose Network from the Options menu. 

The Network Options dialog box appears. 

Clear this check box to ignore 
the status of a network queue. 

~ [!l.~.~~.!.~~H~I~.~~i.'f~J!.p.!.~i.! 
~ Print Net Jobs Direct 

2. Clear the Update Network Display box. 

3. Choose OK. 

All the print jobs will now be tracked on your computer as if they were on a local 
queue. You will not see the status of the network queue with this option turned off. 
And the print job status will not be updated until you tum on this option again. 

Bypassing Print Manager 

When you want to print on a network printer, you can save time by bypassing 
Print Manager. Routing the file through Print Manager adds an extra step that can 
delay printing over a network. Therefore, by default, Windows prints files directly 
to the network, bypassing Print Manager. However, sometimes you might prefer to 
use Print Manager. This will depend on your network. Therefore, you may need to 
experiment with both options to determine which is best for you. In most cases, it 
is faster to bypass Print Manager and print directly to the network printer. 
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[> To print directly to the network: 

1. Choose Network from the Options menu. 

The Network Options dialog box appears. 

Network Options 

r8l (ii.~.~:~.!.~::~.~!~.~!~::.~:;'~.p'J.~i.j 
r8l flint Net Jobs Dilect 

Select this box to 
bypass Print Manager. 

2. Select the Print Net Jobs Direct box. 

3. Choose OK. 

This option remains turned on until you select it again. 

You can also bypass Print Manager by clearing the Use Print Manager check box 
in the Printers dialog box in Control Panel. Using the Print Net Jobs Direct option 
in the Network Options dialog box, however, allows you to bypass Print Manager 
but still have Print Manager report on the status of the network print queue. 

Printing to a File 
There may be times when you want to format a spreadsheet, report, or other docu
ment and print it to a file rather than to a printer. You might do so to accomplish 
the following: 

• Merging into another document 

• Printing at a later time or at a different location 

• Printing several times by copying repeatedly to a printer 
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[:> To print to a file: 

1. Choose Control Panel from the Main Group window or enlarge the Control 
Panel icon. 

2. Choose the Printers icon. 

The Printers dialog box appears. 

3. In the Installed Printers box, select the name of the printer you eventually want 
to print the file to. 

4. Choose Configure. 

The Configure dialog box appears. 

5. In the Ports box, select FILE as your port. 

6. Choose Setup and make sure your print options are set properly. 

7. Choose OK three times to return to the Control Panel window. 

8. Return to your application and follow the instructions to finish printing your 
document to a file. 

While you are connected to a file, Print Manager prompts you for the filename 
each time you print from an application. In addition to the filename, you may also 
specify a drive and directory in which you want to store the file. 

If Things Go Wrong 
Occasionally you might have trouble printing with Windows. The following 
sections describe how to recognize and fix the most common printing problems. 

Most of the sections describe a printer problem and offer suggestions for 
correcting the problem. In most cases, as you follow the steps suggested to find 
and solve a problem, you should print each time you try a step. If Windows prints 
correctly, then you've solved the problem. If not, you should go on to the next 
step. You might have to do some experimenting with your printer to discover why 
a document doesn't print or why it prints incorrectly. 
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If Your Printer Does Not Print at All 

When a printer won't print, the cause is often a simple mechanical problem such 
as the printer being off-line, turned off, or disconnected. Use the following check
list to see if you can find the problem: 

• Do you have the correct cable for your printer and is it properly connected? 

• Is the printer plugged in and turned on? 

• Is the correct printer selected as the default printer? (See "Choosing the Default 
Printer" in Chapter 5.) 

• Are the print options settings correct? (See "Setting the Print Options" in 
Chapter 5.) 

• Have you chosen the correct port for the selected printer? (See "Selecting a 
Printer Port" in Chapter 5.) 

• If you have a serial printer, are the settings in the Ports-Settings dialog box 
correct? (See "Selecting a Printer Port" in Chapter 5.) 

• Do you need to change the ribbon, mount a print wheel or cartridge, or add 
paper? 

If you complete the checklist and still can't print, you should quit the application 
you are working with and try to print a text file from the Windows File Manager. 
See Chapter 4, "File Manager," for instructions. 

If you still can't print, you have a problem with the printer or a problem with the 
cable. Try connecting the printer again. If this doesn't help, contact your printer 
manufacturer or dealer. 

If the Printer Advances the Paper but Does Not Print 

When your printer advances the paper but doesn't print, you might have missed 
one of the following requirements: 

• Select the correct paper source when you set up print options. 

• Select the correct printer name when you set up print options. 

• Configure the correct printer-driver file for your printer. 

See "Installing a Printer" and "Configuring a Printer" in Chapter 5 for the 
appropriate procedures. 



Chapter 6 Print Manager 213 

If the Page Prints but Is Formatted Incorrectly 

If the pages of a document are formatted incorrectly, the margins are incorrect, the 
document contains extra lines, or the document is paginated incorrectly, use this 
checklist: 

• Are the formats you chose in your application accurate, especially font and 
point size selections? 

• Is the correct printer selected as the default printer? (See "Choosing the Default 
Printer" in Chapter 5.) 

• When you installed your printer, did you select the correct printer name when 
you set up printer options? (See "Choosing a Printer" in Chapter 5.) 

• When you set up your printer, did you select the correct paper source? (See 
"Setting the Print Options" in Chapter 5.) 

• Does your printer have hardware switches that set page length or line length? 
(Check your printer manual.) 

• Does your printer have a hardware switch that does an automatic linefeed at 
each carriage return? (Check your printer manual.) 

The switch that controls the automatic linefeed at a carriage return should be 
set to do carriage returns only. 

If Printer Output Is Garbled 

If you can print your document, but it is garbled, unreadable, or contains extra 
characters in front of the text, use this checklist: 

• Is the correct printer selected as the default printer? (See "Choosing the Default 
Printer" in Chapter 5.) 

• When you installed your printer, did you select the correct printer name when 
you set up printer options? (See "Choosing a Printer" in Chapter 5.) 

If the wrong printer or the wrong font cartridge is selected, the printer may 
insert stray characters at the beginning of lines or behave in other unpre
dictable ways. 

• If you have a serial printer, are the settings correct in the Ports-Settings dialog 
box? (See "Selecting a Printer Port" in Chapter 5.) 

Lowering the baud rate might cause the printer to print correctly. 
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• Does Windows have another printer-driver file that might be compatible with 
your printer? If so, try using it. 

For example, if your printer is an Epson ® or IBM-compatible printer, one of 
the printer-driver files for another Epson or IBM printer might work with your 
printer. 

• Has your printer's buffer retained garbled information? Try turning the printer 
off and back on again. 

• Is your printer cable working properly? Verify that you have the correct cable 
and that it is functioning. 

As a last resort, you might try installing the Windows Genericffext Only printer
driver file to see how it works with your printer. 

You may also want to contact your dealer or printer manufacturer to determine if 
there is a problem with your printer. 

If Printer Output from Two Files Gets Mixed 

If the printer output from two files comes out mixed together, use this checklist: 

• Did you have a Windows application and a non-Windows application assigned 
to the same port, switch between them, and then try to print from both of them 
at the same time? 

• Did you have two non-Windows applications assigned to the same port, switch 
between them, and then try to print from both of them at the same time? 

Print Manager cannot help you in either of these two cases. When running 
Windows in real or standard mode, there is no way for the system to warn you 
about device-contention problems. When running Windows in 386 enhanced 
mode, you would see a message advising you to resolve this device-contention 
situation before the printer would print. 

If Your Laser Printer Does Not Print Your Cartridge or Soft Fonts 

If you install a font cartridge or soft fonts for your laser printer, but the printer 
doesn't use the fonts, use this checklist: 

• Are the print options settings for your printer correct? (See "Setting the Print 
Options" in Chapter 5.) 
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• If you are using a font cartridge, is it all the way in the slot? (Tum off the 
printer before checking this.) 

You may need to press firmly on the cartridge until it pops into the slot. 

• If you are using any soft fonts, are they properly installed? (Refer to the 
installation kit provided with your soft fonts.) 

• If your soft fonts are installed as permanent, perhaps the printer was turned off 
or reset. Try downloading the soft fonts to the printer again. 

• If you are using too many soft fonts, your printer might have run out of 
memory. Try installing fewer fonts or installing them as temporary fonts, if 
appropriate. 

If the Printer Loses Text 
If you have a serial printer and it prints the document but loses blocks of text, you 
might have a handshake or flow control problem with your communications port. 

To check for a handshake or flow control problem, use this checklist: 

• Are the settings in the Ports-Settings dialog box correct? (See "Selecting a 
Printer Port" in Chapter 5.) 

Lowering the baud rate might cause the printer to print correctly. 

• If you are still losing text, can you change to a lower baud rate than the one you 
are using now? 

• If you have a parallel interface, is the cable faulty? Try using a new cable of the 
same type. 

To check for other problems, use this checklist: 

• Are all the manual switches on your printer set as described in the printer's 
documentation? 

• Are you using the correct printer-driver file? 

Try printing with the Genericffext Only printer driver. 
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If Only Pari of a Page Prints 

If your printer prints only part of your document, use the following checklist: 

• Does the paper size you chose when setting up the printer match the paper 
loaded in the printer? 

• Are you printing with a PCL/HP LaserJet ® printer? If so, your printer might 
not be able to print every available graphics resolution as a "full page. There 
might be too much information on a page for your printer's memory to handle. 

When this happens, you might get a message on your printer indicating the 
problem. Try printing at a lower graphics resolution. (For more information, 
see "Setting the Print Options" in Chapter 5. Also see your printer manual for 
more information on printing graphics with a PCL printer.) 

If Lines Are Missing from a Paintbrush Drawing 

If lines seem to be missing from the printed copy of a Paintbrush drawing, you 
have probably set a width and/or height in Paintbrush's Page Setup dialog box that 
is too small for the width and/or height setting in the Image Attributes dialog box. 
When this happens, line information for the drawing can be lost when Paintbrush 
shrinks the picture for printing. 

You can usually solve this problem by proportionally increasing the dimensions of 
the printed drawing in the Page Setup dialog box. The best way to avoid the prob
lem is to print using the standard margin settings in the Page Setup dialog box or 
use the Shrink + Grow command on Paintbrush's Pick menu to shrink the 
drawing to a smaller size before printing. 





r: 

Windows Accessories 

CHAPTERS 

7 Write . ...................................... 221 

8 Paintbrush . ................................. 259 

9 Terminal . ................................... 315 

10 Additional Accessories ......................... 355 



Chapter Write 
7 

Creating a Document ............................................ 223 

Typing Text ........................................... 224 

Editing a Document .............................................. 224 

Moving Around in a Document ........................... 224 
Selecting Text ......................................... 226 
Finding and Changing Text ............................... 227 
Inserting Optional Hyphens .............................. 231 
Editing Pictures in Write ................................. 232 
Breaking a Document into Pages .......................... 234 

Formatting Your Document ....................................... 237 

Formatting Characters ................................... 237 
Changing Fonts and Font Sizes ............................ 239 
Formatting Paragraphs .................................. 240 
Formatting a Whole Document ............................ 246 

Managing Write Files ............................................ 253 

Opening a Microsoft Word Document ...................... 253 
Opening a Windows Text File ............................. 253 
Opening a N on-Windows Text File ........................ 254 
Saving a Document ..................................... 254 
Making a Backup Copy .................................. 255 

221 



222 

Printing a Document ............................................. 255 

Changing Printers and Print Option Settings .................. 257 



Chapter 7 Write 223 
~ 

Creating a Document 
Microsoft Windows Write is a word processing application that you can use to 
create and print documents for day-to-day business and personal use. To create 
Write documents, you need to know how to type, edit, and format text in the Write 
window; save the text to a file; and print your documents on your printer. The 
following sections explain each of these tasks. 

t> To start Write: 

1. Open the Accessories window. 

2. Double-click the Write icon. 

Or select Write and choose Open from the File menu. 

The following blank, untitled, Write window appears. 

Insertion point 

I End mark 

File I Edit Search Character Paragraph Document Help 

•• I -

I 

+1 I::::: ........................ . 

Mouse pointer 
... Page status area 

.. .......................... :.:.:.:.;:; ;:;:;:::::;:;::J+ 
~ 
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Typing Text 

In the Write window, you see the following items: 

• The insertion point indicates where text appears when you start typing. When 
you start Write or open an existing document, the insertion point appears in the 
upper-left comer of the Write window. 

• The end mark indicates the end of a document. When there is no text in a Write 
window, the end mark is directly to the right of the insertion point. 

• The page status area indicates which page of your text is currently on the 
screen. Until you break a document into pages, you will see only "Page 1" in 
the page status area. 

• The mouse pointer appears only if you have a mouse connected to your com
puter. It indicates where the mouse is pointing inside the window and where the 
insertion point will move to if you click the mouse button. 

When you are ready, just start typing. The text that you type starts filling the Write 
window at the insertion point. When you reach the end of the line, Write auto
matically wraps your text to the beginning of the next line. To start a new para
graph, press ENTER. If you want to leave a blank line between paragraphs, press 
ENTER twice. 

If you make a mistake while typing, press BACKSPACE to back up the insertion 
point and erase the mistake. Chapter 2, "Basic Skills," explains other basic editing 
techniques, and the following section explains editing techniques specific to Write. 

Editing a Document 
Editing is much the same in Write as in any other Windows application (see Chap
ter 2, "Basic Skills," for more information). However, in addition to providing the 
same editing features used throughout Windows, Write offers various special 
editing techniques. The following sections explain each of these techniques. 

Moving Around in a Document 

You can use the scroll bars, as explained in Chapter 2, "Basic Skills," to move 
around in your Write document. To move the insertion point, point to a location in 
the document and click the mouse button. 
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Since a word processing application relies heavily on using the keyboard, Write 
includes a number of special keys for moving quickly around a Write document. 
These are in addition to the DIRECTION keys, the SPACEBAR, and ENTER, which are 
described in Chapter 2. The GOTO key referred to in the following list is 5 on the 
numeric keypad. 

Press this To move to the 

CTRL + RIGHT Next word 

CTRL+ LEFf Previous word 

GOTO + RIGHT Next sentence 

GOTO +LEFf Previous sentence 

HOME Beginning of a line 

END End of a line 

GOTO + DOWN Next paragraph 

GOTO + UP Previous paragraph 

CTRL + PAGE DOWN Bottom of the window 

CTRL + PAGE UP Top of the window 

GOTO + PAGE DOWN Next page 

GOTO + PAGE UP Previous page 

CTRL+HOME Beginning of the document 

CTRL+ END End of the document 

NOTE You can move the insertion point continuously by holding down any of these key 
combinations. 

You can use GOTO + PAGE DOWN and GOTO + PAGE UP to move to the next or 
previous page only after you either print your document or use the Repaginate 
command to divide your document into pages. Write stores page breaks with a 
document and remembers them each time you use the document. See "Breaking 
a Document into Pages" later in this chapter for more information. 

If you have divided a document into pages, you can move to a specific page by 
choosing the Go To Page command from the Search menu. 
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[> To move to a specific page: 

1. Choose Go To Page from the Search menu. 

Or use the shortcut key, F4. 

The Go To dialog box appears. 

f.age Number: ~ 

OK I I Cancel I 

2. Type the number of the page you want to move to in the Page Number box. 

3. Choose OK. 

The dialog box disappears, and the insertion point moves to the beginning of 
the selected page. 

Selecting Text 

In Write, many of the editing commands require that you first select the text you 
want to edit. The easiest way to select text is to press the mouse button and drag 
the mouse pointer. See Chapter 2, "Basic Skills," for the general selecting tech
niques used throughout Windows. 

In addition to these general techniques, Write also features a technique for 
selecting with the selection area and a mouse. The selection area is at the far left 
edge of the Write window, as shown in the following illustration: 

The mouse pointer in the selection area 

File Edit Search Character Paragraph Document Help 

PREPARING A HOME FOR SALE 

You can understand that showing a home to its best advantage makes the 
/1 buyer want to purchase quickly and at a better price. Here are some 
~ tested tips to set the stage for a profitable and early sale. 

Fix up inside. BadlV faded walls or worn woodwork reduce appeal. 
Selective painting will help you add a fresh look. Clean windows and 
unmarred walls will create a bright. cheery appearance. 

Make minor repairs. Dripping faucets call attention to faulty plumbing. 
You should make sure all plumbing is in good working order. If you can 

+ 

.:.:.: 
:.:.:. 
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In the selection area, the mouse pointer changes to an arrow that slants to the right. 
The following list shows how you can use the selection area to select text: 

To select 

By the line 

By the paragraph 

Between points 

The entire document 

t> To cancel a selection: 

Do this 

Move to the selection area and point next to a line. 
Click the mouse button once to select the line. To 
select more than one line, press the mouse button and 
drag the pointer. 

Move to the selection area and point next to any line in 
the paragraph. Double-click to select the paragraph. To 
extend the selection one paragraph at a time, hold the 
mouse button down after the second click and drag the 
pointer. 

Move to the selection area and select a line or para
graph. Move along the selection area to another line or 
paragraph, hold down SHIFf, and click the mouse 
button. Write selects all lines or paragraphs between 
the two points. 

Move to the selection area, hold down CTRL, and click 
the mouse button. 

[J Move the mouse pointer back inside the document and click the mouse button. 

Finding and Changing Text 

You can easily search for and edit text in your Write documents by using the Find 
and Change commands on the Search menu. These commands allow you to: 

• Search for text up to 255 characters in length. 

• Change all occurrences of the text in the document. 

• Change only certain occurrences of text. 

The following sections explain how to use the Find and Change commands. 
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Finding Text 
Using the Find command on the Search menu, you can look for a character, word, 
or group of characters or words in a Write document. 

When you choose the Find command, Write starts a search at the insertion point 
or at the end of any text that is currently selected. When it reaches the end of the 
document, Write automatically continues searching from the beginning of the 
document to its original starting point. 

[> To find text: 

1. Position the insertion point where you want to start your search. 

2. Choose Find from the Search menu. 

The Find dialog box appears. 

find What: 

D ~holeWord 

Find 

D M.atch Upperllowercase 

Find Nm!t 

3. In the Find What box, type the text you want to find. 

4. Select the Whole Word check box if you want to find only separate 
occurrences of the search text. 

Otherwise Write finds, for example, main in remainder. 

5. Select the Match Upper/Lowercase check box if you want to match 
capitalization exactly. 

Otherwise Write finds, for example, both Main and main. 

6. Choose Find Next (or press ENTER) to start the search. 

Write searches for the text and selects the first occurrence. If you want to edit 
the text, point to it and click the mouse button to switch from the dialog box to 
the document. (If you are using the keyboard, press ALT + F6 to switch from the 
dialog box to the document and back again.) 

If there are no occurrences of the text in the document, Write displays a mes
sage telling you that it could not find the search text. 

7. Choose Find Next (or press ENTER) again to find the next occurrence of the 
search text. 
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When Write finds the last occurrence of the search text, it displays a dialog 
box telling you that the search is complete. 

8. Choose Close from the Control menu (or press ESC) to close the Find dialog 
box. 

To search for text that includes wildcard characters, spaces, tabs, paragraph marks, 
and page breaks, type the following characters (where 1\ means the caret symbol) 
in the Find What box: 

? 

I\w 

I\t 

I\p 

I\d 

To represent 

Any character in a file (called a wildcard character). For example, if 
the search text is hea?, Write finds every word with hea, such as 
headstrong,Jigurehead, heal, heap, or heat. 

A space anywhere in your document-between words, between 
paragraphs, and so on. 

A tab character. 

A paragraph mark. 

A manual page break. For more information, see "Breaking Pages 
Manually" later in this chapter. 

Changing Text 
The Change command on the Search menu allows you to find text and replace it 
with new text. You can find and change all occurrences of the search text auto
matically, or you can decide whether to change each occurrence as Write finds it. 

When you choose the Change command, Write searches forward from the 
insertion point. When it reaches the end of the document, Write automatically con
tinues searching from the beginning of the document to the insertion point. If you 
select a section of your document before choosing Change, however, the com
mand searches only within that selection. 

[> To find and change text: 

1. Position the insertion point where you want to start your search. 

If you want to make changes to only part of your document, select that part. 

2. Choose Change from the Search menu. 

The Change dialog box appears. 
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Change 

f:indW'hat: 

Change 10: 

D ~hole Word D Match Upperllowercase 

I Find !'h~lIt II Ch(m~ltl, lhtm Find .----:-C~h(-m~-Jtl-:-Al~! ----, 

3. In the Find What box, type the text you want to find, and in the Change To 
box, type the text you want to replace it with. 

For infonnation on how to search for text that includes wildcard characters, 
spaces, tabs, paragraph marks, and page breaks, see the previous section, 
"Finding Text." 

4. Select the Whole Word check box if you want to find only separate occur
rences of the search text. 

5. Select the Match Upper!Lowercase check box if you want to match capital
ization exactly. 

6. Choose one of the following options to start the search: Find Next; Change, 
then Find; or Change All. If you selected a section of your document to make 
changes in, choose Change Selection. For an explanation of these options, see 
the list that follows. 

Write displays a dialog box telling you when a search is complete. If there are 
no occurrences of the text in the document, Write displays a message telling 
you that it could not find the search text. 

7. Choose Close from the Control menu (or press ESC) to close the Change dialog 
box. 

The following list describes the options available when you choose the Change 
command: 

Use this option 

Find Next 

Change, then Find 

To do this 

Find the next occurrence of the search text. If you want 
to manually edit the text, click the text (or press 
ALT + P6) to switch to the document. 

Change the current! y selected search text and then find 
the next occurrence. If no text is selected, choosing this 
option finds the first occurrence of the search text. 
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Use this option 

Change 

Change All 

Change Selection 
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To do this 

Change the currently selected search text. Write then 
waits for instructions. 

Automatically change all occurrences of the search text 
in the document. 

Automatically change all occurrences of the search text 
in the selected section of the document. The Change All 
button changes to Change Selection when you select a 
section of text in your document. 

Using the Repeat Last Find Command 
You do not have to keep the Find or Change dialog box on the screen throughout 
the entire search. You can use the Repeat Last Find command on the Search menu 
to continue a search after finding the first occurrence of search text. You cannot, 
however, make automatic changes to text if you use Repeat Last Find to find text. 

t> To repeat the last find: 

1. Use Find or Change to find the first occurrence of the search text. 

2. Close the Find or Change dialog box. 

3. Change the search text, if necessary. 

4. Choose Repeat Last Find from the Search menu to find the next occurrence of 
the search text. 

Or press F3 to quickly choose Repeat Last Find. 

Inserting Optional Hyphens 

As you look over the text in your document, you may occasionally see a large gap 
at the end of a line where a long word has been wrapped to the beginning of the 
next line. You can eliminate such gaps at the end of a line by inserting optional 
hyphens in long words to specify correct hyphenation points. Write then uses one 
of these hyphenation points to break these words at the end of a line. Optional 
hyphens are invisible unless they appear at the end of a line. 
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t> To insert optional hyphens in a word: 

[J Press CTRL + SHIFT + HYPHEN (-) at each desired hyphenation point. 

If you type a nonnal hyphen at the end of a line of text, Write will always break 
the line at that hyphen. 

Editing Pictures in Write 

You can cut and copy text and graphics from other Windows applications and 
paste them into your Write documents using the Clipboard. See Chapter 2, "Basic 
Skills," for more infonnation about transferring infonnation between Windows 
applications using the Clipboard. 

When you paste a picture or graph into Write, it always appears at the left margin. 
If you paste a picture that was created using colors, the colors are converted to 
black and white. You can select the picture and move it horizontally or change its 
size. You can also select the picture and cut, copy, or paste it just as you would the 
text in the document. 

Write displays pictures in a screen resolution that is appropriate for the printer you 
have selected. Because of differences in screen and printer resolutions, pictures 
may seem slightly distorted on the screen. However, when you print a picture in a 
Write document, the resolution will be correct. 

Moving a Picture 
You can move a picture horizontally in a document by using the Move Picture 
command on the Edit menu. 

t> To move a picture: 

1. Click the picture to select it. 

Or use UP ARROW and DOWN ARROW to move the insertion point to the picture. 

2. Choose Move Picture from the Edit menu. 

A square cursor appears in the center of the picture and a dotted frame sur
rounds the picture. 

3. Without pressing the mouse button, move the cursor right or left to move the 
dotted frame. 

Or press RIGHT ARROW or LEFr ARROW to move the dotted frame. 
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You can press ESC if you want to cancel the move. 

4. When the frame is where you want it, click the mouse button. 

Or press ENTER. 

If you are not satisfied with the position of your picture after clicking the mouse 
button or pressing ENTER, you can choose Undo from the Edit menu to return the 
picture to its original position. 

HINT You can also use the formatting commands (Left, Centered, Right) from the 
Paragraph menu to move a picture. 

Changing the Size of a Picture 
You can enlarge or reduce a picture in Write with the Size Picture command on 
the Edit menu. 

[> To change the size of a picture: 

1. Click the picture to select it. 

Or use UP ARROW and DOWN ARROW to move the insertion point to the picture. 

2. Choose Size Picture from the Edit menu. 

A square cursor appears in the center of the picture and a dotted frame sur
rounds the picture. 

3. Without pressing the mouse button, move the cursor until it rests halfway 
across the left side, right side, or bottom of the frame. 

Or press LEFf ARROW, RIGHT ARROW, or DOWN ARROW to move the cursor. 

To change the length and width of the picture at the same time, move the cur
sor halfway across a lower comer of the dotted frame. 

4. Move the cursor in the direction you want to enlarge or reduce the picture. 

Press a DIRECTION key to move the cursor using the keyboard. 

If you are not satisfied with the size of your picture, press ESC to return the 
picture to its original size. 

5. When the frame is the size you want, click the mouse button. 

Or press ENTER. 

If you are not satisfied with the size of your picture after clicking the mouse button 
or pressing ENTER, you can choose Undo from the Edit menu to return the picture 
to its original size. 
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HINT The lower-left corner of the Write window displays sizing information in the form of 
x and y location values. It is best to keep the x and y values the same and to position the 
frame at whole rather than fractional numbers (for example,S rather than 5.5). This will pre
vent distortion of the picture. 

Breaking a Document into Pages 
When you finish editing your document, you might want to see where Write pro
poses to break the document into pages for printing. You can have Write break a 
document into pages at any time. 

Breaking Pages Automatically 

When Write automatically breaks your document into pages, it prevents a single 
line in a paragraph from being printed by itself at the top or bottom of a page. By 
breaking a document into pages before printing, you can see where automatic page 
breaks will occur and decide where you might want to put manual page breaks, 
which tell Write to start a new page at a place that you designate. 

By breaking a document into pages before printing, you can also make sure that 
manual page breaks are still in the right place after you edit a document. You can 
choose to confirm or change each page break as Write creates it. 

r> To break a document into pages automatically: 

1. Choose Repaginate from the File menu. 

The Repaginate Document dialog box appears. 

Repaginate Document 

OK 

Cancel 

2. If you want to approve each page break as Write creates it, select the Confirm 
Page Breaks box. See "Confirming Page Breaks" later in this chapter for more 
information. 

3. Choose OK. 

As Write breaks the document into pages, the page numbers appear in the page 
status area at the lower-left comer of the window. 



Chapter 7 Write 235 

The page breaks that Write automatically assigns to the document look like the 
arrows in the following illustration: 

File Edit Search Character Paragraph Document Help 

• 
Bathrooms that sparkle can be a real plus. You should check and double-

.:-:-: 

check them. 

» Bedrooms are important focal points. You will find it worth the effort 

to keep them neatly arranged. 

These arrows indicate the first new line of each page. 

Breaking Pages Manually 
If you know you want a page to end or begin at a certain place, you can insert a 
manual page break at any time. 

[> To insert a manual page break: 

1. Position the insertion point where you want the page break to occur. 

2. Press CTRL + ENTER. 

A dotted line appears in the document to show where you inserted the page 
break. 

Manual page break 

File Edit Search Character Paragraph Document Help 

critical prospect can concentrate on major considerations. Loose door 
knobs and sticking drawers or doors can distract the buyer as well. 

First impressions are important. You should keep the lawn trimmed and 
edged, cultivate flower beds, and remove all refuse or clutter from the 
yard, sidewalk, and porches. 

You should pay special attention to the kitchen when preparing the home 
for sale. Shining ovens, ranges, and appliances will catch the buyer's 
eye and make a good impression. Keeping the counters and sink cleared 
and neat makes the kitchen look spacious. Colorful curtains in harmony 
with the counter tops and floors add appeal as well. 

• 

.:.:-: 

.:.:.: 
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Manual page breaks can be selected, deleted, or copied just like any other 
character in a document. 

Confirming Page Breaks 
If you select the Confirm Page Breaks box in the Repaginate Document dialog 
box, Write stops at each page break that it proposes to insert and any page breaks 
that you inserted manually. The following dialog box appears every time Write 
stops at a page break that it proposes to insert: 

Write proposes to break the page here. 

File Edit Search Character Paragraph Document Help 

with the counter tops and floors add appeal as well. 

Bathrooms that sparkle can be a real plus. You should check and double-

check them. 

Bedrooms are U~ ortant focal Ol.nts You Wl.ll fl.nd l.t ~~orth the effort 

to keep them nea 

Closets look lar 

Repaginating Document 

Use up and down buUons 
10 move page break 
if necessary. 
then confirm. 

'----l=!!.P=~J ~II £onfirm 

Q.own II Cancel , hats, and 

other articles al8-l!!II'!I!""""'''''''''I'!I!!I!II!~-4--------'''' 

•• I - + 

You can confirm the page 
break or move it. 

+ 

+ 

You can move an automatic page break up from where Write proposes to put it, 
but you cannot move it down. The Down button in the dialog box allows you to 
move the page break down only if you previously moved it up. 

Each time Write stops at a manual page break, it displays a dialog box so that you 
can confirm or remove the manual break. 
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Formatting Your Document 
When you format your Write document, you determine how you want the docu
ment to look. You can determine the appearance of characters throughout the 
document, the spacing and alignment of lines in each paragraph, and the page 
layout for the entire document. Most of the formats you choose look the same on 
your screen as in the printed document. 

Formatting Characters 

The commands on the Character menu control how you format the characters in 
your document. You can format characters by: 

• Using different character styles, such as bold, italic, and underline. 

• Creating superscripts and subscripts. 

• Using different fonts and font sizes. 

Choosing one of the Character-menu commands affects text that is currently 
selected or text that you are about to type. A new paragraph will have the same 
character formatting as the previous paragraph. 

Write usually displays the same character formats that you will see when you print 
your document. If your printer cannot print a certain font, point size, or character 
style, Write attempts to match the selected character format as closely as possible. 

Write saves character formats when you save your document. Write also transfers 
character formats when you move or copy formatted text to other parts of the same 
document or to another Write document. 

Applying Character Styles 
Character styles add emphasis to text by making it bold, italic, or underlined. You 
can apply more than one style to the same characters. For example, you can bold, 
italicize, and underline the same text. 

t> To format existing text in bold, italic, or underline: 

1. Select the text you want to format. 

2. Choose the style you want to use from the Character menu. 

The selected text changes to the format that you chose. 
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r> To format text that you are about to type in bold, italic, or underline: 

1. Choose the style you want to use from the Character menu. 

2. Type your text. 

The text appears in the format that you chose. 

r> To cancel a character style: 

1. Select the text for which you want to cancel the character style. 

2. Choose the style from the Character menu again. 

The checkmark next to the style on the menu disappears. 

If you want to cancel all styles used in a selected portion of text, choose Normal 
from the Character menu. 

Creating Superscripts and Subscripts 
Superscript and subscript characters appear slightly above or below other text. 
They are also scaled to a smaller size. 

File ~dit .§.e!lrch fharacter ~aragraph Qocument Help 

Amino acids contain the amino group NH2' 

One billion can be written as 109 , 

Subscript 
Superscript 

r> To format text as superscript or subscript: 

1. Select the text you want to format as superscript or subscript. 

2. Choose Superscript or Subscript from the Character menu. 

Write repositions the text you selected. 

+ 
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Using Fonts 
A font is a graphic design applied to all text, numerals, and other characters. If 
possible, Write displays the same fonts and sizes that you will see when you print 
your document. If Write cannot exactly match the selected font on the screen, it 
substitutes a font that resembles the selected font as closely as possible. Whenever 
Write uses a substitute font in your document, it still uses the correct line and page 
breaks. 

The Character menu contains the names of up to three fonts as well as commands 
to reduce or enlarge fonts. If more than three fonts are available for use, you can 
see the additional font names by choosing the Fonts command to display the Fonts 
dialog box. If you use the fonts in the Fonts dialog box more than those on the 
Character menu, the font names on the Character menu automatically change to 
the font names you use most often. 

The currently selected printer determines the fonts that are available. If you plan to 
print the document on a printer other than the currently selected printer, you must 
set up the other printer using either Control Panel or Write's Printer Setup com
mand. Then you can use its fonts for text in your document. For more information 
about fonts and the default printer, see Chapter 5, "Control Panel." 

Changing Fonts and Font Sizes 

When you start typing text in a new document, Write uses the standard font for the 
default printer. If you want to use a different font, you can choose one of the font 
names displayed on the Character menu or in the Fonts dialog box. 

[> To change to a font displayed on the Character menu: 

o Choose the font name from the Character menu. 

[> To change the font size by using the Character menu: 

o Choose the Reduce Font command or the Enlarge Font command from the 
Character menu. 

When you choose Reduce Font or Enlarge Font, Write changes the font size to the 
next smaller or larger size. The sizes are determined by Write, independent of the 
default printer. If you choose Reduce Font or Enlarge Font and the default printer 
does not support the next smaller or larger size, the text you type does not change 
size on the screen. 
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If you want to change the font or font size for text that is already typed, you must 
select the text before you choose the new font or size. The Character menu dis
plays a checkmark, the font size, and the font name if the entire selected region 
contains only one font and font size. Items that differ in the selected region are not 
displayed. 

[> To change a font or font size with the Fonts command: 

1. Choose the Fonts command from the Character menu. 

The Fonts dialog box appears. 

Fonts 
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2. In the Fonts box, select the name of the font you want to use. 

Or type the name of the font in the Font Name box. 

3. In the Sizes box, select a size for the font. 

Or type the new size in the Point Size box. 

4. Choose OK. 

If you enter a font size that cannot be printed on the default printer, Write does 
not change the size of text on the screen. 

Formatting Paragraphs 
The format of a paragraph includes the alignment, spacing, and indentation of the 
lines in the paragraph. A new paragraph starts out with the same format as the pre
vious paragraph. For example, if you are typing a paragraph that is double-spaced 
and press ENTER to start a new paragraph, the text you type in the new paragraph 
will also be double-spaced. 

You can use either the Ruler or the commands on the Paragraph menu to change 
the format in each paragraph of a document. Before choosing a command from the 
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Paragraph menu, position the insertion point inside the paragraph you want to for
mat. If you want to format more than one paragraph at the same time, select all the 
paragraphs you want to format. 

Displaying the Ruler 
If you have a mouse, you can change paragraph formats using the Ruler. 

[> To display the Ruler: 

o Choose Ruler On from the Document menu. 

The Ruler appears at the top of the Write window. 

Left indent marker (with first
line indent marker on top) 

File Edit Search Character Paragraph Document Help 
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icons icons marker 

Tab icons 
(for setting tab stops 
in your documents) 

t> To hide the Ruler: 

o Choose Ruler Off from the Document menu. 

The following sections explain the different ways in which you can format your 
paragraphs. They also explain how to use the Ruler to create each format. 

Adding and Removing Paragraph Marks 
A paragraph mark is not a visible character in a document, but it invisibly marks 
the end of a paragraph or a blank line. 
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l> To add a paragraph mark: 

1. Press ENTER after typing the last character in a paragraph. 

2. If you want a blank line between paragraphs, press ENTER again. 

Although there is no visible character for the paragraph mark, you can select, 
delete, copy, and move a paragraph mark just as you do other characters. 

You can select individual paragraph marks, as shown in the following illustration . 

....--__________ ,.- Paragraph marks selected 

I 
File Edit Search Character Baragraph Document Help 

correct small items. a critIcal prospect can concentrate on major 
'\ considerations. Loose doorlknobs and sticking drawers or doors can 

" ~istract the buyer as well .• 

First impressions are important. You should keep the lawn trimmed and 
edged. cultivate flower beds. and remove all refuse or clutter from the 
yard. sidewalk. and porches. 

You should pay special attention to the kitchen when preparing the home 
for sale. Shining ovens. ranges. and appliances will catch the buyer's 
eye and make a good impression. Keeping the counters and sink cleared 
and neat makes the kitchen look spacious. Colorful curtains in harmony 
with the counter tops and floors add appeal as well. 

-------------------------------------~ 

Or you can make a selection that includes both text and paragraph marks. 

Paragraph marks included in selection 

.Eile Edit Search !!elp 

t can concentrate on 

ovens. ranges. app s 
eye and make a good impression. Keeping the counters and sink cleared 
and neat makes the kitchen look spacious. Colorful curtains in harmony 
with the counter tops and floors add appeal as well. 

When you copy or move a paragraph, include the paragraph mark in the selection 
to keep the paragraph formats with the paragraph. 
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[> To remove a paragraph mark: 

1. Place the insertion point at the beginning of the paragraph following the mark 
you want to remove. 

2. Press BACKSPACE. 

If your paragraphs have a blank line between them, press BACKSPACE twice. 

Changing Paragraph Alignment 
You can align a paragraph in any of the following ways: 

• At the left margin 

• At the right margin 

• Justified between both margins 

• Centered between both margins 

C> To change the alignment of a paragraph: 

1. Place the insertion point inside the paragraph you want to change. 

2. Choose the alignment command you want to use from the Paragraph menu. 

Write realigns the paragraph according to the command you chose. 

r> To change paragraph alignment by using the Ruler: 

1. Place the insertion point inside the paragraph you want to change. 

2. Click the appropriate paragraph-alignment icon above the Ruler. 

Changing Paragraph Line Spacing 
You can change the line spacing in a paragraph to single-spacing, one and one-half 
line spacing, or double-spacing. 

[> To change line spacing: 

1. Place the insertion point inside the paragraph you want to change. 

2. Choose a line spacing command from the Paragraph menu. 

The line spacing in the selected paragraph changes to reflect your menu choice. 
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[> To change line spacing with the Ruler: 

1. Place the insertion point inside the paragraph you want to change. 

2. Click the appropriate linespacing icon above the Ruler. 

Changing the Indentation of a Paragraph 
When you first type a paragraph into Write, the text fills the area between the left 
and right margins. You can indent an entire paragraph from the left or right mar
gin, or you can indent just the first line of a paragraph from the left margin. 

Indenting the lines of a paragraph differs from changing the left or right margins 
for a paragraph. Write indents paragraph lines/rom the current margin setting. 
You should set the margins that you want to use for your paper size first (or use 
the standard settings provided by Write) and then indent the paragraphs of your 
document. For more information about margins, see "Changing the Page Layout" 
later in this chapter. 

[> To change the indentation of a paragraph: 

1. Place the insertion point inside the paragraph you want to change. 

2. Choose the Indents command from the Paragraph menu. 

The Indents dialog box appears. 

Indents 

.b.eft Indent: l[ii OK 
[ilst Line: 10• 

Cancel 
!light Indent: 10• 

3. Type a measurement for any indentation you want to change. 

The measurement can be in inches or centimeters, depending on the Measure
ments setting in the Page Layout dialog box. See "Changing the Page Layout" 
later in this chapter for more information. 

4. Choose OK. 

[> To change the indentation of a paragraph by using the Ruler: 

1. Place the insertion point inside the paragraph you want to change. 
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2. Drag the appropriate indent marker to a new position on the Ruler. 

r Left indent marker 
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The indents you create with the Ruler are reflected in the Indents dialog box. 

Creating a Hanging Indent 

You can also use the Indents command to create a hanging indent. In a paragraph 
with a hanging indent, the first line extends farther to the left than the rest of the 
paragraph as would happen in a numbered or bulleted list. 

Write - TESlWRI.WRI 
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[> To create a hanging indent: 

1. Place the insertion point inside the paragraph in which you want to create the 
hanging indent. 

2. Choose the Indents command from the Paragraph menu. 

3. Enter a positive number in the Left Indent box to set the indentation for the 
entire paragraph. 

4. Enter a negative number in the First Line box to set the indentation for the first 
line. 

Both measurements can be in inches or centimeters, depending on the Measure
ments setting in the Page Layout dialog box. See "Changing the Page Layout" 
later in this chapter for more information on these settings. 

5. Choose OK. 

The selected paragraph is reformatted according to the measurements you 
entered. 

Formatting a Whole Document 
The commands on the Document menu affect the document as a whole. When you 
start a new document, it is automatically formatted to look like the document in 
the following illustration: 

--+--t- Text 

1. 25
1

L.-" _______ -----'f' 
Margins 

1"-----1--' 

Footer 
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Commands on the Document menu affect the following parts of a document: 

• A header is text that appears at the top of every page. The standard position of 
the header is .75 inch from the top of the page at the left margin. 

• A/aater is text that appears at the bottom of every page. The standard position 
of the footer is .75 inch from the bottom of the page at the left margin. 

• Text is single-spaced and aligned at the left margin without any indentations. 

• The standard margins allow 1 inch of space at the top and bottom of the docu
ment and 1.25 inches at the left and right edges. 

Using Headers and Footers 
You can have one header and one footer in each Write document. Using the 
Header or Footer commands, you can: 

• Enter the text you want to use as a header or footer. 

• Include page numbers in the printed document. 

• Start the header or footer on the first or second page of the document. 

• Change the distance between the header or footer and the top or bottom of the 
page. 

t> To add a header or footer: 

1. Choose Header or Footer from the Document menu. 

A blank Header or Footer document window and the Page Header or Page 
Footer dialog box appear. 
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The Header r document window 
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2. Type the text for the header or footer in the blank document window. 

You can format the text as you would any other text. For example, if you want 
to center the text, choose Centered from the Paragraph menu before or after 
you type the text. 

If you make a mistake, you can use BACKSPACE to correct the last few char
acters typed, or you can choose the Clear button in the Page Header or Page 
Footer dialog box to erase all the text in the document window and start over. 

3. Click the Page Header or Page Footer dialog box. 

Or press AL T + F6 to select the dialog box. 

4. Type a measurement in the Distance from Top or Distance from Bottom box if 
you want to change the distance between the header or footer and the edge of 
the page. 

The measurement can be in inches or centimeters, depending on the Measure
ments setting in the Page Layout dialog box. See "Changing the Page Layout" 
later in this chapter for more information on these settings. 

5. Select the Print on First Page check box if you want the header or footer to 
appear on the first page of the printed document. 

Otherwise, the header or footer starts on the second page. 

6. Choose the Insert Page # button to print page numbers in the document. See 
the following section for more information about using page numbers. 
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7. When you finish setting up your header or footer, choose Return to Document. 

Or press ESC to return to your document. 

When you print your document, you will see the headers and footers. They do not 
appear on the screen. 

[> To use page numbers in headers or footers: 

1. Depending on where you want your page numbers to appear, choose Header or 
Footer from the Document menu. 

2. Type any text that you want included with the page number in the Header or 
Footer window. 

3. Move the insertion point to where you want the page number to appear on the 
line. (Choose Centered or Right from the Paragraph menu to quickly center or 
right justify the header or footer.) 

4. Click the Page Header or Page Footer dialog box. 

Or press AL T + F6 to select the dialog box. 

5. Choose Insert Page #. 

Choosing this button inserts (page) in the document window at the location of 
the insertion point. 

6. Select the Print on First Page check box if you want a page number to appear 
on the first page of the printed document. 

If you want your first page to be a cover page without a number, do not select 
the Print on First Page check box. 

7. Choose Return to Document. 

When you print your document, consecutive page numbers appear on the printed 
pages. 

Setting Tabs 
Write has tabs preset at every half inch. You can use these preset tabs to create a 
column of items aligned to the left. Preset tabs do not appear in the Tabs dialog 
box or on the Ruler. 

You can easily set your own tabs for lists or tables by using the Tabs command on 
the Document menu or by using the Ruler. Tabs that you set override the preset 
tabs. You can set up to 12 tabs-either left-aligned tabs or decimal tabs. Decimal 
tabs let you create a column of numbers that line up on their decimal points. 
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[> To set tabs: 

1. Choose Tabs from the Document menu. 

The Tabs dialog box appears. 

Type a measurement for a tab you want to set. 
Select this box to create a decimal tab. 

Q.ecimal: 

~osi!ions: 

Q.ecimal: D. D. D. D. D. D. 

OK Cancel I Clear~1 I 

2. Select a position box. 

Press TAB to move to a position box using the keyboard. 

3. Type a measurement. 

This will be the location of the tab stop from the left margin. The number can 
be in inches or centimeters, depending on the Measurements setting in the 
Page Layout dialog box. See "Changing the Page Layout" later in this chapter 
for more information on these settings. 

4. If you want a decimal tab, select the Decimal box below the measurement you 
type. 

5. Choose OK. 

The tabs you set in the Tabs dialog box also appear on the Ruler. 

HINT When you type text at a decimal tab stop, the characters you type are inserted to 
the left of the tab stop until you type a decimal point. The decimal point is inserted at the tab 
stop, and any additional characters you type are inserted to the right of the decimal point. 
You can use a decimal tab to line up text to the right, as long as you don't use more than 
one period in the text. 
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[> To delete a tab: 

1. Choose Tabs from the Document menu. 

The Tabs dialog box appears. 

2. Select the position box for the tab you want to delete and remove the measure
ment there. 

To delete all tabs at once, choose the Clear All button. 

[> To set tabs with the Ruler: 

1. Click the appropriate tab icon above the Ruler. 
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2. Click the Ruler where you want to set the tab. 

You can also drag an existing tab marker to a new position. 

The tabs you set with the Ruler appear in the Tabs dialog box. 

[> To delete a tab using the Ruler: 

o Drag the tab marker you want to remove down and off the Ruler. 

., 
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Changing the Page Layout 
When printing a document, Write automatically: 

• Uses inches in measurements. 

• Uses I-inch top and bottom margins. 

• Uses 1.25-inch side margins. 

• Numbers the first page as page 1. 

You can use the Page Layout command on the Document menu to change these 
settings. 

t> To change the page layout settings for a document: 

1. Choose Page Layout from the Document menu. 

The Page Layout dialog box appears. 
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2. If you want to start numbering your document with a number other than page 
1, type the number with which you want to start in the Start Page Numbers At 
box. This number appears on the first page of your document if you have a 
page number in your header or footer. See "Using Headers and Footers" earlier 
in this chapter. 

3. In the Margins boxes, type the margins you want to use. 

4. Select the cm option if you want to use metric measurements. 

5. Choose OK. 

If you enter a starting page number, Write adjusts the page numbers displayed in 
the lower-left comer of the window. Write also uses the adjusted page numbers for 
the Go to Page command on the Search menu. 
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Managing Write Files 
Working with Write files is much the same as working with any other Windows 
file. If you have not already done so, read Chapter 2, "Basic Skills," for infor
mation about opening and saving Windows files, and Chapter 4, "File Manager," 
for information about managing Windows files. 

The maximum size of a Write file is limited only by the amount of memory in 
your computer. Windows automatically assigns the extension. WRI to a document 
you create using Write and saves the document as a Write file. If you prefer, you 
can choose to save your document in one of several other formats. You can also 
open and work with files that were not created using Write. The following sections 
discuss these topics. 

Opening a Microsoft Word Document 

If you want to use Write to work with a Microsoft Word document, you must first 
convert the Word document to the Write format. 

When you start to open the Word document file from Write, the Write dialog box 
appears asking whether or not you want to convert the text to the Microsoft Write 
format. 

I> To convert a Word document to the Write format: 

D Choose the Convert option in the Write dialog box. 

Opening a Windows Text File 

Most text files created with Windows applications are in ANSI format, which 
is the same format used for Write document files. When you start to open a 
Windows text file from Write, the Write dialog box appears, but you do not need 
to convert Windows text files. 

I> To avoid converting a Windows text file: 

D Choose the No Conversion option in the Write dialog box. 

HINT If you make a mistake in selecting Convert or No Conversion, simply quit Write 
without saving the file. Your file will be restored to its original status. 
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Opening a Non-Windows Text File 

Most text files created outside Windows are not in ANSI format. You must con
vert these files to the Write format. 

When you start to open a non-Windows text file from Write, the Write dialog box 
appears. 

[> To convert a non-Windows text file to the Write format: 

o Choose the Convert option in the Write dialog box. 

CAUTION Be sure you back up a file before you convert it to the Write format. Also, do 
not convert any files that are not purely text files. In binary files, ASCII characters above 127 
might be related to the program that created the file and, therefore, cannot be converted. 
Other files may contain control characters that should not be converted. 

Saving a Document 

When you are working with a Write document-especially a large document
you should save your document often. Doing so helps Write perform faster and 
minimizes lost work if there is a power failure. 

You have four formatting choices when you save a Write document: 

Use this format 

The standard proposed 
by Write (.WRI) 

Text Only 

Microsoft Word Format 

Text Only and 
Microsoft Word Format 

To save your document as 

A Write-formatted document. When you first save 
the file, Write adds the extension. WRI to the 
filename. 

A Windows ANSI text file. You might want to use 
this option if your document is a program or will be 
telecommunicated. See Chapter 9, "Terminal," for 
more information. 

A Microsoft Word document. Do not use this 
format if you have any pictures in your document 
because they will disappear. 

An unformatted Microsoft Word text file. 
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Making a Backup Copy 

You can automatically make a backup copy of a Write file when you save the file. 

[> To make a backup copy: 

o Select the Make Backup check box in the File Save As dialog box. 

Thereafter, Write makes a backup copy each time you save an edited document. 

If you save your document as a Write file, Write assigns the backup copy the 
extension .BKP. If you save your document as a Microsoft Word file, Write 
assigns the backup copy the extension .BAK. 

If, before making a backup, you delete the extension from the filename of a Write 
document and save it in Microsoft Word format, the document and its backup are 
given the extensions .DOC for the document now in Word format and .WRI for 
the backup copy. This is the original version of the document in Write format. 

Similarly, if you delete the extension of the filename from an existing Word docu
ment and save it in Write format, the document and its backup are given the exten
sions .WRI for the document now in Write format and .DOC for the backup copy. 
This is the original version of the document in Word format. 

Printing a Document 
If you have connected and installed a printer, you can print your Write documents. 
Chapter 5, "Control Panel," describes how to install a printer. 

[> To print a document: 

1. Make sure the document is displayed in the Write window. 

2. Choose Print from the File menu. 

The Print dialog box appears. 
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3. Select the options you want to use. (See the following list for more information 
about these options.) 

4. Choose OK. 

A dialog box appears telling you that Write is printing your document. 

The following list describes how to use the options in the Print dialog box: 

Use this option 

Copies 

All Pages 

Fromffo Pages 

Draft Quality 

To do this 

Tell Write the number of copies you want to print. The 
standard setting is 1. 

Print all the pages in your document. This is the standard 
setting. 

Print a range of pages. After you select this option, type 
page numbers in the From and To boxes. 

Quickly print an unformatted copy of the text in your docu
ment. Pictures print as empty boxes when you select Draft 
Quality. 

When printing, Write uses the margin settings in the Page Layout dialog box. If 
you want to position your document differently on the page, you can use the Page 
Layout command on the Document menu to change these settings. See "Changing 
the Page Layout" earlier in this chapter for more information. 
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Changing Printers and Print Option Settings 

Write prints your documents on the default printer. If you have other printers 
installed and assigned as active printers, you can make any of these active printers 
the default printer using the Printer Setup command on the File menu. If you want 
to print to an installed inactive printer, you must use Control Panel to make the 
printer active. For more information, see Chapter 5, "Control Panel." 

[> To change printers: 

1. Choose Printer Setup from the File menu. 

The Printer Setup dialog box appears with a list of all the active printers. 

2. Select from the Printer box the name of the printer to which you want to 
change. 

If you want to change the print options for the selected printer, choose Setup. 
See Chapter 5, "Control Panel," for information on print options. 

3. Choose OK. 

Write now automatically prints to the newly selected printer. 

When you change printers, the appearance of your document may change on the 
screen. This is because Write applies the fonts and character formats available 
with the default printer. These changes may affect the line breaks and page breaks 
in the document. Use the Repaginate command to see the new page breaks. See 
"Breaking a Document into Pages" earlier in this chapter for more information. 
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Drawing with a Mouse or the Keyboard 
With Microsoft Windows Paintbrush TM, you can create simple or elaborate color 
drawings. Unlike the other Windows accessories, Paintbrush makes use of both 
mouse buttons. When you need to use the right mouse button, the instructions in 
this chapter specify that button. If no button is specified, you should use the left 
mouse button-the one most commonly used. If you used Control Panel to reverse 
your mouse buttons, you should use the left mouse button when the instructions 
specify the right. 

In Paintbrush, you will probably find that it is much easier to create your drawings 
using a mouse. For this reason, the instructions in this chapter are directed toward 
mouse users. If you do not have a mouse or prefer using the keyboard, use the fol
lowing keys when the instructions tell you to click, double-click, or press a mouse 
button: 

For this mouse action 

Click or press the left mouse button 

Click or press the right mouse button 

Double-click the left mouse button 

Double-click the right mouse button 

Press this key or 
key combination 

INSERT 

DELETE 

F9 + INSERT 

F9 + DELETE 

See "Moving Around in a Large Drawing" later in this chapter for more infor
mation about using the keyboard. 

The Paintbrush Window 
t> To start Paintbrush: 

1. Choose the Accessories Group from the Program Manager window. 

2. Double-click the Paintbrush icon. 

Or select the Paintbrush icon and choose Open from the File menu. 

The following Paintbrush window appears. 
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Toolbox Cursor 

Linesize box 

In the Paintbrush window, you see the following items: 

• The drawing area is where you create your Paintbrush drawings. The size 
of the drawing area varies, depending on your video display. If you do not 
have enough memory available to create a drawing equal to the size of your 
drawing area, you will see a small drawing area in the upper-left comer of the 
Paintbrush window. You need to free some of your computer's memory before 
Paintbrush can create the larger drawing area. 

You can also override the default size by using the Image Attributes command 
from the Options menu. See the following topic, "Determining the Size of 
Your Drawing Area," for more information. 

• The cursor indicates where a line or other object appears when you start 
drawing in the drawing area, or what you are pointing to outside the drawing 
area. The cursor moves as you move your mouse (or press TAB or a DIRECTION 

key). Inside the drawing area, the cursor's shape changes, depending on which 
tool you are using. Outside the drawing area, the cursor always appears as an 
arrow. 

• The Toolbox contains the tools that you use to create your drawing. The tools 
allow you to draw, fill, airbrush, erase, enter text, and rearrange the items in the 
drawing area. 
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• The Palette contains the colors and patterns available for use in the background 
of the drawing area and with the drawing tools. 

• The Linesize box contains the available drawing widths. 

HINT If you are using the keyboard, use TAB and SHIFT+TAB to move between the different 
areas of the Paintbrush window. 

Determining the Size of Your Drawing Area 
The first time you start Paintbrush, it establishes a standard size for a drawing area 
based on your type of video display and the amount of memory available. If you 
want to create a drawing that is larger or smaller than the standard size established 
by Paintbrush, you can change the standard drawing size. 

[> To change the standard drawing size: 

1. Choose Image Attributes from the Options menu. 

The Image Attributes dialog box appears. 

Image Attributes 
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2. Enter the new width and height measurements you want to use for your 
drawing. 

If necessary, make changes to the other options in the dialog box. See the list 
that follows for an explanation of each of the options. 

3. Choose OK. 

4. Choose New from the File menu to open a new drawing using the new 
standard size. 
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Paintbrush now uses the new settings in the Image Attributes dialog box each time 
you start Paintbrush. 

HINT To start a new Paintbrush drawing quickly, double-click the Eraser tool in the 
Toolbox. (If you are using the keyboard, move the cursor to the Eraser tool; then press 
F9 + INSERT.) For more information about using the Eraser tool, see "The Eraser" later in this 
chapter. 

The following list explains how to use the settings in the Image Attributes dialog 
box: 

Use this option 

Width 

Height 

Units 

Colors 

Default 

To do this 

Change the width of the drawing you want to create. 

Change the height of the drawing you want to create. 

Select the unit of measurement you want to use when you 
enter the width and height of your drawing. The standard 
setting is inches (in). You can also choose to work with 
centimeters (cm) or picture elements (pels, also known as 
pixels )-the smallest unit on the screen. 

Choose whether you want to work in black and white or 
color. 

Return the size of the drawing area to the original size 
established by Paintbrush to accommodate your video 
display. 

NOTE You should keep in mind that the larger the drawing and the more colors you use, 
the more memory required. If you plan to print your drawing at printer resolution, be sure 
that you enter the correct dimensions (in pixels) for the printed drawing in the Image 
Attributes dialog box. Also, be sure that the dimensions you specify are in proportion to the 
current screen dimensions of the drawing. Because printing at printer resolution requires 
more memory, you cannot print as large a drawing as you can at screen resolution. 

Enlarging the Drawing Area 

You can remove the Toolbox, Linesize box, and Palette from the Paintbrush win
dow to increase the size of the drawing area. You can still use the selected tool, 
drawing width, and color as well as the menu commands when the Toolbox, 
Linesize box, and Palette are not visible on the screen. 
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[> To remove the Toolbox and Linesize box from the drawing area: 

o Choose Tools and Linesize from the View menu. 

The Toolbox and Linesize box disappear from the Paintbrush window, and the 
checkmarks next to Tools and Linesize on the View menu also disappear. To 
return the Toolbox and Linesize box to the window, choose Tools and Linesize 
again. 

[> To remove the Palette from the drawing area: 

o Choose Palette from the View menu. 

The Palette disappears from the Paintbrush window, and the checkmark next to 
Palette on the View menu also disappears. To return the Palette to the window, 
choose Palette from the View menu again. 

Moving Around in a Large Drawing 
If you create a drawing that is larger than the size of the drawing area, you can use 
the scroll bars to move around in the drawing using a mouse. If you are using the 
keyboard, the following table shows the keys you can use to move around in the 
drawing: 

Use this key or key combination 

HOME 

END 

PAGE UP 

PAGE DOWN 

SHIFf + UP ARROW 

SHIFf + DOWN ARROW 

SHIFf + HOME 

SHIFf + END 

SHIFf + PAGE UP 

SHIFf + PAGE DOWN 

SHIFf + LEFf ARROW 

SHIFf + RIGHT ARROW 

To move 

To the top of the drawing area 

To the bottom of the drawing area 

Up one screen at a time 

Down one screen at a time 

Up one line at a time 

Down one line at a time 

To the left edge of the drawing area 

To the right edge of the drawing area 

Left one screen 

Right one screen 

To the left one space 

To the right one space 
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Viewing Your Drawing 

To see more of your drawing, you can remove everything from the screen except 
your drawing. You can also compact your drawing so that all of it fits inside the 
current drawing area. 

Showing the Entire Screen 
The View Picture command on the View menu displays as much of your drawing 
as fits on the entire screen by removing everything but your drawing from the 
screen. Because the menus, Toolbox, Palette, Linesize box, and even the cursor 
disappear when you choose View Picture, you cannot edit your drawing in any 
way. 

[> To use the entire screen to display your drawing: 

[] Choose View Picture from the View menu. 

HINT To clear the entire screen quickly of everything except your drawing, double-click 
the Pick cutout tool in the Toolbox. (To choose the Pick cutout tool using the keyboard, 
move the cursor to the Pick cutout tool; then press F9 + INSERT.) 

[> To cancel the View Picture command: 

[] Click the mouse button. 

Or press ESC. 

The screen returns to its normal state. 

Zooming Out 
If you create a drawing that is larger than the drawing area and the entire screen, it 
is still possible to see all of the drawing on the screen at one time. 

l> To display an entire drawing that is larger than the drawing area: 

[] Choose Zoom Out from the View menu. 

Zoom Out shrinks the entire drawing to fit into the drawing area. 

While using Zoom Out, you can cut, copy, and paste parts of your drawing called 
cutouts. You create a cutout using either the Pick or Scissors cutout tool (see 
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"Editing Your Drawing" later in this chapter for more information). You cannot, 
however, add anything new to a drawing in Zoom Out by using the drawing tools. 

[> To cancel the Zoom Out command: 

[] Choose Zoom In from the View menu. 

Or press ESC. 

The drawing returns to normal resolution size. 

When you use Zoom Out to view a drawing, you might lose some of the line detail 
in the drawing. Generally, the larger the size of your original, the greater the 
amount of line detail that you lose when Paintbrush shrinks the drawing. You see 
this loss of detail only in the compacted version of the drawing. It does not affect 
your full-size drawing. 

Creating a Simple Drawing 
To create a simple drawing: 

l. Select a background color. 

2. Select a foreground color. 

3. Select a drawing width. 

4. Select a drawing tool. 

5. Draw your picture. 

6. Edit your picture. 

The following topics describe each of these steps. 

Selecting Background and Foreground Colors 
One of the first things to decide when you create a drawing is what color you want 
to use for the background and what color you want to start drawing with (the fore
ground color). You select your background and foreground colors from the Palette. 

You can change the foreground color at any time while creating a drawing. You 
can also change the background color at any time and, by doing so, create special 
effects with tools and commands that use the background color to draw. For 
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example, you can create shadows around different pieces of text in a drawing 
using various colors. 

You can change the background color used throughout an entire drawing only by 
choosing the color and then choosing New to start a new drawing. 

The Selected Colors box shows the 
~ors that are currently selected. 

The selected foreground color 
The selected background color 

When you start Paintbrush, the selected background color is white and the selected 
foreground color is black. 

[> To select a different background color or pattern: 

[J Point to the color or pattern in the Palette and click the right mouse button. 

Or press TAB to reach the Palette and then use the DIRECTION keys to move the 
cursor to the color and press DELETE. 

The Selected Colors box shows the color you selected. 

If you now choose New from the File menu, Paintbrush opens a new document 
with the newly selected background color or pattern in the drawing area. 

I> To select a different foreground color or pattern: 

[J Point to the color or pattern in the Palette and click the left mouse button. 

Or press TAB to reach the Palette and then use the DIRECTION keys to move the 
cursor to the color and press INSERT. 

The Selected Colors box shows the color you selected. 

Selecting a Drawing Width 

The Linesize box in the lower-left comer of the Paintbrush window displays the 
available drawing widths. The top line represents a one-pixel width. 



An arrow marks 
the selected width. 

-----
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The drawing width determines the width of an object you draw or the thickness of 
the border around the object. For example, if you are drawing a line, the drawing 
width determines the width of the line. If you are drawing a filled box, the drawing 
width determines the thickness of the border around the box. You might want to 
experiment with how different drawing widths work with different tools so that 
you can use them most effectively. 

t> To change the width of the drawing line: 

o Point to the width you want in the Linesize box and click the mouse button. 

Or press TAB to reach the Palette and then use the DIRECTION keys to move the 
cursor to the drawing width you want to select and press INSERT. 

An arrow appears next to the drawing width you selected. 

Selecting and Using a Drawing Tool 

Before you begin working in the drawing area, you need to select the tool you 
want to work with from the Toolbox at the left of the Paintbrush window. 

_ The Brush tool is always selected 
when you start Paintbrush. 
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[> To select a drawing tool: 

D Point to the tool you want to use and click the mouse button. 

Or use the DIRECTION keys to move the cursor to the tool you want to select 
and press INSERT. 

Paintbrush highlights the selected tool in the Toolbox. 

[> To draw with the selected tool: 

1. Move the cursor into the drawing area. 

2. Position the cursor where you want to start drawing and press the mouse 
button. 

The selected tool anchors itself at that spot. 

3. Holding down the mouse button, drag the cursor around the drawing area. 

Or, holding down the INSERT key, use the DIRECTION keys to move the cursor. 

If you are drawing an object such as a box or circle, the object expands and 
contracts, following the cursor's movements. 

4. When you are satisfied with the looks of the object, release the mouse button. 

For specific information about each of the available tools, see "Working with the 
Paintbrush Tools" later in this chapter. 

Basic Graphics Editing 

If you make a mistake while drawing, you can use the Undo command on the Edit 
menu or BACKSPACE to make simple corrections. 

[> To edit a drawing with the Undo command: 

D Choose Undo from the Edit menu. 

Or press ALT + BACKSPACE. 

Undo deletes everything you have drawn since selecting the tool you are 
currently working with. 

Using just BACKSPACE lets you delete a portion or all of what you have drawn 
since selecting the tool you are currently working with. BACKSPACE is particularly 
handy for small cleanup jobs such as deleting stray dots made by the Airbrush. 
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t> To edit a drawing with BACKSPACE: 

1. Press BACKSPACE. 

The cursor turns into a square with an X inside. The size of the square depends 
on the drawing width selected. 

2. Press the mouse button and move the cursor over the parts of the object you 
want to delete. 

3. When you finish, release the mouse button. 

4. Press the mouse button again to continue drawing with the selected tool. 

You can use Undo and BACKSPACE until you do any of these things: 

• Select a tool. 

• Use a scroll bar. 

• Open another application. 

• Resize the window. 

Once you do any of these, Paintbrush pastes down the objects currently in the 
drawing area, and Undo and BACKSPACE no longer delete. You must now use an 
eraser tool or select and edit a portion of your drawing called a cutout. For more 
information about erasing and editing cutouts, see "The Color Eraser," "The 
Eraser," and "Editing Your Drawing" later in this chapter. 

CAUTION To prevent undoing work that you are satisfied with, protect that section of 
your drawing from Undo and BACKSPACE by reselecting the tool you are currently working 
with or by taking one of the other actions in the previous list. Then Undo and BACKSPACE can 
delete only your most recent work. 

Entering Text 
If you want to use text in your drawing, you need to do the following: 

1. Select the foreground color you want to use for the text. 

2. Select the Text tool from the Toolbox. 

3. Choose the font you want to use. 

4. Choose a point size for the font. 
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5. Choose a style for the font. 

6. Enter and position your text. 

7. Edit your text. 

If you do not already know how to select a foreground color, see "Selecting 
Background and Foreground Colors" earlier in this chapter. The following topics 
explain the remaining steps. 

Selecting the Text Tool 

When you select the Text tool, you can type text in the drawing area. 

The Text tool 

[:> To select the Text tool: 

D Point to the tool in the Toolbox and click the mouse button. 

Paintbrush highlights the Text tool in the Toolbox. 
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Choosing a Font and Font Size 

The Font menu lists all available fonts. The Size menu lists a range of point sizes 
for all the fonts. 

The available fonts 
depend on your printer. 

Helv 
Courier 
Tms Rmn 
Roman 
Script 
Modern 

.JSystem 

12.0'" 
'I :t~i 
'14.:1 
" ~).O 
" G},) 

'llU} 
'I~U) 

2'1.0 
22.5 
24.0 
2l.0 
2l.B 
2lU) 
:llU} 
:n.~) 

Available point sizes 
appear in black. 

:n.o 4~U) 

33.8 ~)i?.',) 

36.0 tl4.0 
Point sizes that can't 'H},) ~i~i.~) 

3~U} 56.3 be used are dimmed. 
4lUi tll.O 
42.0 ~)lU) 

42.B 60.0 A point size scaled to 
45.0 ll:l.O approximate another size 
40.0 

A precision-drawn 
point size 

The availability of point sizes depends on the resolution of your printer. If no 
printer is installed, the available point sizes are based upon the screen resolution of 
your video display. 

[> To choose a font for text: 

[J Select the name of the font you want to use from the Font menu. 

Paintbrush places a checkmark next to the selected font on the Font menu. 

The font that you select affects any text that is not pasted down in the drawing area 
as well as the text that you are about to type. For information about pasting down 
text, see "Basic Text Editing" later in this chapter. 

[> To select a point size for a font: 

[J Select the point size you want to use from the Size menu. 

Paintbrush places a checkmark next to the selected point size on the Size menu. 
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Point sizes followed by an asterisk are precision-drawn point sizes provided by a 
font file. Point sizes without an asterisk are point sizes that are scaled by Windows 
to approximate the designated size. 

Windows scales larger point sizes when a size that is available for the printer is 
not available for the screen. Scaled fonts may look slightly different from unsealed 
fonts. When you choose a smaller point size that is available for the printer but not 
for the screen, Windows substitutes the correct size from a precision-drawn font 
that resembles the selected font as closely as possible. 

Setting the Style Options 

In addition to coming in different sizes, fonts also provide different styles for 
emphasizing text. You can bold, italicize, underline, and outline the text you type. 
You can also create a shadow around it in the currently selected background color. 

[> To change the style of text: 

[] Select a style you want to use from the Style menu. 

Paintbrush places a checkmark next to the selected style on the Style menu. 

You can select more than one style for the same text. The styles you select affect 
text that is not pasted down in the drawing area as well as text that you are about to 
type. For information about pasting down text, see "Basic Text Editing" later in 
this chapter. 

[> To cancel a style selection: 

[] Select a style from the Style menu again. 

The checkmark next to the previously selected style on the Style menu 
disappears. 

[> To cancel all the current style selections: 

[] Choose Normal from the Style menu. 

All checkmarks on the Style menu disappear. 
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Entering and Positioning Text 

Entering text in the Paintbrush drawing area is similar to entering text in a word 
processing application, except that text does not automatically wrap from line to 
line in Paintbrush. Also, the cursor does not automatically realign itself with 
previously entered text if you leave the Text tool and then return. 

[> To enter text in the Paintbrush drawing area: 

1. Move the cursor to where you want your text to appear and click the mouse 
button. 

The Text cursor appears as a vertical line. 

2. Start typing. 

The text you type starts filling the Paintbrush window at the initial position of 
the text cursor, while the cursor moves to the right to make room. 

3. Press ENTER when you want to start a new line of text, or reposition the Text 
cursor by clicking the mouse button. 

If you continue typing on the same line, Paintbrush stops entering text when 
you reach the right edge of the drawing area. 

If the size of your drawing is larger than the size of the drawing area, you can use 
the scroll bars and the appropriate DIRECTION keys to move to other parts of your 
drawing and enter text there. See "Moving Around in a Large Drawing" earlier in 
this chapter for more information on using the keyboard to move around in a 
drawing. 

NOTE Text can be drawn only in solid colors with Windows-colors in which all pixels 
are the same color, not a combination of colors. If a non-solid color or a pattern is selected 
for drawing, text will be drawn in the solid color that is closest to the chosen color or 
pattern. 

For example, if you are using a monochrome monitor and select a light gray as your fore
ground color, the text characters are drawn in white. If you then change the foreground 
color to a pattern that is mostly black, the characters are redrawn in black. 

Basic Text Editing 

You can correct simple text errors by pressing the BACKSPACE key. BACKSPACE 

works the same with Paintbrush text as it works in any other Windows application. 
See Chapter 2, "Basic Skills," for more information. 

I 
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You can also select a new foreground color, font, point size, or text style for text in 
the drawing area. You can use BACKSPACE or make other changes to your text 
until you do any of these things: 

• Select a tool. 

• Use a scroll bar. 

• Open another application. 

• Reposition the text cursor. 

• Resize the window. 

Once you do any of these, Paintbrush pastes down the text currently in the drawing 
area. BACKSPACE no longer erases, and you cannot change the color, font, point 
size, or style of the text. If you want to change or delete the text, you must erase or 
cut the text out of the drawing and retype it. For more infonnation, see "The Color 
Eraser," "The Eraser," and "Editing Your Drawing" later in this chapter. 

Working with the Paintbrush Tools 
The Paintbrush Toolbox appears at the left of the Paintbrush window. 

Scissors __ ~ [~ __ Pick 

Airbrush -- ur' abc -- Text tool 

Color Eraser __ __ Eraser 

Paint Roller __ ~ __ Brush 

Curve __ ~ / __ Line 

Box -- 0 II -- Filled Box 

Rounded Box -- 0 II -- Filled Rounded Box 

Circle/Ellipse __ 0 • __ Filled Circle/Ellipse 

Polygon -- 'h. '\. -- Filled Polygon 

You use the tools in the Paintbrush Toolbox to create your drawings. 
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[> To select a tool from the Toolbox: 

o Point to the tool and click the mouse button. 

Paintbrush highlights the selected tool in the Toolbox. 

The following sections explain the tools in the order that they appear in the 
Toolbox. 

The Cutout Tools 

You can define an area of your picture called a cutout by using the cutout tools. 
You can define a free-form cutout with the Scissors tool, or a rectangular or square 
cutout with the Pick tool. The cutout can be very small or as large as the drawing 
area. 

Define a free-form cutout when you want the cutout area to closely follow the 
contours of an object in the drawing. 

[> To define a free-form cutout: 

1. Select the Scissors cutout tool at the top left of the Toolbox and move the 
cursor into the drawing area. 

2. Press the mouse button to anchor the starting point. 
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3. Holding down the mouse button, draw a line around the part of your picture 
you want to define as a cutout. 

4. When you have completely circled the area, release the mouse button. 

If you make a mistake, click the right mouse button to start over. 

Define a rectangular or square cutout with the Pick tool when the size and shape of 
the cutout area don't need to conform closely to the object's contours. 

-----------------+ 

[> To define a rectangular or square cutout: 

1. Select the Pick cutout tool at the top right of the Toolbox and move the cursor 
into the drawing area. 

2. Press the mouse button to anchor one comer of the flexible box. 

3. Holding down the mouse button, move the cursor until the box encloses the 
area you want to define. 

4. Release the mouse button. 

If you make a mistake, click the right mouse button to start over. 

After you define a cutout, you can use commands from the Edit menu to cut, copy, 
paste, and save the cutout, and commands from the Pick menu to manipulate it in 
various other ways. For more information about ways of working with cutouts, see 
"Editing Your Drawing" and "Advanced Paintbrush Features" later in this chapter. 
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The Airbrush 

The Airbrush tool produces a circular spray of foreground-colored dots. 

The Airbrush was used to spray the graffiti on this wall. 

[> To use the Airbrush tool: 

1. Select the foreground color you want to use. 

2. Select the Airbrush tool from the Toolbox and move the cursor into the 
drawing area. 

3. At the location where you want to start the Airbrush spray, press the mouse 
button and drag the cursor. 

The speed at which you drag the cursor determines the density of the spray. 
The drawing width selected determines the size of the circle of spray. 

4. Release the mouse button to stop the spray. 

The Airbrush tool is particularly useful for making clouds or for shading "3-D" 
objects. 
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The Text Tool 

You can add text to your Paintbrush drawings with the Text tool. The text appears 
in the selected foreground color, font, point size, and font style. For more infor
mation about working with the Text tool, see "Entering Text" earlier in this 
chapter. 

The Color Eraser 

Use the Color Eraser to change an area of color. 

You can use the Color Eraser in two ways. You can: 

• Move the Color Eraser over an area of a drawing, changing the selected fore
ground color under the eraser to the selected background color. 

• Automatically change every occurrence of one color in the drawing area to 
another color. 
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[> To change a color with the Color Eraser: 

1. Select the foreground and background colors you want to use the Color Eraser 
with. You will use the background color to replace the foreground color. 

2. Select the drawing width you want to use. 

The larger the drawing width, the larger the Color Eraser cursor. You can erase 
small or large areas easily \Jy changing drawing widths. 

3. Select the Color Eraser tool from the Toolbox and move the cursor into the 
drawing area. 

4. Press the mouse button and drag the cursor to change any areas of currently 
selected foreground color under the cursor. (The other colors remain the same.) 

Hold down SHIff and press the mouse button to make the Color Eraser move 
in a straight horizontal or vertical line when you drag it. 

5. Release the mouse button to stop erasing. 

The selected foreground color remains the same in all areas not touched by the 
Color Eraser. 

[> To change every occurrence of one color to another color: 

1. Make sure that every place that has the colors you want to change is displayed 
in the drawing area. 

2. Select the color you want to change as your foreground color and select the 
color you want to change to as your background color. 

3. Double-click the Color Eraser tool. (Using the keyboard, move the cursor to 
the Color Eraser tool; then press F9 + INSERT.) 

Every section of the selected foreground color in the drawing area changes to 
the selected background color. 
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The Eraser 

The Eraser changes all the foreground color that it touches to the currently selected 
background color. 

Each spot the Eraser touches changes to the background color. 

l> To erase portions of the foreground color with the Eraser: 

1. Make sure the selected background color is the same as the background color 
in the area you want to erase. 

If the colors don't match, you will draw with the currently selected background 
color rather than erase to the original background color. 

2. Select the drawing width you want to use from the Linesize box. 

The larger the drawing width, the larger the Eraser cursor. You can erase small 
or large areas easily by changing drawing widths. 

3. Select the Eraser tool from the Toolbox and move the cursor into the drawing 
area. 
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4. Press the mouse button and drag the cursor to erase the part of the drawing 
under the cursor. 

Hold down SHIFT and press the mouse button to make the Eraser move in a 
straight horizontal or vertical line when you drag it. 

5. Release the mouse button to stop erasing. 

The Paint Roller 

Using the Paint Roller, you can fill in any closed shape or area with the selected 
foreground color. You can fill a hollow area enclosed by a border or fill a solid 
object with a different color or pattern. 

You can fill in enclosed areas using the Paint Roller. 

[> To fill in a closed area with the Paint Roller: 

1. Select the foreground color you want to use in the fill. 

If you fill an object with a pattern rather than a solid color, you will not be able 
to refill the object. However, you can use the Color Eraser to change the pat
tern used to fill an object. 

2. Select the Paint Roller tool from the Toolbox and move the cursor into the 
drawing area. 
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The Brush 

3. Place the cursor inside the area you want to fill and click the mouse button. 

The area fills with the selected foreground color. 

If the shape being filled has any breaks in its border, the filling color will leak 
through and fill the entire drawing area. If this should happen, wait for the color to 
stop leaking and select Undo from the Edit menu (or press ALT + BACKSPACE) to 
clean it up. Note that the drawing area itself defines a border, so color fills will 
stop at the edges of the drawing area. 

You can use the Zoom In command from the View menu to close the opening in 
your object where the color leaked out. See "Editing with Zoom In" later in this 
chapter for more information. 

CAUTION To prevent undoing work that you are satisfied with, reselect the Paint Roller 
each time you perform a fill. 

You can use the Brush tool just like a standard bristle paintbrush to draw freehand 
shapes and lines in the selected foreground color and drawing width. 

A freehand drawing created with the Brush tool 
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[> To draw freehand lines with the Brush tool: 

1. Select the foreground color you want to use. 

2. Select the drawing width you want to use. 

3. Select the Brush tool from the Toolbox and move the cursor into the drawing 
area. 

4. Press the mouse button and drag the cursor to draw freehand shapes. 

Hold down the SHIFf key as you move the mouse to draw straight horizontal or 
vertical lines. 

5. Release the mouse button to stop drawing. 

You can change the shape of the Brush cursor to create different effects as you 
paint. 

[> To change the shape of the Brush cursor: 

1. Choose Brush Shapes from the Options menu. 

The Brush Shapes dialog box appears. 

The standard shape for 
the Brush tool cursor 

OK Cancel 

2. Select a cursor shape by clicking it. 

Or use a DIRECTION key to select a shape. 

3. Choose OK. 

The Brush Shapes dialog box disappears, and the Brush cursor appears in the 
drawing area in the selected shape. 

HINT To open the Brush Shapes dialog box quickly, double-click the Brush tool in the 
Toolbox. 
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The Curve 
With the Curve tool, you can draw curved lines in the selected foreground color 
and drawing width. 

This stained glass window is made entirely of curved lines. 

l> To draw a curved line: 

1. Select the foreground color you want to use. 

2. Select the drawing width you want to use. 

3. Select the Curve tool from the Toolbox and move the cursor into the drawing 
area. 

4. Press the mouse button to anchor one end of the curve and, while still holding 
down the button, move the mouse. 

A flexible line stretches from the anchored endpoint to the current cursor 
position. 

5. When the line is the length you want, release the mouse button to anchor the 
second end of your curve. 

I 
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6. Press the mouse button and drag the cursor. 

The line curves in the direction you move the mouse. 

7. When you are satisfied with the angle of this first curve, release the mouse 
button. 

If you want to curve the line in only one direction, click the second end point 
of the line. Otherwise, go on to the next step. 

8. Press the mouse button again and move the cursor away from the first curve to 
bend your line in the opposite direction. 

9. When you are satisfied with the angle of this curve, release the mouse button 
again. 

Until you release the left mouse button the second time, you can click the right 
button to undo the curve and start over again. 

When you finish your curved line, Paintbrush colors the curve with the foreground 
color. 
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The Line 

You can easily draw straight lines in the selected foreground color and drawing 
width by using the Line tool. 

~ , 

A variety of effects created using only straight lines 

l> To draw a straight line: 

1. Select the foreground color you want to use. 

2. Select the Line tool from the Toolbox and move the cursor into the drawing 
area. 

3. Press the mouse button to anchor one end of the line and, while still holding 
down the button, move the mouse. 

A flexible line stretches from the anchored end to the cursor position, 
expanding and contracting as you move the mouse. 

4. When you are satisfied with the length and position of the flexible line, release 
the mouse button to paste the line onto the drawing area. 

If you are not satisfied with the line, click the right mouse button while still 
pressing the left button to undo the line and start over. 
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HINT To draw a perfectly straight horizontal, vertical, or diagonal line, hold down the 
SHIFT key as you drag the flexible line. 

The Box and the Filled Box 

The Box tool lets you draw hollow squares or rectangles in the selected fore
ground color and drawing width. The Filled Box tool produces squares and 
rectangles that are filled with the selected foreground color and bordered by the 
selected background color. 

Boxes and filled boxes 

!> To draw a box or filled box: 

1. Select the foreground color you want to use. 

2. If you are drawing a filled box, also select a background color for the border. 

3. Select the drawing width you want to use. 

If you are drawing a filled box, the drawing width you select determines the 
thickness of the box's border. If you want a filled box with no border, make 
the foreground and background colors the same. 

4. Select the Box or Filled Box tool from the Toolbox and move the cursor into 
the drawing area. 
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5. Press the mouse button where you want to anchor the box and, while still 
holding down the button, move the mouse. 

A flexible box stretches from the anchor point to the position of the mouse, 
expanding and contracting as you move the mouse. 

6. When you are satisfied with the size of the flexible box, release the mouse 
button to paste the box on the drawing area. 

Until you release the left mouse button, you can click the right button to undo 
the box and start over. 

HINT If you want to draw a square or a filled square, hold down the SHIFT key as you drag 
your flexible box. 

The Rounded Box and the Filled Rounded Box 

The Rounded Box tool works exactly the same as the Box tool, and the Filled 
Rounded Box tool works exactly the same as the Filled Box tool. The only 
differences are that rounded and filled rounded boxes have round comers. 

This streetcar uses rounded and filled rounded boxes. 

To learn how to draw a box or a filled box, see the preceding topic, "The Box and 
the Filled Box." 

HINT If you want to draw a rounded or filled rounded square, hold down the SHIFT key as 
you drag your flexible rounded box. 
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The Circle/Ellipse and the Filled Circle/Ellipse 

By using the Circle/Ellipse tool, you can draw perfect hollow circles or ellipses in 
the selected foreground color and drawing width. The Filled Circle/Ellipse tool 
produces circles and ellipses filled with the selected foreground color and 
bordered by the selected background color. 

Circles and ellipses - filled and unfilled 

l> To draw a hollow or filled circle or ellipse: 

1. Select the foreground color you want to use. 

2. If you are drawing a filled circle or ellipse, also select a background color for 
the border. 

3. Select the drawing width you want to use. 

If you are drawing a filled circle or ellipse, the drawing width you select deter
mines the thickness of the border around the circle or ellipse. If you want no 
border, make the foreground and background colors the same. 

4. Select the Circle/Ellipse or Filled Circle/Ellipse tool from the Toolbox and 
move the cursor into the drawing area. 



294 Working with the Paintbrush Tools 

5. Press the mouse button where you want to anchor the circle and, while still 
holding down the button, move the mouse. 

A flexible circle/ellipse stretches from the anchor point to the position of the 
cursor, expanding and contracting as you move the mouse. 

6. When you are satisfied with the size and shape of the flexible circle/ellipse, 
release the mouse button to paste it on the drawing area. 

Until you release the left mouse button, you can click the right button to undo 
the circle/ellipse and start over. 

HINT If you want to draw a perfect hollow or filled circle, hold down the SHIFT key as you 
drag your flexible circle. 

The Polygon and the Filled Polygon 

Using the Polygon tool, you can draw polygons out of connected straight line seg
ments in the selected foreground color and drawing width. The Filled Polygon tool 
produces polygons filled with the selected foreground color and bordered by the 
selected background color. 

Polygons and filled polygons 
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[> To draw hollow or filled polygons: 

1. Select the foreground color you want to use. 

2. If you are drawing a filled polygon, also select a background color for the 
border. 

3. Select the drawing width you want to use. 

If you are drawing a filled polygon, the drawing width you select determines 
the thickness of the polygon's border. If you want no border, make the fore
ground and background colors the same. 

4. Select the Polygon or Filled Polygon tool from the Toolbox and move the cur
sor into the drawing area. 

5. Press the mouse button to anchor the starting point of the polygon and, while 
still holding down the button, move the mouse. 

A flexible line stretches from the anchored starting point to the position of the 
cursor, expanding and contracting as you move the mouse. 

6. When you reach the point where you want the first side of the polygon to end, 
release the mouse button. 

A line appears from the starting point to the point where you released the 
mouse button. The end of the first line segment then becomes the starting point 
for the next segment. 

7. Continue adding sides until you are ready to complete your polygon. 

If you become dissatisfied with your polygon, click the right mouse button to 
undo it and start over. 

8. When you are ready to complete your polygon, double-click the mouse button. 

The polygon is automatically closed. 

HINT To draw straight horizontal, vertical, or diagonal lines, hold down the SHIFT key as 
you move the mouse. 

If you prefer, you can draw the lines for your polygon without dragging flexible 
lines. Just move the cursor, without pressing the mouse button, to the position 
where you want the next line to end and click the mouse button. A line appears 
between the two points. Before you release the mouse button, you can adjust the 
position of this line. 
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Editing Your Drawing 
As you are creating a Paintbrush drawing, there are a variety of tools and functions 
to help you make changes to your drawing. The BACKSPACE key and the Undo 
command on the Edit menu allow you to delete those parts of a drawing that are 
not pasted down yet. See "Basic Graphics Editing" and "Basic Text Editing" 
earlier in this chapter for information about BACKSPACE, Undo, and pasting. 

After you paste down part or all of a drawing, you can use the Eraser tool to erase 
and the Color Eraser tool to change colors. You can also define an area called a 
cutout and cut, paste, move, sweep, and copy that cutout. You can save a cutout in 
a disk file and retrieve it to use as part of another drawing. The following sections 
discuss using the two erasers and working with cutouts. See "The Cutout Tools" 
earlier in this chapter for information on defining cutouts. 

Using the Erasers 

By dragging the Eraser cursor over parts of your drawing, you can remove all the 
foreground color that the Eraser touches. You can use the Color Eraser to change 
colors in part or all of your drawing. For more information about using the erasers, 
see "The Eraser" and "The Color Eraser" earlier in this chapter. 

Cutting and Pasting Cutouts 

You can use the Cut and Paste commands on the Edit menu to transfer a defined 
cutout to and from the Clipboard, just as you transfer 'selected text to and from the 
Clipboard in other Windows applications. It is important to remember while 
cutting and pasting cutouts that you cannot paste a cutout larger than the current 
drawing area, unless you have zoomed out to display your entire drawing. If you 
try, Paintbrush pastes only the part of the cutout showing in the drawing area. For 
more information about using the Clipboard, see Chapter 2, "Basic Skills." 

Moving a Cutout 

After you define a cutout, you can move it anywhere in the drawing area. See 
"The Cutout Tools" earlier in this chapter for information about defining a cutout. 
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[> To move a cutout: 

1. Move the cursor inside the cutout. 

2. Press either mouse button and drag the cutout around in the drawing area. 

If you want to paste the cutout transparently in its new location, use the left 
mouse button. If you want to paste the cutout opaquely in its new location, use 
the right mouse button. See "Transparent and Opaque Pasting and Sweeping" 
later in this chapter for more information. 

3. When the cutout is where you want to leave it, release the mouse button. 

4. Click the mouse button outside the cutout to permanently paste the cutout in its 
new position. 

Sweeping a Cutout 

When you sweep a cutout, you move the cutout across the drawing area, leaving a 
trail of copies of the cutout behind. . 

Sweeping a cutout to illustrate movement in a drawing 
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[> To sweep a cutout: 

1. Move the cursor inside the cutout. 

2. Press either mouse button and hold down the CTRL key while dragging the 
cutout across the drawing area. 

If you want to sweep the cutout transparently, use the left mouse button. 
If you want to sweep the cutout opaquely, use the right mouse button. See 
"Transparent and Opaque Pasting and Sweeping" later in this chapter for more 
information. 

3. When you finish sweeping the cutout,release the mouse button and the CTRL 
key. 

4. Click either mouse button outside the cutout to permanently paste the cutout in 
the drawing area. 

Copying a Cutout 

When you move a cutout, you can choose to leave a copy of the cutout in its 
original position. 

[> To move a cutout and leave a copy behind: 

1. Move the cursor inside the cutout. 

2. Press either mouse button and hold down the SHIFf key while you drag the 
cutout away from the copy. 

If you want to paste the cutout transparently in its new location, use the left 
mouse button. If you want to paste the cutout opaquely in its new location, use 
the right mouse button. See "Transparent and Opaque Pasting and Sweeping" 
later in this chapter for more information. 

3. Release the SHIFf key once you have moved the cutout away from the copy. 

4. When the cutout is where you want to leave it, release the mouse button. 

5. Click either mouse button outside the cutout to paste the cutout permanently in 
its new position. 
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Moving, Sweeping, and Copying a Cutout in Zoom-Out Mode 

When you perform a cutout operation in zoom out mode, you can only paste the 
cutout opaquely. After you choose Paste or Paste From, a box representing the 
cutout appears in the upper-left comer of the drawing area. You can move the 
cursor inside the box and drag it to the desired position. To paste it down, click 
outside the box. You will have to click outside the drawing if you paste a cutout 
that is as large as the drawing itself. 

Transparent and Opaque Pasting and Sweeping 

Whenever you paste or sweep a cutout, you have the option of pasting or sweeping 
transparently or opaquely. If you paste or sweep transparently, any part of your 
drawing covered by the cutout shows through. If you paste or sweep opaquely, the 
entire cutout area covers whatever part of the drawing is underneath it. For 
example, the following illustrates both transparent and opaque sweeping: 

Sweeping a cutout transparently 

1 
Sweeping a cutout opaquely 

I 

I' 

If you want to paste or sweep transparently, the background color for the cutout 
and the currently selected background color must be the same. Otherwise, the 
object you paste or sweep won't be transparent. 

HINT If you want to sweep a cutout opaquely across the screen, you might want to define 
a freeform cutout. By creating a cutout that closely encircles the object you want to sweep, 
the shape that you sweep is only the defined object. If you define a rectangular cutout, you 
get the object inside a box of background color. 
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Saving a Cutout 

You can save a cutout as a Paintbrush file (.PCX) or as a bitmap file (.BMP). 
Unless you change the setting in the Save dialog box, Windows automatically 
assigns the extension .BMP and saves your cutout as a Windows bitmap. 

[> To save a cutout: 

1. Choose Copy To from the Edit menu. 

2. Type a name for your cutout in the Filename box and choose OK. 

If you want to save your cutout as other than a Windows bitmap file, choose 
the Options button in the Copy To dialog box and select from the options that 
appear. 

For more information about opening and saving files, see Chapter 2, "Basic Skills." 

If you are concerned about the amount of disk space needed to store a cutout, you 
can choose the Info button in the Copy To dialog box to see the size of and num
ber of colors in the cutout before you save it. The larger the size of the cutout and 
the more colors used, the more disk space it requires. 

Retrieving a Cutout from Disk 

The Paste From command on the Edit menu retrieves a previously saved cutout 
from disk and places it in the drawing area. The Paste From command works 
much like the Open command on the File menu. For more information about 
opening files, see Chapter 2, "Basic Skills." 

When you paste a previously saved cutout into Paintbrush, the cutout appears in a 
flexible box in the upper-left comer of the drawing area. (The Pick cutout tool at 
the top right of the Toolbox is automatically selected.) You need to move the 
cutout to the location in the drawing area where you want it to appear permanently. 

[> To place a cutout where you want it to appear permanently: 

1. Move the cursor inside the flexible box and press the mouse button. 

2. Drag the cutout to where you want it to appear in your drawing and release the 
mouse button. 

3. Click the mouse button outside the cutout to paste it on the drawing area. 
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If you want to see the height, width, number of colors, and number of planes used 
in the cutout before pasting it, choose the Info button in the Paste From dialog box. 

CAUTION If you paste a previously saved color drawing into a black and white drawing, 
Paintbrush translates the colors into black and white. 

Advanced Paintbrush Features 
Paintbrush has a number of other features that allow you to: 

• Shrink, enlarge, flip, and tilt defined cutouts. 

• Invert colors in a cutout. 

• Create drawings containing greater detail. 

• Do detailed editing. 

• Use custom colors in your drawings. 

The following topics explain each of these features. 

Shrinking and Enlarging a Cutout 

After you define a cutout, you can use the Shrink + Grow command on the Pick 
menu to enlarge or shrink the cutout to a different size. 

I> To change the size of a cutout: 

1. Choose Shrink + Grow from the Pick menu. 

2. Choose Clear from the Pick menu if you also want the original area to be 
erased after shrinking or enlarging the cutout. 

3. Move the cursor to where you want to anchor the upper-left comer of the 
flexible box that you use to change the dimensions of your cutout. Then press 
and hold down the mouse button. 

4. Stretch the Shrink + Grow flexible box from the anchored comer by moving 
the mouse until you are satisfied with the box's dimensions. 

To require the dimensions of the flexible box to be in proportion to those of the 
cutout, hold down the SHIFf key while moving the mouse. 



302 Advanced Paintbrush Features 

5. When you are satisfied with the dimensions of the flexible box, release the 
mouse button. 

The cutout shrinks or grows to fit the dimensions of the box. 

6. If you are satisfied with the altered cutout, select any tool to paste down your 
changes and prevent accidentally undoing them. 

If you shrink a defined cutout, you can remove what remains of the larger cutout 
using any of the various ways of editing a drawing. 

Flipping a Cutout 

You can use the Flip Horizontally command from the Pick menu to flip a defined 
cutout from side to side. Flip Vertically, on the same menu, flips a defined cutout 
from top to bottom. 

l> To flip a cutout horizontally or vertically: 

1. Choose Flip Horizontally or Flip Vertically from the Pick menu. 

Paintbrush flips the cutout horizontally or vertically at the current cutout 
position. 

2. Select any tool to paste the cutout on the drawing area. 

Inverting Colors in a Cutout 

The Inverse command on the Pick menu allows you to invert the colors in a 
defined cutout. In a black and white drawing, black becomes white and white 
becomes black. In a color drawing, a color changes to its complementary color 
(the color exactly opposite it on the RGB color wheel). For example, blue would 
become yellow. 
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[:> To invert the colors in a cutout: 

1. Choose Inverse from the Pick menu. 

The colors in the cutout are inverted. 

2. Click either mouse button outside the cutout to paste the inverted colors on the 
drawing area. 

Tilting a Cutout 

The Tilt command on the Pick menu tilts a defined cutout on an angle that you 
determine. 

[:> To tilt a cutout: 

1. Choose Tilt from the Pick menu. 

2. Choose Clear from the Pick menu if you also want the original area to be 
erased after tilting the cutout. 

3. Move the cursor to where you want to anchor the upper-left comer of the 
flexible box that you use to determine the angle of tilt. Then press and hold 
down the mouse button. 

Since you are tilting a copy of your cutout, you can anchor this box anywhere 
in your drawing. 

4. Move the mouse left or right. The bottom of the flexible box shifts with the 
mouse, tilting the sides of the box and changing the comer angles. 

You can tilt the same cutout as many times as you like. 

5. When you are finished creating tilted images, select any tool to paste the tilted 
cutout on the drawing area. 
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Working with Detail 

The Cursor Position command on the View menu displays the current cursor 
position as x-y coordinates. You can use these width and height coordinates to 
accurately align text or lines in your drawings. It is particularly helpful when you 
create charts and tables. 

I> To use the cursor position coordinates: 

1. Choose Cursor Position from the View menu. 

The Cursor Position window appears on the right side of the title bar above the 
drawing area. You can move it to any position outside the drawing area. See 
Chapter 2, "Basic Skills," for information on how to move windows. 

The Cursor Position window 

Eile ,Edit :!liew Font ~tyle Si.le Pick Qptions Help 

2. Move the cursor around the drawing area. 

The coordinates inside the Cursor Position window change to indicate the 
position of the cursor. The coordinates register only while the cursor is inside 
the drawing area. If you move the cursor outside the drawing area, the last 
valid coordinates remain showing in the window until you move back inside 
the drawing area. 

3. When you finish using the coordinates, choose Cursor Position again to 
remove the window from the screen. 
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Editing with Zoom In 

The Zoom In command on the View menu lets you magnify a portion of a drawing 
so you can make changes on a pixel-by-pixel basis. 

I> To edit a drawing with Zoom In: 

1. Choose Zoom In from the View menu and move the cursor into the drawing 
area. 

The cursor changes to a movable rectangle. 

2. Place the rectangle over the area you want to magnify with Zoom In. 

3. Click the mouse button, and Paintbrush magnifies the portion of your drawing 
enclosed by the rectangle. 

In the small box that appears in the upper-left comer of the drawing area, you 
can see how changes you make to the magnified area look at normal resolution. 

4. Edit the magnified area in any of the following ways: 

Click the left mouse button to change a single pixel to the selected fore
ground color. 

Click the right mouse button to change a single pixel to the selected 
background color. 

Press either mouse button and drag the cursor to change a wide area of 
pixels. 

Use the Paint Roller tool to change whole areas of solid color within the 
magnified area. The Paint Roller works the same with solid colors whether 
you are working with a full-size drawing or a magnified portion of a 
drawing. See "The Paint Roller" earlier in this chapter for more 
information. 

5. If you make a mistake, choose Undo from the Edit menu to return to the nor
mal resolution and cancel any changes made to your drawing. 

6. When you are satisfied with your changes, choose Zoom Out from the View 
menu. 

HINT If you use the Paint Roller tool with a full-size drawing and the paint leaks, Zoom In 
is very useful for patching the areas where the paint has leaked through. 
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Creating Custom Co/Drs 

Every color and pattern is made by varying the amount of each of the three pri
mary colors-red, green, and blue-present in the color. This is true even in mono
chrome (black and white) mode. For instance, white is made by mixing together 
255 parts of red, 255 parts of green, and 255 parts of blue. Black, on the other 
hand, is 0 red, 0 green, and 0 blue. 

You can create custom Paintbrush colors and patterns for your drawings by 
varying the amounts of red, green, and blue (or RGB components) present in the 
colors provided by Paintbrush. You can change colors and patterns at any time. 
Changing colors and patterns in mid-drawing does not affect your drawing in any 
way other than to provide you with more color options. 

[> To create a custom color: 

1. Select the color you want to modify into a custom color as the foreground 
color. 

2. Choose Edit Colors from the Options menu. 

The Edit Colors dialog box appears. 

Edit Colors 
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3. Use the scroll boxes inside the scroll bars to increase or decrease the amount of 
the primary color used, or type in a number from 0 to 255 in the text boxes. 

Imagine that each scroll bar controls the brightness of a red, green, and blue 
flashlight. Moving the scroll box to the right increases the amount of that RGB 
component present in the color, lightening it. Moving the scroll box to the left 
decreases the amount of that RGB component present, darkening the color. 

If you shine the three flashlights on the same point of a piece of paper, the 
color where the beams of light meet is the composite color, which you see in 
the large rectangle to the right of the scroll bars. 

4. When you are satisfied with your new color, choose OK. 
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If you are not pleased with your new color, choose Cancel to return to the 
drawing with the pre-edited color. Or, if you have edited a color several times, 
you can select Reset to return to the color provided by Paintbrush at the 
beginning of a session. 

When you choose OK, the new color replaces the edited color in the Palette. 

HINT To move quickly to the Edit Colors dialog box, double-click on the color or pattern 
that you want to edit in the Palette. (Using the keyboard, move the cursor to the color in the 
Palette and press F9 + INSERT.) 

If you like the new colors and patterns you create, you might want to save them so 
that they are available the next time you use Paintbrush. Use the Save Colors and 
Get Colors commands on the Options menu to save or retrieve your color palettes. 
You save and get custom color files the same way you save and get any other 
Windows file. Windows automatically assigns the extension .P AL to custom color 
files. For more information about opening and saving Windows files, see Chapter 
2, "Basic Skills." For more information about working with Windows files, see 
Chapter 4, "File Manager." 

Working with Paintbrush Files 
You can save your Paintbrush drawings as Paintbrush files or as bitmap files in 
four formats. Unless you change the setting in the Save As dialog box, Windows 
automatically saves a new drawing as a Windows bitmap file. It saves a drawing 
that you open and edit in the same format that it was opened in. Except for 
choosing what kind of a file to save, you save and open Paintbrush files the same 
way you save and open any other Windows file. For more information about 
opening and saving files, see Chapter 2, "Basic Skills." 

If you want to save your Paintbrush drawing in other than the default Windows bit
map format for your display, choose the Options button in the Save As dialog box 
and select from the following options. 

• PCX (for Paintbrush files) 

• Monochrome bitmap 

• 16 Color bitmap 

• 256 Color bitmap 

• 24-bit bitmap 
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You should save images in one of the Windows bitmap fonnats whenever 
possible, in order to maintain the highest possible level of compatibility across 
machines and future versions of Windows. 

NOTE To avoid using up more memory and disk space than is required, you should 
always use the bitmap format that is closest in size to the number of colors used in the 
picture. 

Converting Microsoft Paint Files 

You can easily convert a Microsoft Paint file to a Paintbrush file. However, you 
cannot use Paintbrush to work with a Paint file and then resave it as a Paint file. 

t> To convert a Microsoft Paint file: 

1. Choose Open from the File menu. 

The Open dialog box appears. 

2. In the Filename box, type the name of the Paint file followed by the extension 
.MSP. 

Or, if you do not know the name of the Paint file you want to convert, select 
the MSP option button from the Open From box, select the directory that con
tains the .MSP file, and then select the correct file from the Files list box. 

3. Choose OK. 

A dialog box appears asking you to confinn that the file should be converted to 
a Paintbrush file. 

4. Choose OK. 

The drawing appears on the screen. 

5. Edit the drawing, if you wish. 

6. When you are finished working with the drawing, choose Save from the File 
menu. 

Paintbrush automatically assigns the extension .BMP to the old filename and 
saves the drawing. 
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Printing a Drawing 
If you have installed a printer according to the directions in Chapter 5, "Control 
Panel," you can print your Paintbrush drawings. When Paintbrush prints a 
drawmg, it preserves the proportions of the drawing, ensuring that objects such as 
squares and circles do not become rectangles and ellipses on the printed page. 

[> To print the currently displayed drawing: 

1. Choose Print from the File menu. 

The Print dialog box appears, containing the different print options available. 

Print 

Quality Window OK 

O~ralt @~hole Cancel 

@frool o Pa~tial 
!!umber 01 copies: [D ~caling: 1100%1 

o Use Printer Resolution 

2. Make any necessary changes to the options. 

See the following table for explanations of the different options. 

3. Choose OK. 

If you want to cancel printing, choose Cancel from the dialog box that appears. 

The following table explains the different options available in the Print dialog box 

Use this option 

Number of copies 

Draft 

To do this 

Tell Paintbrush the number of copies that you want 
to print. 

Produce an un-enhanced copy of your drawing 
using the fastest speed of your printer. A few 
printers support only one setting for printing, in 
which case you will not notice any difference 
between Draft and Proof. 
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Use this option 

Proof 

Whole 

Partial 

Use Printer Resolution 

Scaling 

To do this 

Produce a copy of your drawing that makes use of 
as many of your printer's advanced features as 
possible. This is the standard setting. 

Print your entire drawing, including those parts not 
showing in the drawing area. This is the standard 
setting. 

Print part of your drawing. For more information, 
see the following section, "Printing Part of a 
Drawing." 

Print your drawing at printer resolution rather than 
at screen resolution. Since the dimensions of a pixel 
on a printer may be different from those for a pixel 
on a screen, Paintbrush must stretch a drawing to 
produce the same dimensions on the printed page as 
you see on the screen. 

Tell Paintbrush how much to scale the image before 
sending it to the printer. Scaling by 100 percent 
implies no scaling. 

Printing Part of a Drawing 

When you select the Partial option in the Print dialog box, you must determine 
which part of your drawing you want to print. 

[:> To print part of a drawing: 

1. Select Partial from the Print dialog box. 

Paintbrush adjusts the size of your drawing so that the entire image is dis
played on the screen, and the cursor becomes a flexible box. 

2. Press the mouse button where you want to anchor one comer of the flexible 
box. 

3. Move the box until it contains the portion of the drawing that you want to print. 

4. Release the mouse button. 

Paintbrush prints the selected portion of the drawing. 
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Setting Margins 
Paintbrush prints your drawing using the margin settings in the Page Setup dialog 
box. If you want to position your drawing differently on the page, Paintbrush 
allows you to adjust the margins. 

t> To set the margins you want to use for printing: 

1. Choose Page Setup from the File menu. 

The Page Setup dialog box appears. 

Page Setup 

!!eader: 

[ooler: 

Margins--------. 

lop: ~ !!.ollom: ~ 

heft: ~ Right: ~ 

OK 

Cancel 

The standard settings for margins 

2. Type over the standard settings with the margin settings you want to use. 

Paintbrush warns you if your margin settings are too small for the size of your 
drawing. If your margin settings are larger than the size of your drawing, 
Paintbrush positions the upper-left comer of the drawing according to the 
settings in the Top and Left margin boxes. 

3. Choose OK. 

When you print, Paintbrush uses the new margin settings in the Page Setup 
dialog box to position your drawing on the page. 

Printing Headers and Footers 

When you print a drawing, you can add explanatory text, the date, a page number, 
or the filename as a header or footer on the printed page. You can also choose 
whether you want a header or footer to be left-justified, right-justified, or centered 
on the page. 
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[> To print a header or footer on a drawing: 

1. Choose Page Setup from the File menu. 

The Page Setup dialog box appears. 

2. Type the text you want to use as a header or footer in the appropriate box along 
with any of the codes that can be used in these boxes. See the following table 
for information about these codes. 

The Header and Footer boxes will scroll as you type in text. 

3. Choose OK. 

The following table explains the codes that you can type in the Header and Footer 
boxes: 

Type this 
command 

&d 

&p 

&f 

&1 

&r 

&c 

&t 

To do this automatically 

Enter the current date. 

Enter page numbers. 

Enter the current filename. 

Justify the text that follows at the left margin. 

Justify the text that follows at the right margin. 

Center the text that follows between left and right margins. 
This is the default. 

Enter the current time. 

You can include any or all of these codes in a single header or footer. When you 
print, any assigned headers or footers appear in their designated places on the 
printed pages. Headers always appear in the top margin and footers appear in the 
bottom margin, regardless of how your margins are set. 
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Changing the Printer 
Paintbrush prints your drawings on the default printer. If you have other printers 
installed and assigned as active printers, you can make any of these active printers 
the default printer by using the Printer Setup command on the File menu. If you 
want to print to an installed printer that is not active, you II;lust use Control Panel 
to make it active. For more information, see Chapter 5, "Control Panel." 

The printer you change to does not need to be physically connected to your com
puter. You can change to another printer just to format a drawing for that printer. 

[> To change printers: 

1. Choose Printer Setup from the File menu. 

The Printer Setup dialog box appears with a list of all the active printers. 

2. Select the name of the printer you want to change to from the Printer box. 

If you want to change the print options for the selected printer, choose the 
Setup button. See Chapter 5, "Control Panel," for information on print options. 

3. Choose OK. 

Paintbrush now automatically prints to the newly selected default printer. 
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Before Starting 
This chapter explains how to use Tenninal, the Microsoft Windows application 
that allows you to connect your computer to other computers and exchange infor
mation. For example, with Tenninal you can hook up to on-line infonnation 
services, such as Dow Jones NewslRetrieval ® and CompuServe ®, and to on-line 
bulletin boards. The chapter concludes with a troubleshooting section to help you 
solve any problems you may encounter in your communications sessions. 

The chapter assumes that you are familiar with basic telecommunications concepts 
and tenns, such as modem, baud, and protocols. If exchanging infonnation 
between computers is new to you, you might want to consult an introductory book 
on the subject. 

Besides the basic hardware requirements for Windows (see "Microsoft Windows 
3.0" at the beginning of this manual), you will need additional hardware to make 
full use of Tenninal. You will also need to know the settings required by the 
remote computer with which you want to communicate. 

Hardware Requirements 

You can connect and transfer files to another computer in the same room or to 
computers in different offices or buildings. 

To connect two computers in the same room, you need a special serial cable called 
a null modem cable. Each machine must have its own communications application 
as well-either Tenninal or another application. 

To communicate with computers in different locations, you need the following 
hardware: 

• An unused serial port 

• A modem and a cable to connect to a serial port 

For more infonnation about these components, see your hardware manual or com
puter dealer. 

Communications Settings of the Remote Computer 

You can run Tenninal to see what it looks like without knowing the communica
tions settings for the other computer. However, you need this infonnation, in order 
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to make a connection. To sign on to another computer and transfer data, you need 
to know that computer's basic settings: baud rate, data bits, stop bits, parity, and 
flow-control method. If you use an on-line service, such as CompuServe, you can 
find information about the settings in the introductory package you received when 
you joined the service. 

In addition, you can use Terminal (.TRM) files created with previous versions of 
Windows without having to change any settings. These files allow Terminal to use 
the settings you previously specified. 

A First Session 
Suppose you want to hook up to a remote system that hosts on-line services. You 
want to read mail and then create, edit, and return a document to a person who also 
uses the service. Your first communications session might go like this: 

Start Terminal 

Change settings using Settings menu 

Dial remote computer using Phone menu 

Receive (download) a file using Transfers menu 

Disconnect from remote computer 

Hang up modem using Phone menu 

Save settings using File menu 

Exit Terminal using File menu 
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Of course, your actual sessions might differ. Perhaps you will not download files 
from the remote computer, for example. Or maybe you will use settings specified 
in a previous session. Choose from the following tasks according to your needs. 

Starting Terminal 
I> To start Terminal: 

1. Open the Accessories window. 

2. Double-click the Terminal icon. 

Or select Terminal and choose Open from the File menu. The following screen 
appears: 

= ' Terminal - (Untitled)' "~ , aa 
File Edit Settings Phone Iransfers Help 

+ 
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Preparing to Connect 
Each Terminal session requires that you indicate the settings for the remote com
puter and any other settings you want to specify, or use settings you previously 
saved in a settings file. Settings files are identified by the .TRM extension in the 
filename. Instructions for opening a .TRM file you have already saved and for 
specifying new settings follow. 

Opening Terminal Windows 
You can use the New and Open commands on the File menu to select a different 
settings (. TRM) file from the current one. 

r> To start a new settings file and open a new window: 

D Choose New from the File menu. 

You will start with all the standard settings, which you can change to match the 
remote system to which you want to connect. 

[> To use a settings file that has already been created and saved: 

1. Choose Open from the File menu. 

2. From the displayed list, select the .TRM file you want to use for this session. 

Entering a Phone Number 
Terminal dials a phone number to connect to the remote computer when you 
choose Dial from the Phone menu. 



Chapter 9 Terminal 321 

t> To enter the phone number you want Terminal to dial: 

1. Choose the Phone Number command from the Settings menu to display the 
following dialog box: 

j!ial: 

Iimeout If Not Connected In ~ Seconds 

o Redial After Timing Out 0 liignal When Connected 

2. In the Dial box, type the phone number that you want the modem to dial. 

You can type parentheses and dashes, but they are not required. Type commas 
to provide any delays needed for the number to be processed by the telephone 
system. Each comma inserts a delay of approximately 2 seconds. The 
following string first dials a 9, then pauses for 4 seconds before dialing the 
10-digit number shown: 

9,,1-800-555-1212 

3. Set the options you want and then choose OK. 

Explanations of these options follow: 

Use this option 

Timeout If Not Connected in 
30 Seconds 

Redial After Timing Out 

Signal When Connected 

To do this 

Increase the number of seconds you want 
Terminal to wait for a connect signal from the 
remote computer (30 seconds is the minimum 
waiting time). When one modem calls 
another, the originating modem waits for high
pitched answer tones and data signals. If a 
remote modem is busy with other calls or is 
being serviced, it may not answer with signals 
immediately. 

Dial the phone number again if a previous 
attempt did not result in a connection. 

Ring the system bell (beep) when a successful 
connection to the remote computer has been 
made. If you are likely to step away from the 
computer, the bell can be a helpful reminder. 
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If you want to save these settings for a future communications session, you must 
save them with a Settings file. See "Saving Settings Files" later in this chapter. 

Setting Terminal Emulation 

With Terminal, your computer can emulate the terminal type required by the 
remote computer with which you are exchanging data. You specify the terminal 
type with the Terminal Emulation command. 

I> To specify the terminal emulation type: 

1. Choose Terminal Emulation from the Settings menu to display the following 
dialog box: 

Terminal Emulation 

o lTV (Generic) OK 
@ (t.>.~:~::v.f.I9.~ftA~:~m 
o DECVT-5.2 

Cancel 

The terminal types shown are the most common ones used by the large, main
frame computers that host on-line services. If you are not sure which terminal 
to use, select TTY. 

2. Select a terminal type and then choose OK. 

After you confirm your selection, Terminal adjusts your system so that your com
puter, keyboard, and terminal perform just as the specified terminal does. If you 
select TTY, the remote system receives formatting codes for the carriage return, 
backspace, and tab characters only. 

The table in Appendix C, "Terminal Emulation Tables," describes how the various 
configurations compare with the behavior of the IBM PC keyboard. 
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Specifying Terminal Preferences 
You can specify how your terminal performs during a communications session by 
using the Terminal Preferences command. 

C> To specify terminal preferences: 

1. Choose Terminal Preferences from the Settings menu to display the following 
dialog box: 

Terminal Preferences 

!ZI ~how Scroll Bars Buffer kines: ~ 

2. Select the options you want and then choose OK. Explanations of these options 
follow: 

Use this option 

Line Wrap 

To do this 

Automatically wrap incoming characters running past 
the last specified column to the next line. For example, if 
the host terminal uses 132-column lines and you have an 
80-column terminal, select this option. When Line Wrap 
is not selected, incoming characters to the right of the 
specified column width are lost. 
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Use this option 

Local Echo 

Sound 

Columns 

Terminal Font 

Show Scroll 
Bars 

To do this 

Display your keystrokes on your terminal. This option 
allows you to see the data you are sending to the remote 
computer as you type it. 

If the remote system echoes your characters back to you 
(known as remote echo), do not select Local Echo or you 
will see duplicated characters on your terminal. If the 
remote system is not configured for remote echo, select 
Local Echo to display the outgoing characters as you 
type them. 

The remote system may operate in half or full duplex. 
Half-duplex systems cannot echo your keystrokes to 
your screen. Full-duplex systems can echo your typing. 

Tum on the system bell (or beep) for the remote 
computer. 

Specify your monitor type-the common 80-column 
monitor or the wide 132-column monitor. You can 
specify 132 if you want an 80-column monitor to behave 
as if it were a wide monitor, and vice versa. If you 
specify 132, Terminal will reserve 132 columns for text 
whether or not 132 columns are entered or received. 
Therefore, specify 132 only if you must receive text in 
132 columns. 

Specify the font to use from the list of currently installed 
Windows fonts. Both the characters you type and 
incoming data will appear in the font you choose. After 
choosing a font, select the display size you want for the 
font. 

Display the scroll bars. Scroll bars are useful for 
reviewing information that you have already typed but 
that has scrolled off the screen. 
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CR to CR/LF 

Cursor 

Translation 
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To do this 

Specify each carriage return as a carriage return plus a 
linefeed. Linefeeds move text on a printer or monitor 
down one line, while carriage returns may move the 
print head or cursor to the left margin (depending on the 
computer type). When communicating with remote 
computers, you can specify lhal a carriage return be in
terpreted as a carriage return plus a linefeed. Before 
selecting this option, you will want to know whether the 
remote computer already sends linefeeds or not. 

You can select Inbound, Outbound, both, or neither. If 
you select Inbound, carriage returns in any text coming 
from the remote computer will be interpreted as carriage 
returns followed by linefeeds. If you select Outbound, 
you are assuming that carriage returns you send will be 
interpreted by the remote computer as carriage returns 
followed by linefeeds. 

Whether you select Inbound or Outbound depends on 
how the remote system handles the end of a line and 
what it expects from other computers. For example, if it 
sends carriage returns only, select Inbound to make all 
incoming carriage returns act like a carriage return fol
lowed by a linefeed. If the remote system sends carriage 
returns followed by linefeeds, do not select Inbound; if 
you do, each carriage return will be followed by two 
linefeeds. The same holds true of Outbound; if the re
mote system expects to get carriage returns and add its 
own linefeeds, do not select Outbound. 

Specify whether or not the cursor blinks and what shape 
it has-Block or Underline. 

Specify a country setting to send and receive data in 
another language. By selecting a country name, you 
specify which International Standards Organization 
(ISO) 7-bit character set to use. Make sure that the host 
computer recognizes the character set you select. 
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Use this option 

Buffer Lines 

To do this 

Specify how much incoming data is saved in the buffer. 
You can set the buffer to store from 25 to 400 lines of 
information. If you type a number that is higher than the 
available memory, Terminal automatically sets the buffer 
to the largest number of lines that memory permits. If 
you type fewer than 25 lines, Terminal reserves 25 lines. 

Specifying Communications Settings 

You must specify communications settings before exchanging information with 
another computer. Check your modem documentation and the remote service 
package for the correct settings. 

[> To specify the communications settings: 

1. Choose the Communications command from the Settings menu to display the 
following dialog box: 

Communications 

.!laud Rate--------, 

0110 0300 0600 @ 1200 

o 2400 0 4800 0 9600 0 19200 

,Data Bits I Stop Bits 
I 04 05 06 07 @ 8 @ 1 01.5 02 

farity flow Control tonnector 

@None @XonlXolf ~N."' o Odd o Hardware 

o Even o None 

su:' 
o Mark 

o Space D Parity Checl!,. D Ca[rier Detect 

2. Select the options appropriate to your system and the remote computer. Then 
choose OK. Explanations of these options follow: 
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Baud Rate 

Data Bits 

Parity 

Flow Control 
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To do this 

Specify the data transfer rate of the two modems. The 
most common settings are 300, 1200, and 2400 bits per 
second. Some modems can transmit at more than one 
baud rate, so check your hardware manual and select a 
rate that the remote system can handle. 

Specify the number of data bits in each data packet sent 
between the two computers. Most characters are trans
mitted in 7 or 8 data bits. A few computers require a 
setting of 4,5, or 6 data bits, but they are rare. 

Specify the type of parity. If you selected 8 data bits in 
the previous option, select no parity (None). Mark parity 
means that the eighth bit is always on (set to 1). Space 
parity means the eighth bit is always off (set to 0). 

When Odd is chosen, Terminal adds up the individual 
data bits used to transmit a character and then adds an 
eighth bit. If the sum of the bits in the character is even, 
the system will add a 1 bit to make it odd. If the sum is 
odd to begin with, Terminal will add a 0 bit to leave it 
unchanged. Even parity works similarly. 

When no parity is used to transmit characters in the 
standard ASCII code set, the eighth bit is still trans
mitted, but it is ignored by both Terminal and the remote 
system. 

Tell Terminal what to do if the buffer becomes too full to 
receive more data from the remote system. 

Xon/Xoff specifies that Terminal pause when the buffer 
fills. When Terminal is ready for more data, it sends a 
"go-ahead" signal to the remote computer. This method 
is known as software handshaking. While it is the 
standard method for most systems, it cannot be used 
with a remote system that is configured for hardware 
handshaking. Select Xon/Xoff if you do not know what 
type of flow control method is used. 

Hardware tells Terminal that the remote system uses the 
hardware method for flow control. 

None tells Terminal that the remote system uses no 
method to control the flow of data. 
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Use this option 

Parity Check 

Carrier Detect 

Connector 

Stop Bits 

To do this 

See the byte in which a parity error was encountered. 
Otherwise, you will see a question mark (?) where the 
modem detected an error. The question marks will 
appear at every character that was not transferred 
correctly. 

Tell Terminal to use the modem signal for detecting a 
carrier signal. If your modem still is not connecting after 
correctly setting the other options, tum off this option to 
use Terminal's own carrier detection method and try 
connecting again. 

Select the communications port that your modem uses. 
If you are using a null modem, select None. Terminal 
uses COM! if it is available and then checks COM2, and 
so forth. 

Specify the time between transmitted characters. Stop 
bits are not actually bits; they are the timing unit 
between characters. 

Changing the Modem Command Settings 

You can use the Modem Commands command on the Settings menu to specify the 
settings appropriate for the modem you are using. 

When you choose Modem Commands, Terminal displays the commands used for 
several popular modem types. If your modem is not one of these types, you can 
enter the appropriate commands for it. 
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[> To change modem command settings: 

1. Choose Modem Commands from the Settings menu to display the following 
dialog box: 

Prefix: Suffix: 

J!ial: I WiD II 

.!::!.angup: 1+++ IIATH 

Binary IX: I II 
Modem Defaults 

@ Hayes 
Binary!lX: I II o MultiTech 
Answer: IATQ1EOSO=1 o TrailBlazer 
!!riginale: IATQOEl SO=O o None 

2. Select the modem you are using from the Modem Defaults option. Then 
choose OK. 

When you select another type of modem, the commands change accordingly. 
These commands are explained in your hardware manual. 

3. If you want to, you can make minor adjustments to the settings by modifying 
one or more commands in the Commands option. For example, if the Hayes 
commands are the same ones used by your modem, yet you want to do pulse 
dialing instead of tone dialing, you would change the Hayes Dial Prefix com
mand from A TDT to A TDP. 

4. Choose OK. 

If you modify the commands incorrectly, you can reset them to the standard com
mands by selecting the appropriate modem type again. 
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Assigning Function Keys 
With function keys, you can automatically execute commands that you would 
ordinarily have to type. Because Terminal reserves the function keys for other 
purposes, the function keys you assign must be preceded by the CTRL + AL T key 
combination. 

[> To assign function keys and their commands: 

1. Choose Function Keys from the Settings menu to display the following dialog 
box: 

Function Keys 

Key Name: r-Co_m_ma_"d_: ____ ----, 

F;!: ~====:~======~ 

F§.: ~==~~======~ 
F!!: ~==~:===========: 
FI.: :====~:===========: 
Fa: D Keys Visible 

To use these function keys from the keyboard, 
press CTRL+ALT+ a key from F1 to FB. 

In this dialog box, you can define how each function key performs during a 
Terminal session. You can also rename the key and tell Terminal to display the 
key choices at the bottom of the Terminal window. 

2. Enter a name for each function key you want to specify in the respective Key 
Name box. 

For example, you could enter type hello as the name of a prompt command. 

Names are optional. However, if you do not name a function key, Terminal 
won't display it at the bottom of the window. 

3. In each corresponding Command box, indicate the function you want each key 
to perform. Then choose OK. 

For example, you could type hello in the Command box that corresponds to the 
type hello key name. Your Terminal window would appear as follows if you 
displayed function keys as described later in this chapter: 
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file .Edit lietlings Ehone Iransfers Help 

• + 

F1 F2 F3 F4 
F5 F6 F7 FB 

An explanation of each function follows: 

Control Code 

"A to "Z 

"$D<NN> 

"$B 

"$C 

"$H 

"$L 1 to "$L4 

Function 

Sends control code A through control code Z to the 
remote computer. 

Causes Terminal to delay for NN seconds before 
continuing. 

Causes Terminal to transmit a break code of 117 milli
seconds in duration. 

Causes the same action as choosing Dial from the Phone 
menu. 

Causes the same action as choosing Hangup from the 
Phone menu. 

Changes to another level of key groups in which keys 
are defined. 
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You can assign frequently typed text (strings) to a function key. For example, you 
can assign a sequence that includes a number, a name, and a password to log on to 
a remote computer. A sample log-on command sequence might be: 

"$C"$D03AM"$D02myname"M"$D04passwordAM 

where myname represents your log-on name or user J.D., and password repre
sents your password to the remote computer. These commands would perform the 
following actions in order: 

1. Dial the number that you specified from the Settings menu (I\$C). 

2. Wait 3 seconds (I\$D03). 

3. Send a carriage return (I\M). 

4. Wait 2 seconds (I\$D02). 

5. Send your log-on name to the remote computer (myname). 

6. Send a carriage return (I\M). 

7. Wait 4 seconds (I\$D04). 

8. Send your password (password). 

9. Send a carriage return (I\M). 

The delays are needed to give the remote computer enough time to respond with 
prompts. For example, an on-line service would prompt you to enter your log-on 
name. 

You can assign up to 32 function keys in four different levels by using the Key 
Level box. Assigning function keys to a level allows you to identify up to eight 
keys in a group. For example, you might want to group the eight function keys that 
you use most often in Levell. 
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t> To assign function keys to a level: 

1. In the Key Level box of the Function Keys dialog box, select 1 for the first key 
level. 

2. Enter up to eight function-key names and commands. 

3. Repeat steps 1 and 2 if you want to define another level. You can define up to 
four levels. 

4. Choose OK. 

When you start Terminal, it does not automatically display function-key buttons. 

C> To display function-key buttons: 

1. Select the check box for the Keys Visible option in the Function Keys dialog 
box. 

A pad of function-key buttons with their names and key level appears at the 
bottom of the Terminal window. 

2. To remove the display of these buttons, clear the check box for the Keys 
Visible option. 

3. Choose OK. 

Showing and Hiding Function Keys 

You can switch the function-key pad display at the bottom of the window on and 
off as you work. 

C> To display or hide the function keys: 

o Choose the Show Function Keys command from the Settings menu. The com
mand changes to Hide Function Keys so that you can remove the display by 
choosing the command again. 

To learn how to specify tasks for function keys, see "Assigning Function Keys" 
earlier in this chapter. 
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Timing Sessions with Timer Mode 
When function keys are displayed (with the Show Function Keys command), a 
box in the lower-right comer of the Terminal window also displays and includes 
the system time. 

When you choose the Timer Mode command from the Settings menu, the timer is 
set to 00:00:00. Terminal then tracks how long you have been connected to the 
remote system. That way, you can monitor the length of your hook-up time and 
avoid charges you did not anticipate. 

To see the system time again, click the time display. 

[> To time your communications sessions: 

1. Choose Timer Mode from the Settings menu. 

When the timer function is active, the Timer Mode command is preceded by a 
checkmark. 

2. To display the system time and reset the timer, tum off the Timer Mode com
mand by choosing it. To simply see the system time without resetting the 
timer, click the time display. 

Connecting to the Remote Computer 
Once you specify the settings for a session or open a Settings file, you can call the 
remote system. Terminal uses the phone number specified in the Phone Number 
option on the Settings menu or prompts you to supply the information. 

[> To connect to the remote computer: 

[J Choose Dial from the Phone menu. 

Terminal will begin dialing the number. If you did not specify a number in the 
Settings menu, the Phone Number dialog box appears. See "Entering a Phone 
Number" earlier in this chapter. 

Transferring Files 
Once you have called another computer and the computers are communicating 
properly, you can send or receive text or binary files. 
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Setting Up File Transfers 

Before you send or receive files by using commands on the Transfers menu, you 
can specify the transfer rules. You should do so only if you plan to send or receive 
text or binary files. You need not do so if you are simply going to read or send 
electronic mail. 

Text files are prepared with a text editor or word processing application (such as 
Notepad or Write) and saved unformatted. This type of file is known as an ASCII 
file and contains only the printable ASCII characters and the few control codes 
needed for minimal formatting, such as carriage returns and linefeeds. 

Binary files consist of ASCII characters plus the extended-ASCII character set. 
These files are not converted or translated during the transfer process. If you 
intend to transfer program files, you must use a binary transfer. 

The two methods of transfer-text and binary-differ in a number of ways. In 
general, it is preferable to send both text and binary files using the binary transfer 
method because this method checks more rigorously for errors and loss of data. 
However, if you do not need to send formatting codes and you are not worried 
about the loss of data, the text transfer method can be faster. Other significant 
differences between binary and text transfers are summarized in the following list: 

Binary transfers 

Automatic retransmission if an error 
is detected 

Suitable for use with any type of file 

Protocol (XModem/CRC or Kermit) 
on each system makes system type 
irrelevant 

Parity is usually not used for error
checking 

Transfer of entire file contents only 

Text transfers 

Possible suspension of transmission 
if an error is detected 

Suitable for use with ASCII text files 
only 

Lack of protocol makes system 
specifics important 

Parity can be used to detect character 
transmission errors 

Transfer of entire or partial file 
contents 

When communicating with a system that does not recognize either of the binary 
protocols supported by Windows (XModem/CRC or Kermit), you will need to do 
a text transfer. Text transfers are intended for use with ASCII text files only. 
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Preparing to Transfer Text Files 
Text files are ASCII text, with font, style, and size specifications stripped out. 
Because most applications can work with text alone, this format is useful for 
transfers between vastly different systems. 

I> To prepare for text file transfers: 

1. Choose Text Transfers from the Settings menu to display the following dialog 
box: 

Text Transfers 

Flow Control------, 

@ ii~:~~:~~:i:~:I!~:~::t.~:~~!~:!l 
o .character at a Time 

o Line at a Time 

Transfer Using Standard Flow Conhol-----, 
Selected Flow Control Method: XonlXoff 

Specify the flow control method with 
the Communications command. 

D Word~rap Outgoing Text at Column: 

2. Select the options you want to specify and then choose OK. Explanations of 
the options follow: 

Use this option 

Standard Flow 
Control 

Character at a 
Time 

To do this 

Use the flow control method you chose with the 
Communications command. For an explanation of the 
options, see "Specifying Communications Settings" 
earlier in this chapter. 

Specify that text files be sent one character at a time. 
Choosing this option displays the following additional 
options in the center of the dialog box: 



Use this option 

Line at a Time 
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To do this 

Delay Between Characters 

Transmits characters evenly and slowly enough to 
prevent errors. However, no true verification is done on 
the transmitted data, and no feedback comes from the 
remote system. You can set the delay by typing a value 
in the /10 Sec text box. 

Wait for Character Echo 

Sends one character (8 bits) at a time and then waits to 
echo the character back. Terminal then verifies that the 
two characters are the same before sending the next 
character. The transfer continues in this manner until the 
end of the file is reached. This method is extremely slow 
and should be used only with a system that echoes 
characters reliably. 

Specify that text be sent one line at a time. If you select 
this option, the following options appear: 

Delay Between Lines 

Transmits lines evenly and slowly enough to prevent 
errors. However, no true verification is done on the trans
mitted data, and no feedback comes from the remote 
system. You can set the delay by typing a value in the 
/10 Sec box. 

Wait for Prompt String 

Sends one line and then waits until the remote system 
sends a string (a message) back to Terminal before 
sending the next line. 

The remote system can assume that this session is 
occurring interactively and, therefore, sends back "OK. 
I'm ready for the next line." at the end of each line. This 
scenario assumes that you are waiting to see this string 
in the Terminal window before typing in the next line. 

Terminal can also automate this process by allowing you 
to specify what string of characters it will wait for before 
sending the next line. 
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Use this option 

Word Wrap 
Outgoing Text 
at Column 

To do this 

AM is the suggested end-of-line code, because if your 
remote system actually echoes characters instead of 
sending a prompt string, it will echo the carriage return 
(AM) at the end of a line. This code indicates that it 
received the whole line and is ready for the next. 

This method is faster than character echo and works 
better if your remote character echo is unreliable. You 
can find this out by experimenting or by contacting the 
administrator of the remote system. 

Use this option if the files you want to send were created 
with a text editor or word processor. You can specify a 
column up to 132 characters wide, regardless of the size 
of your terminal. If this option is not chosen, outgoing 
text will be sent as it is currently formatted. To send a 
file to a 132-column terminal, enter 131. Reducing the 
column size by 1 leaves one character space for the 
end-of-line code (usually AM). 

Preparing to Transfer Binary Files 
Unlike text transfers, which require you to know the settings needed by the remote 
computer, binary transfers allow you to use standard protocols for data trans
mission. You must specify the protocol that the remote computer uses. Terminal 
gives you the choice of two common protocols-XModem/CRC and Kermit
which are explained next. 
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[> To prepare for a binary transfer: 

1. Choose Binary Transfers from the Settings menu to display the following 
dialog box: 

@ Ig~:~~:~!!iJ~:~:t.j 
O~elmit 

2. Select the protocol you want to use and then choose OK. Explanations of these 
options follow: 

Use this option 

XModem/CRC 

Kermit 

To do this 

Specify the XModem/CRC binary protocol, which 
uses all 8 bits as data bits and, thus, requires the Parity 
option to be set to None. (You set parity with the 
Communications command on the Settings menu.) 

Terminal initially assumes the cyclic redundancy check 
(CRC) scheme for error-checking. If the remote system 
does not support CRC, Terminal automatically uses the 
checksum scheme. 

Specify the Kermit protocol, which can use either 7 or 8 
bits as data bits; thus, parity can be specified as Even, 
Odd, or None. Use 8 bits when sending data from the 
ASCII extended character set (from 128 to 255). Use 
None for 8-data-bit packets. 



340 Transferring Files 

Sending Text Files 

If you specified the settings for text transfers using the Settings menu, you are 
ready to send your file. You can use the Send Text File command on the Transfers 
menu to send files you have saved in ASCII format (with minimal formatting 
codes). 

[> To send text files: 

1. Choose Send Text File from the Transfers menu to display the following 
dialog box: 

l:.J ............................................... . 
[-a-) 
[-col 
[-dol 
[-1-) 

Following CR: 

o Append LF 

i:8llitlip LF 

L....--___ .....L-_ Or select from Files and Directories. 

2. In the Filename box, type the name, including the directory path, of the file 
you want to send, or select a directory and filename from the Directories and 
Files boxes. 

3. To attach a linefeed to the end of each line of the text you send, select Append 
LF. To strip out linefeeds in the text you send, select Strip LF. 

If the remote system adds them to incoming text, you need to strip out line
feeds. For an explanation of linefeeds, see the CR to CR/LF option under 
"Specifying Terminal Preferences" earlier in this chapter. 

4. Choose OK to begin sending the file. 

You will see the file scroll in the Terminal window. 



Filename 
Pauses transmission and changes to Resume 

Stops transmission 
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5. To pause, resume, or stop the transmission, choose these commands from the 
Transfers menu or from the control buttons that appear near the bottom of the 
Terminal window. 

Receiving Text Files 

If you specified the settings for text transfers using the Settings menu, you are 
ready to receive a text file. You can use the Receive Text File command on the 
Transfers menu to receive a new text file, or to append or overwrite any incoming 
text file to an already existing file. 

t> To receive a text file: 

1. Choose Receive Text File from the Transfers menu to display the following 
dialog box: 

Receive Text File 

Filename: 

Director,: c:\windows 

Qirectories: 

I .. ] + 
Is,stem] 0 Append File 
Itemp] 
l-a-] 0 Save J;.ontrols 

u..1-..... c-]L--_-..1. ..... + 0 lable Format 

2. To receive a new file, type a new filename in the Filename box. Then skip to 
step 4. 
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3. To append to or overwrite an existing file, select the directory that contains the 
file and select the filename. 

You can also rename an incoming file and assign it to a different directory. To 
do so, type the directory path and the filename in the Filename box. Alterna
tively, you could select a directory in the Directories box and type the filename 
in the Filename box. In this case, you would not choose Append File. 

4. Select any or all of the boxes at the lower-right comer of the dialog box and 
choose OK. Descriptions of these options follow this procedure. 

Shows number Filename 
of bytes received 

Pauses transmission and changes to Resume 
Stops transmission 

5. To pause, resume, or stop the transmission of the incoming file, choose these 
commands from the Transfers menu or from the control buttons that appear 
near the bottom of the Terminal window. 

Use this option 

Append File 

Save Controls 

To do this 

Add incoming information to the end of the specified 
file instead of overwriting it. 

In the Filename box, specify the file you want to append 
the incoming information to. 

Save some of the formatting codes in an incoming text 
file. Many applications, such as word processing or 
spreadsheet programs, allow you (or the sender) to save 
files as text. This means most of the formatting codes are 
stripped out of the file and it can be sent as a text file. 
However, the file may retain some formatting codes 
rather than be saved in pure ASCII form. If you select 
this option, those formatting codes will be received by 
your system. 



Use this option 

Table Format 

Viewing Text Files 
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To do this 

Receive the incoming text in a tabular format. Terminal 
will put tab characters between incoming text separated 
by two or more consecutive spaces. 

If you want to look at a text file before sending it or after receiving it, use the 
View Text File command. 

[> To view a text file: 

1. Choose View Text File from the Transfers menu to display the following 
dialog box: 

[00] 
[system] 
[temp] 
[oa-] 
[-co] 
[-do] 
[-to] 

Following CR: 

D Append LF 

D~tripLF 

'---___ ----L_ Or select from Files and Directories. 

2. Type the name of the file in the Filename box, or select a filename and 
directory. 

3. To attach a line feed to the end of each line of the text you send, select Append 
LF. To strip out linefeeds in the text you send, select Strip LF. 

If you already specified linefeeds when you received a file, you might want to 
ignore these options. For an explanation of linefeeds, see the CR to CR/LF 
option under "Specifying Terminal Preferences" earlier in this chapter. 
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4. Choose OK to view the specified file. 

You will see the file scroll in the Terminal window. The bottom of the window 
displays buttons the same as when you send a text file. 

S. Use the Pause, Resume, and Stop buttons to control the display of the file. 

The document bar tells you how much more of the document is yet to be 
displayed. 

Sending Binary Files 

You can use the Send Binary File command on the Transfers menu to send a file 
in binary format. The file is sent according to the protocol specified with the 
Binary Transfers ,command on the Settings menu. 

[:> To send a binary file: 

1. First, tell the host to prepare to receive a binary file, and indicate the type of 
protocol to use (XModem/CRC or Kermit). 

2. Choose the Send Binary File command from the Transfers menu to display the 
following dialog box: 

( .. ] 
(system] 
(Iemp] 
(-a-] 
(-c-] 
(-d-] 
(+] 

'--___ --'--_ Or select from Files and Directories. 

3. Type the name of the binary file you want to send in the Filename box, or 
select a directory and filename from the Directories and Files boxes. 
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4. Choose OK. 

The file transfer begins, and the bottom of the window displays the name of 
the file being sent and a Stop button. 

~mentbar 
Stops transmission 

Filename 

5. To terminate the file transfer, choose Stop. You cannot pause or resume a 
binary file transfer. Consequently, these buttons and commands are 
unavailable. 

Receiving Binary Files 

The Receive Binary File command on the Transfers menu prepares Terminal to 
receive a file in binary file format, according to the protocol specified with the 
Binary Transfers command on the Settings menu. 

t> To receive a binary file: 

1. First, tell the host to send a binary file, and indicate the type of protocol to use 
(XModem/CRC or Kermit). 

2. Choose the Receive Binary File command from the Transfers menu. 

, 

3. Type the name you want to give the incoming file, including the directory path, 
in the Filename box. 

If you select an existing file from the Files box, Terminal asks for verification 
that you want to overwrite the existing file. 

Occasionally, a communications error prevents the successful transfer of data. 
When this occurs, the remote system will try again. When the maximum num
ber of retries has been reached, Terminal cancels the file transfer. The Retries 
box at the bottom of the Terminal window displays the number of times the 
remote system has tried to send the data. The maximum number of retries for 
the XModem/CRC protocol is 20. The maximum number of retries for the 
Kermit protocol is 5. 
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4. Choose OK. 

Terminal displays the name of the binary file being received, the amount of the 
file already received, and a Stop button. 

Stops Shows number 
transmission of bytes received 

5. To terminate the file transfer, choose Stop. 

You cannot pause or resume a binary file transfer. Consequently, those buttons 
and commands are unavailable. 

NOTE If Terminal is running as an icon during a binary send or receive, the icon will flash 
when the transfer is either completed or fails. Restore Terminal to a window to continue 
your communications session. 

Working with Text in the Terminal Window 
By using commands on the Edit menu, you can modify the contents of the 
Terminal window. You can also send, save, append, or print the current selection, 
or clear the Terminal window. Descriptions of the tasks performed with the Edit 
menu follow. 

Copying Text onto the Clipboard 

[> To copy text onto the Clipboard: 

1. Select the text you want to copy. 

2. Choose Copy from the Edit menu. 

Once a selection is copied, you can then insert it in another position or file 
using the Paste command. 
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Sending the Clipboard Contents 

When you paste text from the Clipboard, Terminal sends a copy of the Clipboard 
contents to the remote system. The contents of the Clipboard remain unchanged. 

r> To send the contents of the Clipboard to a remote system: 

o Choose Paste from the Edit menu. 

The Paste command sends the current contents of the Windows Clipboard. 

Sending Selected Text 

Sending text with the Send command is equivalent to choosing the Copy and Paste 
commands. 

r> To send text to a remote system with the Send command: 

1. Select the text you want to send. 

2. Choose Send from the Edit menu. 

Terminal sends the selected text to the remote system. 

Selecting All Text 

Using the Select All command has the same result as selecting the entire contents 
of the Terminal buffer with the mouse or keyboard. After selecting the text, you 
can copy or send it. 

r> To select all the text in the Terminal window and scroll buffer: 

o Choose Select All from the Edit menu. 
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Clearing the Buffer 

In some communications applications, text you type beyond a full screen is lost. 
Terminal, however, displays scroll bars on the window when you type more than a 
screen of information and puts text that does not appear on the screen into a buffer. 
This way, you can scroll forward and backward to see text you already typed or 
received. You might want to clear the buffer to free up memory. 

t> To clear the contents of the scroll buffer and the window: 

Printing 

o Choose Clear Buffer from the Edit menu. 

Terminal removes the contents of the Terminal window and any text in the 
buffer. 

You can print text (either incoming files or a communications session) in two 
ways: you can save scroll buffer information in a file and print it from another ap
plication such as Write, or you can tum on Printer Echo to have incoming text go 
directly to a printer as well as to your screen. (To direct your keystrokes to the 
printer, you must also tum on Local Echo.) 

Setting Up the Printer 

If you have connected and installed a printer, you can print text easily. Chapter 5, 
"Control Panel," describes how to install a printer. Terminal automatically prints 
to the designated default printer. If you have several printers connected to your 
computer and designated as active printers, you can print to one of these printers 
by selecting it as the default printer. To do so, use the Printer Setup command on 
the File menu. For more information about active and default printers, see Chapter 
5, "Control Panel." 
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Printing Incoming Text 

The Printer Echo command on the Settings menu causes Terminal to tum printing 
mode on and off. When Printer Echo is on, all information received by Terminal is 
echoed to the printer. If you plan to print incoming text during this communica
tions session, choose this command before you receive information. If Local Echo 
is turned on, your keystrokes will also go to the printer. See "Specifying Terminal 
Preferences," earlier in this chapter, for information on the Local Echo option. 

[> To print incoming text and keystrokes: 

1. Choose Printer Echo from the Settings menu. 

When Terminal is in print mode, Printer Echo is preceded by a checkmark. All 
incoming text is sent directly to the printer. 

2. If the incoming text is less than a page long and you want to eject the partial 
page from the printer, choose Printer Echo again to tum print mode off. 

Printing Selected Text 

The best time to print selected text in the Terminal window or scroll buffer is 
when you are ready to end the communications session. 

[> To print text you already received or entered: 

1. Select the text you want to print. 

If you want to select the entire contents of the scroll buffer, choose Select All 
from the Edit menu. 

2. Choose Copy from the Edit menu to place the selected text on the Clipboard. 

3. End the Terminal session by choosing Exit from the File menu. 

4. Start a word processing or editor program-preferably a Windows-based 
application such as Write. 

5. Paste the contents of the Clipboard into a text file. 

6. Use the Print command in the word processing program to print your selection. 
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Ending Your Communications Session 
To end a communications session, you save the settings file (if you want to use 
these settings again), disconnect from the remote computer, and exit Terminal. 
Descriptions of these steps follow. 

Saving Settings Files 

You can save Terminal's settings so that you can load them for the next com
munications session. 

[> To save the settings file: 

o Choose Save from the File menu. 

If you have not saved the settings before, a dialog box asks you for a filename. 
Terminal automatically assigns the extension .TRM to the file. You can choose 
Save As to save the settings under a new filename or to overwrite an existing 
file. 

Disconnecting from the Remote Computer 

Disconnecting from the remote computer is an important step in ending your 
Terminal session. 

[> To disconnect from the remote computer: 

1. Type the exit command specified by the remote system-typically, bye. 

This command hangs up the remote modem. 

2. Choose Hangup from the Phone menu to hang up your modem. 

CAUTION It is important to signal the remote computer with an exit command before 
choosing Hangup. If you choose Hangup first, you will be disconnected from the remote 
computer, but its phone connection will remain off the hook. Your account might continue 
to be charged for connect time until the remote system detects that the connection has been 
dropped. 
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Exiting Terminal 

You can end a communications session by exiting Terminal and returning to the 
Program Manager window. 

[> To exit Terminal: 

1. Choose Exit from the File menu. 

2. If you made changes to the current settings file without saving, Terminal will 
ask if you want to save the changes, abandon the changes, or cancel your 
request to exit Terminal. 

3. Choose OK. 

If Things Go Wrong 
If you have trouble connecting to the remote computer, a number of factors could 
be causing your problems. The following recommendations cover the most 
common trouble areas. 

If the Modem Does Not Dial the Number 

You might have a hardware connection problem or the baud rate set improperly. 
Use this checklist to see if you can find the problem: 

• Are the correct cables attached to the modem and phone jack, or between the 
two computers? 

• Was the proper COM port specified when you chose the Communications com
mand from the Settings menu? See the Connector option under "Specifying 
Communications Settings" earlier in this chapter. 

If the Operator Interrupts Your Call 

If the modem dials the number but you get a message from the operator, your 
modem might be misdialing. Use this checklist: 

Is the number correctly entered in the Phone Number option? Choose Phone 
Number from the Settings menu to check. 
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• Does your modem run at a slower baud rate? 

You might have to reduce the baud rate so that your modem can interact with 
the communications port. 

If these steps do not work, you might need to have your modem serviced. 

If the Modem Is Dialing but You Cannot Get Through 

You might not have the correct settings for the remote computer. Communicating 
systems must use the same baud rate, although some modems can automatically 
drop back to the rate of the remote modem and signal Terminal of the change. 
(Check your hardware manual for this feature.) If you want to transfer data, both 
systems must also use the same settings for the following options: 

• Data bits 

• Parity type (none, odd, even, mark, and space) 

• Stop bits 

• Flow control 

If you do not know what settings the remote system is using, refer to its documen
tation on calling the remote system's information number (not the data transmis
sion number). Request the information and then set Terminal accordingly using 
the Communications command on the Settings menu. 

If You Cannot Send or Receive a Text File 

Communicating systems must use the same handshaking, or flow control, method. 

• What software handshaking method, if any, does the remote system use? 

The standard method is XonlXoff. However, another method may be used. See 
"Specifying Communications Settings" earlier in this chapter for more 
information. 

• Does the remote system use hardware handshaking? 

If so, you must select Hardware from the dialog box that appears when you 
choose the Communications command from the Settings menu. For more infor
mation, see "Specifying Communications Settings" earlier in this chapter. 
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If You Cannot Send or Receive Using the Binary Method 

Communicating systems must use the same transfer protocol. You might have 
specified a protocol that the remote system does not use. 

To change the protocol, choose the Binary Transfers command in the Settings 
menu. For more information, see "Setting Up File Transfers" earlier in this chapter. 

If Your Incoming Files or Keyboard Entries Are Not Printing 

Make sure the printer is properly connected and turned on and that the printer has 
paper. See Chapter 6, "Print Manager," for hints on troubleshooting printing prob
lems. If the printer is ready, use this checklist: 

• Did you indicate the correct settings using the Printer Setup command on the 
File menu? 

• Did you choose Printer Echo before receiving the file? 

• Is the Local Echo option in the TermiQal Preferences dialog box selected? 

Local Echo allows your keyboard entries to print. 
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Calculator 
The Windows Calculator includes a standard calculator as well as a scientific cal
culator. The standard calculator allows you to do simple calculations and store 
them in memory. The scientific calculator allows you to do advanced scientific 
and statistical calculations. 

Both calculators work the same way, so you might want to skim "Using the 
Standard Calculator," even if you plan to use only the scientific calculator. 

Using the Standard Calculator 

C> To start Calculator: 

1. Open the Accessories window. 

2. Double-click the Calculator icon. 

Or select Calculator and choose Open from the File menu. 

If you are starting Calculator for the first time, the standard calculator appears. 

These buttons let you edit the 
numbers in the display. 

-i\H--- This is where Calculator 

These buttons allow you to 
use Calculator's memory. 

displays numbers. 

These are the basic 
mathematical operators. 
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The next time you start Calculator, the last calculator-standard or scientific-that 
you used appears. 

You cannot resize the Calculator window. However, you can reduce Calculator to 
an icon so that it is readily available when you want to perfonn calculations. 

Performing Calculations 
Calculator is easiest to use with the mouse-just point to a Calculator button and 
click the mouse button. If you don't have a mouse, each Calculator button has a 
corresponding key (or combination of keys) on the keyboard. You can find the 
keyboard equivalent for each Calculator function in "Standard Calculator 
Functions" or "Advanced Calculator Functions" later in this chapter. For simple 
calculations, you can use the numbers and basic operators (+, -, *; /, =) on your 
keyboard or numeric keypad. (You must press NUM LOCK before you can use the 
numeric keypad.) 

[> To perform a simple calculation using Calculator: 

1. Enter the first number in the calculation. 

The number appears in Calculator's display. 

2. Choose the operator you want to use in the calculation. 

If you're not sure which operator to use, see "Standard Calculator Functions" 
later in this chapter. 

3. Enter the next number in the calculation. 

If you make a mistake, choose BACK (or press BACKSPACE) to correct a few 
digits or choose CE (or press FlO) to clear the entire number. 

4. Enter any remaining numbers and operators. 

5. Choose the equal sign (=). 

Or press EQUALS ( = ) or ENTER if you are using the keyboard. 

Calculator enters the result in the display. 

If you make a mistake and want to restart a calculation, choose C (or press ESC) to 
clear the entire calculation from Calculator. 
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Using Calculator's Memory 

Calculator has its own memory, where you can store a value for future use. The 
following illustration shows the buttons that work with Calculator's memory: 

Displays the value stored in memory. 
Clears any value stored in memory. 

An M appears here 
when a value is 
stored in memory. 

Adds the current value to any value already in memory. 
Stores the currently displayed value in memory. 

When you store a value in memory, an M appears in the box below Calculator's 
display. 

If you store a zero in memory or if a value that you add to memory causes the 
value there to equal zero, M disappears from the box below Calculator's display 
line. If you store another value in memory with the MS button, that value replaces 
any value currently in memory. 

If you don't have a mouse, see "Standard Calculator Functions" later in this 
chapter to find out how to use the memory functions with the keyboard. 

Using Calculator with the Clipboard 

Using the Clipboard, Calculator can supply calculated results to other applications 
and perform calculations on values supplied by other applications. You can use 
Calculator with any application with which you can use the Clipboard. 



360 Calculator 

[> To copy the value in Calculator's display to the Clipboard: 

D Choose Copy from the Edit menu. 

You can now paste the value into any application with which you can use the 
Clipboard. 

[> To paste a number from the Clipboard to Calculator's display: 

o Choose Paste from the Edit menu. 

Calculator interprets most characters on the Clipboard as if they were entered on 
the keyboard. When you paste from the Clipboard, however, Calculator interprets 
some characters as key sequences or function keys. The following describes the 
meaning of these characters: 

Character 

c 

e 

m 

p 

q 

r 

Meaning in Pasted Text 

Clears any value stored in memory. Equivalent to CTRL + C. 

If in Decimal mode, allows entry of numbers in scientific 
notation. This character can optionally be followed by a plus 
( +) or minus (-) to indicate the sign of the exponent. If no sign 
is present, then + is assumed. 

If in Hexadecimal mode, specifies the number "E". 

Stores the currently displayed value in memory. Equivalent to 
CTRL+M. 

Adds the value that is currently displayed to any value in 
memory. Equivalent to CTRL + P. 

Clears the current calculation. Equivalent to the ESC key and 
the C button. 

Displays the value stored in memory. The value also remains in 
memory. Equivalent to CTRL + R. 
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Character Meaning in Pasted Text 

\ 

If placed before a letter, causes Calculator to interpret the letter 
as part of a control key sequence. For example, :A is equivalent 
to CTRL+A. 

If placed before a number, causes Calculator to interpret the 
number as a function key. For example, :4 is equivalent to F4. 

Same as the Data key, which is normally assigned to the Insert 
key. 

Standard Calculator Functions 
The following table describes each key on the standard calculator, its keyboard 
equivalent, and its function: 

Button 

+ 

* 

sqrt 

% 

l/x 

+/-

BACK 

CE 

C 

Keystroke 

+ 

* 
/ 

@ 

% 

r 

= or ENTER 

F9 

. or, 

BACKSPACE 

LEFT ARROW 

DELETE 

ESC 

Function 

Adds. 

Subtracts. 

Multiplies. 

Divides. 

Calculates the square root of the currently displayed value. 

Calculates percentages. For example, if you enter 400*75%, 
Calculator calculates 75% of 400, which is 300. 

Calculates the reciprocal of the currently displayed number. 

Performs any operation between previous two numbers. 
Choose again to repeat the last operation. (For example, 
4 + 2 = 6. Pressing = again calculates 8; again calculates 10; 
and so on.) 

Changes the sign of the currently displayed number. 

Inserts a decimal point in the currently displayed number. The 
decimal point is the standard setting for a decimal separator. 
You can change the decimal separator setting to enter an inter
national symbol by using Control Panel. 

Deletes the rightmost digit of the currently displayed number. 

Clears the currently displayed number. 

Clears the current calculation. 
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Button Keystroke Function 

MC CfRL+ C Clears any value stored in memory. 

MR CfRL+ R Displays the value stored in memory. The value also remains 
in memory. 

MS CfRL+ M Stores the currently displayed value in memory. 

M+ CfRL+ P Adds the value that is currently displayed to any value cur-
rently in memory. 

Using the Scientific Calculator 

The scientific calculator can perform simple, standard mathematical calculations 
or scientific and statistical calculations. This calculator can also calculate in the 
binary, octal, and hexadecimal number systems as well as the decimal system that 
we ordinarily use. 

l> To use the scientific calculator: 

D Choose Scientific from the View menu. 

The scientific calculator appears: 

You can select the number 
system you want to use. Values appear here. 
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You perfonn a simple calculation on the scientific calculator the same way you 
perfonn a simple calculation on the standard calculator. The instructions appear in 
"Perfonning Calculations" earlier in this chapter. The following topics provide 
infonnation that applies only to the scientific calculator. 

Working with Different Number Systems 

When you start the scientific calculator, it is set to work in the decimal number 
system-the base 10 system that we are accustomed to. This calculator can also 
work in the binary, octal, and hexadecimal number systems. 

When you enter values into the scientific calculator, it accepts only values that are 
valid for the number system you have selected to work in. For example, if you are 
working in the hexadecimal number system, B is a valid entry, but if you are 
working in the decimal number system, B is not. 

Converting a Value to Another Number System 
The scientific calculator can convert most values that you are currently working 
with to any of the other available number systems. The following is a list of the 
valid ranges for converting numbers: 

Number System Range 

Hexadecimal _231_1 to 231_1 

Decimal -9.999999999999ge-307 to 9.999999999999ge+307 

Octal _231_1 to 231_1 

Binary _231_1 to 231_1 

r:> To convert a value to another number system: 

1. Enter the value you want to convert. 

2. Select the button for the number system you want to convert to-Hex, Dec, 
Oct, or Bin. 

3. Select the unit of measurement you want Calculator to use to display the result. 

When converting to hexadecimal, octal, or binary numbers, you can select 
Dword, Word, or Byte. See "Advanced Calculator Functions" later in this 
chapter for more infonnation about these settings. 

The value resulting from the conversion appears in the display. 
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If you convert a decimal number containing decimal places to another number sys
tem, Calculator shortens the number to its integer. Numbers converted from the 
hexadecimal, octal, or binary number systems to the decimal system also appear as 
integers. 

Copying and Pasting in Different Number Systems 
When you use the Copy command on the Edit menu to copy a value from 
Calculator to the Clipboard, the Clipboard regards the value as a piece of text. It 
does not distinguish between text and numbers. You can use Copy to transfer a 
number in any number system from the scientific calculator into another Windows 
application or accessory. 

You can also paste a value in any number system into the scientific calculator 
from the Clipboard, provided that the number being pasted is in the number 
system that is currently active. 

Using Calculator's Statistical Functions 
In addition to doing simple and programming calculations, the scientific calculator 
does statistical calculations such as averages and standard deviations. 

Use these buttons to perform statistical calculations. 
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t> To perform a statistical calculation: 

1. Choose Sta. 

The Statistics Box appears. 

These buttons assist you 
in handling data for 
statistical calculations. 

Indicates the number of 
values currently entered. 

The values you enter 
appear here. 

2. Move the Statistics Box to a position where you can easily work with the num
bers and statistical functions you want to use. 

3. Enter the first value. 

If you are clicking calculator buttons with a mouse, the focus immediately 
returns to the Calculator, and the value appears in the display area. If you are 
using the keyboard, choose the RET button in the Statistics Box, and then enter 
your value. 

4. Choose Dat to enter the value in the Statistics Box. 

5. Enter any other numbers you want to use, choosing Dat each time to place the 
number in the Statistics Box. 

You can enter as many numbers as your computer's memory allows. 
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6. Choose the button for the statistical function you want to use in your 
calculation-Ave (average), Sum (total), or s (standard deviation). See the 
following section, "Advanced Calculator Functions," for more information 
about these functions. 

The result of the calculation appears in Calculator's display. 

7. When you complete your statistical calculations, choose Close from the 
Control menu to remove the Statistics Box. 

You can use the Statistics Box buttons in the following ways: 

Use this button 

RET 

LOAD 

CD 

CAD 

To do this 

Switch to the main calculator and retain the Statistics Box 
entries. (To return to the Statistics Box, choose Sta.) 

Change the number in Calculator's display to the currently 
selected number in the Statistics Box. 

Delete the currently selected number from the Statistics 
Box. 

Delete all numbers from the Statistics Box. 

Advanced Calculator Functions 
The following tables describe each button specific to the scientific calculator and 
its functions. They do not describe buttons that also appear on the standard 
calculator. See "Standard Calculator Functions" earlier in this chapter for 
descriptions of those buttons. The tables also provide the keyboard equivalent 
for each function. 



Operators 

Button 

And 

Int 

Lsh 

Mod 

Not 

Or 

Xor 

Keystroke 

& 

< 

% 
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Function 

Starts a new level of parentheses. The current number of levels 
appears below the display. The maximum number is 25. 

Closes the current level of parentheses. 

Calculates bitwise AND. 

Displays the integer portion of a decimal value. Inv + Int 
displays the fractional portion of a decimal value. For 
example, if the current value is 47.5, Int displays 47 and 
Inv + Int displays .5. 

Performs left shift. Inv + Lsh performs right shift. This 
operation is binary. 

Displays the modulus, or remainder, of x/yo For example, 10 
Mod 3 displays 1. 

Calculates bitwise inverse. 

Calculates bitwise OR. 

Calculates bitwise exclusive OR. 

Number Base Functions 

Button Keystroke Function 

Dword F2 Displays the full 32-bit representation of the current number. 

Word F3 Displays the lower 16 bits of the current number, but does not 
change the value. 

Byte F4 Displays the lower 8 bits of the current number, but does not 
change the value. 

Hex F5 Sets Calculator to work in the hexadecimal number system. 

Dec F6 Sets Calculator to work in the decimal number system. This is 
the standard setting. Uses Deg, Rad, or Grad in trigonometric 
functions. Dword, Word, and Byte do not apply here. 

Oct F7 Sets Calculator to work in the octal number system. 

Bin F8 Sets Calculator to work in the binary number system. 
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Statistical Functions 

Button Keystroke 

Ave CfRL+A 

Oat INSERT 

CfRL+ D 

Sta CfRL + S 

Sum CfRL +T 

Other Functions 

Button Keystroke 

cos o 

Deg F2 

dms m 

Exp x 

F-E v 

Function 

Calculates the mean of the values currently in the Statistics 
Box. Inv + Ave calculates the mean of the squares. 

Enters the currently displayed number in the Statistics Box. 

Calculates standard deviation with the population parameter as 
n-l. Inv + s calculates standard deviation with the population 
parameter as n. 

Activates the Statistics Box and the Ave, Sum, s, and Oat 
buttons. 

Calculates the sum (total) of values in the Statistics Box. 
Inv + Sum calculates the sum of squares. 

Function 

Calculates the cosine of the currently displayed number. 
Inv + cos calculates the arc cosine. Hyp + cos calculates the 
hyperbolic cosine. Inv + hyp + cos calculates the arc hyper
bolic cosine. 

Sets trigonometric input for degrees. This function is available 
in decimal only. (For example, to calculate the cosine of 35 
degrees, change to Deg, enter 35, and choose cos.) 

Converts the currently displayed number to degree-minute
second format (assuming the currently displayed number is in 
degrees). Inv + dms converts the currently displayed number 
to degrees (assuming the currently displayed number is in 
degree-minute-second format). 

Allows entry of scientific notation numbers. (For example, to 
enter the calculation 1.24e + 102, enter 1.24, choose Exp, and 
enter 102.) The exponent has an upper limit of +307. You can 
continue to enter numbers as long as you do not use keys other 
than 0-9. Exp can be used only with the decimal number 
system. 

Switches between scientific notation and normal notation. (For 
example, if the currently displayed number is 1234000.2, F-E 
returns to 1.2340002e+6. Pressing F-E again calculates 
1234000.2.) Calculator always displays numbers larger than 
101\15 exponentially. You can use F-E only with the decimal 
number system. 
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Button Keystroke Function 

Grad F4 Sets trigonometric input for gradients when in decimal mode. 

Hyp h Sets the hyperbolic function for sin, cos, and tan. The different 
functions automatically tum off the hyperbolic function after a 
calculation is completed. (See the individual functions for 
more information.) 

Inv Sets the inverse function for sin, cos, tan, PI, xl\y, x1\2, x1\3, In, 
log, Ave, Sum, and s. The different functions automatically 
tum off the inverse function after a calculation is completed. 
(See the individual functions for more information.) 

In n Calculates natural (base e) logarithm. Inv + In calculates e 
raised to the xth power, where x is the current number. 

log Calculates common (base 10) logarithm. Inv + log calculates 
10 raised to the xth power. 

n! Calculates factorial of the currently displayed number. 

PI p Displays 1t. Inv + PI displays 6.28 (or 2 * PI). 

Rad F3 Sets trigonometric input for radians when in decimal mode. 
(For example, to calculate the cosine of PII2 radians: turn 01} 

Rad. Then choose PI, enter / and 2, and choose cos. Calculator 
displays 0.41614683654714.) Input can be from 0-2*PI. 

sin s Calculates the sine of the currently displayed number. 
Inv + sin calculates the arc sine. Hyp + sin calculates the hyper-
bolic sine. Inv + hyp + sin calculates the arc hyperbolic sine. 

tan Calculates the tangent of the currently displayed number. 
Inv + tan calculates the arc tangent. Hyp + tan calculates the 
hyperbolic tangent. Inv + hyp + tan calculates the arc hyper-
bolic tangent. 

xl\y y Computes x raised to the yth power. (For example, to calculate 
3.1231\8.82, enter 3.123, choose xl\y, enter 8.82, and choose =. 
Calculator displays 23021.03795695.) Inv + xl\y calculates the 
yth root of x. 

xl\2 @ Squares the currently displayed number. Inv + xl\2 calculates 
the square root. 

xl\3 # Cubes the currently displayed number. Inv + xl\3 calculates the 
cube root. 
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Calendar 
Windows Calendar combines a month-at-a-glance calendar and a daily appoint
ment book. 

t> To start Calendar: 

1. Open the Accessories window. 

2. Double-click the Calendar icon. 

Or select Calendar and choose Open from the File menu. 

An untitled Calendar window appears, displaying one-hour time intervals for 
the current date. The first hour that appears at the top of the window is 7 :00 
a.m. 

Status line 

r r Scroll arrows 

File I Edit Vie~ Show Alarm Options Help 

I 
8:59 AM 1+ +1 Thursday. August 3. 1989 

7:00 AM 
8:00 
9:00 

10:00 
11 :00 
12:00 PM 
1:00 
2:00 
3:00 
4:00 
5:00 
6:00 
7:00 $ 

+ 

Insertion point '- Appointment area 
Scratch pad 
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Calendar displays in the status line the system time and date. If the time or date is 
wrong, you can reset it using Control Panel. For more information, see Chapter 5, 
"Control Panel." 

Calendar's Different Views of Time 
Calendar gives you two views of the calendar. When you start Calendar, you see 
one full day (the Day view). You can change to the Month view to see the whole 
month at one time. 

File gdit ~iew ~how ~Iarm Qptions !:!.elp 

9:09 AM J+ +1 Thursday. March 15. 1990 
March 1990 

S M T W T F S 

1 2 3 

4 5 6 7 8 9 10 

11 12 13 14 • 16 17 

18 19 20 21 22 23 24 

25 26 27 28 29 30 31 

Calendar's Month View 

[> To switch between the Day view and the Month view: 

C1 Choose Month or Day from the View menu. 

HINT If you have a mouse, you can quickly switch between the Day view and the Month 
view by double-clicking the date in the status line. You can also change back to the Day view 
by double-clicking a specific date in the Month view (or by using the DIRECTION keys to move 
to the date and pressing ENTER). 
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Entering Appointments 

Entering an appointment involves moving the insertion point to a time in the Day 
view and typing text that describes the appointment scheduled for that time. You 
can also set an alarm, if desired, and type notes and reminders in the scratch pad. 

The Day view contains a list of times that are initially set at one-hour intervals, 
beginning with 12 a.m. The insertion point initially appears at 7 a.m. (the starting 
time). 

[> To enter an appointment: 

1. Move the insertion point to the time where you want to enter an appointment. 

If the time is not visible, use the scroll bar or DIRECTION keys to move the time 
onto the screen. 

2. Type the text. 

You can type approximately 80 characters of text describing an appointment. 
The appointment line scrolls horizontally if you continue typing past the end of 
the line initially shown in Calendar. 

If you are using the keyboard, you can use the keys described in the following list 
to move the insertion point: 

Press this 

ENTER 

UPARROW 

DOWN ARROW 

PAGE UP 

PAGE DOWN 

CTRL+HOME 

CTRL+END 

To move to 

The next time 

The time above 

The time below 

The previous screen 

The next screen 

The starting time (set for 7 a.m. the first time you start 
Calendar) 

Twelve hours after the starting time 

If you want to schedule an appointment for a time not currently displayed, you 
need to add a special time. For more information, see "Customizing Your 
Calendar" later in this chapter. 
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Editing an Appointment 
You can edit the text that describes an appointment in much the same way that you 
edit text in other Windows applications. For more information, see Chapter 2, 
"Basic Skills." When you select Calendar text for editing, however, you can select 
only one appointment line at a time. 

Adding a Note or Reminder 
The daily appointment window has a scratch pad at the bottom in which you can 
type notes and reminders. 

t> To write notes on the scratch pad: 

1. Move the insertion point to the scratch pad. 

Press TAB to move to and from the scratch pad if you are using the keyboard. 

The insertion point moves to the upper-left comer of the scratch pad. 

2. Type your notes and reminders. 

You can type up to three lines of text in the scratch pad. When your text 
reaches the right border of the scratch pad, Calendar automatically wraps the 
text to the next line. 

Displaying a Different Appointment Day 

You can move to different appointment days by using commands on the Show 
menu. You can also use this menu to return quickly to the current day's 
appointments. 

t> To display the previous or next appointment day: 

o Choose Previous or Next from the Show menu. 

[> To return to the current appointment day: 

o Choose Today from the Show menu. 

The Previous, Next, and Today commands also apply to months when you are 
using the Month view. 
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HINT To move quickly to the previous day, click the Left scroll arrow in the Calendar 
status line (or press CTRL + PAGE UP). 

To move quickly to the next day, click the Right scroll arrow in the Calendar status line (or 
press CTRL + PAGE DOWN). 

[> To change the appointment day to a specific date: 

1. Choose Date from the Show menu. 

Calendar displays the Show Date dialog box. 

Show Date 

~how Date: 

2. Type the date you want Calendar to display in the Show Date box. 

3. Choose OK. 

You can type any date between January 1, 1980, and December 31, 2099. Type 
dates in either the mm/dd/yyyy or mm-dd-yyyy format. You do not need to type 
leading zeros for days or months. If you type a two-digit number for the year, 
Calendar assumes the 20th century. The following examples show some 
acceptable date formats: 

Y 00 can type this 

3/9/90 

11-17-90 

1/1/2010 

For this date 

March 9, 1990 

November 17, 1990 

January 1,2010 
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Using the Month View 

The Month view lets you see at a glance all the dates in the current month. The 
current date is highlighted and marked by brackets (for example, > 15<). 

C> To move to another date in the Month view: 

IJ Point to the date and click the mouse button. 

Or use the DIRECTION keys. 

[> To view the previous or next month: 

D Choose Previous or Next from the Show menu. 

HINT To move quickly to the previous month, click the Left scroll arrow in the Calendar 
status line (or press PAGE UP). 

To move quickly to the next month, click the Right scroll arrow in the Calendar status line 
(or press PAGE DOWN). 

C> To move quickly to an appointment day from the Month view: 

D Double-click the date in the Month view. 

Or use the DIRECTION keys to move to the date and press ENTER. 

Setting an Alarm 

Calendar has an alarm you can set to remind you of appointments. You can set the 
alarm for as many appointments as you want. 

C> To set the alarm for an appointment time: 

1. Move the insertion point to the desired time. 

2. Choose Set from the Alarm menu. 
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1:00 AM 
8:00 

A checkmark appears next 
to Set on the Alarm menu. 

.c. 9:00 Staff Meeting I 
10:00 
11:00 
12:00 PM 
1:00 
2:00 
3:00 
4:00 

-~~------------------
The alarm symbol appears 
next to the appointment time. 

When the alarm goes off, Calendar alerts you in one of the following ways: 

If Calendar is 

Active 

Inactive 

An icon 

This happens 

A dialog box reminds you of the appointment. 

The title bar at the top of the Calendar window flashes. 

The icon flashes. 

Changing the Sound Option 
In addition to visually alerting you about your appointments, the alarm also beeps 
when it goes off. If you do not want to hear the alarm, you can tum off its sound. 

[> To use a silent alarm: 

1. Choose Controls from the Alarm menu. 

The Alarm Controls dialog box appears. 



Alarm Controls 

~allyRing(0-10): [[] ~ 
t8l ~ound I Cancel I 

Clear this check box if 
you don't want sound. 

2. Clear the Sound check box. 
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Press the SPACEBAR to clear the Sound check box using the keyboard. 

3. Choose OK. 

Setting the Calendar Alarm to Go Off Early 
You can set the alarm to go off up to 10 minutes before appointment times for 
which alarms are set. 

l> To set the alarm to go off early: 

1. Choose Controls from the Alarm menu. 

The Alarm Controls dialog box appears. 

Alarm Controls 

~ally Ring (0 - 10): [!] 

t8l Sound 

Use this box to set the 
alarm to go off early. 

2. Type a number from 0 to 10 in the Early Ring box. 

3. Choose OK. 

Alarms continue to go off early until you change the Early Ring setting. 
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Turning Off the Alarm 
When an alarm goes off, it continues to flash and beep until you turn it off. How 
you turn off an alarm depends on whether Calendar is an icon, or whether the 
enlarged Calendar window is active or inactive. 

[> To turn off the alarm: 

1. If the Alarm dialog box is not already visible, open the Calendar window or 
enlarge the Calendar icon. 

Calendar displays the Alarm dialog box. 

2. Choose OK. 

Removing an Alarm 
If you change your mind about setting an alarm, you can remove the alarm before 
it goes off. 

[> To remove an alarm: 

1. Move to the time the alarm is set for. 

2. Choose Set from the Alarm menu. 

When you remove an alarm, the checkmark next to Set on the Alarm menu 
disappears. 

Customizing Your Calendar 

You can customize the Day view of your calendar so that it shows other than 
60-minute time intervals, uses a 24-hour clock rather than a 12-hour clock, or uses 
a starting time other than 7 a.m. You can also add special times in the Day view 
and mark special dates in the Month view. 
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Changing Settings in the Day View 
The day settings determine the time interval, hour format, and starting time used in 
the Day view. 

t> To change the settings in the Day view: 

1. Choose Day Settings from the Options menu. 

Calendar displays the Day Settings dialog box. 

Day Settings 

!nterval: 015 0 30 @[~:~] 

!iour Formal: @ 12 0 24 

~tarting Time: I 7:00 AM 

2. Select the options you want to use. See the following table for explanations of 
the options. 

3. Choose OK. 

You can set the following options in the Day Settings dialog box: 

Use this option 

Interval 

Hour Format 

Starting Time 

To do this 

Determine the intervals between daily appointments. You 
can select intervals of 15, 30, or 60 minutes. 

Select either a standard 12-hour clock or a 24-hour clock. 

Specify the time that appears at the top of the Calendar 
window when you first view an appointment day. 
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Adding a Special Time 
A special time is any time that falls between the intervals you set in the Day 
Settings dialog box. For example, no matter what time interval you set, 11: 10 is a 
special time. 

[> To add a special time to an appointment day: 

1. Choose Special Time from the Options menu. 

Calendar displays the Special Time dialog box. 

Special Time 

fuJecial Time: ~ @ AM 0 ~M 

~ I !)d(~tll I I Cancel I 

2. Type the time in the Special Time box. 

3. Select a.m. or p.m. if you are using a 12-hour clock. 

4. Choose Insert. 

[> To delete a special time: 

1. Move the insertion point to the time you want to delete. 

2. Choose Special Time from the Options menu. 

The Special Time dialog box appears with the selected time in the Special 
Time box. 

3. Choose Delete. 

Marking a Date 
You can call attention to special days such as paydays, holidays, birthdays, and 
anniversaries by marking the days in Calendar's Month view. Calendar supplies 
five different symbols for marking dates. By always marking a specific type of 
day, such as payday, with the same symbol, you can tell at a glance when that day 
occurs in the month. 
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File Edit View Show Alarm 0 s Help 

S M T T F S 

2 3 

6 7 8 9 10 11 12 

13 14 15 16 17 18 19 

20 21 22 23 24 25 26 

27 29 30 31 

An x designates a payday on this calendar. 
A box marks a holiday. 

[> To mark a date in the Month view: 

1. Select the date you want to mark. 

2. Choose Mark from the Options menu. 

The Day Markings dialog box appears. 

Using these marks, you can call 
attention to special dates. 

Day Markings 

Mark Symbol 

D [~i~~~(i:::::W 
D Symbol ~ - ( ) 

D Symbol;! - 0 

D Symbol ~- K 

D Symbol ~-_ 

3. Select the check box for the symbol you want to use. 
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4. Choose OK. 

Calendar marks the selected date with the symbol you chose. 

r> To cancel a mark: 

1. Select the marked date. 

2. Choose Mark from the Options menu. 

The Day Markings dialog box appears. 

3. Clear the check box for the symbol that marks the selected date and choose OK. 

Calendar removes the mark. 

Managing Calendar Files 

Windows automatically assigns the extension .CAL to Calendar files. For infor
mation about opening and saving Windows files, see Chapter 2, "Basic Skills." 
For information about working with Windows files and directories, see Chapter 4, 
"File Manager." 

Opening Read-Only Appointment Files 
If you and your co-workers would like to share your daily appointment schedules 
over a network, you can open appointment files as read-only files. That way you 
can view someone else's appointments without accidentally changing or erasing 
something. 

r> To open an appointment file as a read-only file: 

1. Choose Open from the File menu. 

2. Select or enter the name of the file you want to open. 

3. Select the Read Only check box. 

Press the SPACEBAR to select the check box using the keyboard. 

4. Choose OK. 

Removing an Appointment Day 
You can remove a single appointment day or a range of days that you don't need 
anymore from a Calendar file to make room for other appointments. 
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t> To remove appointment days: 

1. Open the file you want to remove appointments from. 

2. Choose Remove from the Edit menu. 

Calendar displays the Remove dialog box. 

Remove Appointments: 

[rom: ImIIiIil 
10: 

3. In the From box, type the first date you want to remove. 

4. In the To box, type the last date you want to remove. 

To remove one day's appointments, leave the To box blank. 

S. Choose OK. 

Printing Appointments 

If you have connected and installed a printer, you can print your appointments. 
Chapter S, "Control Panel," describes how to install a printer. Calendar auto
matically prints to the designated default printer. 

C> To print appointments: 

1. Choose Print from the File menu. 

Calendar displays the Print dialog box. 

Print 
Print Appointments: 

[rom: I~ 

10 : 1'---_-----' 

2. In the From box, type the date of the first appointment day you want to print. 
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3. In the To box, type the date of the last appointment day you want to print. 

To print a single day's appointments, leave the To box blank. 

4. Choose OK. 

If you have several printers connected to your computer and designated as active 
printers, you can print to one of these printers by selecting it as the default printer. 
To do so, use the Printer Setup command on the File menu. For more information 
about active and default printers, see Chapter 5, "Control Panel." 

Setting Margins 
Calendar automatically prints your appointments using the standard margin 
settings in the Page Setup dialog box. If you want to position your appointments 
differently on the page, you can adjust the margins before you choose Print. 

[> To set the margins for printing appointments: 

1. Choose Page Setup from the File menu. 

The Page Setup dialog box appears. 

Page Setup 

!!eader: 1m OK 

[ooler: IPage &p Cancel 

Margins------------, 

heft: ~ Right: ~ 

lop: ~ .!!.otlom: ~ 

The standard settings for margins 

2. Type over the standard settings with the margin settings you want to use. 

3. Choose OK. 

When you print, Calendar uses the new margin settings in the Page Setup 
dialog box to position your appointments on the page. 
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Printing Headers and Footers 
When you print your appointments, you can add explanatory text, the date, a page 
number, or the filename as a header or footer on the printed pages. You can also 
choose whether you want a header or footer to be left-justified, right-justified, or 
centered on the page. 

r> To print a header or footer on your appointments: 

1. Choose Page Setup from the File menu. 

The Page Setup dialog box appears. 

[ooler: 

The standard setting automatically 
prints the filename as a header. 

Cancel 

Margins---+---------, 

hell: ~ .!lighl: ~ 

lop: ~ .!!.ollom: ~ 

The standard setting automatically 
prints a page number as a footer. 

2. Type the text you want to use as a header or footer in the Header or Footer box 
along with any of the codes that Calendar allows in these boxes. See the 
following table for more information. 

3. Choose OK. 
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Cardfile 

The following table explains the codes that you can type in the Header and Footer 
boxes: 

Type this command 

&d 

&p 

&f 

&1 

&r 

&c 

&t 

To do this automatically 

Enter the current date. 

Enter page numbers. 

Enter the current filename. 

Justify the text that follows at the left margin. 

Justify the text that follows at the right margin. 

Center the text that follows in the top or bottom 
margin. This is the default. 

Enter the current time. 

You can include any or all of these codes in a single header or footer. When you 
print, any assigned headers or footers appear in their designated places on the 
printed pages. Headers always appear just above the top margin and footers appear 
just below the bottom margin. 

Windows Cardfile is like a set of index cards that sorts itself. You can use it to 
keep track of names, addresses, phone numbers, directions, or anything else you 
want quick access to. 

[> To start Cardfile: 

1. Open the Accessories window. 

2. Double-click the Cardfile icon. 

Or select Cardfile and choose Open from the File menu. 

An untitled Cardfile window containing a single, blank card appears. 
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Status line 

File Edit View Card Search Help 
Card View ++ 1 Card 

'--_________ -++_ Scroll arrows 

r-----------------------------~-----~--mdexline 

Insertion point Information area 

You can change the size of the Cardfile window, but you cannot change the size of 
the cards. 

To create a card file, you fill in as many blank cards as you need. This involves en
tering text in the index line and information area of the card. 

Filling In and Adding Cards 

The index line is the bar at the top of each card. Cardfile uses the text you put in 
the index line to sort the cards. 

t> To fill in a blank card: 

1. Choose Index from the Edit menu. 

You can also double-click the index line or press F6. 

Cardfile displays the Index dialog box. 

Index 

Index Line: / 1r..;...1 _____________________ -' 

I OK Cancel 
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2. Type the text you want in the Index Line box. 

If you make a mistake while typing, press BACKSPACE to correct the text. 

3. Choose OK. 

The insertion point returns to the information area of the card. 

4. Type the text for the card. 

The text automatically wraps to the next line. For more information about 
working with text, see Chapter 2, "Basic Skills." 

[> To add a new card: 

1. Choose Add from the Card menu or press F7. 

Cardfile displays the Add dialog box. 

Add:l L-__________ ---' 

OK Cancel 

2. Type the text for the new card's index line in the Add box. 

3. Choose OK. 

Cardfile adds the new card to your file in sorted order and scrolls the file to 
display the new card at the front. 

4. Type the text you want to store in the card's information area. 

Viewing Cards as a List 

Cardfile has two viewing options-Cards view and List view. The Cards view is 
active when you start Cardfile and displays your file as a series of cards. In the 
List view, Cardfile displays the index line of every card in the file in alphabetical 
order. 

[> To display cards as a list: 

o Choose List from the View menu. 
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Moving Through Your Cards 
You can scroll through a file card by card or bring a specific card directly to the 
front of a file. Cardfile always keeps the cards in alphabetical order based on your 
entries on the index lines. 

[> To scroll through your cards: 

o Click the Right or Left scroll arrow in the status bar at the top of the Cardfile 
window. 

If you are using the keyboard, the following keys let you move among the 
cards in your Cardfile: 

Press this 

PAGE DOWN 

PAGE UP 

CTRL+HOME 

CTRL+END 

DOWN ARROW 

UPARROW 

To do this 

Scroll forward one card when you are in Cards view. 
When you are in List view, PAGE DOWN moves forward 
one page. 

Scroll backward one card when you are in Cards view. 
When you are in List view, PAGE UP moves back one 
page. 

Bring the first card in the file to the front. 

Bring the last card in the file to the front. 

Scroll one card forward when you are in List view. 

Scroll one card backward when you are in List view. 

[> To bring a specific card to the front of a file: 

1. Choose Go To from the Search menu or press F4. 

Cardfile displays the Go To dialog box. 

d·, 
Go To: L.:...-U ___ -----'I 

OK "'--Ca-nc-el---'I 
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2. Type a portion of the index line text for the card you want to bring to the front; 
type just enough text to distinguish the card from the other cards. 

3. Choose OK. 

HINT If a card's index line is visible, you can quickly bring the card to the front of the file 
by pointing to the index line and clicking the mouse button. 

If you are using the keyboard, you can quickly bring a card to the front of a file as long as 
you know the first letter of the index line text. Hold down CTRL and press the appropriate 
letter key. Cardfile scrolls to display the first card that has that letter at the beginning of its 
index line. You can now scroll card by card to find the card you want. 

Searching for Text in Cardfile 

You can find specific text on cards (not index lines) by using the Find command 
on the Search menu. You can start a search at any point in the file. Cardfile 
searches forward from the selected point and, when it reaches the end of the file, 
automatically continues searching from the beginning of the file. When searching 
for text, Cardfile ignores capitalization. 

[> To search for text: 

1. Bring to the front of the file the card from which you want to begin the search. 

2. Choose Find from the Search menu. 

The Find dialog box appears. 

Find: 

OK Cancel 

3. In the Find box, type the text you want to find. 

4. Choose OK. 

Cardfile searches for the text and selects the first occurrence. If there are no 
occurrences of the text in the file, Cardfile displays a message telling you that 
it could not find the text. 
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5. To find the next occurrence of the same text, choose Find Next on the Search 
menu. 

When you choose the Find Next command, Cardfile does not display the Find 
dialog box but immediately searches for the text. 

Editing Text on Cards 

You edit text on a card in much the same way that you edit text in other Windows 
applications. See Chapter 2, "Basic Skills," for information about basic editing. 
There are a few differences in editing a card file, however, that the following 
sections explain. 

Changing the Index Line 
When you edit a card, you edit the index line text separately from the rest of the 
card-just as you enter this text separately from the rest of the card. 

[> To edit the text in the index line: 

1. Bring to the front of the file the card you want to edit. 

2. Choose Index from the Edit menu. 

You can also double-click the index line or press F6. 

The Index dialog box appears with the current index line text selected in the 
Index Line box. 

3. If you want to replace all the text in the index line, type the new text. 

The oJd text disappears as soon as you type the first character of the new text. 

4. If you want to change only a few characters in the index line, click on any 
character (or press RIGHT ARROW) to move to the characters in error and 
correct them. 

5. Choose OK. 

Cardfile automatically places the card in its correct alphabetical order and then 
scrolls the file to display the card at the front. 
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Moving Text to Another Card 
You can use the Clipboard to move text from one card to another in Cardfile. 

t> To move text from one card to another: 

1. Select the text you want to move. 

2. Choose Cut from the Edit menu. 

3. Bring to the front of the file the card to which you want to move the text. 

4. Move the insertion point to where you want the text to appear. 

S. Choose Paste from the Edit menu. 

The text appears in the new location. 

You can paste text from the Clipboard to any part of any card except the index line. 

Copying Text to Another Card 
If you want to use the same text more than once in a file, you can copy it 
repeatedly using the Clipboard. 

[> To copy text from one card to another: 

1. Select the text you want to copy. 

2. Choose Copy from the Edit menu. 

3. Bring the card to which you want to copy the text to the front of the file. 

4. Move the insertion point to where you want the text to appear. 

S. Choose Paste from the Edit menu. 

The text appears in the new location. 

You can continue pasting the text in as many places as you want. 
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Pasting a Picture on a Card 
One of Cardfile's most useful features is the ability to transfer artwork from 
another application to a card. For example, you could create a small map using 
Paintbrush, then transfer it to a card already containing an address. 

[> To transfer a picture to a card: 

1. Copy the picture onto the Clipboard by following instructions in "Editing Your 
Drawing" in Chapter 8. 

2. Start Cardfile or open the Cardfile window. 

3. Bring the card to which you want to transfer the picture to the front of the file. 

4. Choose Picture from the Edit menu. 

S. Choose Paste from the Edit menu. 

The picture appears in the upper-left comer of the card. 

6. Drag the picture to where you want it to appear on the card. 

Or use the DIRECTION keys to move the picture. 

7. Choose Text from the Edit menu to paste the picture in its permanent location 
and go back to working with text. 

When you transfer a color picture to a card, Cardfile converts the picture to a 
black-and-white image. 

If the picture you paste is larger than the area available to paste it in, only the part 
of the picture that fits on the card appears. You can use the DIRECTION keys to 
move different parts of the picture onto the card. If you print the card, only the part 
of the picture that is visible prints. 

Restoring a Card 
If you change your mind about changes you just made to a card, you can restore 
the card to its original condition as long as it is still at the front of the file. 
However, once you move a card away from the front, the changes become per
manent, and you cannot restore the card. 

[> To restore a card: 

o Choose Restore from the Edit menu. 
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Deleting a Card 

To delete a single card from a file, use the following procedure. 

t> To delete a card: 

1. Bring to the front of the file the card you want to delete. 

2. Choose Delete from the Card menu. 

A dialog box appears, asking you to confirm the deletion. 

3. Choose OK. 

Cardfile deletes the card. 

Be sure you have the correct card before you delete it. You can replace a deleted 
card only by retyping the card. 

Duplicating a Card 

If the information for several cards is similar, you might want to type the infor
mation on one card, duplicate the card, and then edit the copies as necessary. 

t> To duplicate a card: 

1. Bring the card you want to duplicate to the front of the file. 

2. Choose Duplicate from the Card menu. 

Cardfile adds an exact copy of the card to the front of the file. 

Managing Cardfile Files 

Windows automatically assigns the extension .CRD to Cardfile files. For infor
mation about opening and saving Windows files, see Chapter 2, "Basic Skills." 
For information about working with Windows files and directories, see Chapter 4, 
"File Manager." 

The following topics provide information specific to working with files in Cardfile. 
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Determining File Size 
The number of cards you can store in a Cardfile file depends on the amount of 
memory in your computer and the amount of information on the individual cards. 
As you work on a file, Cardfile keeps track of how many cards are currently in the 
file and displays the number on the status line. The number of cards might give 
you an indication of file size, but it does not tell you the actual size of the file in 
bytes. 

Merging Files 
If you want to consolidate two sets of cards, you can do so by merging a second 
Cardfile file into the file you are currently using. 

t> To merge two Cardfile files: 

1. Open one of the files that you want to merge. 

2. Choose Merge from the File menu. 

Cardfile displays the File Merge dialog box. 

File Merge 

File~ame: =1 "'=ij;=Ul ____ ---'1 I OK 

Directory: c:lwindows I Cancel 

files: mrectories: 

business.crd I .. ) 
clienls.crd Isystem) 

I·a-) 
I-c-) 
1+) 
I-u-) 

3. Select from the Files box the file you want to merge with the current file, or 
type the name of the file in the Filename box. 

4. Choose OK. 

Cardfile merges the cards from the two files, placing them in correct alpha
beticalorder. 

You can now use the Save As command from the File menu to save the combined 
files under a new name or use the Save command to replace the current file with 
the combined files. 
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The file that you selected in step 3 to merge with the current file still exists in its 
original condition. If you want to delete the file, use the Delete command on the 
File menu in the Windows File Manager. 

Printing a Cardfile File 

If you have connected and installed a printer, you can print a single card or an 
entire file. 

t> To print a single card: 

1. Bring the card you want to print to the front of the file. 

2. Choose Print from the File menu. 

If you want to cancel printing, choose Cancel from the dialog box that appears. 

t> To print an entire file: 

D Choose Print All from the File menu. 

If you want to cancel printing, choose Cancel from the dialog box that appears. 

When printing, Cardfile automatically uses the standard margin settings in the 
Page Setup dialog box. If you want to position your cards differently on the page, 
you can use the Page Setup command on the File menu to change these settings. 
You can also use the Page Setup command to have Cardfile print headers and 
footers. For more information about using this command, see "Setting Margins" 
and "Printing Headers and Footers" under "Printing Appointments" in the 
Calendar section earlier in this chapter. 

HINT If you change the standard Cardfile margin settings, be sure to set left and right 
margins that accommodate the size of the cards. 

If you have several printers connected to your computer and designated as active 
printers, you can print to one of these printers by selecting it as the default printer. 
To do so, use the Printer Setup command on the File menu. For more information 
about active and default printers, see Chapter 5, "Control Panel." 
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Automatic Dialing 

If you have a Hayes or Hayes-compatible modem, Cardfile will automatically dial 
any phone number stored on a card. 

[> To have Cardfile dial a phone number: 

1. Bring the card containing the phone number you want to dial to the front of the 
file. 

2. Choose Autodial from the Card menu. 

The Autodial dialog box appears. 

The number on the front 
card also appears here. 

Choosing this button 
displays the Setup options. 

3. If you need to set up your modem for dialing, choose Setup and select the 
appropriate options. See the list following this procedure for an explanation of 
these options. 

4. Select the Use Prefix check box if you need to use a prefix in front of the num
ber in the Number box. 

Change the standard setting in the Prefix box if necessary. 

5. Choose OK. 

When you choose the Setup button, the Autodial dialog box expands to display the 
Setup options. 



398 Clock 

Clock 

Autodial 

!!umber: 1127-1958 

Pre!!x: ~ 

D Use Prefix 

fort-----, 

OK I 
Cancel I 

I !)tllup» I 

,!!aud Rate 

0110 04800 
@ 300 09600 
01200 019200 
02400 

The following list explains the Setup options: 

Use this option 

Dial Type 

Port 

Baud Rate 

To do this 

Select the dial type of your telephone. If you normally hear 
a tone for each number you dial, you have a tone tele
phone. If you hear a clicking sound, you probably have a 
pulse telephone. 

Select the port to which your modem is connected. 

Tell Cardfile the correct baud rate for your modem. For the 
correct setting, consult the owner's manual for your 
modem. 

To help you keep track of the time, Windows provides an accessory called Clock. 
You can display the Windows clock as an analog or digital clock. 

[> To start Clock: 

1. Open the Accessories window. 

2. Double-click the Clock icon. 

Or select Clock and choose Open from the File menu. 

If you are starting Clock for the first time, a window with a standard analog 
clock appears. The clock shows the system time. 
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Settings 
....... 

• • 
• j/ ... 

• 

• • 
• • ...•... 

The next time you start Clock, the last mode-analog or digital-that you used 
appears. 

You can change the size of the clock and move it wherever you like so that the 
current time-including seconds-appears on the screen but uses little work 
space. Clock even continues to display the time when you shrink it to an icon. 

[> To switch between the analog and digital clocks: 

o Choose Analog or Digital from the Settings menu in the Clock window. 

The type of clock you chose continues to appear when you open the Clock 
accessory until you change the setting again. 

If you need to, you can reset the time from Control Panel. See Chapter 5, "Control 
Panel," for more information. 

Notepad 
Windows Notepad is a text editor. You can use Notepad to jot down notes, write 
short memos, and create and edit batch files. 

[> To start Notepad: 

1. Open the Accessories window. 

2. Double-click the Notepad icon. 

Or select Notepad and choose Open from the File menu. 

An empty, untitled Notepad window appears. 
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Insertion point 

File Edit Search Help 
+ 

+ 

Any text that you type appears at the insertion point in the upper-left comer of the 
window. 

Working with Text 

Working with text in Notepad is much the same as working with text in any other 
Windows application. See Chapter 2, "Basic Skills," for more information. There 
are a few differences, however, that the following sections explain. 

Setting the Word Wrap Option 
Text that you type in the Notepad window can go beyond the right border of the 
window. If you don't want this to happen, you can set the Word Wrap option. This 
option automatically wraps text to the beginning of the next line when the text 
reaches the right edge of the window without affecting your text file. The text file 
retains the full line of text. 

[> To set the Word Wrap option: 

o Choose Word Wrap from the Edit menu. 

A checkmark appears next to the Word Wrap command on the menu. 
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The Word Wrap option remains in effect until you choose Word Wrap again. 
After choosing Word Wrap again, you must press ENTER to begin a new line. 

Moving Around in a Notepad File 
You can use the scroll bars as explained in Chapter 2, "Basic Skills," to move 
around your Notepad file using a mouse. If you are using the keyboard, you can 
use the DIRECTION keys, the SPACEBAR, and ENTER, which are described in 
Chapter 2, as well as the following keys: 

Press this 

HOME 

END 

CTRL+HOME 

CTRL+END 

To move to 

The beginning of a line 

The end of a line 

The beginning of the document 

The end of the document 

Selecting Text in Notepad 
In addition to the different ways of selecting text described in Chapter 2, "Basic 
Skills," you can select all the text in a given Notepad file. This feature is useful if 
you want to copy an entire Notepad file to the Clipboard and merge it with another 
file. 

l> To select all the text in a Notepad file: 

o Choose Select All from the Edit menu. 

Notepad highlights all the text in your file. If you change your mind, click any
where in the text area. 

Searching for Text in Notepad 
You can find specific text in Notepad by using the Find command on the Search 
menu. You can start a search at any point in a file and search either forward or 
backward from that point. You can also specify whether Notepad should match the 
uppercase and lowercase characters of the text. 

When searching for text, Notepad begins the search at the position of the insertion 
point and ends at the beginning or end of the file, depending on whether you 
choose Backward or Forward. 
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t> To search for text in Notepad: 

1. Position the insertion point where you want to start the search. 

2. Choose Find from the Search menu. 

The Find dialog box appears. 

Find 

EindWhat: L,;...II ________ -' 

D Match Upper/lowercase 

I @ FQ.lward o !!.ackward 

3. In the Find What box, type the text you want to find. 

4. Select the Match Upper!Lowercase box if you want to match capitalization 
exactly. 

5. Select Backward if you want to search from the insertion point to the 
beginning of the file. 

The standard setting is Forward. 

6. Choose OK. 

Notepad searches for the text and selects the first occurrence. If there are no 
occurrences of the text in the portion of the document searched, Notepad 
displays a message telling you that it could not find the text. 

7. To find the next occurrence of the same text, choose Find Next on the Search 
menu. 

When you choose the Find Next command, Notepad does not display the Find 
dialog box but immediately searches for the search text. 

Managing Notepad Files 

Windows automatically assigns the extension .TXT to Notepad files. For infor
mation about opening and saving Windows files, see Chapter 2, "Basic Skills." 
Information about working with Windows files and directories can be found in 
Chapter 4, "File Manager." The following sections provide information specific to 
working with Notepad files. 
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Determining the Size of a Notepad File 
As you work on a file, Notepad keeps track of how much disk space the file is 
using. The maximum size for a Notepad file is approximately 50,000 characters. 

[> To find out the current size of a Notepad file: 

1. Choose About Notepad from the Help menu. 

Notepad displays a dialog box that tells you the number of characters currently 
in the file. 

2. Choose OK to close the dialog box. 

Creating a Time-Log File 
You can use Notepad to create a log to keep track of how you spend your time. 

[> To create a Time-Log file: 

o Type LOG in capital letters, beginning at the left margin of the first line in a 
Notepad file. 

Every time you open this file, Notepad automatically adds the current time and 
date to the end of the file. To keep an accurate log of how you spend your day, you 
can type notes about your daily activities after each time and date. 

File Edit Search Help 

. LOG • 
1:14PM 3/08/1990 

Spent morning organizing workshops for May sales meeting. 

5:19PM 3/08/1990 

Worked with artist on design for inuitation to sales meeting. 

Superuised update of address file for sales reps. 

8:23AM 3/09/1990 

A sample Time-Log file 
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NOTE Notepad uses the system time and date. You can reset the time and date using 
Control Panel. For more information, see Chapter 5, "Control Panel." 

You can also add the current time and date to any Notepad file that you are 
working with. 

I> To add the current time and date to a Notepad file: 

[J Choose TimelDate from the Edit menu. 

The time and date appear at the location of the insertion point. 

Printing a Notepad File 

If you have connected and installed a printer, you can print your Notepad files. 
Notepad automatically prints to the designated default printer. Chapter 5, "Control 
Panel," describes how to install a printer. 

I> To print the currently displayed file: 

[J Choose Print from the File menu. 

If you want to cancel printing, choose Cancel from the dialog box that appears. 

When printing, Notepad automatically uses the standard margin settings in the 
Page Setup dialog box. If you want to position your Notepad text differently on the 
page, you can use the Page Setup command on the File menu to change these set
tings. You can also use the Page Setup command to have Notepad print headers 
and footers. For more information about using this command, see "Setting 
Margins" and "Printing Headers and Footers" under "Printing Appointments" in 
the Calendar section earlier in this chapter. 

If you have several printers connected to your computer and designated as active 
printers, you can print to one of these printers by selecting it as the default printer. 
To do so, use the Printer Setup command on the File menu. For more information 
about active and default printers, see Chapter 5, "Control Panel." 
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Recorder 
Windows Recorder allows you to record a sequence of keystrokes and mouse 
actions-called a macro-to play back at a later time. You can use macros to type 
automatically a special phrase or code that you use frequently or to automate the 
steps of any routine task. 

[> To start Recorder: 

1. Open the Accessories window. 

2. Double-click the Recorder icon. 

Or select Recorder and choose Open from the File menu. 

The Recorder window appears. 

r 
Macros that you create appear here 

=> . - , ,- -, 
File Macro Options Help 

Recording a Simple Macro 

.... 1 ... 

Recorder provides various options that you can set when recording complex 
macros. When you are recording a simple macro, however, the standard settings 
for these options should work in most cases. 
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Recording a simple macro is a straightforward, simple process. However, the 
Windows environment, which can contain multiple windows and multiple applica
tions, can be a complex one in which to record a macro. It is a good idea to read 
the sections "Using the Record Options" and "Guidelines for Creating Macros" 
later in this chapter before recording macros. 

[> To record a simple macro: 

1. In the application where you are recording the macro, position the cursor 
where you want to start recording. 

This will also be the position from which you start playing back the macro. 

2. Choose Record from the Macro menu in the Recorder window. 

The Record Macro dialog box appears. 

Fill in one or both when recording a macro. 

L...-.... __ --' 00 
rgJ Ctrl 

D Shift 
DAlt 

Record Macro 

~Iayback 

To: I S arne Application I f I 

Speed: IFast If I 

D Continuous Loop 
rgJ Enable Shortcut Keys 

Record M,.ouse: I Clicks + Drags If I Relative to: IWindow If I 

Description 

i .:.:. 

+ 

~tart 

Cancel 

3. Type a name of up to 40 characters that identifies your macro in the Record 
Macro Name box or assign the shortcut key that you want to use to play back 
the macro in the Shortcut Key box. (You can do both if you want.) 

Although you do not have to assign a shortcut key to a macro, doing so 
provides an easy way to play back the macro. You can assign a shortcut key 
by combining the CTRL, SHIFf, or ALT key with any other keyboard key. CTRL 
is the standard setting. For more information about shortcut keys, see the 
following section, "Assigning Shortcut Keys." 

4. Choose Start to begin recording your macro. 
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You probably do not need to change the settings for any of the other options 
when recording a simple macro. For more information about these options, see 
"Using the Record Options" later in this chapter. 

When you choose Start, Recorder shrinks to a flashing icon. The icon con
tinues flashing until recording stops, although the icon may not be visible if 
you move another window in front of it. 

5. Enter the keystrokes and mouse actions that you want to record. 

It is best to use few or no mouse actions when recording a macro. For more 
information, see "Deciding What to Record" and "Guidelines for Creating 
Macros" later in this chapter. 

6. When you want to stop recording, click the Recorder icon. 

Or press CTRL + BREAK to stop recording using the keyboard. 

A dialog box appears, asking if you want to save your macro, resume 
recording, or cancel recording. 

7. Choose Save Macro and then OK to save your macro and return to what you 
were doing before you started recording. 

If you want to resume recording where you left off, choose Resume Recording, 
if necessary, and then choose OK. If you want to cancel recording and throw 
away what you have recorded so far, choose Cancel Recording and then OK. 

Assigning Shortcut Keys 
It is a good idea to assign a shortcut key to a macro. Doing so provides an easy 
way of using the macro. You just have to press the shortcut key, and the macro 
starts playing back. However, if you prefer not to assign a shortcut key or if you 
run out of key combinations to use, you can type a name in the Record Macro 
N arne box in the Record Macro dialog box instead. For more information about 
names and starting a macro using its name, see the next section, "Using Macro 
Names and Descriptions," and "Playing Back a Macro" later in this chapter. 

Virtually any key on the keyboard can be used with the CTRL, SHIFf, or ALT key to 
create a shortcut key. If you want to use a function or keypad key as a shortcut key 
instead of a basic keyboard key, select the name for the key from the list in the 
Shortcut Key box. 

t> To create a shortcut key using a regular keyboard key: 

1. Type the keyboard key that you want to use in the Shortcut Key box. 

2. Select the check box for CTRL, SHIFf, or ALT. 

CTRL is the standard setting. 
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t> To assign a shortcut key using a function or keypad key: 

1. Click the Down arrow in the Shortcut Key box. 

The Shortcut Key box drops down to display a list of function and keypad key 
names. 

Names of function and keypad 
keys available for shortcut keys 

Record Macro 

Record Macro Name: 

flayback 

To: Is ame Applicalion I f I .. 
Caps Lock 
Delele 
Down 
End 
Enler 

Speed: I Fasl If I 

D Conlinuous Loop 
!8l Enable Shoricul Keys 

Record M,.ouse: '----__ ""'--'--' IWindow If I 

Descriplion 

2. Select the name you want to use from the list. 

~Iarl 

Cancel 

The selected name appears in the Shortcut Key box at the top of the list. 

You can also use combinations of CTRL, SHIff, and ALT as shortcut keys. 

CAUTION Although Recorder does not prevent you from using ALT as a shortcut key, it is 
best to use it sparingly. Shortcut keys using ALT could easily conflict with Windows shortcut 
keys. 

Using Macro Names and Descriptions 
You can store many macros in the same Recorder file. To help you remember the 
purpose of a macro, you can enter a descriptive name for the macro in the Record 
Macro Name box in the Record Macro dialog box. The name then appears with 
the shortcut key on the list of macros in the main Recorder window. If you do not 
want to assign a shortcut key to a macro, you must enter a name in the Record 
Macro Name box. 
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A name can contain up to 40 characters. If you want to enter a longer description 
for your macro, you can use the Description box in the Record Macro dialog box. 
This box allows you to enter an unlimited amount of text describing the macro. 

Playing Back a Macro 

Once you record a macro, you can use it to speed up your work. You must be sure, 
however, to start the macro when and where it can work properly. For example, 
suppose you want to play back a macro that automatically enters and sets an alarm 
for a standing Wednesday-afternoon appointment. Such a macro would not be 
appropriate to use in any application except Calendar. 

[> To play back a macro using the shortcut key: 

1. Open the Recorder window and select the macro you want to play back. 

2. Position the cursor in the application's window where you want to start playing 
back the macro. 

3. Press the shortcut key assigned to the macro. 

If you have not assigned a shortcut key to a macro, you must use the Run com
mand on the Macro menu to play back the macro. You can also use this command 
to play back a macro if you don't remember the shortcut key for the macro. 

[> To play back a macro using the Run command: 

1. Position the cursor in the application's window wher;e you want to start playing 
back the macro. 

2. Open the Recorder window. 

3. Select the macro you want to play back from the Recorder window. 

4. Choose Run from the Macro menu. 

[> To stop a macro while it is playing back: 

o Press CTRL + BREAK. 

A dialog box appears, confirming the cancellation. 
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Maintaining the Recorder Window at Playback 
When you start playing back a macro using the Run command, the Recorder win
dow shrinks to an icon. If you want, you can maintain the Recorder window in its 
position on the screen while the macro plays. 

[> To maintain the Recorder window when you use the Run command: 

D Choose Minimize on Use from the Options menu. 

The checkmark is removed from the menu command. 

Choose Minimize on Use again to shrink the Recorder window to an icon during 
playback. 

Using the Record Options 

When you choose Record from the Macro menu, the Record Macro dialog box 
appears. 

Record Macro 

Record Macro Name: 

,Shortcut ~ey- ~Iayback 

'--__ --'I [!] 
[gJ Chi 

o Shift 
DAlt 

To: I S arne Application I f I 

Speed: I Fast If\ 

o Continuous Loop 
[gJ Enable Shortcut Keys 

Record M.ouse: IClicks + Drags If I Relative to: IWindow If I 

i ..... 
+ 

Standard settings appear next to the option names. 

,[tart 

Cancel 

In addition to providing the boxes where you assign a shortcut key or a descriptive 
name to a macro, the Record Macro dialog box provides a number of options that 
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you can use when recording a macro. These options allow you to decide such 
things as whether a macro can: 

• Record mouse movements relative to only a window or the whole screen. 

• Record some or all mouse movements as well as keystrokes or record only 
keystrokes. 

• Play back only in the application where you record the macro or play back 
anywhere. 

• Play back quickly or at the recorded speed. 

• Use other macros while it is playing back. 

Each time you finish recording a macro, Recorder resets to the standard setting 
any option that you changed before recording. If you want to permanently change 
the standard setting for an option, see "Setting Permanent Preferences" later in this 
chapter. The following sections explain the options in the Record Macro dialog 
box. 

Deciding What to Record 
When you record a macro, Recorder assumes that you want to record all key
strokes and only mouse clicks and drags. You can choose, however, to record as 
much or as little mouse movement as you want. 

Although Recorder allows you to record as much mouse movement as you want, 
it is best to keep the recording of mouse movements to a minimum. Macros that 
record keystrokes are generally more reliable. This is because mouse movements 
that you record in one window might not be appropriate for the window in which 
you later want to replay the macro, particularly if the windows are not the same 
size. 

[> To determine the mouse movements you want to record: 

1. In the Record Macro dialog box, click the Down arrow in the Record Mouse 
box to select the box and display its options. 

Or select the box and press ALT + DOWN ARROW to display the Record Mouse 
options. 

2. Choose the option you want to use. The option then appears as the setting in 
the Record Mouse box. 

The following list describes the options available in the Record Mouse box. 
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Use this option 

Clicks + Drags 

Ignore Mouse 

Everything 

To do this 

Record keystrokes and all mouse movement while a 
button is pressed. This is the standard setting. It allows 
you to record most drawing or editing sequences in a 
program like Paintbrush. 

Record only keystrokes. It is best to use this option when 
you want to record a macro to be used by a variety of 
people using different machines. Macros containing 
mouse movements will work properly only on machines 
using a video adapter identical to the one used by the 
system on which the macro was recorded. 

Record keystrokes and all mouse action even when a 
button is not pressed. You should use this option 
sparingly, but it is appropriate when you are using an 
application that pays attention to mouse movement even 
when no button is pressed. 

CAUTION If you use the Everything option to record keystrokes and all mouse move
ments, you should press GTRL + BREAK when you want to stop recording your macro. If you 
use the mouse to stop recording, the movement of the mouse to the Recorder icon can 
cause the macro to behave incorrectly when played back. The Recorder icon could be in a 
different location, or the Window could be a different size. 

Choosing Where to Record 
Recorder assumes that you want to record a macro relative to the window you are 
currently working in. There may be times, however, when you want to record a 
macro relative to the entire screen. For example, you might be using a full-screen 
application. 

[> To record a macro relative to the entire screen: 

1. In the Record Macro dialog box, click the Down arrow in the Relative To box 
to select the box and display its options. 

Or select the box and press ALT + DOWN ARROW to display the Relative To 
options from the keyboard. 

2. Choose Screen. 

Screen now appears as the setting in the Relative To box. 
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The Relative To option that you use to record a macro is the same option used to 
play back the option. You cannot change this option after the macro is recorded. 

Choosing Where a Macro Plays Back 
The To option in the Record Macro dialog box gives you a choice of playing back 
a macro in any application or only in the application in which you record it. 
Recorder assumes that you want to play back a macro only in the application 
where you recorded it. Many times, a macro that makes sense in one application 
might not make any sense in another. For example, a macro that types a long 
phrase that you use frequently might be appropriate for your word processor, but 
not for your spreadsheet. 

[> To record a macro that plays back in any application: 

1. In the Playback area of the Record Macro dialog box, click the Down arrow in 
the To box to select the box and display its options. 

Or select the box and press ALT + DOWN ARROW to display the To options. 

2. Choose Any Application. 

Any Application now appears as the setting in the To box. 

Including Macros Within a Macro 
Recorder allows you to include-or nest-up to five levels of macros within a 
macro. In other words, Macro 1 can contain a macro called Macro 2, Macro 2 can 
contain a macro called Macro 3, and so on. Recorder assumes that you want a 
macro to be able to include nested macros. However, you can also record macros 
that cannot nest other macros inside themselves. 

[> To record a macro that cannot nest other macros: 

o Clear the Enable Shortcut Keys check box in the Playback area of the Record 
Macro dialog box. 

Press the SPACEBAR to clear the Enable Shortcut Keys check box using the 
keyboard. 

CAUTION Since a macro that contains a nested macro records only a shortcut key, not 
the actual sequence of steps represented by the shortcut key, any nested macros can be 
changed at any time. When you change a nested macro, you must be sure not to make 
changes that cause the macro containing the nested macro to stop working properly. 
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Managing Recorder Files 

Recorder files can contain many macros. The macro name and/or shortcut key 
identifies each macro in the file, as does any description that you entered for the 
macro. You can create Recorder macros of up to 64K. Different Recorder files can 
contain groups of macros for use at specific times or with a specific application, 
but you can open only one file at a time. 

Windows automatically assigns the extension .REC when you save your Recorder 
files. For information about saving and opening Windows files, see Chapter 2, 
"Basic Skills." For information about working with Windows files, see Chapter 4, 
"File Manager." 

The following sections provide information specific to working with Recorder 
files. 

Changing a Macro's Properties 
You can use the Properties command on the Macro menu to change the following 
properties that you assigned to a macro when you recorded it: 

• The shortcut key assignment 

• Thename 

• The description 

• Whether the macro plays back to the same application where it was recorded or 
to any application 

• The speed at which the macro plays back 

• Whether or not the macro plays back continuously 

• Whether or not the macro can contain other shortcut keys 

[> To change a macro's properties: 

1. Select the macro you want to modify from the Recorder window. 

2. Choose Properties from the Macro menu. 

The Macro Properties dialog box appears. 
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You cannot change the Relative setting. 

Macro Properties 

Macro Name: 

Imenu!; '443tT11m'lttftfflm 
Shortcut !;.ey 

Is I [!] 
I2Sl Chi 
DShifl 
DAIt 

f.layback 

To: ISame Application If I 

Speed: IFast If I 

D Continuous loop 
I2Sl Enable Shortcut Keys 

Mouse Coordinates Relative To: Window 
Recorded on (compatible) 640 by 480 display 
,!!.escription 

This macro will start Calendar. enter the weekly staff 
meeting on Wednesdays at 10:00. and set an alarm 
to remind me. 

The screen resolution under which 
the selected macro was recorded 

OK 

Cancel 

+ 

+ 

3. You can change any of the macro settings, except Mouse Coordinates Relative 
To. 

4. Choose OK. 

The screen resolution information lets you know what kind of video display the 
macro was recorded on. This is helpful because mouse movements are sensitive to 
the screen resolution, and macros containing mouse movements seldom work 
properly on a different type of video adapter. 

Deleting Macros from a Recorder File 
You can delete a macro that you are no longer using from a Recorder file to make 
room for new macros. 

[> To delete a macro: 

1. Open the file from which you want to delete macros. 

2. Select the macro you want to delete from the Recorder window. 

3. Choose Delete from the Macro menu. 

A dialog box appears, asking you to confirm the deletion. 

4. Choose OK to delete the macro. 
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Merging Recorder Files 
If you want to consolidate two Recorder files, you can do so by merging a second 
Recorder file into the file you are currently using. 

[> To merge two Recorder files: 

1. Open one of the files that you want to merge. 

2. Delete any macros that you know are duplicated in the file you want to merge 
with the current file. 

3. Choose Merge from the File menu. 

Recorder displays the File Merge dialog box. 

File Merge 

File!!.ame: =1"'=;1=:11'''----___ --' 
Directory: c:\windows 

Files: Directories: 
documentrec [ .. ] 
misc.rec [system] 
sprdsht.rec [-a-] 

[-co] 
[-to] 
[·u-] 

OK 

Cancel 

4. Select from the Files box the file you want to merge with the current file, or 
type the name of the file in the Filename box. 

5. Choose OK. 

Recorder merges the two files. If Recorder finds duplicate shortcut key assign
ments in the files, it clears the duplicate shortcut keys from the file it is 
merging with the current file. A dialog box appears to inform you of this. You 
can use the Properties command on the Macro menu to assign new shortcut 
keys to the macros. 

6. Choose Save As from the File menu to save the combined files under a new 
name or choose Save to replace the current file with the combined files. 
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Setting Permanent Preferences 
Each time you choose the Record command, the Record Mouse, Relative To, 
Playback To, and Playback Speed recording options are set to record macros in 
the following ways: 

This option 

Record Mouse 

Relative To 

Playback To 

Playback Speed 

Is set to 

Record all keystrokes and mouse movements when a 
mouse button is pressed. 

Record macros relative to the window in which you are 
currently working. 

Record macros that will play back only in the applications 
in which you record them. 

Record macros that play back quickly. 

You can change the standard settings for these options if you want to. 

r> To change the standard settings for recording: 

1. Choose Preferences from the Options menu. 

The Default Preferences dialog box appears. 

Default Preferences 
Elayback---------, '---OK-"'. 

To: IbllI1iEl1lilll!l f I 
Speed: I Fast If I Cancel 

RecO/d M,.ouse: I Clicks + Drags If I 

Relative to: IWindow If I 

2. Click the Down arrow in the option box for which you want to change the 
standard setting. This selects the box and displays its settings. 

Or select the box and press ALT + DOWN ARROW to display the options from 
the keyboard. 

3. Select the setting you want Recorder to use as the standard setting. 

4. Choose OK. 
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The settings you select in the Default Preferences dialog box become the standard 
settings for the appropriate options in the Record Macro dialog box. Recorder con
tinues to use these standard settings until you use the Preferences command to 
change them again. See "Changing a Macro's Properties" earlier in this chapter. 

Creating Macros to Use as Demos 
Recorder provides certain options for demonstrating features or applications. For 
instance, you can have a macro play back at a speed appropriate for a demonstra
tion and play back continuously. You can also set a demonstration that runs con
tinuously until you tum off the computer. 

Choosing How Fast a Macro Plays Back 
Recorder assumes that you want a macro to play back quickly. However, if you 
are going to use a macro as a demonstration, you will want the macro to play back 
at the same speed at which it was recorded. 

[> To play back a macro at the speed at which it was recorded: 

1. In the Playback area of the Record Macro dialog box, click the Down arrow in 
the Speed box to select the box and display its options. 

Or select the box and press ALT + DOWN ARROW to display the Speed options 
from the keyboard. 

2. Choose Recorded Speed. 

Recorded Speed now appears as the setting in the Speed Box. 

Setting Up for a Continuously Running Demo 
If you want to use a macro as a demonstration, you might also want the macro to 
restart itself each time it reaches the end so that it plays back continuously. 

[> To set a macro to play back continuously: 

o Select the Continuous Loop check box in the Playback area of the Record 
Macro dialog box. 

Press the SPACEBAR to select the Continuous Loop check box using the 
keyboard. 
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If you select the Continuous Loop check box, you can still stop a macro by 
pressing CTRL + BREAK. 

Turning Off Control + Break Checking 

Pressing CTRL + BREAK usually stops the recording or playing back of a macro. If 
you want to use a macro as a continuously running demonstration, you might want 
to tum off Recorder's ability to detect the CTRL + BREAK key combination so that 
you can prevent an automated demonstration from being turned off by anyone who 
uses the keyboard. The macro runs until you tum off the computer. 

[> To turn off Recorder's ability to detect CTRL + BREAK: 

o Choose Control+Break Checking from the Options menu. 

The checkmark next to the menu command disappears. 

You must restart your computer to stop a continuously running demo after turning 
off Control+Break Checking. 

HINT You might also want to turn off Recorder's ability to detect CTRL + BREAK if you want 
to include a CTRL + BREAK key combination in a macro. 

The next time you start Recorder after turning off Control+Break Checking, the 
command is again set to detect CTRL + BREAK. 

Temporarily Turning Off Recorder 

There may be times when you want to temporarily tum off Recorder's ability to 
detect shortcut keys. For example, you might want to run an application that uses 
the same shortcut key that one of your macros uses. You can do so without having 
to exit from Recorder. 

[> To temporarily turn off Recorder's ability to detect shortcut keys: 

o Choose Shortcut Keys from the Options menu. 

The checkmark next to the menu command disappears. 

If you want to use macros again before you exit from Recorder, choose Shortcut 
Keys again. Otherwise, the next time you start Recorder, the Shortcut Keys com
mand is reset automatically to detect when you press shortcut keys. 
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Guidelines for Creating Macros 
To get the best results, follow these guidelines when recording macros: 

• Get ready for recording the macro. 

If there are applications on the screen that should not be involved in the macro, 
close or move them out of the way before you start recording. 

• Use the mouse sparingly. 

An application window might be a different size and in a different place when 
you play back a macro. This can create problems with recorded mouse actions. 
For example, the mouse might go outside of a window's boundaries com
pletely when you play back the macro, or it might point at something different 
than it did when you were recording the macro. 

• Use the Windows shortcut keys to choose menus commands. 

If a window is near the bottom of the screen when you play back a macro, a 
menu might pop up instead of down, making UP ARROW and DOWN ARROW 
move the cursor inappropriately. 

• Be aware of system incompatibility issues. 

Recorder is sensitive to the screen resolution of the system that mouse move
ments were recorded on. Macros that use mouse movements will seldom work 
properly when used on a system that does not use the same graphics adapter as 
the system on which the macro was recorded. 

Recorder is also sensitive to the keyboard that keystrokes were recorded with. 
While most keys will play back correctly, it is best not to use a macro recorded 
using a keyboard set up for one country on a system using a keyboard set up 
for another country. See Chapter 5, "Control Panel," for more information 
about keyboard settings. 

• Be aware that Recorder is designed for use with Windows applications only. 

PIF Editor 
To use a non-Windows application with Windows, you might need a program 
information file (PIF). A program information file provides special information 
that Windows needs to run an application, such as the path to the directory where 
the application is stored and the extension for the command file that starts the ap
plication. You can create a new PIF, or edit an existing one, by using PIF Editor. 
See Chapter 12, "More About Applications," to learn how to use PIF Editor. 
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The Windows Command Line 
The Windows command line is the text you type at the DOS prompt to start 
Microsoft Windows. Most of the time, you'll probably start Windows simply by 
typing win. However, sometimes you might want to start Windows in a particular 
mode, or tell Windows to run a particular application at start-up. This chapter ex
plains how to use the Windows start-up options. 

The Windows command line tells your computer: 

• To start Windows. 

• What mode to start Windows in (optional). 

• How Windows should use expanded memory (optional). 

• The application or command that you want Windows to run when it starts 
( optional). 

The Windows command line has the following form: 

win Switches RunCommand 

The win portion of the Windows command line tells MS-DOS to start Windows. 
You must always include the win portion of the command line; the rest of the 
command line is optional. 

The Switches portion of the Windows command line represents optional switches, 
such as /R, that you can include on the command line. There are two types of 
switches: those that specify the mode that Windows runs in, and those that deter
mine how Windows uses expanded memory. The switches are described later in 
this chapter. 

The RunCommand portion of the Windows command line represents optional 
text that you can include to start an application when you start Windows. For more 
information, see "Specifying a Run Command" later in this chapter. 
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Starting Windows in a Specific Mode 
Windows can run in three modes: real mode, standard mode, or 386 enhanced 
mode. When you type win, Windows examines your system's configuration and 
starts in the most appropriate mode for your system. (To determine what mode 
Windows is running in, choose About Program Manager from the Help menu in 
Program Manager.) 

Windows uses the following criteria when deciding what mode to use: 

• Windows runs in 386 enhanced mode if your system is an 80386 computer (or 
higher) with at least 2MB of memory (640K of conventional memory and 
1024K of extended memory). 

• Windows runs in standard mode if your system is an 80286 computer (or 
higher) with at least 1MB of memory (640K of conventional memory and 
256K of extended memory). 

• Windows runs in real mode if your system is an 8086 or 8088 computer with at 
least 640K of conventional memory. Windows also runs in real mode if your 
system is an 80286, 80386, or 80486 computer with less extended memory than 
specified previously. 

Sometimes you might want to run Windows in a specific mode, even if it is not the 
most efficient one for your system. For example, if you're running applications 
designed for previous versions of Windows, you would want to run Windows 3.0 
in real mode, even though it could run in standard mode or 386 enhanced mode. 

To ensure that Windows runs in a particular mode, include the switch for that 
mode on the Windows command line when you start Windows. For example, to 
start Windows in real mode, type win fr. You can specify one of the following 
switches: 

Use this 
switch 

fR 

To do this 

Run Windows in real mode. 

This switch is most useful if you want to run applications 
designed for earlier versions of Windows. Many such applications 
are incompatible with the memory management that Windows 
performs when running in standard mode or 386 enhanced mode. 
Chapter 12, "More About Applications," explains more about 
running older Windows applications. 
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IS 
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To do this 

Run Windows in standard mode. 

You might want to use this switch if your system is an 80386 
computer with between 2MB of memory (640K conventional, 
1024K extended) and 3MB of memory (640K conventional, 
2096K extended), and you do not use non-Windows applications 
with Windows. On such systems, Windows runs faster in standard 
mode than in 386 enhanced mode, as long as you use only 
Windows applications. 

You might also want to use this switch if you are having hardware 
compatibility problems when running in 386 enhanced mode. 

Run Windows in 386 enhanced mode. 

You might want to use this switch if you want to run Windows 
in 386 enhanced mode, even though your 80386 computer (or 
higher) has less than the 2MB of memory that 386 enhanced 
mode normally requires. This switch works only on 80386 
systems with at least 1MB of memory (640K conventional, 
384K extended). (Note that if your system has less than 2MB 
of memory, Windows will probably run more slowly in 386 
enhanced mode than in standard mode.) 

Specifying a mode switch is optional. If you do not specify a mode, Windows 
examines your system configuration and starts in the mode most appropriate for 
your system. 

Controlling How Windows Uses Expanded 
Memory in Real Mode 

When running in real mode, Windows can use your system's expanded memory if 
there is any. (Windows does not use expanded memory in standard mode or 386 
enhanced mode although some Windows applications do.) When Windows starts 
in real mode, it examines your system's memory configuration and determines the 
most efficient way to use your expanded memory. For more information about 
expanded memory, see Chapter 13, "Optimizing Windows." 

Normally, Windows uses your system's expanded memory as efficiently as 
possible. However, sometimes you might want to control Windows' use of 
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expanded memory. To do so, you can include expanded-memory switches on the 
Windows command line. You can specify one or more of the following switches: 

Use this 
switch 

IE 

/L 

IN 

To do this 

Tell Windows how much conventional memory must be available 
in order to use large-frame EMS mode. If there is less conven
tional memory available than the amount you specify, Windows 
starts in small-frame EMS mode instead of large-frame EMS 
mode. 

Move the EMS bank line up or down by I-kilobyte increments. 

To move the bank line up, specify the /L switch, followed by a 
plus sign ( + ) and the number of kilobytes you want to move the 
bank line. For example, to move the bank line up 16KB, you 
would specify the value 11+16. 

To move the bank line down, specify the /L switch, followed by a 
minus sign (-) and the number of kilobytes you want to move the 
bank line. For example, to move the bank line down 8KB, you 
would specify the value 11-8. 

(Because the EMS bank line exists only in large-frame EMS 
mode, the /L switch has no effect when Windows uses small
frame EMS mode.) 

Prevent Windows from using any expanded memory. When 
running in real mode, Windows normally uses expanded memory 
if it is available. 

Note that these switches have no effect when starting Windows in standard or 386 
enhanced mode. 

See Chapter 13, "Optimizing Windows," for more information on these switches 
and on expanded memory in general. 
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Specifying a Run Command 
You can use the RunCommand portion of the Windows command line to run a 
particular application or command immediately after starting Windows. For 
example, the following command line starts Windows, then immediately runs 
Microsoft Excel as the foreground application: 

win c:\excel\excel.exe 

The RunCommand portion of the Windows command line is identical to the text 
you enter after choosing Run from the File menu in Program Manager or File 
Manager. See Chapter 2, "Basic Skills," for more infonnation on the Run 
command. 

The RunCommand text must follow any switches you include on the Windows 
command line. For example, the following command line starts Windows in real 
mode, then immediately runs the application MYEDITOR.EXE: 

win Ir myeditor.exe 

Some Sample Windows Command Lines 
This section shows some command lines that illustrate the Windows start-up 
options. 

Sample 1: Starting Windows in Real Mode 

The following command line starts Windows in real mode: 

winlr 

Sample 2: Starting Windows and an Application 

The following command line starts Windows, then immediately runs the 
application TEXTEDIT.COM: 

win d:\editors\textedit.com 

The command line tells Windows that the file TEXTEDIT.COM is located in the 
\EDITORS directory on drive D. 
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Sample 3: Starting Windows and Editing a Document 

The following command line starts Windows in standard mode, then immediately 
opens the document AGENDA. TXT in Notepad: 

win Is agenda.txt 

The command line runs Notepad because Windows associates all files that have 
the .TXT filename extension with the Notepad application. You can change such 
file associations in File Manager by choosing the Associate command from the 
File menu. See Chapter 4, "File Manager," for details. 

Sample 4: Starting Windows and Editing a Document 

The following command line starts Windows, then runs Microsoft Word and 
opens the Word document LETTER.DOC: 

win c:\word\word.com letter.doc 

Sample 5: Preventing Windows from Using Expanded Memory 

The following command line starts Windows in real mode (IR) and prevents it 
from using any expanded memory (IN): 

win Ir In 
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Working with Different Types of Applications 
In Microsoft Windows, different types of applications behave differently. There 
are four basic types of applications: 

• Windows applications designed for Windows 3.0 

• Older Windows applications, designed for previous versions of Windows 

• Non-Windows applications 

• Memory-resident software 

The following sections explain how to work with each type of application. 

Windows Applications DeSigned for Windows 3.0 

Windows applications are specifically designed to take advantage of Windows' 
features and to work with other Windows applications. All Windows applications 
require Windows in order to run. 

Many Windows applications were designed to run with Windows 3.0. These 
applications can take advantage of the additional features and memory capacity 
that Windows 3.0 provides. To run such applications, use the techniques explained 
in Chapter 3, "Program Manager." 

Older Windows Applications 

Some Windows applications were designed for previous versions of Windows, 
and might not work correctly with Windows 3.0. If you have an older Windows 
application, the best thing to do is obtain an updated version of the application for 
Windows 3.0. Updates are already available for many Windows applications; for 
more information, check with your application's manufacturer. 

This section explains how to tell if an application might be incompatible with 
Windows 3.0 and explains how to run such an application with Windows. 

Identifying Older Windows Applications 
It can sometimes be difficult to tell, just by looking at a Windows application, 
whether it was designed for Windows 3.0 or for an earlier version of Windows. 
The most reliable way to detect an older Windows application is to try running it 
with Windows in standard or 386 enhanced mode. 
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Whenever you start a Windows application, if Windows is running in standard 
mode or 386 enhanced mode, Windows checks the application file to ensure that 
the application was designed for use with Windows 3.0. If the application was not 
designed for Windows 3.0, you'll see the following dialog box: 

Application Compatibility Warning 

The application you are about to run. PAINT.EXE. 
was designed for a previous version of 
Windows. 

You should obtain an updated version of the 
application that is compatible with Windows 3.0. 
To run the current version of the application. 
choose Cancel. Then. exit Windows. restart it by 
typing Win Ir. and start the application again. 

If you choose OK and continue to start this 
application. you might encounter compatibility 
problems that could cause the application or 
Windows to terminate unexpectedly. 

OK I 1l::::¢.:~~:~~(J\ 

Windows displays this dialog box to warn you that the application might not run 
properly with Windows 3.0. In general, you should choose Cancel. If you choose 
OK, Windows will start the application even though it might not be compatible 
with Windows 3.0. 

Running Older Windows Applications 
In order to run an older Windows application with Windows 3.0 in standard mode 
or 386 enhanced mode, you should obtain an updated version of the application. 
Until you receive an update, you can still run the application with Windows 3.0, as 
long as you first start Windows in real mode. Older Windows applications should 
run successfully with Windows in real mode, since real mode is the operating 
mode used by previous versions of Windows. 

NOTE When running in real mode, Windows behaves differently from when it is running 
in standard mode or 386 enhanced mode. For example, in real mode, Windows does not use 
extended memory; only your system's conventional and expanded memory is available to 
applications. For additional information about the differences between Windows operating 
modes, see the introduction to this guide. 
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t> To run an older application with Windows 3.0: 

1. Exit Windows if you are running in standard mode or 386 enhanced mode. 

2. Start Windows in real mode by typing win Ir at the DOS prompt. 

3. Start the application as you would any Windows application. 

When you run an older Windows application with Windows 3.0, you might 
encounter one or more of the following problems: 

• The application's menus and dialog boxes might not display fonts correctly. 

• The application might not display colors or color bitmaps correctly. 

---, 

• If the application uses memory incorrectly and Windows is running in standard 
mode or 386 enhanced mode, the application or Windows might become 
unstable or terminate unexpectedly. 

Sharing Data Between Modes 
Sometimes you might want to exchange data between an application that runs only 
in real mode and an application that runs only in 386 enhanced mode. (Many older 
Windows applications can run only in real mode; some Windows applications 
designed for Windows 3.0 might require the additional memory that is available in 
standard mode or 386 enhanced mode.) 

The procedure that follows explains how to exchange information between applica
tions that require different Windows modes. (The basic techniques for sharing 
information are explained fully in Chapter 2, "Basic Skills.") 

t> To transfer data between applications in different modes: 

1. Start Windows in the mode the first application requires. 

For example, if the first application requires real mode, you would start 
Windows by typing win Ir at the DOS prompt. 

2. Start the first application, and cut or copy the information you want to transfer 
to the Clipboard. See "Working with Applications" in Chapter 2 for more 
information. 

3. Start Clipboard and save the information on the Clipboard to a file, as 
explained in "Working with Applications" in Chapter 2. 

4. Exit from Windows. 
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5. Start Windows in the mode the second application requires. 

For example, if the second application requires 386 enhanced mode, you might 
start Windows by typing win (if your system supports 386 enhanced mode). 

6. Choose Clipboard from the Main Group in Program Manager. 

7. Start Clipboard and open the file you just created, as explained in "Working 
with Applications" in Chapter 2. 

8. Leave Clipboard running, and start the application into which you want to 
paste the information. 

9. Choose the Paste command in the Edit menu to move the information from the 
Clipboard into the application. 

Non-Windows Applications 

A typical non-Windows application (called a standard application in previous ver
sions of Windows) was not designed specifically for Windows. Such applications 
do not include Windows-type dialog boxes or other Windows-specific elements. 

With 386 enhanced mode, you can run most non-Windows applications in a win
dow. This makes it easy to share information between applications. You can also 
run multiple non-Windows applications simultaneously. 

With real mode or standard mode, you can run non-Windows applications only in 
a full-screen display. You can start and switch among multiple non-Windows 
applications; however, while you are using a non-Windows application, Windows 
suspends other applications. 

Because Windows applications use memory cooperatively, Windows can 
distribute memory among them as efficiently as possible. In contrast, a non
Windows application requests a certain amount of memory when it starts, and 
keeps that memory until you exit it. If you get an out-of-memory message when 
starting or running a non-Windows application, see "Freeing Up Memory," later in 
this chapter, for information on making more memory available to the application. 

Changing Settings for a Non-Windows Application 
Whenever you start a non-Windows application, Windows looks for that 
application's program information file , or PIF. A PIF is a special file containing 
settings that tell Windows how to run a non-Windows application. A PIF's 
filename usually matches that of the corresponding application. For example, 
the main application file for WordPerfect ® has the filename WP.EXE; the 
corresponding PIF would be WP.PIF. When you start a non-Windows application 
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and Windows cannot find that application's PIF, Windows simply starts the 
application using the standard settings. Most applications run properly using the 
standard settings. 

The following are some of the reasons you might want to change an application's 
settings: 

• To change the pathname for the application. 

• To change the start-up directory that contains the application's data files. 

• To specify a program parameter for the application, or to be prompted for 
parameters whenever you start it. 

• To give the application more memory so that it can run properly, or to enable it 
to run faster (386 enhanced mode only). 

There are two ways to change an application's settings: 

I 386 I' • In 386 enhanced mode, while an application is running, you can change certain 
settings by choosing Settings from the application's Control menu. Your 
changes will remain in effect until you quit the application. For details, see 
"Changing Settings for a Running Application" later in this chapter. 

• In any Windows mode, you can make more permanent changes by using 
Windows PIF Editor to edit the application's PIF. If the application does not 
have a PIF, you can use PIF Editor to create one. For details, see "Working 
with PIFs and PIF Editor" later in this chapter. 

Running a Non-Windows Application from Its PIF 
You can run most non-Windows applications using the standard procedures 
described in Chapter 3, "Program Manager." You can also run a non-Windows 
application directly from its PIF. The PIF tells Windows where to find the file that 
starts the application, and provides other information that determines how the 
application starts and runs. 

You can run an application directly from its PIF just as you can from the 
application's .EXE file. For example, in File Manager, you can start an application 
by double-clicking its PIF filename. You can also add a PIF to a Program Manager 
group just as you would an application. When you do so, specify the PIF's 
filename, including the .PIF extension, as the application command line. 

You can then run that application directly from its PIP. The advantage of running 
an application from its PIF is that, when you do so, Windows starts and runs the 
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application using the values in that particular PIP. This can be useful if you have 
several PIFs for a single application. 

Using Multiple PIFs for the Same Application 
Sometimes, you might want to create more than one PIF for an application-for 
example, to specify different start-up directories for different types of work. In one 
case, you might want to run a word processing application that starts in a directory 
with business documents; in another case, you might want to start the same 
application in a directory that contains personal correspondence. 

To set up the word processing application to start in two different directories, you 
would create two PIFs and assign different directories with the Start-up Directory 
option. Then, you would save each PIF with a distinguishing name (for example, 
BUSINESS.PIF and PERSONAL.PIF). Lastly, you would add each PIF to 
Program Manager and give each PIF a distinguishing title (for example, "Word 
Processing-Business" and "Word Processing-Personal"). You could then 
choose either of the resulting application icons to start the word processor. 
Choosing one would start the word processor in your business directory; choosing 
the other would start the word processor in your personal correspondence 
directory. 

Memory-Resident Software 

Memory-resident software is loaded into memory when you start it, and is then 
available whenever you need it, even when another application is running. 
Memory-resident software comes in two forms: 

• Utility software, such as a mouse driver or network software, that loads when 
you start your computer. 

Normally, you do not interact directly with such utilities; however, they are 
necessary in order to use certain hardware (such as a mouse or network). In 
addition, some applications require special memory-resident utility software. 

• Applications known as pop-up programs. 

Once you start a pop-up program, it loads into memory, but remains invisible 
until you press the key combination that displays the program. At that point, 
the program's menus or prompts appear, and it temporarily suspends any other 
applications that were running. When you dismiss the pop-up program, it 
disappears again, and you resume your previous task. 
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The following sections explain how to use each type of memory-resident software 
with Windows. 

Using Memory-Resident Utilities with Windows 
Typically, you do not interact directly with memory-resident utilities such as net
works and hardware drivers. However, many applications require such utilities in 
order to work properly. For example, an electronic mail application might require 
a memory-resident network driver in order to function. 

If you want a memory-resident utility to be available to all Windows and non
Windows applications, you should start it before you start Windows. The utility 
will then be available to all applications you run with Windows; however, it will 
also take memory away from all applications. In general, most memory-resident 
utilities should be started from your CONFIG.SYS or AUTOEXEC.BAT files. 
(These files are usually located in your hard disk's root directory. They tell 
MS-DOS what commands and utilities to run when starting your computer.) 

If only a particular application requires a memory-resident utility, you might want 
to use a different method to start that utility, so that the utility will not take away 
memory from other applications. There are two ways to do this: 

• If only a particular non-Windows application needs the memory-resident 
utility, you can create an MS-DOS batch file that starts first the utility and then 
the application. You would then run that batch file from Windows. For more 
information on using batch files with Windows, see "Creating PIFs for Batch 
Files" later in this chapter. 

J 

13861· • If only a particular Windows application needs the memory-resident utility, you 
might want to start the utility from the special batch file WINST ART.BAT. 
When you start a utility from this batch file, the utility will be available to 
Windows applications, but not to non-Windows applications. This prevents the 
utility from taking memory away from non-Windows applications. For more 
information on using WINSTART.BAT, see Chapter 13, "Optimizing 
Windows." 

Running Pop-Up Programs with Windows 
You should start pop-up programs, such as Borland's SideKick, directly from 
Windows. You can then switch to and from that program as you would any non
Windows application. 
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[> To use a pop-up program with Windows: 

1. If necessary, create a PIF for the pop-up program as you would for any non
Windows application. The following section, "Working with PIFs and PIF 
Editor," explains how to do this. 

2. Start the pop-up program as you would any application-for example, by 
installing it as an item in Program Manager, then double-clicking its icon. 
Chapter 3, "Program Manager," explains how to install and start applications. 

When you start the pop-up program, Windows displays a message confirming 
that the program has been loaded. 

3. To use the pop-up program, press the appropriate key combination to "pop up" 
the program, just as you would if you were not running it with Windows. 

A few pop-up programs require a key combination that is usually reserved for 
Windows (for example, ALT + ESC). In that case, you might want to edit the 
pop-up program's PIF and select the Reserve Shortcut Keys option for that key 
combination. If you do so, pressing that key combination will display the 
pop-up program instead of performing the usual Windows function. 

You can also switch to a pop-up program using normal Windows methods, 
rather than by pressing the key combination that usually pops up the program. 

It can sometimes be useful to load a pop-up program only when you use another 
application. For example, you might want to load Borland's SideKick in conjunc
tion with the Framework II ® application. Sidekick would then be available from 
Framework II, and would not take away memory from other applications. To load 
a pop-up program in conjunction with another application, you would create a 
batch file that starts first the pop-up program and then the application. For addition
al information on creating a batch file and running it with Windows, see "Creating 
PIFs for Batch Files" later in this chapter. 

Working with PIFs and PIF Editor 
Whenever you start a non-Windows application, Windows looks for that 
application's PIP. As explained earlier in "Changing Settings for a Non-Windows 
Application," a PIF is a special file containing settings that tell Windows how to 
run a non-Windows application. If Windows cannot find a PIF for the application, 
it simply starts the application using the standard settings. Because most applica
tions run properly using the standard settings, many applications never need a PIF 
of their own. 
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However, if an application does not run properly, or if it does not run the way you 
want it to, you might want to change that application's PIF using PIF Editor. If the 
application does not have a PIF, you can use PIF Editor to create one. 

An application's PIF can come from any of the following sources: 

• Windows Setup might create a predefined PIF for that application. 

• The application might come with its own predefined PIF. 

• You can create a PIF for the application using PIF Editor. 

The rest of this section explains how to install, copy, and create PIFs. 

Installing Predefined PIFs 

Windows creates predefined PIFs for many popular applications. When you use 
Setup to install a non-Windows application, it automatically creates and installs a 
predefined PIF for that application in your personal Windows directory. For infor
mation on using Setup to install existing applications, see "Changing the Contents 
of a Group" in Chapter 3. 

When you use Setup to install existing applications, it searches the drive(s) you 
specify and lists any applications it found on those drives. Setup lists only 
Windows applications and applications for which Windows includes predefined 
PIF information. If the application you want is not on Setup's list, Windows does 
not provide a predefined PIF for that application. You can still install the applica
tion from Program Manager, and it will probably run normally even without a PIF. 
If the application doesn't run the way you want it to, create a PIF for it using PIF 
Editor. 

Copying PIFs from Other Disks 

Your application might come with its own PIF. Check the application documen
tation or the application disks themselves for a file with the .PIF extension. 

Some applications come with PIFs that are designed for IBM's TopView@ 
system. You can use a TopView PIF in the same way that you use a Windows PIF. 
You can also use the advanced settings available for Windows PIFs by opening 
the Top View PIF in PIF Editor and saving it again. 
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t> To copy a PIF from another disk to your Windows directory: 

1. Insert the disk that contains the PIF into drive A. 

2. Start File Manager. 

3. Choose the A disk-drive icon. 

4. Double-click the A:\ directory icon or press ENTER. 

File Manager lists the files on the disk. Look for the appropriate file with the 
.PIF filename extension. 

S. Select the PIF you want to copy, and choose Copy from the File menu. 

File Manager displays a dialog box. 

6. Type the destination directory in the To box. In general, you should install 
PIFs in your Windows directory, but you can also install a PIF in the same 
directory as the associated application file. 

7. Choose Copy. 

Windows displays a message when it has finished copying the PIF. 

Add the application to Program Manager as you would any application. When you 
start the application, Windows looks for that application's PIF. A typical PIF's 
filename matches the associated application (for example, the PIF for 
MY APP.COM would be MY APP.PIF). 

If the application does not run properly, you might have to change the settings in 
its PIF. For more information, see the sections on PIF options later in this chapter. 

Starting PIF Editor 

!> To start PIF Editor: 

1. Choose the Accessories Group from the Program Manager window. 

2. Choose the PIF Editor icon from the Accessories Group window. 

PIF Editor displays a new, untitled PIF that contains the standard settings. (To 
edit an existing PIF, choose Open from the File menu, and specify the PIF you 
want.) 

Changing the PIF settings can affect how and whether the application runs. For 
more information, see the sections on PIF options later in this chapter. 
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Changing PIF Modes 

Each PIF contains two sets of options: 

• The Standard options are for running the application with Windows in real 
mode or standard mode. 

• The 386 Enhanced options are for running the application with Windows in 
386 enhanced mode. 

When you start PIF Editor, it automatically displays the correct options for the 
mode you are running Windows in. 

Occasionally, you might want to specify PIF options for a mode you are not 
currently running Windows in. For example, you might be running Windows in 
386 enhanced mode, but want to set PIF options for an application that runs only 
in real mode. In that case, you would want to change the PIF options before 
creating a PIF for that application. 

NOTE Most options have effect only in the mode for which they are entered. For 
example, you can enter two different values for the Optional Parameters option: one for use 
with real or standard mode and one for use with 386 enhanced mode. However, a few 
options, such as Program Filename and Window Title, are common to both modes. 

[> To display different PIF options: 

o Choose the mode you want (Standard or 386 Enhanced) from the Mode menu 
in PIF Editor. For running an application in real mode, choose Standard. 

If you choose the mode you are not currently running, PIF Editor displays a 
message warning you that these are the wrong options for the current mode. If 
you really want to switch PIF modes, choose OK. 

PIF Editor displays the options for the mode you chose. 

For information on how to specify PIF options, refer to the appropriate sections 
later in this chapter. 
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Managing PIFs 

You create, edit, and save PIFs just as you would any Windows file. For example, 
to create a new PIF, you would start PIF Editor, choose New from the File menu, 
edit the PIF options, and save the new PIF with a new filename. You could also 
create a new PIF by opening an existing PIF, editing it, and saving the changed 
PIF with a new filename. 

Typically, a PIF has the same filename as the associated application file, except 
that a PIF has a .PIF filename extension. You should save PIFs in your Windows 
directory or in the directory that contains the associated application file. 

Creating PIFs for Batch Files 

You can create a PIF for an MS-DOS batch file you want to run with Windows. 
An MS-DOS batch file is a text file that contains MS-DOS commands. When you 
run a batch file, MS-DOS executes each command in the file. A batch file can be 
particularly useful for running other commands before or after running a non
Windows application. For example, the commands in a batch file might first load a 
memory-resident program the application needs, then run the application itself. 
The following is a sample batch file called SKFWLOAD.BAT, which you could 
create using Notepad: 

SK.COM 
FW.EXE 

The first line in the batch file loads a pop-up program, SideKick (SK.COM). The 
second line starts the application Framework II (FW.EXE). 

To run the batch file with Windows, you would create a PIF for it. 

[> To create a PIF for a batch file: 

1. Choose the PIF Editor icon from the Accessories Group window. 

2. Type the filename of the batch file in the Program Filename text box. Include 
the .BAT extension. 

To use the sample batch file discussed previously, you would type 
skfwload.bat in the text box. 

3. Set other PIF options as appropriate. The options you set affect all applications 
that the batch file starts. 

4. Choose Save As from the File menu. 
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5. Choose OK to use the PIF filename that PIF Editor suggests. Or type a 
filename for the PIF in the Filename text box, including the .PIF extension. 

=:::J 

Run the batch file by choosing that PIF just as you would choose an applica
tion. For example, you could add the PIF to a Program Manager group, then 
choose it from that group. Or you could start File Manager, then double-click 
the PIF's filename. 

Changing the Standard PIF Settings 

When you start a non-Windows application and Windows cannot find a PIF for 
that application, it starts the application using the standard settings. You can 
override these settings by creating a PIF with the filename _DEFAULT .PIF. You 
might want to override the standard settings if, for example, you are running in 
386 enhanced mode and you want all applications without PIFs to start in a win
dow rather than in a full-screen display. 

[> To override the standard PIF settings: 

1. Choose the PIF Editor icon from the Accessories Group window. 

2. Change the settings until they appear the way you want them. (Leave the 
Window Title option blank.) 

3. Type a valid program pathname in the Program Filename text box. 

For example, you might type c:\command.com. 

Windows ignores certain settings, such as Program Filename, when it starts 
an application using the settings in _DEFAULT.PIF. However, because PIF 
Editor verifies the contents of these fields when you save the PIF, you must 
still provide complete, valid settings. 

4. Choose Save As from the File menu. 

5. Type default.pif in the Filename text box, and choose OK. 

From now on, whenever Windows cannot find an application's PIF, it will start 
the application using the settings in your _DEFAULT.PIF file, rather than using 
Windows' standard PIF settings. You can change your standard settings by editing 
the file _DEFAULT.PIF as you would any PIF. To restore Windows' standard 
settings, just delete the file _DEFAULT.PIF. 

NOTE The settings in _DEFAULT.PIF do not affect the settings PIF Editor displays for 
a new, untitled PIF (the settings you see when you choose New from the File menu). PIF 
Editor always uses Windows' standard PIF settings when creating an untitled PIF. 
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Specifying PIF Options for Standard Mode or 
Real Mode 

As explained earlier in "Non-Windows Applications," you do not normally need 
a PIF to run a non-Windows application. However, to change the way a non
Windows application runs with Windows, you can create a PIF for that application 
(or edit its PIF, if it has one). You create and edit PIFs using PIF Editor. 

A PIF contains two sets of options: Standard options and 386 Enhanced options. 
This section explains how to specify the Standard options. Use these options for 
running an application with real mode or standard mode. 

If you are currently running Windows in real mode or standard mode, PIF Editor 
displays the Standard options automatically. (If you are running Windows in 386 
enhanced mode, you can display the Standard options by choosing Standard from 
the Mode menu.) For more information on modes and PIF options, see "Changing 
PIF Modes" earlier in this chapter. 

The Standard options appear as follows: 

Eile Mode Help 

frogram Filename: 

Window Litle: 

Qptional Parameters: 

.s.tart-up Directory: 

Y:ideo Mode: @ Text 0 Graphics/Multiple Text 

Memory Requirements: KB Required ~ 

XMS Memory: KB Required ~ KB limit ~ 

Directly Modifies: D COMl D COM;! D ,!I;eyboard 

D COM~ D COM! 

D No Screen [xchange D Prevent Program S!!itch 

[8J !;Iose Window on Exit 

Reserve Shortcyt Keys: D AIt+Tab D Alt+Esc D CIrI+Esc 

D PrtSc D Alt+PrtSc 

PIF options for standard mode or real mode 

The rest of this section explains each of the Standard options. 
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Program Filename 
In the Program Filename text box, type the pathname of the file that starts the 
application. (Windows will use this pathname for starting the application in 
386 enhanced mode as well as in standard mode and real mode.) 

For most applications, you can type the pathname of the main application file, 
which usually has the extension .EXE or .COM. For example, to create a PIF for 
Microsoft Word, you would type e:\word\word.eom, since you start Word using 
the file WORD.COM. 

If you start the application from a batch file, type the pathname of the batch file, 
which usually has the .BA T extension. See "Creating PIFs for Batch Files," earlier 
in this chapter, for more information on batch files. 

You must make an entry in this box. 

Window Title 

You can type a descriptive name in the Window Title text box. For example, you 
might type IBM Writing Assistant if you were creating a PIF for that application. 
The name you type will appear under the application's icon when the application 
is minimized. (The application will have the same title when running in 386 
enhanced mode.) 

This entry is optional. If you leave the Window Title box blank, when the applica
tion is minimized, its icon title will contain the application's filename without the 
extension. 

Optional Parameters 

You can type any application parameters in the Optional Parameters text box. 
These are the same parameters you type after the application's filename when 
starting the program from MS-DOS. For example, if you normally type word Ie 
when you start Microsoft Word from MS-DOS, you would type Ie in this box. 

Parameters can be filenames, letters, numbers, or any type of information up to 
62 characters in length. See the application documentation for valid parameters. 

If you want Windows to prompt you for parameters whenever you start the 
application, type a question mark (?) in this box. 
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This entry is optional. If the application does not require parameters, or if you do 
not want to use any parameters when you start this application, leave this box 
blank. 

NOTE To use parameters other than the ones you specify in this text box, start the 
application by choosing Run from the File menu in Program Manager or File Manager. This 
gives you the opportunity to enter alternate parameters. In that case, the application uses 
those alternate parameters, not the parameters in the application's PIF. 

Start-up Directory 

You can type a pathname in the Start-up Directory text box to specify the drive 
and directory that you want Windows to make current when the application is 
started. Some applications require access to certain files in a particular directory. 
This box lets you tell Windows to start the application in the directory that 
contains the required files. 

Although this entry is optional, it is a good idea to specify a start-up directory. 
For most applications, you can specify the drive and directory that contains the 
application file. 

Video Mode 

Use the Video Mode options to tell Windows how the application uses the display. 
The video mode determines how much memory Windows sets aside for storing 
the contents of the application's display. When you switch away from the applica
tion, Windows saves the application's display so that it is restored correctly when 
you return to the application. 

The memory that Windows reserves for the application's display comes out of the 
memory allocated to the application. Therefore, the more memory the applica
tion's display requires, the less memory is available for the application itself. 

You can select from two video modes: Text and Graphics/Multiple Text. Text 
requires less memory than Graphics/Multiple Text. You can select one of the 
following modes: 



Use this option 

Text 

Graphics/ 
Multiple Text 
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To do this 

Tell Windows that the application will be running only in 
normal text mode. Text mode uses the least memory; 
therefore, to make the most memory available to the 
application, you might want to choose this option, and 
then run the application solely in text mode. 

Tell Windows that the application will run in graphics 
mode, or that it will use more than one text screen's 
worth of display memory. The Graphics/Multiple Text 
option uses more memory than the Text option; however, 
choosing this option ensures that enough video memory 
will be available when you switch back and forth 
between modes. 

(Multiple text refers to text-mode applications that use 
more than one video page to display text, and therefore 
need more video memory than typical text-mode applica
tions. Some BASIC programs use this mode.) 

You can make more memory available to the application by selecting the 
Text option. However, if you are not sure which video mode to use, select 
Graphics/Multiple Text. This option is the safest. If the application needs the 
Graphics mode, but the Text option is selected, you will not be able to switch 
away from the application; the only way to get back to Windows would be to 
quit the application. 

Memory Requirements 
Use the Memory Requirements: KB Required text box to tell Windows how many 
kilobytes of conventional memory must be free in order to start the application. In 
general, you should leave this setting at the standard of 128. 

Regardless of what you type in the KB Required text box, when you start the 
application, Windows gives it all available conventional memory. The number in 
this text box simply determines how much memory must be available before 
Windows will even try to start the application; it does not limit how much 
conventional memory the application receives. 

If Windows cannot provide as much memory as you specify, when you try to 
start the application, you will see a message telling you that there is not enough 
memory to run the application. For more information about specifying memory 
options and fine-tuning memory requirements, see "Freeing Up Memory" later in 
this chapter. 
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NOTE A typical application's documentation tells you its system memory requirements. 
However, this number is usually an estimate of the total amount of system memory you'll 
need to run the application; rarely is it an accurate description of exactly how much free 
memory the application really needs. 

XMSMemory 

Use the XMS Memory options to tell Windows how much extended memory to 
give to an application that uses memory according to the Lotus ®-Intel-Microsoft
AST ® eXtended Memory Specification (XMS) standard. Because very few 
applications use extended memory, you can usually leave these options at their 
standard settings. Lotus 1-2-3 ® version 3.0 is an example of a non-Windows 
application that does use extended memory. (For more information about extended 
memory, see Chapter 13, "Optimizing Windows.") The following list explains 
each option: 

Use this option 

KB Required 

KB Limit 

To do this 

Tell Windows how many kilobytes of extended memory 
must be free in order to start the application. 

Leave this setting at 0 for most applications. Specifying a 
value other than 0 will dramatically increase the time it 
takes to switch to and from the application. You should 
specify a value only if the application requires a certain 
amount of extended memory in order to run. 

Tell Windows how many kilobytes of extended memory it 
should permit the application to use. 

This option is useful for limiting an application's access to 
extended memory, since some applications will take all 
available extended memory whether they need it or not. 

Leave at 0 to prevent the application from gaining access 
to any extended memory. 

Setting this option to -1 gives the application all the 
extended memory it requests (up to the maximum amount 
available). Set this option to -1 only if the application 
requires large amounts of extended memory. In general, it 
is not a good idea to set this option to -1, since it slows 
your system down dramatically. 

To prevent the application from using any extended memory, leave both XMS 
Memory options at the standard setting of O. 
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Directly Modifies 

Use the Directly Modifies options to tell Windows that the application uses certain 
system resources in a way that prevents sharing those resources with other applica
tions. For example, some communications applications take control of the com
munications port they are using, to the exclusion of other applications. The 
following list explains each option: 

Use this option 

COMl,COM2, 
COM3,COM4 

Keyboard 

To do this 

Tell Windows which communications port(s) the applica
tion uses. This information lets Windows prevent two 
applications from trying to use the same communications 
port at once (which can result in garbled or lost data). 

Tell Windows that because the application takes direct con
trol of the keyboard, Windows will be unable to respond to 
any shortcut keys you press while you're using the applica
tion. This means that you will be unable to switch away 
from the application or copy its screen onto the Clipboard. 

Selecting this option can make more memory available to 
the application, since Windows can then assume that it 
does not need to save the application's current state or 
display. 

Selecting any of the Directly Modifies options is similar to selecting the Prevent 
Program Switch option; you will have to quit the application in order to get back 
to Windows or other applications. If you are uncertain, do not select these options. 

No Screen Exchange 

You can conserve memory by selecting the No Screen Exchange option. If you 
select this option, you will not be able to copy information from the application's 
window onto the Clipboard using ALT + PRINT SCREEN or PRINT SCREEN. If you 
are uncertain, do not select this option. 

The effect of selecting this option is similar to what happens if you select both the 
PrtSc and Alt+PrtSc check boxes in the Reserve Shortcut Keys options. 
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Prevent Program Switch 
You can conserve memory by selecting the Prevent Program Switch option. If 
you select this option, you will not be able to switch from this application; to use 
Windows or other applications, you will have to first quit this application. If you 
are uncertain, do not select this option. 

The effect of selecting this option is similar to what happens if you select all the 
Reserve Shortcut Keys options, or select any of the Directly Modifies options. 

Close Window on Exit 
You can use the Close Window on Exit option to close the application's display 
and return to Windows automatically when you exit the application, rather than 
leaving the information on the screen. If this option is not selected and you are 
running the application in text mode, you will see a message reminding you to 
press any key to resume your Windows session. If you are running the application 
in graphics mode, you will not see a message; however, pressing any key will 
clear the screen and continue your Windows session. 

Reserve Shortcut Keys 
Use the Reserve Shortcut Keys options to specify the key combinations you want 
to use for the application, rather than as Windows shortcut keys. 

Normally, when you type a Windows shortcut key combination, Windows 
executes that shortcut key's assigned action; the application never registers that 
you pressed those keys. However, sometimes you might want to use a shortcut key 
combination within an application. 

Selecting one or more of the Reserve Shortcut Keys options tells Windows to 
ignore the specified key combination when the application is running in the 
foreground, and instead let the application respond to the key combination. For 
example, suppose your word processing application uses the key combination 
ALT + TAB to insert a special character. When you run the word processor with 
Windows, pressing ALT + TAB would switch to another application, rather than 
inserting the special character in your word processor. In order to use ALT + TAB 

in your word processor, you could edit your word processor's PIF and select the 
Reserve Shortcut Keys option for the ALT + TAB shortcut key. Thereafter, when 
using your word processor with Windows, pressing AL T + TAB would insert the 
special character rather than switch to a different application. (When using other 
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applications, the key combination ALT + TAB would still act as a normal Windows 
shortcut key.) 

The following list explains each option and describes how Windows uses each 
shortcut key: 

Use this option 

Alt+Tab 

Alt+Esc 

Ctrl+Esc 

PrtSc 

A1t+PrtSc 

To do this 

Reserve the ALT + TAB shortcut key for the application. 
Otherwise, Windows toggles between applications when 
you press this key combination. 

Reserve the ALT + ESC shortcut key for the application. 
Otherwise, Windows switches to the next application when 
you press this key combination. 

Reserve the CTRL + ESC shortcut key for the application. 
Otherwise, Windows displays the Task List when you 
press this key combination. 

Reserve the PRINT SCREEN shortcut key for the application. 
Otherwise, Windows copies a full screen onto the 
Clipboard when you press this key. 

Reserve the ALT + PRINT SCREEN shortcut key for the 
application. Otherwise, Windows copies a full screen onto 
the Clipboard when you press this key combination. 

Specifying Basic PIF Options for 386 Enhanced 
Mode 

As explained earlier in "Non-Windows Applications," you do not normally need 
a PIF to run a non-Windows application. However, to change the way a non
Windows application runs with Windows, you can create a PIF for that application 
(or edit its PIF if it has one). You create and edit PIFs using PIF Editor. 

A PIF contains two sets of options: Standard options and 386 Enhanced options. 
Use the 386 Enhanced options to determine how the application will run with 386 
enhanced mode. (For an application you will run with real mode or standard mode, 
use the Standard options instead.) 

The 386 Enhanced options appear in two categories: basic and advanced. The 
basic options are similar to the PIF options for standard mode. The advanced 
options fine-tune the way the application runs with 386 enhanced mode. This 
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section explains each of the basic options for running an application with 386 
enhanced mode. For more information on modes and PIF options, see "Changing 
PIF Modes" earlier in this chapter. 

If you are currently running Windows in 386 enhanced mode, PIF Editor displays 
the 386 Enhanced options automatically. (If you are running Windows in real 
mode or standard mode, you can display the 386 Enhanced options by choosing 
386 Enhanced from the Mode menu.) 

The basic options for 386 enhanced mode appear as follows: 

file Mode Help 

Erogram Filename: 

Window Litle: 

.!lptional Parameters: 

~tart-up Directory: 

Memory Requirements: KB Required ~ KB !lesired ~ 

Display Usage: @ Fyll Screen 

o ~indowed 
[gJ !;Iose Window on Exil 

Execution: D J!ackground 

D Exclusive 

I Advanced ... 

PIF options for 386 enhanced mode 

Program Filename 

In the Program Filename text box, type the pathname of the file that starts the 
application. (Windows will use this pathname for starting the application in 
standard mode and real mode as well as in 386 enhanced mode.) 

For most applications, you can type the pathname of the main application file, 
which usually has the extension .EXE or .COM. For example, to create a PIF for 
Microsoft Word, you would type c:\word\word.com, since you start Word using 
the file WORD.COM. 

If you start the application from a batch file, type the pathname of the batch file, 
which usually has the .BAT extension. See "Creating PIFs for Batch Files," earlier 
in this chapter, for more information on batch files. 
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Window Title 

You can type a descriptive name in the Window Title text box. For example, you 
might type IBM Writing Assistant if you were creating a PIF for that application. 
The name you type will appear in the window's title bar, and under its icon when 
the application is minimized. (The application will have the same title when 
running in real mode or standard mode.) 

This entry is optional. If you leave the Window Title box blank, when the applica
tion is running with 386 enhanced mode, its title bar will contain the application's 
filename without the extension. 

Optional Parameters 

This option is identical to the corresponding Standard option; for information, see 
"Specifying PIF Options for Standard Mode or Real Mode" earlier in this chapter. 

NOTE The optional parameters you enter when PIF Editor is displaying the 386 
Enhanced options apply to 386 enhanced mode only. This means that you can enter 
different parameters for running the same application in real or standard mode, and for 
running it in 386 enhanced mode. 

Start-up Directory 

This option is identical to the corresponding Standard option; for information, see 
"Specifying PIF Options for Standard Mode or Real Mode" earlier in this chapter. 

Memory Requirements 

Use the Memory Requirements text boxes to allocate conventional memory to the 
application. 

NOTE The Memory Requirements options refer to the amount of free memory the 
application needs. When setting these options, do not use the memory requirements listed 
in the application's documentation. Such "requirements" usually refer to the total amount of 
memory your system should have, not to the amount of memory that must be free in order 
for the application to run. Application manufacturers normally specify more memory than 
the application actually needs; this ensures that your system will have enough memory to 
run MS-DOS, the utilities in your CONFIG.SYS and AUTOEXEC.BAT files, and the application. 

/ 
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The following list explains each Memory Requirements option: 

Use this option 

KB Required 

KB Desired 

Display Usage 

To do this 

Tell Windows how many kilobytes of conventional 
memory must be free in order to start the application. In 
general, you should leave this setting at the standard of 
128. 

Windows will start the application only if there is at least 
as much free memory as the KB Required option specifies. 
Otherwise, you will see a message telling you that there is 
not enough memory to run the application. If other applica
tions are running, you can close one or more of them and 
try running the application again. For more information 
about making more memory available, see "Freeing Up 
Memory" later in this chapter. 

The KB Required option does not limit how much 
memory the application receives; Windows gives it as 
much memory as possible, up to the limit set by the KB 
Desired option. 

Set this option to -1 to give the application all available 
conventional memory. 

Limit the amount of conventional memory Windows will 
give the application. Windows will give an application up 
to, but no more than, the amount of memory you specify in 
this box. The standard of 640K provides the maximum 
amount of conventional memory any application can use. 

You might want to set KB Desired to an amount less 
than 640K in order to reserve more memory for other 
applications. 

A setting of -1 tells Windows to give this application as 
much memory as possible, up to the maximum of 640K. 

Use the Display Usage options to tell Windows how to display the application 
when you start it. You can select one of the following options: 



Execution 

Use this option 

Full Screen 

Windowed 
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To do this 

Start the application in a full-screen display rather than 
in a window. The application retains mouse support. 

Start the application in a window. Mouse support goes to 
Windows, not to the application. Running an application 
in a window takes more memory than running it in a full 
screen. However, you gain the advantages of running in a 
window, including easily sharing information between 
applications. 

---, 

Once the application is running, you can move it from a window to a full-screen 
display, or vice versa, by pressing ALT + ENTER. 

Use the Execution options to control when the application can run and how it 
cooperates with other applications. The following list explains each option: 

Use this option 

Background 

Exclusive 

To do this 

Allow the application to run while you are using another 
application. For example, a communications program 
might run in the background, accepting information from 
another computer, while you work with a word processing 
application. If you do not select this option, the application 
will be suspended when you switch to another application. 

Suspend other applications while this application is in the 
foreground (even if the other applications have their 
Background options selected). Selecting this option can 
give this application more memory and processor time. 

You can set this option both for applications that run in a 
window and those that run in a full screen. It is best to run 
exclusive applications in a full screen, since this gives 
them the full benefit of using the Exclusive option. When 
you run an exclusive application in a window, Windows 
reserves some resources for itself and for running 
Windows applications. 

/ 
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Close Window on Exit 
Nonnally, when you quit a non-Windows application, Windows closes the 
application's window automatically. Clear this option if you want Windows to 
leave the application's window on the screen after you quit the application. 

Specifying Advanced PIF Options for 386 
Enhanced Mode 

The PIP options for 386 enhanced mode appear in two categories: basic and 
advanced. The basic options are similar to the Standard PIP options; see the 
preceding section for more infonnation. 

The advanced PIP options let you fine-tune how the application runs with 386 
enhanced mode and how it uses memory and other system resources. In most 
cases, you will not need to change the advanced options; you can simply leave 
them with the standard settings. If you plan to change these options, it is best to be 
familiar with memory issues, Windows, and the applications you use. Some of the 
technical concepts discussed in this section are described in more detail in Chapter 
13, "Optimizing Windows." 

I> To display the advanced PIF options for 386 enhanced mode: 

[J Choose the Advanced button at the bottom of the PIP Editor window. 

PIP Editor displays a dialog box with the advanced options. The advanced 
options appear as follows: 
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Iii -, 
I ft·,ma

.,; .. Opl;"M I ~ Hackground Priority: ~ foreground Priority: ~ OK 

[8J Qetect Idle Time I Cancel I 
Memory Options 
EMS Memory: KB Required ~ KB limit ~ 0 Loc~ed 
XMS Memory: KB Reguired ~ KB Limit ~OL!!.cked 

[8J Uses tl.igh Memory Area o Lock Application Memory 

Display Options 
~ideo Memory: @ Text o Low Graphics o High Graphics 
Monitor Ports: o Text o Low Graphics [8J High Graphics 

[8J fmulate Text Mode o Retain Video M.emory 

Other Options 
[8J Allow Fast ~aste o Allow ~Iose When Active 

Reserve :i.hortcut Keys: o AIt+Tab o AIt+Esc o Clrl+Esc 

o PrtSc o AIt+PrtSc o AIt+Space 

o Alt+Enter 

~pplication Shortcut Key: I None I 

Advanced PIF options for 386 enhanced mode 

The advanced options are divided into four groups: Multitasking Options, Memory 
Options, Display Options, and Other Options. The sections that follow explain 
each group of options. 

Multitasking Options 

Use the Multitasking options to determine how the application will run in 
relationship to other applications. The Multitasking options appear as follows: 

Multitasking Options-----------------. 

Hack ground Priority: ~ foreground Priority: ~ 

[8J Qetect Idle Time 

Advanced PIF options: Multitasking 

The following sections explain each Multitasking option. 

I 
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Background Priority 
Use the Background Priority text box to specify how much processor time the 
application should receive when it is running in the background. The application 
will receive this priority only when its Background option is selected and the 
foreground application's Exclusive option is not selected. 

You can specify a value from 0 to 10000; the standard background priority is 50. 
The figure you specify is meaningful only when compared to other applications' 
background and foreground priorities; it refers to the amount of computer 
processor time the applications use. 

For example, suppose you have four applications running. One application is 
running in the foreground with a foreground priority of 200. The other three 
applications are running in the background with a background priority of 50 each. 
The total priority of all four applications is 3 times 50 (the background priorities), 
plus 200 (the foreground priority), or 350. Of this total, the foreground application 
will get 200 out of 350, or 57 percent of the processor time. Each of the back
ground applications will get 50 out of the total of 350, or one-seventh of the 
processor time. 

NOTE While an application is running, you can change its priorities by changing options 
in the Control menu. See "Changing Settings for a Running Application" later in this chapter. 

Foreground Priority 
Use the Foreground Priority text box to specify how much processor time you 
want the application to receive when it is running in the foreground. You can 
specify a value from 0 to 10000; the standard foreground priority is 100. 

The figure you specify is meaningful only when compared to other applications' 
background and foreground priorities; it refers to the amount of computer 
processor time the applications use. For more information on how Windows 
interprets application priorities, see the preceding section, "Background Priority." 
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Oetect Idle Time 
Select the Detect Idle Time option to let Windows give resources to other applica
tions while this application is idle-that is, waiting for input from you. 

Leave this option selected except in rare cases; this enhances the performance of 
the entire system. 

If an application is running extremely slowly, it is possible that Windows might 
incorrectly consider it to be idle. Try clearing this option to speed up such an 
application. 

Memory Options 

The advanced PIF options include options that control how the application uses 
the computer's available memory when running with 386 enhanced mode. The 
Memory options appear as follows: 

Memory Options-----------------, 

EMS Memory: KB B.equired ~ 

XMS Memory: KB Re!luired ~ 

[8l Uses liigh Memory Area 

KB Limit ~ 0 Loc~ed 
KB Limit ~ 0 LQ.cked 

o Lock Application Memory 

Advanced PIF options: Memory 

The following sections explain each Memory option. 

EMS Memory 
Although Windows uses only extended memory when running in 386 enhanced 
mode, it simulates expanded memory for applications that use expanded memory. 
Use the EMS Memory options to specify how much expanded memory Windows 
should provide to the application. Although few applications actually require 
expanded memory, many run better if they can use it. (See Chapter 13, 
"Optimizing Windows," for an explanation of the different types of memory.) 
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The following list explains each EMS Memory option: 

Use this option 

KB Required 

KB Limit 

To do this 

Tell Windows how many kilobytes of expanded memory it 
must be able to provide in order to start the application. In 
general, you can leave this option at the standard setting of 
0, which tells Windows that this application does not 
require expanded memory. 

The KB Required option does not limit how much 
expanded memory the application receives; Windows 
gives it as much expanded memory as the application 
requests, up to the limit set by the KB Limit option (or 
until no more memory is available). 

Windows will start the application only if it can provide 
at least as much expanded memory as the KB Required 
option specifies. Otherwise, Windows displays a message 
telling you that there is not enough memory to run the 
application. If other applications are running, you can 
close one or more of them and try running the application 
again. For more information about making more memory 
available to the application, see "Freeing Up Memory" 
later in this chapter. 

Limit the amount of expanded memory Windows will 
provide to the application. Windows will give an applica
tion as much expanded memory as it requests, up to the 
amount you specify in this text box (or until no more 
memory is available). 

This option is useful for limiting an application's access to 
expanded memory, since some applications will take all 
available expanded memory whether they need it or not. 

To prevent Windows from providing any expanded 
memory to the application, set this option to O. 

The standard setting of 1024 tells Windows to provide the 
application with as much expanded memory as it asks for, 
up to a limit of 1024K, or until there is no more memory 
available. 



Use this option 

Locked 

XMSMemory 
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To do this 

Tell Windows not to swap the application's expanded 
memory to the hard disk. Locking an application's 
memory can improve that application's performance, 
but it slows down the rest of your system. 

Use the XMS Memory options to tell Windows how much extended memory to 
give to an application that uses memory according to the Lotus-Intel-Microsoft
AST eXtended Memory Specification (XMS) standard. Because very few 
applications use extended memory, you can usually leave these options at their 
standard settings. The following list explains each option: 

Use this option 

KB Required 

To do this 

Tell Windows how many kilobytes of extended memory 
it must be able to provide in order to start the application. 
In general, you can leave this option at the standard setting 
of 0, which tells Windows that this application does not 
require extended memory. 

The KB Required option does not limit how much ex
tended memory the application receives; Windows gives it 
as much extended memory as the application requests, up 
to the limit set by the KB Limit option (or until no more 
memory is available). 

Windows will start the application only if it can provide 
at least as much extended memory as the KB Required 
option specifies. Otherwise, Windows displays a message 
telling you that there is not enough memory to run the 
application. If other applications are running, you can 
close one or more of them and try running the application 
again. For more information about making more memory 
available to the application, see "Freeing Up Memory" 
later in this chapter. 
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Use this option 

KB Limit 

Locked 

To do this 

Limit the amount of extended memory Windows will 
provide to the application. Windows will give an applica
tion as much extended memory as it requests, up to the 
amount you specify in this text box (or until no more 
memory is available). 

This option is useful for limiting an application's access to 
extended memory, since some applications will take all 
available extended memory whether they need it or not. 

To prevent Windows from providing any extended 
memory to the application, set this option to O. 

The standard setting of 1024 tells Windows to provide the 
application with as much extended memory as it asks for, 
up to a limit of 1024K, or until there is no more memory 
available. 

Tell Windows not to swap the application's extended 
memory to the hard disk. Locking an application's 
memory can improve that application's performance, but it 
slows down the rest of your system. 

Uses High Memory Area 
The Uses High Memory Area option tells Windows that the application is allowed 
to use the high memory area (HMA) of RAM. The high memory area is the first 
64K of extended memory. 

If the HMA is available when Windows starts, each application can allocate its 
own private HMA. However, the HMA is used by some memory-resident utilities 
such as networks. If such a utility is using the HMA when you start Windows in 
386 enhanced mode, no other application will be able to use the HMA. 

Keep this option selected for most applications. If the HMA is available and the 
application uses it, more memory will be available to the application. If the applica
tion does not use the HMA, no memory is wasted. 

Clear this option to prevent the application from using the HMA even when the 
HMA is available. 
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Lock Application Memory 
Select the Lock Application Memory option to speed up some applications. While 
the application is running, if this option is selected, Windows will keep the applica
tion in memory and not swap it to the hard disk. Although selecting this option can 
speed up the application, it slows down the rest of your system. 

NOTE This option affects how the application's conventional memory is handled. The use 
of its expanded and extended memory is controlled separately by the Locked options in the 
EMS Memory and XMS Memory sections of this dialog box. See Chapter 13, "Optimizing 
Windows," for more information on memory. 

Display Options 

Use the Display options to determine how the application appears on the screen 
and how Windows handles memory for the application's display. The Display 
options appear as follows: 

Display Options-------------, 

~ideo Memory: @ Text 0 Low Graphics 0 High Graphics 

Monitor Ports: D Text D Low Graphics [8;J High Graphics 

[8;J Emulate Text Mode D Retain Video !!lemory 

Advanced PIF options: Display 

The following sections explain each Display option. 

Video Memory 
Use the Video Memory options to tell Windows how the application initially uses 
the display. The video mode determines how much memory Windows provides 
for the application's display when you start the application. 
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You can select from three video modes: Text, Low Graphics, and High Graphics. 
The following list explains each option: 

Use this option 

Text 

Low Graphics 

High Graphics 

To do this 

Tell Windows to set aside enough memory to initially 
display the application in text mode. Text mode requires 
the least amount of memory (usually less than 16K). 

Tell Windows to set aside enough of the application's 
memory to initially display it in low-resolution graphics 
mode. On most video adapters, this mode corresponds to 
eGA resolution graphics, and requires about 32K of 
memory. 

Tell Windows to set aside enough of the application's 
memory to initially display it in high-resolution graphics 
mode. EGA and VGA video adapters display applications 
in high-resolution graphics mode, which usually requires 
about 128K of memory. 

Selecting both this option and the Retain Video Memory 
option will ensure that there's always enough memory to 
run the application; however, less memory will be avail
able for other applications. 

Windows uses the Video Memory options to reserve enough memory for the 
application's initial display. After the application is running, Windows can adjust 
the application's display memory depending on the application's current video 
mode. For example, if you start the application in graphics mode and later change 
it to text mode (which requires less memory), Windows releases the extra memory 
for use by other applications. If you change to a video mode that requires more 
memory, Windows tries to provide the additional memory. 

If you switch to a higher video mode and there is not enough additional memory 
available, the application's display might be partially or totally lost. You can 
prevent this by ensuring that there will always be enough display memory avail
able for this application. To do this, select the highest video mode the application 
will run in. Also, select the Retain Video Memory option to tell Windows not to 
release extra video memory to other applications. See the description of that option 
later in this section. 



Chapter 12 More About Applications 471 

NOTE The exact effects of the Video Memory options depend on the video adapter for 
your system. For example, some video adapters, such as Hercules ® and eGA, have only 
one graphics mode; on these adapters, there is no difference between Low Graphics and 
High Graphics. 

Monitor Ports 

=::::J 

Some applications interact directly with system hardware input and output ports in 
order to control the display adapter. If an application does this, Windows might 
need to monitor that application's interaction with the hardware ports. This 
ensures that, when you switch away from and return to the application, Windows 
can restore the application's display correctly. 

For most applications, you can leave these options at their standard settings. You 
should change these options only if the application's display does not appear as it 
should, since monitoring the application's video operations slows the application 
down considerably. 

If the application's display does not appear as it should, select the option for the 
mode the application was running in when the problem occurred, and try running 
the application again. If the display is still not restored correctly, try selecting the 
other Monitor Ports options until the display appears as it should. The following 
list explains each option: 

Use this option 

Text 

Low Graphics 

High Graphics 

To do this 

Tell Windows to monitor all video operations when the 
application is running in text mode. Few applications 
require this option. 

Tell Windows to monitor all video operations when the 
application is running in low-resolution graphics mode. 
Few applications require this option. 

Tell Windows to monitor all video operations when the 
application is running in high-resolution graphics mode. 
Most applications require this option. 

NOTE Some display adapters, such as the IBM VGA, will not be affected by these 
options. 
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Emulate Text Mode 
The Emulate Text Mode option can increase the rate at which the application 
displays text. For most applications, you can leave this option selected. 

Try clearing this option if the text is garbled, the cursor appears in the wrong 
place, or the application will not run. 

Retain Video Memory 
Use the Retain Video Memory option to tell Windows not to release the 
application's extra video memory for use by other applications. 

Some applications can use several different video modes; usually, you can change 
the video mode from the application itself. For example, Microsoft Word lets you 
change back and forth between Text and Graphics modes. If you are using such an 
application and the Retain Video Memory option is not selected, Windows adjusts 
the application's video memory to accommodate the application's current video 
mode. If you change to a video mode that requires less memory, Windows releases 
the extra memory for use by other applications. If you later change back to a mode 
that requires more memory, Windows gives the application additional memory for 
its display. 

This dynamic allocation of video memory works well as long as you do not run 
out of memory. However, if you run out of memory and then change the applica
tion to a more memory-intensive video mode, Windows might not be able to 
provide enough memory to support that mode, and the application's display might 
be lost. 

Selecting both this option and the appropriate Video Memory option ensures 
that there will always be enough memory available for Windows to handle the 
application's display correctly. The Video Memory option ensures that there will 
be enough video memory to display the application when it starts; the Retain 
Video Memory option ensures that Windows will not release any of the appli
cation's video memory to other applications. Note that if you select both options, 
the memory will not be available for other applications even when it is not 
actually in use. 

Other Options 

The Advanced PIF options include several additional options you can use to 
customize the way the application runs with Windows in 386 enhanced mode. 
The Other options appear as follows: 
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Other Options 
[8J Allow Fast ~aste 0 Allow !;;.Iose When Active 

Reserve S,.hortcut Keys: 0 AIt+Tab 0 Alt+Esc 0 Clrl+Esc 

o PrtSc 0 Alt+PrtSc 0 AIt+Space 

o AIt+Enter 

Application Shortcut Key: IL-N_on_e ______ ---l 

Advanced PIF options: Other options 

The following sections explain each option. 

Allow Fast Paste 
Select this option if the application is capable of accepting infonnation pasted 
from the Clipboard using the fastest method. Most applications can use the fastest 
pasting method without problems. Windows can detect most applications that 
cannot handle fast pasting and, for those applications, automatically uses the 
slower pasting method instead. 

Clear this option only if you are having trouble pasting infonnation into the 
application. Occasionally, Windows is unable to detect an application that cannot 
accommodate the fastest pasting method; then, when you choose Paste from the 
application's Control menu, nothing happens. To fix this problem, cancel the paste 
operation by pressing ESC, and quit the application. In the application's PIF, clear 
the Allow Fast Paste option, save the PIF, and restart the application. 

Allow Close When Active 
Use this option to tell Windows that it can close the application without requiring 
you to choose the application's exit command. This feature lets you exit Windows 
without having to close every application separately. 

Select this option only if you are sure that the application uses standard MS-DOS 
file handles. If you are unsure, do not select this option. 

CAUTION Selecting this option could result in data loss or damage to your files. 
Windows might close an application before the application closes its open files; as a result, 
you could lose any changes you made to those files. 
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Reserve Shortcut Keys 
Selecting one or more of the Reserve Shortcut Keys options tells Windows to 
ignore the specified key combination when the application is running in the 
foreground, and instead let the application respond to the key combination. The 
following list explains how Windows uses each shortcut key: 

Use this option 

A1t+Tab 

Alt+Esc 

Ctrl+Esc 

PrtSc 

A1t+PrtSc 

A1t+Space 

Alt+Enter 

To do this 

Reserve the ALT + TAB shortcut key for the application. 
Otherwise, Windows switches between applications when 
you press this key combination. 

Reserve the ALT + ESC shortcut key for the application. 
Otherwise, Windows switches to the next application when 
you press this key combination. 

Reserve the C1RL + ESC shortcut key for the application. 
Otherwise, Windows displays the Task List when you 
press this key combination. 

Reserve the PRINT SCREEN shortcut key for the application. 
Otherwise, Windows copies a full screen onto the 
Clipboard when you press this key. 

Reserve the ALT + PRINT SCREEN shortcut key for the 
application. Otherwise, Windows copies the contents of the 
active window onto the Clipboard when you press this key 
combination. 

Reserve the ALT + SPACEBAR shortcut key for the applica
tion. Otherwise, Windows displays the application's 
Control menu when you press this key combination. 

Reserve the ALT + ENTER shortcut key for the application. 
Otherwise, Windows toggles the application in or out of a 
window (if it can run in one) when you press this key 
combination. 

The Reserve Shortcut Keys options for 386 enhanced mode are similar to the 
corresponding options for standard mode. For additional information, see 
"Specifying PIF Options for Standard Mode or Real Mode" earlier in this chapter. 
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Application Shortcut Key 
When running in 386 enhanced mode, Windows provides a special feature called 
an application shortcut key. When an application is running and you press its 
application shortcut key, it immediately becomes the foreground application. An 
application shortcut key lets you switch to a particular application quickly, no 
matter where you are in Windows or what other application you are using. 

To assign an application shortcut key to an application, you use the Application 
Shortcut Key option in the application's PIF. The key combination you specify 
must include either the ALT or CTRL key. For example, the key combinations 
CTRL + Y, ALT + F4, CTRL + SHIFT + FII, and CTRL + ALT + 7 are all valid applica
tion shortcut keys. You cannot specify a key combination that includes the ESC, 
ENTER, TAB, SPACEBAR, PRINT SCREEN, or BACKSPACE keys. 

Once you assign an application shortcut key, when that application is loaded, that 
key combination works only as a shortcut key. This means that no application 
(including Windows, Windows applications, and the application that owns the 
shortcut key) can use that key combination for any other purpose. For this reason, 
you should select application shortcut keys carefully. 

For example, suppose you specify ALT + F as the application shortcut key for 
PFS: ® FirstChoice ®. In many Windows applications, ALT + F acts as a shortcut 
key; it displays the File menu. However, if you are using Notepad when 
FirstChoice is loaded, pressing ALT + F switches FirstChoice into the foreground, 
rather than displaying Notepad's File menu. 

A void assigning the same shortcut key to more than one application. 

[> To specify a shortcut key: 

1. Select the Application Shortcut Key option. 

2. Press the key combination you want. 

Windows will interpret any key combination you press as an application 
shortcut key definition except for keys that allow you to move away from the 
option (such as TAB). 

3. Choose OK. 

If you press an invalid key combination, Windows displays a dialog box telling 
you there is something wrong with the shortcut key definition and sets the key 
definition to its previous value. 
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[> To delete a shortcut key definition: 

1. Select the Application Shortcut Key option. 

2. Press SHIFT + BACKSPACE to set the shortcut key to None. This means that no 
shortcut key is defined for this application. 

Or, while entering a key combination, press BACKSPACE to set the shortcut key 
definition to its previous value. 

Changing Settings for a Running Application 
1 386 I·· The previous sections explained how to use a PIF to change the way a non

Windows application starts and runs. When a non-Windows application is running 
with Windows in 386 enhanced mode, you can also make temporary changes to 
the way the application runs. To do so, you choose Settings from the application's 
Control menu. Your changes stay in effect until you quit the application. 

This section briefly explains the settings you can change while the application 
runs. Most of these settings are similar to settings in the application's PIF; for 
details on each setting, see the appropriate sections earlier in this chapter. 

[> To change settings for a running application: 

1. Choose the Settings command from the application's Control menu. Windows 
displays the following dialog box: 

Display Options 

o ~indow 
@ F!!IIScreen 

Tasking 0 ptions 

D E!!.clusive 

D !!.ackground 

dBASE III 

Priority 

foreground: ~ 

B!!ckground: ~ 

Special------, 

I Ierminatem 

2. Change the appropriate setting. 

The following sections describe the options you can select. 
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Display Options 
Use the Display options to change how the application appears-either in a 
full-screen display or in a window. You can select one of the following options: 

Use this option 

Window 

Full Screen 

To do this 

Move the application into a window. 

Move the application into a full-screen display. 

You can also move a running application from a window to a full-screen display, 
or vice versa, by pressing AL T + ENTER. 

NOTE If you want to use a mouse with a non-Windows application, you must run it full 
screen. When you run a non-Windows application in a window, the mouse functions with 
Windows only. 

Tasking Options 
Use the Tasking options to control how the application shares system resources 
with other applications. You can select one or both of the following options: 

Use this option 

Exclusive 

Background 

Priority Options 

To do this 

Suspend other applications while this application is the 
active application. (If this application is running in a win
dow, Windows applications will continue to run, but other 
non-Windows applications will be suspended.) 

Allow this application to run in the background while 
you are working with other applications. (However, this 
application will still be suspended while you are using an 
exclusive application.) 

Use the Priority options to specify how much processor time the application 
should receive, relative to other applications. Giving the application a high priority 
makes it run faster than applications with lower priorities; conversely, giving it a 
priority lower than other applications will slow it down. 
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You can set the following options: 

Use this option 

Foreground 

Background 

Terminate Option 

To do this 

Control how fast the application runs, relative to other 
applications, when it is the foreground application. 

Control how fast the application runs, relative to other 
applications, when it is the background application. 

For this option to take effect, you must also specify 
Background in the Tasking options. 

Choose Terminate to quit a non-Windows application when you cannot use the 
usual methods from within the application-for example, when the application 
does not respond to the commands you type. Ordinarily, when running from 
MS-DOS, if an application does not respond to your commands, you have to 
restart your computer. Windows provides the Terminate option so that you can 
close the application and then save any open files in other applications. After 
terminating the application and saving other applications' open files, you should 
exit Windows, and then restart your computer by pressing CTRL + ALT + DEL. 

CAUTION Use the Terminate option only as a last resort. Terminating an application 
can result in lost data. If you don't restart your computer after terminating an application, 
Windows and/or MS-DOS may become unstable. 

Freeing Up Memory 
If you get out-of-memory messages when you try to run an application, you can 
free up memory in a number of ways, including the following: 

• Close other applications. 

• Run non-Windows applications in a full-screen display instead of in a window 
(386 enhanced mode only). To move an application from a window to a full
screen display, press ALT + ENTER. 

• Minimize Windows applications to icons. To minimize an application to an 
icon, bring it to the foreground and press ALT + SPACEBAR. Then select the 
Minimize command, or click the Minimize button. 
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Clear or save the Clipboard contents. For more information on using the 
Clipboard, see "Working with Applications" in Chapter 2. 

If you are using a desktop wallpaper, set the desktop wallpaper to None. See 
Chapter 5, "Control Panel," for information. 

Change PIF options for the application you want to run. 

Change PIF options for other non-Windows applications that you want to run 
simultaneously (386 enhanced mode only). 

The following sections explain what PIF options will free memory for non
Windows applications running with Windows in real or standard mode and 
386 enhanced mode, respectively. 

Freeing Memory with Standard PIF Options 

If you are using Windows in real or standard mode, and you get an out-of-memory 
message when trying to run a non-Windows application, first try the techniques 
listed in the previous section. If you still get an out-of-memory message, consider 
changing the following PIF options: 

Option 

Memory Requirements 

XMSMemory 

Prevent Program 
Switch 

Suggested Change 

If Windows displays an out-of-memory message 
when you try to start the application, reduce the 
amount specified in Memory Requirements: 
KB Required. 

If Windows succeeds in starting the application, but 
the application subsequently displays its own out-of
memory message, you might need to free up more 
memory before starting Windows. See Chapter 13, 
"Optimizing Windows." 

If the application does not need extended memory, 
make sure that XMS Memory: KB Required and 
XMS Memory: KB Limit are set to O. 

Select this option to make more memory available 
to the application; however, if you do so, you will 
have to quit the application to return to Windows. 
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Option 

No Screen Exchange 

Video Mode 

Suggested Change 

Select this option to prevent Windows from 
allocating memory for copying information onto 
the Clipboard with PRINT SCREEN or ALT + PRINT 

SCREEN. This makes more memory available for the 
application; however, you will not be able to copy 
this application's display onto the Clipboard. 

Select Video Mode: Text to reduce the amount of 
memory Windows sets aside for the application's 
display. This makes more memory available for the 
application; however, if you change modes while 
using the application, you might not be able to 
switch away from the application. 

Freeing Memory with 386 Enhanced PIF Options 
13861; When Windows is running in 386 enhanced mode, Windows applications and 
, ; non-Windows applications share memory resources. The more memory you give 

to one application, the less is available to others. If you get an out-of-memory 
message when trying to start an application, first try the techniques listed at the 
beginning of this section, "Freeing Up Memory." 

If you still get an out-of-memory message, try changing that application's PIF. 
You can free up memory for an application by changing the following settings in 
its PIF: 

Option 

Memory Requirements 

Suggested Change 

If Windows displays an out-of-memory message 
when you try to start the application, reduce the 
amount specified in the KB Required option. 

If Windows succeeds in starting the application, but 
the application subsequently displays its own out-of
memory message and then terminates, increase the 
amount specified in the KB Required and KB 
Desired options. (An application might also run out 
of memory if it doesn't have enough extended or 
expanded memory. If you suspect this is the case, 
try increasing the amounts in the XMS Memory and 
EMS Memory options.) 
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Display Usage 

Execution 

Display Options 
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Suggested Change 

Select Full Screen instead of Windowed. Windowed 
applications require more memory to run. 

Select the Exclusive option to suspend other 
applications while this application is in the 
foreground. This makes more memory available to 
the application, but prevents other applications 
from running simultaneously. 

Select the Video Memory: Text option if you are 
sure that you will use only Text mode while running 
an application. Text mode requires less memory 
than the other modes. Clear the Retain Video 
Memory option to release reserved memory to the 
system. 

If you still get out-of-memory messages after changing the application's PIF, try 
changing the PIFs for other applications you plan to run at the same time. You can 
free up additional memory for an application by changing the following settings in 
other applications' PIFs: 

Option 

Memory Requirements 

Display Usage 

Execution 

Suggested Change 

Reduce the amount specified in other applications' 
KB Desired options. (Do not reduce it so much that 
the other applications will not be able to run 
effectively.) 

Select other applications' Full Screen options. 

Clear other applications' Background options to 
prevent them from running in the background. This 
makes more memory available to the application 
you want to run, but prevents the other applications 
from running at the same time. 

You might want to do this to prevent particular 
applications from running in the background while 
others continue. To prevent all applications from 
running in the background, it is much easier to 
simply select the foreground application's 
Exclusive option. 
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Option 

Lock Application 
Memory 

Suggested Change 

Clear other applications' Lock options (Lock 
Application Memory, XMS Memory: Locked, and 
EMS Memory: Locked) to release memory to the 
system. This makes more memory available to the 
application you want to run, but might slow down 
the application(s) for which you clear the Lock 
options. 

If you still get out-of-memory messages, see Chapter 13, "Optimizing Windows," 
for more information on freeing up memory. 

If Things Go Wrong 
Most applications will run without problems. However, occasionally, you might 
see error messages when starting or running an application; or, a key or function 
might not work as it should. The following recommendations cover the most 
common trouble areas. 

It You Get Out-ot-Memory Messages 

If you get out-of-memory messages when you try to run a non-Windows applica
tion, see "Freeing Up Memory," earlier in this chapter, for recommendations about 
how to make more memory available to the application. If you follow those recom
mendations, but still cannot get the non-Windows application to run, make sure 
that your system has enough physical memory and is configured correctly. For 
minimum memory requirements, see "What You Need to Run Windows" in the 
introduction of this guide. Chapter 13, "Optimizing Windows," explains how to 
configure your system's memory. 

If you get out-of-memory messages when you try to run a Windows application, 
see Chapter 13, "Optimizing Windows," for information about making more 
memory available to Windows and Windows applications. 

NOTE A few non-Windows applications use extended memory in a way that is 
incompatible with the version of HIMEM.SYS that comes with Windows 3.0. If a non
Windows application will not start because there is insufficient extended memory available, 
first try the methods described in "Freeing Up Memory" earlier in this chapter. If these 
methods do not work, disable the HIMEM.SYS command line in your CONFIG.SYS file, 
restart your computer, start Windows in real mode (by typing win Ir), and restart the 
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application. For information on editing your CONFIG.SYS file, see "Freeing Up Memory 
Before Starting Windows" in Chapter 13. 

If You Cannot Switch from a Non-Windows Application 

If you unable to switch away from a non-Windows application, one of the 
following might be the reason: 

• The application's PIF might reserve one or more Windows shortcut keys for 
the application. 

Quit the application and edit its PIP. So that you can switch from the applica
tion, clear the Reserve Shortcut Keys options for ALT + TAB, AL T + ESC, and 
CTRL + ESC. 

• The application might be using a video mode that Windows does not support. 
Therefore, Windows cannot save and restore the application's display. 

Quit the application and edit its PIP. Try selecting a higher video mode. 

If you are running Windows in real or standard mode, and you are unable to 
switch away from the application, one of the following might be the reason: 

• The Prevent Program Switch option might be selected in the application's PIP. 

Quit the application and edit its PIP. So that you can switch from the applica
tion, clear the Prevent Program Switch option. 

• The wrong video mode might be selected in the application's PIP. 

Quit the application and edit its PIP. Try selecting a higher video mode. 

• If you have an EGA display, the device driver EGA.SYS might not be properly 
installed in your CONFIG.SYS file. EGA.SYS is included with Windows, and 
resides in your Windows system directory. Normally, Setup should install 
EGA.SYS in your CONFIq.SYS file automatically. 

Run Setup again to ensure that EGA.SYS is installed correctly. For infor
mation about running Setup again, see Appendix A, "Using Setup to Maintain 
Windows." For more information about EGA.SYS, see Appendix D, 
"Command Lines in the CONFIG.SYS File." 

• One or more Directly Modifies options might be set in the application's PIF. 

Quit the application and edit its PIF; try clearing one or more Directly 
Modifies options. 
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• The application might be intercepting all keyboard input. Some applications 
intercept keyboard input before Windows can receive and process your 
keystrokes. 

You cannot switch away from such an application; you must quit the applica
tion in order to return to Windows or switch to other applications. 

CAUTION Sometimes an application's PIF contains settings that purposely prevent you 
from switching from that application, because doing so might result in a lost display or lost 
data. Use caution when changing these settings. 

If Your Application Display Is Lost 
If you are running Windows in 386 enhanced mode and you lose the display of a 
non-Windows application, the cause is often one of the following: 

The application might require the Monitor Ports options to be selected in its 
PIP. 

Quit the application, select the appropriate Monitor Ports option in its PIF, and 
restart the application. 

If the application switched to a higher video mode (for example, from text 
mode to graphics mode), there might not be enough memory to accommodate 
the new video mode. 

To prevent this problem from recurring, select a higher Video Memory option 
in the application's PIF; also, select the Retain Video Memory option in the 
application's PIF. 

For more information about these PIF options, refer to the PIF descriptions earlier 
in this chapter. 

If the same thing happens when you are running Windows in real or standard 
mode, the preceding alternatives will not work. 
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If You Get Garbled Data When Using a Communications Application 

When using a non-Windows communications application with Windows, you 
might see garbled data. The cause might be that the baud rate setting is too high 
for your application or modem to handle. In this case, you need to do the 
following: 

1. Stop the data transmission. 

2. Check to make sure the remote computer can use a slower baud rate. 

3. Change the baud rate setting in the communications application. 

4. Try running the application again. 

1 3861' If you see garbled data when running a communications application with 
Windows in 386 enhanced mode, you might need to adjust the Device 
Contention options in Control Panel. To do so, start Control Panel and choose 
the 386 Enhanced icon. See Chapter 5, "Control Panel," for more information. 

If You Press a Key and the Unexpected Happens 

If the desired action does not take place when you press a key combination, the 
cause is usually that another running application or Windows is using the key 
combination for another purpose. 

The following is a list of some common problems and solutions: 

• You press a key combination that should perform a function in an application, 
but it instead performs a Windows function (for example, you unexpectedly 
switch to the next application). 

You are probably pressing a Windows shortcut key. If you want that key 
combination to work differently when using a particular application, select the 
Reserve Shortcut Keys option for that shortcut key in the application's PIF. 
(For a list of Windows shortcut keys, see "Reserve Shortcut Keys" earlier in 
this chapter.) 

• You press a Windows shortcut key such as ALT + TAB, but something happens 
other than the normal Windows function. 

The key combination you pressed has probably been reserved for an applica
tion and no longer works as a Windows navigation tool. Check the PIF of the 
foreground application to see if a Windows key combination has been reserved 
for that application. See the Reserve Shortcut Keys options and (if you are 
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running Windows in 386 enhanced mode) the Application Shortcut Key 
option. These options are described earlier in this chapter. 

1386 11 • You press a key combination and unexpectedly switch to a particular applica-
L,,,,k_-,-,J tion (386 enhanced mode only). 

If pressing a particular key combination always switches to the same applica
tion, that key combination is probably assigned to that application as an 
application shortcut key. 

Check that application's PIF. If you want to use the key combination for any 
other purpose, you need to assign the application a different application 
shortcut key. 

13861'1 • If you are running Windows in 386 enhanced mode, and you hear a beep 
k,,,, .. ~,~~"J whenever you press a key while using the application, Windows might have 

suspended that application. This might happen if, for example, you try to 
display the application in a window, but it cannot run in a window. 

To resume using the application, press ALT + ENTER to return it to a full-screen 
display. 

• If you are running Windows in 386 enhanced mode and the application's title 
contains the word "Select" or "Mark," Windows is expecting you to select 
information for transfer onto the Clipboard. To return to the application, press 
ESC, click the right mouse button in the application window, or complete the 
copy operation. 

1386 t • If you are running Windows in 386 enhanced mode and the application's title 
contains the word "Scroll" or "Mark," Windows is expecting you to use the 
keyboard to scroll the information in the application's window. To return to the 
application, press ESC. 

If an Application Is Abnormally Slow 

If a Windows application is running very slowly, your system is probably low on 
memory. You can tell that there's not enough memory when your system's disk 
light is frequently lit. This indicates that Windows is swapping information to disk 
to make room in memory for other information, or that Windows is re-reading 
information from the disk into memory. For information on making more memory 
available, see "Freeing Up Memory" earlier in this chapter and Chapter 13, 
"Optimizing Windows." 
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If a non-Windows application is running very slowly, there are several possible 
causes: 

• The application was not given enough memory when it was started. Although it 
can run with that amount of memory, it runs more slowly. 

Free up some memory before running Windows. Windows cannot give a non
Windows application any more conventional memory than was available when 
you started Windows. Therefore, freeing up memory before starting Windows 
can make more memory available to each non-Windows application. Chapter 
13, "Optimizing Windows," explains how to free up memory before you start 
Windows. 

I 386 I If you are running Windows in 386 enhanced mode, try increasing the KB 
Required and KB Desired settings in the application's PIF. 

13861· • Windows is not giving the application enough of the computer's processor time 
(386 enhanced mode only). 

The application might not be getting enough processor time, or other running 
applications are getting too much processor time. To reallocate processor time, 
choose the Settings command in the application's Control menu and change 
the Background or Foreground option while the application is running. Or 
change the Foreground Priority and Background Priority options in the 
application's PIF. (You might also want to change the Priority options for 
other applications that you plan to run at the same time as this application.) 

Sometimes Windows applications might use more processor time than you 
want. To make more time available to a non-Windows application, change it to 
exclusive status. To do so, select the Exclusive option in the application's PIF, 
or choose the Settings command in the application's Control menu and select 
Exclusive. 

13861 • Windows is incorrectly treating that application as idle (386 enhanced mode 
only). 

Occasionally, Windows interprets a non-Windows application's pauses for 
maintenance activity as idle time. When Windows thinks an application is idle, 
it gives more processing time to other applications; this slows down an active 
application. To prevent Windows from trying to tell whether the application is 
idle, clear the Detect Idle Time option in the application's PIF. 
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If You Cannot Take a Snapshot of the Screen 
If you are having trouble moving or copying information onto the Clipboard, one 
of the following might be the cause: 

• If you are running Windows in real or standard mode, the No Screen Exchange 
option might be selected in the application's PIF. This option prevents you 
from copying information onto the Clipboard using PRINT SCREEN or 
ALT + PRINT SCREEN. This option might have been set to give the application 
enough memory to run. Try clearing this option, starting the application, and 
copying the information again. 

• The PRINT SCREEN or ALT + PRINT SCREEN key combinations, normally 
Windows shortcut keys, might have been reserved for an application. Try 
clearing the corresponding Reserve Shortcut Key options in the foreground 
application's PIF. 

• If you are running Windows in real or standard mode, the wrong Video Mode 
option might be selected in the application's PIP. Try selecting a higher video 
mode. 

I 386 P • If you are running Windows in 386 enhanced mode, it might not have enough 
memory to perform this activity. Close some applications and, if necessary, 
refer to "Freeing Up Memory" earlier in this chapter. 

If You Cannot Paste Information Properly 
A number of situations can affect Windows' ability to paste information from the 
Clipboard into an application. The following list explains some common problems: 

• The information on the Clipboard might not be in Text format. (Windows 
cannot paste graphics into a non-Windows application.) 

Try saving the information you want to paste as a separate file and then 
reading that file into the application. 

I ,386 I: • The application might be unable to accommodate the fastest pasting method. 

If you are running Windows in 386 enhanced mode, the Allow Fast Paste 
option in the application's PIF is normally selected, since most applications 
can accommodate the fastest pasting method. However, if the application can
not use the fastest method, it might not respond when you try to paste into it. 
Try quitting the application, clearing the Allow Fast Paste option in the 
application's PIF, restarting the application, and doing the paste again. 
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If Your Application Remains on the Screen When You Close It 

Nonnally, when you quit a non-Windows application, Windows clears the 
application's display automatically. However, if the Close Window on Exit option 
is not selected in the application's PIF, the application's display will remain on the 
screen even though the application is no longer running. 

If you are running Windows in real or standard mode, you can clear the screen 
and return to Windows by pressing any key or clicking a mouse button. If you are 
running Windows in 386 enhanced mode, you can remove the inactive application 
window by double-clicking the window's Control menu icon. 

To allow Windows to remove the application's display automatically, edit the 
application's PIF and select the Close Window on Exit option. 

If You Cannot Quit an Application 

Occasionally, a non-Windows application might encounter an error, so that you 
cannot exit the application nonnally. In that case, first try pressing CTRL + C or 
CTRL + BREAK. 

If pressing CTRL + C or CTRL + BREAK does not work, try tenninating the appli
cation using the End Task command in the Task List. 

[> To terminate an application using the End Task command: 

1. Press ALT + TAB to switch back to Windows. 

2. Press CTRL + ESC to display the Task List. 

3. Select the application from the Task List. 

4. Choose End Task to tenninate the application. 

If you cannot switch back to Windows, then you will not be able to exit Windows 
nonnally. Restart your computer by pressing CTRL + AL T + DEL. 

If you are running Windows in 386 enhanced mode, you can also terminate the 
application using the Terminate option in the application's Control menu. 
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[:> To terminate an application using the Terminate option: 

1, Display the application in a window by pressing ALT + SPACEBAR. 

2. Choose the Settings command from the Control menu. 

3. Choose Terminate. 

CAUTION Use the End Task and Terminate options only as a last resort. Terminating an 
application can result in lost data. 

If Your System Stops Responding or Terminates Unexpectedly 

If your current application, Windows, or your computer stops responding, the 
application or Windows terminates unexpectedly, or your computer restarts 
unexpectedly, one of the following may be the cause: 

• You are running an older Windows application that is incompatible with 
Windows 3.0. Try running the application after starting Windows in real mode 
(by typing win Ir). For more information about running older Windows applica
tions, see "Windows Applications" earlier in this chapter. 

• Your computer is connected to a network that does not support Windows, and 
you are running a Windows or non-Windows application that accesses the 
network directly. For additional information, see Chapter 14, "Networks and 
Windows." 

• You are using hardware that is incompatible with Windows. See the Hardware 
Compatibility List supplied with Windows for more information on hardware 
compatibility. Sometimes, you can get around a hardware incompatibility by 
adjusting settings in your SYSTEM.INI file. For more information about 
SYSTEM.INI, use Notepad to open the SYSINI.TXT file. 
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What Is Optimizing? 
Optimizing is customizing your system so that it uses its resources most efficiently 
for the tasks you usually perform. Typically, optimizing involves improving one or 
more aspects of your system's performance, but sometimes sacrificing something 
else. For example, you might improve your system's capacity, but have less disk 
space available as a result. In Microsoft Windows, optimizing your system usually 
means balancing the following performance factors: 

Performance factor 

Speed 

Capacity 

Free disk space 

What it affects 

Your system's speed affects the time it takes for 
Windows or an application to start up, carry out a 
task, redisplay a window, and so on. 

Your system's capacity determines how many 
applications you can run simultaneously, and how 
much data applications can store in memory at a 
time. 

The amount of available disk space can affect your 
hard disk's speed and efficiency. In addition, some 
applications need extra disk space to store tem
porary files while they run. When running in 386 
enhanced mode, Windows can also use some of 
your available disk space to increase your system's 
capacity; you might want to control how much disk 
space Windows uses for this purpose. 

The most important thing you can do to improve Windows' performance is to 
configure your system's memory properly. After you configure your system's 
memory for optimum performance with Windows, you can use other procedures 
and utilities to improve performance further. For information about configuring 
memory, see "Configuring Your System's Memory" later in this chapter. For infor
mation about optimization procedures, see "Optimizing Your System" later in this 
chapter. 
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What Are System Resources? 
Your system's resources determine its limitations. Most computers have two types 
of system resources: disk space and memory. In Windows, the available resources 
can affect: 

• Which applications you can run. 

• How many applications you can run simultaneously. 

• How fast Windows and applications run. 

• How much data you can store from one session to the next. 

The sections that follow explain each resource and how Windows uses it. 

Understanding Memory 

Memory provides temporary storage for applications and data. It exists on your 
computer's main system board or on add-in memory boards. All applications must 
be loaded into memory in order to run. 

In general, the more memory you have, the more applications you can run with 
Windows at a time. You can increase the amount of memory on your system by 
plugging a memory board into a slot inside the machine. For example, you might 
add a 2MB memory board to a system that already has 1MB of memory. 

Your system may have up to three different kinds of memory: 

• Conventional memory 

• Extended memory 

• Expanded memory 

The sections that follow explain each type of memory. 

Conventional Memory 
Conventional memory exists on all 8086, 8088, 80286, 80386, and 80486-based 
computers. Most computers have at least 256K of conventional memory, and can 
accommodate up to 640K of conventional memory. 

When you start MS-DOS, it uses up some of your computer's conventional 
memory. Next, MS-DOS starts the utilities and applications listed in your 
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CONFIG.SYS and AUTOEXEC.BAT files. These utilities and applications use up 
more conventional memory. The memory that is left over is available for running 
applications (including Windows). 

Extended Memory 
One way to add more memory to your system is to install extended memory. 
Extended memory is general-purpose memory beyond 640K on 80286, 80386, 
and 80486 computers. In effect, it is a simple extension of your computer's 
conventional memory. (Many 80286 and 80386 computers come with 640K of 
conventional memory and 256K of extended memory, for a total of 1MB of 
memory.) 

To use extended memory efficiently, you should install a special program called 
an extended memory manager. An extended memory manager "administrates" the 
use of your system's extended memory, so that several programs do not try to use 
the same memory at the same time. An extended memory manager is required in 
order to run Windows in standard or 386 enhanced mode. Windows includes the 
extended memory manager HIMEM.SYS. 

Extended memory is very fast and efficient for applications to use. However, 
many non-Windows applications are not designed to use extended memory. 

When running in standard or 386 enhanced mode, Windows takes full advantage 
of extended memory and its performance benefits. Because of this, Windows runs 
best if extended memory is available. (When running in real mode, Windows uses 
extended memory only for storing information that would otherwise be discarded 
and later read back from the disk.) 

Expanded Memory 
Another way to add memory in excess of 640K to your system is to install 
expanded memory. Most personal computers can accommodate expanded 
memory. Expanded memory exists separately from your system's conventional 
and extended memory. 

To use expanded memory, you must install a special program called an expanded 
memory manager, which comes with the expanded memory board. The expanded 
memory manager is necessary because, in order to gain access to expanded 
memory, applications (including Windows) must request it from the expanded 
memory manager. 

Some applications are unable to use expanded memory because they were not 
designed to interact with an expanded memory manager. However, because 
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expanded memory was introduced before extended memory, more applications are 
designed to use expanded than extended memory. 

Because an expanded memory manager gives applications access to only a limited 
amount of expanded memory at a time, expanded memory is slower and more 
cumbersome to use than extended memory. Therefore, Windows uses expanded 
memory only when running in real mode. (When running in 386 enhanced mode, 
Windows can simulate expanded memory for applications that require it, even if 
your system does not have any expanded memory.) 

In real mode, Windows uses only expanded memory that conforms to version 4.0 
of the Lotus-Intel-Microsoft Expanded Memory Specification (LIM EMS 4.0). 
(However, Windows applications can use LIM EMS 3.2 for storing data in 
memory.) Windows uses expanded memory primarily for storing background 
applications. 

Some expanded memory boards, such as the AST RAMpage! ® AT or Intel 
Above ™ Board/AT, can be set up with extended memory, with expanded 
memory, or with both. For most systems, Windows runs best if you set up your 
expanded memory board with all extended memory. For details, see "Configuring 
Y our System's Memory" later in this chapter. 

For additional information about expanded memory, see "Controlling Windows' 
Use of Expanded Memory" later in this chapter. 

Identifying Your System's Memory Configuration 
It's important to know how much and what type of memory your computer 
has. As explained earlier in this chapter, your system's memory configuration 
significantly affects your system's speed and capacity. 

The best way to identify your system's memory configuration is to use a utility or 
diagnostics program that is designed specifically for your computer. Most com
puters and memory boards come with utility programs that tell you exactly what 
types of memory you have and how much of each type you have. Some programs 
even let you change your memory configuration. For more information on the 
program(s) that came with your computer, consult the documentation that accom
panied your computer and any memory boards you have installed. 

Understanding Disk Space 

Disks provide long-term and temporary storage for program files and data files. 
The most common types of disk media are diskettes and hard disks. Applications 
and other files are stored on these media magnetically, much as information is 
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stored on a cassette tape. In this chapter, disk space refers to space that is available 
on your hard disk. 

It's best if there is some disk space left after you have installed all the software 
and data files you need. There are several reasons you might need free disk space: 

• You need disk space to save documents and other data files. 

• Some applications use available disk space to store temporary files and data 
while they're running. 

• When low on memory, Windows and some applications can use free disk space 
to temporarily store information that does not fit in memory. See the following 
sections for more information on how Windows uses free disk space. 

Disk Space and 386 Enhanced Mode 
I ,386iJ When running in 386 enhanced mode, Windows can simulate additional memory 

by swapping. Swapping involves moving information between memory and the 
hard disk to make room in memory for other information. Using swapping, 
Windows can provide much more memory than your system physically has. 

When Windows swaps information to the hard disk, it stores the information in a 
swap file. A swap file is a hidden file that reserves space on the hard disk for 
Windows to use for swapping. 

The amount of available disk space determines how large your swap file can be. 
The larger the swap file, the more memory Windows can provide. For more infor
mation about swap files, see "Working with Windows Swap Files" later in this 
chapter. 

Disk Space, Real Mode, and Standard Mode 
In real mode or standard mode, each time you start a non-Windows application, 
Windows creates a temporary application swap file for that application. When you 
switch away from the application, Windows moves some or all of the application 
from memory to the application swap file. This helps make your system's memory 
resources last longer. When you exit Windows, it deletes any application swap 
files it created during that session. (Windows does not use application swap files 
when running in 386 enhanced mode.) 

The amount of available disk space determines how many application swap files 
Windows can create; this, in tum, determines how many non-Windows applica
tions you can start before running out of memory. For more information about 
application swap files, see "Working with Application Swap Files" later in this 
chapter. 
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Checking Your System's Disk Space 
It's often useful to know how much disk space is available on your system. As 
explained earlier in this chapter, the amount of free disk space can affect your 
ability to store files and data. The amount of available disk space can even affect 
your system's capacity for running multiple applications. 

Often, there will be less free disk space when you are running Windows than when 
you are not running Windows. This is because Windows uses swap files, which 
take up some disk space. (See the previous sections for more about how Windows 
uses disk space.) To tell how much disk space Windows is using, compare the 
amount of free disk space when Windows is running to the amount of free disk 
space when Windows is not running. 

I 386 I If you are running Windows in 386 enhanced mode, you can limit the size of your 
Windows swap file to conserve disk space. For more information, see "Working 
with Windows Swap Files" later in this chapter. 

[> To check the amount of free disk space when Windows is running: 

1. Choose the File Manager icon from the Main Group in Program Manager. 

2. Choose the disk-drive icon for the drive you want to check. 

For example, to find out how much disk space is free on drive D, you would 
choose the D disk-drive icon. 

In the status bar at the bottom of the File Manager window, you'll see a 
number that indicates how many bytes of disk space are currently available 
on that disk drive. (If the status bar does not appear, you can display it by 
choosing Status Bar from the Options menu.) 

[> To check the amount of free disk space when Windows is not running: 

1. Exit Windows. 

2. Type the MS-DOS command dir at the DOS prompt. 

MS-DOS displays information about the files in your current directory. The 
last line of information tells you how many bytes of disk space are free on that 
drive. 
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Configuring Your System's Memory 
The most effective way to improve how Windows runs on your system is to 
configure your system's memory correctly. There are many ways to configure 
memory for maximum efficiency with Windows. The best configuration for you 
will depend on the type of computer you have, which Windows mode you use, 
and the memory requirements of the applications you run. 

Your system's memory configuration consists not only of the hardware that's 
installed in your system; it also includes the software settings and utilities listed 
in your CONFIG.SYS file. When you install Windows on your computer, Setup 
checks the settings in your computer's CONFIG.SYS file. If necessary, Setup 
updates your CONFIG.SYS file so that it includes the necessary settings and 
command lines. 

The following sections provide basic recommendations for configuring different 
types of computers for use with Windows. Each section describes the memory 
your system should have, and lists the command lines your CONFIG.SYS file 
should contain. After reading the configuration section that applies to your com
puter, see "Optimizing Your System," later in this chapter, for ways you can 
further improve Windows' performance on your system. 

Configuring an 80386 or 80486 Computer 

When you start Windows on an 80386 or 80486 computer, Windows checks to 
see how much memory is available, and starts in the mode most appropriate for 
your system. If your system has at least 2MB of memory, Windows runs in 
386 enhanced mode; with between 1MB and 2MB, Windows runs in standard 
mode; and with less than 1MB, Windows runs in real mode. (To find out what 
mode Windows is running in, choose the About Program Manager command 
from the Help menu in Program Manager.) 

To run Windows most efficiently, your 80386 or 80486 computer should have the 
following memory: 

• 640K of conventional memory. 

• Extended memory, if possible. The more extended memory your system has, 
the better. 

To run Windows in standard mode, you'll need at least 256K of extended 
memory. 
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To run Windows in 386 enhanced mode, you'll need at least 1024K of 
extended memory. 

• If you have a configurable expanded memory board, you should reconfigure it 
all as extended memory. (See the documentation that came with your expanded 
memory board for information on how to reconfigure it.) 

Your CONFIG.SYS file should contain the following command lines: 

• A command line for an extended memory manager such as HIMEM.SYS. 

To use extended memory, Windows requires HIMEM.SYS or a compatible 
memory manager. When you install Windows, Setup automatically installs 
HIMEM.SYS, and adds the HIMEM.SYS command line to your 
CONFIG.SYS file. 

• A command line for the expanded memory manager that came with your 
expanded memory board, if you have one. For details, consult the documen
tation that accompanied your expanded memory board. 

• A command line for the SMARTDrive disk-caching utility. 

Windows runs much faster if you use SMARTDrive. "Using SMARTDrive," 
later in this chapter, explains how to install and optimize SMAR TDrive. 

• The FILES command line. You should set FILES = 30. 

• The BUFFERS command line. In general, you should set BUFFERS = 20 or 
less. If you are using SMARTDrive, you can set BUFFERS = 10. 

• If necessary, a command line for the expanded memory emulator 
EMM386.SYS. 

An expanded memory emulator is a software utility that converts extended 
memory into expanded memory. For more information, see "Installing the 
EMM386 Expanded Memory Emulator" later in this chapter. 

• If necessary, a command line for the device driver EGA.SYS. 

If your system has an EGA monitor and you run non-Windows applications 
with Windows in real mode or standard mode, your CONFIG.SYS file should 
contain a command line like the following: 

device = c:\windows\ega.sys 

Configuring an 80286 Computer 

When you type win on an 80286 computer, Windows checks your system 
configuration. If your computer has at least 1MB of memory, Windows runs in 
standard mode. Otherwise, Windows runs in real mode. 
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80286 computers can accommodate two types of additional memory: expanded 
and extended. You can configure most expanded memory boards so that they 
provide all expanded memory, all extended memory, or a mixture of both. How
ever, you cannot reconfigure most extended memory boards; they provide only 
extended memory. 

To run Windows most efficiently, your 80286 computer should have the following 
memory: 

• At least 1MB of memory, consisting of the following: 

640K of conventional memory. 

At least 256K of extended memory. The more extended memory your 
system has, the better. 

• As much expanded memory as necessary for applications that require it. 

Some applications require expanded memory. To run such an application on an 
80286 computer-either with Windows or from MS-DOS-your system must 
include as much expanded memory as the application needs. 

If your 80286 system has a configurable expanded memory board, you should 
configure it so that it provides only as much expanded memory as the applica
tions need. To improve Windows' performance, configure any additional 
memory as extended. (See the documentation that came with your expanded 
memory board for information on how to reconfigure it.) 

Your CONFIG.SYS file should contain the following command lines: 

• A command line for an extended memory manager such as HIMEM.SYS. 

To use extended memory, Windows requires HIMEM.SYS or a compatible 
memory manager. When you install Windows, Setup automatically installs 
HIMEM.SYS in your Windows directory, and adds the HIMEM.SYS 
command line to your CONFIG.SYS file. 

• A command line for the expanded memory manager that came with your 
expanded memory board, if you have one. For details, consult the documen
tation that accompanied your expanded memory board. 

• A command line for the SMARTDrive disk-caching utility. 

Windows runs much faster if you use SMARTDrive. "Using SMARTDrive," 
later in this chapter, explains how to install and optimize SMARTDrive. 

• The FILES command line. You should set FILES = 30. 

• The BUFFERS command line. In general, you should set BUFFERS = 20 or 
less. If you use SMARTDrive, you can set BUFFERS = 10. 
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• If necessary, a command line for the device driver EGA.SYS. 

If your system has an EGA monitor and you run non-Windows applications 
with Windows in real mode or standard mode, your CONFIG.SYS file should 
contain a command line like the following: 

device = c:\windows\ega.sys 

Configuring an 8086 or 8088 Computer 

On an 8086 or 8088 computer, Windows runs only in real mode. To run Windows 
most efficiently, your 8086 or 8088 computer should have the following memory: 

• At least 640K of conventional memory. 

• As much expanded memory as possible. For Windows to use it, the expanded 
memory must confonn to the LIM EMS 4.0 standard. 

Your CONFIG.SYS file should include the following command lines: 

• A command line for the expanded memory manager that came with your 
expanded memory board, if you have one. For details, consult the documen
tation that accompanied your expanded memory,board. 

• A command line for the SMARTDrive disk-caching utility, if you have 
expanded memory. 

Windows runs much faster if you use SMARTDrive. "Using SMARTDrive," 
later in this chapter, explains how to install and optimize SMARTDrive. 

• The FILES command line. You should set FILES = 30. 

• The BUFFERS command line. In general, you should set BUFFERS = 20 or 
less. If you are using SMARTDrive, you can set BUFFERS = 10. 

• If necessary, a command line for the device driver EGA.SYS. 

If your system has an EGA monitor and you run non-Windows applications 
with Windows in real mode or standard mode, your CONFIG.SYS file should 
contain a command line like the following: 

device = c:\windows\ega.sys 
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Optimizing Your System 
Before you begin optimizing your system, you should consider how you use 
your system and Windows. You also need to decide what aspects of system per
formance are most important to you: speed, capacity, and/or disk space. This will 
depend on which applications you use and what you do with them. 

::oJ 

For example, if you normally use a single spreadsheet to manage small amounts of 
information, speed will probably be most important to you. On the other hand, if 
you need to run a database, a word processor, and a communications application 
simultaneously, it will be more important to have enough memory capacity to load 
all three at once. And, if you are running applications that need extra disk space, 
you'll also want to be sure you have enough extra disk space to run those applica
tions. Remember to consider the requirements of the applications you want to use. 

Once you've decided whether to optimize your system for speed, capacity, free 
disk space, or a combination of these, you need to decide which methodes) to use 
to optimize your system. There are several different methods; most have both 
advantages and drawbacks. For example, using SMARTDrive provides improved 
speed, but can reduce your system's capacity. 

Some optimization methods, such as using SMARTDrive, will be useful for 
almost everyone. Other methods will help only if you use a specific type of ap
plication or have a particular system configuration. The following list shows the 
methods you can use, what aspect(s) of your system each method improves, and 
when you would want to use each method. (The methods appear in order of 
importance. ) 

NOTE Although many of these optimization methods are effective in themselves, the most 
effective way to improve your system's performance is to configure your system's memory 
correctly for the way you use Windows and the types of applications you use. For more infor
mation, see "Configuring Your System's Memory" earlier in this chapter. 
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What It 
Method Improves When to Use It 

Install additional Speed and If you have an 80286, 80386, 
extended memory capacity or 80486 computer. See 

"Configuring an 80386 or 
80486 Computer" and 
"Configuring an 80286 
Computer" earlier in this 
chapter. 

Free up memory before Capacity and If you want to make more con-
starting Windows speed ventional memory available to 

Windows and applications. 
See "Freeing Up Memory 
Before Starting Windows" 
later in this chapter. 

Install SMARTDrive Speed If your computer has a 
hard disk and extended or 
expanded memory. On most 
systems, Windows runs much 
faster if you install 
SMARTDrive. (However, in-
stalling SMARTDrive might 
result in decreased capacity.) 
See "Using SMARTDrive" 
later in this chapter. 

Compact your hard disk Speed You should compact your disk 
regularly for good disk main-
tenance. You should also 
compact your disk before 
installing Windows on it, and 
before creating a permanent 
swap file on it. See "Improving 
the Efficiency of Your Hard 
Disk" later in this chapter. 

Free up disk space Disk space If you are low on disk space. 
There are several ways to free 
up disk space. See "Improving 
the Efficiency of Your Hard 
Disk" later in this chapter. 
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What It 
Method Improves When to Use It 

Use a permanent Speed If you run Windows in 386 
Windows swap file enhanced mode and do not 
instead of a temporary mind reserving disk space for 
one Windows' exclusive use. A 

permanent swap file is very 
fast, but takes up disk space 
even when Windows is not 
running. See "Working with 
Windows Swap Files" later in 
this chapter. 

Use a temporary Disk space and If you run Windows in 386 
Windows swap file capacity enhanced mode and do not 
instead of a permanent want to reserve disk space for 
one Windows' use. A temporary 

swap file is much slower than 
a penn anent swap file, but 
does not take up disk space 
when Windows is not running. 
See "Working with Windows 
Swap Files" later in this 
chapter. 

Tell Windows to create Capacity If you run Windows in real or 
application swap files standard mode and you have 
on a hard disk with more than one hard disk. See 
more free space "Working with Application 

Swap Files" later in this 
chapter. 

Tell Windows to create Speed If you run Windows in real or 
application swap files standard mode and you have 
on a faster hard disk more than one hard disk. See 

"Working with Application 
Swap Files" later in this 
chapter. 

Install RAMDrive Speed and disk If you have a diskless work-
space station. A RAM disk can also 

improve speed if you run 
applications that use many 
small temporary files. 
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What It 
Method Improves When to Use It 

Set your TEMP Speed If you run applications that 
environment variable store temporary files in the 
to a faster hard disk or directory specified by the 
to a RAM disk TEMP variable. See "Using 

the TEMP Environment 
Variable" later in this chapter. 

Change your hard disk Speed If you are running 
controller's interleave SMARTDrive and your hard 

disk still responds sluggishly. 
See "Improving the Efficiency 
of Your Hard Disk" later in 
this chapter. 

Install EMM386 Ability to If you have an 80386 or 80486 
run certain computer and run applications 
applications that require expanded memory 

when you are not running 
Windows in 386 enhanced 
mode. See "Installing the 
EMM386 Expanded Memory 
Emulator" later in this chapter. 

Install additional Capacity If you have an 8086 or 8088 
expanded memory computer, or if you have an 

80286 computer and want to 
run applications that require 
expanded memory. See 
"Configuring an 80286 
Computer" and "Configuring 
an 8086 or 8088 Computer" 
earlier in this chapter. 

Fine-tune Windows' Speed and If you have expanded memory 
use of expanded capacity and you run Windows in real 
memory mode. See "Controlling 

Windows' Use of Expanded 
Memory" later in this chapter. 

The rest of this section explains each method. 
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Improving the Efficiency of Your Hard Disk 

As explained earlier in "Understanding Disk Space," the amount of free disk space 
can affect your system's performance and capacity. In addition, it is important that 
the information on your disk be structured as efficiently as possible. 

You can use the following methods to improve your hard disk's efficiency: 

• Delete files you don't need. 

If your disk is getting full, you should delete files you don't need or use often. 
Depending on how you use Windows, you might want to delete certain 
Windows files to free disk space. The following section lists the Windows files 
you might want to delete. 

• Run the CHKDSK utility to recover lost disk space. 

Running CHKDSK can fix lost file clusters that are taking up space on your 
hard disk. 

• Compact your hard disk. 

Running a disk-compaction utility reorganizes the file structure on your hard 
disk, so that all the free disk blocks are together. This can greatly improve your 
system's speed. 

• Change your hard disk controller's interleave. 

A disk's interleave affects how many times the disk must revolve in order for 
an entire disk track to be read. An improperly interleaved hard disk can be 
slow and inefficient. 

The following sections explain each method. 

NOTE If you run Windows in 386 enhanced mode, you can also conserve disk space by 
preventing Windows from swapping any information to disk. You should do this only if disk 
space is at a premium, since it can drastically reduce your system's capacity. To prevent 
Windows from swapping, edit your SYSTEM.INI file and set Paging=No in the [386enh] 
section of the file. For more information on changing SYSTEM.INI, open the file SYSINI,TXT 
with a text editor such as Notepad. 

Deleting Unnecessary Files 
As explained in "Understanding Disk Space" earlier in this chapter, disk space is a 
valuable system resource. With Windows, free disk space can provide not only 
storage for files; it can provide additional capacity for running applications. 
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If you need more disk space, an easy solution is to delete some unnecessary files. 
There are three categories of files you might want to delete: 

• Application files, documents, or utilities that you no longer need or use. 

• Temporary files that were left on your hard disk when an application or 
Windows terminated unexpectedly. 

• Windows files that were installed automatically by Setup, but which you do not 
need or plan to use. See the list later in this section for details. 

CAUTION Do not delete any Windows files other than the ones listed later in this 
section. 

Basic Recommendations 

• It is particularly important to delete unnecessary files before compacting a hard 
disk. 

• In general, keep as much disk space free as possible. 

Advantages 

• Frees up disk space. 

• Easy to do. 

• Can improve your system's capacity for running both Windows and non
Windows applications, if Windows is running in 386 enhanced mode with a 
temporary swap file. 

• Can allow you to start a larger number of non-Windows applications, if 
Windows is running in real mode or standard mode. 

Disadvantages 

• Makes some Windows features unavailable, if you delete Windows files. 
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[> To delete unnecessary files: 

1. While running Windows, exit all applications except Program Manager and 
File Manager. If you plan to delete Windows wallpaper files, use Control Panel 
to set your desktop wallpaper to None. 

2. If you want, use File Manager to delete any unwanted application files or docu
ments. For information on using File Manager, see Chapter 4, "File Manager." 

At the end of this procedure is a list describing the Windows files you can 
delete if you do not plan to use them. 

3. Exit Windows and all applications. 

4. Delete any files that remain in your TEMP directory, the directory that applica
tions use to store temporary files. (If you have a TEMP directory, it is specified 
in your AUTOEXEC.BAT file using the SET TEMP command.) 

You should periodically clean out your TEMP directory. To avoid deleting a 
temporary file that is currently in use, you should delete files in your TEMP 
directory only when you are not running Windows or any applications. 

5. Delete any files that start with the characters ""WOA. These files are applica
tion swap files. Normally, Windows deletes application swap files when you 
exit the associated applications; however, these files might remain on your 
hard disk if Windows terminates unexpectedly. You can safely delete applica
tion swap files if Windows is not currently running. 

6. Delete any file named WIN386.SWP. This file is a temporary Windows swap 
file. Normally, Windows deletes it when you exit Windows. However, a 
temporary Windows swap file might be left on your hard disk if Windows 
terminates unexpectedly. You can safely delete WIN386.SWP if Windows is 
not currently running. (Do not delete files named 386SPART.PAR or 
SPART.PAR.) 

7. If your system is very short on disk space, you might want to delete some 
Windows files in order to conserve disk space. See the list that follows this 
procedure for more information on files you can delete. 
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You can delete the following Windows files if you do not plan to use them: 

Filename(s) 

*.BMP 

SOL.EXE, SOL.HLP 

REVERSI.EXE, REVERSI.HLP 

MSDOS.EXE 

PBRUSH.EXE, PBRUSH.HLP 

WRITE.EXE, WRITE.HLP 

CALENDAR.EXE, 
CALENDAR. HLP 

CALC.EXE, CALC.HLP 

CARDFILE.EXE, CARDFILE.HLP 

TERMINAL.EXE, TERMINAL.HLP 

RECORDER.EXE, 
RECORDER.HLP, 
RECORDER.DLL 

CLOCK.EXE 

EMM386.SYS 

Running the CHKOSK Utility 

Description 

Bitmap files with the .BMP filename 
extension. Setup automatically 
installs several bitmap files for use as 
desktop wallpaper. 

Solitaire game and its help text. 

Reversi game and its help text. 

The MS-DOS Executive. 

Paintbrush accessory and its Help 
text. 

Write accessory and its Help text. 

Calendar accessory and its Help text. 

Calculator accessory and its Help 
text. 

Cardfile accessory and its Help text. 

Terminal accessory and its Help text. 

Recorder accessory, its Help text, and 
its dynamic-link library. 

Clock accessory. 

Expanded memory emulator. 

The MS-DOS utility CHKDSK can fix lost file clusters that are taking up space on 
your hard disk. Files can get "lost" when an application terminates unexpectedly, 
leaving temporary files on the hard disk without saving or deleting them properly. 
Over time, lost files can accumulate and take up disk space. 

When you run CHKDSK with the IF option, it finds and fixes any lost files. If you 
want, CHKDSK converts them to visible files that you can examine and delete. 
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CAUTION Always exit Windows before running CHKDSK with the IF option; never run 
CHKDSK IF from within Windows. Loss of data might result. 

Basic Recommendations 

• Run CHKDSK IF occasionally to make sure there are no lost file clusters on 
your disk. 

• Run CHKDSK IF before compacting your disk. 

• You also might want to run CHKDSK IF after an application terminates 
unexpectedly. 

Advantages 

• Frees up disk space. 

• Easy to do. 

I 386 I • Can improve your system's capacity for running applications, if you are 
running Windows in 386 enhanced mode with a temporary swap file. 

Disadvantage 

• Must not be run from Windows. 

[> To clean up lost files using CHKDSK: 

1. Exit from Windows. 

2. Change to the hard disk you want to clean up. For example, to clean up files on 
your drive D, you would type d: at the DOS prompt. 

3. Enter the command chkdsk If 

The IF option tells CHKDSK to fix any lost file clusters it finds. 

4. If CHKDSK finds any lost clusters, it asks if you want to convert the lost 
clusters to files. If you want to inspect the contents of the lost clusters before 
deleting them, type y for Yes. (If you are sure the lost clusters do not contain 
information you want, type n for No. CHKDSK will then simply delete the 
information; you can then skip the remaining steps in this procedure.) 

If you answer y, CHKDSK converts any lost file clusters to visible files with 
filenames similar to FILEOOO1.CHK. It puts the files it finds in the disk's root 
directory. CHKDSK also displays information about the disk it just checked. 
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5. Use the MS-DOS TYPE command to examine the .CHK files. For example, to 
examine the file FILEOOOl.CHK, you would type typefile0001.chk at the DOS 
prompt. (To interrupt the TYPE command, press CTRL + c.) 

Sometimes, a .CHK file might contain information you want to keep. For 
example, if a word processing application terminated before you saved your 
edits, you might find your lost edits in a recovered CHKDSK file. 

6. Delete any .CHK files you don't want. 

Compacting Your Hard Disk 
Over time, as applications read from and write to your hard disk, information on 
your disk can become fragmented. Fragmentation occurs when a file, instead of 
being stored in a single location, is broken into fragments that are stored in 
different locations on the disk. Although fragmentation doesn't affect the validity 
of the information-your files are still complete when you read them into an 
application-it takes much longer to read them from the disk. It also takes longer 
for applications to write files back to the disk. 

To compact your hard disk, you run a disk-compaction utility. Disk-compaction 
utilities reorganize the information on your disk so that all the information in each 
file is stored as close together as possible. This makes reading from and writing to 
your hard disk much more efficient. 

CAUTION Run disk-compaction utilities directly from MS-DOS, after exiting Windows. 
Never run a disk-compaction utility from Windows; damage to the files on your hard disk 
might result. 

Basic Recommendations 

• You should compact your hard disk(s) regularly to help keep your system's 
performance from degrading due to fragmentation. 

• You should compact a hard disk immediately before installing Windows on it. 

• You should compact a hard disk before creating a permanent Windows swap 
file on it. 

• It is a good idea to delete any unnecessary files, and then run CHKDSK IF, 
before compacting a hard disk. . 
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Advantages 

• Makes it faster to read and write files on the hard disk. This, in tum, speeds up 
your system's perfonnance. 

• Can significantly speed up the time it takes for Windows and applications to 
start up. 

• Easy to do. 

• Can allow you to create a larger penn anent Windows swap file. 

• Can improve the efficiency of a temporary Windows swap file. 

Disadvantages 

• Takes several minutes to run. 

• Must not be run from Windows. 

• Windows does not include a disk-compaction utility. However, various disk
compaction utilities are available. (Disk-compaction utilities are sometimes 
called defragmentation utilities or disk organizers.) See your local computer 
store for details. 

t> To compact a hard disk: 

1. Delete any unnecessary files from that disk using the steps outlined in 
"Deleting Unnecessary Files" earlier in this chapter. 

2. If you are running Windows, exit from Windows. 

3. Run the CHKDSK utility with the IF option. 

Never run CHKDSK IF from Windows. The previous section explains how to 
run CHKDSK IF. 

4. Ensure that you are not running any programs that use the hard disk. 

5. Run your disk-compaction utility according to the manufacturer's instructions. 

Changing Your Hard Disk's Interleave 
A hard disk's interleave detennines how many times the disk must revolve in 
order for an entire disk track to be read. 

On a hard disk, data is organized in concentric circles called tracks. As the disk 
spins, the data on a track is brought beneath the disk head for reading and writing. 
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Each track is divided into sections called sectors. Each sector is referred to by its 
sector number. 

The disk controller reads one sector at a time. On many systems, the disk spins so 
fast that by the time the controller is ready to read the next numbered sector on 
that track, that sector has already spun past the disk head. If the sectors were 
arranged around the track in strict numerical order (sector 1, sector 2, and so on), 
the disk would have to rotate an extra time to read each sector. 

On most hard disks, the sectors are "interleaved"-arranged so that successively 
numbered sectors are spaced farther apart on a track. For example, instead of 
arranging sectors in numerical order (1, 2, 3, and so on) successive sectors might 
be placed 2 or 3 sectors away from each other. On a hard disk with an interleave of 
3: 1, the controller would read sequential sectors by reading every third sector on 
the track; the sector numbers on a track might be 1, 7, 13,2,8, 14,3,9, 15, and so 
on. This spacing gives the controller time to process the sector it has just read; by 
the time it is ready to read the next sector, that sector is just moving beneath the 
head. 

The optimum interleave for each hard disk depends on the type of hard disk and 
controller. The interleave is particularly important if you are using SMARTDrive, 
since SMARTDrive reads entire disk tracks into its memory cache. 

Basic Recommendation 

• It is a good idea to adjust your hard disk's interleave so that it is optimum for 
your disk type and controller. 

Advantages 

• An optimum interleave can drastically improve your system's speed, 
particularly if you are using SMARTDrive. 

• Does not take up memory or disk space. 

• Needs to be done only once (although you might want to experiment to find the 
best interleave for your system). 

Disadvantages 

• Windows does not include a utility for adjusting the interleave of your hard 
disk. You can purchase such a utility from your computer store. 

• Some disk-interleaving utilities require that you reformat your hard disk; 
however, a few utilities are capable of safely resetting the interleave without 
affecting the data on the hard disk. 
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Freeing Up Memory Before Starting Windows 

You can make more conventional memory available to Windows, and to applica
tions running with Windows, by minimizing how much memory is already in use 
when you start Windows. Windows can use only the memory that is available 
when you start it. If memory-resident software is already using memory, then 
Windows cannot use that memory. 

The following section explains how to "streamline" your CONFIG.SYS and 
AUTOEXEC.BAT files so that they start only programs that you really need. It 
also explains how to conserve conventional memory when starting memory
resident software. 

Streamlining Your CONFIG.SYS and A UTOEXEC. BAT Files 
When you start your computer, the settings in your CONFIG.SYS and 
AUTOEXEC.BAT files can start device drivers, utilities, and other programs that 
use memory . You can make more memory available to Windows by removing 
unnecessary commands and utilities from these files. 

Basic Recommendation 

• A void starting unnecessary memory-resident software from your 
CONFIG.SYS and AUTOEXEC.BAT files. 

Advantages 

• Can improve your system's speed. 

• Makes more memory available to non-Windows applications that you start 
from Windows. 

• Fairly easy to do. 

Disadvantages 

• To effectively streamline your CONFIG.SYS and AUTOEXEC.BAT files, you 
should know the function of each of the command lines in those files. 

Because the information in these files can determine how your computer starts 
and runs, you should not change these files unless you know what effect your 
changes may have. 

• When you stop using a utility, you lose the features that the utility provides. 
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For example, if you disable the RAMDrive command line in your 
CONFIG .SYS file, you will no longer have a RAM disk, and you will 
thereby lose the benefits associated with a RAM disk. 

CAUTION Use care when changing your CONFIG.SYS and AUTOEXEC.BAT files. If you in
correctly change or disable some values, your system may not function properly. Therefore, 
it is important to make a system diskette that contains a backup copy of these files. 

I> To streamline your CONFIG.SYS and AUTOEXEC.BAT files: 

1. Make a system diskette that includes a backup copy of both your 
CONFIG.SYS file and your AUTOEXEC.BAT file. 

You can make a system diskette by starting File Manager and then choosing 
Make System Diskette from the Disk menu. Then copy your current 
CONFIG.SYS and AUTOEXEC.BAT files to the diskette. (These files are 
normally located in the root directory of your first hard disk, which is usually 
drive C.) For more information on performing these tasks, see Chapter 4, "File 
Manager." 

2. Use a text editor such as Notepad to open and edit each file. 

3. Edit the command lines in each file. (For specific information on the command 
lines in each file, see the sections that follow.) 

4. Disable any command lines for unnecessary device drivers and utilities. 

When streamlining your CONFIG.SYS and AUTOEXEC.BAT files, it is 
better to simply disable command lines than to delete them. That way, if you 
accidentally disable a command line you really need, you can restore it easily. 
To disable a command line, insert the MS-DOS command REM (for "remark") 
at the beginning of the line. For example, to disable the following 
CONFIG.SYS command line: 

device = c :\device\mouse .sys 

you would insert REM in front of it, as follows: 

rem device = c :\device\mouse .sys 

5. Save the file. 

6. When you have finished editing both files, restart your computer. 

If your system does not start properly, insert the system diskette you created in 
step 1 in drive A, and start your computer again. If you know which command 
line(s) are causing the problem, edit the appropriate file (CONFIG.SYS or 
AUTOEXEC.BAT) on your hard disk, and restart your computer. Or, to start 
over, copy the backup version of the file from the diskette to your hard disk. 
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NOTE If you use the REM command to disable command lines in your CONFIG.SYS file, 
and you are using a version of MS-DOS earlier than 4.0, you'll see a message such as 
"Unrecognized command in CONFIG.SYS" when you start your computer. Once you are sure 
that your computer works properly with the command lines disabled, you might want to 
delete the disabled command lines to avoid the message. 

Your CONFIG. SYS File 

Your CONFIG.SYS file is a text file that defines device drivers and specifies your 
MS-DOS configuration. For example, a typical CONFIG.SYS file might specify 
the location of the MS-DOS file COMMAND. COM, define an extended memory 
manager, and specify how many files an application can have open at once. 
MS-DOS runs the command lines in your CONFIG.SYS file before those in your 
AUTOEXEC.BAT file. (Your CONFIG.SYS file is located in the root directory of 
your first hard disk, which is usually drive C.) 

Basic Recommendations 

• Disable command lines for any unnecessary device drivers using the method 
explained in the preceding section. 

Your CONFIG.SYS file should define only device drivers that you absolutely 
need. (Device drivers are defined using the DEVICE command.) 

Do not disable the HIMEM.SYS or SMARTDRV.SYS command lines. When 
you install Windows, Setup adds those command lines to your CONFIG .SYS 
file if your system needs those device drivers. For a list of the device drivers 
your system needs, see the section that applies to your system in "Configuring 
Your System's Memory" earlier in this chapter. 

• Your CONFIG.SYS file should contain a FILES command line that looks like 
the following: 

files = 30 

The FILES command specifies the maximum number of files each application 
can have open at a time. The larger the number you specify for FILES, the 
more memory is used up. In general, you should set FILES to 30. 

Setting FILES to a value higher than 30 allows each application to open more 
files, but uses up more conventional memory. 

There is no significant advantage to setting FILES to a value lower than 30. 
With a value below 30, Windows and applications might not run. 

• Your CONFIG.SYS file should contain a BUFFERS command line that looks 
like the following: 

buffers = 20 
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The BUFFERS command line sets the number of disk buffers that MS-DOS 
allocates in memory when your computer starts. These buffers allow MS-DOS 
to improve disk access time in certain cases. The larger the number you specify 
for BUFFERS, the more conventional memory is used up. In general, you 
should set BUFFERS to a value from 10 to 20. 

If you are using SMARTDrive, you can conserve conventional memory by 
setting BUFFERS to 10. 

Setting BUFFERS to a value higher than 20 might improve disk access time in 
some cases (but not as much as other methods, such as using SMARTDrive). 
However, doing so will use more memory. 

• If your CONFIG .SYS file includes the LASTDRIVE command, you can save 
some memory by setting LASTDRIVE to a letter such asj or k, rather than to z. 
(If you use a network, this may limit the number of network disk drives you 
can use simultaneously.) 

• If your CONFIG .SYS file contains a SHELL command that specifies your 
environment space, you can save some memory by specifying a smaller 
environment. This will limit how many environment variables you can define 
using the MS-DOS SET command. 

• If you are using MS-DOS 3.3 or later, your CONFIG.SYS file should contain a 
STACKS command line that looks like the following: 

stacks = 0,0 

Your AUTOEXEC.BAT File 
Your AUTOEXEC.BAT file is a special MS-DOS batch file. Like any batch file, 
it lists MS-DOS commands; when you run the batch file, MS-DOS executes the 
commands in the file. Unlike other batch files, MS-DOS automatically executes 
the commands in your AUTOEXEC.BAT file immediately after it completes the 
commands in your CONFIG.SYS file. (Your AUTOEXEC.BAT file is located in 
the root directory of your first hard disk, which is usually drive C.) 

Typically, an AUTOEXEC.BAT file starts memory-resident utilities such as a 
network and sets up environment variables that are used later by applications. In 
addition, your AUTOEXEC.BAT file might set your DOS prompt or start pop-up 
programs such as Borland's SideKick. 

Basic Recommendations 

• If you use a mouse only with Windows and Windows applications, you might 
want to disable any command lines that start and enable mouse-driver software 
such as MOUSE.COM. 
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• Disable command lines that start pop-up programs or other memory-resident 
software. Instead of starting some memory-resident programs from 
AUTOEXEC.BAT, you might want to start them from within Windows. For 
more information on running memory-resident software, see the following 
section and Chapter 12, "More About Applications." 

• Leave intact any command lines that start or enable a network. 

• If you have a RAM disk, you might want to set your TEMP variable to the 
RAM disk. Doing so can speed up applications that store temporary files in the 
directory specified by the TEMP variable. For example, if your RAM disk has 
the drive letter E, you might enter the following command lines, which create 
the directory \TEMP on the RAM disk, then set the TEMP variable to that 
directory: 

mkdir e :\temp 
set temp = e :\temp 

For more information about the TEMP variable, see "Using the TEMP 
Environment Variable" later in this chapter. 

Conserving Memory When Starting Memory-Resident Utilities 
As discussed in the previous section, you'll probably want to start some memory
resident utilities (such as network drivers) before starting Windows. This ensures 
that the utilities will be available to all applications you run with Windows. 
However, doing so takes memory away from non-Windows applications. 

There are two ways to conserve memory when starting memory-resident utilities: 

::OJ 

• If a particular non-Windows application needs the memory-resident utility, you 
can start both the utility and the application from the same batch file. This gives 
the application access to the utility, and does not take memory away from other 
applications. For more information about running batch files with Windows, 
see "Creating PIFs for Batch Files" in Chapter 12. 

13861 • If only a Windows application uses the memory-resident utility, you might 
want to start the utility from the special batch file WINSTART.BAT. 
WINSTART.BAT is a normal batch file, except that Windows automatically 
runs it after starting in 386 enhanced mode. When you start a utility from 
WINSTART.BAT, that utility will be available to Windows applications, but 
not to non-Windows applications. This prevents the utility from taking memory 
away from non-Windows applications. For example, some Windows programs 
require the memory-resident IBM Personal Comunications/3270 utility. Since 
this utility uses a fair amount of memory, but is only needed by particular 
Windows programs, WINSTART.BAT would be an ideal way to start it. 
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Working with Windows Swap Files 
13861" When you're running Windows in 386 enhanced mode and get low on memory, 

Windows compensates by swapping information from memory to a swap file on 
your hard disk. A swap file is a hidden file that reserves space on the hard disk for 
Windows to use for swapping. There are two kinds of Windows swap files: 
permanent and temporary. 

A permanent swap file stays on your hard disk until you remove it, and it stays the 
same size until you change it. It is much faster than a temporary swap file, since it 
consists of contiguous disk blocks. A permanent swap file stays on your hard disk 
even when you are not using Windows. 

A temporary swap file is created dynamically each time you start Windows. When 
Windows starts in 386 enhanced mode, it checks for the existence of a permanent 
swap file. If it doesn't find one, it creates a temporary swap file in your Windows 
directory. When you exit Windows, it deletes the temporary swap file. 

NOTE A third type of swap file, the application swap file, is used only when Windows is 
running in real or standard mode. For more information, see "Working with Application 
Swap Files" later in this chapter. 

When you are running Windows, you can tell which type of Windows swap file 
you are currently using, and how large it is, by using Setup. 

l> To display information about your swap file: 

o Choose the Windows Setup icon from the Main Group in Program Manager. 

Setup displays information about your system configuration, including the type 
of Windows swap file you are currently using: permanent, temporary, or none. 
If you are using a permanent swap file, Setup also displays your swap file's 
size and location. 

The following sections explain how to work with permanent and temporary 
Windows swap files. 

Working with a Permanent Windows Swap File 
I 386 I You can set aside a portion of your hard disk for Windows' exclusive use by 

creating a permanent Windows swap file. Such a swap file is very fast, because it 
consists of contiguous disk blocks; that is, all parts of the file are together on the 
disk, rather than fragmented into several pieces. (For more information about 
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fragmented information on your hard disk, see "Compacting Your Hard Disk" 
earlier in this chapter.) Another reason that a permanent swap file is so fast is that 
Windows can access the file directly, bypassing the MS-DOS file system. 

NOTE A permanent Windows swap file consists of two hidden, write-protected files. The 
files are named SPART.PAR and 386SPART.PAR. Do not delete, move, or rename these 
files. 

Basic Recommendation 

• Whenever possible, use a permanent Windows swap file instead of a temporary 
one. 

Advantages 

• Makes Windows run much faster when low on memory. 

• Ensures that there will be disk space available for swapping if you run out of 
real memory. 

• Lets you control how much disk space Windows uses for swapping. 

• Easy to do. 

• Can be adjusted as necessary, or removed altogether. 

Disadvantages 

• Reduces free disk space. Once you set aside part of your disk as a permanent 
Windows swap file, only Windows can use that disk space, even when 
Windows isn't running. 

• Works only on hard disk drives. You cannot set up a permanent Windows swap 
file on a network disk drive or a memory disk (such as a RAM disk). 

Setting Up a Permanent Windows Swap File 
I 386 I You can set aside a portion of your hard disk for Windows' exclusive use by 

creating a permanent Windows swap file. To create such a swap file, you use the 
Swapfile application. 
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l> To set up a permanent Windows swap file: 

1. If possible, compact your disk before setting up a permanent swap file. 
Because a permanent swap file can exist only in contiguous disk space, 
compacting your disk can make it possible to create a larger permanent 
swap file. For more information, see "Compacting Your Hard Disk" earlier 
in this chapter. 

2. Start Windows in real mode by typing win Ir at the DOS prompt. 

3. If necessary, close any applications (including File Manager) so that only 
Program Manager is still running. 

4. Run Swapfile by choosing Run from the File menu, typing swapfile, and 
choosing OK. 

If you already have a permanent Windows swap file, Swapfile asks what you 
want to do with your permanent swap file. See the following section for more 
information. 

If you do not currently have a permanent swap file, Swapfile displays the 
following dialog box: 

Swapfile 

Swapfile has found a suitable location for a swap file !;reate 
on drive C: 

Largest possible swap file size: 9556K bytes I Hext Drive 

Total free disk space: 2BB92K bytes 
Cancel 

Recommended swap file size: 140961 I~ K bytes Help ... 

Swapfile examines your hard disk drives to see how much contiguous (unfrag
mente d) space on each disk drive is available for a swap file. (To see infor
mation for the next hard disk with sufficient space for a swap file, choose Next 
Drive.) Swapfile displays the following information about the first disk drive 
that has sufficient space: 

The size of the largest swap file that can be created on this disk drive (that 
is, the size of the largest available block of contiguous disk space). 

The total amount of disk space available on this disk drive. This number 
includes both contiguous and discontiguous disk space. 

Based on these two pieces of information, Swapfile recommends a size for the 
permanent swap file. Swapfile always recommends a file size that will take up 
no more than half your available disk space. 
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The first time you set up a permanent swap file, you should probably use the 
values that Swapfile suggests. If that doesn't work the way you want, you can 
always go back and adjust the size of the swap file. 

5. Make any necessary changes to the options and choose Create. 

Swapfile creates a hidden swap file of the specified size on the specified hard 
disk. The swap file will remain this size, and will stay on your hard disk even 
when you are not using Windows. 

6. Exit from Windows. 

7. Start Windows in 386 enhanced mode by typing win. 

When low on memory, Windows will swap information from memory to the 
permanent swap file you just created. 

The following list explains the options in the Swapfile window: 

Use this option 

Recommended 
swap file size 

Create 

Next Drive 

Cancel 

Help 

To do this 

Specify a size for the permanent swap file you are creating. 
You can change the file size by clicking the Up or Down 
scroll arrow to the right of this value. 

Tell Swapfile to create a swap file on the specified hard 
disk drive, using the file size that currently appears in the 
Recommended swap file size option. 

Tell Swapfile to examine the next hard disk drive. 
Swapfile then displays information about the next disk 
drive, and recommends a swap file size for that drive. 

Exit from Swapfile without creating a permanent swap file. 

Display information about the Swapfile options. 

Changing Your Permanent Windows Swap File 
1 3861 ~ Once you have set up a permanent Windows swap file, you can easily change its 

size or location. You might want to do this to make more disk space available or 
to give Windows more swapping space. When you make any changes to your 
permanent swap file, Swapfile simply deletes the current swap file and creates a 
new one with the size and location you specify. 
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t> To change your existing permanent swap file: 

1. Start Windows in real mode by typing win Ir at the DOS prompt. 

2. If necessary, close any applications (including File Manager) so that only 
Program Manager is still running. 

3. Run Swapfile by choosing Run from the File menu, typing swapfile, and 
choosing OK. 

Swapfile displays the following dialog box: 

Swapfile 

A 4194K permanenl Windows swap file exists on drive C: 

Swapfile can: 

@ i:~~:i~:!i:!6:~::~:~!!~:~L~~:~p.:::W:~::~:~~:::~!~:~~~:::~::n~~:::Q~:~;:J 
o !!elele Ihe currenl swap file. 

OK I I Cancel I 

4. Select the option "delete the current swap file and create a new one" and 
choose OK. 

Whenever you make changes to your permanent swap file, you first delete 
the current file and then create a new swap file. After you select this option, 
Swapfile deletes your current swap file and displays a message confirming the 
deletion. You can then create a new swap file. 

After deleting your existing swap file, Swapfile displays the following dialog 
box so that you can create a new swap file: 

Swapfile 

Swapfile has found a suilable localion for a swap file J;;reale 
on drive C: 

Largest possible swap file size: 9556K byles I Hexl Drive 

T olal free disk space: 28892K byles 
Cancel 

Recommended swap file size: 140961 IIiJ K byles Help ___ 

5. Make any changes to the options, and choose Create. 

Making the swap file smaller than your previous swap file will free up disk 
space, but will decrease your system's capacity and speed. 
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Making the swap file larger than your previous swap file will increase your 
system's capacity and speed, but use up more disk space. 

Changing the swap file's location from one disk drive to another will 
affect your system's performance only if one disk drive runs faster or more 
efficiently than the other. In addition, since different disk drives might have 
different amounts of free space, the optimum size for the swap file might 
differ from drive to drive. 

6. Exit from Windows. 

7. Restart Windows in 386 enhanced mode by typing win at the DOS prompt. 

Removing Your Permanent Windows Swap File 
I 386 I If you no longer want Windows to use a permanent swap file, you can remove 

your permanent swap file. Windows then uses a temporary swap file instead. See 
the following section for the advantages and disadvantages of using a temporary 
swap file. 

r> To remove your permanent Windows swap file: 

1. Start Windows in real mode by typing win Ir at the DOS prompt. 

2. If necessary, close any applications (including File Manager) so that only 
Program Manager is still running. 

3. Run Swapfile by choosing Run from the File menu, typing swapfile, and 
choosing OK. 

Swapfile displays the following dialog box: 

. Swapfile 

A 4194K permanent Windows swap file exists on drive C: 

Swapfile can: 

@ !:~~:i~I~jh~::~:~I.I.~:riG~:~p.:::m:~::~:ri~:::~I.~:~~~:::~::~~~:::i1.~iJ 
o !felete the current swap file. 

OK I I Cancel I 

4. To delete your permanent swap file, select the option "delete the current swap 
file" and choose OK. 

Swapfile deletes your permanent swap file and displays a confirmation 
message. 
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5. Exit from Windows. 

6. Start Windows in 386 enhanced mode by typing win at the DOS prompt. 

From now on, Windows will create a temporary swap file each time it starts in 386 
enhanced mode; it deletes the temporary swap file when you exit from Windows. 

Even without a permanent Windows swap file, you can still control how much 
disk space Windows uses for swapping. See the following section for more 
information. 

Working with a Temporary Windows Swap File 
If you choose not to use a permanent Windows swap file, when you start Windows 
in 386 enhanced mode, it automatically creates a temporary swap file instead. 
Later, if you run low on memory, Windows uses the temporary swap file to 
provide additional capacity, just as it does with a permanent swap file. The dif
ference is that, when you exit from Windows, it deletes the temporary swap file. 
A permanent swap file, on the other hand, remains on your disk even when you 
are not using Windows. 

Your temporary Windows swap file is named WIN386.SWP, and is normally 
located in your Windows directory. You can tell Windows to put your temporary 
swap file in a different location by changing a setting in your SYSTEM.INI file. 
(Never delete, move, or rename your Windows swap file directly.) For more infor
mation, see "Changing the Location of Your Temporary Windows Swap File" 
later in this chapter. 

The size of your temporary swap file will vary depending on how much memory 
you need. When Windows starts, it normally creates a l024K temporary swap file. 
It enlarges the file as necessary to accommodate any additional memory require
ments, and reduces the file if you need less memory. You can limit how much disk 
space your-temporary swap file uses by changing settings in your SYSTEM.INI 
file. For more information, see "Controlling the Size of Your Temporary Windows 
Swap File" later in this chapter. 

Basic Recommendations 

• Use a temporary Windows swap file if you do not want Windows to use up 
disk space when it is not running. 

• Whenever possible, use a permanent swap file instead of a temporary swap file. 
(Y ou might have to use a temporary swap file if there is not enough contiguous 
disk space to create a permanent swap file.) 
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Advantages 

• Takes up disk space only when you are running Windows in 386 enhanced 
mode. 

• Fairly easy to do. 

• Can be adjusted as necessary. 

• Does not require contiguous disk space. 

Disadvantages 

Slows down start-up time for Windows because Windows must create the 
temporary swap file. 

Slower than a permanent swap file. 

Setting Up a Temporary Windows Swap File 
1 3861 If you have not set up a permanent Windows swap file, you need do nothing to set 

up a temporary swap file, since Windows creates one automatically each time it 
starts. Windows normally creates the temporary swap file in your Windows 
directory. The following section explains how to specify a different drive for the 
swap file. 

If you are currently using a permanent swap file, you can change to a temporary 
swap file simply by removing your permanent swap file. For information on how 
to do this, see "Removing Your Permanent Windows Swap File" earlier in this 
chapter. 

Changing the Location of Your Temporary Windows Swap File 
13861 Normally, Windows creates its temporary swap file in the Windows directory. 

You can tell Windows to create the file in the root directory of a specific disk 
drive by changing the PagingDrive setting in your SYSTEM.lNI file. If you have 
more than one hard disk, you might want to ensure that Windows creates the file 
on the fastest hard disk. 

Basic Recommendations 

• If you have more than one hard disk, you can improve Windows' capacity by 
setting PagingDrive to the hard disk with the most free space. 

• If you have more than one hard disk and the disks differ in efficiency, you can 
improve Windows' speed by setting PagingDrive to your fastest hard disk. 
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• Do not set PagingDrive to a RAM disk. Doing so would not result in an 
increase in speed, since Windows would simply swap information from one 
area of memory to another. 

t> To specify a different drive for your temporary swap file: 

1. Open your SYSTEM.INI file using a text editor such as Notepad. 

Your SYSTEM.INI file is located in your Windows directory. 

2. Find the [386enh] section of the file. (If you're using Notepad, you can do this 
by choosing Find from the Search menu, typing [386enh), and choosing OK.) 

3. Add or change the PagingDrive setting to tell Windows on which drive to 
create the temporary swap file. The Paging Drive setting must be a drive letter 
followed by a colon (:). 

For example, to tell Windows to create its temporary swap file on drive E, you 
would type the following: 

PagingDrive = e: 

4. Save your SYSTEM.INI file. 

S. Exit and restart Windows. 

Control/ing the Size of Your Temporary Windows Swap File 
1.3861. If you don't have a permanent swap file, Windows creates a temporary swap file 

when you start Windows. Normally, this file starts out with a size of l024K; 
Windows enlarges the file as necessary, depending on your memory requirements. 
However, sometimes you might want more control over the file's size, particularly 
if your computer is short on disk space. 

[> To control the size of your temporary Windows swap file: 

1. Open your SYSTEM.INI file using a text editor such as Notepad. 

Your SYSTEM.INI file is located in your Windows directory. 

2. Find the [386enh] section of the file. (If you're using Notepad, you can do this 
by choosing Find from the Search menu, typing [386enh), and choosing OK.) 

3. Define the size you want for your temporary swap file by specifying values 
for the MinU serDiskSpace and/or the MaxPagingFileSize settings. (If the 
[386enh] section does not contain these settings, simply add the setting(s) you 
want.) You can specify either or both settings. The following list explains each 
setting: 
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MinUserDiskSpace 

MaxPagingFileSize 
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To do this 

Tell Windows how much disk space to leave free 
when creating the temporary swap file. For example, 
if you set MinUserDiskSpace = 2048, Windows 
would always leave at least 2048K of disk space free. 

Specify a maximum size for the temporary 
swap file. For example, if you set 
MaxPagingFileSize = 1024, Windows would 
never create a swap file larger than 1024K. 

4. Save your SYSTEM.lNI file. 

S. Exit and restart Windows. 

Working with Application Swap Files 

In real mode or standard mode, when you start a non-Windows application, 
Windows creates a temporary application swap file for that application. 
(Windows does not use application swap files in 386 enhanced mode.) When 
you switch away from the application, Windows moves some or all of the 
application from memory to the application swap file. This helps make your 
system's memory resources last longer. When you exit the application, Windows 
deletes the associated application swap file. 

Application swap files are hidden files with names that start with the characters 
.... WOA. Windows puts these files in the directory specified by the Swapdisk 
setting in your SYSTEM.lNI file. If the Swapdisk setting is not set, Windows 
places the files in your Windows directory. 

The location Windows uses to store application swap files can affect your 
system's speed and available disk space. 

Basic Recommendations 

• Set the Swapdisk setting to a hard disk with at least 512K of free disk space. If 
you have more than one hard disk, set Swapdisk to the disk with the most free 
space. 

The more disk space Windows can use for application swap files, the more 
non-Windows applications you can run at a time. 

• If you have more than one hard disk and the disks differ in speed, you might 
want to set the Swapdisk setting to the fastest disk. 
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• Usually, it is not a good idea to set Swapdisk to a RAM disk. If the Swapdisk 
setting specifies a RAM disk, when Windows tries to swap application infor
mation from memory to disk, it instead swaps it to another area of memory 
(since the RAM disk exists in memory). 

However, you might want to set S wapdisk to a RAM disk if you run Windows 
in real mode with a single non-Windows application. In that case, setting 
Swapdisk to a RAM disk will enable you to switch to and from the application 
quickly. 

[> To change the location Windows uses for application swap files: 

1. Open your SYSTEM.INI file using a text editor such as Notepad. 

Your SYSTEM.INI file is located in your Windows directory. 

2. Find or add the [NonWindowsApp] section of the file. 

If you're using Notepad, you can do this by choosing Find from the Search 
menu, typing [NonWindowsAppJ, and choosing OK. 

3. Add or change the Swapdisk setting. 

Set Swapdisk to the directory and drive you want. 

For example, to tell Windows to create application swap files in the \TEMP 
directory on drive D, you would type the following: 

swapdisk = d:\temp 

4. Save your SYSTEM.INI file. 

5. Exit and restart Windows. 

For more information about SYSTEM.INI settings, open the SYSINI.TXT file 
using a text editor such as Notepad. 

Using SMARTOrive 

SMARTDrive is a disk-caching program for computers that have a hard disk and 
extended or expanded memory. Disk-caching programs can reduce the amount of 
time your computer spends reading data from your hard disk. SMARTDrive, 
unlike other disk -caching programs, cooperates with Windows to provide the 
most effective use of your system's memory. 

SMARTDrive saves information read from your hard disk in your computer's 
expanded or extended memory. When an application tries to read that information 
from the hard disk, SMARTDrive supplies the information directly from memory 
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instead. SMARTDrive always copies new or modified information to the hard 
disk, so there is no danger of losing information when you tum off your computer. 

You install SMARTDrive by adding the SMARTDrive command line to your 
CONFIG.SYS file. (When you installed Windows, Setup should have done this for 
you.) 

Basic Recommendations 

Because the optimum settings for SMARTDrive depend on your Windows mode, 
the applications you run, and your system configuration, there is no single "best 
setting" for SMARTDrive. After installing SMARTDrive, you might want to 
experiment to find the optimum settings for your system. 

The following are basic recommendations you can start with: 

• You should use SMARTDrive if your system has a hard disk and at least 512K 
of extended memory or 256K of expanded memory. Windows runs much faster 
with SMARTDrive. 

• If you run Windows in standard or 386 enhanced mode, run SMARTDrive in 
extended memory. 

• If you always run Windows in real mode and your system has expanded 
memory, run SMARTDrive in expanded memory. (Add the fA switch to the 
SMARTDrive command line.) 

• To start with, set the normal cache size as large as possible, and set the mini
mum cache size to 256K. "Specifying the Size of the SMARTDrive Cache," 
later in this chapter, explains more about figuring out the best cache size for 
your system. 

• If possible, compact your hard disk regularly. SMARTDrive runs best if the 
files on your hard disk are not fragmented. 

Advantages 

• Improves speed on all systems. 

• Ideal for users who work with many applications and files at once. It is 
especially useful when you run multiple non-Windows applications. 

• Installed automatically by Setup. 

• Fairly easy to adjust. 
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Disadvantages 

• Reduces your system's capacity. 

• Requires either extended or expanded memory. 

• Cannot be used in conjunction with other disk-caching programs. 

NOTE Windows/386 ™ version 2.x will not run in conjunction with SMARTDrive 
version 3.0. 

Installing SMARTOrive 
When you install Windows, Setup copies the SMARTDRV.SYS file to your 
Windows directory and adds the SMARTDrive command line to your 
CONFIG.SYS file. If, for some reason, Setup did not install SMARTDrive on 
your system, or if you later removed SMARTDrive, you can install it by using 
the following procedure. 

[> To install SMARTDrive: 

1. Configure your system's memory for optimum efficiency with Windows. See 
"Configuring Your System's Memory" earlier in this chapter. 

2. Make a system diskette that includes a backup copy of your CONFIG.SYS file. 

You can make a system diskette by starting File Manager and then choosing 
Make System Diskette from the Disk menu. Then copy your current 
CONFIG.SYS file to the diskette. For more information on performing these 
tasks, see Chapter 4, "File Manager." 

3. Open your CONFIG.SYS file using a text editor such as Notepad. 

4. Add a command line for SMARTDRV.SYS to your CONFIG.SYS file. 

The command line tells MS-DOS where to find the SMARTDRV.SYS file, 
defines the size of SMARTDrive's memory cache, and (optionally) specifies 
whether to use extended or expanded memory. The following is a typical 
SMARTDrive command line: 

device = c:\windows\smartdrv.sys 1024 256 

This command line tells MS-DOS that SMAR TDRV .SYS is in the 
\WINDOWS directory on drive C. It runs SMARTDrive in extended 
memory, since SMARTDrive runs in extended memory by default. It gives 
SMARTDrive a l024K cache, and specifies a minimum cache size of 256K. 

If you run SMARTDrive in extended memory, the SMARTDRV.SYS 
command line must come after the HIMEM.SYS command line. 
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If you run SMARTDrive in expanded memory, the SMARTDRV.SYS 
command line must come after the command line for your expanded memory 
manager. 

5. Disable or remove any other command lines for disk-caching software. 

6. Save the changes to your CONFIG.SYS file. 

7. Restart your computer. 

For additional information about setting up and optimizing SMARTDrive on your 
system, see the following sections. For details about the SMARTDrive command 
line and its optional parameters, see the following sections and Appendix D, 
"Command Lines in the CONFIG.SYS File." 

Running SMARTDrive in Extended or Expanded Memory 
SMARTDrive can run in either extended or expanded memory. By default, it uses 
extended memory. To run SMARTDrive in expanded memory instead, add the fA 
switch to the end of the SMARTDrive command line. 

Basic Recommendation 

• You should run SMARTDrive in extended memory unless your system has 
only expanded memory. In that case, run SMARTDrive in expanded memory. 

Specifying the Size of the SMARTDrive Cache 
The size of SMARTDrive's disk cache affects SMARTDrive's efficiency. In 
general, the larger the cache, the less often SMAR TDrive needs to read data from 
the disk. 

The SMARTDrive command line specifies two values for the cache size: 

• The normal cache size determines the size of the cache when SMARTDrive 
starts or when Windows is not running. The normal cache size is the first 
numeric parameter on the SMARTDrive command line. 

• The minimum cache size limits how much Window can reduce the cache size. 
Windows reduces the size of SMARTDrive's cache to recover memory for its 
own use. Windows and SMARTDrive then cooperate to provide optimum use 
of your system's memory. When you exit Windows, it restores the cache to its 
normal size. The minimum cache size is the second numeric parameter on the 
SMARTDrive command line. 

When Windows starts in standard mode or 386 enhanced mode and 
SMARTDrive's cache is in extended memory, Windows immediately reduces 
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the cache to its minimum size. (Windows cannot reduce an expanded-memory 
cache when running in standard mode or 386 enhanced mode.) 

If Windows is running in real mode and SMARTDrive's cache is in expanded 
memory, Windows reduces the cache size gradually as the memory becomes 
necessary. (Windows cannot reduce an extended-memory cache when running 
in real mode.) 

The following SMARTDrive command line starts SMARTDrive in extended 
memory, sets the normal cache size to 1024K, and sets the minimum cache size to 
256K: 

device = c:\windows\smartdrv.sys 1024 256 

When creating its cache, SMARTDrive rounds the specified cache size down to 
the nearest multiple of the largest disk track size. In other words, the actual size of 
the SMARTDrive cache depends on how many disk tracks will fit in the cache. 
When you start SMARTDrive, it determines how many disk tracks can fit in the 
amount of memory you specified for the cache. Thereafter, SMARTDrive will 
cache no more than that number of disk tracks at a time. For example, if the track 
size on your hard disk is 10K and you have set up a 256K cache, then 25 tracks 
will fit in the cache. SMARTDrive will then cache no more than 25 tracks at a 
time, and will create a cache that uses 250K, not 256K, of memory. 

In general, SMARTDrive runs most efficiently with disks that have small tracks. 
If you have several hard disks with different track sizes, SMARTDrive uses the 
largest track size to determine how many tracks it can cache at a time. For 
example, if one hard disk has a track size of 10K and the other has a track size of 
5K, and you have set up a 128K cache, SMARTDrive determines that 12 of the 
10K tracks will fit in the cache. Thereafter, it will cache no more than 10 tracks at 
a time, even though it could cache 25 of the 5K disk tracks. 

NOTE The SMARTDrive driver uses at least 17K of conventional memory in order to run. 
The larger the cache sizes you specify, the more conventional memory SMARTDrive uses. 

Basic Recommendations 

Because the optimum cache sizes for SMARTDrive depend on how you use your 
system, there is no single "best setting." You should experiment to find the best 
cache sizes for your system. 
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The following are basic recommendations you can start with: 

• Set the normal cache size to between 256K and 1024K. (Set it as large as 
possible within that range.) 

Setting the cache size to less than 256K is not a good idea, since SMARTDrive 
will probably not be able to cache enough information to be effective. 

Setting the cache size larger than 1024K might not be the best use of your 
system's memory. Although, in general, a larger cache is faster, you get less 
return on your memory investment as the cache size increases above 1024K. 
For example, increasing a 256K cache to 512K might improve your system's 
speed by 20 percent. However, increasing a 1024K cache the same amount, 
from 1024K to 1280K, might improve speed by only 2 percent. 

• Set the minimum cache size to at least 256K. 

When Windows is running, it can reduce the cache to recover memory for its 
own use. Setting the minimum cache size above 1024K might prevent 
Windows from making effective use of memory. Setting the minimum cache 
size below 256K might handicap SMARTDrive while Windows is running, 
since a cache smaller than 256K is not particularly useful. 

USing Alternative Disk-Caching Programs with Windows 
Although you can use other disk-caching programs in conjunction with Windows 
3.0, there are drawbacks to doing so. SMARTDrive is designed to cooperate with 
Windows; other disk-caching programs might not do so. Using other disk-caching 
programs might result in less effective memory management, slower performance, 
or even memory-management conflicts between the disk-caching program and 
Windows. 

Using RAMOrive 

RAMDrive is a memory-resident utility that lets you use part of your system's 
memory as if it were a hard disk drive. This memory area is called a RAM disk 
because it exists in memory (RAM). RAM disks are much faster than hard disks 
because your computer can read information faster from memory than from a hard 
disk. A RAM disk appears to be a normal hard disk drive; you can use it just as 
you would any disk drive. The most important difference between a real disk drive 
and a RAM disk is that, since it exists only in memory, information on a RAM 
disk is lost when you tum off or reset your computer. 
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Basic Recommendations 

• Install RAMDrive only if you really need a RAM disk. In many cases, using 
the same amount of memory for SMARTDrive will improve your system's 
speed more than RAMDrive would. 

• You might want to install RAMDrive if you use a diskless workstation on a 
network, and the workstation has plenty of memory. 

• You might also want to install RAMDrive if you often run applications that use 
many small temporary files. In that case, set up a RAM disk of about 256K, 
and set your TEMP environment variable to the RAM disk. For additional infor
mation, see "Using the TEMP Environment Variable" later in this chapter. 

Advantages 

• Provides you with a very fast disk drive. 

• Provides additional disk space for temporary storage. 

• Fairly easy to set up. 

Disadvantages 

• Uses additional memory, which can cut down your system's speed and 
capacity. (For many systems, SMARTDrive is a better use of your system's 
memory than RAMDrive.) 

• When you tum off your computer, it does not save information that is stored on 
the RAM disk. Because of this, the RAM disk is best for storing temporary 
files, not for saving data files that may change. 

• Whenever you restart your computer, the RAM disk is re-created. This means 
you must recopy information (except temporary files) to your RAM disk each 
time you start your computer. 

Setting Up RAMDrive 
When you install Windows, Setup puts a copy of the RAMDRIVE.SYS file in . 
your Windows directory. 



Chapter 13 Optimizing Windows 537 

[> To set up RAMDrive: 

1. Configure your system's memory for optimum efficiency with Windows. For 
more information, see "Configuring Your System's Memory" earlier in this 
chapter. 

2. Make a system diskette that includes a backup copy of your CONFIG.SYS file. 

You can make a system diskette by starting File Manager and then choosing 
Make System Diskette from the Disk menu. Then copy your current 
CONFIG.SYS file to the diskette. For more information on performing these 
tasks, see Chapter 4, "File Manager." 

3. Open your CONFIG.SYS file using a text editor such as Notepad. 

4. Add a command line for RAMDRIVE.SYS to your CONFIG.SYS file. 

The command line tells MS-DOS where to find the RAMDRIVE.SYS file and 
how much memory to allocate to RAMDrive. The following is a typical 
RAMDrive command line: 

device = c:\windows\ramdrive.sys 256 Ie 
This command line gives RAMDrive 256K of extended memory and tells 
MS-DOS that RAMDRIVE.SYS is in the \WINDOWS directory on drive C. 

If you run RAMDrive in extended memory, the RAMDRIVE.SYS command 
line must come after the command line that starts HIMEM.SYS. 

5. Save the changes to your CONFIG.SYS file. 

6. Restart your computer. 

For more information about the RAMDrive command line and its optional 
parameters, see Appendix D, "Command Lines in the CONFIG.SYS File." 

Using Other Memory-Disk Programs with Windows 
Although you can use other memory-disk programs in conjunction with Windows, 
it is best to use RAMDrive. When you run RAMDrive in extended memory, it 
cooperates with the version of HIMEM.SYS that comes with Windows, and uses 
less conventional memory than other memory-disk programs. 

Using the TEMP Environment Variable 

Many applications use temporary files to store data while they're running. Some 
of these applications store temporary files in the directory specified by the TEMP 
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environment variable. For information about how your applications store 
temporary files, consult the applications' documentation. 

You set the TEMP variable using the MS-DOS SET command. (Typically, the 
SET command is in your AUTOEXEC.BAT file.) For example, the following 
command line sets the TEMP variable to the C:\TEMPFILES directory: 

set temp=c :\tempjiles 

Setting the TEMP variable affects only those applications that check for the value 
of TEMP. The location you specify for temporary files can affect the speed of 
applications that use the TEMP variable. For example, if the TEMP variable 
specifies a relatively slow hard disk, applications that store temporary files on 
that drive might run at less than optimum speed. 

Basic Recommendations 

Set the TEMP variable to a subdirectory, not to the root directory. 

MS-DOS allows you to create only a limited number of files in the root 
directory of a disk, but lets you create as many files as you need within a 
subdirectory. 

Set the TEMP variable to a disk that has enough free space for the temporary 
files your application creates. Consult the application's documentation for more 
information about how the application uses temporary files. 

• If you use RAMDrive, you might want to set the TEMP variable to your RAM 
disk. 

Because it's much faster to read information from memory than from a hard 
disk, an application that uses temporary files might run faster if it stores its 
temporary files on a RAM disk. Since most applications delete their temporary 
files when they're finished using them, you don't need to worry about saving 
copies of those files before turning off your computer. 

Controlling Windows' Use of Expanded Memory 

If your system has expanded memory that meets the LIM EMS 4.0 standard, 
Windows makes extensive use of that expanded memory when running in real 
mode. Depending on how much conventional and expanded memory is available, 
Windows uses expanded memory in one of two ways: small-frame EMS mode or 
large-frame EMS mode. 

In Windows, small-frame EMS mode is more efficient if there is less conventional 
memory available, and is especially useful for running a single, large Windows 
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application. Large-frame EMS mode is better for running multiple Windows 
applications simultaneously. However, with large-frame EMS mode, less total 
memory is available to each individual application. 

Normally, when you start Windows in real mode, Windows determines which 
EMS mode to use, based on how much conventional and expanded memory is 
available. However, sometimes you might want more control over which EMS 
mode Windows uses. For example, since small-frame EMS mode is better for 
running a single, large application, if you only run one application at a time, you 
might want to ensure that Windows uses small-frame EMS mode. 

Running Windows in Small-Frame EMS Mode 
If you are running only one Windows application at a time, you can try using the 
IE switch to make sure Windows is starting in small-frame EMS mode. Typically, 
in small-frame EMS mode, there is more expanded memory available for the 
application you want to run. 

The IE switch tells Windows how much conventional memory must be available 
in order to use large-frame EMS mode. If there is less conventional memory 
available than you specified, Windows starts in small-frame mode instead of large
frame mode. Therefore, to make sure Windows starts in small-frame mode, 
specify an amount of conventional memory that you're sure will not be available 
(for example, 999K). 

[> To run Windows in real mode and small-frame EMS mode: 

D Start Windows by typing the following: 

win Ir Ie 999 

This command line starts Windows in real mode (IR) and tells it to use small
frame EMS mode if there is less than 999K of conventional memory available 
(IE 999). Since no computer will have more than 640K of conventional 
memory available, this is a reliable way to ensure that Windows uses the 
small-frame EMS mode. 

Moving the EMS Bank Line in Large-Frame EMS Mode 
With large-frame EMS mode, Windows divides all available memory into two 
sections: global memory and banked memory. The EMS bank line is the dividing 
line between these two sections of memory. Global memory is located below the 
EMS bank line, and is available to all applications. Banked memory is located 
above the bank line, and is available to one application at a time. 



540 Optimizing Your System 

With large-frame EMS mode, applications need both global and banked memory 
in order to run. Therefore, if you run out of either global or banked memory, you 
might not be able to start additional applications. 

You can "fine-tune" the way Windows uses large-frame EMS mode by moving 
the EMS bank line up or down in memory. Moving the bank line down makes 
more banked memory available and reduces the amount of global EMS memory 
available. Moving the bank line up does the opposite; it decreases banked memory 
and increases global memory. 

You might want to move the bank line if you are running an application that 
runs out of banked memory before it runs out of global memory, or vice versa. 
Optimizing by moving the EMS bank line is generally by trial and error: you set 
the bank line at a particular position, run the application, observe which type of 
memory it runs out of first, and adjust the bank line as necessary until you find the 
optimum position for the line. 

To move the bank line, you start Windows with the IL switch. This switch moves 
the bank line up or down by I-kilobyte increments. (Because the EMS bank line 
exists only in large-frame EMS mode, the IL switch has no effect when you start 
Windows in small-frame mode.) 

I> To move the EMS bank line: 

[J Start Windows in real mode with the /R and IL switches. 

You can use the IL switch to move the bank line from 1 to 16 kilobytes in 
either direction. For example, the following command line starts Windows in 
real mode and moves the EMS bank line down 8 kilobytes: 

win Ir /l-8 

The following command line starts Windows in real mode and moves the EMS 
bank line up 16 kilobytes: 

win Ir /l +16 

Installing the EMM386 Expanded Memory Emulator 
I 386 I' An expanded memory emulator is a utility that simulates expanded memory for 

applications that use expanded memory. Windows includes the expanded memory 
emulator EMM386.SYS (for use on 80386 and 80486 systems only). (When you 
install Windows, Setup copies the EMM386.SYS file to your Windows directory.) 
You should use EMM386.SYS only if necessary. 



Chapter 13 Optimizing Windows 541 

When running in 386 enhanced mode, Windows can simulate expanded memory 
for applications that need it. However, sometimes you might use applications that 
require expanded memory when you're not running Windows in 386 enhanced 
mode. You might want to install EMM386.SYS in the following situations: 

• When your CONFIG.SYS or AUTOEXEC.BAT file starts programs that 
require expanded memory. 

• When you want to run an application that requires expanded memory with 
Windows in real mode, or when you are not running Windows. 

NOTE To use a Windows application that requires expanded memory with Windows in 
standard mode, you need to configure your system so that it provides as much physical 
expanded memory as the application needs. For more information, see "Configuring Your 
System's Memory" earlier in this chapter. 

Basic Recommendations 

• Install EMM386 only if you really need it. 

• If you install EMM386, allocate it as much memory as the application needs. 

For example, if you want to run an application that requires 256K of expanded 
memory when you are not running Windows, you would allocate 256K of 
memory to EMM386. 

l> To install EMM386.SYS: 

1. Configure your system's memory for optimum efficiency with Windows. For 
more information, see "Configuring Your System's Memory" earlier in this 
chapter. 

2. Make a system diskette that includes a backup copy of your CONFIG.SYS file. 

You can make a system diskette by starting File Manager and then choosing 
Make System Diskette from the Disk menu. Then copy your current 
CONFIG.SYS file to the diskette. For more information on perfollning these 
tasks, see Chapter 4, "File Manager." 

3. Open your CONFIG.SYS file using a text editor such as Notepad. 

Your CONFIG.SYS file is normally located in your hard disk's root directory. 
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4. Add a command line for EMM386.SYS to your CONFIG.SYS file. 

The command line tells MS-DOS where to find the EMM386.SYS file and 
how much extended memory to allocate to EMM386. EMM386 will then 
provide that amount of expanded memory to applications that need it. 

The following is a typical EMM386 command line: 

device = c:\windows\emm386.sys 640 

It gives EMM386 640K of memory and tells MS-DOS that EMM386.SYS is 
in the \WINDOWS directory on drive C. 

The EMM386.SYS command line must come after the command line that 
starts HIMEM.SYS, but before any command lines for programs that use 
expanded memory. 

5. Disable or remove any other command lines for expanded memory 
management software. 

6. Save the changes to your CONFIG.SYS file. 

7. Restart your computer. 

For more information about the EMM386 command line and its optional switches 
and arguments, see Appendix D, "Command Lines in the CONFIG.SYS File." 

Using Alternatives to EMM386 
If possible, you should use the version of EMM386 that came with the version of 
Windows you are using. EMM386 was designed to cooperate with Windows and 
its management of extended memory. Windows will not run in standard or 386 
enhanced mode in conjunction with current versions of other expanded memory 
emulators (for example, 386-Max TM, CEMM, and QEMM). If you use one of these 
utilities instead of EMM386, Windows will run only in real mode. (Note that 
future versions of these utilities might be enhanced so that they cooperate with 
Windows.) 
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Getting Windows from a Network 
If a system administrator has put a shared copy of Microsoft Windows on a 
network, you can install it on your system by running Setup with the IN 
(network) switch. 

Setup copies some Windows files to your personal Windows directory, which 
is usually located on your hard disk. You specify the name of your personal 
Windows directory when you run Setup. This directory is required in order to 
run Windows. 

By maintaining your own copies of these files, you can customize Windows 
according to your preferences, even though you are still sharing most Windows 
files with the other users on the network. 

NOTE Check with your network system administrator for any special instructions before 
installing the shared copy of Windows. 

[> To install a shared copy of Windows from a network: 

1. Connect to the network. 

2. Change to the directory where Windows is located on the network. 

3. Type setup In at the DOS prompt. 

4. Follow the instructions on the screen. 

Setup will ask you where it should put your Windows files. Type in the path
name of your personal Windows directory. Setup will copy to your directory 
only the files that contain information relevant to your system. 

If you are using a diskless workstation (your machine does not have a hard disk), 
follow the preceding instructions for installing a shared copy of Windows from a 
network. But instead of having Setup copy the Windows files to a hard disk, 
specify that Setup should copy them to your personal Windows directory on a 
network disk drive. Ask your system administrator if you are not sure what 
directory you should use as your personal Windows directory. 
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Using Networks with Windows 
Windows provides many features that make it easier to work with a network's 
resources. But before you can use these features, you need to be aware of some 
basic guidelines for using networks. This section lists these guidelines, outlines 
Windows network features, and describes what to do if your network does not 
support some or all of these features. 

Guidelines for Using Networks 

You can avoid many problems when using Windows with a network by following 
these guidelines: 

• Make sure your network software is compatible with Windows 3.0 by reading 
the NETWORK. TXT file that is included with Windows. This file contains a 
list of all network versions that are compatible with Windows 3.0. 

• Always start the network before you start Windows. 

You can connect to network disk drives and printers after you start Windows, 
but you must make sure the network software is running on your machine 
before you start Windows. Otherwise your system will likely fail. 

• Ask your network system administrator about the procedures you should follow 
for storing your personal files. 

You might be required to keep your files out of a shared directory, where you 
could lose them or interfere with the files of other users. 

• Every time you connect to a network disk drive to start Windows (or another 
shared application), use the same letter to designate that network disk drive on 
your system. 

For example, if you select the letter W when you connect to the network disk 
drive to set up a shared copy of Windows on your local hard drive, Windows 
will record W as the path it should use in the future to look for the shared 
Windows files. If you connect to the same network disk drive next time using 
any letter other than W, you will not be able to run Windows correctly. 

• Every time you connect to a network printer, use the same port for that 
particular printer. 

Control Panel remembers the printer settings for a particular port. Therefore, if 
you change the port you are using for a printer, the settings for the new port 
may not be correct for that printer. 



Chapter 14 Networks and Windows 547 

Windows Network Features 
This User's Guide describes a number of Windows features that enable you to 
work with a network more easily. The following list describes where to find infor
mation about these features. 

Windows allows you to: 

• Configure Windows for a particular type of network. For information, see 
"Changing Settings" in Appendix A. 

• Connect your system to a particular network disk drive. On some networks, 
you can even browse through network disk drives to find the one you want. For 
information, see Chapter 4, "File Manager." 

• Set options that are specific to your network. For information, see Chapter 5, 
"Control Panel." 

• Set up network printer connections. For information, see Chapter 5, "Control 
Panel." 

• Take advantage of special features offered by Windows Print Manager when 
using a network printer. For information, see Chapter 6, "Print Manager." 

• Configure your system so that your network can take advantage of expanded 
memory. For information, see Chapter 13, "Optimizing Windows." 

Using an Unsupported Network 
The extent to which you can use Windows network features depends on the 
network you use. An unsupported network is one that does not allow you to 
use all of these features. 

Contact your network manufacturer for information about a version of its network 
software that is compatible with Windows 3.0. 

If you are using an unsupported network, you might have trouble running 
Windows or certain applications. This section contains recommendations for 
overcoming trouble areas you might encounter. 
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If Your System Fails When You Start Windows in Standard Mode 
If your system fails when you start Windows in standard mode, it is possible that 
your network does not support Windows in this mode. Try starting Windows in 
real mode by typing win Ir at the DOS prompt. 

13861' If Your System Fails When You Start Windows in 386 Enhanced 
Mode 
Depending on what unsupP9rted network you are using, your system might fail 
when you start Windows in 386 enhanced mode for one of two possible reasons: 

• Most likely, your network does not support Windows in this mode. 

Try starting Windows in standard mode by typing win Is at the DOS prompt. 

• Windows might not run in 386 enhanced mode if the network is not set up to 
handle the way your network card uses memory. This problem can take two 
forms. 

First, the network may require a larger buffer for direct memory access (DMA) 
data transfers than Windows normally provides. Second, your network may 
not be able to run unless Windows is prevented from using a portion of 
memory between 640K and 1MB to map unused address space. 

You can make Windows running in 386 enhanced mode compatible with your 
network card by changing the NetDMASize or EMMExclude setting in your 
SYSTEM.lNI file. Whether you will need to change these settings depends on 
your network hardware. 

CAUTION Use care when changing your SYSTEM.INI file. If you incorrectly change its 
contents, your system may not function properly. See your network administrator before 
changing these settings. 
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r.> To change the size of the direct memory access buffer: 

1. Open your SYSTEM.INI file using a text editor such as Notepad. 

Your SYSTEM.INI file is located in your personal Windows directory. 

2. Find the [386enh] section of the file. (If you are using Notepad, you can do this 
by choosing Find from the Search menu, typing [386enhj, and choosing OK.) 

3. Add the NetDMASize setting if you need to tell Windows how much memory 
(in kilobytes) to reserve for direct memory access. The default value is 32 on 
Micro Channel machines (such as the IBM PS/2 ®) or 0 on other machines. 

For example, to tell Windows to provide a 32K buffer for direct memory 
access, you would type the following: 

NetDMASize= 32 

4. Save your SYSTEM.INI file. 

5. Exit and restart Windows in 386 enhanced mode. 

[> To prevent Windows from scanning or using a part of conventional memory: 

1. Open your SYSTEM.INI file using a text editor such as Notepad. 

Your SYSTEM.INI file is located in your personal Windows directory. 

2. Find the [386enh] section of the file. (If you are using Notepad, you can do this 
by choosing Find from the Search menu, typing [386enhj, and choosing OK.) 

3. Add the EMMExclude setting to specify a range of memory addresses. 
Windows will be prevented from scanning these addresses when running in 
386 enhanced mode. 

For example, to tell Windows not to scan the addresses between C800:0000 
and DOOO:OOOO, you would type the following: 

EMMExclude = C800-CFFF 

4. Save your SYSTEM.INI file. 

5. Exit and restart Windows in 386 enhanced mode. 

If, after trying the preceding methods, you still cannot run Windows on the 
network, you can try running Windows without loading the network onto your 
system. Ask your system administrator for assistance. 
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If Your System Fails When You Run a Network-Specific 
Application 
Your system might run Windows, but fail when you are running a particular 
application that is network-specific (in other words, an application that is directly 
accessing the network). There are two reasons why this could happen: 

• The network -specific application might not run if you are running Windows in 
standard mode or 386 enhanced mode. 

If this is the case, try running Windows in real mode by typing win Ir at the 
DOS prompt. 

You might also be able to solve this problem by obtaining a special Windows 
library for your network from your network vendor. 

• Windows might fail when you are running the application and then switch to or 
from a non-Windows application. 

If this happens, avoid switching to another application. 

If you are running the non-Windows application with Windows in real or 
standard mode, you can prevent switching from it by selecting the Prevent 
Program Switch option in the application's program information file (PIF). 
For more information, see "Specifying PIF Options for Standard Mode or 
Real Mode" in Chapter 12. 

If you are using Windows in 386 enhanced mode, you might also need to 
avoid the invisible switching that Windows does to run applications in the 
background. 

If the network -specific application is a Windows application, make sure that 
any non-Windows applications you are running at the same time will not run 
in the background. For more information on running applications in the back
ground, see "Specifying Advanced PIF Options for 386 Enhanced Mode" in 
Chapter 12. 

If the network-specific application is a non-Windows application, try running 
it in exclusive mode. For more information on running applications in 
exclusive mode, see "Specifying Basic PIF Options for 386 Enhanced Mode" 
in Chapter 12. 

If the application creates or deletes files, it might not be running exclusively 
even if it has been set to run in exclusive mode. This is because Windows is 
alerted anytime a file is manipulated. You can prevent this alert by changing 
the FileSysChange setting in your SYSTEM.INI file. 

J 
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[> To prevent Windows from getting file manipulation messages: 

1. Open your SYSTEM.INI file using a text editor such as Notepad. 

Your SYSTEM.INI file is located in your personal Windows directory. 

2. Find the [386enh] section of the file. (If you are using Notepad, you can do this 
by choosing Find from the Search menu, typing [386enh], and choosing OK.) 

3. Type the line FileSysChange=no in the section. 

4. Save your SYSTEM.INI file. 

5. Exit and restart Windows in 386 enhanced mode. 

If an Application Does Not Run Correctly in Standard Mode 
If you are running Windows in standard mode, a Windows application might not 
run correctly if it requires a larger buffer for transferring data over the network 
than Windows normally provides. 

You can increase the buffer size by changing the NetHeapSize setting in the 
[standard] section of your SYSTEM.INI file. 

[> To increase the size of the data transfer buffer: 

1. Open your SYSTEM.INI file using a text editor such as Notepad. 

Your SYSTEM.INI file is located in your personal Windows directory. 

2. Find the [standard] section of the file. (If you are using Notepad, you can do 
this by choosing Find from the Search menu, typing [standard], and choosing 
OK.) 

3. Add the NetHeapSize setting to tell Windows the maximum buffer size 
(in kilobytes) required for data transfers. The default value is 8. 

For example, to make the buffer size 16K, you would type the following: 

NetHeapSize = 16 

4. Save your SYSTEM.INI file. 

5. Exit and restart Windows in standard mode. 
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13861" If an Application Does Not Run Correctly in 386 Enhanced Mode , 

If you are running Windows in 386 enhanced mode, a Windows application might 
not run correctly if it requires a larger buffer for transferring data over the network 
than Windows normally provides. 

You can increase the buffer size by changing the NetHeapSize setting the in 
[386enh] section of your SYSTEM.INI file. 

I> To increase the size of the data transfer buffer: 

1. Open your SYSTEM.INI file using a text editor such as Notepad. 

Your SYSTEM.INI file is located in your personal Windows directory. 

2. Find the [386enh] section of the file. (If you are using Notepad, you can do this 
by choosing Find in the Search menu, typing [386enh), and choosing OK.) 

3. Add the NetHeapSize setting to tell Windows the maximum buffer size (in 
kilobytes) required for data transfers. The default value is 12. All values are 
rounded up to the nearest 4K. 

For example, to make the buffer size 16K, you would type the following: 

NetHeapSize = 16 

4. Save your SYSTEM.INI file. 

5. Exit and restart Windows in 386 enhanced mode. 

If You Cannot Run Any Non-Windows Applications 
If you are not able to run any non-Windows applications while you are connected 
to the network, try the following: 

• Run in a lower Windows mode. 

If you are running Windows in 386 enhanced mode, try running Windows in 
standard mode instead by typing win Is at the DOS prompt. If non-Windows 
applications do not run with Windows in standard mode, try running Windows 
in real mode by typing win Ir. 

• Avoid switching to or from any non-Windows applications. 

1 386 I' • If you are running Windows in 386 enhanced mode, you can try running non-
Windows applications in exclusive mode. For more information on exclusive 
mode, see "Specifying Basic PIF Options for 386 Enhanced Mode" in Chapter 
12. 
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If You Cannot Connect to Network Drives or Printers 
If you are running Windows, but cannot connect to network disk drives or printers, 
try connecting to them before starting Windows. 

Putting Windows on a Network 
This section is intended for system administrators or anyone who will install 
Windows on a network to be shared by multiple users. 

The Microsoft License Agreement that came with your Windows package gives 
you permission to install Windows on a network. For information on this license, 
see the Grant of License section of this agreement or contact the Microsoft 
Information Center. 

Most of the files on the Windows disks are compressed. To put Windows on the 
network, you must decompress these files by using the Expand decompression 
program that is included with Windows. To operate Expand efficiently, you will 
need to create an MS-DOS batch file. The following procedure contains the 
commands necessary to create this batch file. 

This procedure assumes you are copying Windows from the Windows disks in 
drive A to the \WINDOWS network directory on network disk drive W. You 
should replace these pathnames with the actual ones you are using, where 
appropriate. 

l> To install Windows on a network: 

1. Connect to the network. 

2. Change to the directory where you want to put the shared copy of Windows. 

3. Type copy con expall.bat at the DOS prompt. 

This DOS command means that what you type next will be copied into the 
EXP ALL.BA T batch file. You can use any filename for this batch file as long 
as it contains the .BA T extension. 

4. Type the following at the DOS prompt: 

a: 
for %%i in (*.*) do w:\windows\expand %%i w:\windows\%%i 
w: 

This MS-DOS code creates a program that will allow you to enter the path
names of the source and destination of the Windows files. 
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5. At the DOS prompt, press CTRL + Z. 

This MS-DOS command closes the batch file. 

6. Insert Windows Disk 2 into drive A and type the following at the DOS prompt: 

copy a:expand.exe w:\windows 

The Expand decompression program is copied to your network Windows 
directory. 

7. Insert Windows Disk 1 into drive A and type the following: 

expall a:*. * w:\windows 

This command will run the EXP ALL batch file program, which copies and 
expands the files from the Windows disks to the WINDOWS directory on 
network disk drive W. You should enter the network disk drive and directory 
of your choice. 

8. Repeat Step 7 for the remaining Windows disks. 

9. Make all Windows files and the network share read-only. 

Users may now connect to this directory and run Setup as described in "Getting 
Windows from a Network" earlier in this chapter. 

Giving Users Access to Network Applications 

You can give users easier access to applications running on the network by 
modifying the SETUP .INF file when you put Windows on the network. This text 
file is included with Windows and remains in the shared Windows directory. 

Windows Setup uses this file, among other reasons, to detennine the initial 
contents of the user's Program Manager groups. By modifying the file, you can 
add applications to these groups and customize their settings. 

The [progman.groups] section of SETUP.INF lists the groups in the Program 
Manager window. Following this section is a list of the applications that are 
displayed as icons in each group when a user starts Windows. Each application is 
listed by title, pathname, icon filename, and icon number. These fields are 
separated by commas. The icon fields are optional. 

If you want Windows to install an application that is on the network and place it 
in the user's Program Manager window, you need to add to SETUP.INF a title 
(of your choice) and the pathname of that application. 

You have the option of specifying which icon will be displayed by including an 
icon filename and/or an icon number. 
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The icon filename identifies the file that contains the icon you want to use. If you 
want to use an icon that is assigned to another application, you can enter that 
application's filename as the icon filename. If you don't specify an icon filename, 
the displayed icon will be one from the application file. Or, if the application file 
does not contain any icons, the icon will come from Program Manager. 

If the file you select contains more than one icon, you can specify the one you 
want to use by entering the appropriate icon number. This number corresponds to 
the order in which the icon is listed in the file. If you do not enter an icon number, 
Program Manager will use the first icon listed in the file. 

[> To add a network application to a user's Program Manager window: 

1. Open the SETUP.INF file by using Write. 

2. Choose the No Conversion option in the Write dialog box. 

3. In the section for the group where you want the application to appear, type the 
program title, pathname, and, optionally, the icon filename and icon number of 
the application. The fields must be separated by commas. 

4. Choose Save from the File menu to save the changes. 

The following are examples of different entries that you could put in SETUP.INF 
if you wanted to add a shared copy of Microsoft Word to a user's Program 
Manager window. 

"Microsoft Word" ,k:\word\word.exe 

"Microsoft Word" ,k:\word\word.exe,progman.exe 

"Microsoft Word" ,k:\word\word.exe,,2 

"Microsoft Word" ,k:\word\word.exe,progman.exe,2 

Keeping a User's Files Off a Shared Directory 
When a user runs an application, Program Manager changes the user's directory to 
the one that contains the application. As a result, a user running a shared applica
tion from the network might accidentally leave personal files in the shared direc
tory. These files will use up disk space and possibly interfere with other users. 

You can avoid this problem when you add the application to SETUP.INF. First, 
make sure the application is located on the user's path. Then, instead of typing the 
network pathname for the application, type the user's personal Windows directory 
followed by the application filename. 
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For example, if EXCEL.EXE is located in K:\APPS, and that directory is in the 
user's path, type c:\excel.exe in SETUP.INF. Then, when the user selects the 
Excel icon, Windows will change to the user's directory (C:\) and run Microsoft 
Excel from the user's path. Any document files the user creates will stay in the 
user's directory rather than in the shared network directory. 

Putting Additional Network Files on a User's System 

When a user runs the network version of Setup, Windows will copy selected files 
to the user's system. You can copy additional files to the user's Windows direc
tory by adding the filenames to the [net] section of the user's SETUP.INF file. 

l> To put additional files in the user's Windows directory: 

1. Open the SETUP.INF file by using a text editor, such as Notepad. 

2. Find the [net] section of the file. (If you are using Notepad, you can do this by 
choosing Find from the Search menu, typing [net], and choosing OK.) 

3. Type a drive number, a colon, the filename, and a title (optional) for the file 
you want to copy. 

You must enter a drive number, but it does not matter what number you use. 
Include a title only if you want a message to appear during Setup that indicates 
when this file is being copied to the user's disk. 

The following are acceptable entries in the [net] section of SETUP.INF: 

2:NEW.PIF 

2 :NEW.P IF, "Network Application Settings" 
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Appendix A 
Using Setup to Maintain Windows 

When you installed Microsoft Windows, you ran the Windows Setup program. 
During this process, you provided Windows with information about the hardware 
and software you are using with Windows. 

If you make additions or changes to this hardware or software, you will need to 
inform Windows by running Setup again. In many instances, you will be able to 
do this from within Windows. Other situations will require you to run Setup from 
outside of Windows. This appendix describes how to use Setup to maintain your 
Windows environment. 

Running Setup from Windows 
By running Setup from Windows, you can: 

Change some of the hardware options you set when you installed Windows. 

• Add applications already installed on your hard disk to the Windows 
environment. 

[> To run Setup from Windows: 

o Choose the Windows Setup icon from the Main Group window. 

The Windows Setup window appears. It lists your current hardware and 
software settings. 

1:1 Windows Setup a 
Qptions .!::!.elp 

Display: 

Keyboard: 

Mouse: 

Network: 

Swap file: 

VGA 
Enhanced 101 or 102 key US and Non US 

Microsoft. or IBM PS/2 

Microsoft Network (or 100% compatible) 

Permanent (5136 K bytes on Drive C:) 
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i 

Changing Settings 

Suppose you want to add a mouse to your system, or you want to upgrade the 
display device you specified when you first ran Setup. You can easily inform 
Windows of such changes by using Setup. Setup allows you to change: 

• The type of display device you are using. 

• The keyboard you are using. 

• The mouse you are using. 

• The type of network you are on. 

Windows Setup will allow you to install only those drivers included with 
Windows. For information on changing to a driver not supplied with Windows, 
see "Installing a Device Driver Not Supplied with Windows," later in this 
appendix. 

NOTE You will have to restart Windows or reboot your computer if you change settings 
using Setup. For this reason, it is a good idea to close all your running applications before 
you start Setup to change settings. 

[> To change your display, keyboard, mouse, or network: 

1. Make sure that your hardware is set up to match the setting to which you are 
changing. 

2. Choose the Change System Settings command from the Options menu. 

The Change System Settings dialog box appears. 

Change System Settings 

Qisplay: 

Keyboard: I Enhanced 101 or 102 key US and Non US keyboards 

Mouse: IMicrosoft Mouse (Bus or Serial) 

,Network: IL-N_o _Ne_tw_o_rk ___________ ---'-' 

OK Cancel 
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3. Choose the Down arrow at the right of the setting that you want to change. 

A drop-down list box appears. It lists the settings that you can select. 

4. Make sure that your hardware is listed in the list box. 

5. Select the setting that you want. 

6. Choose OK. 

Setup may request that you insert a Windows disk into drive A. If it does, 
put the disk in drive A and close the drive door, or type the pathname of 
the appropriate device-driver file. Then choose OK. 

The Windows Setup window displays the new setting. 

7. Choose Exit from the Options menu. 

A dialog box appears that contains a Restart Windows button and may contain 
a Reboot button. 

8. If a Reboot button appears, make sure there are no disks in any diskette drive 
and choose Reboot. Then restart Windows. 

Otherwise, choose Restart Windows. 

Adding Existing Applications 

After you install an application on your system, you can use Setup to make sure it 
will run smoothly with Windows. 

If you are adding just one Windows application, it might be easier to use Program 
Manager rather than Setup. For information on adding an application using 
Program Manager, see Chapter 3, "Program Manager." 

If you are adding several Windows applications or one or more non-Windows 
applications, using Setup is the best method. 

Setup will add only those non-Windows applications for which Setup has infor
mation. Setup includes information for many major applications, but not all. If 
Setup does not create a PIF for the application you want to add, you can create 
one. For more information on creating a PIF, see Chapter 12, "More About 
Applications. " 
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[> To add an application to Windows: 

1. Choose Set Up Applications from the Options menu. 

Setup displays a dialog box that allows you to direct Setup to search all drives, 
one drive, or the current path for applications. 

2. Choose the Down arrow to the right of the search option you want. 

3. Choose OK. 

At the completion of the search, the Set Up Applications dialog box appears. 

Applications found on hard disk(s): 

dBASE III Plus 
DESIGNER 
GRAPH 

icrosoft Excel 
Word Perfect 
Microsoft Basic 
Microsoft Advanced Basic 
Microsoft Works 

II Microsoft Excel 
C:\WINDOWS\EXCEL 

Set Up Applications 

Setup for use with Windows. 
Microsoft Word 

Add -} 

I<-Remove I 
MdAIl I 

,--I __ OK_--.JI I Cancel 

In the list box at the left, Setup lists the names of all the applications it found. 
These names are taken from the application; they are not supplied by Setup. 

When you select one of these applications, Setup displays the pathname of that 
application in the lower-left comer of the dialog box. Because more than one 
application can have the same name, check the pathname to make sure the 
application is the one you want. 

4. Select from the list box on the left the applications you want to add. 

If you are using a mouse, click on each application you want to select. If you 
are using the keyboard, use the DIRECTION keys to move to the application you 
want and press the SPACEBAR to select it. 

You can select more than one application by repeating this step for each 
application you want. 

If you change your mind about selecting an item, you can cancel the selection 
by clicking it again or, with the keyboard, by moving to it and pressing the 
SPACEBAR again. 
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5. After you select all the applications you want, choose Add to move them to 
the list box on the right. If you are using the keyboard, you do this by pressing 
ALT+A. 

To add all the listed applications to the right list box, choose Add All. With the 
keyboard, you can do this by pressing ALT + D. 

If you change your mind about adding an application after you add it to the 
right list box, click the application, and then choose Remove. With the key
board, move to the application and press the SPACEBAR to select it. Then press 
ALT + R to move it back to the left list box. 

6. Once you are sure you have selected the applications you want Windows to set 
up, choose OK. 

Running Setup from MS-OOS 
By running Setup from MS-DOS, you can: 

• Install a device driver (for a display, keyboard, mouse, network, or system) that 
is not supplied with Windows. 

Use Control Panel to install printer drivers. For more information, see Chapter 
5, "Control Panel." 

• Install an updated version of a device driver that you previously installed. 

Installing a Oevice Driver Not Supplied with Windows 

A specific set of device drivers was supplied with Windows 3.0. Additional 
device drivers become available as they are completed. See your device driver 
manufacturer for information about these device drivers. 

Microsoft also periodically provides the Driver Library Disk, which contains 
device drivers that are made available after Windows 3.0 was released. You can 
request the Driver Library Disk from Microsoft. See the Hardware Compatibility 
List for contact information. 

If you want to install a device driver that is not included with Windows, you must 
run Setup from MS-DOS. 
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Before running Setup, check for any special installation instructions that came 
with the device driver. There may be other things you will have to do to set up the 
hardware. Some drivers supply set-up information files that tell Setup what type of 
files (such as font files) the driver supports. If you are not sure what your device 
driver supports, contact the device-driver manufacturer. 

[> To install a device driver not supplied with Windows: 

1. Exit Windows. 

Do not use the DOS Prompt icon in the Main Group window. Using this icon 
will result in an incorrect set-up. 

2. Type setup and press ENTER. 

Setup lists your current Windows configuration. 

3. Press the UP or DOWN ARROW key to select the setting you want to change and 
press ENTER. 

A list of choices is displayed. 

4. Scroll to the bottom of the list using the DOWN ARROW key. 

5. Select Other and press ENTER. 

Select Other even if you are installing an updated version of a driver that 
appears on the list. 

Setup prompts you for the disk containing the device driver. 

6. Insert the disk into drive A. Setup displays a list of the device drivers on that 
disk. Then select the appropriate driver and press ENTER. 

Or type the pathname of the device driver and press ENTER. 

(You might be prompted for additional disks if more than one disk was 
provided from the device driver vendor.) 

Setup then copies the appropriate files to your Windows system directory and 
displays the updated list of your hardware. 

7. Press ENTER to complete the process. 

8. At the DOS prompt, type win to start Windows. 
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If Your System Hangs When You Run Setup 

Nonnally, Setup examines your hardware and displays the components you are 
using in the Windows Setup window. It is possible that an unusual hardware 
configuration could conflict with this hardware detection, leaving your system 
unresponsive (hanging). 

If this happens, try running Setup with the /I switch by typing setup Ii at the DOS 
prompt. This switch will prevent Setup from doing any hardware detection. Setup 
will display a default list of hardware instead of a list of your current hardware. 
You will need to change the settings to match your hardware. Follow the 
instructions in Setup. 

Starting Over When Things Go Wrong 

If, for some reason, changes to your files have left Windows inoperable, you will 
need to run Setup from MS-DOS. 

t> To install Windows from scratch: 

1. Exit Windows. 

2. Delete the Windows directory and all the files and subdirectories contained in 
it. 

3. Follow the procedure you used when you originally installed Windows. For 
more infonnation, see "Installing Windows with Setup" in Chapter 1. 
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Appendix 8 
Special Characters 

This appendix explains how to enter characters that usually are not found on your 
computer's keyboard. Some examples of these characters are accented letters 
(6, ~, 6), currency symbols (£, ¥), mathematical symbols (±, Il), and fractions (1;2). 

Your computer uses a character set to translate your keystrokes into the symbols 
you see on your screen or in your printed documents. Windows supports the 
American National Standards Institute (ANSI) character set, which includes 256 
characters, numbered 0 to 255. 

Using ANSI Characters with Windows 
Since Windows uses the ANSI character set, you can enter any of the ANSI 
characters in files you create with Windows. If the character is on the keyboard, 
just press the key. If the character is not on the keyboard, you can still enter it by 
using a special key combination. 

[> To enter an ANSI character that isn't on your keyboard: 

1. Locate the character you want on the ANSI chart (on the next page) and notice 
its corresponding numeric code in the column to the left. 

2. Press NUM LOCK to activate the numeric keypad on your keyboard if the 
keypad is not already active. 

3. Hold down ALT and type 0 and the 3-digit code from the ANSI chart on your 
numeric keypad. 

For example, to type the British pound symbol (£) in a Windows application, you 
would first locate it on the ANSI chart and notice that its character code is 163. 
Then you would hold down ALT while you typed 0163 on the numeric keypad. 

NOTE If you want to save a file using a special ANSI character in the filename, first check 
your computer's manual to make sure the character exists in your computer's character set. 
If the character does not exist in your computer's character set, Windows substitutes 
another character, which means you might have trouble locating the file later. 
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ANSI Character Set 

o • 
1 • 

2 • 

3 • 

4 • 

5 • 

6 • 

7 • 

8 • 

9 • 

10 • 

11 • 

12 • 

13 • 

14 • 

15 • 

16 • 

17 • 

18 • 

19 • 

20 • 

21 • 

22 • 

23 • 

24 • 

25 • 

26 • 

27 • 

28 • 

29 • 

30 • 

31 • 

32 

33 ! 
34 II 

35 D 

36 $ 
37 % 
38 &: 
39 

40 ( 

41 ) 

42 * 
43 + 

44 

45 -

46 • 

47 I 
48 0 

49 1 
50 2 
51 3 
52 4 
53 5 
54 6 
55 7 
56 8 
57 9 
58 

59 

60 < 
61 

62 ) 

63 ? 

64 ~ 

65 A 
66 B 
67 C 

68 D 
69 E 
70 F 
71 G 
72 H 
73 I 
74 J 

75 K 
76 l 

77 M 
78 H 
79 0 
80 P 
81 Q 
82 R 
83 S 

84 T 
85 U 
86 U 
87 W 
88 X 
89 Y 
90 2 

91 [ 

92 \ 

93 ] 

94 .... 

95 

96 ... 

97 a 
98 b 

99 C 

100 d 

101 e 
102 f 

103 g 
104 h 

105 i 
106 j 
107 k 
108 1 
109 (I) 

110 n 
111 0 

112 P 
113 q 
114 ... 

115 5 

116 t 
117 U 

118 U 

119 IJJ 

120 X 

121 Y 
122 Z 

123 { 

124 I 
125 } 

126 

127 • 

128 • 

129 • 

130 • 

131 • 

132 • 

133 • 

134 • 

135 • 

136 • 

137 • 

138 • 

139 • 

140 • 

141 • 

142 • 

143 • 

144 • 

145 ' 

146 ' 

147 • 

148 • 

149 • 

150 • 

151 • 

152 • 

153 • 

154 • 

155 • 

156 • 

157 • 

158 • 

159 • 

• Indicates that this character is not supported by Windows. 

160 

161 i 
162 ¢ 

163 £. 
164 I:f 

165 ¥ 
166 

167 § 
168 

169 © 
170 ~ 

171 « 

172 -. 

173 -

174 @ 

175 

176 0 

177 :!: 

178 l 

179 ]: 

180 

181 J.l 
182 ,-

183 • 

184 ... 

185 1 

186 Q 

187 » 

188 % 
189 % 
190 % 
191 l 

192 A 
193 A 
194 A 
195 A 
196 A 
197 li 
198 tI 

199 C 
200 E 
201 E 
202 E 
203 E 
204 i 
205 i 
206 i 
207 Y 
208 0 

209 H 
210 0 
211 11 
212 0 
213 ii 
214 ii 
215 X 

216 It 

217 U 
218 0 
219 0 
220 U 
221 Y 
222 ~ 

223 B 

224 a 
225 a 
226 a 
227 a 
228 a 
229 a 
230 C2 

231 C 
232 e 
233 e 
234 e 
235 e 
236 i 
237 i 
238 i: 
239 :.: 

240 (j 

241 n 
242 0 
243 6 
244 0 
245 0' 
246 ii 
247 

248 B 

249 U 
250 li 
251 (j 

252 U 
253 Y 
254 ~ 

255 9 
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Using Other Character Sets with Windows 
Character sets can vary among computer manufacturers. Most manufacturers 
follow a standard definition of characters 0 to 127, which correspond to the letters, 
numbers, and symbols you see on a standard U.S. keyboard. Manufacturers often 
differ, however, in their definitions of characters 128 to 255, which correspond to 
the special characters described at the beginning of this appendix. Thus, the British 
pound symbol is character 163 in ANSI but character 156 in the IBM personal 
computer's standard U.S. character set. 

The IBM PC extended character set is shown in the following chart. Windows 
can display and print only those characters that also appear on the ANSI chart. 
Windows does not support the other characters, each of which is denoted by a 
rectangle. 

IBM PC Extended Character Set 

128 C 144 E 160 a 176 192 208 I 224 I 240 I 
129 U 145 (J! 161 i 177 193 209 I 225 f) 241 :!: 

130 e 146 fI 162 6 178 194 210 I 226 I 242 I 

131 a 147 6 163 U 179 195 211 I 227 4( 243 I 

132 a 148 jj 164 n 180 196 212 I 228 I 244 I 

133 a 149 0 165 f.i 181 197 213 I 229 I 245 I 

134 a 150 (j 166 ~ 182 198 214 I 230 J.l 246 I 

135 ~ 151 U 167 Q 183 199 215 I 231 I 247 I 

136 e 152 y 168 b 184 200 216 I 232 I 248 0 

137 e 153 ii 169 185 201 217 I 233 I 249 I 

138 e 154 U 170 ~ 186 202 218 I 234 I 250 I 

139 :.: 155 ¢ 171 ~ 187 203 219 I 235 I 251 I 

140 i 156 f. 172 % 188 204 220 I 236 I 252 I 
141 i 157 V- 173 i 189 205 221 I 237 I 253 2: 

142 A 158 I 174 « 190 206 222 I 238 I 254 .. 
143 ~ 159 I 175 » 191 207 223 I 239 I 255 I 

I Indicates that this character is not supported by Windows. 
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You can use your computer's character set codes for any characters between 128 
and 255 that also exist in the ANSI character set, even if the ANSI code for the 
character is different. Windows performs the conversion to ANSI for you. If there 
is no corresponding ANSI character, Windows displays an arbitrary character. 

t> To enter a character using your computer's character code: 

1. Look up the code for the character in your computer manual. 

2. Check the ANSI chart to make sure the character is included. 

3. Press NUM LOCK to activate the numeric keypad on your keyboard if the 
keypad is not already active. 

4. Hold down ALT and type the 3-digit code from your computer's character set 
on your numeric keypad. Do not type 0 before the code. 

5. Release ALT. 

For example, to type the British pound symbol in Windows when using an IBM 
personal computer, you would hold down ALT while you type 156. Windows 
would convert 156 to its ANSI equivalent, 0163. 

NOTE If, after typing special characters in Windows, you work on your files with a non
Windows application, you might find that different characters have been substituted for 
your special characters. This is because the non-Windows application interprets the ANSI 
character codes as if they were the codes for your computer's character set. 
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Using Special Characters in a Non-Windows 
Application 

Non-Windows applications use your computer's character set, but the procedure 
for typing the character's value differs slightly from what you may be used to. 

t> To type a special character in a non-Windows application: 

1. Look up the code for the character in your computer manual. 

2. Press NUM LOCK to activate the numeric keypad on your keyboard if the 
keypad is not already active. 

3. Hold down ALT and type the 3-digit code from your computer's character set 
on your numeric keypad. 

4. Release ALT. 

Using Special Characters in a Non-Windows 
Document 

If you work in Windows on files created with non-Windows applications, you 
might find that any special characters appear as arbitrary characters-for example, 
a black rectangle (_). Windows attempts to translate these characters, but you will 
probably need to convert each character to its corresponding ANSI character. 

Microsoft Windows Write has an automatic conversion feature that converts 
characters in non-Windows files to the ANSI character set. See "Managing Write 
Files" in Chapter 7 for more information. 
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AppendixC 
Terminal Emulation Tables 

This appendix defines the technical specifications for tenninal emulations when 
you use the Microsoft Windows Tenninal application. There are two tables for 
each tenninal emulation: 

• Definition of the IBM PC equivalent keystrokes and the corresponding 
characters transmitted 

• Definition of the functions supported by Windows and their corresponding 
escape sequences 

The letter "I" is italicized ( I ) in all tables to help distinguish it from the numeral 
"1." 

VT 52 Terminal - Keyboard 
The following are the IBM PC equivalent keystrokes and corresponding characters 
transmitted for the Digital Equipment Corporation VT 52 Tenninal keystrokes. 

VT52 keyboard IBM PC keyboard Characters transmitted 

ASCII HEX 

PFI Fl ESC P IB 50 

PF2 F2 ESC Q IB 51 

PF3 F3 ESC R IB 52 

PF4 F4 ESC S IB 53 

LEFf ARROW LEFf ARROW ESC D IB 44 

UPARROW UPARROW ESC A IB 41 

RIGHT ARROW RIGHT ARROW ESC C IB 43 

DOWN ARROW DOWN ARROW ESC B IB 42 
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The host computer may prompt you to put your keyboard in keyboard application 
mode, a terminal emulation mode required for some applications. The following 
table lists keystrokes and characters for keyboard application mode. 

VT52 keyboard IBM PC keyboard Characters transmitted 

ASCII HEX 

0 0 ESC? P 1B 3F70 

ESC? q 1B 3F71 

2 2 ESC? r 1B 3F 72 

3 ESC? s 1B 3F 73 

4 4 ESC? t 1B 3F 74 

5 5 ESC? u 1B 3F 75 

6 6 ESC? v 1B 3F76 

7 7 ESC? w 1B 3F77 

8 ESC? x 1B 3F 78 

9 9 ESC? Y 1B 3F 79 

ESC? m 1B 3F6D 

, (or *) ESC? I 1B 3F6C 

ESC? n 1B 3F6E 

ENTER + ESC? M 1B 3F 4D 

LEFf ARROW LEFfARROW ESC 0 D 1B 4F44 

UPARROW UPARROW ESC 0 A 1B 4F 41 

RIGHT ARROW RIGHT ARROW ESC 0 C 1B 4F43 

DOWN ARROW DOWN ARROW ESC 0 B 1B 4F42 
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VT 52 Terminal - Functions 
The following are the supported functions for the Digital Equipment Corporation 
VT 52 Terminal and their corresponding escape sequences. 

Function Escape sequence 

ANSI MODE ENTER ESC< 

CURSOR MOVE DOWN ESCB 

CURSOR MOVE HOME ESCH 

CURSOR MOVE LEFT ESCD 

CURSOR MOVE RIGHT ESCC 

CURSOR MOVE UP ESCA 

CURSOR POSITION SET ESC Y Ie 

ERASE TO END OF LINE ESCK 

ERASE TO END OF SCREEN ESCJ 

IDENTIFY ESCZ 

KEYPAD APPLICATION ESC = 

KEYPAD NUMERIC ESC> 

LINE FEED REVERSE ESC I 
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VT 100 Terminal- Keyboard 
The following are the IBM PC equivalent keystrokes and corresponding characters 
transmitted for the Digital Equipment Corporation VT 100 ™ Terminal keystrokes. 

VT100 keyboard IBM PC keyboard Characters transmitted 

ASCII HEX 

PFI FI ESC 0 P 1B 4F 50 

PF2 F2 ESC 0 Q 1B 4F 51 

PF3 F3 ESC 0 R 1B 4F 52 

PF4 F4 ESC 0 S 1B 4F 53 

LEFfARROW LEFfARROW ESC [ D 1B 5B 44 

UPARROW UPARROW ESC [ A 1B 5B 41 

RIGHT ARROW RIGHT ARROW ESC [ C 1B 5B 43 

DOWN ARROW DOWN ARROW ESC [ B 1B 5B 42 
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The host computer may prompt you to put your keyboard in keyboard application 
mode, a terminal emulation mode required for some applications. The following 
table lists keystrokes and characters for keyboard application mode. 

VT100 keyboard IBM PC keyboard Characters transmitted 

ASCII HEX 

0 0 ESC a p IB 4F 70 

ESC 0 q IB 4F 71 

2 2 ESC 0 r IB 4F 72 

3 3 ESC 0 s IB 4F 73 

4 4 ESC 0 t IB 4F 74 

5 5 ESC 0 u IB 4F 75 

6 6 ESC 0 v IB 4F 76 

7 7 ESC 0 w IB 4F 77 

8 8 ESC 0 x IB 4F 78 

9 9 ESC 0 Y IB 4F 79 

ESC 0 m IB 4F 6D 

, (or *) ESC 0 I IB 4F6C 

ESC 0 n IB 4F 6E 

ENTER + ESC 0 M IB 4F 4D 

LEFT ARROW LEFT ARROW ESC 0 D IB 4F44 

UPARROW UPARROW ESC 0 A IB 4F 41 

RIGHT ARROW RIGHT ARROW ESC 0 C IB 4F 43 

DOWN ARROW DOWN ARROW ESC a B IB 4F42 
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VT 100 Terminal - Functions 
The following are the supported functions for the Digital Equipment Corporation 
VT 100 Terminal and their corresponding escape sequences. 

Substitute one or more values (separated by semicolons) from the specified table 
(* Tn) for the <xl> and <x3> arguments. 

Substitute a value from the specified table (* Tn) for the <x2> argument. 

Substitute a value specifying the desired number of characters or lines for the 
<n> argument. 

Substitute a value specifying the desired line and column number for the <I> and 
<c> arguments. 

Substitute a value specifying the desired row numbers for the top row and bottom 
row of the scrolling region for the <tr> and <hr> arguments. 

Function Escape sequence 

BACKSPACE I\H 

CARRIAGE RETURN I\M 

CHARACTER DELETE ESC [<n> P 

CHARACTER INSERT ESC [<n>@ 

CHARACTER WIDTH DOUBLE ESC#6 

CHARACTER WIDTH SINGLE ESC#5 

CURSOR MOVE DOWN ESC [<n> B 

CURSOR MOVE LEFf ESC [<n> D 

CURSOR MOVE RIGHT ESC [<n> C 

CURSOR MOVE UP ESC [<n>A 

CURSOR POSITION SET ESC [ <I> ; <c> H 

CURSOR POSITION SET (ABSOLUTE) ESC [ <I> ; <c> f 

CURSOR RESET ESC 8 

CURSOR SAVE ESC 7 

ERASE ENTIRE LINE ESC [2 K 

ERASE ENTIRE SCREEN ESC [2 J 

ERASE FROM START OF LINE ESC [1 K 
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Function Escape sequence 

ERASE FROM START OF SCREEN ESC [ I J 

ERASE NORMAL DATA FROM START OF ESC [ ? I J 
SCREEN 

ERASE NORMAL DATA ON LINE ESC [ ? 2 K 

ERASE NORMAL DATA ON SCREEN ESC [ ? 2 J 

ERASE NORMAL DATA TO END OF LINE ESC [ ? 0 K 

ERASE NORMAL DATA TO END OF ESC [ ? 0 J 
SCREEN 

ERASE NORMAL DATA TO START OF ESC [ ? I K 
LINE 

ERASE TO END OF LINE ESC [ 0 K 

ERASE TO END OF SCREEN ESC [ 0 J 

ESCAPE ESC 

IDENTIFY ESC Z 

INDEX ESCD 

INDEX REVERSE ESC M 

KEYPAD APPLICATION ESC = 
KEYPAD NUMERIC ESC> 

LINE DELETE ESC [<n> M 

LINE FEED "J 

LINE HEIGHT DOUBLE (BOTTOM) ESC # 4 

LINE HEIGHT DOUBLE (TOP) ESC # 3 

LINE INSERT ESC [ <n> L 

NEXT LINE ESC E 

READ CURSOR POSITION ESC [ <I> ; <c> R 

READ STATUS ESC [ Ps 5 

RING BELL "G 

SET SCROLLING REGION ESC [ <tr> ; <hr> r 

TAB CLEAR ESC [g 

TAB CLEAR ALL ESC 3 g 

TAB MOVE-HORIZONTAL "I 

TAB SET ESCH 

TERMINAL MODES RESET ESC [<xl> I (* TI) 
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Function 

TERMINAL MODES SET 

TERMINAL PARAMETERS REQUEST 

TRANSMIT DEVICE ATTRIBUTES 

SET MEDIA COPY OFF 

SET MEDIA COPY ON 

VIDEO ATTRIBUTE SET 

CHANGE GO CHAR SET TO GRAPHICS 

CHANGE GO CHAR SET UK 

CHANGE GO CHAR SET US ASCII 

CHANGE G 1 CHAR SET TO GRAPHICS 

CHANGEG1CHARSETUK 

CHANGE G 1 CHAR SET US ASCII 

GO ALTERNATE CHARACTER ROM 

G 1 ALTERNATE CHARACTER ROM 

TABLE 1 - TERMINAL MODES <xl> 

Function 

LINEFEED/NEWLINE 

APPLICATION/CURSOR KEYS 

ANSINT 52 

132/80 COLUMN 

SMOOTHflUMPSCROLL 

REVERSE/NORMAL SCREEN 

RELATIVE/ABSOLUTE ORIGIN 

CHARACTER WRAP ON/OFF 

AUTO REPEAT ON/OFF 

INTERLACE ON/OFF 

Escape sequence 

ESC [ <xl> h (* T1) 

ESC [ {sol} x 

ESC [c 

ESC [ 4 <x2> (* T2) 

ESC [ 5 <x2> (* T2) 

ESC [ <x3> m (* T3) 

ESC(O 

ESC(A 

ESC(B 

ESC)O 

ESC)A 

ESC)B 

ESC (2 

ESC) 2 

Escape sequence 

?O 

?1 

?2 

?3 

?4 

?5 

?6 

?7 

?8 

?9 
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TABLE 2 - MEDIA COpy MODES <x2> 

Function 

COpy ENTIRE SCREEN TO PRINT PORT 

COpy ENTIRE SCREEN TO MODEM 

DISABLE TRANSPARENT PRINT MODE 

ENABLE TRANSPARENT PRINT MODE 

COPY CURSOR ROW TO PRINT PORT 

COPY CURSOR ROW TO MODEM 

DISABLE COPY PRINT MODE 

ENABLE COPY PRINT MODE 

TABLE 3 - VIDEO ATTRIBUTES <x3> 

Function 

ATTRIBUTES OFF 

BOLD 

UNDERSCORE 

BLINK 

NEGATIVE (REVERSE) 

Escape sequence 

o 
2 

4 

5 

?1 

?3 

?4 

?5 

Escape sequence 

o 

4 

5 

7 





Appendix 0 
Command Lines in the CONFIG.SYS File 

To install memory-resident utilities such as SMARTDrive, you add a command 
line for the utility to your system's CONFIG.SYS file. This appendix explains the 
HIMEM, SMARTDrive, RAMDrive, EMM386, and EGA command lines. (For 
more information about what each utility does and how to install it, see Chapter 
13, "Optimizing Windows.") 

Using the HIMEM. SYS Command Line 
HIMEM is an extended memory manager-a utility that "administrates" the use of 
your system's extended memory so that no two applications can use the same 
memory at the same time. 

You install HIMEM by adding the HIMEM command line to your CONFIG.SYS 
file. The HIMEM command line must come before any command lines for applica
tions or device drivers that use extended memory. 

The HIMEM command line tells your computer: 

• Where to find the HIMEM program file. 

• The minimum amount of space an application must use in the High Memory 
Area (HMA) in order for HIMEM to give that application use of the HMA 
( optional). 

• How many extended memory handles HIMEM should make available 
( optional). 

• Whether or not to disable shadow RAM (optional). 

• What type of system you are using (optional). 

The HIMEM command line has the following form: 

device=pathname\himem.sys I hmamin=m Inumhandles=nl shadow: 
on/offlmachine:name 
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The following list explains each part of the command line. 

Use this value 

device = 

pathname\himem.sys 

Ihmamin=m 

I numhandles=n 

To do this 

Tell MS-DOS to install a device driver-in this 
case, HIMEM. You must include this part of the 
command line. 

Specify the pathname of the HIMEM program 
file. For example, if HIMEM.SYS is in the 
root directory of drive C, you would type 
c:\himem.sys. HIMEM.SYS should always be 
located on your start-up disk drive. If the 
HIMEM.SYS file is in the directory you use to start 
MS-DOS, you don't need to include a pathname. 
However, you must always include the filename 
(HIMEM.SYS). 

Specify how many kilobytes of memory an applica
tion must use in the High Memory Area (HMA) in 
order for HIMEM to give that application use of the 
HMA. Only one application can use the HMA at a 
time; HIMEM gives the HMA to the fIrst applica
tion that meets the memory-use requirements set by 
this switch. You can specify a value from 0 to 63. 

To ensure the most efficient use of your system's 
HMA, set /HMAMIN to the request size of the 
application that uses the most HMA memory. 

The /HMAMIN switch is optional; the default value 
is O. Omitting this switch (or setting it to 0) tells 
HIMEM to give the HMA to the first application 
that requests it. 

The /HMAMIN switch has no effect when 
Windows is running in 386 enhanced mode. 

Specify the maximum number of Extended 
Memory Block (EMB) handles that can be in use 
simultaneously. You can specify a value from 1 to 
128; the default is 32. Each additional handle 
requires an additional 6 bytes of memory. 



Use this value 

Ishadow:on/off 

Imachine:name 
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To do this 

Tell HIMEM whether or not to disable shadow 
RAM. Some computers make ROM code run faster 
by "shadowing" it in RAM-that is, by copying the 
ROM code into faster RAM memory at startup. 
However, this uses up some extended memory. 

Normally, on systems that use shadow RAM and 
have less than 384K of extended memory, HIMEM 
attempts to disable shadow RAM in order to 
recover additional extended memory for Windows' 
use. (HIMEM can disable shadow RAM only on 
certain types of systems.) When HIMEM disables 
shadow RAM, the ROM code runs in the slower 
ROM instead of RAM; therefore, your system 
might run slightly slower. 

The /SHADOW option lets you control HIMEM's 
treatment of shadow RAM. To leave the ROM code 
running from RAM, even on systems with less than 
384K of memory, specify the value Ishadow:on. To 
tell HIMEM to disable shadow RAM, specify the 
value I shadow :off. 

Tell HIMEM what type of computer you are using. 
Normally, HIMEM can detect your system type 
successfully; however, there are a few computers 
that HIMEM cannot detect. On such systems, 
HIMEM uses the default system type (IBM AT or 
compatible). You might need to include the 
/MACHINE option if your computer is a type that 
HIMEM cannot detect, and if HIMEM does not 
work properly on your system using the default 
system type. Currently, the only system that 
requires this switch is the Acer ® 1100. If you 
are using an Acer 1100, include the value 
Imachine:acerll00. 

The /NUMHANDLES option has no effect when 
Windows is running in 386 enhanced mode. 
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Sample HIMEM Command Lines 

This section shows three sample HIMEM command lines and explains what they 
do. 

Sample One: Running HIMEM with the Default Values 
The following command line runs HIMEM using the default values: 

device = himem.sys 

The command line does not include a pathname for HIMEM.SYS; therefore, 
MS-DOS looks for the HIMEM.SYS file in the root directory of the disk from 
which MS-DOS started. Because this command line does not include additional 
switches, HIMEM uses the default values for those switches. HIMEM will give 
the HMA to the first application that requests it, and will allow the simultaneous 
use of up to 32 extended memory handles. 

Sample Two: Controlling Use of the HMA with HIMEM 
The following command line tells HIMEM to give an application access to the 
HMA only if that application will use at least 40K of that memory: 

device = c:\windows\himem.sys Ihmamin=40 

The command line tells MS-DOS to look for the HIMEM.SYS file in the 
\WINDOWS directory on drive C. Because the /NUMHANDLES switch is 
not included, HIMEM will allow the simultaneous use of up to 32 extended 
memory handles. 

Sample Three: Increasing the Number of Memory Handles that 
HIMEM Provides 
The following command line tells HIMEM to allow simultaneous use of up to 128 
extended memory handles: 

device = c:\devices\himem.sys Inumhandles=128 

The command line tells MS-DOS to look for the HIMEM.SYS file in the 
\DEVICES directory on drive C. 128 is the maximum number of handles that 
HIMEM supports; by default, HIMEM allows simultaneous use of only 32 
handles. 
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Using the SMARTDrive Command Line 
SMARTDrive is a disk-caching program for computers that have a hard disk and 
extended or expanded memory. 

NOTE Windows/386 version 2.x will not run in conjunction with SMARTDrive version 3.0. 

You install SMARTDrive by adding the SMARTDrive command line to your 
CONFIG.SYS file. The SMARTDrive command line tells your computer: 

• Where to find the SMARTDrive program file. 

• The size of the SMARTDrive memory cache. 

• Whether SMARTDrive should use expanded or extended memory. 

The SMARTDrive command line has the following form: 

device=pathname'smartdrv.sys NormalCacheSize MinimumCacheSize fa 

The following list explains each part of the command line. 

Use this value To do this 

device = Tell MS-DOS to install a device driver-in this 
case, SMARTDrive. You must include this part of 
the command line. 

pathname'smartdrv.sys Specify the pathname of the SMARTDrive program 
file. For example, if SMARTDRV.SYS is in the 
\ WINDOWS directory on drive C, you would type 
c:\windows\smartdrv.sys. If the SMARTDRV.SYS 
file is in the drive and directory you use to start 
MS-DOS, you don't need to include a pathname. 
However, you must always include the filename 
(SMARTDRV.SYS). 
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Use this value 

N ormalCacheSize 

MinimumCacheSize 

To do this 

Specify the nonnal size of the SMARTDrive 
memory cache in kilobytes. This size will be in 
effect when Windows is not running. 

You can specify a value from 128 to 8192 (8MB). 
For example, to give SMARTDrive a 640K 
memory cache, specify 640. (Because 
SMARTDrive caches entire disk tracks, it rounds 
the cache size down to the nearest multiple of the 
largest disk track size on your system.) 

The NormalCacheSize value is optional; if you 
don't specify an amount, the SMARTDrive cache 
will use 256K of memory. If there is not enough 
memory to create a cache of the size you specify, 
SMARTDrive creates a smaller cache using the 
available memory. 

Specify the minimum size for the SMARTDrive 
cache. 

With an extended-memory cache, when Windows 
starts in standard mode or 386 enhanced mode, it 
immediately reduces SMARTDrive's cache to the 
minimum size. This lets Windows recover memory 
for its own use. 

With an expanded-memory cache, Windows 
reduces the cache when running in real mode; 
however, instead of immediately reducing the 
cache to its minimum size, Windows reduces the 
cache gradually as it needs the additional 
expanded memory. 

The MinimumCacheSize value is optional; if you 
don't specify an amount, Windows can reduce the 
cache size to its default minimum size, 256K. (If 
you include a value for MinimumCacheSize, you 
must also include a value for NormaICacheSize.) 



Use this value 

fa 
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To do this 

Specify that you want SMARTDrive's cache to use 
expanded memory, or that you want it to use your 
extended memory board as expanded memory. For 
SMARTDrive to use expanded memory, your 
system must be configured so that it provides 
expanded memory, and the command line for the 
expanded memory manager (such as EMM386, 
386MAX, CEMM, or QEMM) must appear in your 
CONFIG.SYS file before the SMARTDrive 
command line. 

This switch is optional; leave it out if you want 
SMARTDrive's cache to use extended memory. 
For SMARTDrive to use extended memory, your 
system must be configured so that it provides 
extended memory, and the command line for the 
extended memory manager (such as HlMEM.SYS) 
must appear in your CONFIG.SYS file before the 
SMARTDrive command line. 

Sample SMARTDrive Command Lines 

This section shows two sample SMARTDrive command lines and explains what 
they do. 

Sample One: Running SMARTDrive in Extended Memory 
If you have an 80286 or 80386 computer, you'll probably want to run 
SMARTDrive in extended memory and give it as much memory as possible. 
When you run Windows in standard mode or 386 enhanced mode, it shrinks 
SMARTDrive's cache to release memory for its own use. Windows and 
SMARTDrive then cooperate to provide both effective disk caching and efficient 
memory management. 

NOTE To run SMARTDrive in extended memory, the SMARTDrive command line must 
appear in your CONFIG.SYS file after the HIMEM command line. 
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The following command line runs SMARTDrive in extended memory: 

device = smartdrv.sys 1024 256 

This command line tells MS-DOS to look for the SMARTDRV.SYS file in the 
drive and directory from which you start MS-DOS. It gives SMARTDrive l024K 
(lMB) of extended memory, so the normal cache size is l024K. It specifies a mini
mum cache size of 256, so that Windows cannot make the cache any smaller than 
256K. (Windows will shrink an extended-memory cache only when running in 
standard mode or 386 enhanced mode.) 

Sample Two: Running SMARTDrive in Expanded Memory 
Normally, you'll want to run SMARTDrive in expanded memory only if you run 
Windows in real mode. 

The following command line runs SMARTDrive in expanded memory: 

device = c:\win\smartdrv.sys 2048 256 fa 

This command line tells MS-DOS to look for the SMARTDRV.SYS file in the 
\WIN directory on drive C. It gives SMARTDrive 2048K (2MB) of expanded 
memory, so the normal cache size is 2048K. It specifies a minimum cache size of 
256, so that Windows cannot make the cache any smaller than 256K. (Windows 
will shrink an expanded-memory cache only when running in real mode.) 

Using the RAMDrive Command Line 
RAMDrive is a utility that lets you use part of your system's memory as if it were 
a hard disk. This memory area is called RAM disk. 

NOTE Windows/386 version 2.x will not run in conjunction with RAMDrive version 3.0. 

To set up a RAM disk, you add the RAMDrive command line to your 
CONFIG.SYS file. The RAMDrive command line tells your computer: 

• Where to find the RAMDrive program file. 

• How much memory you want the RAM disk to use. 

• Attributes of the RAM disk (optional), such as the sector size and the number 
of root-directory entries. 

• Whether the RAM disk should use expanded or extended memory. 
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You can set up as many RAM disks as you want. Add one RAMDrive command 
line to your CONFIG.SYS file for each RAM disk you want. 

The RAMDrive command line has the following form: 

device = pathname\ramdrive.sys DiskSize SectorSize NumEntries Ie la 

The following list explains each part of the command line. 

Use this value 

device = 

pathname\ramdrive.sys 

DiskSize 

SectorSize 

To do this 

Tell MS-DOS to install a device driver-in this 
case, RAMDrive. You must include this part of 
the command line. 

Specify the pathname of the RAMDrive 
program file. For example, if RAMDRIVE.SYS 
is in the \WINDOWS directory on drive C, you 
would type c:\windows\ramdrive.sys. If the 
RAMDRIVE.SYS file is in the drive and 
directory you use to start MS-DOS, you don't 
need to include a pathname. However, you 
must always include the filename 
(RAMDRIVE.SYS). 

Specify how many kilobytes of memory you 
want to use for the RAM disk. For example, to 
create a 640K RAM disk, type 640. If you don't 
specify an amount, RAMDrive will create a 
64K RAM disk. You can specify a value from 
16 to 4096. 

Specify the sector size in bytes. The size can be 
128, 256, 512, or 1024 bytes. (If you include a 
SectorSize value, you must also include a value 
for DiskSize.) 

Normally, you should omit this value; the RAM 
disk will then use the default sector size of 512 
bytes. 
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Use this value 

NumEntries 

Ie 

To do this 

Limit the number of directory entries (files and 
directories) you can create in the RAM disk's 
root directory. The limit can be from 2 to 1024 
entries; the limit you specify will be rounded up 
to the nearest sector size boundary. If you do not 
specify a limit, you'll be able to create up to 64 
entries in the RAM disk's root directory. (If you 
include a value for NumEntries, you must also 
include values for DiskSize and SectorSize.) 

If there is not enough memory to create the 
RAM disk as specified, RAMDrive will try to 
create it with a limit of 16 directory entries. This 
may result in a RAM disk with a different limit 
from the one you specified. 

Create the RAM disk in extended memory. 

For RAMDrive to use extended memory, your 
system must be configured so that it provides 
extended memory, and the command line for 
the extended memory manager (such as 
HIMEM.SYS) must appear in your 
CONFIG.SYS file before the RAMDrive 
command line. 

Although specifying a memory type is optional, 
it is highly recommended. In general, it is best 
to create a RAM disk in extended memory if 
your system has extended memory. If you omit 
both the IE switch and the / A switch (described 
next), RAMDrive will use your system's base 
(conventional) memory. It is not a good idea to 
use base memory for a RAM disk, since doing 
so reduces the performance of Windows. 



Use this value 

la 
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To do this 

Create the RAM disk in expanded memory. 

For RAMDrive to use expanded memory, your 
system must be configured so that it provides 
expanded memory, and the command line 
for the expanded memory manager (such as 
EMM386, 386MAX, CEMM, or QEMM) must 
appear in your CONFIG.SYS file before the 
RAM Drive command line. 

Although specifying a memory type is optional, 
it is highly recommended. If you omit both 
the fA switch and the IE switch (described 
previously), RAM Drive will use your system's 
conventional memory. It is not a good idea to 
use conventional memory for a RAM disk, since 
doing so reduces the performance of Windows. 

Sample RAMDrive Command Lines 
This section shows three sample RAMDrive command lines and explains what 
they do. 

Sample One: Running RAMDrive in Extended Memory 
The following command line gives RAMDrive 64K of extended memory: 

device = ramdrive.sys Ie 

The IE switch tells RAMDrive to use extended memory; because the command 
line does not specify how much memory to use, RAMDrive uses the default 
(64K). 

Because this command line does not include a pathname for RAMDRIVE.SYS, 
MS-DOS looks for the RAMDRIVE.SYS file in your hard disk's root directory. 

NOTE To run RAMDrive in extended memory, the RAMDrive command line must appear 
in your CONFIG.SYS file after the HIMEM command line. 
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Sample Two: Running RAMDrive in Expanded Memory 
The following command line tells RAMDrive to run in expanded memory, and 
gives RAMDrive the maximum amount (4096K) of expanded memory that 
RAMDrive can use: 

device = c:\windows\ramdrive.sys 4096 la 

The command line tells MS-DOS to look for the RAMDRIVE.SYS file in the 
\ WINDOWS directory on drive C. 

Sample Three: Specifying Additional RAM Disk Attributes 
You can create a RAM disk with a specific number of disk sectors, and can limit 
how many entries the disk can contain in its root directory. 

The following command line gives RAMDrive 1024K of extended memory: 

device = d:\devices\ramdrive.sys 1024 512 64 Ie 

The command line creates a RAM disk with 512-byte sectors and a limit of 64 
root-directory entries. It tells MS-DOS to look for the RAMDRIVE.SYS file in the 
\DEVICES directory on drive D. 

Using the EMM386.SYS Command Line 
EMM386 is an expanded memory emulator-a utility that uses extended memory 
to simulate expanded memory. You should install EMM386.SYS only if you run 
applications that require expanded memory with Windows in real mode, or if you 
run such applications when you are not running Windows. 

You install EMM386 by adding the EMM386 command line to your 
CONFIG .SYS file. The EMM386 command line tells your computer: 

• Where to find the EMM386 program file. 

• How much memory you want EMM386 to use. 

• How you want EMM386 to use memory. 

The EMM386 command line has the following form: 

device=pathname\emm386.sys Memory MemoryOptions 
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The following list explains each part of the command line. 

Use this value 

device = 

pathname\emm386.sys 

Memory 

MemoryOptions 

To do this 

Tell MS-DOS to install a device driver-in this 
case, EMM386. You must include this part of the 
command line. 

Specify the pathname of the EMM386 program 
file. For example, if EMM386.SYS is in the 
\WINDOWS directory on drive C, you would 
type c:\windows\emm386.sys. If the EMM386.SYS 
file is in the drive and directory you use to start 
MS-DOS, you don't need to include a pathname. 
However, you must always include the filename 
(EMM386.SYS). 

Specify how many kilobytes of memory you want 
EMM386 to use. For example, to give EMM386 
640K of memory, specify 640. You can specify a 
value from 16 to 32768. (EMM386 rounds the 
value down to the nearest multiple of 16.) 

EMM386 reserves the memory you specify for the 
common memory pool. The memory will be avail
able to applications as expanded memory. 

This value is optional; if you don't specify an 
amount, EMM386 will use 256K of memory. 

Fine-tune the way EMM386 uses memory. 

The EMM386 memory options are optional 
parameters you can include on the EMM386 
command line. You use these options to control the 
location of the EMS page frame, determine how 
EMM386 uses certain addresses, and so on. For 
more information, see "Specifying EMM386 
Memory Options" later in this appendix. 
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Sample EMM386 Command Lines 

This section shows two sample EMM386 command lines and explains what they 
do. (The sample command lines in this section do not illustrate the memory 
options; for information on EMM386 memory options, see the following section, 
"Specifying EMM386 Memory Options.") 

Sample One: Running EMM386 Using the Default Values 
The following command line runs EMM386 using the default values: 

device = emm386.sys 

Because this command line does not include a pathname for EMM386.SYS, 
MS-DOS looks for the EMM386.SYS file in your hard disk's root directory. This 
command line allocates to EMM386 the default amount of memory (256K). This 
means that EMM386 can provide up to 256K of expanded memory to applications 
that need expanded memory. 

Sample Two: Allocating Memory to EMM386 
The following command line gives EMM386 4096K of memory, and tells 
MS-DOS to look for the EMM386.SYS file in the \WINDOWS directory on 
drive C: 

device = c:\windows\emm386.sys 4096 

Specifying EMM386 Memory Options 

Normally, you don't need to specify memory options on the EMM386 command 
line, since EMM386 usually runs properly using the default values. 

However, in some cases, you may want to control how EMM386 uses memory
for example, where EMM386 puts the EMS page frame, or which addresses it can 
use for EMS pages. EMM386 provides several command-line options that let you 
fine-tune the way it uses memory. You can use as many of these options as you 
want, in any order you want; be sure to include the options you want after the 
EMM386 pathname and memory amount (if any). 
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The following list describes the EMM386 memory options: 

Use this option 

w=onlo!! 

ji-ame=address 

pn=address 

x= addressrange 

To do this 

Enable or disable support for the Weitek Coprocessor. 
To enable support, include the value w = on on the 
command line. To disable support, include the value 
w = offinstead. By default, Weitek Coprocessor 
support is disabled. 

Specify the base address of the 64K page frame. 

Normally, you won't need to specify a base address; by 
default, EMM386 uses a contiguous 64K region of 
memory, and does not place the page frame below 
COOO:OOOO. However, sometimes it is not possible to 
identify adapter memory absolutely. If a conflict occurs, 
you may need to ensure that EMM386 places the page 
frame at a particular location. 

To specify a specific base address for the page frame, 
use the FRAME option to specify the address you want. 
For example, to place the page frame at C800:0000, 
include !rame=CBOO on the EMM386 command line. 

Define the address of a specific page. 

The P option has the form pn=address, in which n is 
the number of the page you are specifying, and address 
is the address you want. For example, to place page 4 at 
the address CCOO, include p4=CCOO on the EMM386 
command line. 

If you use the FRAME option, you cannot use the P 
option to specify addresses for pages 0 through 3. 

Prevent EMM386 from using a particular range of 
addresses for an EMS page. To specify the range, 
include this option on the command line, followed by 
the range of addresses you want to exclude. For 
example, to prevent EMM386 from using segments 
8000:0000 through 9000:0000, include the value 
x=BOOO-9000 on the command line. 
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Use this option 

b=address 

l=minXMS 

a=altregs 

h=handles 

To do this 

Specify the lowest address. By default, 4000:0000 is 
the lowest address. To specify a different low address, 
include this option on the command line, followed by 
the address you want. For example, to make 8000:0000 
the lowest address, include the value b=8000. You can 
specify an address from 1000:0000 to ECOO:OOOO. 

Ensure that the specified amount of extended memory 
will still be available after EMM386 is loaded. Specify 
the memory in kilobytes. For example, to ensure that 
640K of extended memory will be available after 
loading EMM386, include the value 1=640 on the 
command line. 

Specify how many fast alternate register sets you want 
to allocate to EMM386. For example, to allocate 16 
register sets to EMM386, include the value a=16 on 
the command line. You can specify a number from 
o to 254; the default is 7 sets. 

Specify how many handles EMM386 can use. For 
example, to let EMM386 use 127 handles, include the 
value h=127 on the command line. You can specify 
from 1 to 255 handles; the default is 255. 

Sample EMM386 Command Lines with Memory Options 

This section shows some sample EMM386 command lines that illustrate how to 
use EMM386 memory options. 

Sample One: Specifying the Location of the EMS Page Frame 
There are several ways to specify the base address for the EMS page frame. Each 
of the following sample command lines sets the page frame's base address at 
DOOO:OOOO, and gives EMM386 512K of memory. 

device = emm386.sys 512 frame=DOOO 

device = emm386.sys 512 pO=DOOO p1=D400 p2=D800 p4=DCOO 
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Sample Two: Excluding a Range of Memory Addresses 
Like the command lines in the preceding section, the following command line sets 
the page frame's location at the address DOOO:OOOO, and gives EMM386 512K of 
memory. In addition, however, this command line keeps EMM386 from using the 
memory addresses EOOO:OOOO to ECOO:OOOO. 

device = emm386.sys 512 !rame=DOOO x=EOOO-ECOO 

Using the EGA. SYS Command Line 

You need the EGA.SYS device driver if your system has an EGA monitor and you 
run non-Windows applications with Windows in real mode or standard mode. 

EGA.SYS enables Windows to keep track of the current state of the EGA video 
display. EGA.SYS does so by maintaining an exact copy of the contents of your 
system's video control registers. Whenever a non-Windows application writes to a 
video control register, EGA.SYS duplicates the application's change in the copy of 
that register that EGA.SYS maintains. 

To use EGA.SYS, add a command line like the following to your CONFIG.SYS 
file: 

device = c:\windows\ega.sys 

The EGA.SYS command line simply defines EGA.SYS as a device driver, and 
tells MS-DOS the location of the EGA.SYS file. 





Glossary 
386 enhanced mode A mode that Windows runs 
in to access the virtual memory capabilities of the 
Intel 80386 processor. This mode allows Windows 
to use more memory than is physically available 
and to provide multitasking for non-Windows 
applications. 

A 
active Describes the window or icon to which 
the next keystroke or command will apply. If a 
window is active, its title bar changes color to 
differentiate it visually from other open windows. 
If an icon is active, the Control menu appears. 

active printer The printer currently connected 
to a port. 

ANSI character set The American National 
Standards Institute 8-bit character set. It contains 
256 characters. 

application A computer program used for a 
particular kind of work, such as word processing 
or database management. This term is used 
interchangeably with "program" in this manual. 
See also Windows application, Non-Windows 
application. 

application icon A graphic that appears only 
after you start an application and then minimize it. 
Application icons are the only icons that appear on 
the desktop, outside window borders. 

application shortcut key A key combination 
that brings an application to the foreground when 
running Windows in 386 enhanced mode. 

application window A window that contains a 
running application. The name of the application 
appears at the top of this window. An application 
window may contain multiple document windows. 

ASCII character set The American Standard Code 
for Information Interchange 8-bit character set. It 
consists of the first 128 (0-127) characters of the 
ANSI character set. 

associate To identify a filename extension as 
"belonging" to a certain application. When you 
select a file with an extension that has been 
associated with an application, that application is 
opened automatically. 

8 
background The area behind the active window. 

binary file A file containing characters that are in 
machine-readable form. 

bitmap An image stored as an array of bits. 

boot To start your computer, or to restart it, 
loading the disk operating system (DOS). 

branch A segment of the File Manager 
Directory Tree, representing a directory and 
any subdirectories within it. 

built-in font (also known as resident or hardware 
font) A font that is built into the read-only memory 
(ROM) of a printer. 

c 
cartridge font A font contained in a cartridge that 
physically plugs into your printer. A cartridge font 
is usually used by laser printers in the HP LaserJet 
family, but some dot-matrix printers also use font 
cartridges. See also font cartridge. 

cascade A way of arranging open windows on 
the desktop so that they overlap each other, with the 
title bar of each window remaining visible. 
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cascading menu A menu that opens from a 
command on another menu. 

check box A small square box that appears in a 
dialog box and that can be selected or cleared. 
When the check box is selected, an X appears in the 
box. A check box represents an option that you can 
set. 

choose To use a mouse or key combinations to 
pick an item that begins an action in Windows. 

click To press and release a mouse button quickly. 

Clipboard A temporary storage location used to 
transfer data between documents and between 
applications. 

close To remove a document window or applica
tion window from the desktop. You can choose to 
save or abandon the document in a document win
dow before you close the application. 

collapse To "hide" additional directory levels 
below a selected directory in File Manager. 

COM port See serial port. 

command A word or phrase, usually found in a 
menu, that you choose in order to carry out an 
action. 

command button A button in a dialog box. It 
carries out or cancels the selected action. Two 
common command buttons are labeled Cancel 
and OK. 

communications settings Special settings that 
you use to tell Windows how to send information 
using a serial device such as a modem or printer. 
See also serial port. 

confirmation message A message displayed by 
Windows when you have specified a destructive 
action, asking you if you are sure you want to 
proceed. For example, Windows displays a confir
mation message when you tell it to delete a file. 

Control menu The menu appearing on every 
application that runs in a window and on some non
Windows applications. Icons, some dialog boxes, 
and windows within an application workspace also 
have Control menus. For applications running in a 
Window and for icons and dialog boxes, Control
menu commands move, change the size of, and 
close windows. For non-Windows applications, the 
Control-menu commands transfer information and 
perform other miscellaneous functions. Also known 
as System menu. 

Control-menu box The icon that opens the 
Control menu for the window. It is always at the 
left of the title bar. 

conventional memory The first 640K of memory 
that MS-DOS uses to run applications. 

copy To put a copy of the selected text or item 
on the Clipboard so you can transfer it to another 
location. Most Windows applications have a Copy 
command that performs this task. 

current directory The directory that is currently 
highlighted in the Directory Tree or whose direc
tory window is the active window. 

cut To move text from a document into a 
temporary storage area called the Clipboard. 

o 
data file Any file created within an application: 
a word processing document, a spreadsheet, a 
database file, a chart, and so forth. Also known as 
document. 

default button The command button in some 
dialog boxes selected as the most logical or safest 
choice. This button has a bold border when the 
dialog box appears, and pressing ENTER chooses the 
button. 

default printer The printer that Windows 
applications automatically use when you choose 
the Print command. You can have only one default 



printer, and the default printer must also be an 
active printer. 

desktop The screen background for Windows on 
which windows, icons, and dialog boxes appear. 

desktop pattern A geometric pattern that appears 
across the desktop. You can use Control Panel to 
design your own pattern or choose one from 
patterns provided by Windows. 

destination directory The directory to which you 
intend to copy or move one or more files. 

dialog box A rectangular box that either requests 
or provides information. Many dialog boxes present 
options to choose among before Windows can 
carry out a command. Some dialog boxes present 
warnings or explain why a command can't be 
completed. 

DIRECTION keys The four arrow keys on your com
puter keyboard. Each arrow key is named for the 
direction the key points: UP ARROW, DOWN ARROW, 

LEFf ARROW, and RIGHT ARROW. 

directory A collection of files and subdirectories 
that are stored at the same location on a disk. The 
name of the directory identifies its location. Part of 
the structure for organizing your files on a disk. 
See also subdirectory. 

directory path See pathname. 

Directory Tree A graphic display in File Manager 
of the directory structure of a disk. The directories 
on the disk are shown as a branching structure that 
resembles a tree. Directories are shown as branches 
off the top-level directory, known as the root 
directory. 

directory window A File Manager window that 
lists the contents of a directory. Each directory 
window shows all the files and other directories 
contained in the directory. 

disk drive A device used for storing and 
retrieving data on disks. 
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disk-drive icon An icon in File Manager that 
represents a disk drive. Different icons depict 
floppy disk drives, hard disk drives, network disk 
drives, RAM drives, and CD-ROM drives. 

document window A window within an applica
tion window. A document window contains a 
document you create or modify by using an applica
tion. There can be more than one document win
dow in an application window. 

DOS prompt The letter designation for the active 
drive. The prompt appears at the left side of the 
computer screen and is followed by a colon. 

double-click To rapidly press and release a mouse 
button twice without moving the mouse. Double
clicking carries out an action, such as opening an 
icon. 

downloadable font See soft font. 

drag To move an item on the screen by holding 
down the mouse button while moving the mouse. 
For example, you can move a window to another 
location on the screen by dragging its title bar. 

drive icon See disk-drive icon. 

drop-down list box A single-line dialog box that 
opens to display a list of choices. 

E 
EMS memory A type of expanded memory 
available on systems that conform to the Lotus
Intel-Microsoft Expanded Memory Specification 
(LIM EMS). 

emulation mode A mode in which a device such 
as a printer can imitate the behavior of a different 
device. See also terminal emulation. 

EPT port A port requiring a special card and 
special software. Only certain printers, such as the 
IBM Personal Pageprinter, use this port. 
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exclusive application An application that has sole 
use of the computer's resources while it is running 
in the foreground with Windows in 386 enhanced 
mode. When an exclusive application is running in 
a window, it gets most, but not all, of the resources. 

expand To show currently hidden levels in the 
Directory Tree. With File Manager, you can expand 
a single directory level, one branch of the tree, or 
all branches at once. 

expanded memory Memory in addition to conven
tional memory that is available for applications. It 
is allocated in 16K blocks. Windows will make use 
of expanded memory only if the /R switch is used 
at start-up. Windows running in 386 enhanced 
mode simulates expanded memory for the applica
tions that need it. Windows running in standard 
mode or 386 enhanced mode allows applications to 
use expanded memory, but it does not use expanded 
memory itself in the management of applications. 

extend selection To select more than one object. 
For example, you can select a group of files to be 
moved or copied with File Manager. 

extended memory Memory in addition to conven
tional memory that is not readily accessible to 
MS-DOS or MS-DOS applications. Extended 
memory cannot be used on 8086/88 computers. 
Windows running in standard mode or 386 
enhanced mode uses extended memory to manage 
and run applications. 

extension The period and three letters at the end 
of a filename. An extension identifies the kind of 
information a file contains. For example, files 
created with Calendar have the extension .CAL. 

F 
file A document or application that has been 
given a name. All documents are stored as files in 
Windows. 

file attribute A characteristic of a file-for 
example, the read-only attribute-that can be 
changed using File Manager. 

file format The structure or arrangement of data 
stored in a file. 

filename The name of a file. Windows uses DOS 
filenaming conventions. 

fixed-width font A font in which all characters 
have uniform widths. 

flow control The processes and procedures used 
to regulate the rate at which data is transferred from 
one device to another. Also known as handshake. 

font A graphic design applied to all numerals, 
symbols, and characters in the alphabet. A font 
usually comes in different sizes and provides 
different styles, such as bold, italic, and underlining 
for emphasizing text. 

font cartridge A piece of hardware that is plugged 
into a printer to supply one or more fonts. 

font family A group designation that describes the 
general look of a font. For example, the Roman 
font family contains fonts with serifs and variable 
character widths, such as Tms Rmn. 

font set A group of fonts designed for use with a 
specific device resolution. Windows includes seven 
sets of fonts. 

font size See point size. 

footer Text that appears at the bottom of every 
page of a document when it is printed. 

foreground The area of the screen occupied by 
the active window. 

format (1) The appearance of text on the pages of 
a document. (2) To prepare a disk so that it can hold 
information. Formatting a disk erases all infor
mation that was previously on it. 

full-screen application Any non-Windows 
application that occupies the whole screen rather 
than running in a window. 



G 
graphics resolution The level of quality at which 
Windows prints graphics. The higher the resolution, 
the better the quality of the printed graphics (and 
the slower the printing). 

group A collection of programs in Program 
Manager. Grouping your programs makes them 
easier to find when you want to start them. 

group icon The graphic that represents a Program 
Manager group that is minimized. Double-clicking 
the group icon opens the group window. 

group window A window that displays the items 
in a group within Program Manager. These items 
can be applications or data files associated with 
applications. 

H 
handshake A flow-control, or "go-ahead," signal 
sent by a local computer to a remote computer 
when working with a communications program 
such as Terminal. XON/XOFF is the standard 
software handshaking method, although it can't be 
used with remote systems that use a hardware hand
shaking method. 

header Text that appears at the top of every page 
of a document when it is printed. 

hidden file A system file that cannot be viewed, 
such as your MS-DOS BIOS file. 

high memory area See HMA. 

highlighted Indicates that an object or text is 
selected and will be affected by your next action. 
Highlighted text appears in reverse video on 
monochrome displays or in color on some color 
displays. Highlighted objects might change color 
or be surrounded by a selection cursor. 

HMA (high memory area) The first 64K of 
extended memory. This area is used by some 
applications. 
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I 
icon A graphical representation of various 
elements in Windows, such as disk drives, applica
tions, and documents. 

inactive window Any open window that you are 
not currently working in. 

insertion point The place where text will be 
inserted when you type. The insertion point usually 
appears as a flashing vertical bar in an application's 
window or in a dialog box. The text you type 
appears to the left of the insertion point, which is 
pushed to the right as you type. 

L 
list box Within a dialog box, a box listing avail
able choices-for example, the list of all available 
files in a directory. If all the choices won't fit, the 
list box has a vertical scroll bar. 

LPT port See parallel port. 

M ________________________ __ 
macro A series of actions recorded using the 
Recorder accessory. When you run the macro, 
Recorder carries out all the recorded actions. 
Macros can be assigned to special keys, called 
shortcut keys, or to longer descriptive names. 

mark To select text in a non-Windows application. 

Maximize button The small box containing an Up 
arrow at the right of the title bar. Mouse users can 
click the Maximize button to enlarge a window to 
its maximum size. Other users can use (he 
Maximize command on the Control menu. 

memory-resident software Software that is 
loaded into memory and is available for use even 
when another application is active. Also known as 
TSR software. 
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menu A list of items, most of which are Windows 
commands. Menu names appear in the menu bar 
near the top of the window. You use a command on 
a menu by selecting the menu name, then choosing 
the command. 

menu bar The horizontal bar containing the 
names of all the application menus. It appears 
below the title bar. 

Minimize button The small box containing a 
Down arrow at the right of the title bar. Mouse 
users can click the Minimize button to shrink a 
window to an icon. Other users can use the 
Minimize command on the Control menu. 

I\J 
network A group of computers connected by 
cables and using special software that allows them 
to share equipment (such as printers) and exchange 
information. 

network disk drive A disk drive that is available 
for public use on a network. Network disk drives 
are often used to store data files for many people in 
a work group. 

non-Windows application Computer programs 
that were not designed to run within the Windows 
environment. Non-Windows applications do not 
necessarily follow any of the Windows user inter
face conventions. Although most non-Windows 
applications can run with Windows, there may be 
limitations regarding how many of Windows' 
features they can take advantage of. 

o 
open To display the contents of a file in a window 
or to enlarge an icon to a window. 

option A choice in a dialog box. An option 
affects the way in which a command is carried 
out. Dialog boxes have several kinds of options, 
including mutually exclusive option buttons and 
non-exclusive check boxes. 

option button A small round button that appears 
in a dialog box and is used to select an option. 
Within a group of related option buttons, you can 
select only one button. 

p 
parallel interface An interface between a com
puter and a printer in which the computer sends 
multiple bits of information to the printer simul
taneously. Parallel and Centronics interfaces are the 
same type. 

parallel port A connection on a computer, usually 
LPTl, where you plug in the cable for a parallel 
printer. Windows supports parallel ports LPTI 
through LPT3. 

parameter Information added to the command 
that starts an application. This information deter
mines how the application will run. For example, to 
start Microsoft Word in character mode, you would 
type word / c at the DOS prompt. The / c is the 
parameter. A parameter can be a filename or any 
type of information up to 62 characters in length. 

paste To transfer the contents of the Clipboard to 
an application. Many applications have a Paste 
command that performs this task. 

path name The directions to a directory or 
file within your system. For example, 
C:\ WINDOWS3\APPTS\JUNE.CAL is the path
name of the JUNE.CAL file in the APPTS sub
directory in the WINDOWS3 directory on drive C. 

pels See pixels. 

personal Windows directory The directory, 
usually located on your hard disk, that contains the 
Windows files that were loaded to your system 
when you ran Windows Setup. 

PIF (program information file) A file that 
provides information that Windows needs to run a 
non-Windows application. For example, you use a 
PIF to tell Windows to run a non-Windows 



application in a full screen rather than in a window 
or to specify a start-up directory. 

pixels The smallest graphic units on the screen. 
Also known as picture elements (pels). 

point To move the pointer on the screen until it 
rests on the item you want to select or choose. 

point size The height of a printed character. A 
point equals In2 of an inch. 

pointer The arrow-shaped cursor on the screen 
that indicates the position of the mouse. 

port A connection on a computer where you plug 
in the cable that carries data to another device. 

print queue A list of files that have been sent 
to a particular printer. The list indicates the file 
currently printing and those waiting to be printed. 

Printer Cartridge Metrics file (PCM) A file that 
contains Printer Fonts Metrics files for each font on 
a font cartridge. 

printer driver Special software that controls how 
your computer and printer interact. A printer-driver 
file supplies Windows with information such as the 
printing interface, descriptions of fonts, special 
features, and so on. 

Printer Font Metrics file (PFM) A file that 
supplies a Windows printer driver with information 
about a font, such as family, point size, widths of 
individual characters, and more. 

program information file See PIE 

program item icon The graphic that represents 
an application that you can start from Program 
Manager. A program item icon is contained in a 
group window. 

proportional font A font in which different 
characters have varying widths. 
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protected mode The operating mode of a 
computer that is capable of addressing extended 
memory directly. 

protocol A set of rules that define how computers 
communicate with each other. 

Q 
queue See print queue. 

R 
RAM (random access memory) The memory that 
is used to run applications and perform other neces
sary tasks while the computer is on. When you tum 
the computer off, all information in RAM is lost. 
See also virtual memory. 

raster font A font created as a graphic bitmap 
image. It is available only in a fixed size-not 
scalable. A raster font is used mostly on the screen, 
but is also used by some dot-matrix printers and 
built into some laser printers. 

read-only file A file that you can only open and 
read. You cannot edit a read-only file and save it 
again. 

real mode An operating mode that Windows runs 
in to provide maximum compatibility with versions 
of Windows applications prior to 3.0. Real mode is 
the only mode available for computers with less 
than 1MB of extended memory. 

Restore button The small box containing a Down 
arrow and an Up arrow at the right of the title bar. 
The Restore button appears after you have enlarged 
a window to its full size. Mouse users can click the 
Restore button to return the window to its previous 
size. Other users can use the Restore command on 
the Control menu. 

root directory The highest directory of a disk. The 
root directory is created when you format the disk. 
From the root directory, you can create other 
directories. 
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s 
scaled point size A point size that approximates a 
specified point size for use on the screen. 

screen font A raster font designed to duplicate a 
printer font on the screen. See also raster font. 

scroll To move text or graphics up or down, or 
left or right, in order to see parts of the file that 
cannot fit on the screen. 

scroll bars The bars at the bottom and right 
edge of a window whose contents are not entirely 
visible. Each scroll bar contains a small box, called 
a scroll box, and two scroll arrows to allow 
different types of scrolling. 

scroll buffer In Terminal, the buffer that holds 
typed or received information that does not fit on 
the screen. 

select To highlight an item by clicking it with the 
mouse or usin"g key combinations. Selecting does 
not initiate an action. After selecting an item, you 
choose the action you want to affect the item. See 
also choose and highlighted. 

selection cursor The marking device that shows 
where you are in a window, menu, or dialog box. 
The selection cursor can appear as a highlight or as 
a dotted rectangle around the text in a dialog box 
option. 

serial interface An interface between a computer 
and a printer in which the computer sends single 
bits of information to the printer, one after the 
other. Serial, asynchronous, and RS232 interfaces 
are all the same type. 

serial port A connection on a computer, usually 
COMI, where you plug in the cable for a serial 
printer or another serial communications device, 
such as a modem. 

server See network disk drive. 

share A partition of a network disk drive. 

shortcut key A key combination that carries out 
some action in Windows. For example, pressing 

" ALT + ESC switches among loaded applications. 

shrink To reduce a window to an icon at the 
bottom of the desktop using the Minimize button. 
The document or application remains open and can 
be the active document or application. 

soft font A font that is downloaded to your 
printer's memory from a disk provided by the font 
manufacturer. 

solid color The color that appears on a display 
when all pixels are the same color. On a mono
chrome display, there are only two solid colors: 
black and white. 

source directory The directory that contains the 
file or files you intend to copy or move. 

spool To print a document or file in the back
ground while working on something else. 

standard mode The normal operating mode for 
running Windows. This mode provides access to 
extended memory and also lets you switch among 
non-Windows applications. 

standard setting Standard settings are settings 
shipped with Windows. For example, if you print a 
drawing or document from one of the Windows 
accessories without entering new margin settings, 
the accessory uses standard margin settings to print. 

subdirectory A directory contained within another 
directory. All directories are subdirectories of the 
root directory. 

swap file An area of your hard disk that is set 
aside for exclusive use by Windows in 386 
enhanced mode. This area is used only when your 
system runs low on memory. 

switch See parameter. 

System menu See Control menu. 



system time The time set by your computer's 
internal clock. 

T 
task An open application, when you are using 
Task Manager. 

terminal emulation A setting specified with 
Terminal that causes your computer to emulate a 
remote computer. Terminal emulation allows your 
computer to display data it receives and to use 
features of the remote computer. 

text box A box within a dialog box where you 
type information needed to carry out the chosen 
command. The text box may be blank when the 
dialog box appears or may contain text. 

text file A file containing only letters, digits and 
symbols. A text file usually consists of characters 
coded from the ASCII character set. 

tile A way of arranging open windows on the 
desktop so that no windows overlap but all win
dows are visible. Each window takes up a portion 
of the screen. 

title bar The horizontal bar located at the top of a 
window and containing the title of the window. On 
many windows, the title bar also contains the 
Control-menu box and Maximize and Minimize 
buttons. 

TSR software See memory-resident software. 

v 
vector font A series of dots connected by lines 
that can be scaled to different sizes. Plotters 
typically use vector fonts. Also known as stroke 
font. 

virtual machine An environment created by 
Windows running in 386 enhanced mode in which 
an application can run and behave as if it had an 
entire machine all to itself. Windows in 386 
enhanced mode can have multiple applications 
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running in their own separate virtual machines at 
the same time. 

virtual memory A memory management system 
used by Windows running in 386 enhanced mode, 
which allows Windows to behave as if there were 
more memory than is actually present in the sys
tem. Virtual memory equals the amount of free 
RAM plus the amount of disk space allocated to a 
swap file that Windows uses to simulate additional 
RAM. 

volume label A name that identifies a disk. 
The volume label appears in the title bar of the 
Directory Tree window. 

Mf ________________________ ___ 

wallpaper A picture or bitmapped pattern that 
appears as the Windows desktop. 

wildcard character A character that represents 
another character. In filenames, you can use the 
asterisk (*) as a wildcard character to indicate any 
character or group of characters that might match 
that position in other filenames. For example, 
* .EXE represents all files that end with the .EXE 
filename extension. 

window A rectangular area on your screen in 
which you view an application or document. See 
also application window and document window. 

Windows application Any application that was 
designed especially for Windows and will not run 
without Windows. All Windows applications follow 
the same conventions for arrangement of menus, 
style of dialog boxes, use of the keyboard and 
mouse, and so on. 

word wrap A feature that moves text from the end 
of a line to the beginning of a new line as you type. 
With word wrap, you do not press ENTER at the end 
of each line in a paragraph. 

workspace The area of a window that displays 
the information contained in the application or 
document you are working with. 
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386 Enhanced command, in PIF Editor, 447 
386 enhanced mode 

conserving disk space by preventing swapping, 507 
Control menu, 60 
Control Panel options for, 192 - 193 
defined, xxiii 
device contention options, 190 - 192 
Edit commands, 32, 60 
freeing up memory for applications, 480 - 482 
making the network card compatible with, 548 
non-Windows applications with 

changing settings for, 476 
described, 50, 440 

permanent swap file for 
adjusting size of, 524 
changing location of, 524 
described, 521 
displaying information about, 520 
removing, 525 
setting up, 522 

PIF options for 
Allow Close When Active, 473 
Allow Fast Paste, 473 
Application Shortcut Key, 475 
Close Window on Exit, 462 
Display Usage, 460 
EMS Memory, 465 
Emulate Text Mode, 472 
Execution, 461 
Lock Application Memory, 469 
Memory Requirements, 460 
Monitor Ports, 471 
Multitasking, 463, 465 
Optional Parameters, 451 
Program Filename, 458 
Reserve Shortcut Keys, 474 
Retain Video Memory, 472 
Start-up Directory, 452 
Uses High Memory Area, 468 
Video Memory, 470 
Window Title, 459 
XMS Memory, 467 - 468 

printer ports, setting access priorities for, 164 
requirements for running, x 
Settings command, 33 
starting Windows in, 429 
temporary swap file for 

changing location of, 527 
controlling size of, 528 

PIF options for (continued) 
temporary swap file for (continued) 

deleting to free up disk space, 509 
described, 520, 526 
setting up, 527 

386SPART.PAR file, 509, 521 
_DEFAULT.PIF file, 449 

A 
About Application command, in Help menu, 72 
Accessories 

Calculator, 357 
Calendar, 370 
Cardfile, 386 
Clock,398 
Notepad,399 
Paintbrush, 263 
PIF Editor, 444 
Recorder, 405 
Terminal, 317 
Write, 223 

Accessories group, described, 80 
Active printer, 169 
Active windows 

closing, 48 
defined,54 

Add command, in Cardfile, 388 
Add dialog box, in Cardfile, 388 
Airbrush tool, in Paintbrush, 281 
Alarm Controls dialog box, 377 
Alarms, in Calendar 

removing, 378 
setting for an appointment time, 375 
setting for early ring, 377 
shutting off, 378 
silent alarm option, 376 

Alert Always command, in Print Manager, 204 
All Pages option, in Write, 256 
Allow Close When Active option, in PIF Editor, 473 
Allow Fast Paste option, in PIF Editor, 473 
Always Warn option, in Control Panel,. 191 
Analog command, in Clock, 399 
ANSI charal!:ter set 

See also Character set 
chart,568 
converting to, 570 
entering characters not on keyboard, 567 

ANSI format for Write documents, 253 
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Append File option, in Terminal, 342 
Application icons, defined, xxiii 
Application Shortcut Key option, in PIF Editor, 475 
Application swap files 

controlling location of, 530 
deleting to free up disk space, 509 
described, 529 
using RAM disk for, 530 

Application windows 
described, 19 
moving, 41 
opening the Control menu for, 28 
rearranging, 55 
selecting, 54 

Applications 
See also Program items 
adding with the Setup program, 562 
associating documents with, 135 
changing default directory for, 97 
compatibility with Windows 3.0, 438 
defined, xxiii 
freeing up memory while running, 478 
icons for, 82 
identifying older versions, 437 
improving access to network, 554 
non-Windows. See Non-Windows applications 
PIFs for. See PIFs 
problems running in 386 enhanced mode, 552 
problems running in standard mode, 551 
problems with, 482 - 489 
processing speed, described, 493 
quitting, 63 
returning to Program Manager from within, 97 
running in real mode, 438 
running older versions with Windows, 438 
running two or more at once 

described, 50 
device contention options, 190 - 192 
processing time options, 192 - 193 

starting 
from a directory window, 51,137 
from a document or program file, 137 
from a group, 51, 96 
from a network, 546 
from the Windows command line, 431 
with the Run command, 52 

swap files for, 529 - 530 
temporary files for, 509 
transferring data between modes, 439 
Windows. See Windows applications 
working with different types, described, 437 

Appointments calendar. See Calendar 
Archive file attribute, 134 

Arrange Icons command, in Program Manager 
rearranging group icons, 86 
rearranging program item icons, 86 

Arranging 
application windows, 55 
File Manager windows, 114, 120 
icons 

individually, 86 
with Task List, 56 
with the Arrange Icon command, 84, 86 
with the Auto Arrange command, 84 

overlapping group windows, 84 
Arrow keys, defined, xxiv 
ASCII files, transferring, 335 
Associate command, in File Manager 

associating documents with an application, 136 
deleting an association, 137 

Associate dialog box, 136 
Associating documents with applications, 135 
Attributes. See File attributes 
Auto Arrange command, in Program Manager, 83 
Auto command, restoring Clipboard format, 61 
Autodial command, in Cardfile, 397 
Autodial dialog box, 397 - 398 
AUTOEXEC.BAT file 

described, 518 
editing to free up memory, 516 - 518 

Automatic phone dialing, by Cardfile, 397 

B 
Back button, in on-line Help, 74 
Background color, selecting for a drawing, 270 
Background Priority option 

in PIF Editor, 464 
of the Settings command, 477 

Backing up Write files, 255 
Batch files, creating PIFs for, 448 
Baud Rate option 

in Cardfile, 398 
in Terminal, 327 

Beep, turning sound on and off, 190 
Binary files 

and nonconversion to Write format, 254 
defined, 335 

Binary number system, with scientific calculator, 364 
Binary Transfers command, in Terminal, 339 
Binary Transfers dialog box, 339 
Bitmaps 

creating, 155 
displaying as wallpaper, 155 

Bold type 
in a Paintbrush drawing, 276 



Bold type (continued) 
in Write documents, 237 
purpose in this guide, xxii 

Box tool, in Paintbrush, 291 - 292 
Browse button, in on-line Help, 74 
Browsing 

through filenames of program items, 90 
through list of network servers, 106 

Brush Shapes command, in Paintbrush, 287 
Brush Shapes dialog box, 287 
Brush tool, in Paintbrush, 286 - 287 
Buffer Lines option, in Terminal, 326 
BUFFERS command line 

in CONFIG.SYS file, 500 - 501,517 
By Name command, in File Manager, 117 
By Type command, in File Manager, 117 

c 
Calculator 

copying a value to the Clipboard, 360 
described, 357 
entering simple calculations, 358 
memory functions, described, 359 
pasting from the Clipboard 

binary, octal, and hex values, 364 
decimal values, 360 

scientific 
described, 362 - 363 
number systems, 363 - 364 
statistical calculations, 364 - 366 
Statistics Box buttons, described, 366 
table of number base functions, 367 
table of operators, 366 
table of statistical functions, 368 
table of trig and log functions, 368 - 369 

standard 
described, 357 - 358 
memory functions, described, 359 
table of standard calculator functions, 361 

starting, 357 
using with the Clipboard, 359, 361 

Calendar 
Alarm Controls dialog box, 377 
customizing, 378 - 381 
Day Settings dialog box, 379 
day view 

adding a special time, 380 
adding notes, 373 
changing the day settings, 379 
deleting a special time, 380 
displaying different appointment days, 373 - 374 
editing appointments, 373 

Calendar (continued) 
day view (continued) 

entering appointments, 372 
removing alarms, 378 
setting alarms for appointments, 375 
setting alarms to ring early, 377 
shutting off an alarm, 378 
silent alarm option, 376 

described, 370 
managing files 

opening read-only files, 382 
removing appointments, 382 

Mark dialog box, 381 
month view 

described,375 
displaying appointments for a date, 375 
marking dates, 380 - 382 

Page Setup dialog box, 384 - 385 
Print dialog box, 383 
printing appointments 

changing the margins, 384 
with headers and footers, 385 - 386 
with standard settings, 383 

Remove dialog box, 383 
Show Date dialog box, 374 
Special Time dialog box, 380 
starting, 370 
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switching between day view and month view, 371 
Canceling 

dialog boxes, 41 
menus, 26 
selections 

in dialog boxes, 38 
in directory windows, 128 

Capacity of computer system, described, 493 
Cardfile 

Add dialog box, 388 
adding cards to a file, 388 
Autodial dialog box, 397 - 398 
deleting a card, 394 
described, 386 
duplicating a card, 394 
editing cards 

changing the index line, 391 
copying text to another card, 392 
described, 391 
moving text to another card, 392 
pasting pictures, 393 

entering an index line, 387 
entering card information, 388 
Find dialog box, 390 
finding text, 390 - 391 
Go To dialog box, 389 
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Cardfile (continued) 
Index dialog box, 387 
listing the cards, 388 
managing files 

merging files, 395 
tracking the number of cards, 394 

Merge dialog box, 395 
moving through cards 

bringing a card to the front, 389 - 390 
scrolling, 389 

phone dialing, 397 
printing cards 

entire file, 396 
single card, 396 

restoring a changed card, 393 
starting, 386 

Carrier Detect option, in Terminal, 328 
Cartridge fonts, installing, 179 
Cartridges option, in Control Panel, 168 
Cascade command 

rearranging application windows, 55 
rearranging document windows, 66 
rearranging File Manager windows, 114, 120 
rearranging group windows, 84, 86 
rearranging icons, 55 

Cascading menus, defined, 28 
Change All option, in Write, 230 
Change Attributes command, in File Manager, 135 
Change Attributes dialog box, 135 
Change command, in Write, 229 
Change dialog box, 230 
Change option, in Write, 230 
Change Selection option, in Write, 230 
Change System Settings command, in Setup, 560 
Change System Settings dialog box, 560 
Change, then Find option, in Write, 230 
Changing 

directories, 108 
program item properties, 96 

Character at a Time option, in Terminal, 336 
Character sets 

converting to ANSI, 570 
entering ANSI characters, 567 
with non-Windows applications, 571 

Characters 
character styles 

in a document, 237 
in a Paintbrush drawing, 276 

formatting, 237 
subscript, 238 
superscript, 238 
translation of, 567 - 571 

Check boxes, selecting options, 40 

Checkmark next to command names, defined, 28 
CHKDSK program, 54, 510 - 511 
Choosing 

defined, xxiii 
menu commands, 27 

Circle/Ellipse tool, in Paintbrush 
drawing circles and ellipses, 293 - 294 
drawing perfect circles, 294 

Clear Buffer command, in Terminal, 348 
Clear command, in Paintbrush, 303 
Clearing check boxes, 40 
Clicking, defined, xxiii 
Clicks + Drags option, in Recorder, 412 
Clipboard 

clearing contents of, 62 
copying an entire screen to, 58 
copying information to, 57 
cutting and pasting cutouts in drawings, 296 
defined,56 
file formats supported by, 61 
moving information to, 57 
opening files, 62 
pasting information from, 59 
saving contents in a file, 61 
size of, 56 
using with Calculator, 359, 361 
using with Terminal, 346 
viewing contents of, 61 

Clock 
analog display, 398 
digital display, 399 
starting, 398 

Close All Directories command, in File Manager, 121 
Close command, on Control menus 

closing directory windows, 121 
closing the Change dialog box, 230 
closing the Find dialog box, 229 
described, 32 
exiting Windows, 12 

Close Window on Exit option, 456, 462 
Closing 

See also Quitting 
active windows, 48 
dialog boxes, 41 
directory windows, 121 
files. See Saving documents and files 
menus, 26 
on-line Help, 74 

Collapse Branch command, in File Manager, 111 
Collapsing a directory, 111 
Color dialog box, 148 - 149 
Color Eraser tool, in Paintbrush, 282 - 283 



Colors 
custom, in Paintbrush, 306 - 307 
filling in shapes with, 285 - 286 
for text in a drawing, 277 
for the desktop 

creating a color scheme, 148 - 149 
defining custom colors, 150 - 152 
removing a color scheme, 150 
using an existing color scheme, 147 

inverting in cutouts, 302 
leaking through borders, 286 
replacing in a drawing, 282 - 283 
selecting in Paintbrush, 270 

Colors option, in Paintbrush, 266 
Columns option, in Terminal, 324 
Command buttons, described, 35 
Command lines 

EGA.SYS, 599 
EMM386.SYS, 594 
HIMEM.SYS, 583 
RAMDRIVE.SYS, 590 
SMARTDRIVE.SYS, 587 
Windows 

described, 427 
samples of, 431 

Commands option, in Help menu, 72 
Communications command, in Terminal, 326 
Communications dialog box, 326 
Communications with remote computers. See Terminal 
CONFIG.SYS file 

adding EMM386.SYS command line, 541 
and memory configuration, 499 
described, 517 
editing to free up memory, 516 - 517 
for an 80286 computer, 501 
for an 80386 or 80486 computer, 500 
for an 8086 or 8088 computer, 502 
sample EMM386 command lines, 596 - 598 
sample HIMEM command lines, 586 
sample RAM Drive command lines, 593 - 594 
sample SMARTDrive command lines, 589 - 590 

Configure dialog box 
changing printer ports, 164 
changing standard print options, 166 
changing timeout options, 171 
removing installed printers, 173 - 174 

Configuring memory 
on an 80286 computer, 500 - 501 
on an 80386 or 80486 computer, 499 
on an 8086 or 8088 computer, 502 

Configuring ports. See Ports 
Configuring printers 

active, 169 

Configuring printers (continued) 
default, 170 
described, 164 
ports 

choosing, 163 - 164 
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setting access priorities for 80386 computers, 164 
print options 

changing, 166 
described, 167 - 168 

timeout options 
changing, 171 - 172 
described, 171 

Confirm on Delete option, in File Manager, 133 
Confirm on Mouse Operation option 

in File Manager, 133 
Confirm on Replace option, in File Manager, 133 
Confirm on Subtree Delete option, in File Manager, 133 
Confirmation command, in File Manager, 132 
Confirmation dialog box, 132 
Confirmation messages, in File Manager, 132 
Connect Net Drive command, in File Manager 

browsing through network disk drives, 106 
connecting to a network disk drive, 105 

Connect Network Drive dialog box, 105 
Connecting 

to network printers, 172 
to network servers, 105 - 106 
to remote computers, 334 

Connector option, in Terminal, 328 
Control codes for Terminal function keys, 331 
Control-menu box, described, 21 
Control menus 

commands in, 32 
Control-menu box for, 21 
described, 28 
Edit commands in, 60 
opening, 28 - 29 

Control Panel 
386 enhanced mode 

dialog box, 191 
options, 190 - 193 

changing printer ports, 163 - 164 
changing the keyboard speed, 189 
Color dialog box, 148 - 149 
colors. See Desktop 
Configure dialog box 

changing printer ports, 164 
changing standard print options, 166 
changing timeout options, 171 
removing installed printers, 173 - 174 

Currency Format dialog box, 185 
Custom Color Selector dialog box, 150 
customizing the mouse, 187 -188 
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Control Panel (continued) 
Date & Time dialog box, 188 
Date Format dialog box, 182 
Desktop dialog box, 153 
desktop. See Desktop 
Fonts dialog box 

adding a font, 177 
removing a font, 180 

icons for Control Panel options 
choosing, 147 
described, 146 - 147 

installing new printers, 159 
International dialog box, 181 
international settings, 180 - 186 
Keyboard dialog box, 189 
List of Printers box, 162 
Mouse dialog box, 187 
network options, 177 
Number Format dialog box, 186 
Ports dialog box, 176 
Printers dialog box 

adding printers, 159 - 160 
choosing the active printer, 169 
choosing the default printer, 170 
printing without using Print Manager, 175 

removing a printer, 173 - 174 
setting system date and time, 188 - 189 
Settings dialog box, 176 
Setup Printer dialog box, 165 - 166 
Sound option, 190 
starting, 145 
Time Format dialog box, 184 

Control+Break Checking command, in Recorder, 419 
Controls command, in Calendar, 376 
Conventional memory, described, 494 
Conventions used in this guide, described, xxi 
Copies option, in Write, 256 
Copy command 

copying a PIF to your Windows directory, 446 
copying files or directories, 131 
copying from a non-Windows application, 57 
copying from a Windows application, 57 
copying program items to a group, 95 
copying selected text, 69 
copying text from the Terminal window, 346 
copying text to a Cardfile card, 392 
copying the display in Calculator, 360 
described,32 

Copy Diskette command, in File Manager, 140 
Copy To command, for saving cutouts, 300 
Copying 

Cardfile text to another card, 392 
cutouts in drawings, 298 

Copying (continued) 
diskettes, 140 - 141 
files to a group window or icon, 91 
files to another directory, 130 - 131 
from non-Windows applications, 57 
from Windows applications, 57 
multiple files at once, 131 
program items between groups, 94 

Correcting typing mistakes, 67 
Country option, in Control Panel, 181 
CR to CR\LF option, in Terminal, 325 
CRC. See Cyclic redundancy check scheme 
Create Directory command, in File Manager, 123 
Create Directory dialog box, 123 
Creating directories, 123 
Creating drawings 

Airbrush tool, 281 
Box tool, 291 - 292 
Brush tool, 286 - 287 
changing standard drawing size, 265 - 266 
choosing font for text, 275 - 276 
Circle/Ellipse tool, 293 - 294 
Color Eraser tool, 282 - 283 
Curve tool, 288 - 289 
defining cutouts, 279 - 280 
described, 263 
entering text, 274 - 277 
Eraser tool, 284 - 285 
Filled Box tool, 291 - 292 
Filled Circle/Ellipse tool, 293 - 294 
Filled Polygon tool, 294 - 295 
Filled Rounded Box tool, 292 
Line tool, 290 - 291 
moving in a large drawing, 267 
Paint Roller tool, 285 - 286 
Paintbrush window, described, 265 
Polygon tool, 294 - 295 
Rounded Box tool, 292 
selecting a drawing line width, 271 
selecting a drawing tool, 272 
selecting colors, 270 
Text tool, 274 
using a drawing tool, 272 

Creating groups, 87 
Currency Format dialog box, 185 
Current directory, defined, 103 
Cursor 

See also Selection cursor 
changing blink rate, 158 
in Paintbrush window 

changing brush shapes, 287 
described, 264 
displayingx-y coordinates, 304 



Cursor option, in Tenninal, 325 
Cursor Position command, in Paintbrush, 304 
Curve tool, in Paintbrush, 288 - 289 
Custom Color Selector dialog box, 150 
Customizing 

Calendar, 378 - 381 
desktop appearance. See Desktop 
keyboard, 189 
mouse, 187 
system resource usage. See Optimizing Windows 

Cut command, on Edit menus 
cutting from a Windows application, 57 
deleting selected text, 69 
moving text to another Cardfile card, 392 
transferring a cutout to the Clipboard, 296 

Cutouts 
changing size, 301 
copying, 298 
creating 

free-fonn, 279 
rectangular or square, 280 

cutting and pasting, 296 
described,279 
flipping, 302 
inverting colors, 302 
pasting from a file to a drawing, 300 
sweeping, 297 - 298 
tilting, 303 

Cutting. See Copying 
Cyclic redundancy check scheme, 339 

D 
Daily appointment calendar. See Calendar 
Data Bits option, in Tenninal, 327 
Data files. See Documents 
Data transfer 

between applications, 56 
between computers. See File transfers 
between modes, 439 
increasing buffer size for, 551 
with networks, 548 

Date & Time dialog box, 188 
Date command, in Calendar, 374 
Date Fonnat dialog box, 182 
Dates 

adding current date to Notepad files, 404 
changing the fonnat of, 182 - 183 
changing the system date, 188 
marking in Calendar, 380 - 382 

Day command, in Calendar, 371 
Day.Markings dialog box, 381 
Day Settings command, in Calendar, 379 

Day Settings dialog box, 379 
Default option, in Paintbrush, 266 
Default PIF settings, 449 
Default Preferences dialog box, 417 
Default printer, 170 
Delete command 

clearing the Clipboard, 62 
deleting a macro, 415 
deleting Card file cards, 394 
deleting files or directories, 132 
deleting groups, 88 
deleting program items from groups, 94 

Delete dialog box, in File Manager, 132 
Deleting 
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associations between files and applications, 136 
cards from Cardfile, 394 
files from a print queue, 202 
files or directories, 131 
font files, 180 
groups, 88 
macros, 415 
portions of a drawing 

with BACKSPACE or Undo, 272 
with the Eraser tool, 284 - 285 

program items from a group, 94 
text, 69 

Demonstrations, creating macros for, 418 - 419 
Deselect All command, in File Manager, 128 
Desktop 

changing cursor blink rate, 158 
changing icon spacing, 156 
changing width of window borders, 157 
color schemes for 

choosing existing scheme, 147 
creating, 148 - 149 
defining custom colors, 150 - 152 
removing, 150 

defined, xxiv 
grid lines, 157 
initial appearance, 79 
lining up windows and icons, 157 
patterns for 

changing, 153 - 154 
choosing, 152 
creating, 154 
removing, 154 

saving the appearance for future sessions, 81 
wallpaper for 

choosing a bitmap, 155 
creating, 155 

Desktop dialog box, 153 
Detect Idle Time option, in PIF Editor, 465 
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Device contention options 
for 386 enhanced mode, 190 - 192 

Device drivers, installing, 563 
Device Not Selected timeout option, 171-172 
Diagonal lines, drawing perfectly straight, 291 
Dial command, in Terminal, 334 
Dial Type option, in Cardfile, 398 
Dialog boxes 

closing, 41 
described,33 
moving, 41 
moving within, 34 
opening the Control menu for, 30 
options within 

check boxes, 40 
command buttons, 35 
described,33 
drop-down list boxes, 38 
list boxes, 36 
option buttons, 39 
text boxes, 36 

Digital command, in Clock, 399 
Direct memory access buffer 

changing size settings in SYSTEM.lNI file, 549 
DIRECTION keys, defined, xxiv 
Directly Modifies options, in PIF Editor, 455 
Directories 

changing, 108 
changing default for applications, 97 
changing sort order, 117 
collapsing, 111 
copying, 130 - 131 
creating, 123 
current, 103 
defined, xxiv 
deleting, 131 
destination, 128 
expanding, 109 - 110 
for a shared copy of Windows, 545 
moving, 128 
naming conventions, 122 
renaming, 133 
root, 101 
searching for, 123 
selecting 

from directory windows, 125 -127 
from the Directory Tree, 108 

source, 128 
Directory icons, described, 104 
Directory path, in Directory Tree window, 103 
Directory Tree 

collapsing directory levels, 111 
described, 10 1 - 104 

Directory Tree (continued) 
displaying for another disk drive, 104 
expanding directory levels, 109 - 110 
selecting from, 108 

Directory windows 
arranging, 120 
canceling selections, 128 
changing default displays, 115 - 116 
changing sort order, 116 - 117 
choosing the types of files to display, 118 
closing 

all open windows, 121 
the active window, 121 

described, 101, 111 
display options, 114 - 120 
icons in, 112 
opening, 112 
replacing contents of, 114 
selecting, 113 
selecting files and directories from 

all, 127 
more than one group, 127 
mUltiple consecutive, 126 
mUltiple nonconsecutive, 126 
one at a time, 125 

sort options for, 117 
starting applications from, 137 
status bar, 120 
updating, 121 

Disconnect Net Drive command, in File Manager, 106 
Disconnecting 

from network printers, 173 
from network servers, 106 
from remote computers, 350 

Disk-drive icons, described, 103 
Disk drives, changing, 104 
Disk space 

and 386 enhanced mode, described, 497 
and real or standard mode, described, 497 
conserving by preventing swapping, 507 
controlling amount used for swapping, 524 - 526 
displaying number of kilobytes available, 498 
effect on performance, described, 493 
freeing up by deleting files, 507 

Disk-caching program, 530 - 535,587 - 590 
Diskettes 

copying, 140 - 141 
formatting, 138 
system, 139 

Disks 
labeling, 141 
volume labels, defined, 103 



Display options 
for the Settings command, 477 
in PIF Editor, 469 

Display Usage options, in PIF Editor, 460 
Document windows 

described, 19 
opening the Control menu for, 29 
selecting, 32 
switching among, 65 

Documents 
See also Files 
adding to groups, 88 - 91 
associating with applications 

in File Manager, 135 - 136 
in Program Manager, 91 

deleting associations, 136 
opening from group windows, 96 
opening read-only, 64 
printing. See Printing 
saving, 64 
working with in Write. See Write 
working with text, basic techniques, 66 - 69 

DOS. See MS-DOS 
DOS prompt 

icon for, 53 
running programs from, 53 
starting, 53 

Dotted box. See Selection cursor 
Double-clicking, defined, xxiv 
Double-click speed, changing, 187 
Draft option, in Paintbrush, 309 
Draft Quality option, in Write, 256 
Drawing area 

changing standard size, 265 
described, 264 
displaying entire drawing, 268 - 269 
displaying entire screen, 268 

Drawings 
creating. See Creating drawings 
editing. See Editing drawings 
managing files. See Paintbrush files 
printing 

a portion of drawing, 310 
changing printers, 313 
changing standard margins, 311 
currently displayed drawings, 309 - 310 

viewing, 268 - 269 
Driver Library Disk, 162 
Drop-down list boxes 

described, 38 
opening, 39 

Duplicate command, in Cardfile, 394 
Duplicating cards in Cardfile, 394 

E 
Echo, keystroke, 324 
Edit Colors command, in Paintbrush, 306 
Edit Colors dialog box, in Paintbrush, 306 
Edit commands in 386 enhanced mode, 32, 60 
Editing drawings 

aligning text and lines, 304 
basic techniques, 273 
by zooming in, 305 
changing cutout size, 301 
copying cutouts, 298 
creating custom colors, 306 - 307 
flipping cutouts, 302 
inverting colors in cutouts, 302 
opaque pasting and sweeping, 299 
pasting cutouts, 300 
pixel by pixel, 305 
sweeping cutouts, 297 - 298 
text, 278 
tilting cutouts, 303 
transparent pasting and sweeping, 299 
using eraser tools, 296 
using the Clipboard, described, 296 

Editing graphics 
in Paintbrush. See Editing drawings 
in Write. See Pictures; editing in Write 

Editing text 
basic techniques, 69 
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in a Paintbrush drawing. See Editing drawings 
in Calendar. See Calendar 
in Cardfile cards, 391 - 392 
in Terminal, 346 - 348 
in Write. See Write; editing documents 

EGA.SYS command line 
in CONFIG.SYS file, 502,599 

Ellipses, drawing hollow or solid, 293 
Ellipsis following command names, defined, 28 
EMM386 utility 

command lines for, 594 - 598 
installing, 540 

EMS bank line, moving, 430, 540 
EMS memory. See Expanded memory 
EMS Memory options, in PIF Editor, 465 
Emulate Text Mode option, in PIF Editor, 472 
End mark, in Write window, 224 
End Task option, in Task List, 489 
Enlarge Font command, in Write, 239 
Enlarging windows, 45 
Entering text in documents, 66 
Eraser tool, in Paintbrush, 284 - 285 
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Erasing 
color in a drawing, 282 - 283 
portions of a drawing 

with BACKSPACE, 272 - 273 
with the Undo command, 272 - 273 
with the Eraser tool, 284 - 285 

text in a drawing, 278 
Error checking 

cyclic redundancy check scheme, 339 
Error messages. See Messages 
Everything option, in Recorder, 412 
Exclusive in Foreground option, in Control Panel, 193 
Exclusive option 

in PIF Editor, 461 
of the Settings command, 477 

Execution options, in PIF Editor, 461 
Exit command 

closing a window, 49 
deleting all files from print queues, 202 
exiting from the Print Manager window, 206 
exiting Terminal, 351 
quitting an application, 63 
quitting File Manager, 142 

Exit Windows command, 11, 98 
Expand All command, in File Manager, 110 
Expand Branch command, in File Manager, 110 
Expand One Level command, in File Manager, 110 
Expanded memory 

controlling use by Windows, 429, 538 
described,495 
installing additional, 506 
providing by using EMM386, 540 
reconfiguring as extended memory, 501 
use by applications, 465 

Expanded memory emulator, installing, 540 
Expanded memory manager, 495 
Expanding a directory, 109 - 110 
Extended memory 

described,495 
installing additional, 504 
reconfiguring expanded memory as, 501 
running SMARTDrive in, 533 
use by applications 

with 386 enhanced mode, 467 - 468 
with standard or real mode, 454 

Extending a selection 
in a list box, 38 
in directory windows, 125 - 126 

F 
File attributes 

described, 134 - 135 
setting, 135 

File Attributes option, in File Manager, 116 
File Details command, in File Manager, 115 
File formats, choices for Write documents, 254 
File information line, in print queue, 200 
File Manager 

See also Directories and Directory windows 
Associate dialog box, 136 
Change Attributes dialog box, 135 
Confirmation dialog box, 132 
Connect Network Drive dialog box, 105 
copying files and directories, 130 
Create Directory dialog box, 123 
Delete dialog box, 132 
described, 101 
Disconnect Net Drive dialog box, 106 
Include dialog box, 118 
making a system diskette, 139 
Move dialog box, 130 
moving files and directories, 128 
printing files, 134 
quitting, 142 
replacing Program Manager as the startup program, 102 
Search dialog box, 123 
Search Results window, 124 
selecting files. See Directory windows 
setting file attributes, 134 
shrinking to an icon, 120 
Sort By dialog box, 117 
starting, 101 
View Other dialog box, 115 
windows 

arranging, 120 
closing, 121 
updating, 121 

File Merge dialog box 
in Cardfile, 395 
in Recorder, 416 

File servers. See Network servers 
File transfers 

binary 
described, 335 
preparing for, 338 
receiving files, 345 - 346 
sending files, 344 

protocols for, 335 
specifying communications settings for, 326 - 328 

... 



File transfers (continued) 
text 

described, 335 
preparing for, 336 - 338 
receiving files, 341 - 343 
sending files, 340 - 341 
viewing files, 343 - 344 

File type option, in File Manager, 119 
Filename extensions 

associating with applications, 136 
conventions for naming files and directories, 122 
deleting associations, 136 
for bitmap files, 155 
for Calendar files, 382 
for Cardfile files, 394 
for Clipboard files, 62 
for group files, 87 
for Notepad files, 402 
for Paintbrush cutout files, 300 
for Paintbrush drawings, 307 
for Paintbrush palette files, 307 
for PIF files, 448 
for program files, 92 
for Recorder files, 414 
for temporary files, 13 
for Terminal files, 320, 350 
for Write files, 254 - 255 
when saving files, 65 

Files 
attributes, 134 
binary transfers, 335 
Clipboard, 61 
copying 

to a group window or icon, 91 
to another directory, 130 - 131 

deleting, 131 
deleting to optimize Windows, 508 - 511 
for communications settings, 320 
managing Calendar files 

opening read-only files, 382 
removing appointments, 382 

managing Cardfile files 
merging files, 395 
tracking file size, 394 

managing Notepad files 
adding current time and date, 404 
creating time-log file, 403 - 404 
displaying file size, 402 

managing Paintbrush files 
described, 307 
opening, 308 
printing a drawing, 309 - 313 
saving, 308 

Files (continued) 
managing Paintbrush files (continued) 

using Microsoft Paint files, 308 
managing Recorder files 

changing macro properties, 414 
deleting macros, 415 
merging files, 416 

managing Write files 
backing up, 255 
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converting non-Windows files to Write format, 254 
managing Write files (continued) 

converting Word files to Write format, 253 
format choices when saving documents, 254 
opening binary files, 254 
opening Text Only files, 253 

moving 
several at once, 130 
to another directory, 128 

naming conventions, 122 
opening, 64 
opening read-only, 64 
personal, using with a network, 546 
printing. See Printing 
renaming, 133 
saving with ANSI characters in filename, 567 
searching for, 123 
selecting from directory windows, 125 - 127 
sorting in directory windows, 116 - 117 
starting applications from, 137 - 138 
temporary, 13,509 
text transfers, 335 

FILES command line 
in CONFIG.SYS file, 500 - 501,517 

Filled Box tool, in Paintbrush, 291- 292 
Filled Circ1e/Ellipse tool, in Paintbrush, 293 - 294 
Filled Polygon tool, in Paintbrush, 294 - 295 
Filled Rounded Box tool, in Paintbrush, 292 
Find command 

in Cardfile, 390 
in Notepad, 402 
in Write, 228 

Find dialog box 
in Cardfile, 390 
in Notepad, 402 
in Write, 228 

Find Next option, in Write, 230 
Finding text 

in Cardfile cards, 390 - 391 
in Notepad documents, 401 - 402 
in Write documents, 228 - 229 

Flash if Inactive command, in Print Manager, 204 
Flip Horizontally command, in Paintbrush, 302 
Flip Vertically command, in Paintbrush, 302 
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Floppy disks. See Diskettes 
Flow Control options, in Terminal, 327 
Font Installer, 179 
Fonts 

defined,178 
deleting font files, 180 
for printers, 168 
in a Paintbrush drawing, 275 - 276 
in Write 

and default printer, 239 
changing font name, 239 - 240 
changing font size, 240 
described, 239 

installing screen fonts, 178 
problems with, 214 
viewing printer fonts on the screen, 178 

Fonts command, in Write, 240 
Fonts dialog box 

adding a font, 179 
removing a font, 180 

Footer command, in Write, 247, 249 
Footers 

adding to documents, 247 - 249 
defined,247 
in Calendar appointments, 385 - 386 
in Paintbrush drawings, 311 - 312 
using page numbers as, 249 

Foreground color, selecting for a drawing, 270 
Foreground Priority option 

in PIF Editor, 464 
of the Settings command, 477 

Format Diskette command, in File Manager, 139 
Formatting diskettes, 138 
Formatting text. See Write; formatting documents 
Free disk space 

effect on performance, 493 
increasing by deleting files, 507 

Freehand drawing, with Brush tool, 286 
Fromrro Pages option, in Write, 256 
Full Screen option 

in PIF Editor, 461 
of the Settings command, 477 

Full-duplex systems, 324 
Function keys 

in Terminal window, 333 
shortcut keys for macros, 408 

Function Keys command, in Terminal, 330 
Function Keys dialog box, 330 - 332 

G 
Games group, described, 80 
Genericrrext Only printer driver, 162 
Get Colors command, in Paintbrush, 307 
Go To command, in Cardfile, 389 
Go To dialog box 

in Cardfile, 389 
in Write, 226 

Go To Page command, in Write, 226 
GOTO key, 225 
Granularity, for the sizing grid, 157 
Graphics 

creating in Paintbrush. See Creating drawings 
editing in Write, 232 - 233 
mode, for applications; 453, 470 - 471 
resolution, printing problems with, 216 

Graphics Resolution option, in Control Panel, 168 
Group icons, defined, xxiv 
Group windows 

defined,81 
opening, 82 
opening documents from, 96 
rearranging, 55,84 
rearranging icons when resizing, 83 
resizing, 42 
shrinking, 82 

Groups 
adding items to 

from File Manager, 91 
from Program Manager, 88 - 89 
from Setup, 93 

appearing when Windows starts up, 79 - 80 
changing contents of, 88 
changing the description of, 88 
copying files to, 91 
copying items between, 94 
creating, 87 
defined, xxiv 
deleting, 88 
deleting items from, 94 
described, 80 
icons for, 81 
moving items between, 95 
starting applications from, 51, 96 



H 
Half-duplex systems, 324 
Handshaking 

data transfer problems, 352 
printing problems, 215 
specifying in Terminal, 327 

Hanging indent 
creating, 245 - 246 
defined, 245 

Hangup command, in Terminal, 350 
Hard disk 

changing the interleave, 513 
compacting, 512 - 513 
disk space, described, 497 
methods for improving efficiency of, 507 

Hardware Compatibility List, 162 
Header command, in Write, 247, 249 
Headers 

adding to documents, 247 - 249 
defined, 247 
in Calendar appointments, 385 - 386 
in Paintbrush drawings, 311 - 312 
using page numbers as, 249 

Height option, in Paintbrush, 266 
Help option, in Setup Printer dialog box 

for printer information, 168 
Hexadecimal number system 

using with scientific calculator, 364 
Hidden file attribute, 135 
"Hidden" windows. See Inactive windows 
Hide Function Keys command, in Terminal, 333 
High Memory Area option, in PIF Editor, 468 
High Priority command, in Print Manager, 203 
Highlighting. See Selecting 
HIMEM utility, 500 - 501,583 - 586 
Horizontal lines, drawing perfectly straight, 291 
Hour Format option, in Calendar, 379 
Hue, defined, 150 
Hyphens, for optional line breaks, 231 

I 
IBM PC extended character set, 569 
Icons 

changing, 91 
changing spacing of, 156 
copying files to, 91 
defined, xxiv 
described, 23 - 25 
directory, 104 
disk-drive, 103 
for applications, 82 

Icons (continued) 
for network applications, 554 
group, xxiv, 81 
in Control Panel window, 146 - 147 
in directory windows, 113 
in on-line Help, 74 
lining up, 157 
moving, 41 
opening Control menus for, 29 
program item, xxv, 81 
rearranging 

individually, 86 
with Task List, 56 
with the Arrange Icons command, 84, 86 
with the Auto Arrange command, 84 

restoring windows from, 46 
shrinking windows to, 44 
switching to, 55 

Idle option, in Control Panel, 192 
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Ignore if Inactive command, in Print Manager, 204 
Ignore Mouse option, in Recorder, 412 
Image Attributes command, in Paintbrush, 265 
Image Attributes dialog box, 265 - 266 
Inactive applications, messages from, 63 
Inactive printer, making active, 169 
Inactive windows 

making active, 54 
rearranging to make visible, 84 
selecting when "hidden", 54 

Include command, in File Manager, 118 
Include dialog box, 118 
Indentation, paragraph 

changing, 244 
hanging indent, 245 
vs. changing margins, 244 

Indents command, in Write 
changing paragraph indentation, 244 
creating a hanging indent, 246 

Index button, in on-line Help, 74 
Index cards. See Cardfile 
Index command 

in Cardfile 
changing the index line, 391 
filling in a blank card, 387 

in Help menu, 72 
Index dialog box, 387 
Inserting text, 66 
Insertion point 

in Notepad window, 400 
in text boxes, 36 
in Write window, 224 
moving through a Write document, 224 - 225 
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Installing printers 
checking compatibility, 162 
printer-driver files 

described, 159 
Generic!Text Only, 162 
installing a new version, 161 
using the current version, 161 

unlisted in Control Panel, 163 
using Control Panel, 159 - 160 

Installing Windows, 7 - 8 
International dialog box, 181 
International settings 

currency format, 185 
date format, 182 - 183 
number format, 186 
options, described, 181 - 182 
time format, 183 - 184 

Interval option, in Calendar, 379 
Inverse command, in Paintbrush, 303 
Italics 

I( 

in a Paintbrush drawing, 276 
in Write documents, 237 
purpose in this guide, xxii 

Kermit option, in Terminal, 339 
Keyboard 

See also on-line Help 
changing the repeat rate, 189 
for correcting typing mistakes, 67 
for moving in a Notepad file, 401 
for moving in Calendar, 372 
for moving in Write documents, 225 
for moving through cards in Cardfile, 389 
for moving within text, 67 
for scrolling, 48 
for selecting from directory windows, 125 
for selecting from the Directory Tree, 108 
for selecting text in documents, 68 
for using on-line Help, 70, 72 
for working with dialog boxes, 34 - 41 
for working with menus, 26 - 29 
for working with windows, 42 - 47 
formats, defined 

KEYl + KEY2, xxiii 
KEYl, KEY2, xxiii 

function keys in Terminal, 330 - 332 
IBM PC equivalent keystrokes 

for VT 100 terminals, 576 
for VT 52 termminals, 573 

recording key sequences. See Recorder 

Keyboard (continued) 
shortcut keys 

for macros, 407 - 408 
in Write, 225 

using in Paintbrush 
for moving in a large drawing, 267 
mouse button equivalents, 263 

using with Calculator 
numeric keypad, 358 
standard calculator functions, 361 

Keyboard buffer for applications, 455 
Keyboard command, in Help menu, 72 
Keyboard dialog box, 189 
Keyboard Layout option, in Control Panel, 181 

L 
Label Disk command, in File Manager, 141 
Labeling disks, 141 
Labels. See Volume labels 
Landscape orientation, 166 
Language option, in Control Panel, 181 
Large-frame EMS mode 

moving bank line in, 539 
specifying amount of conventional memory for, 430 

Last Modification Date option 
in File Manager, 115, 117 

Last Modification Time option, in File Manager, 116 
LASTDRIVE command line 

in CONFIG.SYS file, 518 
Line at a Time option, in Terminal, 337 
Line breaks, optional, 231 
Line spacing, changing, 243 
Line tool, in Paintbrush, 290 - 291 
Line Wrap option, in Terminal, 323 
Lines 

aligning in the Paintbrush window, 304 
connecting into polygons, 294 - 295 
drawing curves, 288 
drawing freehand, 286 
drawing straight lines 

diagonal, 291 
freehand, 290 
horizontal,291 
vertical, 291 

Linesize box in Paintbrush window 
described, 265 
removing, 267 

List boxes 
described, 36 
drop-down, 38 
selecting multiple items from, 38 
selecting single items from, 37 



List command, in Cardfile, 388 
List of Printers box, 162 
List Separator option, in Control Panel, 182 
Local Echo option, in Terminal, 324 
Lock Application Memory option, in PIF Editor, 469 
Logarithmic functions, using with Calculator, 368 - 369 
Long Date Format option, in Control Panel, 183 
Low Priority command, in Print Manager, 203 
Lower Case command, in File Manager, 120 
Luminosity, defined, 150 

M ________________________ _ 
Macro Properties dialog box, 415 
Macros. See Recorder 
Magnetic grid on desktop, 157 
Magnifying portions of a drawing, 305 
Main group, described, 80 
Make System Diskette command 

in File Manager, 139,537 
Margins 

changing for Calendar appointments, 384 
changing for Paintbrush drawings, 311 
changing for whole document, 252 
standard, in Write documents, 247 

Mark command 
described, 32 
in Calendar, 381 

Maximize button, described, 22 
Maximize command, on Control menus 

described,32 
restoring a window to its previous size, 45 

Measurement option, in Control Panel, 182 
Medium Priority command, in Print Manager, 203 
Memory 

and swapping by Windows, 497 
configuring 

on an 80286 computer, 501 
on an 80386 or 80486 computer, 499 - 500 
on an 8086 or 8088 computer, 502 

conserving with keyboard option, 455 
conserving with Prevent Program Switch option, 456 
conventional, described, 494 
expanded, described, 495 
extended, described, 495 
for large drawings, 264 
for wallpaper, 156 
freeing up, 478 - 482,515 - 518 
functions in Calculator, described, 359 
identifying your system's configuration, 496 
installing the expanded memory emulator, 540 
network card for, 548 
reconfiguring expanded as extended, 501 

Memory (continued) 
reserving, for direct memory access, 549 
used by the Clipboard, 62 
using a RAM disk, 535, 591- 594 
using the EMM386 utility, 594 - 598 
using the HIMEM utility, 583 - 586 

Index 625 

using the SMARTDrive program, 530, 587 - 590 
Memory option, in Control Panel, 168 
Memory Requirements option, in PIF Editor, 453, 460 
Memory-resident software 

described,442 
minimizing use of memory, 515,519 
running with Windows, 51, 443 
starting from the WINSTART.BAT file, 519 

Menu bars, described, 22 
Menus 

canceling, 26 
cascading, 28 
commands 

active vs. inactive, 28 
choosing, 27 
dimmed,28 

Control,28 
conventions, 27 
defined, xxiv 
described, 25 
selecting, 26 

Merge command 
merging Cardfile files, 395 
merging Recorder files, 416 

Merging files 
in Cardfile, 395 
in Recorder, 416 

Messages 
from inactive applications, 63 
from Print Manager, 204 
suppressing in File Manager, 132 
system, 13 - 14 

Microsoft Paint files, using in Paintbrush, 308 
Minimize button, described, 22 
Minimize command, on Control menus 

described, 32 
shrinking a group window to an icon, 82 
shrinking a window to an icon, 44 

Minimize on Use command 
described, 120 
retaining the Recorder window for macro playback, 410 
shrinking Program Manager to an icon, 97 

Modem commands, in Terminal, 329 
Modems 

choosing commands for, 328 
connecting to serial port, 317 
entering phone number for Terminal sessions, 320 - 322 



626 Index 

Modems (continued) 
problems with 

failure to dial, 351 
misdialing, 351 

supported by Windows, x 
Modes 

386 enhanced. See 386 enhanced mode 
for running Windows, defined, xxiii - xxv 
graphics, 453, 470 - 471 
large-frame EMS, 538 
multiple text, for applications, 453 
real. See Real mode 
small-frame EMS, 538 
standard. See Standard mode 
text, for applications, 453, 470 - 471 

Monitor Ports options, in PIF Editor, 471 
Monochrome monitor, using with Paintbrush, 277 
Month command, in Calendar, 371 
Monthly calendar. See Calendar 
Mouse buttons 

changing double-click speed, 187 
clicking, defined, xxiii 
double-clicking, defined, xxiv 
right vs. left 

in Paintbrush, 263 
switching functions, 188 

Mouse dialog box, 187 
Mouse pointer 

changing speed of movement, 187 
in Write window, 224 

Mouse-driver software, minimizing use of memory, 518 
Move command 

described,32 
moving a window, icon, or dialog box, 42 
moving files or directories, 130 
moving program items between groups, 95 

Move dialog box, in File Manager, 130 
Move Picture command, in Write, 232 
Moving 

Cardfile text among cards, 392 
data between applications, 56 
dialog boxes, 41 
files to another directory, 128 
icons, 41 
mUltiple files at once, 130 
program items between groups, 95 
windows, 41 
within dialog boxes, 34 

MS-DOS Executive. See File Manager 
MS-DOS 

applications. See Non-Windows applications 
commands to avoid running from Windows, 54 
naming conventions for files, 122 

MS-DOS (continued) 
wildcard characters for specifying filenames, 123, 128 

Multiple Text mode for applications, 453 
Multitasking 

N 

See also Applications, running two or more at once 
options for 386 enhanced mode, 192 - 193, 463 - 465 

Name command, in File Manager, 115 
Name option, in File Manager, 117, 119 
Naming conventions, for files and directories, 122 
Nested macros, 413 
Network command, in Print Manager 

ignoring network queue status, 209 
printing directly to the network, 210 

Network Connections dialog box, 172 
Network Options dialog box 

network printing with Print Manager, 210 
updating network queues, 209 

Network options, choosing, 177 
Network printers 

connecting to, 172 
disconnecting from, 173 

Network printing 
described, 206 
print queues 

displaying all files for a printer, 206 
displaying files you send, 200 
displaying other network queues, 207 
updating, 208 - 209 

printing large files, 209 
with Print Manager, 209 
without Print Manager, 174 

Network servers 
adding new connections to the Previous list, 105 
browsing, 106 
choosing from previous connections, 105 
connecting to, 105 - 106 
described, 104 
disconnecting from, 106 
displaying connections with Print Manager, 200 

Networks 
features of Windows for, 547 
guidelines for using with Windows, 546 - 550 
improving access to applications, 554 
installing network applications in Program Manager, 555 
installing Windows on, 553 
problems with 

connecting to network drivers or printers, 553 
non-Windows applications won't run, 552 
system fails at start-up, 548 - 549 
system fails with specific application, 550 



Never Warn option, in Control Panel, 192 
New command, on File menus 

adding program items and documents to groups, 89 
creating a new group, 87 
opening a drawing with a new color, 270 
opening a drawing with a new standard size, 265 
opening a new settings file, 320 

New Program Object dialog box, 87 
Next command 

described,32 
selecting an open directory window, 113 
switching among document windows, 65 
viewing the next Calendar day or month, 373, 375 

No Screen Exchange option, in PIF Editor, 455 
N on-Windows applications 

changing settings for 
described, 441 
with PIF Editor. See PIF Editor 
with the Settings command, 476 - 478 

conserving memory when running, 519 
Control menu, 30 
copying an entire screen, 58 
copying information from, 57 
copying PIFs from non-Windows disks, 445 
creating multiple PIFs for, 442 
creating single PIFs for, 448 
defined, xxiv 
described, 49 
display of, 49 
full-screen, 49 
group in Program Manager, described, 80 
improving speed with SMARTDrive, 531 
installing predefined PIFs for, 445 
memory-resident. See Memory-resident software 
network problems with, 552 
pasting into, 59 - 60 
PIFs for, described, 445 
printing with, 197 
problems with. See Troubleshooting 
quitting, 63 
running from a PIF, 441 
running from MS-DOS, 53 
running in a window, 461, 477 
using special characters with, 571 
with 386 enhanced mode, 50 

Normal command, in Write, 276 
Notepad 

described, 400 
entering and editing text, 400 
Find dialog box, 402 
finding text, 401 - 402 

Notepad (continued) 
managing files 

adding current time and date, 404 
creating time-log files, 403 - 404 
displaying file size, 402 

moving through a document, 401 
printing files, 404 
selecting text, 401 
starting, 399 
word wrap option, 400 

Null modem cable, 317 
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Number base functions, using with Calculator, 367 
Number Format dialog box, 186 
Number of Copies option, in Paintbrush, 309 
Number systems 

converting values with scientific calculator, 364 
Numbers, changing display format of, 186 
Numeric keypad keys 

shortcut keys for macros, 408 

o 
Octal number system 

using with scientific calculator, 364 
On-line Help 

buttons in, 74 
described, 70 
exiting, 74 
Help menu options, described, 72 
requesting, 70 
retracing steps through, 74 
searching for a topic, 73 
selecting topics, 74 
using the Help menu, 71 
viewing next or previous topic, 74 

Open command, on File menus 
converting a Microsoft Paint file, 308 
opening a document or file, 64 
opening a settings file, 320 
opening read-only Calendar files, 382 
retrieving a Clipboard file, 62 
starting 

an application from a directory window, 137 
an application from File Manager, 52 
an application from Program Manager, 51 
Calculator, 357 
Calendar, 370 
Cardfile, 386 
Clock,398 
File Manager, 102 
Notepad,399 
Paintbrush, 263 
PIF Editor, 446 
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Open command, on File menus (continued) 
starting (continued) 

Recorder, 405 
Write, 223 

Opening 
Control menus 

for application windows, 28 
for dialog boxes, 30 
for document windows, 29 
for icons, 29 
for non-Windows applications, 30 

directory windows, 112 
documents, 64 
drop-down list boxes, 39 
files, 64 

Operators, using with Calculator, 366 
Optimizing Windows 

by adjusting permanent swap file size, 523 
by changing the hard disk's interleave, 513 
by compacting the hard disk, 512 - 513 
by configuring memory correctly, 499 
by controlling temporary swap file size, 528 
by controlling use of expanded memory, 539 
by deleting unnecessary files, 508 - 511 
by freeing up memory before starting, 515 - 518 
by installing additional expanded memory, 506 
by installing additional extended memory, 504 
by reconfiguring expanded memory as extended, 501 
by setting location of application swap files, 529 - 530 
by setting the TEMP environment variable, 538 
by using a permanent swap file, 521 - 524 
by using a temporary swap file, 526 - 528 
by using the EMM386 utility, 540, 596 - 598 
by using the HIMEM utility, 583 - 586 
by using the RAMDrive utility, 535, 591- 594 
by using the SMARTDrive utility, 530 - 535,587 - 590 
by using the WINSTART.BAT file, 519 
described, 493 
disk space, described, 497 
memory, described, 494 - 495 
table of methods for, 503 

Option buttons 
described,39 
selecting, 40 

Optional hyphens, in Write documents, 231 
Optional Parameters option, in PIF Editor, 451 
Orientation option, in Control Panel, 168 
Other command, in File Manager, 115 
Other Net Queue command, in Print Manager, 207 
Other Net Queue dialog box, 207 
Overlapping windows 

rearranging, 84, 120 
selecting when "hidden", 114 

p 
Page breaks 

automatic, 234 - 235 
confirming, 236 
manual, 235 - 236 
searching for, 229 
when changing printers, 257 

Page layout 
changing for whole document, 252 
standard, 247 

Page Layout command, in Write, 252 
Page Layout dialog box, 252 
Page numbering, changing for whole document, 252 
Page numbers 

from automatic page breaking, 235 
using as header or footer, 249 

Page orientation, 166 
Page Setup command 

printing a header or footer in a drawing, 312 
printing a header or footer on appointments, 385 
setting margins for printing a drawing, 311 
setting margins for printing appointments, 384 

Page Setup dialog box 
in Calendar, 384 
in Paintbrush, 311 

Page status area, in Write window, 224 
Paint files, using in Paintbrush, 308 
Paint Roller tool, in Paintbrush, 285 - 286 
Paintbrush 

advanced features, 301 
Airbrush tool, 281 
Box tool, 291 - 292 
Brush Shapes dialog box, 287 
Brush tool, 286 - 287 
Circ1e/Ellipse tool, 293 - 294 
Color Eraser tool, 282 - 283 
creating a drawing. See Creating drawings 
Curve tool, 288 - 289 
Edit Colors dialog box, 306 
editing a drawing. See Editing drawings 
editing text in a drawing, 278 
Eraser tool, 284 - 285 
Filled Box tool, 291 - 292 
Filled Circ1e/Ellipse tool, 293 - 294 
Filled Polygon tool, 294 - 295 
Filled Rounded Box Tool, 292 
Image Attributes dialog box, 265 
Line tool, 290 - 291 
managing files 

described, 307 
opening, 307 
saving, 307 



Paintbrush (continued) 
managing files (continued) 

using Microsoft Paint files, 307 
mouse vs. keyboard, 263 
Page Setup dialog box, 311 - 312 
Paint Roller tool, 285 - 286 
Pick cutout tool, 280 
Polygon tool, 294 - 295 
Print dialog box, 309 
printing a drawing 

changing printers, 313 
changing standard margins, 311 
currently displayed drawing, 309 - 310 
portions of, 310 
problems with, 216 
with headers and footers, 311 - 312 

Rounded Box tool, 292 
Scissors cutout tool, 279 
starting, 263 
Text tool, 274 
window, described, 263 - 265 

Palette command, in Paintbrush, 267 
Palette, in Paintbrush window 

described, 265 
removing, 267 

Paper Orientation option, in Control Panel, 168 
Paper Size option, in Control Panel, 167 
Paper source option, in Control Panel, 167 
Paragraph format 

changing alignment, 243 
changing indentation, 244 
changing line spacing, 243 
creating hanging indents, 245 - 246 
described,240 
paragraph marks, 242 
using the Ruler, 240 - 244 

Paragraph marks 
adding, 242 
deleting, 243 
searching for, 229 

Parameters for applications, 451, 459 
Parity Check option, in Terminal, 328 
Parity option, in Terminal, 327 
Parity, using with file transfers, 335 
Partial option, in Paintbrush, 310 
Paste command, on Edit menus 

copying a cutout from the Clipboard, 296 
copying a number to Calculator's display, 360 
copying a picture to a Cardfile card, 393 
copying into a non-Windows application, 60 
copying into a Windows application, 59 
copying text to a Cardfile card, 392 
described, 32 

Paste command, on Edit menus (continlled) 
inserting cut or copied text, 70 
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sending Clipboard contents to a remote system, 347 
Paste From command, for retrieving cutouts, 300 
Pasting 

cutouts from files, 300 
cutouts in drawings, 296 
numbers in Calculator 

binary, octal, and hex values, 364 
decimal values, 360 

opaquely 
described, 299 
when moving a cutout, 297 - 298 

pictures onto cards, 393 
portions of a drawing, 273 
text into the active window, 70 
to non-Windows applications, 59 - 60, 488 
to Windows applications, 59 
transparently 

described, 299 
when moving a cutout, 297 - 298 

Pathname, defined, xxv 
Patterns 

filling in shapes with, 285 - 286 
for the desktop 

changing, 153 - 154 
choosing, 152 
creating, 154 
removing, 154 

selecting for a drawing, 270 
Pause button 

in Print Manager, 201 
in Terminal, 344 

Phone Number command, in Terminal, 321 
Phone Number dialog box, 321, 334 
Phone numbers 

automatic dialing by Cardfile, 397 
for Terminal sessions, 320 - 322 

Pick cutout tool, in Paintbrush, 280 
Picture command, in Cardfile, 393 
Pictures 

creating in Paintbrush. See Creating drawings 
editing in Write 

changing picture size, 233 
moving pictures, 232 - 233 

pasting on cards in Cardfile, 393 
PIF Editor 

changing modes, 447 
creating a PIF 

for a batch file, 448 
for an application, 448 
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PIF Editor (continued) 
options for 386 enhanced mode 

advanced, 462 - 475 
basic, 452, 457 - 474 

options for standard or real mode, 450 - 457 
overriding default PIF settings, 449 

PIFs 
See also PIF Editor 
copying from non-Windows disks, 445 
creating, 448 
described, 444 
for batch files, 448 
installing predefined PIFs, 445 
multiple PIFs for an application, 442 
running non-Windows applications from, 441 

Pixels, editing one by one, 305 
Placeholders in bold text, defined, xxii 
Playback Speed option, in Recorder, 417 
Playback To option, in Recorder, 417 
Point size, defined, 178 
Pointer, described, 22 
Pointing with the mouse, defined, xxv 
Polygon tool, in Paintbrush 

using lines at any angle, 294 - 295 
using lines with fixed angles, 295 

Pop-up programs. See Memory-resident software 
Port option, in Cardfile, 398 
Portrait orientation, 166 
Ports 

choosing, 163 - 164 
communications settings for, 175 
for communications applications, 455 
for remote communications, 317 

Ports dialog box, 176 
Preferences command, in Recorder, 417 
Prevent Program Switch option, in PIF Editor, 456 
Previous command, in Calendar, 373, 375 
Print All command, in Cardfile, 396 
Print command 

in Calendar, 383 
in Cardfile, 396 
in File Manager, 134 
in Notepad, 404 
in Paintbrush, 309 
in Write, 255 

Print dialog box 
in Calendar, 383 
in Paintbrush, 309 
in Write, 256 

Print File Size command, in Print Manager, 205 

Print Manager 
See also Printing, Network printing 
described, 198 
Network Options dialog box 

network printing with Print Manager, 210 
updating network queues, 209 

Other Net Queue dialog box, 207 
print queues. See Print queues 
Selected Net Queue dialog box, 207 
starting, 199 
window 

described, 199 
exiting, 205 
opening, 199 
showing network queues, 200 
showing one queue, 199 

Print options 
defined, 166 
for printer configuration, described, 167 

Print queues 
changing order of files, 200 
defined, 198 
deleting files, 202 
displaying 

all files for a network printer, 206 
described, 198 
file information line, 200 
for multiple printers, 200 
for network printers, 200 
for other networks, 207 
printer queue information line, 199 

file size display, turning off, 205 
interrupting printing, 201 
time/date display, turning off, 205 
updating network queues, 208 - 209 

PRINT SCREEN key 
copying screens to the Clipboard, 58 

Printer echo 
printing incoming text, 349 
setting for Terminal sessions, 349 

Printer Echo command, in Terminal, 349 
Printer installation. See Installing printers 
Printer option, in Control Panel, 167 
Printer queue information line, 199 
Printer Setup command 

in Paintbrush, 313 
in Write, 257 

Printer Setup dialog box, in Write, 257 
Printer-driver files 

and non-Windows applications, 197 
described, 159 
for more than one printer, 167 
Generic/Text Only printer driver, 162 



Printer-driver files (continued) 
installing new version, 161 
non-Windows printer drivers, 163 
obtaining the Driver Library Disk, 162 
removing, 174 
using existing version, 161 

Printer-specific settings, 166 
Printers 

See also Printer-driver files 
active, 169 
compatibility of, 162 
configuring 

changing the print options, 166 - 168 
choosing a connection, 163 - 164 
choosing the active printer, 169 
choosing the default printer, 170 
choosing timeout options, 171 - 172 
described, 164 
setting access priorities for 80386 computers, 164 

connecting to a network printer, 172 
default, 170 
disconnecting from a network printer, 173 
fonts for, 168 
Help (print option), 168 
installing, 158 - 162 
printer-driver files, described, 159 
problems with. See Printing; problems with 
removing, 173 - 174 
using Genericffext Only printer driver, 162 

Printers dialog box 
adding printers, 159 - 160 
choosing the active printer, 169 
choosing the default printer, 170 
printing without Print Manager, 175 

Printing 
Calendar appointments, 383 - 386 
cards in Cardfile, 396 
from File Manager, 134 
from Tenninal, 348 - 349 
Notepad files, 404 
on a network. See Network printing 
Paintbrush drawings, 309 - 313 
preparing printers for. See Printers 
problems with 

garbled output, 213 
incorrect page fonnat, 213 
installed fonts do not print, 214 
lines missing from a Paintbrush drawing, 216 
lost blocks of text, 215 
part of a document does not print, 216 
printer does not print, 212 

text files from File Manager, 134 
to a file, 210 - 211 

Printing (continued) 
transferred files, 348 - 349 
with non-Windows applications, 197 
with Print Manager 

changing order in print queue, 200 
changing printing speed, 202 - 203 
deleting files from print queues, 202 
described, 198 
displaying messages, 204 
displaying print queues, 198 - 200, 205 
interrupting printing, 201 
on a network, 206 - 209 
using Pause and Resume buttons, 201 

with Windows applications, described, 197 
without Print Manager, 174 
Write documents 

changing printers, 257 
print options, 255 - 256 

Printing speed, changing, 202 - 203 
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Priority options, for non-Windows applications, 477 
Problems. See Troubleshooting 
Procedures command, in Help menu, 72 
Processing time 

and options for 386 enhanced mode, 192 - 193 
and printing speed, 203 

Program Filename option, in PIF Editor, 451, 458 
Program Group Properties dialog box, 87 
Program item icons 

defined, xxv 
described, 82 

Program Item Properties dialog box, 90 
Program items 

adding 
from File Manager, 91 
from Program Manager, 88 - 89 
from Setup, 93 

browsing through, 90 
changing icons for, 91 
changing properties of, 96 
command line for, 90 
copying to another group, 94 
deleting, 94 
icons for, 82 
moving to a different group, 95 

Program Manager 
changing layout of, 81 
described, 79 - 80 
groups, described, 80 
installing network applications in, 555 
New Program Object dialog box, 87 
Program Group Properties dialog box, 87 
Program Item Properties dialog box, 90 
quitting, 11 - 12, 98 
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Program Manager (continued) 
replacing with File Manager as start-up program, 102 
returning to, 97 
shrinking, 97 
starting, 79 

Proof option, in Paintbrush, 310 
Properties command, in Program Manager 

changing a group's description, 88 
changing a macro's properties, 414 
changing a program item's properties, 96 

Protected mode. See Standard mode, 386 enhanced mode 
Protocols 

a 

for binary and text transfers, 335 
Kermit, described, 339 
XModem/CRC, described, 339 

Queues. See Print queues 
Quitting 

R 

applications, 10, 63 
File Manager, 142 
non-Windows applications, 489 
Program Manager, 11-12,98 
Windows, 11 -12,98 

RAM disk 
defined,535 
setting the TEMP environment variable to, 519, 538 
using for application swap files, 530 

RAM Drive utility 
command lines for, 591 - 594 
described, 535 
setting up, 536 

Read Only file attribute, 134 
Read-only files, 64 
Real mode 

controlling use of expanded memory, 429 
defined, xxv 
freeing up memory for applications, 479 
PIF options for. See Standard mode 
requirements for running, x 
running applications in, 438 
starting Windows in, 428 

Rearranging. See Arranging 
Receive Binary File command, in Terminal, 345 
Receive Binary Files dialog box, 345 
Receive Text File command, in Terminal, 341 
Receive Text File dialog box, 341 
Record command, in Recorder 

choosing options for recording a macro, 410 
recording a simple macro, 406 

Record Macro dialog box, 406 
Record Mouse box, 411 
Record Mouse option, in Recorder, 417 
Recorder 

Default Preferences dialog box, 417 
described, 405 
File Merge dialog box, 416 
guidelines for recording macros, 420 
Macro Properties dialog box, 415 
macros for demonstrations 

creating, 418 
disabling CTRL + BREAK, 419 

managing files 
changing macro properties, 414 
deleting macros, 415 
merging files, 416 

naming macros, 408 
options for playing back macros 

continuous playback, 418 
minimizing Recorder at playback, 410 
play back in any application, 413 
play back in one application, 413 
slow speed, 418 

options for recording macros 
changing standard settings, 417 - 418 
described, 410 
including mouse movements, 411 - 412 
macros that cannot nest, 413 
nested macros, 413 
relative to window or full screen, 412 
standard settings, described, 417 

playing back a macro, 409 
Record Macro dialog box, 406 
Record Mouse box, 411 
recording simple macros, 405 - 407 
shortcut keys 

assigning to macros, 407 - 408 
disabling temporarily, 419 

starting, 405 
stopping a macro during playback, 409 

Rectangles 
drawing hollow or solid, 291 - 292 
drawing with round comers, 292 

Redial After Timing Out option, in Terminal, 321 
Reduce Font command, in Write, 239 
Reducing. See Shrinking 
Refresh command, in File Manager, 121 

. Registering Windows, xi 
Relative To option, in Recorder, 417 
Remote computers 

See also Terminal 
communications settings for, 318 
connecting to, 334 



Remote computers (continued) 
disconnecting from, 350 

Remote echo, defined, 324 
Remove command, in Calendar, 383 
Remove dialog box, in Calendar, 383 
Rename command, in File Manager, 133 
Renaming files and directories, 133 
Repaginate command, in Write, 234 
Repaginate Document dialog box, 234 
Repaginating Document dialog box, 236 
Repeat Last Find command, in Write, 231 
Repeat rate of keyboard, changing, 189 
Replace on Open command, in File Manager, 114 
Replacing 

contents of the active directory window, 114 
text, 69 

Requirements for running Windows, x 
Reserve Shortcut Keys options, in PIF Editor, 457, 474 
Resizing windows, 42 
Restore button, described, 22 
Restore command 

described, 32 
restoring a window to its previous size, 47 
restoring an icon to a window, 46 
undoing changes to a Cardfile card, 393 

Resume button 
in Print Manager, 201 
in Terminal, 344 

Retain Video Memory option, in PIF Editor, 472 
Reversi. See on-line Help in Reversi 
Reversing edit commands, 69 
Revisions for Windows, xi 
Root directory, described, 101 
Rounded Box tool, in Paintbrush, 292 
Ruler Off command, in Write, 241 
Ruler On command, in Write, 241 
Ruler, in Write window 

changing line spacing with, 244 
changing paragraph alignment with, 243 
changing paragraph indentation with, 244 
deleting tabs with, 251 
displaying, 241 
hiding, 241 
setting tabs with, 251 

Run command 
playing back a macro, 409 
starting an application, 52, 138 
starting Swapfile, 522 

Running. See Starting 

s 
Saturation, defined, 150 
Save As command, on File menus 

backing up a Write document, 255 
creating a PIF, 448 
overriding standard PIF settings, 449 
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saving a drawing in nonstandard format, 307 
saving a file under another name, 65 
saving a settings file under a new name, 350 
saving the Clipboard contents, 62 

Save Colors command, in Paintbrush, 307 
Save command, on File menus 

saving a document or file, 65 
saving a drawing, 307 
saving a settings file, 350 
saving a Write document, 254 

Save Controls option, in Terminal, 342 
Saving documents and files 

formatting choices in Write, 254 
with different names, 65 
with the same name, 65 

Scientific calculator 
displaying, 362 
functions, 366 - 369 

Scissors cutout tool, in Paintbrush, 279 
Scratch pad, in Calendar, 373 
Screen fonts 

installing, 178 
viewing printer fonts on screen, 178 

Scroll bars 
described, 22 
displaying in Terminal sessions, 324 
for moving in a Paintbrush drawing, 267 
for moving through a Write document, 224 
in the Directory Tree window, 104 
viewing text in windows and dialog boxes, 47 

Scroll buffer in Terminal window, 348 
Search button, in on-line Help, 74 
Search command, searching for files or directories, 123 
Search dialog box 

in File Manager, 123 
in on-line Help, 73 

Search Results window in File Manager, 124 
Searching for files or directories, 123 
Select All command 

selecting all files in a directory window, 127 
selecting all text in a Notepad file, 401 
selecting all text in the Terminal window, 347 

Selected Net Queue command, in Print Manager, 206 
Selected Net Queue dialog box, 207 



634 Index 

Selecting 
application windows, 54 
check boxes, 40 
defined, xxv 
directories and files from directory windows, 125, 127 
directories from the Directory Tree, 108 
directory windows, 113 
from drop-down list boxes, 39 
from list boxes 

mUltiple items, 38 
single items, 37 

"hidden" windows, 114 
menus, 26 
option buttons, 40 
text 

described,67 
in text boxes, 36 
with the Mark command, 57 

Selection bar, described, 226 - 227 
Selection cursor, described, 22 
Send Binary File command, in Terminal, 344 
Send Binary File dialog box, 344 
Send command, in Terminal, 347 
Send Text File command, in Terminal, 340 
Send Text File dialog box, 340 
Serial ports. See Ports 
Set command, in Calendar 

removing an alarm, 378 
setting an alarm, 375 

Set System Default option, in File Manager, 116 - 119 
Set Up Applications command, in Setup, 93, 562 
Set Up Applications dialog box, 93, 562 
Settings command, on Control menus 

changing settings for a running application, 476 
terminating a non-Windows application, 490 

Settings dialog box, 176,476 
Settings files in Terminal. See Terminal 
Setup Printer dialog box, 165 - 166 
Setup program 

adding applications to Windows, 562 
adding program items to groups, 93 
Change System Settings dialog box, 560 
changing system settings, 560 
described, 7 
installing device drivers, 563 
reinstalling Windows, 565 
running from Windows, 559 
running to install Windows, 7 
Set Up Applications dialog box, 93, 562 
using to maintain the Windows environment, 559 

Shading a drawing, with the Airbrush tool, 281 

Shapes 
cutting out, 279 
drawing circles 

with Circle/Ellipse tool, 293 - 294 
with perfect proportions, 294 

drawing ellipses, 293 
drawing freehand, 286 
drawing polygons 

using lines at any angle, 294 - 295 
using lines at fixed angles, 295 

drawing rectangles 
with round comers, 292 
with square comers, 291 - 292 

drawing squares 
with perfect proportions, 292 
with rounded comers, 292 
with square comers, 291 - 292 

filling in with color, 285 - 286 
SHELL command line, in CONFIG .SYS file, 518 
Short Date Format option, in Control Panel, 183 
Shortcut keys 

assigning to macros, 407 - 408 
disabling temporarily in Recorder, 419 
for moving an application to foreground, 475 
for switching to a pop-up program, 444 
in menus, described, 28 
in Write, 225 
problems with, 483, 485 
reserving for applications 

in 386 enhanced mode, 457, 474 
in standard or real mode, 457 

Shortcut Keys command, in Recorder, 419 
Show Date dialog box, 374 
Show Function Keys command, in Terminal, 333 
Show Hidden/System Files option, in File Manager, 119 
Show Scroll Bars option, in Terminal, 324 
Shrink + Grow command, in Paintbrush 

adjusting cutout size, 301 
adjusting picture size for printing, 216 

Shrinking 
cutouts in a drawing, 301 
File Manager when applications start, 120 
group windows, 82 
Program Manager on application start-up, 97 
windows to icons, 44 

Signal When Connected option, in Terminal, 321 
Size command, on Control menus 

changing the size of a window, 43 
described, 32 

Size of windows 
changing, 42 
minimum, 42 

Size option, in File Manager, 115, 117 



Size Picture command, in Write, 233 
Small-frame EMS mode, running Windows in, 539 
SMARTDrive program 

command lines for, 587 - 590 
described, 530 
installing, 532 
running in extended or expanded memory, 533 
specifying the disk cache size, 533 - 535 

Soft fonts, installing, 179 
Solitaire. See on-line Help in Solitaire 
Sort By command, in File Manager, 117 
Sort By dialog box, 117 
Sorting contents of directory windows, 116 - 117 
Sound option 

in Control Panel, 190 
in Terminal, 324 

Source directories, defined, 128 
Spaces, searching for, 229 
SPART.PAR file, 509, 521 
Special Time command, in Calendar, 380 
Special Time dialog box, 380 
Speed of computer system 

described, 493 
improving by using RAMDrive, 535, 591- 594 
improving by using SMARTDrive, 530 - 535 

Spooling. See Print Manager 
Spray painting with the Airbrush tool, 281 
Squares 

drawing hollow or solid, 291 - 292 
drawing perfect squares 

with round comers, 292 
with square comers, 292 

STACKS command line, in CONFIG.SYS file, 518 
Standard applications. See Non-Windows applications 
Standard calculator 

displaying, 357 
functions, 361 

Standard command, in PIF Editor, 447 
Standard Flow Control option, in Terminal, 336 
Standard mode 

defined, xxv 
freeing up memory for applications, 479 
non-Windows applications with, described, 440 
PIF options for 

Close Window on Exit, 456 
Directly Modifies, 455 
Memory Requirements, 453 
No Screen Exchange, 455 
Optional Parameters, 451 
Prevent Program Switch, 456 
Program Filename, 451 
Reserve Shortcut Keys, 457 
Start-up Directory, 452 

Standard mode (continued) 
PIF options for (continued) 

Video Mode, 452 
Window Title, 451 
XMS Memory, 454 

problems running applications in, 551 
requirements for running, x 
starting Windows in, 429 
transferring information, 32 

Start-up Directory option, in PIF Editor, 452 
Starting 

applications 
from a directory window, 137 
from a document or program file, 137 
from a group, 51, 96 
from a network, 546 
from directory windows, 51 
from the Windows command line, 431 
with the Run command, 52 

Calculator, 357 
Calendar, 370 
Cardfile, 386 
Clock,398 
Control Panel, 145 
DOS prompt, 53 
File Manager, 102 
Notepad,399 
Paintbrush, 263 
Print Manager, 199 
Program Manager, 79 
Recorder, 405 
Terminal, 319 
Windows 

general instructions for, 8 
in 386 enhanced mode, 429 
in real mode, 428 
in standard mode, 429 
options for, described, 427 

Write, 223 
Starting Time option, in Calendar, 379 
Statistical calculations, 364 - 366 
Statistical functions, using with Calculator, 368 
Statistics Box buttons, described, 366 
Status Bar command, in File Manager, 120 
Status bar, in directory windows, 120 
Status messages. See Messages 
Stop Bits option, in Terminal, 328 
Stop button, in Terminal, 344 
Subscript, 238 
Superscript, 238 
Support for Windows, xi 
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Swap files 
application. See Application swap files 
described, 520 
displaying information about, 520 
penn anent 

adjusting size of, 524 
changing location of, 524 
described, 521 
removing, 525 
setting up, 522 

temporary 
changing location of, 528 
controlling size of, 528 
deleting to free up disk space, 509 
described, 520, 526 
setting up, 527 

Swapfile program 
options, described, 523 
using to create a Windows swap file, 521 

Swapping 
described, 497 
preventing, 507 

Sweeping 
cutouts in drawings, 297 - 298 
opaquely 

described, 299 
when dragging a cutout, 298 

transparent! y 
described, 299 
when dragging a cutout, 298 

Switch To command, on Control menus 
described, 32 
opening Task List, 55 

Switches 
for command lines in CONFIG.SYS, 583 - 599 
for controlling use of expanded memory, 430 
for starting Windows, 428 - 429 

Switching among windows, 54, 65 
System diskettes, making, 139 
System file attribute, 135 
System messages. See Messages 
System resources. See Optimizing Windows 
System settings 

and network compatibility, 548 
changing, 560 

SYSTEM.INI file 
MaxPagingFileSize setting, 528 
MinUserDiskSpace setting, 528 
PagingDrive setting, 528 
Swapdisk setting, 529 

T 
Table Fonnat option, in Tenninal, 343 
Tabs 

decimal, 250 
deleting, 251 
preset, 249 
removing with the Ruler, 251 
searching for, 229 
setting with the Ruler, 251 
setting your own, 249 - 250 

Tabs command, in Write 
deleting tabs, 251 
setting tabs, 250 

Tabs dialog box, 250 
Task List 

rearranging icons, 56 
rearranging windows, 55 
switching among windows, 54 
tenninating a non-Windows application, 489 

Tasking options, for non-Windows applications, 477 
Telecommunications. See Tenninal 
TEMP environment variable 

setting to a RAM disk, 519, 538 
specifying, 538 

Temporary files, application 
deleting to free up disk space, 509 
specifying the directory for, 538 

Tenninal 
assigning function keys, 330 
Binary Transfers dialog box, 339 
Communications dialog box, 326 
communications session, described, 318 
connecting to a remote computer, 334 
displaying function keys, 333 
editing text 

clearing the window and buffer, 348 
copying to the Clipboard, 346 
pasting to the remote system, 347 
selecting all text, 347 
sending selected text, 347 

ending a Tenninal session 
disconnecting from the remote computer, 350 
saving Settings files, 350 

Function Keys dialog box, 330 - 331 
hardware requirements, 317 
Phone Number dialog box, 321, 334 
preparing a Tenninal session 

assigning function keys, 330 - 332 
choosing modem commands, 328 
choosing options for binary transfers, 338 - 339 
choosing options for text transfers, 336 - 338 
choosing tenninal emulation type, 322 



Tenninal (continued) 
preparing a Tenninal session (continued) 

choosing tenninal preferences, 323 - 326 
entering a phone number, 320 - 322 
opening settings files, 320 
setting the timer, 334 
specifying communications settings, 326 - 328 
turning on print mode, 349 

printing 
selected text, 349 
setting up a printer, 348 
starting print mode, 349 

problems with 
binary transfers fail, 353 
modem dials but cannot connect, 352 
modem fails to dial, 351 
operator interrupts call, 351 
text fails to print, 353 
text transfers fail, 352 

quitting, 351 
Receive Binary Files dialog box, 345 
Receive Text File dialog box, 341 
Send Text File dialog box, 340 
starting, 319 
Tenninal Emulation dialog box, 322 
Tenninal Preferences dialog box, 323 
Text Transfers dialog box, 336 
transferring binary files 

receiving, 345 - 346 
sending, 344 

transferring files, described, 335 
transferring text files 

receiving, 341 - 343 
sending, 340 - 341 
viewing, 343 - 344 

View Text File dialog box, 343 
Tenninal emulation 

described,322 
tables 

described, 573 
for VT 100 tenninals, 576 - 581 
for VT 52 tenninals, 573 - 575 

Tenninal Emulation command, 322 
Tenninal Font option, in Tenninal, 324 
Tenninal Preferences command, 323 
Tenninate option, with 386 enhanced mode, 478 
Text 

breaking into pages 
automatic page breaks, 234 - 235 
confinning page breaks, 236 
manual page breaks, 235 - 236 

deleting, 69 
editing after selecting, 69 

Text (continued) 
editing in Tenninal, 346 - 348 
editing in Write, 224 - 226 
entering in a Paintbrush drawing 

aligning accurately, 304 
choosing character styles, 276 - 277 

entering in a Paintbrush drawing 
choosing fonts, 275 - 276 
described,274 

entering in Cardfile, 387 - 388 
entering in Write documents, 224 
entering, basic techniques, 66 
finding and changing, in Write, 229 - 231 
finding in Cardfile, 390 - 391 
finding in Notepad, 401 - 402 
fonnatting 

character styles, 237 
documents. See Write 

inserting, 67 
printing. See Printing 
replacing, 69 
searching techniques, in Write, 228 
selecting 

described, 67 
in Notepad, 401 
in text boxes, 36 
in Write, 226 - 227 
options for, 68 
with the Mark command, 57 

typing, 224 
Text boxes, described, 36 
Text command, in Cardfile, 393 
Text editor. See Notepad 
Text files 

defined, 335 
printing with File Manager, 134 

Text mode, for applications, 453, 470 - 471 
Text tool, in Paintbrush, 274 
Text Transfers command, in Tenninal, 336 
Text Transfers dialog box, 336 
Tile command 
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rearranging application windows, 55 
rearranging document windows, 66 
rearranging File Manager windows, 114, 120 
rearranging group windows, 84, 86 
rearranging icons, 55 

Tilt command, in Paintbrush, 303 
Time 

adding to a Notepad file, 404 
changing the fonnat of, 183 - 184 
changing the system time, 189 
displaying with Clock, 398 - 399 
logging with Notepad, 403 - 404 
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Time (continued) 
setting alanns in Calendar, 375 - 377 
timing Tenninal sessions, 334 

Time Fonnat dialog box, 184 
Time Slice option, in Control Panel, 192 
Time/Date command, in Notepad, 404 
Time/Date Sent command, in Print Manager, 205 
Timeout If Not Connected in 30 Seconds option 

in Tenninal, 321 
Timeout options, described, 171 
Timer Mode command, in Tenninal, 334 
Title bars, described, 22 
Today command, in Calendar, 373 
Toolbox 

Airbrush tool, 281 
Box Tool, 291 - 292 
Brush tool, 286 - 287 
Color Eraser tool, 282 - 283 
Curve tool, 288 - 289 
described, 264 
Eraser tool, 284 - 285 
Filled Box tool, 291 - 292 
Line tool, 290 - 291 
Paint Roller tool, 285 - 286 
Pick cutout tool, 280 
removing from Paintbrush window, 267 
Scissors cutout tool, 279 
selecting a drawing tool, 272 
Text tool, 274 

Tools and Linesize command, in Paintbrush, 267 
Transferring data. See Data transfer 
Transferring files. See File transfers 
Translation option, in Tenninal, 325 
Transmission Retry timeout option, 171 - 172 
Trigonometric functions 

using with Calculator, 368 - 369 
Troubleshooting 

application problems, 482 - 489, 551 
modems. See Modems 
network problems. See Networks 
printing problems. See Printing; problems with 
running Setup to reinstall Windows, 565 

TSR programs. See Memory-resident software 
Type option, in File Manager, 117 
Typographic conventions, described, xxii 

u 
Underlining 

in a Paintbrush drawing, 276 
in Write documents, 237 

Undo command, on Edit menus 
canceling changes to a drawing, 305 
deleting portions of a drawing, 272 
described, 69 

Undoing previous edit operations, 69 
Units option, in Paintbrush, 266 
Update Net Queues command, in Print Manager, 208 
Updating directory windows, 121 
Upgrades for Windows, xi 
Use Printer Resolution option, in Paintbrush, 310 
Uses High Memory Area option, in PIF Editor, 468 
Using Help command, in Help menu, 72 

v 
Vertical lines, drawing perfectly straight, 291 
Video Memory options, in PIF Editor, 470 
Video Mode options, in PIF Editor, 452 
View Other dialog box, in File Manager, 115 
View Picture command, in Paintbrush, 268 
View Text File command, in Tenninal, 343 
View Text File dialog box, 343 
Volume labels 

assigning or changing, 141 
described, 103 

VT 100 tenninals 
escape sequences for supported functions, 578 - 581 
IBM PC equivalent keystrokes, 576 

VT 52 tenninals 
escape sequences for supported functions, 575 
IBM PC equivalent keystrokes, 573 

Mf ________________________ _ 

Wallpaper 
choosing a bitmap for, 155 
creating, 155 
described, 155 
freeing up disk space by deleting, 510 
freeing up memory by removing, 156 

Warning beep, turning on or off, 190 
Warning messages. See Messages 
Weitek Coprocessor, 597 
Whole option, in Paintbrush, 310 
Width option, in Paintbrush, 266 
Wildcard characters 

for specifying groups of files, 119, 123, 128 
searching for, 229 

WIN386.SWP file, 509, 526 
Window title 

described, 22 
specifying for a non-Windows application, 451, 459 

Window Title option, in PIF Editor, 451, 459 



Windowed option 
in PIF Editor, 461 
of the Settings command, 477 

Windows (program) 
See also Standard mode, 386 enhanced mode, Real mode 
adding applications with Setup, 562 
command line 

described, 427 
samples of, 431 

described, xi, xiii - xvi 
Help. See On-line Help 
installing, 7 - 8 
installing on a network, 553 
installing shared copy from a network, 545 
MS-DOS commands to avoid running, 54 
network features, 547 
new features, xvii - xviii 
optimizing. See Optimizing Windows 
quitting, 10, 98 
registering, xi 
requirements for running, x 
running Setup to change system settings, 559 
starting 

general information for, 8 
in 386 enhanced mode, 429 
in real mode, 428 
in standard mode, 429 
options for, described, 427 

structure of, described, 17 
technical support for, xi 
upgrades for, xi 
using memory-resident software with, 443 

Windows (screen elements) 
cascading, 84 
changing border width, 157 
changing size of, 32, 42 
closing, 32, 48 
common parts of, 21 
defined, xxv 
Directory Tree, 101 
directory. See Directory windows 
document. See Document windows 
enlarging, 32, 45 
for applications, 19 
group. See Group windows 
inactive. See Inactive windows 
lining up on desktop, 157 
minimum size of, 42 
moving, 32, 41 
opening, 82 
rearranging with Task List, 55 

Windows (screen elements) (continued) 
restoring 

from icons, 46 
to previous size, 32, 46 

scrolling through text, 47 
shrinking to icons, 32,44 
switching among, 54, 65 
tiling, 84 

Windows applications 
See also Applications 
affected by printing speed, 203 
copying an entire screen, 58 
copying information from, 57 
cutting information from, 57 
defined, xxv 
described, 49 
group in Program Manager, described, 80 
notification of new products, xi 
pasting to, 59 
printing with, 174, 197 - 211 
quitting, 63 
running older versions, 438 
switching among, 54 
transferring data between, 56 
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Windows in Background option, in Control Panel, 193 
Windows in Foreground option, in Control Panel, 193 
WINSTART.BAT file, 519 
Word breaks, optional, 231 
Word processing. See Write 
Word wrap 

absence in Paintbrush, 277 
for text transfers in Terminal, 338 
in Notepad documents, 400 
in Write documents, 224 
Terminal Line Wrap option, 323 

Word Wrap command, in Notepad, 400 
Word Wrap Outgoing Text at Column option 

in Terminal, 338 
Workspace, described, 22 
Workstation, diskless, 545 
Write 

breaking documents into pages 
automatic page breaks, 234 - 235 
confirming page breaks, 236 
manual page breaks, 235 - 236 

Change dialog box, 230 
character formats 

choosing, 238 
displaying, 237 
displaying fonts, 239 
saving, 237 
superscript and subscript, 238 
using fonts, 239 - 240 
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Write (continued) 
editing documents 

changing text, 229 - 231 
finding special characters, 229 
finding text, 228 
inserting optional hyphens, 232 
moving to specific pages, 225 - 226 
selecting text, 226 - 227 
using cursor movement keys, 224 - 225 
using scroll bars, 224 

editing pictures 
changing picture size, 233 
moving pictures, 232 - 233 

entering text, 224 
Find dialog box, 228 
Fonts dialog box, 240 
formatting documents, 237 - 252 
Go To dialog box, 226 
Indents dialog box, 244 
managing files 

backing up, 255 
opening non-Windows text files, 254 
opening non-Write docum~iits, 253 
opening Windows text files, 253 
saving documents, 254 

Page Layout dialog box, 252 
paragraph formats 

aligning paragraphs, 243 
changing indentation, 244 - 246 
changing line spacing, 244 
creating with the Ruler, 241 - 244 
described, 240 
using paragraph marks, 242 

Print dialog box, 256 
printing documents 

changing page layout settings, 256 
changing printers, 257 
print options, 255 - 256 

Repaginate Document dialog box, 234 
Repaginating Document dialog box, 236 
starting, 223 
Tabs dialog box, 250 
whole document formats 

changing page layout, 252 
described, 246 
setting tabs, 249 - 251 
using headers and footers, 247 - 249 

Write dialog box, 253 - 254 
Write window, described, 223 - 224 

)( 
XModem/CRC option, in Terminal, 339 
XMS memory. See Extended memory 
XMS Memory options, in PIF Editor 

z 
for 386 enhanced mode, 467 - 468 
for standard mode, 454 

Zoom In command, in Paintbrush 
canceling Zoom Out, 269 
editing a drawing, 305 
fixing color leaks, 286 

Zoom Out command, in Paintbrush 
canceling Zoom In, 305 
displaying an entire drawing, 268 



MICROSOFT PRODUCT ASSISTANCE REQUEST 
Microsoft Product Support Services - Phone (206) 454-2030 
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Instructions 

When you need assistance with a Microsoft pro
duct, call our Product Support Services group at 
(206) 454-2030. So that we can answer your 
question as quickly as possible, please gather all 
infonnation that applies to your problem. Note or 
print out anyon-screen messages you get when the 
problem occurs. Have your manual and product 
disks close at hand and have all the infonnation 
requested on this fonn available when you call. 

Diagnosing a Problem 
So that we can assist you more effectively, please 
be prepared to answer the following questions 
regarding your problem, your software, and your 
hardware. 

1. Can you reproduce the problem? 
Dyes D no 

2. Does the problem occur with another copy of 
the original disk of your Microsoft Software? 

Dyes D no 

3. Does the problem occur with another system 
(if available)? 

Dyes D no 

4. If you were running other windowing or 
memory-resident software at the same time, 
does the problem also occur when you don't use 
the other software? 

Dyes Dno 

Product 

Product name 

Version Number Registration Number 

Software 
Operating System 

NameN ersion number 

Windowing Environment 
If you were running Microsoft Windows or another 
windowing environment, give name and number of 
windowing software: 

CD ROM Software 

NameN ersion number 

Other Software 
NameNersion number of any other software you 
were running when problem occurred, including 
memory-resident software (such as keyboard 
enhancers or print spoolers): 



Hardware 
So that we can assist you more effectively, please 
be prepared to answer the following questions 
regarding your problem, your software, and your 
hardware. 

Computer 

Manufacturer/model 

Floppy-disk drives 
Number: 0 1 0 2 0 Other 
Size: 03 1/2" 051/4" 
Number of Sides: 0 1 0 2 

Total memory 

Density: 0 Single 0 Double 0 Quad 
Capacity: 
5 1/4": 0 160K D360K 0 1.2 megabytes 

3 1/2": 0 360K 0 400K 0 720K 0 800K 
o 1.4 megabytes 

System Memory 

Manufacturer/model Total memory 
(If using DOS, you can run CHKDSK to determine 
the amount of memory available. If using Apple 
Macintosh Finder, select "About The Finder ... " 
from the Apple menu to determine the amount of 
memory available.) 

Peripherals 
Hard Disk 

Manufacturer/model 

PrinterlPlotter 

Manufacturer/model 

o Serial o Parallel 

Capacity(megabyte) 

Printer peripherals, such as font cartridges, 
downloadable fonts, sheet feeders: 

Mouse 
Microsoft Mouse: 0 Bus 0 Serial 0 InPoJtrM 
o Other 

Manufacturer/model 

Boards 
o Add-on RAM board 

Manufacturer/model 

o Graphics-adapter board 

Manufacturer/model 

o Other boards installed 

Manufacturer/model 

Modem 

Manufacturer/model 

CD ROM Player 

Manufacturer/model 

Version of Microsoft MS-DOS® CD ROM 
Extensions: 

Network 
Is your system part of a network? 0 Yes 0 No 

Manufacturer/model 

What hardware and software does your network 
use? 
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